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Player  

Overview of the QALoad Player 
The QALoad Player simulates one or more virtual-users running C-based scripts. These scripts mimic user 
act ivi t ies to load test the appl icat ion, network, and server components of a cl ient-server system. 

The QALoad Player is used to simulate mult iple cl ients sending middleware cal ls back to a server. 
General ly, these are database SQL cal ls — al though other types of middleware layers can also be tested. 
When running virtual user simulat ion, QALoad Player can emulate mult iple users from a single platform 
using the mult i-tasking features of 32-bit  Windows. The number of users that a single hardware system can 
emulate is determined by the processor speed, main  memory size, middleware layer, and simulated 
transact ion rate. Please contact your QALoad distributor for further sizing in formation. 

Once started, QALoad Player is designed to funct ion ent irely in  the background without any direct user 
in teract ion. Al l  commands to QALoad Player come from the QALoad Conductor. In  fact, once QALoad 
Player has been started, the only in teract ion you may have with i t  is to change startup parameters or to 
save the contents of the display window to a fi le.  

Citrix and SAP 6.20/6.40 scripts play back in  a virtual user window on the desktop. For SAP, you can enable 
or disable the VU window from the Conductor's Custom middleware opt ions dialog box. Citrix replay 
sessions are min imized by default , but can be restored on the desktop. 

QALoad Player menus 
The fol lowing menus are avai lable from the QALoad Player:  

Fi le menu  

Edit  menu  

View menu 

Options menu  

Help menu  

Installing UNIX Players 
For in formation about instal l ing UNIX Players, please refer to the QACenter Performance Edit ion 
Instal lat ion and Configurat ion Guide.  

You can access th is guide by cl icking 
Start>Program s>Com puw are>QALoad>Docum en tat ion>Instal l at i on  and Con f igurat ion  Guide. 

 

Tuning QALoad Player for use with Oracle 
Oracle version 7 SQL*NET puts significant demands on the system running QALoad Player by demanding 
at least 1MB of physical memory and approximately 3MB of virtual memory per simulated user. 
Compuware recommends you fol low these guidel ines when using Oracle to opt imize QALoad Player 
performance: 

!  Set the Execut ing Threads Startup Interval parameter on the Player Configurat ion dialog box ’s 
Startup Parameters tab to between 2,000 and 4,000 mil l iseconds. 
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!  Unless your appl icat ion cont inual ly logs in  and out of Oracle, move the logon commands 
(DO_olog and i ts associated DO_ologof) outside the Begin_Transact ion/End_Transact ion loop, 
where the Oracnvrt  program places them by default . 

 

Dialog Box and Field Descript ion 

QALoad Player Main Window 

The QALoad Player Main Window is divided into two parts: 

!  The top port ion contains fields, buttons, and opt ions that help you configure the Player for script  
val idat ion. When an actual load test is in  progress, th is area displays the fol lowing in formation: 

 Version : The version of the QALoad Player. 

 Player Nam e: The network name assigned to the Player workstat ion. 

 Player Address: The network address of the Player workstat ion. 

 Player Port : The port  number on th is Player workstat ion being monitored by the QALoad 
Conductor. 

 Player i s runn ing… the type of virtual users th is Player is running. 

 The number of virtual users and transact ions th is Player is running. 

!  The bottom port ion of the Player M ain Window displays Player messages whi le a script  is running.  

This sect ion describes the configurat ion opt ions on the top port ion of the Main Window. 

Fields and Buttons 

Com pi led Script  

Navigate to the compiled script  (.dl l ) to val idate. 

Users 

Type the number of users to emulate when val idat ing the selected script . Compuware recommends one 
user for script  val idat ion. 

Transact ions 

Type the number of t ransact ions to run when val idat ing the selected script . Compuware recommends one 
transact ion for script  val idat ion. 

Start  

Click the Start  button to begin script  val idat ion. Player messages wil l  display below. 

Abort  

Click the Abort button to stop al l  virtual users immediately. 

Ex i t  

Click the Exit  button to exit  the load test graceful ly, when each virtual user is fin ished. 

Debug Data 
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Select th is check box to have the Player display a debug message indicat ing which command the script  is 
execut ing and to generate WWW replay log fi les. 

RR__Fai ledM sg 

Select th is check box to view, in  the Player window, the point where a middleware command with in your 
script  fai ls. 

Check  Poin ts 

Select th is check box i f you want to display the Check Point command response t imes in the Player 
window.  

Auto Clear 

Select th is check box to automatical ly clear any messages from the bottom port ion of the window before 
running a new script . 

Abort  on  Error 

Select th is check box to abort  script  execut ion when an error is encountered. 

Create Tim ing Fi l e 

Select th is check box to create and save a Player t im ing fi le for th is Player to the default  QALoad t im ing fi le 
directory (normally \Program Files\Compuware\QALoad\TimingFiles). 

Run As 

Select i f th is Player should run scripts as thread- or process-based. 

 

Save As 

Use th is dialog box to save a text fi le of the messages reported by Player during a test, or to save an exist ing 
buffer with a different name. 

Access th is dialog box from the Fi le menu by selecting Save Buf fer  or Save Buf fer As. 

 

Player configurat ion 

Use th is dialog box to set startup parameters for Player. The default  startup parameters are saved in the 
player sect ion of the QALOAD.INI fi le. 

Access th is dialog box from the Opt ions menu by select ing Player Con f igurat ion . 

Runt im e tab 

Player Nam e: This is the name that the Player wi l l  report  to the QALoad Conductor during a request. It  
may be any string of alphanumeric characters, provided that the length does not exceed 10 characters and 
there are no embedded spaces. 

Com pi led Scripts: This field points to the directory which wil l  hold the compiled scripts. When a test is 
started, Player looks for scripts in  th is directory. The configurat ion screen wil l  veri fy that the directory 
exists. 
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Compuware recommends that you use a directory on a networked drive to hold the compiled scripts. 
Otherwise you wil l  need to manually copy the script  fi les to each Player system whenever a script  changes. 

Local  Datapool : This field points to the directory which wil l  hold the local datapool fi le referenced by th is 
Player workstat ion.  

Tim ing Fi l e: This field points to the default  directory where the t im ing fi les are located. 

Java tab 

jvm .dl l  di rectory : (opt ional) This is the directory where the JVM.DLL fi le is located. If specified, th is 
JVM.DLL wil l  be used to run the Java scripts from a standalone Player; otherwise, the entry specified in  the 
Compiler Sett ings tab of the Configure QALoad Script Development Workbench dialog box wil l  be used. 

 

How to ... 

Installing UNIX Players 

For in formation about instal l ing UNIX Players, please refer to the QACenter Performance Edit ion 
Instal lat ion and Configurat ion Guide.  

You can access th is guide by cl icking 
Start>Program s>Com puw are>QALoad>Docum en tat ion>Instal l at i on  and Con f igurat ion  Guide. 

 

Transferring scripts to a UNIX Player 

Normally, the appropriate script  is automatically uploaded from the QALoad Conductor to the Players and 
compiled at runt ime. However, i f i t  is ever necessary to manually transfer a script , use the procedure that 
fol lows. 

Note: The machine where the QALoad Script Development Workbench is installed must have Winsock-
based TCP/IP to transfer a script to the UNIX machine where you wish to run it. 

To t ransf er  a scr ip t : 

The fol lowing procedure describes how to transfer a script  fi le from the Windows workstat ion where the 
QALoad Script Development Workbench resides to the system running the QALoad Player. 

1. Access the Script Development Workbench. 

2. From the Session menu, choose the middleware session you want to start. 

3. In the Workspace Pane, click the Scripts tab. 

4. On the Scripts tab, select the script you want to transfer. 

5. From the Tools menu, choose FTP to open the FTP Transfer dialog box. Note that the file name you selected to 
transfer appears in the File to Transfer field. 

6. Enter the Host Name, User Name, Password, and Destination Directory. 

7. Click Transfer to send the file to the system where your QALoad Player is installed. 

8. If you want to save the information you have entered for subsequent transfers, click Save Settings. 

9. Click Close/Abort to exit the FTP Transfer dialog box.  
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Validate a script  

To val idat e a scr ip t , f ol low  t hese st eps: 

1. In  the Com pi led Script  field, browse for the compiled script  DLL you want to val idate. Compiled 
scripts are usual ly located in  the directory \Program Files\Compuware\QALoad\Scripts. 

2. Type a value in  the Num ber of  Users field. Compuware recommends one user for script  val idat ion. 

3. Type a value in  the Transact ions field. Compuware recommends one transact ion for script  
val idat ion. 

4. Select any appropriate opt ions to the right of the Compiled Script field. These opt ions determine 
the type and amount of data that wi l l  display in  the Player Main Window. For descript ions of each 
opt ions, see the topic QALoad Player Main Window . 

5. In  the Run As area, select whether the transact ion should run as th read- or process-based . 

6. Click Start  to run the script . The Player M ain Window wil l  show the script 's progress. If the script  
runs successful ly, i t  is val id to use in  a load test. 
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Scr ip t  Developm en t  Wor k bench  

Overview of the Script  Development  Workbench 
The QALoad Script Development Workbench is the QALoad component used to develop load test scripts. It  
contains the faci l i t ies you need for recording transact ions such as funct ion cal ls or request / response 
interact ions placed by your Windows appl icat ion. The recorded transact ion, cal led a capture fi le, contains 
raw data that must be converted to an editable test script  based on C, C++, or Java, depending upon which 
middleware environment is under test.  

After convert ing the recorded transact ion to a script , you can use the Script Development Workbench's 
script  editor and other funct ional i ty to make any necessary modificat ions to your script . For example, 
maybe you had to sign on to a Web server with a user name and password as part  of your recorded 
transact ion. At test t ime, when mult iple virtual users are running your test script , you might want each 
user to have a different user name/password combinat ion. You can use the Script Development Workbench 
to create a re-usable pool of user name/password combinat ions, saved as a datapool fi le, and edit  your 
script  to extract values from that fi le at test t ime. QALoad provides script ing commands for si tuat ions l ike 
that, and provides a Funct ion Wizard and onl ine language reference, both avai lable right from the editor, 
to help you locate and insert  the right commands.  

When you are sat isfied wi th your test script , you can compile i t  direct ly from the Script Development 
Workbench. And, final ly, add i t  to a load test in  the QALoad Conductor. 

In  shor t , t o p roduce a usable t est  scr ip t  you: 

1. Record a transaction into a capture file (.cap). 

2. Convert the capture file to an editable script. 

3. Edit the script. 

4. Compile the script. 

 

Set t ing a default  middleware session 

To set  a par t icular  m iddlew are as t he def aul t  f or  new  sessions: 

1. Access the QALoad Script Development Workbench. 

2. From the Session menu, choose the name of the middleware session you want to open. The Default Session 
Prompt opens. The Default Session Prompt didn't open? 

3. Select the Make this my default Session check box . 

4. Click OK.  
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Configuring the Script  Development  Workbench 
The first  t ime you use the QALoad Script Development Workbench, you should set opt ions to determine a 
working directory QALoad can use for temporary fi les, compiler sett ings, and other general opt ions related 
to the behavior of the QALoad Script Development Workbench. 

To set  a w ork ing d i r ect ory: 

1. Access the Script Development Workbench. 

2. From the Session menu, choose the session you want to start. 

3. From the Options menu, choose Workbench. 

4. Set any appropriate options. For a description of the available options, press F1 from the Configure Script 
Development Workbench dialog box. 

Note: Compuware recommends that you always select the Automat ically Compile Scripts and 
Automat ically Convert  Capture options. 

5. Click OK to save your settings.  

 

Developing, Convert ing, and Compiling a Test  Script   
When you are sat isfied wi th your test script , you can compile i t  direct ly from the Script Development 
Workbench. and add i t  to a load test in  the QALoad Conductor. 

To access t he Scr ip t  Developm ent  W orkbench and develop  a t est  scr ip t :  

1. Click Start>Programs\Compuware\QALoad\Script Development Workbench.  

2. From the Session menu, select the appropriate middleware.  

3. Choose the middleware name from the Session  menu or by cl icking the appropriate button on the toolbar. 
The Defaul t  Session  Prom pt  opens.  

4. Click OK. 

Note: If this middleware type should be the default every time you open the Script Development 
Workbench, select the check box Make this my default  session. If you do not want to be prompted to set a 
default middleware, clear the Enable default  session checking check box. You can also turn default session 
checking on or off from the Configure Script Development Workbench dialog box at any time. 

 

 To set  up  aut om at ic conversion and com pi lat ion: 

1. From the Script Development Workbench menu, choose Options>Workbench. 

2. On the Configure Script Development Workbench dialog box, in the Record Options area, select the check box 
Automatically Convert Capture. 

3. Click the Compiler Settings tab. 

4. Select the check box Automatically compile scripts. 

5. Select the check box Prompt before overwriting script to ensure that a script isn't overwritten accidentally.  

6. Click OK to save your settings. 
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The Script Development Workbench automatical ly converts a capture fi le when you stop the recording 
process and compile the result ing script . You are prompted i f a script  by the same name already exists, so 
that you can decide whether to overwrite an exist ing script  or to save your script  under a different name. 

Sessions 

EasyScript  Sessions 

When you first  open the Script Development Workbench, you can set general opt ions related to which 
panes to display, your compiler, and so on, but you can't  begin any middleware-specific act ivi t ies, such as 
recording a transact ion, unt i l  you open an EasyScript Session. Opening an EasyScript Session tai lors the 
Script Development Workbench to a specific middleware environment, providing you with al l  the 
appropriate opt ions and funct ions for your script ing needs. 

To open an EasyScript Session, choose your middleware type from the Session menu, or cl ick the 
appropriate toolbar button. Once a session is open, the Workbench interface wil l  change. 

You can also open a Universal session to record cal ls from mult iple middlewares with in a single session. 

 

Using the Universal session 

The Universal session al lows you to record cal ls from mult iple middleware appl icat ions with in a single 
Script  Development Workbench session. You might use the Universal session in  cases where your 
appl icat ion accesses an addit ional appl icat ion that uses a different protocol. 

For example, your browser might download and open a Java applet which then communicates with a 
Winsock server. If you recorded that act ivi ty using a simple WWW session, the Script Development 
Workbench would only record the HTTP requests that downloaded and opened the Java applet. Recording 
that transact ion with the Universal session ensures that you record the HTTP requests from the browser as 
well  as the Winsock-based communicat ion between the Java applet and the Winsock server — al l  with in a 
single script . 

You start  and record from a Universal session exact ly l ike a single middleware session with one difference 
— after start ing a Universal session you must select which middleware appl icat ions to record.  

 

The Script  Development  Workbench main window 

The QALoad Script Development Workbench main window is divided into dynamic panes that you can 
h ide or show as needed by select ing commands from the View menu.  

Hint : Click on a pane in the following graphic for a description of that pane. Use your scroll bars to see the 
rest of the graphic. 
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Menus and toolbar but tons 

The QALoad Script Development Workbench menus and buttons change depending on whether you have 
an EasyScript Session open.  

Menus and toolbars without an open EasyScript session 

The fol lowing menus and toolbars are avai lable when an EasyScript Session is not open. 

Fi le 
View 
Options 
Session 
Tools 
Help  
Toolbar Buttons 

  

Menus and toolbars with an open EasyScript session 

The fol lowing menus and toolbars are avai lable when an EasyScript Session is open. 

Fi le 
Edit  
View 
Options 
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Session 
Tools 
Window 
Help 
Toolbar Buttons  
Recording toolbar 

 

Recording toolbar 

The Recording toolbar is a float ing toolbar that is launched automatical ly when you start  recording a 
transact ion.  

Cl ick each button on the fol lowing toolbar image for a descript ion of i ts funct ional i ty. 

 

 

Developing a Test  Script  

Recording a Transact ion 

Recording middleware calls 

QALoad begins recording before start ing your appl icat ion, ensuring that any early startup act ivi ty is 
recorded. 

Hint : You can save yourself some steps later by setting options now to automatically convert your 
recorded capture file and compile it into a script. 

To record a m iddlew are cal l : 

1. Open an appropriate middleware session in the QALoad Script Development Workbench. 

2. (Oracle Forms Server only) Choose Options>Workbench, then click the Compiler Settings tab. In the Java 
section of the dialog box, set the location of your Java files for recording. 

3. Select Session>Record>Start. QALoad launches your application and any proxies, if necessary, and begins 
recording any calls. 

4. Run the desired user operations using your application. 

5. (WWW only) If you are capturing SSL requests using EasyScript for Secure WWW, the browser generates one or 
more prompts indicating the following: 

!  It does not recognize the authority who signed the server certificate. 

!  The server certificate presented by the Web site does not contain the correct site name. 

When you receive these prompts, click the browser’s Next or Continue button so you can connect to and exchange 
information with the desired Web site. 

 

6. (Optional) At any time during the recording process, you can insert any necessary commands or comments into the 
capture file. 
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7. (Optional) At any time during the recording process, you can insert any necessary commands or comments into the 
capture file. 

8. When you have recorded a complete transaction, stop the application from which you are recording. 

9. When you finish, click Stop Record. You are prompted to save your capture file. By default, capture files (.cap) are 
saved in the QALoad\Middlewares\<middleware_name>\captures directory. 

 

Note: If QALoad is not able to record from your application, try QALoad’s alternate procedure for 
recording.  

 

Inserting commands/comments into a capture file 

You can insert  commands or comments while recording a capture fi le. 

To inser t  com m ands/ com m ent s in t o a capt ure f i le: 

1. On the Recording toolbar, click Insert Command. The toolbar expands into a window where you can select options 
for inserting commands into your capture file. 

2. In the Command Type area, select whether you want to insert a comment or a begin/end checkpoint. 

3. In the Command Info area, type your comment or a description of the checkpoint. 

4. Do one of the following: 

 Click Insert  to insert  your comment or checkpoint command into your capture fi le. 

 Click  Insert  Com m and  again to close the expanded window without insert ing a 
command. 

5. Continue recording your transaction as usual. 

 

Convert ing a Transact ion to a Script  

Converting 

A capture fi le contains al l  the raw data that was recorded, but i t  needs to be converted in to an editable 
script  fi le before you can proceed. The script  fi le can then be open in the Script Development Workbench 
editor and edited as needed. 

To conver t  a capt ure f i le t o a scr ipt : 

1. Access the QALoad Script Development Workbench. Details. 

2. From the Session menu, choose the session you want to start. 

3. If you have not already done so, set conversion options. 

4. In the Workspace Pane, click the Captures tab. 

5. Click the capture file you want to convert and click Options>Convert. The capture file is converted to a script. In the 
Workspace Pane, click the Scripts tab to view the list of scripts you have converted. 

Note: If an Error/Warning Summary opens in the Output  Pane, resolve any errors. 

6. Compile the script.  
Note: You can set an option to automatically convert your recorded transactions into scripts. How? 
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Compiling a test script 

A QALoad script  is a real C-, C++-, or Java-based script , and therefore needs to be compiled before i t  can be 
used. QALoad works with your exist ing compiler to compile usable test scripts. If you make changes to an 
exist ing script , you must re-compile i t  before you can successful ly use i t  in  a test. If you add an uncompiled 
or out-of-date script  to a load test, the QALoad Conductor wi l l  prompt you to compile the script . 

Customizing a Script  

Using the Function Wizard 

The Funct ion Wizard al lows you to quickly and easi ly edit  your script  by choosing from the QALoad 
commands avai lable to your script  and insert ing them with a cl ick of your 
mouse.  

The Funct ion Wizard is located in  the Script Development Workbench in a 
pane on the right side of the window. You can enable or disable the 
Funct ion Wizard from the View  menu or by cl icking the Show  or Hide 
Funct ion  Wizard  button on the toolbar.  

The Funct ion Wizard l ists al l  funct ions that are val id to use in  your open 
script . Funct ions are grouped in logical sect ions with in the top window of 
the wizard. When you h ighl ight a funct ion in  the top window of the 
wizard, the lower window wil l  l ist  a descript ion of that funct ion and i ts 
parameters.  

To insert  a funct ion in to your script , locate i t  in  the Funct ion Wizard and 
then simply drag-and-drop i t  in to your script .  

The funct ion wil l  be writ ten in to your script  at  the point you chose. When 
you insert  a funct ion using the wizard, a text box opens showing the 
proper syntax and parameter opt ions. (The text box may not appear i f an 
associated variable or object has not been declared in  the script .) As you 
edit  the funct ion 's parameters, the text box h ighl ights the parameter that 
is current ly being edited.  

Note for ADO scripts: After inserting an ADO method, change the # sign 
to the appropriate object number. 

 

 

Using custom counters and messages 

QALoad al lows you to define your own counters and insert  messages into 
your script , where they are writ ten to your t im ing fi le and are viewable in  Analyze or at runt ime in the 
Conductor.  

Counters can be either cumulative or instance. This determines how they are graphed in Analyze: 

!  For a cumulative counter, Analyze keeps a running sum of the counter while graphing verses elapsed time. This type 
of counter is used for all the WWW error counters. Each time a WWW error occurs, a value of 1 is written for that 
counter. When looking at a detailed view in Analyze, you can see at what times that error occurred. When you graph 
a counter in Analyze, the graph will show the total number of occurrences verses the elapsed time.  

!  For an instance counter, Analyze graphs each value directly. No summing of previous values is done.  

Counters must be added manually using the QALoad commands DEFINE_COUNTER and 
COUNTER_VALUE. Messages must be added manually using the QALoad command SCRIPT_MESSAGE. 

The fol lowing sample script  i l lustrates both script  counters and messages: 
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#include <stdio.h> 
#include "smacro.h" 
#include "do_www.h" 

int rhobot_script( PLAYER_INFO *s_info ) 
{ 
char  buf1[256]; 
int   id1, id2, id3, id4; 

DEFINE_TRANS_TYPE( "ScriptCounters " );  
DO_InitHttp(s_info); 

// "Counter Group", "Counter Name", "Counter Units (Optional)",  
// Data Type, Counter Type. 

id1 = DEFINE_COUNTER( "Cumulative Group", "Cumulative long",  
                      0, DATA_LONG, COUNTER_CUMULATIVE); 
id2 = DEFINE_COUNTER( "Cumulative Group", "Cumulative float",  
                      0, DATA_FLOAT, COUNTER_CUMULATIVE); 
id3 = DEFINE_COUNTER( "Instance Group", "Instance long",  
                      0, DATA_LONG, COUNTER_INSTANCE); 
id4 = DEFINE_COUNTER( "Instance Group", "Instance float",  
                      0, DATA_FLOAT, COUNTER_INSTANCE); 

SYNCHRONIZE(); 
BEGIN_TRANSACTION(); 

// add value to cumulative counter 1 
COUNTER_VALUE( id1, 1 ); 
DO_SLEEP( 2 ); 

// add value to cumulative counter 2 
COUNTER_VALUE( id2, 1.5 ); 
RND_DELAY( 6 ); 

// add value to instance counter 1 
COUNTER_VALUE( id3, s_info->nRndDelay ); 

// add custom message for this user 
wsprintf( buf1, "User %d slept for %d milliseconds during transaction %d", 
          s_info->nAbsVUNum, s_info->nRndDelay, s_info->s_trans_count ); 
SCRIPT_MESSAGE( "User Messages", buf1 ); 
DO_SLEEP( 2 ); 

// add value to instance counter 2 
// relative user number plus pi times the current transaction number 
COUNTER_VALUE( id4, s_info->nRelVUNum + ( 3.14159 * s_info->s_trans_count ) ); 

END_TRANSACTION(); 
DO_FreeHttp(); 
REPORT(SUCCESS); 
EXIT(); 

} 

 

Defining checkpoints 

Checkpoint statements col lect t im ings of events, such as the execut ion of SQL statements. If you manually 
insert  checkpoint statements in to your capture fi le during the recording process, or i f you select the 
Include Defaul t  Checkpoin t  Statem en ts conversion opt ion before convert ing a script , your script  
includes checkpoints.  

Otherwise, you must manually insert  checkpoints in  your scripts to col lect t im ings. 
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Defining transaction loops 

If you did not insert  begin-and end-transact ion commands into your capture f i le, QALoad’s Convert  faci l i ty 
automatical ly places begin-and end-transact ion commands at the start  and end of the recorded sequence. 
QALoad scripts execute the code between the begin-and end-transact ion commands in a loop according to 
the number of t imes you specify in  the QALoad Conductor when sett ing up a test. 

Depending on how you completed your recording, you may want to move one or both of these transact ion 
commands to another place in  the script  to more accurately define the transact ion that runs during the 
load test. 

For example, let ’s say during the recording process you log in  and log out as part  of the procedure. 
However, during the load test you do not want to log in  and log out as part  of every transact ion. To avoid a 
login and logout with every procedure, move the begin- and end-transact ion commands so the login and 
logout commands are outside of the transact ion loop. 

 

Simulating user-entered data 

When you create a script , you probably have some constant data embedded in  the script , for example, an 
employee number,  that automatical ly enters your appl icat ion ’s input fields while recording. If you run a 
load test using th is script , the script  uses the same data for each transact ion. To run a real ist ic test, you can 
modify the script  to use variable data from a datapool fi le. By varying the data input over the course of a 
test, the behavior more real ist ical ly emulates the behavior of mult iple users. You can use the QALoad Script 
Development Workbench to create, maintain, and use datapool fi les (.dat) to insert  variable data in to your 
scripts. 

A datapool can be defined as either central or local: 

!  A central datapool is a datapool that resides on the same workstation as the QALoad Conductor, and is available to 
any Player system on the network that requests it from the QALoad Conductor. A central datapool is controlled by 
the QALoad Conductor, and you use the QALoad Conductor to set any options relating to a central datapool. 

!  A local datapool is a datapool that resides on a Player workstation, and is only available to that Player. Because a 
local datapool resides locally and is only available to the local Player, it does not generate any network traffic. You 
use the QALoad Script Development Workbench to insert local datapools into a script. 

The fol lowing sect ions describe how to create and use central and local datapools. 

Creat ing a datapool  f i l e 

You can create a datapool fi le using the Script Development Workbench. 

To creat e a dat apool  f i le: 

1. Open a middleware session in the QALoad Script Development Workbench. 

2. From the File menu, choose New. 

3. On the New dialog box that opens, select New from the Datapools tree item. 

4. In the Filename field, type a unique name for your datapool file. 

5. In the Rows: and Cols: fields, type the number of rows and columns your new datapool should have. 

6. Click OK. 

7. Enter your datapool records in the grid that opens in the Workbook Pane. 

8. When you are finished entering datapool records, click File>Save As to name your datapool file. 

9. Click OK to save the file. QALoad saves the file in your \QALoad\Datapools directory. 
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M odi fying a datapool  f i l e 

You can modify a datapool fi le using the Script Development Workbench. 

To m odi f y a dat apool  f i le: 

1. In the Workspace Pane, click the Datapools tab. 

2. Double-click the datapool file you want to modify. The datapool file opens in the Workbook pane. 

3. Make the appropriate changes and save the file. 

 

Using a cen t ral  datapool  f i l e i n  a script  

You assign a central datapool fi le to a specific script  by select ing the datapool fi le and sett ing any 
appropriate opt ions using the Conductor. Each script  can use a single central  datapool. The central 
datapool is avai lable to al l  Player workstat ions running the test. The fol lowing procedures describe how to 
assign and extract data from a central datapool. These procedures assume you have already created the 
datapool fi le as described above. 

Assigning a central datapool fi le 

1. With a session ID file open in the QALoad Conductor, click the Script Assignment tab. 

2. In the External Data column for the selected script, click the Browse button. 

3. In the External Data dialog box, navigate to the datapool you wish to use. Select it and click Open. 

4. If you wish to re-use the datapool records when the script reaches the end of the file, select Rewind. To only use 
each record once, and then discard it, select Strip. 

5. When you are done, click OK. 

Using data records from a central datapool fi le 

To use data from a central  datapool in  your load test, you wil l  have to modify your script . Typical ly, you 
wil l  read one record per transact ion.  

To add dat apool  st at em ent s t o your  scr ip t : 

1. With your script open in the QALoad Script Development Workbench, navigate to the place where you want to insert 
a datapool variable and highlight the text to replace. 

2. From the Session menu, choose Insert>Datapool. The Insert New Datapool dialog box appears. 

3. Select a datapool from the list and click OK, or click the Add button to open the Select Datapool dialog box where 
you can choose a datapool file to add to your test. 

4. When you are finished, the QALoad Script Development Workbench places several datapool functions into your 
script, denoting them with markers so you can easily identify them. 

  

Using local  datapool  f i l es i n  a script  

You assign a local datapool fi le to a specific script  by select ing the datapool fi le and sett ing any appropriate 
opt ions using the QALoad Script Development Workbench. Each script  can use up to 64 local datapools. 
Use the fol lowing procedures to assign and extract data from a local datapool  fi le. These procedures assume 
you have created a datapool as described above. 

Assigning a Local Datapool 
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1. Open a session in the QALoad Script Development Workbench. 

2. In the Workspace pane, click the Scripts tab. 

3. On the Scripts tab, double-click on the appropriate script name to open it in the Workbook pane. 

4. From the Session menu, choose Insert>Datapool. The Insert Datapool Commands dialog box appears. 

5. On the Insert Datapool Commands dialog box, click the Add button. The Select Datapool dialog box opens. 

6. In the Type field, select Local. Note that you can also choose to insert a central datapool from this dialog box. If you 
choose to insert a central datapool from here, the QALoad Script Development Workbench places the Conductor 
command GET_DATA into the script just after the BEGIN_TRANSACTION command, bookmarks the command in the 
margin of the script, and uses any options set for the specified datapool in the QALoad Conductor. 

7. In the ID field, give the datapool a unique identifier. The name can contain alphanumeric characters only. Use 
underscores ( _ ) for spaces. This ID will help you identify the datapool in your script, for example 
“ACCOUNT_NUMS”. 

8. In the Filename field, type (or browse for) the fully qualified path of your datapool file. For example: c:\Program 
Files\Compuware\QALoad\Workbench\<middleware_name>\Scripts\datapool.dat 

9. If you wish to re-use the datapool records when the script reaches the end of the file, select Rewind at End of File. 
To only use each record once, and then discard it, clear this option. 

10. When you are finished, click OK. The selected datapool is displayed on the Insert New Datapool dialog box. 

11. Click OK. The QALoad Script Development Workbench will place a #define statement identifying the datapool file 
near the beginning of your script, and place the datapool commands OPEN_DATA_POOL, READ_DATA_RECORD, and 
CLOSE_DATA_POOL at the default locations in the script. These statements will be bookmarked in the margin for 
easy identification. 

12. When you are finished modifying the script, save any changes. 

For detai led in formation about any of these commands, refer to the Language Reference sect ion. 

Using Data Records from a Local Datapool Fi le 

To use data from a local datapool fi le you wil l  have to modify your script  to read data records and fields at 
the appropriate place in  the script . Datapool fi les should typical ly be opened with the statement 
OPEN_DATA_POOL just before the BEGIN_TRANSACTION statement, then datapool fields can be cal led in to 
the script  to replace variable strings. The OPEN_DATA_POOL statement is automatical ly inserted in to your 
script  when you use the QALoad Script Development Workbench to insert  your datapool. 

1. Read a record from the datapool file using the following command, which reads a single record from the local 
datapool file you specify: 
READ_DATA_RECORD(<LOCAL DATAPOOL ID>); 

2. To access the fields of this record, substitute GET_DATA_FIELD(ACCOUNT_NUMS, n) expressions in place of 
variable strings. 

3. After the END_TRANSACTION statement, close the local datapool file by using the following statement: 
CLOSE_DATA_POOL( LOCAL DATAPOOL ID ); 

Note that th is statement is added automatical ly i f you use the QALoad Script Development Workbench to 
insert  your datapool. 

For detai led in formation about any of these commands, refer to the Language Reference sect ion. 

 

Insert i ng Variable Data w i th  Act i veData Subst i tut i on  

The QALoad Script Development Workbench al lows you to transform string data from quoted constants or 
substrings into variables. Act iveData variable subst i tut ion lets you ident i fy and right-cl ick on a string to 
declare the selected string a variable with in the QALoad script . This faci l i ty also lets you select or edit  
datapool entries more dynamical ly, making script  development easier and more efficient.  
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To subst i t ut e a dat apool  value or  a var iable in  p lace of  a select ed st r ing in  your  scr ip t : 

1. Start the appropriate session in the QALoad Script Development Workbench. 

2. In the Workspace pane, click the Scripts tab. 

3. On the Script tab, double-click the script you wish to open. The script opens in the Workbook pane. 

4. In the script, highlight the string you wish to replace. 

5. Right-click anywhere in the highlighted string. 

!  To substitute a value from a datapool: 

 — Cl ick Act i veData>Datapool  Subst i tut i on  in  the shortcut menu that opens. The 
Act i veData Datapool  Subst i tut i on  dialog box opens. 

 In  the Datapool (s) area, h ighl ight the datapool to use. The contents of the datapool fi le 
display below. If the datapool you want to use is not l isted, cl ick the Add  button to add 
i t  to the l ist  of avai lable datapools. 

 In  the Field: ID  field, type the field number of the specific value to use from the 
datapool. 

 When you are fin ished, cl ick OK. The QALoad Script Development Workbench wil l  
place a #define statement ident i fying the datapool  fi le at the beginning of your script . 
It  wi l l  also insert  the datapool commands OPEN_DATA_POOL, READ_DATA_RECORD, 
GET_DATA_FIELD and CLOSE_DATA_POOL at  the default  locat ions in  the script , and 
bookmark them in the margin for easy ident i ficat ion. Refer to the Language Reference 
sect ion for detai led in formation about any of those commands. 

!  To substitute a variable: 

 Click Act i veData>Variable Subst i tut i on  from the shortcut menu that appears. The 
Act i veData Variable Subst i tut i on  dialog box opens. 

 Assign a variable name for the selected string in  the Variable Nam e field. 

 Click OK. The QALoad Script Development Workbench wil l  declare the variable at the 
beginning of your script  and subst i tute the named variable for the selected string. It  wi l l  
also bookmark both locat ions for easy ident i ficat ion. 

6. When you are finished, save your script changes. Compuware recommends that you also compile your script to 
check for any errors. 

 

Middleware Scripting Techniques 

Ci t r i x  

Handling Citrix server farms 

Citrix servers can be grouped in farms. When load test ing, you may want to connect to a Citrix server farm 
rather than to a specific server. This type of setup load tests the server farm and Citrix load balancing 
rather than a single server, which provides a more real ist ic load test. 

To record a script  that connects to a farm, you must use an ICA fi le to connect. However, when a capture 
takes place, a specific server (in  the farm) must have a connect ion. Specify the correct ICA fi le to connect 
to the server farm as well  as a specific server with in that server farm. To veri fy that your script  is 
connect ing to a server farm and not a specific server, assign the server name to one blank space when 
val idat ing the script . For example: 

. 

. 

. 
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/* Declare Variables */ 
const char *CitrixServer   = " "; 
const char *CitrixUsername = "citrix"; 
const char *CitrixPassword = "~encr~657E06726F697206"; 
const char *CitrixDomain   = "qacitrix2"; 
const int CitrixOutputMode = OUTPUT_MODE_NORMAL; 

. 

. 

. 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("Orders.cpp"); 

CitrixInit(4); 

/* Citrix replay settings */ 

CtxSetConnectTimeout(90); 
CtxSetDisconnectTimeout(90); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetDomainLoginInfo(CitrixUsername, CitrixPassword, Citrix-Domain); 
CtxSetICAFile("PRD desktop.ica"); 
CtxSetEnableCounters(TRUE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 

SYNCHRONIZE(); 

 

Handl ing dynamic window t i t les 

Some appl icat ions create windows whose t i t les vary depending on the state of the window. For example, 
M icrosoft  Word creates a t i t le based on the default  document name at the t ime of the window creat ion. 
During replay, th is dynamic t i t le can differ from the window t i t le that was recorded, and the window is 
not recognized. If th is occurs, t ry the fol lowing steps to modify the script : 

1. Ensure that the Enable Wildcard Title Match check box is selected in the Citrix conversion options prior to 
converting the recording.  
In the Window Verification group of the Citrix Convert Options dialog box, ensure that the Enable Wildcard Title 
Match check box is selected. This check box is selected by default. If you are working with a previously-converted 
script, ensure that a CtxSetEnableWildcardMatching command exists in the script prior to the 
BEGIN_TRANSACTION command and that the parameter is set to TRUE. 

2. Verify whether there is an issue with dynamic window titles.  
When a script fails on validation because the run time window title is different than the expected window title from the 
recording, it is likely that you are dealing with a dynamic title issue that can be handled by this scripting technique. In 
this case, the script fails on the CtxWaitForWindowCreate call. 

3. Identify a match “pattern” for the dynamic window title.  
Note the error message that is returned during validation (or replay). The message indicates the expected window 
title versus the window title from script playback. Examine the differences in the window titles to create a “match 
pattern” that recognizes the window title, while ignoring other windows. A match pattern can be a simple substring of 
the window title or a pattern string using wildcard characters such as ? (to match any single character) or * (to match 
any number of characters). The examples below illustrate the different match patterns. 

4. Insert a CtxSetWindowMatchTitle command prior to the CtxWaitForWindowCreate call for the dynamic 
window.  
When adding the SetWindowMatchTitle command, ensure that the first parameter contains the correct window 
object and the second parameter contains the match string in double-quotes. 

5. Validate the script to ensure the CtxWaitForWindowCreate command recognizes the dynamic window name.  
Run the revised script through validation to ensure that the script succeeds. If the script does not validate 
successfully, go to step 3 to determine if the match pattern is correct. 
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Example 1: Using a substring match 

In  th is example, the M icrosoft  Word appl icat ion generates a dynamic t i t le when the script  is replayed. The 
dynamic name is a concatenat ion of the default  document that Word creates at appl icat ion startup with 
the name of the appl icat ion. The script  is altered to reflect the fact that the string “ Microsoft  Word”  is 
always part  of the window t i t le: 

// Window CWI_13 ("Microsoft Word") created 
CtxSetWindowMatchTitle( CWI_13, “Microsoft Word” ); 
CtxWaitForWindowCreate(CWI_13); 

Example 2: Using a wildcard match with the * character 

In  th is example, the SampleClientApp appl icat ion generates a dynamic t i t le when the script  is replayed. 
The dynamic name is the name of the appl icat ion fol lowed by the name of the user, beginning with the 
word “ User” . The asterisk (*) wi ldcard is subst i tuted for a given username, reflect ing the pattern of 
“ SampleClientApp – User:”  as part  of the window t i t le fol lowed by an arbitrary user name: 

// Window CWI_13 ("SampleClientApp – User: John") created 
CtxSetWindowMatchTitle(CWI_13,“SampleClientApp – User: *” ); 
CtxWaitForWindowCreate(CWI_13); 

Example 3: Using a wildcard match with the ? character 

In  th is example, the RandomValue appl icat ion generates a dynamic t i t le when the script  is replayed. The 
dynamic name is the appl icat ion fol lowed by a random single digit . The question mark character is 
subst i tuted for the single digit  to reflect the pattern  that begins “ RandomValue: ” , fol lowed by single digit : 

// Window CWI_13 ("RandomValue: 0") created 
CtxSetWindowMatchTitle( CWI_13, “Sample Application: ?” ); 
CtxWaitForWindowCreate(CWI_13); 

 

Handling dynamic windows 

During conversion, CtxWaitForWindowCreate cal ls are added to the script  for each named window 
creat ion event. During replay, some dynamic windows that were in  the capture may not appear, which 
causes the script  to fai l  because a wait  point t imes out. To avoid script  fai lure in  th is circumstance, 
comment out the CtxWaitForWindowCreate commands that may be referencing dynamic windows. 

Handling dynamic windows that require user in teract ion 

Some windows that require user act ion before normal script  processing can proceed may appear 
in termit tent ly during replay. One example commonly encountered with Citrix is the ICA Seamless Host 
Agent window. This window, i f i t  appears, requires user act ion or the script  may fai l .  

To w ork  around t h is issue, f ol low  t hese st eps: 

1. Capture a session in which the dynamic window appears and the user performs the action to dismiss the window. 
This may require multiple attempts to capture the window. Once this is captured in a recording, save the script as a 
temporary script. 

2. If the window did not appear in the primary script, extract the code snippet from the temporary script that acts on the 
dynamic window and insert it into the real script. The code usually consists of a CtxPoint command and a CtxClick 
command for this window. Insert the commands after the CtxWaitForWindowCreate command for the dynamic 
window. In addition, extract and insert the Citrix window information object constructor call and delete call to the 
relevant parts of the script, changing the object name to avoid conflicting with existing window objects. Ensure that 
the additional code is not inserted between a CtxPoint command and a CtxClick command in the primary script. 

3. Add a special CtxSetWindowMatchTitle command immediately before the CtxWaitForWindowCreate command. The 
first parameter of the CtxSetWindowMatchTitle command should be the correct window object. The second 
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parameter contains a special wildcard match “*” that enables the CtxClick command to accept any window title, 
which ensures that even if the matching window does not appear, the command still executes successfully. 

4. If the window appears in the primary script, comment out the CtxWaitForWindowCreate command for the dynamic 
window. Because the window itself may not appear, the CtxWaitForWindowCreate command should be commented 
out. 

5. Validate the script. If the validation is not successful, ensure that steps 2-4 were performed correctly. 

In  the fol lowing example’s scenario, the ICA Seamless Window Agent window does not appear in  the 
primary script , but appears in termit tent ly when the primary script  is replayed, causing those replay 
sessions to fai l . A second Citrix script , which includes the window appearance, is recorded and the 
CtxPoint and CtxClick commands are extracted from th is script  and inserted in to the primary script , with 
the window object changed to match the object in  the primary script . In  addi t ion, the Citrix window 
object constructor cal l  and delete cal l  are added in the appropriate places in  the script , and the CtxClick 
command is changed to refer to th is object. In  the fol lowing example, the text in  bold represents code that 
was manually inserted in to the locat ion in  the primary script  where the window appears in  the secondary 
script . 

CtxWI *CWI_99 = new CtxWI(0x10052, "ICA Seamless Host Agent", 0, 0, 391, 224); 
... 
CtxSetWindowMatchTitle( CWI_99, “*” ); 
CtxPoint(190, 203); 
CtxClick(CWI_99, 0, L_BUTTON, NONE); 
CtxPoint(300, 400); 
... 
delete CWI_99; // "ICA Seamless Host Agent" 

 

 

Handl ing unexpected events in  Citrix 

The CtxWindowEventExists and CtxScreenEventExists commands can be used to handle unexpected 
window and screen events in  Citrix scripts. When there is a possibi l i ty of unexpected dialogs appearing or 
unexpected screen events occurring, you must modi fy the script  to respond to the changes and cont inue 
the load test. 

For example, i f a script  opens a M icrosoft  Word document that resides on a network, and that document is 
already open by another network user, an unexpected dialog box appears that prompts the user to choose 
between cont inuing to open the document in  read-only mode or to cancel i t . To prevent script  fai lure, 
modificat ions can be made in the script  to handle the dialog boxes that appear in  th is si tuat ion.  

General ly, to handle unexpected events, you record two scripts. The first  script  contains a recording of the 
expected events. The second script  should include the unexpected events. Using the 
CtxWindowEventExists and CtxScreenEventExists funct ions, create a condit ional block of code that 
handles the dialogs that may appear. 

Example 

The fol lowing script  example shows the addit ional script  l ines that were added to handle a Word 
document that is already open by another user on a network. The added l ines appear in  boldface type. 

/* 
 *  capSave11111-2.cpp 
 * 
 *  Script Converted on June 21, 2004 at 01:04:17 PM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 50 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
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/* Converted using the following options: 
 * General: 
 *  Line Split                       : 132 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Window Verification             : Yes 
 *   Session Timeouts                : Yes 
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *   Include Wait Points             : Yes 
 *   Enable Counters                 : No 
 *   Include Unnamed Windows         : Yes 
 *   Output Mode                     : Normal 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 */ 
  
#define CITRIX_CLIENT_VERSION "8.00.60000" 
#define CITRIX_ICO_VERSION    "2.4" 
#define SCRIPT_VER 0x00000205UL 
  
#include <stdio.h> 
#include "smacro.h" 
  
#include "do_citrix.h" 
  
/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 
  
#ifndef NULL 
#define NULL  0 
#endif 
  
extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 
            /* Declare Variables */ 
            const char *CitrixServer      = "qaccitrix"; 
            const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL;             
  
            /* Citrix Window Information Objects */ 
            CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
            CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
            CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
            CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 
397, 127); 
            CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 
397, 127); 
            CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
            CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
            CtxWI *CWI_8 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
            CtxWI *CWI_9 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
            CtxWI *CWI_10 = new CtxWI(0x1008c, "", 115, 0, 405, 457); 
            CtxWI *CWI_11 = new CtxWI(0x1005a, "", 2, 49, 205, 408); 
            CtxWI *CWI_12 = new CtxWI(0x2006a, "", 200, 186, 156, 287); 
            CtxWI *CWI_13 = new CtxWI(0x10138, "", 112, 116, 416, 248); 
            CtxWI *CWI_14 = new CtxWI(0x50036, "Microsoft Word", -4, -4, 649, 461); 
            CtxWI *CWI_15 = new CtxWI(0x1017e, "Open", 19, 23, 602, 387); 
            CtxWI *CWI_16 = new CtxWI(0x20174, "*Microsoft Word", -4, -4, 649, 461); 
            CtxWI *CWI_17 = new CtxWI(0x10058, "", 113, 114, 305, 26); 
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            CtxWI *CWI_18 = new CtxWI(0x2013e, "Calculator", 66, 66, 261, 253); 
            CtxWI *CWI_19 = new CtxWI(0x1005a, "", 2, 49, 205, 408); 
            CtxWI *CWI_20 = new CtxWI(0x3006a, "Shut Down Windows", 111, 96, 418, 193); 
  
            CtxWI *CWI_117 = new CtxWI(0x20172, "File In Use", 144, 127, 352, 179); 
            CtxWI *CWI_118 = new CtxWI(0x30172, "11111111 (Read-Only) - Microsoft Word", -4, 
-4, 649, 461); 
             
            SET_ABORT_FUNCTION(abort_function); 
  
            DEFINE_TRANS_TYPE("capSave11111-2.cpp"); 
  
            CitrixInit(1); 
  
            /* Citrix replay settings */ 
            CtxSetConnectTimeout(60); 
            CtxSetDisconnectTimeout(60); 
            CtxSetWindowTimeout(30); 
            CtxSetPingTimeout(20); 
            CtxSetWaitPointTimeout(30); 
            CtxSetWindowVerification(TRUE); 
            CtxSetEnableCounters(FALSE); 
            CtxSetWindowRetries(5, 5000); 
            CtxSetEnableWildcardMatching(TRUE); 
             
            SYNCHRONIZE(); 
  
            BEGIN_TRANSACTION(); 
  
            DO_SetTransactionStart(); 
             
            CtxConnect(CitrixServer, CitrixOutputMode); 
             
            // Window CWI_1 ("Warning !!") created 1087837356.454 
             
            CtxWaitForWindowCreate(CWI_1, 2125);             
             
            DO_MSLEEP(1891); 
            CtxPoint(246, 267);  //1087837358.797             
             
            DO_MSLEEP(453); 
            CtxMouseDown(CWI_1, L_BUTTON, NONE, 246, 267);  // 1087837358.797 
             
            CtxMouseUp(CWI_1, L_BUTTON, NONE, 247, 267); //1087837359.032 
             
            . 
            . 
            . 
             
            DO_MSLEEP(63); 
            // Window CWI_14 ("Microsoft Word") created 1087837397.390 
             
            CtxWaitForWindowCreate(CWI_14, 141);             
             
            DO_MSLEEP(78); 
            CWI_14->setTitle("Document1 - Microsoft Word"); //1087837397.468 
             
            // Window CWI_13 ("") destroyed 1087837397.468             
             
            DO_MSLEEP(2468); 
            CtxPoint(37, 50);  //1087837400.218             
             
            DO_MSLEEP(282); 
            CtxClick(CWI_14, 203, L_BUTTON, NONE); //1087837400.421 
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            // Window CWI_15 ("Open") created 1087837400.764 
             
            CtxWaitForWindowCreate(CWI_15, 344); 
             
             
            DO_MSLEEP(1656); 
            CtxPoint(132, 99);  //1087837402.671             
             
            DO_MSLEEP(250); 
            CtxDoubleClick(CWI_15); // 1087837402.874             
             
            DO_MSLEEP(109);       
             
             
            DO_MSLEEP(1953); 
            CtxPoint(247, 197);  //1087837404.827 
             
            // Window CWI_15 ("Open") destroyed 1087837404.827 
  
  
            if(CtxWindowEventExists(EVT_STR_CTXWINDOWCREATE,3000,CWI_16)) 
            BeginBlock();    
                        CtxPoint(337, 265);  //1087837404.905 
             
                        // Window CWI_16 ("11111111 - Microsoft Word") created 
1087837404.905 
             
                        CtxWaitForWindowCreate(CWI_16, 31); 
             
                        // Window CWI_14 ("Document1 - Microsoft Word") destroyed 
1087837404.905  
             
                        DO_MSLEEP(7547); 
                        CtxPoint(628, 9);  //1087837414.592             
             
                        DO_MSLEEP(2141); 
                        CtxClick(CWI_16, 281, L_BUTTON, NONE); //1087837414.873             
             
                        DO_MSLEEP(234); 
                        // Window CWI_16 ("11111111 - Microsoft Word") destroyed 
1087837415.108 
             
                        CtxPoint(113, 93);  //1087837418.779 
             
                        // Window CWI_17 ("") created 1087837418.779 
            EndBlock() 
  
///ReadOnly Code Start 
  
            else 
            BeginBlock();    
             
                        // Window CWI_117 ("File In Use") created 1087840076.599 
             
                        CtxWaitForWindowCreate(CWI_117, 578); 
             
                        DO_MSLEEP(2360); 
                        CtxPoint(358, 283);  //1087840079.068 
             
             
                        DO_MSLEEP(125); 
                        CtxClick(CWI_117, 281, L_BUTTON, NONE); //1087840079.365 
             
             
                        DO_MSLEEP(109); 
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                        // Window CWI_117 ("File In Use") destroyed 1087840079.458 
             
                        // Window CWI_118 ("11111111 (Read-Only) - Microsoft Word") created 
1087840079.521 
             
                        CtxWaitForWindowCreate(CWI_118, 63); 
             
                        // Window CWI_115 ("Document1 - Microsoft Word") destroyed 
1087840079.521 
                         
                        DO_MSLEEP(4766); 
                        CtxPoint(631, 3);  //1087840084.490 
             
                        DO_MSLEEP(203); 
                        CtxClick(CWI_118, 250, L_BUTTON, NONE); //1087840084.740 
             
                        DO_MSLEEP(93); 
                        // Window CWI_118 ("11111111 (Read-Only) - Microsoft Word") 
destroyed 1087840084.833 
             
                        DO_MSLEEP(2407); 
                        CtxPoint(34, 465);  //1087840087.333 
  
            EndBlock(); 
  
///ReadOnly Code End  
  
  
            DO_MSLEEP(1063); 
             
            DO_MSLEEP(484); 
            CtxPoint(112, 93);  //1087837419.654             
             
            DO_MSLEEP(406); 
            CtxDoubleClick(CWI_9); // 1087837419.904             
            . 
            . 
            . 
 
            // Window CWI_9 ("Program Manager") destroyed 1087837440.122 
             
            // Window CWI_7 ("") destroyed 1087837440.138 
             
            DO_SetTransactionCleanup(); 
             
            CtxDisconnect(); 
             
             
            END_TRANSACTION(); 
  
            delete CWI_1; // "Warning !!" 
            delete CWI_2; // "Log On to Windows" 
            delete CWI_3; // "Please wait..." 
            delete CWI_4; // "Citrix License Warning Notice" 
            delete CWI_5; // "Citrix License Warning Notice" 
            delete CWI_6; // "UsrLogon.Cmd" 
            delete CWI_7; // "" 
            delete CWI_8; // "ICA Seamless Host Agent" 
            delete CWI_9; // "Program Manager" 
            delete CWI_10; // "" 
            delete CWI_11; // "" 
            delete CWI_12; // "" 
            delete CWI_13; // "" 
            delete CWI_14; // "Microsoft Word" 
            delete CWI_15; // "Open" 
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            delete CWI_16; // "11111111 - Microsoft Word" 
            delete CWI_17; // "" 
            delete CWI_18; // "Calculator" 
            delete CWI_19; // "" 
            delete CWI_20; // "Shut Down Windows" 
  
            delete CWI_117; // "File In Use" 
            delete CWI_118; // "11111111 (Read-Only) - Microsoft Word" 
             
            CitrixUninit(); 
             
            REPORT(SUCCESS); 
            EXIT(); 
            return(0); 
} 
  
void abort_function(PLAYER_INFO *s_info) 
{ 
            RR__printf("Virtual User ABORTED."); 
             
            CitrixUninit(); 
             
            EXIT(); 
} 

 

Moving the Citrix connect and disconnect outside the transact ion loop 

If your load test ing requirements for Citrix include creat ing extended logon sessions, in  which the user 
remains connected to the Citrix server between transact ions, review the fol lowing t ips for recording and 
script  development. 

Recording 

Perform the fol lowing steps during the recording process in  order to prepare for moving the connect and 
disconnect act ions outside the transact ion loop: 

1. Insert a comment such as “Logged in to Citrix” after the Citrix logon but before any windows have been opened. 

2. Ensure that all application windows are closed before disconnecting from the Citrix session. 

3. Insert a comment such as “Ready to log off Citrix” before the Citrix logoff sequence is initiated. Ensure that the first 
comment is added after the user has logged on and closed all login-related dialog boxes, but before any applications 
are started. Similarly, the second comment must be placed after all applications have been closed, but before the 
user logs off. 

Scripting 

Comment out the BEGIN_TRANSACTION and END_TRANSACTION cal ls and add new 
BEGIN_TRANSACTION and END_TRANSACTION cal ls at the locat ion where the comments from steps 1 
and 3 above were placed. Comment out the cal ls instead of delet ing them so that the original locat ion of 
these commands can be determined for debugging purposes.  

Also comment out the DO_SetTransact ionStart  and DO_SetTransact ionCleanup cal ls. 

 

Using the CtxWaitForScreenUpdate command 

In some situat ions, a window may vary in  how long i t  takes to refresh on the screen. For example, the 
Windows Start  menu is an unnamed window that can take varying amounts of t ime to appear, depending 
on system resource usage. To prevent playback problems in which a mouse cl ick does not synchronize with 
i ts in tended window, insert  the CtxWaitForScreenUpdate command in the script  after the act ion that 
causes the window to appear. The parameters for the CtxWaitForScreenUpdate command correspond to 
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the X and Y coordinates and the width and height of the window. This command ensures that the window 
has enough t ime to display before the mouse cl ick. 

 

OFS 

Understanding the C++ script  

Oracle Forms Server scripts are produced for Oracle Forms, 6.0, 6i, and 9i (Release 2 and later) recordings. 
The C++ script  executes OFS-related statements by passing the statements in  the script  DLL to the OFS Java 
engine that performs the cl ient act ivi t ies and the cl ient communicat ion with the server. Because the C++ 
script  statements are direct ly t ied to corresponding methods in the OFS Java engine, modificat ions to the 
script  statements are l im ited to changing the property parameter values through variabl izat ion. 

An OFS C++ script  contains three main sect ions: Connect ion, Appl icat ion Body, and Disconnect. The 
QALoad transact ion loop includes al l  three sect ions by default .  The transact ion loop can be moved using 
the guidel ines described in Moving the OFS transact ion loop.  An internal auto checkpoint is created 
during connect ion statements and transmission statements. 

The C++ script  statements are a condensed version of the Java-style script  statements.  The C++ script  
statements show the GUI controls in  the OFS appl icat ion and the control propert ies, which are either 
control at tributes or act ivi t ies. For example: 

ofsClickButton( "BUTTON", 52, OFS_ENDMSG, 325 ); 

In  th is example, the user cl icks (property 325) a button ( control ID 52).  OFS_ENDMSG is a flag that 
indicates that the GUI act ivi ty ends the current OFS Message.  

QALoad also al lows OFS and WWW statements from a Universal session to be scripted in  the C++ script , 
providing the abi l i ty to play back WWW and OFS statements. 

 

Connect ion statements 

The connect ion script  l ines in  the C++ script  vary depending on the type of Forms connect ion mode that is 
act ive. You choose the Forms connect ion mode on the Oracle Forms Server Recording Options dialog box. 
Forms connect ion modes include server-side recording, HTTP, HTTPS, or socket. 

Server-side recording is l im ited to appl icat ions that  use Forms 9i (appl icat ions running in Oracle 9iAS 
Release 2 and above). HTTP connect ion mode is avai lable for appl icat ions using Forms 9i and for 
appl icat ions using the patched Forms 6i version configured with the HTTP servlet. HTTPS connect ion 
mode is strict ly for SSL-enabled appl icat ions that use Forms 9i. Socket connect ion mode is for appl icat ions 
that use Forms 6i and lower versions, such as Oracle 11i. 

Server-side recording connections 

Server-side recording mode contains only one connect ion statement. The funct ion that is used – 
ofsSetServletMode –  contains the l istener servlet value that you entered on the Oracle Form s Server 
Recording Opt ions dialog box. The first  parameter defines the HTTP or HTTPS configurat ion of the 
appl icat ion environment. The second parameter defines the name of the Forms Listener Servlet used by the 
appl icat ion. To connect, QALoad internal ly invokes Oracle’s dispatch cal ls using the two parameters. 
Oracle’s proprietary classes provide the implementat ion for the HTTP or HTTPS connect ion.  For example: 

ofsSetServletMode(OFS_HTTP, "http://ntsap45b:7779/forms90/l90servlet" ); 

HTTP connections 

HTTP connect ion mode contains mult iple connect ion statements. To connect, QALoad internal ly performs 
Java cal ls to accomplish the fol lowing tasks:   

!  Define HTTP header properties 
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!  Connect to the Forms Servlet (an HTTP-GET request) 

!  Set the parameters of the Forms Listener Servlet 

!  Connect to the Forms Listener Servlet (an HTTP-GET request) 

!  Set additional HTTP header property for the Listener Servlet 

!  Connect to the Forms Listener Servlet (an HTTP-POST request). The last connection statement also initiates the 
required Forms “handshake” and determines the Forms encryption used by the application environment.  

For example: 

ofsHTTPSetHdrProperty("User-Agent", "Java1.3.1.9" );  
ofsHTTPSetHdrProperty("Host", "ntsap45b:7779" );  
ofsHTTPSetHdrProperty("Accept", "text/html, image/gif, image/jpeg, *; q=.2, "*/*; q=.2" 
);  
ofsHTTPSetHdrProperty("Connection", "Keep-alive" );  
ofsHTTPConnectToFormsServlet( 
"http://ntsap45b:7779/forms90/f90servlet?ifcmd=startsession"  ); 
ofsHTTPSetListenerServletParms( "?ifcmd=getinfo&ifhost=C104444D01&ifip= "192.168.234.1" 
); 
ofsHTTPConnectToListenerServlet( "http://ntsap45b:7779/forms90/l90servlet"); 
ofsHTTPSetHdrProperty("Content-type", "application/x-www-form-urlencoded" );  
ofsHTTPInitialFormsConnect(); 

HTTPS connections 

HTTPS connect ion mode uses the same connect ion statements as HTTP mode. To connect, QALoad 
internal ly performs the same tasks as the HTTP connect ion mode plus i t  performs the SSL connect ion 
when the ofsHTTPSDoSSLHandshake funct ion is cal led. This statement is posit ioned in the script  before 
the ofsHTTPConnectToFormsServlet funct ion. 

Socket connections 

Socket mode contains only one connect ion statement.  The funct ion that is used – ofsConnectToSocket  – 
contains the port  number and the URL you entered on the OFS Recording Options dialog box to start  OFS 
capture. The port  value is the port  on which the Forms Server direct ly l istens for Forms traffic. To connect, 
QALoad uses Java cal ls to open a Java socket using the parameters, in i t iate the required Forms "handshake” , 
and determine the Forms encrypt ion used by the appl icat ion environment. For example: 

ofsConnectToSocket("10.10.0.167", 9002 ); 

 

Applicat ion statements 

The appl icat ion statements in  the C++ script  consist of property statements and transmission statements. 
Property statements describe the attributes and act ivi t ies of GUI controls in  the appl icat ion. Transmission 
statements send the GUI controls and their propert ies as Forms Message data to the server. There is only 
one transmission statement: ofsSendRecv. QALoad creates an in ternal auto checkpoint when th is statement 
is executed. In  the fol lowing example, the first  two (property) statements set the locat ion and size of a 
FormWindow GUI control. The ofsSendRecv statement sends the GUI control  propert ies to the server. 

ofsSetWindowLocation( "FORMWINDOW", 6, OFS_ENDMSG, 135, 0, 0);   //Property  
ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 650, 500);   //Property 
ofsSendRecv(1 ); //Transmission 

Parameters of a property statement: 

The parameters of a property statement are arranged in the fol lowing sequence: 

1. Captured control name.  If the name is not available, this value is the class name to which the control belongs. 

2. Captured control ID. 
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3. Action type. This flag indicates if the property is to be added to the current Forms Message or if the property ends 
the current Forms Message. During playback, each control is treated as a Forms Message.  When the current 
Message ends, QALoad translates the control and its properties to binary format. The valid values are: 

 OFS_ADD –  add the property to the current Message. 

 OFS_ENDMSG – add the property to the current Message and end the Message. 

 OFS_STARTSUBMSG – add the property of the succeeding nested Message to the current 
Message. 

4. Property ID. The Forms version-specific ID of the property. 

5. Property value. Captured value of the property (optional) 

6. Property value. Captured value of the property (optional) 

For example: 

ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 650, 500); 

In  th is example, control ID 6, which belongs to GUI class FORMWINDOW, is resized (PROPERTY 
137) to have coordinates 650 and 500. This marks the end of the current Message. 

Forms environment statements: 

The in it ial  set of statements in  the Forms script  describes the Forms appl icat ion environment.  In  th is set, 
the "version ”  and the “ cmdline”  propert ies are the most important. The version property shows the Forms 
Bui lder version used by the appl icat ion. The version  indicates the capabi l i t ies of the appl icat ion. For 
example, some versions cannot support HTTP connect ions. The cmdline property shows the Forms 
configurat ion parameters passed to the server by the Forms applet. The parameter “ record=names”  
indicates that the appl icat ion enables GUI control names to be captured. Control names are preferred in  
mult i-threaded playback. The “ ICX”   parameter indicates that the appl icat ion  uses a Personal Home Page, 
which requires that you supply OracleAppsLogin in formation on the Oracle Forms Server Convert  opt ions 
dialog box for the script  to run successful ly. 

In  the sample script  below, the Forms bui lder version is 90290 (the version used in Oracle 9iAS Release 2, 
unpatched). The cmdline property shows “ record=forms”  which defaults “ record=names” . The cmdline 
property does not have the “ ICX”  t icket parameter. 

ofsSetInitialVersion( "RUNFORM", 1, OFS_ADD, 268, "90290" ); 
ofsSetScreenResolution( "RUNFORM", 1, OFS_ADD, 263, 96, 96); 
ofsSetDisplaySize( "RUNFORM", 1, OFS_ADD, 264, 1024, 768); 
ofsInitSessionCmdLine("RUNFORM", 1, OFS_ADD, 265,  
 "server module=test1.fmx userid=  sso_userid=  debug=no buffer_records=no debug_" 
 "messages=no array=no query_only=no quiet=yes render=no host=ntsap45b.prodti.com" 
 "puware.com port= record=forms tracegroup=debug log=run1 term=" ); 
ofsSetColorDepth( "RUNFORM", 1, OFS_ADD, 266, "256" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "0" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "8421504" ); 
ofsSetFontName( "RUNFORM", 1, OFS_ADD, 383, "Dialog" ); 
ofsSetFontSize( "RUNFORM", 1, OFS_ADD, 377, "900" ); 
ofsSetFontStyle( "RUNFORM", 1, OFS_ADD, 378, "0" ); 
ofsSetFontWeight( "RUNFORM", 1, OFS_ADD, 379, "0" ); 
ofsSetScaleInfo( "RUNFORM", 1, OFS_ADD, 267, 8, 20); 
ofsSetNoRequiredVAList( "RUNFORM", 1, OFS_ADD, 291 ); 
ofsSetPropertyString( "RUNFORM", 1, OFS_ENDMSG, 530, "America/New_York" ); 
ofsSendRecv(1 ); 
//ClientSeqNo=1|CapTime=1086884188.281|MsgCount=1 

Sending messages to the server: 

The ofsSendRecv statement sends the accumulated GUI controls and their propert ies to the Forms Server as 
binary data. This statement represents the point at which the cl ient sends a Forms Terminal Message to the 
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server. In  Oracle Forms, the cl ient and the server must end each data block with a Terminal Message before 
any transmission occurs. 

In ternal ly, QALoad varies the binary data transmission depending on the connect ion mode: 

!  For server-side recording mode, QALoad sends the binary data by invoking Oracle’s dispatch calls. Oracle’s own 
classes provide the implementation for the HTTP transmission.  

!  For HTTP or HTTPS mode, QALoad wraps the binary data inside an HTTP stream and invokes Java’s HTTP calls.  

!  For socket mode, QALoad sends the binary data directly to the Java socket opened at the connection point. 

The ofsSendRecv statement has one parameter: the response code of the captured Terminal Message. The 
possible values for th is parameter are 1 (add), 2 (update), and 3 (close). Typical ly, when the response code 
is 3, the Forms Server reacts by removing the GUI controls associated with the cl ient message from the 
server cache. 

A comment l ine appears after each ofsSendRecv statement that contains script-tracking in formation. The 
information on the comment l ine is also found in the capture fi le in  each ofsSendRecv capture l ine. The 
comment l ine shows the relat ive sequence of each cl ient request, as represented by a Terminal Message, 
from the start  of the appl icat ion (e.g. Cl ientSeqNo=1). The comment l ine also shows the t im ing mark of 
the captured Terminal Message (e.g. CapTime=1086884188.281) and the number of Forms messages 
contained in the request (e.g. MsgCount=1). The number of Messages can be veri fied by count ing the 
preceding ENDMSG and STARTSUBMSG flags in  the request block. The comment l ine is useful for 
debugging playback issues because i t  readi ly shows the cl ient request sequence number where the issue is 
occurring. 

Getting the server reply: 

During the execut ion of ofsSendRecv, QALoad also obtains the server’s reply and translates the binary 
Forms data in to Forms control values and control propert ies. The values are also writ ten to the playback 
log fi le (in  capture fi le format) i f script  logging is enabled. The fol lowing sample is a server reply: 

VU 0 :   M|S|2|0|1 
VU 0 :   P|S|322|java.lang.Integer|0|151000320 
VU 0 :   P|S|279|java.lang.Boolean|0|false 
VU 0 :   P|S|525|java.lang.String|AMERICAN_AMERICA.WE8MSWIN1252 
VU 0 :   T|S|1|ServerSeqNo=1|MsgCount=76 

The first  l ine indicates the start  of a Forms Message from the server (M |S). The th ird parameter is an act ion 
code (1= add, 2= update, 3= delete, 4= get property value). The fourth parameter is the Class Code of the 
control (0 = root class). The fi fth  parameter is the Control ID (1= RunForm). 

The second, th ird and fourth l ines are property l ines related to the above Forms Message from the server 
(P|S).  The th ird parameter of each l ine is the property ID (322). The fourth parameter is the data type of 
th is property (java.lang.In teger). The fi fth  parameter is the data value. If the value is 0, the data value is in  
a sixth parameter (false).  

The th ird l ine is the terminal message l ine from the server (T|S). The th ird parameter is the response code 
associated with the terminal message (1= add, 2= update,  = close). The fourth parameter is the relat ive 
sequence of the server reply, as represented by a Terminal Message, from the start  of the appl icat ion (e.g. 
ServerSeqNo= 1). The fi fth  parameter is the number of Forms messages contained in the reply (e.g. 
MsgCount = 1). The number of Messages may be veri fied by count ing the preceding M|S flags in  the reply 
block.  The fourth and fi fth  parameters are script-tracking in formation, which can be useful for debugging 
a playback issue. If logging is enabled, the log fi le shows the tracking in formation, which can make the 
comparison between server responses and captured responses easier. 

Processing large data and delayed response scenarios: 

When HTTP or HTTPS connect ion mode is used, Forms data is wrapped inside the HTTP reply stream. 
QALoad checks the HTTP header of the reply before processing the Forms data.  The HTTP header 
sometimes indicates that the cl ient needs to perform addit ional HTTP POST requests to obtain the 
complete Forms data. This indicat ion occurs when the content-length of the reply is 64000 (a large data 
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scenario), or the content-type is "text/plain ”  and the HTTP header contains an  “ i ferror: ”  string (a delayed 
response/re-post scenario). QALoad performs the necessary POST requests to obtain the complete reply 
data, and then translates the accumulated reply data to Forms controls and propert ies. 

 

Disconnect statements 

The disconnect script  l ines vary depending on the Forms connect ion mode.   

!  In server-side recording mode, the ofsServerSideDisconnect script statement internally invokes Oracle’s dispatch 
calls to disconnect.  

!  In HTTP mode, the ofsHTTPDisconnect statement internally makes Java calls to disconnect the main URL 
connection from the servlet.  

!  In socket mode, the ofsSocketDisconnect statement closes the socket on which the Forms Server listens for traffic. 

 

Using script  logging as a debugging tool 

You can debug a playback issue in a C++ script  by enabl ing replay logging. The opt ion for enabl ing replay 
logging is located on the Script Assignment tab of the Conductor. For more in formation about enabl ing log 
fi le generat ion, see Debugging a script .  

In  Java-based scripts, logging is not enabled by default . To enable logging, change the parameter of the 
Logging method to true in  the script . For example: 

oracleForms.Logging( true ); 

When logging is enabled, QALoad writes the cl ient requests and server repl ies to the playback log fi le in  the 
same format as the capture fi le. The playback log fi le is found in the \QALoad\LogFiles directory. When 
there is an issue during playback, such as the server not responding to a cl ient  request, you can compare 
the capture fi les and check the differences in  the server reply data. Both the capture fi le and the log fi le 
contain tracking in format ion appended to the server’s terminal messages. The tracking data contains the 
relat ive sequence number of the server reply from the start  of the Forms session and the t im ing mark. The 
tracking data also shows the number of Forms messages contained in the reply block. The number of 
messages are based on the number of  “ M|S”  l ines prior to the “ T|S”  l ines.  

In  the fol lowing example, the first  set of statements shows the logged statements and the second set of 
statements shows the captured statements. The ServerSeqNo value shows that th is is the 8th reply from the 
server. The MsgCount value of 1 shows that only one Forms Message is included in th is reply block. 

1087419810.000|ofsShowWindow|WINDOW_START_APP|11|OFS_ENDMSG|173|PROPERTY_VISIBLE|java.lang.B
oolean|true 
1087419810.000|ofsSendRecv|1|ClientSeqNo=8|CapTime=1087419810.000|MsgCount=1 
1087419810.000|M|S|2|0|30 
1087419810.000|P|S|135|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087419810.000|P|S|137|java.awt.Point|0|java.awt.Point[x=706,y=464] 
1087419810.000|P|S|139|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087419810.000T|S|1|ServerSeqNo=8|CapTime=1087419810.000|MsgCount=1 

   

1087402349.296|ofsShowWindow|WINDOW_START_APP|11|OFS_ENDMSG|173|PROPERTY_VISIBLE|java.lang.B
oolean|true 
1087402349.296|ofsSendRecv|1|ClientSeqNo=8|CapTime=1087402349.296|MsgCount=1 
1087402349.296|M|S|2|0|30 
1087402349.296|P|S|135|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087402349.296|P|S|137|java.awt.Point|0|java.awt.Point[x=706,y=464] 
1087402349.296|P|S|139|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087402349.296|T|S|1|ServerSeqNo=8|CapTime=1087402349.296|MsgCount=1 
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Moving the OFS transact ion loop 

To enable movement of the QALoad transact ion loop in the C++ script , you must fi rst  record a ful l  business 
transact ion and a part ial  business transact ion. The business transact ion is the act ivi ty that you would l ike 
to repeat during QALoad playback.  Insert  QALoad capture comments (using the Insert  Com m and  button 
on the Recording toolbar) at the start  and end of a business transact ion. These comments wi l l  help you 
find the spots in  the script  where you would l ike to reposit ion the BEGIN_TRANSACTION() and 
END_TRANSACTION() statements. Then re-start  the business transact ion.  

QALoad's OFS script  presents a sequence of Forms GUI objects. The GUI objects contain context 
dependencies. For example, when a window is opened, the buttons, text fields and edit  boxes inside that 
window are logical ly dependent on the state of that window. When only one business transact ion is 
captured and the corresponding script ’s transact ion loop is moved, the sequence of the GUI objects is 
broken during the second i terat ion of the transact ion loop. The broken sequence results in  a broken 
context, which causes the server to respond unpredictably during playback on the second and subsequent 
i terat ions of the transact ion loop. When the business transact ion is restarted during capture, the Forms 
GUI objects that compose the new transact ion are used to anchor in to the new transact ion loop without 
breaking the context dependencies of  GUI objects. 

When modifying the script , use the comment l ines as guides in  moving the END_TRANSACTION()  and 
BEGIN_TRANSACTION() statements. Ensure that there is a contextual flow from the new posit ion of the 
END_TRANSACTION() statement to the new posit ion of the BEGIN_TRANSACTION() statement. The set  of 
GUI objects that belong to the ofsSendRecv() statement just before the new END_TRANSACTION() 
statement must be the same as the set of GUI objects that belong to the ofsSendRecv() statement prior to 
the new BEGIN_TRANSACTION() statement. 

During playback, modify the Conductor sett ing for Transact ion Pacing on the Script Assignment tab to 
al low the database to process each new business transact ion. 

The fol lowing example shows a modified OFS transact ion loop: 

New position of the BEGIN_TRANSACTION statement 

/* 
NewSales 
*/ 

DO_SLEEP(13); 
ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "B" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 1, 1); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "1" ); 
ofsIndexKey( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 175, 97, 0); 

DO_SLEEP(6); 
ofsSendRecv(1); //ClientSeqNo=31|MsgCount=2|1093981339.921 
BEGIN_TRANSACTION(); 

ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "Business World" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 14, 14); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "14" ); 
ofsRemoveFocus( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 174 ); 
ofsSetSelection( "ORDER_CUSTOMER_NUMBER_0", 564, OFS_ADD, 195, 0, 0); 
ofsSetCursorPosition( "ORDER_CUSTOMER_NUMBER_0", 564, OFS_ENDMSG, 193, "0" ); 
ofsFocus( "ORDER_CUSTOMER_NUMBER_0", 564, OFS_ENDMSG, 174 ); 

DO_SLEEP(6); 
ofsSendRecv(1); //ClientSeqNo=32|MsgCount=4|1093981347.296 

New position of the END_TRANSACTION statement 
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/* 
EndTrans 
*/ 

DO_SLEEP(39); 
ofsSendRecv(1); //ClientSeqNo=61|MsgCount=4|1093981458.031 

ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "14" ); 
ofsSelectMenuItem( "Sales Orders", 257, OFS_ENDMSG, 477, "MENU_11059" ); 

DO_SLEEP(26); 
ofsSendRecv(1); //ClientSeqNo=62|MsgCount=2|1093981485.265 

ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "B" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 1, 1); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "1" ); 
ofsIndexKey( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 175, 97, 0); 

DO_SLEEP(3); 
ofsSendRecv(1); //ClientSeqNo=63|MsgCount=2|1093981488.437 
END_TRANSACTION(); 

ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "Business World" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 14, 14); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "14" ); 
ofsIndexSKey( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 176, 10, 0); 

DO_SLEEP(13); 
ofsSendRecv(1); //ClientSeqNo=64|MsgCount=2|1093981502.640 

Tips:  
During capture, the OFS configuration parameter "record=names" must be enabled to produce control names 
that may be included in the converted script. Control names persist throughout the Forms session, unlike 
control IDs, whose values may change at runtime. Add the “ record=names”  parameter in the Formsweb.cfg 
file or add this parameter to the startup servlet URL. Control IDs can create problems when the transaction 
loop is moved. Some of the control IDs that have been instantiated by the server prior to the new transaction 
loop lose context during iterations of the new loop. For example, in a second loop iteration, the server 
assumes that these client controls are new, generates new control IDs, and eventually cannot find the proper 
context. Then the server stops responding. If control names are used, Forms objects that have been 
instantiated before the new transaction loop are maintained through all iterations of the loop because the 
control name persists throughout the application session. 
During playback, ensure that the sleep factor is at 100% and that the transaction pacing is set to a large 
enough value for the server to process the business transaction that is contained in the new loop. These 
options can be set on the Script Assignment tab of the Conductor. 

 

OFS and WWW Universal  sessions 

You can record with a Universal session to capture both the OFS and WWW transact ions and merge the 
two sets of t ransact ions in to one script . The captured WWW statements contain non-servlet, non-Forms 
data such as GIF objects, whi le the captured OFS statements contain the Forms data.  

Universal script ing for OFS-WWW sessions is avai lable in  C++ format only. After conversion, the WWW 
statements do not appear in  visual scripts. 

Note: The only Universal session combination that is available for Oracle Forms Server is the combination 
of WWW and Oracle Forms Server. 

When an Oracle Appl icat ions login is captured, the login can be scripted using the OracleAppsLogin 
statement or the ofsSetICXTicket statement. Compuware recommends that you use ofsSetICXTicket.  

When OracleAppsLogin is used, the login is performed twice: once by the scripted DO_Http statement for 
the WWW act ions and again by OracleAppsLogin. To prevent dupl icate logins, you must comment out the 
DO_Http (WWW middleware) statement. 
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When ofsSetICXTicket is used, the login is performed just once. This statement al lows the WWW login to 
execute, extracts the ICX t icket from the server reply, and passes the ICX t icket to the Forms session.  

To use ofsSetICXTicket, you must modify the script .  

To capt ure an Oracle Appl icat ions login w i t h  of sSet ICXTicket : 

1. Add the following variable declaration statements to the top of the script: 
char *p; 
char ICX_Ticket[100]; 
char *pTicket; 

2. In the *.postcapweb file, find the HTTP request that returns the ICX ticket. The reply should contain a string that 
indicates the ICX ticket value, such as "ICX_TICKET=". Note the left and right characters that delimit the ICX ticket 
value. In the example in step 4, the left delimiter is "icx_ticket='" and the right delimiter is "'". 

3. In the script, find the matching request line for the HTTP request. 

4. After the matching HTTP request line, add the DO_GetUniqueString statement using your chosen delimiters. For 
example: 
p = DO_GetUniqueString( "icx_ticket='", "'"); 

5. Add script lines that copy the extracted value into your script variables. 
strcpy(ICX_Ticket, p); 
pTicket=ICX_Ticket; 

6. (optional) Verify the ICX ticket value. 
RR__printf("ICX_Ticket=\"%s\"\n", ICX_Ticket); 

7. Add the script line ofsSetICXTicket(&pTicket); before the ofsInitSessionCmdLine. This passes the value of 
the ICX ticket to the ofsInitSessionCmdLine statement. 

8. Free the memory allocated by DO_GetUniqueString and ofxSetICXTicket before the end of the transaction:  

free(p); 
p=NULL; 
free(pTicket); 

pTicket=NULL 

 

 

   

SAP 

Required commands 

Certain commands must be present in  an SAP script  for i t  to run successful ly. These commands are created 
automatical ly during the conversion process. Most of the commands exist  before the 
BEGIN_TRANSACTION statement. The required commands include: 

SET_ABORT_FUNCTION(abort function); 

DEFINE_TRANS_TYPE("capture.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info, "ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard(‘*’); 
SYNCHRONIZE(); 

Required commands for transaction restarting 
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When transact ion restart ing is enabled in  the Conductor for an SAP script , the fol lowing commands, 
which are automatical ly added by QALoad during script  conversion, must exist  for the script  to run: 

SAPGuiApplication(RegisterROT); 
SAPGuiApplication(RevokeROT); 
SAPGui_error_handler(s_info, buffer); 

The SAPGuiApplicat ion command properly registers and removes the script 's SAP GUI usage on the 
Runtime Object Table (ROT). If a transact ion fai ls, these act ions are taken to start  and clean up the SAP 
environment. 

Note: Do not call RR__FailedMsg in an SAP script if the script includes a restart transaction operation. 
SAPGui_error_handler can be called with the same parameters as RR__FailedMsg to output a fatal error 
message while still allowing a proper clean up of the current transaction before restarting the transaction.  
 

Error handl ing and report ing 

A try/catch block is automatical ly generated for the commands between the BEGIN_TRANSACTION and 
END_TRANSACTION statements. This construct provides error handl ing and report ing from the script . 

BEGIN_TRANSACTION(); 

try{ 

   SAPGuiConnect( s_info,"qacsapdb2"); 
   SAPGuiVerCheckStr("6204.119.32"); 

   //Set SapApplication = CreateObject("Sapgui.ScripingCtrl.1")    
   //SapApplication.OpenConnection ("qacsapdb") 
   //Set Session = SapApplication.Children(0).Children(0) 

   DO_SLEEP(3); 

   SAPGuiPropIdStr("wnd[0]"); 
   SAPGuiCmd3(GuiMainWindow, ResizeWorkingPane, 83, 24, false); 

   DO_SLEEP(6); 

   SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME"); 
   SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 

   SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE"); 
   SAPGuiCmd1Pwd(GuiPasswordField, PutText,"~encr~1211616261"); 

   SAPGuiCmd0(GuiPasswordField,SetFocus); 
   SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 

   SAPGuiPropIdStr("wnd[0]"); 
   SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
   SAPGuiCheckScreen("S000","SAPMSYST","SAP"); 

   ... 

   DO_SLEEP(10); 

   SAPGuiPropIdStr("wnd[0]/usr/cntlIMAGE_CONTAINER/shellcont/shell/shellcont[0]/shell"); 
   SAPGuiCmd1(GuiCtrlTree, ExpandNode, "0000000003"); 
   SAPGuiCmd1(GuiCtrlTree, PutSelectedNode, "0000000004"); 
   SAPGuiCmd1(GuiCtrlTree, PutTopNode, "Favo"); 
   SAPGuiCmd1(GuiCtrlTree, DoubleClickNode, "0000000004"); 
   SAPGuiCheckScreen("SESSION_MANAGER", "SAPLSMTR_NAVIGATION", "SAP Easy Access"); 
   SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off"); 

} // end try 

catch (_com_error e){ 
   char buffer[1024]; 
   sprintf (buffer," EXCEPTION 0x%x %s for VU(%i)\n",e.Error(),  
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            (char *)e.Description(), S_task_id); 
   RR__FailedMsg(s_info,buffer); 

} // end catch 

END_TRANSACTION(); 

To include the log on with in the transact ion loop, move the SAPGuiConnect  cal l  inside the try block as 
shown in the fol lowing example: 

SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("capture.cpp"); 
RESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info,"ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

try{ 

   SAPGuiConnect( s_info,"qacsapdb2"); 
   SAPGuiVerCheckStr("6204.119.32"); 
   ... 
   SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off"); 

} // end try 

catch (_com_error e){ 

   char buffer[1024]; 
   sprintf(buffer," EXCEPTION 0x%x %s for VU(%i)\n",e.Error(),  
           (char *)e.Description(), S_task_id); 
   RR__FailedMsg(s_info,buffer); 

} // end catch 

END_TRANSACTION(); 

To include the log on outside the transact ion loop, move the log off sect ion so that i t  fol lows the 
END_TRANSACTION statement. However, ensure that the recording with in the transact ion loop begins 
and ends in the same locat ion in  the menu system. For example: 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("capture.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
   RR__FailedMsg(s_info,"ERROR initializing COM"); 
SAPGuiSetCheckScreenWildcard('*'); 

SYNCHRONIZE(); 

SAPGuiConnect( s_info,"qacsapdb2"); 

SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME"); 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 

SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE"); 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~1211616261"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 

SAPGuiPropIdStr("wnd[0]"); 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
SAPGuiCheckScreen("S000","SAPMSYST","SAP"); 
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BEGIN_TRANSACTION(); 

try{ 
   SAPGuiVerCheckStr("6204.119.32"); 
   ... 
} // end try 

catch (_com_error e){ 
   char buffer[1024]; 
   sprintf(buffer," EXCEPTION 0x%x %s for VU(%i)\n",e.Error(), 
           (char *)e.Description(), S_task_id); 
   RR__FailedMsg(s_info,buffer); 

} // end catch 

END_TRANSACTION(); 

SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off"); 

 

Handling mult iple logons 

You may need to modify your script  to handle mult iple logons when the recording scenario differs from 
the run-t ime scenario. For example, i f when you record, no users are logged on to the SAP environment 
and when you run the script , users are already logged on, the script  may fai l . To work around th is issue, 
you can use the SAPGuiPropIdStrExists and SAPGuiPropIdStrExistsEnd commands to handle either 
scenario. This technique works by checking for the mult iple logon dialog box from SAP and select ing the 
Cont inue opt ion. 

The fol lowing example demonstrates the usage of the SAPGuiPropIdStrExists and 
SAPGuiPropIdStrExistsEnd commands to handle mult iple logons: 

... 

SAPGuiCheckScreen("S000","SAPMSYST","SAP"); 
SAPGuiPropIdStrExists("wnd[1]/usr/radMULTI_LOGON_OPT2"); 

   DO_SLEEP(24); 

   SAPGuiCmd0(GuiRadioButton,Select); 
   SAPGuiCmd0(GuiRadioButton,SetFocus); 
   SAPGuiPropIdStr("wnd[1]/tbar[0]/btn[0]"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen("S000","SAPMSYST","License Information for Multiple Logon"); 

SAPGuiPropIdStrExistsEnd("wnd[1]/usr/ radMULTI_LOGON_OPT2"); 

... 

 

Checking the SAP status bar 

The SAP status bar displays error and status messages, as shown in the fol lowing figure. 
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You can use the SAPGuiCheckStatusbar command to test for certain status responses in the SAP 
environment. 

The SAPGuiCheckStatusbar command is used in the fol lowing script  example: 

... 
SAPGuiPropIdStr("wnd[0]"); 
SAPGuiCmd1(GuiMainWindow, SendVKey, 0); 
SAPGuiCheckScreen("S000", "SAPMSYST", "SAP"); 
SAPGuiCmd3(GuiMainWindow, ResizeWorkingPane, 94, 24, false); 

//SAPGuiCheckStatusbar returns TRUE if the message is found 
//and FALSE if not found 

BOOL bRetSts = SAPGuiCheckStatusbar("wnd[0]/sbar", "E: Make an entry in all required 
fields"); 

if (bRetSts) 
    RR__printf(" True\n"); 

else 
    RR__printf(" False\n"); 

... 

 

Object l i fe span 

Whenever a script  is run, al l  objects on the SAP GUI window are deleted and re-created. These objects, 
which are created in  the SAP environment and can disappear without user in teract ion, can cause script  
fai lure i f the script  references the objects after they have disappeared. 

For more troubleshoot ing in formation, refer to SAP’s publ icat ion t i t led “ SAP GUI Scripting API for the 
Windows and Java Platforms” . 

 

Winsock  

Understanding data representat ion in  the script  

This sect ion describes how data that is sent and received is displayed in a Winsock script . Use th is sect ion 
as a reference when you examine a script . 

During the conversion process, QALoad determines how to represent each character in  the script . This 
conversion process uses the fol lowing rules: 
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1. The character is compared to the “space” character in the ASCII table, which has a decimal value of 32. If the 
character’s value is less than 32, the following steps are taken: 

b. If the character is “\r”, “\n”, “\t”, or “\f”, it is represented in the script as a normal C escape character. 

c. If the character is either “^\” or “^^”, it is represented in the script as an octal character. For example, the 
values would be “\034” and “\036”, respectively. 

d. If the character’s value is less than 32 and it does not meet the descriptions in a) and b) above, it is 
represented in the script as a control character. For example, if the character is a null character, it is represented in 
the script as “^@”. 

2. If the character’s decimal value is between 32 (the “space” character) and 126 (~), it displays in the script as a 
standard readable ASCII character, with the following exceptions: 

 If the character is “ \ ” , which has a decimal value of 92, i t  is represented as “ \ \ ”  in  the 
script . 

 If the character is “ “ “ , which has a decimal value of 34, i t  is represented as “ \ ” ”  in  the 
script . 

 If the character is “ ^ ” , which has a decimal value of 94, i t  is represented as “ ^^ ”  in  the 
script . 

3. If the character has a decimal value of 127, which corresponds to Delete (DEL), it is represented as “^” in the script. 

The fol lowing table summarizes the results of rules 1-3. 

Code Octal  Decim al  Char 

^@ 000 0 NUL 

^A 001 1 SOH 

^B 002 2 STX 

^C 003 3 ETX 

^D 004 4 EOT 

^E 005 5 ENQ 

^F 006 6 ACK 

^G 007 7 BEL 

^H 010 8 BS 

\t 011 9 HT 

\n 012 10 LF 

^K 013 11 VT 

\f 014 12 FF 

\r 015 13 CR 

^N 016 14 SO 

^O 017 15 SI 

^P 020 16 SLE 
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^Q 021 17 SC1 

^R 022 18 DC2 

^S 023 19 DC3 

^T 024 20 DC4 

^U 025 21 NAK 

^V 026 22 SYN 

^W 027 23 ETB 

^X 030 24 CAN 

^Y 031 25 EM 

^Z 032 26 SIB 

^[ 033 27 ESC 

\034 034 28 FS 

^] 035 29 GS 

^_ 037 31 US 

 040 32 SP 

\" 042 34 " 

\\ 134 92 \  

^^ 136 94 ^  

^? 177 127 DEL 

4. If the character is not included in the groups defined in steps 1-3, it is represented as an octal character in the script. 
These characters are often referred to as high ASCII characters (those with a decimal value greater than 128), and 
are represented in the script as “\OOO”, where OOO is the octal value for the ASCII character. 

 

Handl ing Winsock appl icat ion data flow 

Frequently, server programs return unique values (for example, a session ID) that vary with each execut ion 
of the script  and may be vital  to the success of subsequent transact ions. To create scripts that include these 
values, you need to subst i tute the hard-coded values returned by the server with variables. The fol lowing 
original and modified code examples demonstrate th is technique. 

Original code 

In  th is script , the server sends a session ID in response to a connect ion by the cl ient. This session ID is 
required to successful ly complete subsequent transact ions. 

/* 
* wsk-AdvancedTechniques_original.c 
* 
* This script contains support for the following 
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* middlewares: 
* - Winsock 
*/ 
 
/* Converted using the following options: 
* General: 
* Line Split : 80 characters 
* Sleep Seconds : 1 
* Auto Checkpoints : Yes 
*/ 

#define SCRIPT_VER 0x00000005UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_wsk.h" 

/* set function to call on abort*/ 

void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL 0 
#endif 

int rhobot_script(s_info) 
PLAYER_INFO *s_info; 
{ 

/* Declare Variables */ 

SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("wsk-AdvancedTech_1.c"); 

// Checkpoints have been included by the convert process 

DefaultCheckpointsOn(); 

DO_WSK_Init(s_info); 

SetTimeout(20); /* Wait up to 20 seconds for each expected pattern */ 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Connect(S1, "172.22.24.125", 2100, AF_INET); 

///////////////////////////////////////////////////// 
// The session id returned by the server is 
// unique to each connection 
///////////////////////////////////////////////////// 

/* 21bytes: SessionID=jrt90847\r\n */ 

DO_WSK_Expect(S1, "\n"); 

////////////////////////////////////////////////////// 
// This unique id is then used for subsequent 
// requests 
////////////////////////////////////////////////////// 

/* 34 bytes */ 

DO_WSK_Send(S1, "SessionID=jrt90847\r\n:^B^@^@^@^B^@^@^@^A^@^@^@"); 

/* 15 bytes: ID Accepted#^@\r\n */ 

DO_WSK_Expect(S1, "\n"); 
DO_WSK_Closesocket(S1); 

END_TRANSACTION(); 

REPORT(SUCCESS); 
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EXIT(); 

return(0); 
} 

void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User %i:ABORTED.", S_task_id); 

EXIT(); 
} 

Modified code 

If the original script  (wsk-AdvancedTechniques_original.c shown above) is replayed, i t  wi l l  fai l  because the 
session ID wil l  not be unique; rather, i t  wi l l  be the session ID that is coded in the script . To use the unique 
session ID received from the server, variable subst i tut ion must be used. 

/* 
* wsk-AdvancedTechniques_modified.c 
* 
* This script contains support for the following 
* middlewares: 
* - Winsock 
*/ 

/* Converted using the following options: 
* General: 
* Line Split : 80 characters 
* Sleep Seconds : 1 
* Auto Checkpoints : Yes 
*/ 

#define SCRIPT_VER 0x00000005UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_wsk.h" 

/* set function to call on abort*/ 

void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL 0 
#endif 

int rhobot_script(s_info) 
PLAYER_INFO *s_info; 

{ 

/* Declare Variables */ 

char Buffer[64]; 
char SendBuffer[64]; 
int nBytesReceived = 0; 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("wsk-AdvancedTech_1.c"); 

// Checkpoints have been included by the convert process 

DefaultCheckpointsOn(); 

DO_WSK_Init(s_info); 

SetTimeout(20); /* Wait up to 20 seconds for each expected pattern */ 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 



QALoad 5.5  

42 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Connect(S1, "172.22.24.125", 2100, AF_INET); 

////////////////////////////////////////////////////// 
// The reply from the server is read into 
// the Buffer variable. We will then have 
// the unique Session ID for this connection. 
// Also need to null-terminate the buffer 
// after receiving. 
////////////////////////////////////////////////////// 

DO_WSK_Recv(S1, Buffer, 64, 0, &nBytesReceived); 
Buffer[nBytesRecieved] = '\0'; 

/* 21bytes: SessionID=jrt90847\r\n */ 

//DO_WSK_Expect(S1, "\n"); 

////////////////////////////////////////////////////// 
// Finally, substitute the Session ID received from 
// the server with the one coded in the script. 
////////////////////////////////////////////////////// 

sprintf(SendBuffer, "%s:^B^@^@^@^B^@^@^@^A^@^@^@", Buffer); 
DO_WSK_Send(S1, SendBuffer); 

/* 34 bytes */ 

//DO_WSK_Send(S1, "SessionID=jrt90847:^B^@^@^@^B^@^@^@^A^@^@^@"); 

/* 15 bytes: ID Accepted#^@\r\n */ 

DO_WSK_Expect(S1, "\n"); 
DO_WSK_Closesocket(S1); 

END_TRANSACTION(); 

REPORT(SUCCESS); 

EXIT(); 

return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 

{ 
RR__printf("Virtual User %i:ABORTED.", S_task_id); 
EXIT(); 
} 

Modifying QALoad's funct ions to incorporate dynamic data 

If you need to use dynamic data with your scripts, you can modify some QALoad funct ions to handle 
dynamic data. The two scenarios below describe specific si tuat ions in  which you might need dynamic data, 
and how to achieve that in  the script . 

Scenario 1: 

One method of accessing dynamic data is by using a datapool fi le. However, you might need to read in  
data that is not in  the format of an ASCII string, which is required for datapool fi les. 

For example, i f the string “ \ 121\ 101\ 114\ 157\ 141\ 144”  is read in from a datapool fi le with one of the 
datapool funct ions, the output would be “ \ \ 121\ \ 101\ \ 114\ \ 157\ \ 141\ \ 144” , which is incorrect. To 
work around th is problem, you can use the OctalToChar() command to convert  any octal sequences into 
their binary representat ion. The fol lowing examples i l lustrates the use of the OctalToChar() command for 
th is purpose: 
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Example 

In  th is example, the string “ \ 121\ 101\ 114\ 157\ 141\ 144”  is read in from a central datapool fi le and 
converted to i ts binary representat ion. 

/* Declare variables */ 
char temp[40]; 
 
... 

BEGIN_TRANSACTION(); 
GET_DATA(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 

strcpy(temp,VARDATA(1)); 

OctalToChar(temp); //used to convert octal strings 
                   //to their binary format 

DO_WSK_Send(S1,temp); 
//DO_WSK_Send(S1,"\121\101\122\165\156"); 
DO_WSK_Closesocket(S1); 

The DO_WSK_Send() command above sends the string “ 121\ 101\ 114\ 157\ 141\ 144”  to the server. This 
string is the octal representat ion of the string “  QALoad ” . 

Scenario 2: 

You might find that your capture data is not the same data you need for running a test. For example, you 
might need to change the value of a user ID during replay. One method of changing the value is to change 
the value through the DO_WSK_Send() command, but that results in  the value being stat ic only with in the 
funct ion. To subst i tute a different value each t ime, create a dynamic variable, such as a datapool value, to 
replace the user ID. 

Example  

In  th is example, the script  includes a DO_WSK_Send() command that sends “ name=Jim ”  to the server as 
the user ID. Then a variable is used to change the name to “ Mark” . 

/* Declare variables */ 
char buffer[65]; 
char sendbuffer[65]; 

... 

BEGIN_TRANSACTION(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1,ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

//original DO_WSK_Send(S1,"name=Jim"); 

strcpy( buffer, "Mark"); 
sprintf( sendbuffer, "name=%s", buffer); 
DO_WSK_Send(S1, sendbuffer); 

/* 2 bytes: ok */ 

DO_WSK_Expect(S1,"ok"); 
DO_WSK_Closesocket(S1); 
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The buffer before the DO_WSK_Send() command is modified and a new buffer is passed as the second 
parameter of the DO_WSK_Send() command. This effect ively sends “ name=Mark”  to the server instead of 
 "name=Jim ” . 

 

Saving server repl ies 

There are two methods for saving the ent ire reply that a server sends back. The fol lowing paragraphs 
describe each method. 

Using the Response() and ResponseLength() commands 

The Response() command can be cal led direct ly after the DO_WSK_Expect() command. It  returns a pointer 
to the data that has been received by DO_WSK_Expect(). To also receive the length of the replay, cal l  the 
ResponseLength() command, which returns the number of characters that were received. The fol lowing 
example uses the Response() and ResponseLength() commands. 

Example  

In  th is example, variables are declared to store the results from the two funct ions. Both funct ions are also 
used to save the buffer that is received with in the DO_WSK_Expect() command. 

/* Declare Variables */ 
int x = 0; 
char *temp; 

... 

BEGIN_TRANSACTION(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

/* 21 bytes: You are now connected */ 

DO_WSK_Expect(S1, "d"); 

// Used to store the data that was received by the 
// DO_WSK_Expect 

temp = Response(); 

// Used to get the size of the response that was received 
// so far 

x = ResponseLength(); 

/* The line below will print the length of the response and the actual response */ 

RR__printf(“length = %d, and response= %s",x, temp); 
DO_WSK_Closesocket(S1); 

The message “ length=21 response=You are now connected”  displays in  the Player buffer window. 

 

Using the DO_WSK_Recv() command 

To save a response based on i ts size instead of a unique character string that is used with in the 
DO_WSK_Expect() command, use the DO_WSK_Recv() command. This command enables you to specify 
how much data to receive and where to store the data. 
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You can also use the DO_WSK_Recv() command to store the reply that is returned from the server. This 
strategy is useful when you need to retrieve the buffer that is returned from the server, even though the 
returned data is too dynamic and causes the DO_WSK_Expect() command to fai l  every t ime. 

Example  

In  th is example, the DO_WSK_Recv() command is used to save a server reply based on size. Two variables 
are declared to store the results from the DO_WSK_Recv() command. 

/* Declare Variables */ 
int size = 0; 
char temp[45]; 

... 

BEGIN_TRANSACTION(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

/* 21 bytes: You are now connected */ 

memset(temp,'\0',45); 
DO_WSK_Recv(S1,temp,45,0,&size); 
RR__printf("size=%d string=%s",size,temp); 
DO_WSK_Closesocket(S1); 

The message “ size=21 string=You are now connected”  displays in  the Player buffer window. 

Note: If you use this method as a substitute for the DO_WSK_Expect() command, ensure that you receive 
the correct information prior to calling the next function in the script. 

 

Parsing server repl ies for values 

To parse a buffer for a part icular value, you can write a parsing rout ine that searches the ent ire buffer for 
the value. However, you can also use one of QALoad ’s Winsock helper commands. The fol lowing scenarios 
describe two situat ions in  which you could use the Winsock commands to solve a parsing problem. 

Scenario 1: 

To find a string in  a server reply, you can use the SkipExpr() and ScanExpr() commands. SkipExpr() 
searches for the first  occurrence of a string in  the in ternal buffer that contains the response that was 
received with in the DO_WSK_Expect() command. Then, use the ScanExpr() command to search for 
another string. ScanExpr() saves the buffer from the first  occurrence of the string that was used with 
SkipExpr() up to and including the string used with in ScanExpr(). The first  parameter of ScanExpr() is a 
UNIX-style regular expression. The fol lowing table l ists the most common expressions: 

Character M ean ing 

. Matches the end of a string. 

* Matches any number of characters. 

? Matches any one character. 

Example In th is example, the buffer contains “ sessionid=1234567890abc” , and the goal is to retrieve 
everyth ing after the “ =” , up to and including “ abc” . 
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/* Declare Variables */ 
char temp[35]; 
int size = 0; 

... 

BEGIN_TRANSACTION(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

/* 23 bytes: sessionid=1234567890abc */ 

DO_WSK_Expect(S1, "c"); 
SkipExpr("sessionid="); 
size=ScanExpr(".*abc" , temp); 
RR__printf("length = %d string = %s", size, temp); 
DO_WSK_Closesocket(S1); 

The message “ length=13 string=1234567890abc”  displays in  the Player buffer window. 

Scenario 2: 

You may have data returned from the server that is too dynamic, that is, you are not able to base parsing 
on actual characters. The solut ion is to base the parsing on character posit ions instead. 

For example, to save the characters 20 through 25, you could use the ScanSkip() and ScanString() 
commands. ScanSkip() skips a specified number of characters in  the in ternal buffer that stores the response 
that was received with in the DO_WSK_Expect() command. ScanString() scans a number of characters from 
the current posit ion with in the buffer in to a character string. 

Example  

In  th is example, a buffer contain ing “ xxx123456789yyy”  is returned from the server. The value between 
“ xxx”  and “ yyy”  is returned. 

/* Declare Variables */ 

char temp[15]; 

... 

BEGIN_TRANSACTION(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

/* 16 bytes: xxx0123456789yyy */ 

memset(temp,'\0',15); 
DO_WSK_Expect(S1, "yyy"); 
ScanSkip(3); 
ScanString(10,temp); 
RR__printf("string=%s",temp); 
DO_WSK_Closesocket(S1); 

The message “ string=0123456789”  displays in  the Player buffer window. 

 

WW W 
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Simulat ing variable IP addresses 

While QALoad can simulate mult iple virtual users from a single system, i t  general ly does so using a single 
source IP address. In  most  test ing situat ions th is isn ’t  a problem, but with a small  set of HTTP-based 
appl icat ions, i t  may not be the best way to simulate real-l i fe act ivi ty. For QALoad Player machines with  
more than one stat ic IP address, QALoad can direct each virtual user to use a di fferent source IP address.  

To accomplish th is, a local datapool fi le contain ing a l ist  of local stat ic IP addresses must be created on 
each QALoad Player mach ine. When you enable IP spoofing in  the QALoad Conductor, the QALoad 
Conductor instructs each QALoad Player to create the appropriate datapool fi le at run t ime. The QALoad 
Player uses these addresses for connect ions to HTTP and SSL servers. Each virtual user receives one address 
for use with al l  i ts connect ions. If there are more virtual users than addresses, IP addresses are re-used 
start ing from the beginning of the datapool fi le. 

Modifying a Script to Use Variable IP Addresses 

QALoad uses the DO_IPSpoofEnable command to insert  IP addresses from the datapool in to the script . 
When th is command is executed, the script  opens the datapool fi le located on the QALoad Player, reads 
the first  avai lable data record, and stores that record for use on al l  subsequent DO_Http and DO_Https 
cal ls. If there are more virtual users than IP addresses in  the datapool fi le, IP addresses are reused. You can 
automatical ly generate the DO_IPSpoofEnable command in your script  during conversion by select ing the 
IP Spoofing opt ion from the QALoad Script Development Workbench ’s WW W Advanced  dialog box. 
Access th is dialog box from the Convert  Options wizard’s WWW tab by cl icking the Advanced  button. 
This opt ion inserts the DO_IPSpoofEnable command direct ly in  the script  during conversion, before the 
first  DO_Http or DO_Https command.  

Creating a Datapool of IP Addresses 

Use the fol lowing procedure to create a datapool of val id IP addresses from the QALoad Conductor. This 
fi le is automatical ly created on the QALoad Player workstat ions (Windows and UNIX) at run t ime. 

To creat e a dat apool  of  IP addresses: 

1. Start QALoad Conductor. 

2. Click the Machine Configuration tab. 

3. Double-click the Player machine name in the list. The Properties dialog box appears. 

4. Select the Generate IP Spoof Data (machines with multiple IP addresses only) option. 

5. Click OK.  

At run t ime, the QALoad Conductor sends a command to each QALoad Player Agent to create the datapool 
fi le of IP addresses, and the script  is sent to the server using the different IP addresses. 

The Generate IP Spoof  Data check box is val id only for WWW scripts. 

Note: The machine on which the QALoad Conductor resides must have static IP addresses assigned to it. If 
no static IP addresses are found, the QALoad Conductor displays a warning and the datapool file is not 
generated. The datapool file is named ipspoof.dat, and is saved in the \Compuware\QALoad\Datapools 
directory. 
 

Handling error messages from the Web server 

When a server returns an error message, i t  returns i t  in  one of two ways. It  ei ther returns an error message 
with a response code (for example, 404 Not Found) or returns an HTML page that contains an error 
message. The fol lowing sect ions provide examples of code that you can use in  your script  to handle errors 
that the Web server returns to the browser. 
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Handling error messages with response codes 

The example below demonstrates how to write code to handle error messages that include response codes 
that the Web server returns to the browser. The code performs the fol lowing act ions: 

!  Checks for an error code using the DO_GetLastHttpError command 

!  Aborts or continues script execution, based on the WWW_FATAL_ERROR statement 

Example 

int error; 
char errorString[30]; 
 
DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 

if((error = DO_GetLastHttpError()) > 399) 

{ 
sprintf(errorString, "Error in response: %d\n", error); 
WWW_FATAL_ERROR("Request-host", errorString); 
} 

Handling error messages returned in an HTML page 

The examples below demonstrate how to write code to handle error messages that the Web server returns 
to the browser in  an HTM L page. 

Using DO_VerifyDocTitle to verify page requests 

By insert ing the DO_VerifyDocTit le command into your script , you can compare the HTML document 
t i t les in  your load test script  with the document t i t les you original ly captured. The code performs the 
fol lowing act ions: 

!  Calls DO_Http to request an HTML page from the Web server 

!  Calls DO_VerifyDocTitle with the original HTML document title. If the titles do not match, DO_VerifyDocTitle exits the 
script 

Exam ple 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welcome to The Main Page", TITLE); 

Searching response text for error messages 

In  some scripts, error messages are displayed as text  in  an HTML page. The fol lowing example 
demonstrates how to detect these messages in a script . The code performs the fol lowing act ions: 

!  Searches for errors returned as HTML from the Web server 

!  Branches to error handling code 

Exam ple 

int response; 
response = DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
if (strstr (response, "200 OK") == NULL) 
   WWW_FATAL_ERROR("host", "Response did not have 200 OK"); 

 

Simulat ing CGI requests 

The fol lowing topics describe strategies for simulat ing CGI requests: 

CGI parameter encoding 
CGI Get requests 
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CGI Post requests 
CGI forms 

 

Simulat ing JavaScript 

JavaScript is handled by the fol lowing process: 

1. The browser makes a page request to a server for a page that contains JavaScript. 

2. Because JavaScript is simply uncompiled code, the browser downloads and immediately executes this code upon 
receipt of the page. 

Supported objects 

QALoad supports the bui l t -in  JavaScript objects (global, object, funct ion, array, string, boolean, number, 
math, date, regexp, and error), document objects, and image objects. 

Supported properties 

The only document propert ies that QALoad supports are cookies, t i t le, and the images array. The only 
image property that QALoad supports is src. 

Evaluation errors 

If an object, property, or funct ion used with in a block of JavaScript code is not defined, i t  wi l l  cause a 
JavaScript except ion. The except ion stops evaluat ion of that block. 

Example Web page 

The fol lowing Web page contains the JavaScript funct ion and an onLoad tag that cal ls the scrol l i t  funct ion. 
The onLoad tag tel ls the browser to execute the JavaScript immediately after loading the page. The scrol l i t  
funct ion displays a scrol l ing banner region on the Web page. 

<HTML> 
<HEAD> 
<TITLE>Java Script Example</TITLE></HEAD> 
 
<SCRIPT LANGUAGE="JavaScript" src="js_do_nothing.js"> 

function scrollit_r2l(seed) 
{ 

var m1 = " Welcome to Compuware's QALoad homepage."; 
var m2 = " Glad to see you."; 
var m3 = " Thanks for coming. "; 
var msg = m1 + m2 + m3; 
var out = " "; 
var c = 1; 

if (seed > 100) { 
seed--; 
var cmd="scrollit_r2l(" + seed + ")"; 
timerTwo=window.setTimeout(cmd,100); 
} 

else if (seed <= 100 && seed > 0) { 
for (c=0 ; c < seed ; c++) { 
out+=" "; 
} 
out+=msg; 
seed--; 
var cmd="scrollit_r2l(" + seed + ")"; 
window.status=out; 
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timerTwo=window.setTimeout(cmd,100); 
} 

else if (seed <= 0) { 
if (-seed < msg.length) { 
out+=msg.substring(-seed,msg.length); 
seed--; 
var cmd="scrollit_r2l(" + seed + ")"; 
window.status=out; 
timerTwo=window.setTimeout(cmd,100); 
} 

else { 
window.status=" "; 
timerTwo = window.setTimeout("scrollit_r2l(100)", 75); 
} 
} 
} 

</script> 

<BODY onLoad="timerONE=window.setTimeout('scrollit_r2l(100)',500);"> 
<!-- End scrolltext --> 
 
<center><h2>Java Script Example</h2><hr>Check out the browser's scrolling status 
 bar.<br><br> 
</center> 

</BODY></HTML> 

Example script 

The fol lowing script  features a DO_Http cal l  to retrieve the JavaScript page.  

How  I t  Works: QALoad evaluates the JavaScript in  the context of script  blocks, onLoad tags, and src and 
then executes them. 

DO_InitHttp(s_info); 

... 

... 

BEGIN_TRANSACTION(); 
DO_AutomaticSubRequests(TRUE); 

... 

... 

DO_Http("GET http://www.host.com/js.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Java Script Example", TITLE); 

... 

... 

END_TRANSACTION(); 

 

Simulat ing cookies 

This sect ion describes how QALoad handles cookies. Cookies are handled by the fol lowing process: 

1. The browser makes a CGI request to a server for a dynamic page. 

2. When the server sends the page back to the browser, the page includes a cookie in the header. The browser saves 
the cookie along with information that ties it to the Web server. 

3. On all subsequent requests to that Web server, the browser passes the cookie along with the request. 

Example Web page 
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The fol lowing CGI Perl  script  generates a Set-Cookie header as a part  of subsequent HTTP requests. 

Set-Cookie: SaneID=172.22.24.180-4728804960004 
Set-Cookie: SITESERVER=ID=f0544199a6c5970a7d087775f83b23af 

<html> 

... 

The cookies for this site are:<br><br> 

<B>SaneID=172.22.24.180-4728804960004; SITESERVER=ID=f0544199a6c5970a7d087775f83b23af 
</B><P> 

<b>Next cookie for this URL will be : 1</b><br> 
<br>RELOAD PAGE TO INCREMENT COUNTER<br><br><A HREF=http://www.host.com/index.htm>Return to 
previous homepage.</A> 

Example script when Dynamic Cookie Handling is turned on 

This is the default  method by which QALoad handles cookies. The example script  features the fol lowing 
elements: 

!  Two CGI requests that return dynamic pages 

!  Cookies are handled by the replay engine 

BEGIN_TRANSACTION(); 
DO_DynamicCookieHandling(TRUE); 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl" 
        "HTTP/1.0\r\n\r\n"); 

/* Request: 2 */ 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl" 
        "HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

Example script when Dynamic Cookie Handling is turned off 

The example script  features the fol lowing elements: 

!  A CGI request that returns a dynamic page 

!  Two DO_GetCookieFromReply calls to retrieve the cookie from reply 

!  Two DO_SetValue calls to set the cookie 

!  A free cookie 

How  I t  Works: For cookies that are set with CGI scripts, the script  stores incoming cookies in  a variable 
and passes them back to the Web browser in  the reply from the CGI script . The script  handles these 
cookies by execut ing a DO_GetCookieFromReply command after the CGI request. 
DO_GetCookieFromReply stores the cookie values in  variables, which the script  then passes back to 
subsequent CGI requests using the DO_SetValue command. 

int i; 
char *Cookie[4]; 

... 

... 
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for(i=0;i<4;i++) 
Cookie[i]=NULL; 
DO_InitHttp(s_info); 

... 

... 

BEGIN_TRANSACTION(); 
DO_DynamicCookieHandling(FALSE); 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl  
        "HTTP/1.0\r\n\r\n"); 

/*Set-Cookie: NUM=1 */ 
DO_GetCookieFromReplyEx("NUM", &Cookie[0], '*'); 

/*Set-Cookie: SQUARE=1 */ 
DO_GetCookieFromReplyEx("SQUARE", &Cookie[1], '*'); 

/* Request: 2 */ 
DO_SetValue("cookie000", Cookie[0]); /* NUM=1 */ 
DO_SetValue("cookie001", Cookie[1]); /* SQUARE=1 */ 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl " 
        "HTTP/1.0\r\n" 
        "Cookie: {*cookie000}; {*cookie001}\r\n\r\n"); 

... 

... 

DO_HttpCleanup(); 
for(i=0; i<4; i++) 
{ 
free(Cookie[i]); 
Cookie[i]=NULL; 
} 

END_TRANSACTION(); 

 

Execut ing a Visual Basic script  

QALoad does not evaluate a Visual Basic script . However, any Visual Basic script  request that occurs is 
inserted in to the script  as a main request. 

Execut ing a Java applet 

Java applets are handled by the fol lowing process: 

1. The browser makes a request to a Web server for an HTML document that contains embedded Java applets. 

2. The browser downloads the Java applets, in the order in which they appear on the Web page, and immediately 
executes them. 

Example Web page 

The fol lowing Web page contains two sect ions that reference Java applets. Not ice the parameters that 
fol low the applet. The browser passes these parameters when invoking an applet. 

<HTML> 
<HEAD> 
<TITLE>Java Example</TITLE></HEAD> 
<BODY> 

<center><h2>Java Applet Example</h2><hr> 
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<applet code="LScrollText.class" width="500" height="20" > 
<PARAM NAME="MESSAGE" VALUE="Scrolling Text created by Java Applet... >>Click here to 
Download<< Use it FREE"> 
<PARAM NAME="FONTHEIGHT" VALUE="14"> 
<PARAM NAME="SPEED" VALUE="2"> 
<PARAM NAME="PIXELS" VALUE="1"> 
<PARAM NAME="FONTCOLOR" VALUE="0000FF"> 
<PARAM NAME="BACKCOLOR" VALUE="FFFF00"> 
<PARAM NAME="TARGET" VALUE="lscrolltext.zip"> 
</applet> 

<br><br><br> 

A scrolling message, with custom colors, font size, speed, and target URL.<br> 
The source (.ZIP) file can be downloaded by clicking the associated area in text window. 

<br><br><br><hr> 

<APPLET CODE="imagefader.class" WIDTH=80 HEIGHT=107> 
<PARAM name="demicron" value="www.demicron.se"> 
<PARAM name="reg" value="A00012"> 
<PARAM name="maxitems" value="3"> 
<PARAM name="width" value="80"> 
<PARAM name="height" value="107"> 
<PARAM name="bitmap0" value="anibal.jpg"> 
<PARAM name="bitmap1" value="jak.jpg"> 
<PARAM name="bitmap2" value="jan.jpg"> 
<PARAM name="url0" value=" "> 
<PARAM name="url1" value=" "> 
<PARAM name="url2" value=" "> 
<PARAM name="step" value="0.05"> 
<PARAM name="delay" value="20"> 
<PARAM name="sleeptime" value="2000"> 

</APPLET> 

<br><br><br> 

This applet is a very popular image fader that displays a series of images, and allows URLs 
to be associated with each image.<br><br><hr> 

</center> 
</BODY></HTML> 

Example script 

QALoad does not evaluate Java applets. They appear as main requests. The example script  features the 
fol lowing elements: 

!  A DO_Http call to retrieve the main page. 

!  A DO_Http call to retrieve the scrolling text class. 

!  A DO_Http call to retrieve the image fader class Java applet. 

How  I t  Works: QALoad interacts with the Web server without execut ion of the Java applet program wi th in 
the virtual browser. The browser accepts the pages that contain Java applets, but does not execute the 
applet as part  of the load test. The Java applets are not evaluated by QALoad and appear as main requests 
in  the script . 

DO_InitHttp(s_info); 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 
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DO_Http("GET http://www.host.com/java.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Java Example", TITLE); 

/* Request: 2 */ 
DO_Http("GET http://www.host.com/LScrollText.class HTTP/1.0\r\n\r\n"); 

/* Request: 3 */ 
DO_Http("GET http://www.host.com/imagefader.class HTTP/1.0\r\n\r\n"); 
DO_Http("GET http://www.host.com/jak.jpg HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

 

Simulat ing frames 

Frames are handled by the fol lowing process: 

1. The browser makes a main page request to a Web server for a page that contains frames. 

2. The browser parses the frame pages and places them in sub-windows within the browser, each of which displays the 
frame content. 

Example Web page 

The fol lowing Web page contains four frames. 

<HTML> 
<HEAD> 
<TITLE>FRAME Example</TITLE> 
</HEAD> 

<! -- Here is the FRAME information for browsers with frames --> 

<FRAMESET Rows="*,*"><!-- Two rows, each equal height --> 
  <FRAMESET Cols="*,*"><!-- Two columns, equal width --> 
     <FRAME Src="findex.htm" Name="ul-frame"> 
     <FRAME Src="findex.htm" Name="ur-frame"> 
  </FRAMESET> 

   <FRAMESET Cols="*,*"><!-- Two columns, equal width --> 
     <FRAME Src="findex.htm" Name="ll-frame"> 
     <FRAME Src="findex.htm" Name="lr-frame"> 
  </FRAMESET> 
</FRAMESET> 

</HTML> 

Example script 

QALoad automatical ly generates al l  constructs necessary to request frames. The example script  features the 
fol lowing element: 

!  A DO_Http call to retrieve the main page. 

How  I t  Works: The frames are treated as sub-requests and are evaluated and requested by QALoad . 

BEGIN_TRANSACTION(); 
DO_AutomaticSubRequests(TRUE); 

... 

... 

DO_Http("GET http://www.host.com/frameset.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("FRAME Example", TITLE); 

... 

... 
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END_TRANSACTION(); 

 

Simulat ing browser caching 

Browser caching is handled by the fol lowing process: 

1. When the browser makes a request for static HTML pages, it may include an option to retrieve the page only if it is 
newer than the one held in the browser’s cache. 

2. If browser caching is enabled, the server returns only newer versions of the page. If browser caching is not enabled, 
the server always returns the page. 

How  I t  Works: The QALoad Script Development Workbench disables browser caching while recording, 
which means a page is always retrieved.  

 

Request ing password-protected directories 

Web developers use password-protected directories to protect access to some pages. When the browser 
requests a page in a password-protected directory, the server returns a special response that specifies the 
page is password-protected. When the browser receives th is type of reply, i t  gathers the user ID and 
password, encrypts them, and passes them back to the server in  a subsequent request. 

Example script 

QALoad automatical ly generates al l  the constructs that are necessary to execute a request of a password-
protected directory. 

The example script  features the fol lowing elements: 

!  DO_BasicAuthorization, which takes the user ID and password as parameters 

!  DO_Http request to the password-protected directory 

BEGIN_TRANSACTION(); 
DO_BasicAuthorization("frank", "~encr~557A2549474E57444A"); 

... 

... 

DO_Http("GET http://www.host.com/access_controlled/secure.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Successful Test of a Secured Page", TITLE); 

... 

... 

END_TRANSACTION(); 

Example script 

QALoad also handles Windows Domain Authent icat ion (NTLM). 

The example script  features the fol lowing elements: 

!  A DO_NTLMAuthorization call, which takes the domain, user ID, and password as parameters 

!  DO_Http request to the NTLM protected directory 

BEGIN_TRANSACTION(); 
DO_NTLMAuthorization("dom1\\frank", "~encr~557A2549474E57444A"); 

... 

... 

DO_Http("GET http://www.host.com/ntlm_controlled/secure.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Successful Test of a NTLM Page", TITLE); 
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... 

... 

END_TRANSACTION(); 

 

Using the WWW Convert Options dialog box 

The fol lowing topics provide usage t ips and result ing script  examples for each of the opt ions that are 
avai lable on the Convert  Opt ions dialog box: 

Form fields as comments 
Anchors as comments 
Cl ient image maps as comments 
Debug comments 
Document t i t le veri ficat ion 
Baud rate 
Refresh t imeout 
Encode CJK characters 
Enable Visual Navigator 

Advanced opt ions: 

Cache 
Dynamic redirect handl ing 
Dynamic cookie handl ing 
Automatical ly process subrequests 
Persistent connect ions during replay 
Max concurrent connect ions 
Max connect ion retries 
Server response t imeout 
HTTP version 

Proxy HTTP version 
Act iveData 
IP spoofing 
Streaming media 
Hostnames as IP addresses 
Strip al l  cookies from request 

Generate XML requests for web services 

Traffic fi l ters 

Memory Options 

Rule Fi l ters 

 

Baud rate 

This opt ion is used to simulate slower connect ions to a Web server, such as 56 Kbps modem or DSL. 
Specify a baud rate when enabl ing baud rate emulat ion in  the Convert  Opt ions dialog box. 

The DO_SetBaudRate command is inserted in  the script  with the specified baud rate as i ts only parameter. 
If baud rate emulat ion must be asymmetric (upload rate is different than the download rate), use the 
DO_SetBaudRateEx command. DO_SetBaudRateEx takes two parameters: the upload baud rate and the 
download baud rate.  

Baud Rate (57600) – Yes 
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The fol lowing example has the Baud Rate check box selected and set to 57600. 

... 

... 

BEGIN_TRANSACTION(); 
DO_SetTransactionStart(); 
DO_SetBaudRate(57600); 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

... 

... 

Baud Rate Emulation – No 

The fol lowing example has the Baud Rate check box cleared. 

... 

... 

BEGIN_TRANSACTION(); 
DO_SetTransactionStart(); 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

Cache 

When th is opt ion is enabled, requested images are cached at playback t ime. The image cache is cleared by 
the next i terat ion of the DO_Clear command. 

Script example with the Cache option selected 

The fol lowing example has the Cache opt ion selected. 

... 

... 

BEGIN_TRANSACTION(); 
DO_Cache(TRUE); /* Enable cache */ 

... 

... 

END_TRANSACTION(); 

... 

... 
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Script example with the Cache option not selected 

The fol lowing example has the Cache check box cleared. 

... 

... 

BEGIN_TRANSACTION(); 
DO_Cache(FALSE); /* Disable cache */ 

... 

... 

END_TRANSACTION(); 

... 

... 

 

CGI forms 

CGI forms are handled by the fol lowing process. 

1. The browser requests a page that contains a CGI form. It displays the page and provides the interaction for input 
fields that the CGI form specifies. 

2. A user enters data into the CGI form and clicks the submit button. This action causes the browser to process the CGI 
form’s action statement. 

3. By processing the action statement, the browser gathers all input fields as name value pairs and passes them to a 
CGI call that the action statement contains. 

Example Web page 

The fol lowing Web page contains a CGI form with: 

!  An action statement 

!  Input fields 

!  Hidden fields 

<HTML> 
<HEAD><TITLE>Forms Example</TITLE> 
</HEAD> 
<BODY> 
<FORM ACTION="http://www.host.com/cgi-bin/perl_9.pl" method=post> 

<TABLE> 
<TR> 
<TD>Name: 
<TD><INPUT NAME="name" SIZE="20" MAXLENGTH=20> 
<TR> 
<TD>Password: 
<TD><INPUT TYPE =password NAME="password" SIZE="20" MAXLENGTH=20> 

There is a hidden field containing data here: <INPUT TYPE=hidden NAME="hidden" VALUE="This 
rocks!"> 

Here is another hidden field: <INPUT TYPE=hidden NAME="hidden1" VALUE="Web testing is fun"> 

</FORM> 
</BODY> 
</HTML> 

Example script 

QALoad automatical ly generates al l  the constructs that are necessary to make a CGI form request. 

The example includes the fol lowing features: 
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!  A DO_Http call to retrieve the forms page. 

!  Commented description of the input fields on the page. 

!  GetFormValueByName commands to retrieve the values of the hidden fields from the form. 

!  DO_SetValue calls to store the field names and their user-entered values. 

!  A DO_Http call for the CGI get request. 

char *Field[2]; 
char *ActionURL[1]; 
 
... 
... 
 
for(i=0;i<2;i++) 
Field[i]=NULL; 
 
for(i=0;i<1;i++) 
ActionURL[i]=NULL; 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

/* Request: 1 */ 

DO_Http("GET http://www.host.com/forms.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Forms Example", TITLE); 

/* ActionURL[0]="http://www.host.com/cgi-bin/perl_9.pl" */ 

DO_GetFormActionStatement(FORM(1), &ActionURL[0]); 

/* Form:1 text Name: name, Value: , Desc: */ 
/* Form:1 text Name: password, Value: , Desc: */ 
/* Form:1 hidden Name: hidden, Value: This rocks! */ 

DO_GetFormValueByName(FORM(1), "hidden", "hidden", 1, &Field[0]); 

/* Form:1 hidden Name: hidden1, Value: Web testing is fun */ 

DO_GetFormValueByName(FORM(1), "hidden", "hidden1", 1, &Field[1]); 

/* Request: 2 From: Forms Example */ 

DO_SetValue("action_statement0", ActionURL[0]); 
DO_SetValue("name", "form-name"); 
DO_SetValue("password", "form-password"); 
DO_SetValue("hidden", Field[0]); 
DO_SetValue("hidden1", Field[1]); 
DO_Http("POST {*action_statement0} HTTP/1.0\r\n" 
        "Content-Type: application/x-www-form-urlencoded\r\n" 
        "Content-Length: {*content-length}\r\n\r\n" 
        "{name}&{password}"); 

DO_VerifyDocTitle("Forms Example - Results", TITLE); 

... 

... 

for(i=0; i<2; i++) 
{ 
free(Field[i]); 
Field[i]=NULL; 
} 
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for(i=0; i<1; i++) 
{ 
free(ActionURL[i]); 
ActionURL[i]=NULL; 
} 

END_TRANSACTION(); 

 

CGI Get requests 

Get requests are handled by the fol lowing process: 

1. The browser makes a request to a server for a URL that contains a call to a CGI program. 

2. The server calls the CGI program, which usually returns a Web page. The returned page is referred to as a dynamic 
page because it is created by the CGI program. 

3. The browser accepts the resulting dynamic page and displays it. 

Example Web Page 

The fol lowing Web page contains an anchor (l ink) that references a CGI program. The reference results in  a 
CGI Get request.  

The anchor cal ls the CGI program named perl_1.pl with some parameters. In  perl_1.pl?name=FRANK, the 
quest ion mark (?) denotes the start  of parameters that need to be passed to the program. The name/value 
pair being passed to the perl_1.pl program is name=FRANK. 

When you cl ick the anchor text (dynamic HTML page), the browser makes a CGI Get request. A Get 
request, when executed by the server, passes parameters in  an environment variable to the CGI program. 
This type of parameter handl ing is l imited to 255 characters. 

<HTML> 
<HEAD> 
<TITLE> QALoad WWW Capture Examples</TITLE> 
</HEAD> 
<BODY> 
<A HREF="/cgi-bin/perl_1.pl?name=FRANK">Dynamic HTML Page</A> 
</BODY> 
</HTML> 

Example Script 

QALoad automatical ly generates al l  constructs that are necessary for a CGI Get request. The fol lowing 
script  uses a DO_Http cal l  for the CGI Get request.  

How  I t  Works: The script  processes a CGI Get request in  the same way as i t  processes URL l inks to a page. 
In the example script  below, note that the parameters passed to the Web server on the CGI cal l  are 
recorded unchanged. The parameters do not change unless the page is dynamical ly generated. 

char *Anchor[1]; 
for(i=0;i<1;i++) 
Anchor[i]=NULL; 

DO_InitHttp(s_info); 

SYNCHRONIZE(); 
BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 

/* 
* Anchor 'http://www.host.com/cgi-bin/perl_1.pl?name=FRANK' 
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* 'Dynamic HTML Page' 
*/ 

DO_GetAnchorHREF("Dynamic HTML Page", &Anchor[0]); 
DO_SetValue("Anchor000", Anchor[0]); 
DO_Http("GET {*Anchor000} HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Perl Example Page", TITLE); 

... 

... 

for(i=0; i<1; i++) 

{ 
free(Anchor[i]); 
Anchor[i]=NULL; 
} 

END_TRANSACTION(); 

 

CGI parameter encoding 

CGI (Common Gateway Interface) is widely used on World Wide Web sites to provide the abi l i ty to run 
server-side scripts that can take variable input from a Web browser. QALoad recognizes when the browser 
has communicated to a CGI si te and automatical ly creates variables for parameters whenever necessary. For 
example, many CGI submission forms contain h idden parameters that the user cannot modify, but are 
always sent in  the WWW request. Because these values can contain variable data, QALoad inserts 
statements in to the script  to store these h idden parameters in  variables and append them automatical ly to 
CGI requests. 

CGI requests also include parameters that the browser has al lowed the user to modify. For example, a CGI 
form might require a user to enter a name and address and cl ick a submit button to cont inue. QALoad does 
not automatical ly store these types of parameters in  variables, but instead provides an easy way to modi fy 
the content of the parameters that are being sent in  the CGI request via the DO_SetValue command.  

When you modify parameters that are passed into a QALoad CGI request, ensure that al l  CGI parameters 
that contain characters that are not alphanumeric (a-Z, 0-9) are encoded prior to being sent to the server. 
CGI encoding entai ls insert ing the ASCII value of a character, prefixed with the “ %”  character, in to the 
parameter. QALoad automatical ly CGI-encodes any values that i t  detects during the recording and 
conversion process; however, to manually add or modify any CGI parameter strings after your script  is 
created, you must manual ly encode special characters to ensure that the CGI parameter data is sent to the 
Web server properly. For example, to insert  the “ =”  character in to a CGI parameter, fi rst  determine i ts 
ASCII hexadecimal value (3D), and insert  that value in to the CGI parameter prefixed with “ %” . In  the CGI 
parameter string, “ %3D”  would replace “ =” . Al l  CGI parameter encoding is handled by th is method, except 
for spaces. Blank spaces must be specified in  the encoded CGI string by the character “ +” , rather than the 
ASCII value. 

QALoad provides an automatic way of performing th is encoding via the DO_EncodeString command.  

 

CGI Post requests 

Post requests are handled by the fol lowing process: 

1. The browser makes a request to a server for an HTML page that contains a form that uses an action statement with 
a Post call to a CGI program. 

2. When you click the Submit button on a CGI form, the browser makes a Post request and the server returns a Web 
page. 

3. The browser accepts the dynamic page and displays it. Because it is a CGI Post request, the browser passes the 
parameters of the program to the CGI script as command line options. 
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Example Web Page 

The fol lowing Web page contains a form that cal ls a CGI script  with a Post Request. 

<html> 
<head><title> QALoad's Perl Example Page</title> 
</head><body><center> QALoad's Perl Example Page</center> 
<form name = myform method = POST action = perl_1.pl> 
<input type = text name = yourname size = 50><br> 
<input type = submit value = "Submit Request"> 
<input type = reset> 
</form> 
</body></html> 

Example Script 

QALoad automatical ly generates al l  the constructs that are necessary for a CGI Post request. The fol lowing 
script  features a DO_HTTP request that executes a CGI Post request : 

char *ActionURL[1]; 
... 
... 
for(i=0;i<1;i++) 
ActionURL[i]=NULL; 
... 
... 
BEGIN_TRANSACTION(); 
/* Request: 1 */ 
DO_SetValue("name", "FRANK"); 
DO_Http("GET http://www.host.com/cgi-bin/perl_1.pl?{name} " 
        "HTTP/1.0\r\n\r\n"); 

DO_VerifyDocTitle(" QALoad's Perl Example Page", TITLE); 
/* ActionURL[0]="http://www.host.com/cgi-bin/perl_1.pl" */ 
DO_GetFormActionStatement(FORM(1), &ActionURL[0]); 

... 

/* Request: 2 From: QALoad's Perl Example Page */ 
DO_SetValue("action_statement0", ActionURL[0]); 
DO_SetValue("yourname", "PostFrank"); 
DO_SetValue("function", "View the log of previous visitors."); 
DO_Http("POST {*action_statement0} HTTP/1.0\r\n" 
        "Content-Type: application/x-www-form-urlencoded\r\n" 
        "Content-Length: {*content-length}\r\n\r\n" 
        "{yourname}&{function}"); 

DO_VerifyDocTitle(" QALoad's Perl Example Page", TITLE); 

... 

... 

for(i=0; i<1; i++) 
{ 
free(ActionURL[i]); 
ActionURL[i]=NULL; 
} 

END_TRANSACTION(); 

 

Debug comments 

When th is opt ion is selected, some items, such as received repl ies are placed in comment blocks in  the 
script . 

Script example with the Debug comments option selected 
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The fol lowing example has the Debug Com m ents check box selected. 

... 

... 

DO_Http("GET http://www.host.com/index.htm HTTP/1.0\r\n\r\n"); 

/* Received reply: < QALoad WWW Capture Examples> */ 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 

... 

... 

Script example with the Debug Comments option not selected 

The fol lowing example has the Debug Com m ents check box cleared. 

... 

... 

DO_Http("GET http://www.host.com/index.htm HTTP/1.0\r\n\r\n"); 
 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 

... 

... 

 

Enable Visual Navigator 

The Enable Visual Navigator opt ion enables the Visual Navigator. The Visual Navigator renders your 
recorded C-based transact ion in  a tri -paned, browser-l ike environment similar to popular visual ly-oriented 
development tools, with icons that represent al l  the elements of your script . 

Script example with the Enable Visual Navigator option selected 

When the Enable Visual  Navigator  check box is selected, the fol lowing conversion opt ions are not 
avai lable because they do not apply to Visual Navigator: 

!  Comment Options 

!  Form field as comments 

!  Anchors as comments 

!  Client Image Maps as comments 

!  Debug comments 

!  Dynamic Redirect Handling 

!  Dynamic Cookie Handling 

!  Automatically Process Sub-Requests 

!  ActiveData 

!  IP Spoofing 

!  Hostnames as IP Addresses 

Script example with the Enable Visual Navigator option not selected 

If you do not select the Enable Visual  Navigator  check box, QALoad generates a standard C script . Al l  
normal and advanced conversion opt ions apply to the script . 

 

Hostnames as IP addresses 
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When th is opt ion is selected, DO_Http and DO_Https requests include IP addresses for the requests instead 
of hostnames. This opt ion only works i f the hosts can be reached direct ly. If a host must be reached 
through a proxy, the IP address cannot be determined. 

Script example with the Hostnames as IP Addresses options selected 

The fol lowing example has the Hostnam es as IP Addresses check box selected. 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://172.22.24.39/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welcome to The Main Page", TITLE); 

... 

... 

END_TRANSACTION(); 

... 

... 

Script example with the Hostnames as IP Addresses option not selected 

The fol lowing example has the Hostnam es as IP Addresses check box cleared. 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welcome to The Main Page", TITLE); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

HTTP version  

A WWW script can be set to 1.1 or 1.0. When set to 1.1, al l  requests and subrequests are sent as HTTP/1.1. 
When set to 1.0, al l  HTTP requests and subrequests are sent as HTTP/1.0.  

The fol lowing example has the HTTP Version field set to 1.0. 

... 

... 

BEGIN_TRANSACTION(); 
DO_HTTPVersion("1.0"); 

... 

... 

END_TRANSACTION(); 

... 

... 
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IP spoofing 

By default , QALoad searches for the fi le ipspoof.dat in  the Datapools directory. You can override th is 
behavior by providing a different fi le name as the parameter to the DO_IPSpoofEnable command in the 
converted script . For example: 

DO_IPSpoofEnable("myaddresses.dat"); 

Script example with the IP Spoofing option selected 

The fol lowing example has the IP Spoofing check box selected. 

... 

... 

DO_InitHttp(s_info); 
DO_IPSpoofEnable(""); 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

Script example with the IP Spoofing option not selected 

The fol lowing example has the IP Spoof ing check box cleared. 

... 

... 

DO_InitHttp(s_info); 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

END_TRANSACTION(); 

... 

... 

Max concurrent connect ions 

This field indicates the maximum number of connect ions that a DO_Http or DO_Https command wil l  
open to the server at any t ime. These simultaneous connect ions are only used i f sub-request ing is enabled. 

The fol lowing example has the Max Concurrent Connect ions field set at 4. 

... 

... 

BEGIN_TRANSACTION(); 
DO_SetTransactionStart(); 
DO_SetMaxBrowserThreads(4); 

... 

... 
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/* Request: 1 */ 
DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welcome to QAWEBSERV", TITLE); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

Max connect ion retries 

This field specifies the number of t imes during replay that QALoad wil l  at tempt to connect to the server 
after t im ing out. The fol lowing example has the M ax Connect ion  Ret ries field set at 4. 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_SetMaximumRetries(4); 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welcome to QAWEBSERV", TITLE); 

... 

... 

 

Persistent connect ions during replay 

This is an opt ion placed in the script  to be used at replay t ime. During replay, QALoad attempts to keep the 
connect ion to the Web server open for each DO_Http request that is sent to the server. 

Script example with the Persistent Connections During Replay option selected 

The fol lowing example has the Persisten t  connect i ons during replay  check box selected. 

... 

... 

BEGIN_TRANSACTION(); 
DO_UsePersistentConnections(TRUE); 

... 

... 

END_TRANSACTION(); 

... 

... 

Script example with the Persistent Connections During Replay option not selected 

The fol lowing example has the Persisten t  connect i ons during replay  check box cleared. 

... 

... 
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BEGIN_TRANSACTION(); 
DO_UsePersistentConnections(FALSE); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

Reuse SSL session ID 

This opt ion is avai lable only on an SSL instal lat ion of QALoad . By default , th is opt ion is not selected and 
SSL session IDs are not re-used, which reflects standard browser behavior. If your appl icat ion re-uses SSL 
session IDs, consider select ing th is opt ion. 

The Reuse SSL session ID opt ion is used by the replay engine at replay t ime and the current session ’s ID is 
re-used for al l  the requests with in the transact ion. 

Script example with the Reuse SSL Session ID option selected 

The fol lowing example has the Reuse SSL session  ID  check box selected. 

... 

... 

SYNCHRONIZE(); 

/* Select following statement for reuse of Session ID with */ 
/* SSL. If session ID needs only to be reused within */ 
/* a transaction insert after the BEGIN_TRANSACTION */ 
/* statement */ 
 
/* DO_SSLReuseSession(TRUE); */ 

BEGIN_TRANSACTION(); 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/subs.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Page Of Subs", TITLE); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

Script example with the Reuse SSL Session ID not selected 

The fol lowing example has the Reuse SSL session  ID  check box cleared. 

... 

... 

SYNCHRONIZE(); 

/* Select following statement for reuse of Session ID */ 
/* with SSL. If session ID needs only to be reused within */ 
/* a transaction, insert after the BEGIN_TRANSACTION */ 
/* statement */ 
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/* DO_SSLReuseSession(FALSE); */ 

BEGIN_TRANSACTION(); 

... 

... 

/* Request: 1 */ 

DO_Http("GET http://www.host.com/subs.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Page Of Subs", TITLE); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

Server response t imeout 

This field specifies, in  seconds, the length of t ime during replay that QALoad wil l  wait  for data from the 
server before t im ing out. The fol lowing example has the Server Response Tim eout  field set at 120. 

... 

... 

DO_InitHttp(s_info); 
DO_SetTimeout(120); /* Maximum time to wait for HTTP Reply */ 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welcome to QAWEBSERV", TITLE); 

... 

... 

 

Strip al l  cookies from request 

When th is opt ion is selected, no cookies wil l  be sent in  the DO_Http requests. 

Script example with the Strip All Cookies From Request option selected 

The fol lowing example has the Strip Al l  Cook ies From  Request  check box selected. 

... 

... 

DO_Http("GET http://qawebserv.compuware.com/cgi-bin/cookies5.pl HTTP/1.0\r\n\r\n"); 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl HTTP/1.0\r\n\r\n"); 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl HTTP/1.0\r\n\r\n"); 

... 

... 

Script example with the Strip All Cookies From Request option not selected 

The fol lowing example has the Strip Al l  Cook ies From  Request  check box cleared. 
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... 

... 

DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl HTTP/1.0\r\n Cookie: 
username=username\r\n\r\n"); 

... 

... 

 

Traffic fi l ters 

The Traffic Fi l ters dialog box enables you to determine which traffic should be included or blocked from 
your script . This dialog box is accessed by the Traffic Fi l ters button on the WWW Advanced dialog box. 

Script example with a traffic fi l ter set 

In  the fol lowing example, a traffic fi l ter has been set to exclude requests with URLs that contain the string 
“ www.host.com ” . 

... 

... 

DO_InitHttp(s_info); 

... 

... 

/* Exclude requests with URLs containing */ 
DO_BlockRequestsFrom("www.host.com;"); 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://rm.host.com:8099/ramgen/realmp3.mp3 " 
        "HTTP/1.0\r\n" 
        "Referer: http://www.host.com/index.htm\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

... 

... 

Script example without a traffic fil ter set 

The fol lowing example does not use traffic fi l ters. 

... 

... 

DO_InitHttp(s_info); 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welcome to The Main Page", TITLE); 
DO_Http("GET http://www.host.com/index.htm HTTP/ 1.0\r\n\r\n"); 
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DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 
DO_Http("GET http://rm.host.com:8099/ramgen/realmp3.mp3 HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

Anchors as comments 

Anchors as comments 

When th is opt ion is selected, al l  anchors are placed in comment blocks in  the script . 

Example Web page 
Script example with opt ion selected 
Script example with opt ion not selected 

Example Web Page 

<HTML> 
<HEAD> 
<TITLE> QALoad WWW Capture Examples</TITLE> 
</HEAD> 

<BODY> 
<HR> 
<IMG SRC="../logo.gif" ALIGN=LEFT width="127" height="129"> 
<IMG SRC="../logo.gif" ALIGN=RIGHT width="127" height="129"> 

<BR><BR> 

<CENTER><H2><EM> QALoad WWW Capture Examples</EM></H2> 
<A HREF=../default.htm><h3>Return to welcome homepage.</h3></A> 

<BR></CENTER><HR> 

<CENTER> 
<TABLE CELLSPACING="10"> 

<TR> 
<TH ALIGN=left>LINK: 
<TH ALIGN=left>DESCRIPTION: 

<TR> 
<TD><A HREF="../standard.htm">Standard HTML Homepage</A></TD> 
<TD>Static page w/ images (.GIF 87a, 89a), sound files (.WAV), and assorted links</TD> 
 
<TR> 
<TD><a href="../subs.htm">Multiple Inline Images Page</a></TD> 
<TD>Static page with 16 inline images</TD> 
</TABLE> 

</CENTER> 
</BODY> 
</HTML> 

Script example with the Anchors as comments option selected 

The fol lowing example has the Anchors as com m ents check box selected. 

 

... 

... 
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/* Declare Variables */ 

int i; 

char *Anchor[1]; 

... 

... 

for(i=0;i<1;i++) 

Anchor[i]=NULL; 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

/* Request: 1 */ 

DO_Http("GET http://www.host.com/index.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 

/* Anchors 'http://www.host.com/default.htm' 'Return to welcome homepage.' */ 
/* Anchors 'http://www.host.com/standard.htm' 'Standard HTML Homepage' */ 

DO_GetAnchorHREF( "Standard HTML Homepage", &Anchor[0]); 

/* Anchors 'http://www.host.com/subs.htm' 'Multiple Inline Images Page' */ 
 
/* Request: 2 To: Standard HTML Homepage From: QALoad WWW Capture Examples */ 

/* Variable: Anchor000 links to: Standard HTML Homepage on page: QALoad WWW Capture Examples 
*/ 

DO_SetValue("Anchor000", Anchor[0]); 
DO_Http("GET {*Anchor000} HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("\"Standard HTML Example\"", TITLE); 

... 

... 

for(i=0; i<1; i++) 
{ 
free(Anchor[i]); 
Anchor[i]=NULL; 
} 

Script example with the Anchors as comments option not selected 

The fol lowing example has the Anchors as com m ents check box cleared. 

... 

... 

/* Declare Variables */ 
int i; 
char *Anchor[1]; 

... 

... 

for(i=0; i<1; i++) 
Anchor[i]= NULL; 

... 

... 

BEGIN_TRANSACTION(); 
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... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/index.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 
DO_GetAnchorHREF( "Standard HTML Homepage", &Anchor[0]); 

/* Request: 2 To: Standard HTML Homepage From: QALoad WWW Capture Examples */ 
/* Variable: Anchor000 links to: Standard HTML Homepage on page: QALoad WWW Capture Examples 
*/ 

DO_SetValue("Anchor000", Anchor[0]); 
DO_Http("GET {*Anchor000} HTTP/1.0\r\n\r\n"); 

... 

... 

for(i=0; i<1; i++) 
{ 
free(Anchor[i]); 
Anchor[i]=NULL; 
} 

 

Automatical ly process subrequests 

Automatically process subrequests 

This is a playback opt ion. When th is opt ion is selected, subrequests (such as .jpg, .gi f, .css, and .js) are not 
included in the script  during conversion, and playback makes the requests at run t ime. 

Example Web page 
Script example with opt ion selected 
Script example with opt ion not selected 

Example Web page 

<html> 
<head> 
<title>Page Of Subs</title> 
</head> 
<body> 
<p>The page of subrequests</p> 
<p>.<img border="0" src="win2000.gif" width="456" height="124"><img border="0" 
src="APACHE.GIF" width="259" height="32"><img border="0" src="banner.gif" width="470" 
height="64"><img border="0" src="COLORS.GIF" width="200" height="100"></p> 
</body> 
</html> 

Script example with the Automatically Process Subrequests option selected 

The fol lowing example has the Autom at i cal l y Process Subrequests check box selected. 

... 

... 

BEGIN_TRANSACTION(); 
DO_AutomaticSubRequests(TRUE); 

... 

... 

DO_Http("GET http://www.host.com/subs.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Page Of Subs", TITLE); 

... 

... 
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END_TRANSACTION(); 

... 

... 

Script example with the Automatically Process Subrequests option not selected 

The fol lowing example has the Autom at i cal l y Process SubRequests check box cleared. 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_AutomaticSubRequests(FALSE); 

... 

... 

DO_Http("GET http://www.host.com/subs.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Page Of Subs", TITLE); 

/* Request: 2 From: Page Of Subs */ 
DO_Http("GET http://www.host.com/win2000.gif HTTP/1.0\r\n\r\n"); 

/* Request: 3 From: Page Of Subs */ 
DO_Http("GET http://www.host.com/web.gif HTTP/1.0\r\n\r\n"); 

/* Request: 4 From: Page Of Subs */ 
DO_Http("GET http://www.host.com/APACHE.GIF HTTP/1.0\r\n\r\n"); 

/* Request: 5 From: Page Of Subs */ 
DO_Http("GET http://www.host.com/COLORS.GIF HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

Cl ient image maps as comments 

Client image maps as comments 

When th is opt ion is selected, al l  cl ient image maps are placed with in comment blocks in  the script . 

Example Web page 
Script example with opt ion selected 
Script example with opt ion not selected 

Example Web Page 

<html><head></head><body> 

<center><h2>Client-side version of clickable imagemap</h2> 

Click on one of the fields contained in the image to access the associated link. 

<MAP NAME="title"> 
<AREA SHAPE="rect" COORDS="1,108,115,124" HREF="sup.htm"></AREA> 
<AREA SHAPE="rect" COORDS="119,107,234,124" HREF="reg.htm"></AREA> 
<AREA SHAPE="rect" COORDS="235,107,352,124" HREF="fea.htm"></AREA> 
<AREA SHAPE="rect" COORDS="353,107,466,124" HREF="tech.htm"></AREA> 
<AREA SHAPE="rect" COORDS="0,127,156,144" HREF="htmlsam.htm"></AREA> 
<AREA SHAPE="rect" COORDS="157,127,312,144" HREF="exampro.htm"></AREA> 
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<AREA SHAPE="rect" COORDS="313,127,466,144" HREF="feedback.htm"></AREA> 
<AREA SHAPE="rect" COORDS="0,0,466,143" HREF="invalid.htm"></AREA> 
</MAP> 

<P> 

<IMG SRC="title.gif" BORDER="0" ALT="[Netscape FastTrack Server 2.0]" USEMAP="#title" 
width="468" height="145"> 

</center> 
</body></html> 

Script example with the Client Image Maps as Comments option selected 

The fol lowing example has the Cl ien t  Im age M aps as Com m ents check box selected. 

... 

... 

for(i=0;i<1;i++) 
ClientMapURL[i]= NULL; 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/ismap.htm HTTP/1.0\r\n\r\n"); 

/* Client Map:1 Region:1 HREF: http://www.host.com/sup.htm */ 
/* Client Map:1 Region:2 HREF: http://www.host.com/reg.htm */ 

DO_GetClientMapHREF(MAP(1), REGION(2), &ClientMapURL[0]); 

/* Client Map:1 Region:3 HREF: http://www.host.com/fea.htm */ 
/* Client Map:1 Region:4 HREF: http://www.host.com/tech.htm */ 
/* Client Map:1 Region:5 HREF: http://www.host.com/htmlsam.htm */ 
/* Client Map:1 Region:6 HREF: http://www.host.com/exampro.htm */ 
/* Client Map:1 Region:7 HREF: http://www.host.com/feedback.htm*/ 
/* Client Map:1 Region:8 HREF: http://www.host.com/invalid.htm */ 

/* Request: 2 */ 
DO_SetValue("ClientMap000", ClientMapURL[0]); 
DO_Http("GET {*ClientMap000} HTTP/1.0\r\n\r\n"); 

... 

... 

for(i=0; i<1; i++) 
{ 
free(ClientMapURL[i]); 
ClientMapURL[i]=NULL; 
} 

END_TRANSACTION(); 

... 

Script example with the Client Image Maps as Comments options not selected 

The fol lowing example has the Cl ien t  Im age M aps as Com m ents check box cleared. 

... 

... 

for(i=0; i<1; i++) 
ClientMapURL[i]= NULL; 

... 

... 

/* Request: 1 */ 
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DO_Http("GET http://www.host.com/ismap.htm HTTP/1.0\r\n\r\n"); 
DO_GetClientMapHREF(MAP(1), REGION(2), &ClientMapURL[0]); 

/* Request: 2 */ 

DO_SetValue("ClientMap000", ClientMapURL[0]); 
DO_Http("GET {*ClientMap000} HTTP/1.0\r\n\r\n"); 

... 

... 

for(i=0; i<1; i++) 
{ 
free(ClientMapURL[i]); 
ClientMapURL[i]= NULL; 
} 

END_TRANSACTION(); 

... 

... 

 

Document t i t le veri ficat ion 

Document title verification 

There are three supported methods for veri fying a document t i t le, which are shown in the fol lowing 
sect ions. Document t i t le veri ficat ion can be a good tool for detect ing and handl ing error messages that are 
returned in an HTML page. You can veri fy a document t i t le by searching for the Ent i re Docum en t  Ti t l e, 
the Pref i x  of the document t i t le, or the Suff i x  of the document t i t le. The fol lowing is an example of a 
search for the Ent ire document t i t le. 

Example Web page 
Script examples with opt ion selected 
Script examples with opt ion not selected 

Example Web Page 

<HTML> 
<HEAD> 
<title>Welcome to The Main Page</title> 
</head> 
<body> 
<p> 

<A href="index.htm">WWW Capture Examples</A> (relative link) 

</p> 
</body> 
</HTML> 

Script example with the Document Title Verification option selected 

The fol lowing example has the Docum en t  Ti t l e Veri f i cat ion  check box selected and compares by the 
ent ire document t i t le. 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welcome to The Main Page", TITLE); 

... 

... 

Script example that matches the first 5 characters 
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The fol lowing example compares by prefix. 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welco", PREFIX); 
DO_SetTransactionCleanup(); 

... 

... 

Script example that matches the last 4 characters 

The fol lowing example compares by suffix. 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Page", SUFFIX); 
DO_SetTransactionCleanup(); 

... 

... 

Document Title Verification – No 

The fol lowing example has the Docum en t  Ti t l e Veri f i cat ion  check box cleared. 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_SetTransactionCleanup(); 

... 

... 

 

Dynamic cookie handl ing 

Dynamic cookie handling 

This is a playback opt ion. When th is opt ion is selected, the script  does not have any cookie-specific 
in formation and playback deals with dynamic cookies at run t ime. 

Example Web page 
Script example with opt ion selected 
Script example with opt ion not selected 

Example Web page 

The cookies for th is si te are: 

Set-Cookie: SaneID=172.22.24.180-4728804960004 
Set-Cookie: SITESERVER=ID=f0544199a6c5970a7d087775f83b23af 

<html> 
<head></head> 
<body> 
<br>RELOAD PAGE TO INCREMENT COUNTER<br><br> 
</body> 
</html> 

Script example with the Dynamic Cookie Handling option selected 

The fol lowing example has the Dynam ic Cook ie Handl ing check box cleared. 
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... 

... 

BEGIN_TRANSACTION(); 
DO_DynamicCookieHandling(TRUE); 

... 

... 

DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl HTTP/1.0\r\n\r\n"); 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

... 

... 

Script example with the Dynamic Cookie Handling option not selected 

The fol lowing example has the Dynam ic Cook ie Handl ing check box cleared. 

... 

... 

char *Cookie[4]; 

... 

... 

for(i=0;i<2;i++) 
Cookie[i]=NULL; 

... 

... 

BEGIN_TRANSACTION(); 
DO_DynamicCookieHandling(FALSE); 

... 

... 

DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl HTTP/1.0\r\n\r\n"); 

/*Set-Cookie: NUM=1 */ 
DO_GetCookieFromReplyEx("NUM", &Cookie[0], '*'); 

/*Set-Cookie: SQUARE=1 */ 
DO_GetCookieFromReplyEx("SQUARE", &Cookie[1], '*'); 

/* Request: 2 */ 
DO_SetValue("cookie000", Cookie[0]); /* NUM=1 */ 
DO_SetValue("cookie001", Cookie[1]); /* SQUARE=1 */ 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl HTTP/1.0\r\n Cookie: {*cookie000}; 
{*cookie001}\r\n\r\n"); 

... 

... 

DO_HttpCleanup(); 
for(i=0; i<2; i++) 
{ 
free(Cookie[i]); 
Cookie[i]=NULL; 
} 

END_TRANSACTION(); 

... 

... 
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Dynamic redirect handl ing 

Dynamic redirect handling 

This is a playback opt ion. When Dynamic redirect handl ing is enabled, playback automatical ly handles the 
redirect ion. 

Consider a Web page with a l ink to 'Redirected Webpage' (http:/ /www.host.com/cgi-bin/dynredir.exe). 
When th is l ink is cl icked, the server generates a 302 return value with a new redirected locat ion of 
http:/ /172.22.24.39/cgi-bin/aperl_8.pl. 

Script  example with opt ion selected 
Script example with opt ion not selected 

Script example with the Dynamic Redirect Handling option selected 

When th is opt ion is selected, the script  only contains the request for http:/ /www.host.com/cgi-
bin/dynredir.exe and replay handles the 302 return value and cal ls http:/ /172.22.24.39/cgi-bin/aperl_8.pl 
automatical ly. 

The fol lowing example has the Dynam ic Redi rect  Handl ing check box selected. 

... 

... 

/* Declare Variables */ 
int i; 
char *Anchor[1]; 

... 

... 

for(i=0;i<1;i++) 
Anchor[i]=NULL; 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_DynamicRedirectHandling(TRUE); 

... 

... 

DO_Http("GET http://www.host.com/index.htm HTTP/""1.0\r\n\r\n"); 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 

... 

... 

DO_GetAnchorHREF( "Redirected Webpage", &Anchor[0]); 

... 

... 

DO_SetValue("Anchor000", Anchor[0]); 
DO_Http("GET {*Anchor000} HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Successful Test of Dynamic Redirect Sample", TITLE); 

... 

... 

for(i=0; i<1; i++) 
{ 
free(Anchor[i]); 
Anchor[i]=NULL; 
} 
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END_TRANSACTION(); 

... 

... 

Script example with the Dynamic Redirect Handling option not selected 

In  th is example, the script  contains the request for http:/ /www.host.com/cgi-bin/dynredir.exe as well  as 
http:/ /172.22.24.39/cgi-bin/aperl_8.pl. The fol lowing example has the Dynam ic Redi rect  Handl ing check 
box cleared. 

... 

... 

/* Declare Variables */ 
int i; 
char *Anchor[1]; 

... 

... 

for(i=0;i<1;i++) 
Anchor[i]=NULL; 

... 

... 

BEGIN_TRANSACTION(); 
DO_DynamicRedirectHandling(FALSE); 

... 

... 

DO_Http("GET http://www.host.com/index.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 
DO_GetAnchorHREF( "Redirected Webpage", &Anchor[0]); 
DO_SetValue("Anchor000", Anchor[0]); 
DO_Http("GET {*Anchor000} HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Document Moved", TITLE); 
DO_Http("GET http://www.host.com/redir/frm.pl HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Successful Test of Dynamic Redirect Sample", TITLE); 
DO_SetTransactionCleanup(); 

/* Clear up some internal storage used for DO_SetValue() */ 
DO_HttpCleanup(); 
for(i=0; i<1; i++) 
{ 
free(Anchor[i]); 
Anchor[i]=NULL; 
} 

END_TRANSACTION(); 

... 

... 

 

Encode DBCS characters 

Encode CJK characters 

When th is opt ion is selected, the double-byte characters used for Chinese, Japanese, and Korean (CJK) 
scripts are converted in to octal format. Since CJK characters use Double Byte Character Sets (DBCS), 
encoding must be enabled for a capture with CJK characters, so that the double-byte characters can be 
viewed in a legible format . 
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Example Web page 
Example script  with opt ion selected 
Example script  with opt ion not selected 

Example Web page 

<html> 
<head> 

<title>  </title> 
<meta http-equiv="Content-type" content="text/html; charset=euc-kr"> 
<meta http-equiv="Cache-Control" content="no-cache"> 
<meta http-equiv="Pragma" content="no-cache"> 
<meta http-equiv="Expires" content="Wed, 04 Jul 1973 16:00:00 GMT"> 

<!--CSS--> 
<style type='text/css'> 
</style> 

<!--/CSS--> 
</head> 
<body onload="document.search.p.focus();" topmargin=8> 

... 

... 

</body> 
</html> 

Script example with the Represent CJK as Octal Characters option selected 

The fol lowing example has the Represen t  CJK as Octal  Characters check box selected. 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://kr.yahoo.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("\276\337\310\304!\304\332\270\256\276\306", TITLE); 

... 

... 

Script example with the Represent CJK as Octal Characters option not selected 

The fol lowing example has the Represen t  CJK as Octal  Characters check box cleared. 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://kr.yahoo.com/ HTTP/1.0\r\n\r\n"); 

DO_VerifyDocTitle( , TITLE); 
 
... 
... 

Form field as comments 

Form field as comments 

When th is opt ion is selected, al l  forms and their fields are placed in comment blocks in  the script . 

Example Web page 
Script example with opt ion selected 
Script example with opt ion not selected 

 



QALoad Online Help 

81 

Example Web page 

<!DOCTYPE HTML PUBLIC "-//AdvaSoft//DTD HTML 3.2 extended 961018//EN"> 
<HTML> 
<HEAD> 
  <TITLE>Forms Example</TITLE> 
</HEAD> 

<BODY BGCOLOR="#7093DB"> 
<H2 ALIGN=center>Example of HTTP&nbsp;Forms</H2> 
<BR> 
<FORM ACTION="/cgi-bin/perl_9.pl" method=post> 
<TABLE> 
 
<TR> 
<TD>Name: 
<TD><INPUT NAME="name" SIZE="20" MAXLENGTH=20> 
 
<TR> 
<TD>Password: 
<TD><INPUT TYPE =password NAME="password" SIZE="20" MAXLENGTH=20> 

<TR> 
<TD>E-Mail Address: 
<TD><INPUT NAME= "e-mail" SIZE = "40" MAXLENGTH=80> 
<TR> 
<TD>Address: 
<TD><INPUT TYPE = text NAME = "Address" SIZE = "40" MAXLENGTH=40> 
 
<TR> 
<TD>City: 
<TD><INPUT NAME="city" SIZE="40" MAXLENGTH=40> 
<TD ALIGN=left>State: 
<TD ALIGN=left><INPUT NAME="state" SIZE="2" MAXLENGTH=2 ALIGN=left> 
<TD ALIGN=left>Zip: 
<TD ALIGN=left><INPUT NAME="zip" SIZE="5" MAXLENGTH=5> 
 
<TR> 
<TD VALIGN=top>Favorite Color: 
<TD><SELECT NAME="options"> 
<OPTION>Red 
<OPTION>Orange 
<OPTION>Yellow 
<OPTION>Green 
<OPTION selected=on>Blue 
<OPTION>Indigo</OPTION> 
<OPTION>Violet</OPTION> 
</SELECT> 
 
<TR> 
 
<TR> 
<TD VALIGN=top>Color of your money: 
<TD><SELECT NAME="dates" multiple="multiple"> 
<OPTION selected=on>Red 
<OPTION>Blue 
<OPTION>Green</OPTION> 
<OPTION>Beige</OPTION> 
</SELECT> 

<TR> 
<TD VALIGN=top>Comments: 
<TD><TEXTAREA NAME="comments" COLS=40 ROWS=5></TEXTAREA> 
</TABLE> 

<BR><INPUT TYPE=checkbox CHECKED NAME="echo">Echo a copy of the result HTML Page to E-
mail<BR><BR> 
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<P> 
 
<TABLE> 
 
<TR> 
<TD VALIGN=top>Testing: 
<TD><INPUT TYPE=radio CHECKED NAME="test" VALUE="capture">Capture<BR> 
<INPUT TYPE=radio NAME="test" VALUE="replay">Replay<BR> 
<INPUT TYPE=radio NAME="test" VALUE="loadtest">Loadtest<BR> 
 
<TR> 

<TR> 
<TD>Web page to append to reply: 
<TD><INPUT TYPE=file NAME="web page"> 
</TABLE> 

<BR> 

There is a hidden field containing data here: <INPUT TYPE=hidden NAME="hidden" VALUE="This 
rocks!"> 
Here is another hidden field: <INPUT TYPE=hidden NAME="hidden1" VALUE="Web testing is fun"> 

<BR><BR> 

<TABLE ALIGN=center> 
<TR> 
<TD ALIGN=center>Don't Click This 
 
<TR> 
<TD><INPUT TYPE=image SRC="colors.gif" width="200" height="100"> 
</TABLE> 

<TABLE ALIGN=center> 
<TR> 
<TD ALIGN=center>Don't Click This 

<TR> 
<TD><INPUT TYPE=image SRC="eye.gif" width="80" height="60"> 
</TABLE> 

<TABLE ALIGN=center> 
<TR> 
<TD ALIGN=center>Don't Click This 
 
<TR> 
<TD><INPUT TYPE=image SRC="devplatform.gif" width="48" height="43"> 
</TABLE> 

<TABLE ALIGN=center> 
<TR> 
<TD ALIGN=center>Don't Click This 

<TR> 
<TD><INPUT TYPE=image SRC="enterprise_sm.gif" width="42" height="41"> 
</TABLE> 

<BR> 

<TABLE ALIGN=center> 
<TR> 
<TD><INPUT TYPE=submit NAME="submit"> 
<TD><INPUT TYPE=reset> 
</TABLE> 

</FORM> 

</BODY> 
</HTML> 
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Script example with Form field as comments option selected  

The fol lowing example has the Form  f ield as com m ents check box selected. 

... 

... 

/* Declare Variables */ 
int i; 
char *Field[2]; 
char *ActionURL[1]; 

... 

... 

for(i=0; i<2; i++) 
Field[i]= NULL; 
for(i=0; i<1; i++) 
ActionURL[i]= NULL; 

... 

... 

/* Request: 1 */ 

DO_Http("GET http://www.host.com/forms.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Forms Example", TITLE); 

/* ActionURL[0]="http://www.host.com/cgi-bin/perl_9.pl" */ 
DO_GetFormActionStatement(FORM(1), &ActionURL[0]); 

/* Form:1 text Name: name, Value: */ 
/* Form:1 text Name: password, Value: */ 
/* Form:1 text Name: e-mail, Value: */ 
/* Form:1 text Name: Address, Value: */ 
/* Form:1 text Name: city, Value: */ 
/* Form:1 text Name: state, Value: */ 
/* Form:1 text Name: zip, Value: */ 
/* Form:1 select Name: options, Value: */ 
/* Form:1 select Name: options, Value: */ 
/* Form:1 select Name: options, Value: */ 
/* Form:1 select Name: options, Value: */ 
/* Form:1 select Name: options, Value: */ 
/* Form:1 select Name: options, Value: */ 
/* Form:1 select Name: options, Value: */ 
/* Form:1 select Name: dates, Value: */ 
/* Form:1 select Name: dates, Value: */ 
/* Form:1 select Name: dates, Value: */ 
/* Form:1 select Name: dates, Value: */ 
/* Form:1 text Name: comments, Value: */ 
/* Form:1 checkbox Name: echo, Value: */ 
/* Form:1 radio Name: test, Value: capture, */ 
/* Form:1 radio Name: test, Value: replay, */ 
/* Form:1 radio Name: test, Value: loadtest, */ 
/* Form:1 *unknown* Name: web page, Value: , */ 

/* Form:1 hidden Name: hidden, Value: This rocks!, */ 
DO_GetFormValueByName(FORM(1), "hidden", "hidden", 1, &Field[0]); 

/* Form:1 hidden Name: hidden1, Value: Web testing is fun */ 
DO_GetFormValueByName(FORM(1), "hidden", "hidden1", 1, &Field[1]); 

/* Form:1 *unknown* Name: , Value: */ 
/* Form:1 *unknown* Name: , Value: */ 
/* Form:1 *unknown* Name: , Value: */ 
/* Form:1 *unknown* Name: , Value: */ 
/* Form:1 submit Name: submit, Value: */ 
/* Form:1 *unknown* Name: , Value: */ 

/* Request: 2 From: Forms Example */ 
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DO_SetValue("action_statement0", ActionURL[0]); 
DO_SetValue("name", "joe"); 
DO_SetValue("password", ""); 
DO_SetValue("e-mail", ""); 
DO_SetValue("Address", ""); 
DO_SetValue("city", ""); 
DO_SetValue("state", ""); 
DO_SetValue("zip", ""); 
DO_SetValue("options", "Blue"); 
DO_SetValue("dates", "Red"); 
DO_SetValue("comments", ""); 
DO_SetValue("echo", "on"); 
DO_SetValue("test", "capture"); 
DO_SetValue("web+page", ""); 
DO_SetValue("hidden", Field[0]); 
DO_SetValue("hidden1", Field[1]); 
DO_SetValue("submit", "Submit Query"); 
DO_Http("POST {*action_statement0} HTTP/1.0\r\n" 
        "Content-Type: application/x-www-form-urlencoded\r\n" 
        "Content-Length: {*content-length}\r\n\r\n" 
        "{name}&{password}&{e-mail}&{Address}&{city}&{state}&" 
        "{zip}&{options}&{dates}&{comments}&{echo}&{test}&" 
        "{web+page}&{hidden}&{hidden1}&{submit}"); 
... 
... 

Script example Form field as comments option not selected 

The fol lowing example has the Form  f ield as com m ents check box cleared. 

... 

... 

/* Declare Variables */ 
int i; 
char *Field[2]; 
char *ActionURL[1]; 

... 

... 

for(i=0; i<2; i++) 
Field[i]= NULL; 
for(i=0; i<1; i++) 
ActionURL[i]= NULL; 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/forms.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Forms Example", TITLE); 
DO_GetFormActionStatement(FORM(1), &ActionURL[0]); 
DO_GetFormValueByName(FORM(1), "hidden", "hidden", 1, &Field[0]); 
DO_GetFormValueByName(FORM(1), "hidden", "hidden1", 1, &Field[1]); 

/* Request: 2 From: Forms Example */ 
DO_SetValue("action_statement0", ActionURL[0]); 
DO_SetValue("name", "joe"); 
DO_SetValue("password", ""); 
DO_SetValue("e-mail", ""); 
DO_SetValue("Address", ""); 
DO_SetValue("city", ""); 
DO_SetValue("state", ""); 
DO_SetValue("zip", ""); 
DO_SetValue("options", "Blue"); 
DO_SetValue("dates", "Red"); 
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DO_SetValue("comments", ""); 
DO_SetValue("echo", "on"); 
DO_SetValue("test", "capture"); 
DO_SetValue("web+page", ""); 
DO_SetValue("hidden", Field[0]); 
DO_SetValue("hidden1", Field[1]); 
DO_SetValue("submit", "Submit Query"); 
DO_Http("POST {*action_statement0} HTTP/1.0\r\n" 
        "Content-Type: application/x-www-form-urlencoded\r\n" 
        "Content-Length: {*content-length}\r\n\r\n" 
        "{name}&{password}&{e-mail}&{Address}&{city}&{state}" 
        "&{zip}&{options}&{dates}&{comments}&{echo}&{test}" 
        "&{web+page}&{hidden}&{hidden1}&{submit}"); 

... 

... 

for(i=0; i<2; i++) 
{ 
free(Field[i]); 
Field[i]=NULL; 
} 

for(i=0; i<1; i++) 
{ 
free(ActionURL[i]); 
ActionURL[i]=NULL; 
} 

... 

... 

 

Refresh t imeout 

Refresh timeout 

When th is opt ion is selected, the t ime value that you specify in  the seconds field is compared to a Web 
page’s META Refresh value (e.g. <META HTTP-EQUIV=Refresh CONTENT=” 10” ; 
URL=” http:/ /www.compuware.com ” >). If the META Refresh tag’s CONTENT field value is less than the 
t ime value you specify, the page is treated as a redirected page. If the CONTENT field value is greater than 
the t ime you specify, the page is treated as a regular page. 

This opt ion is useful for avoiding in fin i te loops in  the script . In fin i te loops can occur i f a page refreshes 
periodical ly to update data. 

Example Web page 
Script example with opt ion selected 
Script example with opt ion not selected 

Example Web page 

<html> 
<head> 
<title>Just Wait</title> 
<meta http_equiv=refresh content=”5;url=/path/to/realpage.pl”> 
</head> 
<body> 
<h2>Loading the real page</h2> 
</body> 
</html> 

Script example with the Refresh Timeout option selected 

The fol lowing example has the Refresh  Tim eout  check box selected and is set  to a value greater than 5. 
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... 

... 

DO_SetTransactionStart(); 
DO_SetRefreshTimeout(10); 
DO_SetMaxBrowserThreads(2); 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://host/path/to/page.pl HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("You have reached the final page!!", TITLE); 

Script example with Refresh Timeout option not selected 

The fol lowing example has the Refresh  Tim eout  check box cleared. The example also appl ies to having 
the opt ion selected and set to a value less than 5. 

... 

... 

BEGIN_TRANSACTION(); 
DO_SetTransactionStart(); 
DO_SetMaxBrowserThreads(2); 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://host/path/to/page.pl HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Just Wait", TITLE); 
DO_SLEEP(5); 

/* Request: 2 */ 
DO_Http("GET http://host/path/to/realpage.pl HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("You have reached the final page!!", TITLE); 

 

Streaming media 

Streaming media 

QALoad supports two types of streaming media: 

!  RealOne Player 

!  Windows Media Player 

When streaming media conversion is enabled and you record a transact ion that cal ls streaming media, an 
addit ional command is inserted in to the script  that requests the media. You do not have to l isten to or 
view the ent ire media you are request ing; just record i ts URL and ensure that the appropriate media player 
is instal led on the QALoad Player machines that wi l l  execute playback of the script . At run t ime, the script  
invokes the media player and requests the streaming media resource. 

Note: Streaming media is not supported through firewalls and across proxies. 

Advanced RealOne Player media opt ions 
Script examples with opt ion selected 
Script examples with opt ion not selected 

Advanced RealOne Player media options 

The fol lowing statements are examples of how addit ional RealOne Player streaming media commands can 
be used in a script . 

!  void ShowMediaRP(BOOL displayAudio, BOOL displayVideo); 
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Enable/disable cl ient audio and video for RealNetworks Streaming Media. 

!  void EnableStatisticsRP(int statisticFlags, int interval, BOOL traceOutput); 

Enable cl ient-side performance stat ist ics for RealNetworks Streaming Media. 

!  void DisableStatisticsRP(void); 

Disable cl ient side performance stat ist ics for RealNetworks Streaming Media. 

Script examples with Streaming Media option selected 

The fol lowing example has the Stream ing M edia check box selected and uses RealOne Player. 

... 

... 

#include "do_www.h" 
#include "RPLayer.h" 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://www.host.com/index.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 
DownloadMediaRP("http://rm.host.com:8099/ramgen/demo.rm", 0); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

The fol lowing example has the Stream ing M edia check box selected and uses Windows Media Player. 

... 

... 

#include "do_www.h" 
#include "SMPLayer.h" 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://www.host.com/index.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 
DO_Http("GET http://www.host.com/wmp-test.asx HTTP/1.0\r\n\r\n"); 
DownloadMediaFromASX(0); 

... 

... 

END_TRANSACTION(); 

... 

... 

Script examples with Streaming Media option not selected 
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The fol lowing example has the Stream ing M edia check box cleared and uses RealOne Player. 

... 

... 

#include "do_www.h" 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://www.host.com/index.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 
DO_Http("GET http://rm.host.com:8099/ramgen/demo.rm HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

The fol lowing example has the Stream ing M edia check box cleared and uses Windows Media Player. 

... 

... 

#include "do_www.h" 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://www.host.com/index.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 
DO_Http("GET http://www.host.com/wmp-test.asx HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

Act iveData 

ActiveData 

When th is opt ion is enabled, the generated script  wi l l  automatical ly be variabl ized. Otherwise, al l  requests 
are not modified after the capture. The fol lowing example shows a capture of a form, how it  is variabl ized 
by the Act iveData opt ion, and not variabl ized when the Act iveData opt ion is cleared. 

Example Web page 
Script example with opt ion selected 
Script example with opt ion not selected 

Example Web page 
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<!DOCTYPE HTML PUBLIC "-//AdvaSoft//DTD HTML 3.2 extended 961018//EN"> 
<HTML> 
<HEAD> 
<TITLE>Forms Example</TITLE> 
</HEAD> 

<BODY BGCOLOR="#7093DB"> 

<H2 ALIGN=center>Example of HTTP&nbsp;Forms</H2> 
<BR> 
 
<FORM ACTION="/cgi-bin/perl_9.pl" method=post> 
<TABLE> 
<TR> 
<TD>Name: 
<TD><INPUT NAME="name" SIZE="20" MAXLENGTH=20> 
 
<TR> 
<TD>Password: 
<TD><INPUT TYPE =password NAME="password" SIZE="20" MAXLENGTH=20> 
 
<TR> 
<TD>E-Mail Address: 
<TD><INPUT NAME= "e-mail" SIZE = "40" MAXLENGTH=80> 
 
<TR> 
<TD>Address: 
<TD><INPUT TYPE = text NAME = "Address" SIZE = "40" MAXLENGTH=40> 
 
<TR> 
<TD>City: 
<TD><INPUT NAME="city" SIZE="40" MAXLENGTH=40> 
<TD ALIGN=left>State: 
<TD ALIGN=left><INPUT NAME="state" SIZE="2" MAXLENGTH=2 ALIGN=left> 
<TD ALIGN=left>Zip: 
<TD ALIGN=left><INPUT NAME="zip" SIZE="5" MAXLENGTH=5> 
 
<TR> 
<TD VALIGN=top>Favorite Color: 
<TD><SELECT NAME="options"> 
<OPTION>Red 
<OPTION>Orange 
<OPTION>Yellow 
<OPTION>Green 
<OPTION selected=on>Blue 
<OPTION>Indigo</OPTION> 
<OPTION>Violet</OPTION> 
</SELECT> 
 
<TR> 
 
<TR> 
<TD VALIGN=top>Color of your money: 
<TD><SELECT NAME="dates" multiple="multiple"> 
<OPTION selected=on>Red 
<OPTION>Blue 
<OPTION>Green</OPTION> 
<OPTION>Beige</OPTION> 
</SELECT> 
 
<TR> 
<TD VALIGN=top>Comments: 
<TD><TEXTAREA NAME="comments" COLS=40 ROWS=5></TEXTAREA> 
</TABLE> 
 
<BR><INPUT TYPE=checkbox CHECKED NAME="echo">Echo a copy of the result HTML Page to E-
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mail<BR><BR> 
<P> 
<TABLE> 
 
<TR> 
<TD VALIGN=top>Testing: 
<TD><INPUT TYPE=radio CHECKED NAME="test" VALUE="capture">Capture<BR> 
<INPUT TYPE=radio NAME="test" VALUE="replay">Replay<BR> 
<INPUT TYPE=radio NAME="test" VALUE="loadtest">Loadtest<BR> 
 
<TR> 
 
<TR> 
<TD>Web page to append to reply: 
<TD><INPUT TYPE=file NAME="web page"> 
</TABLE> 
 
<BR> 
There is a hidden field containing data here: <INPUT TYPE=hidden NAME="hidden" VALUE="This 
rocks!"> 
Here is another hidden field: <INPUT TYPE=hidden NAME="hidden1" VALUE="Web testing is fun"> 
<BR> 
<BR> 
 
<TABLE ALIGN=center> 
<TR> 
<TD ALIGN=center>Don't Click This 
 
<TR> 
<TD><INPUT TYPE=image SRC="colors.gif" width="200" height="100"> 
</TABLE> 
 
<TABLE ALIGN=center> 
<TR> 
<TD ALIGN=center>Don't Click This 
 
<TR> 
<TD><INPUT TYPE=image SRC="eye.gif" width="80" height="60"> 
</TABLE> 
 
<TABLE ALIGN=center> 
<TR> 
<TD ALIGN=center>Don't Click This 
 
<TR> 
<TD><INPUT TYPE=image SRC="devplatform.gif" width="48" height="43"> 
</TABLE> 
 
<TABLE ALIGN=center> 
<TR> 
<TD ALIGN=center>Don't Click This 
 
<TR> 
<TD><INPUT TYPE=image SRC="enterprise_sm.gif" width="42" height="41"> 
</TABLE> 
 
<BR> 
 
<TABLE ALIGN=center> 
<TR> 
<TD><INPUT TYPE=submit NAME="submit"> 
<TD><INPUT TYPE=reset> 
</TABLE> 
</FORM> 
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</BODY> 
</HTML> 

Script example with the ActiveData option selected 

When th is opt ion is enabled, variabl izat ions are done in the script  based on the sett ings of other 
conversion opt ions that become avai lable. The fol lowing example has the Act i veData check box selected. 

... 

... 

/* Declare Variables */ 
int i; 
char *Field[2]; 
char *ActionURL[1]; 

... 

... 

for(i=0; i<2; i++) 
Field[i]= NULL; 
 
for(i=0; i<1; i++) 
ActionURL[i]= NULL; 

... 

... 

/* Request: 1 */ 

DO_Http("GET http://www.host.com/forms.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Forms Example", TITLE); 
DO_GetFormActionStatement(FORM(1), &ActionURL[0]); 
DO_GetFormValueByName(FORM(1), "hidden", "hidden", 1, &Field[0]); 
DO_GetFormValueByName(FORM(1), "hidden", "hidden1", 1, &Field[1]); 

/* Request: 2 From: Forms Example */ 
DO_SetValue("action_statement0", ActionURL[0]); 
DO_SetValue("name", "joe"); 
DO_SetValue("password", ""); 
DO_SetValue("e-mail", ""); 
DO_SetValue("Address", ""); 
DO_SetValue("city", ""); 
DO_SetValue("state", ""); 
DO_SetValue("zip", ""); 
DO_SetValue("options", "Blue"); 
DO_SetValue("dates", "Red"); 
DO_SetValue("comments", ""); 
DO_SetValue("echo", "on"); 
DO_SetValue("test", "capture"); 
DO_SetValue("web+page", ""); 
DO_SetValue("hidden", Field[0]); 
DO_SetValue("hidden1", Field[1]); 
DO_SetValue("submit", "Submit Query"); 
DO_Http("POST {*action_statement0} HTTP/1.0\r\n" 
        "Content-Type: application/x-www-form-urlencoded\r\n" 
        "Content-Length: {*content-length}\r\n\r\n" 
        "{name}&{password}&{e-mail}&{Address}&{city}&{state}&" 
        "{zip}&{options}&{dates}&{comments}&{echo}&{test}&" 
        "{web+page}&{hidden}&{hidden1}&{submit}"); 

... 

... 

for(i=0; i<2; i++) 
{ 
free(Field[i]); 
Field[i]= NULL; 
} 
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for(i=0; i<1; i++) 
{ 
free(ActionURL[i]); 
ActionURL[i]=NULL; 
} 

... 

... 

Script example with the ActiveData option not selected 

When th is opt ion is not selected, variabl izat ions are not done in the script  regardless of the other opt ions. 
The fol lowing example has the Act i veData check box cleared. 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://www.host.com/forms.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Forms Example", TITLE); 
DO_Http("POST http://www.host.com/cgi-bin/perl_9.pl HTTP/1.0\r\n" 
        "Content-Type: application/x-www-form-urlencoded\r\n" 
        "Content-Length: {*content-length}\r\n\r\n" 
        "name=joe&password=&e-mail=&Address=&city=&state=&zip=&" 
        "options=Blue&dates=Red&comments=&echo=on&test=capture&" 
        "web+page=&hidden=This+rocks%21&" 
        "hidden1=Web+testing+is+fun&submit=Submit+Query"); 

DO_VerifyDocTitle("Forms Example - Results", TITLE); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

Test ing a Script  

Script Validation 

Before adding a script  to a load test, val idate i t  to ensure that i t  runs without problems. The fol lowing 
procedure is only val id for Win32 scripts. To val idate a UNIX script , see Val idat ing a UNIX script . 

To conf igure t he Scr ip t  Developm ent  W orkbench and Player  f or  val idat ion: 

1. Click Options>Workbench and select the Script Validation tab. 

2. Select the Automatically Recompile check box if you want QALoad to compile a script before attempting to validate 
it. QALoad lists any compilation errors in the editor after compiling. 

3. (For Java and OFS) select Ask for Automatic Validation of Java and OFS Scripts. 

4. Select the Only Display Player Output on Script Failure check box to view only Player messages upon script 
failure. 

5. Type a value in the Wait up to field. This is the number of seconds that the QALoad Script Development Workbench 
should wait for a script to execute before timing out. 

6. In the Player Settings area, select the Abort on Error check box for QALoad to stop script execution upon 
encountering an error. 
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7. Select the Debug Data check box for the script to display a debug message indicating which command the script is 
executing. 

8. In the Run As area, indicate whether the transaction should be run as thread- or process-based. 

Note: Oracle Forms Server, Citrix, Java, and Uniface scripts are limited to process-based validation only. 

9. In the Number of users field, type a number of virtual users to run this script for validation. The default is 1. 

10. Enter a value in the Transactions field. For validation, Compuware recommends that you accept the default value of 
1 transaction. 

11. In the Sleep Factor % field, type the percentage of each DO_SLEEP (pause in the script) to maintain. For validation, 
you may not need to run every pause in the script at its full length. The value can be a percentage between 0 and 
100. The default is 0. 

12. Click OK to save your changes. 

To val idat e t he scr ip t : 

1. In the Workspace Pane, click the Scripts tab. 

2. Double-click on the appropriate script name to open the script. 

3. From the Session menu, choose Validate Script. 

You receive a message and Trace information in  the Output pane. When the script  executes successful ly, 
you receive a confirmation message. If i t  does not execute successful ly, use the Trace information to help 
you ident i fy errors. 

 

Debugging a Script  

Log files 

Log fi les can be generated for Oracle, Oracle Forms Server, Citrix, WWW, Uniface, ODBC, SAP, and 
Winsock scripts only. 

If you encountered errors whi le val idat ing or test ing a script , you can view any log fi les generated during 
the test from the Script Development Workbench's LogFiles tab. Log fi les are generated during a test i f you 
set debug opt ions while sett ing up your test in  the Conductor. Each virtual user for which you enabled 
Logfi le Generat ion wil l  have created a fi le contain ing in formation about i ts performance. When a test 
fin ishes running, al l  log fi les are saved in the directory \Program Files\Compuware\QALoad\LogFiles. 
Log fi les are named <scriptname>_<middleware>_vu<AbsoluteVirtualUserNumber>.<ext>, where: 

!  <scriptname> is the name of the script the virtual user ran 

!  <middleware> is the name of your middleware application 

!  <AbsoluteVirtualUserNumber> is the identification number assigned to the virtual user 

!  <.ext> is the file extension, dependent upon which middleware application you are testing. File extensions are listed 
in the following table: 

M iddlew are Fi l e Ex tension  

Oracle 
WWW 
Citrix 

.rip — A log fi le generated by a fai led Player. At the end of a test, al l  

.rip fi les are sent from the Players to the \QALoad\LogFiles 
directory and added to the merged t im ing fi le for your analysis.  

Uniface 
WWW 

.cap — A standard log fi le contain ing in formation about al l  
statements executed during a test. 

Citrix .log — A standard log fi le contain ing in formation about al l  
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ODBC 
Oracle 
Forms Server 
SAP 
Winsock 
WWW 

statements executed during a test. 

 

Verifying script checkpoints 

You can quickly veri fy the syntax of the checkpoint commands BeginCheckpoint() and EndCheckpoint() 
in  your script  every t ime you compile your script  by sett ing a single opt ion, or on-the-fly with a single 
menu command. 

To aut om at ical ly ver i f y scr ip t  checkpoin t s, every t im e you com pi le a scr ipt : 

1. From the Script Development Workbench's main menu, click Options>Workbench. 

2. On the Configure Script Development Workbench dialog box, click the Compiler Settings tab. 

3. Select the Verify Checkpoints option. 

4. Click OK. 

Every t ime you compile your script , the Script  Development Workbench veri fies the syntax of your 
checkpoint statements, and ensures the parameters passed in each pair match . If any errors are 
encountered, an error message displays in  the Output pane. You can cl ick on any error l ine to go direct ly 
to that l ine in  the script . 

To m anual ly ver i f y scr ip t  checkpoint s, f or  t he open scr ip t  only: 

With your script  open in the Workbook pane, cl ick Session>Veri fy Checkpoin ts.  

The Script Development Workbench veri fies the syntax of your checkpoint statements, and ensures the 
parameters passed in each pair match. If any errors are encountered, an error message displays in  the 
Output pane. You can cl ick on any error l ine to go direct ly to that l ine in  the script . 

 

Using EasyScript  

ADO 

ADO Recording Options 

User Started : Select th is opt ion i f you would l ike to start  your appl icat ion manually for recording, either 
before or after you start  recording. Because th is method may fai l  to record your appl icat ion ’s in i t ial  cal ls, 
Compuware recommends you select the Autom at i c opt ion instead. Select the User Started opt ion when 
you do not know the ful l  appl icat ion startup name and command opt ion parameters or when the 
appl icat ion spawns off processes that generate traffic that you want recorded. 

Note: If you choose this option and the application under test generates traffic before the first Windows 
screen displays, you must also select the Capture Init ializat ion Phase check box in the Workbench 
Configuration tab of the Configure QALoad Script Development Workbench dialog box. 

Autom at i c: Select th is opt ion for QALoad to automatical ly start  your appl icat ion for recording, al lowing 
you to record early appl icat ion startup act ivi ty. This is the recommended method of recording cal ls, 
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because i t  takes advantage of QALoad’s enhanced abi l i t ies to handle various mult i-threaded programming 
techniques. Choose th is opt ion to record traffic from just one appl icat ion. This opt ion l im its the recording 
output to just the traffic generated by the appl icat ion, not including the traffic that is generated by 
processes spawned by the appl icat ion. 

Com m and Line: If you chose Automatic Program Startup, enter the command l ine of your appl icat ion. 
You can also use the browse button to locate your appl icat ion. 

Work ing Di rectory : Enter the working directory of your appl icat ion.  

 

ADO Conversion Options 

Field Ret rieval : Select th is opt ion to include al l  instances of the ADO CARecordset->GetFields (represented 
in a QALoad script  as ADO_Recordset(#)->GetFields( ADOFieldSet[#] ); in  the converted script . 

Clearing th is field removes a number of different elements from the script  that may not be necessary for 
playback because they are processed on the cl ient side rather than the server side. Removing them can 
great ly decrease the size of your script  without affect ing your load test results.  

Caut ion: Clear this option only if you are certain that ADO_Recordset(#)->GetFields( ADOFieldSet[#] ); is 
not integral to your script. 

For more in formation about th is opt ion, see Using the Field Retrieval opt ion.  

 

ADO Method Reference 

QALoad provides descript ions and examples of the various methods that are avai lable for an ADO script . 
For detai ls, refer to the Language Reference Help sect ion for ADO. 

 

Cit rix 

Overview 

Use QALoad's Citrix middleware to load test systems that run Citrix MetaFrame or Citrix MetaFrame XP.  

What  i s Ci t r i x? 

Citrix middleware is a communicat ion layer that provides remote access to Windows systems. The remote 
system appears in  a window on the local system.  

Connect ing to the rem ote system  

Once you have connected to a machine that is running the MetaFrame server, you can log in  to the remote 
system and then run appl icat ions. Alternat ively, you can specify an appl icat ion in  addit ion to a user name 
and password, which provides access only to the specified appl icat ion and min imizes user input that is 
necessary to access the appl icat ion under test. 

Test ing in  l oad-balanced envi ronm en ts 

If you are test ing an environment that includes a server farm, you can use Citrix ICA fi les to support th is 
type of configurat ion. Specify the ICA fi le on the Citrix Record Options dialog box. ICA fi les are also 
necessary for encrypt ion, Publ ished Applicat ions, and Published Desktops. ICA fi les are generated on the 
MetaFrame server and can be obtained from your M etaFrame administrator. For more in formation about 
using ICA fi les, see Using ICA fi les.  
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Recording a Citrix session 

To begin recording a Citrix session, cl ick the Record  button on the Session toolbar. (If you have not 
already chosen Citrix as the session type, cl ick the Ci t r i x  Session  button to act ivate a new Citrix session.) 
The Citrix capture appl icat ion appears, as shown in the fol lowing image.  

Cl ick the three sect ions of the image to learn more about the fields and the in formation that is displayed 
in each area. 

 

 

 

Citrix recording options 

To set recording opt ions, choose Record... from the Opt ions menu in the Script Development Workbench.  

Set the fol lowing opt ions for recording Citrix appl icat ions: 

Server In form at ion  

Server: Type the name or address of the server machine for automatic connect ions. To connect to a 
server manually, do not enter a value in  th is field. 

Usern am e: Type the user name for the server machine that was specified in  the Server  field. 

Passw ord: Type the password for the user name that  was specified in  the Usernam e field. 
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Dom ain : Type a domain name that appl ies to the user name and password that were specified in  the 
Usern am e and Passw ord  fields. Specifying a domain is opt ional. To ensure that the specified user 
name is logged on to the server instead of a domain, type the server name in th is field. 

Applicat ion Information 

Select whether to automat ical ly start  an appl icat ion after logging on. Choose Autostart  to launch the 
appl icat ion specified in  the Appl i cat ion  field, Custom  to refer to the ICA fi le for appl icat ion in formation, 
or None to disable automatic appl icat ion startup. 

Appl i cat ion : Type the path and fi le name of an appl icat ion to start  upon a successful log on.  

Di rectory: Type the working directory for the appl icat ion that was specified in  the Appl i cat ion  field. 
Specifying a working directory is opt ional even i f you have specified an appl icat ion in  the 
Appl i cat ion  field. 

ICA File:  Type the name of a Citrix ICA file. To enable this field, click the Custom option. Specify a URL or 
a file name without a path. This file, which is located on the MetaFrame server, contains configuration 
options for the Citrix client. For more information about ICA files, consult your Citrix administrator.  

Notes: To test Published Applications and load-balanced environments (server farms), you must 
specify an ICA file. 
 
To validate a script on the same machine on which it was captured, you must copy the ICA file to 
the QALoad \BinaryFiles directory. To use the ICA file on remote Player machines, the ICA file 
should be specified as an attached file in the External Data column of the Script Assignment tab in 
the Conductor. 

Connect ion Information 

Port :  Type the port  number over which Citrix ICA traffic travels. This port  is also the port  on which 
the MetaFrame server is l istening. The default  port  is 1494.  

Resolut ion : Choose a window size for the Citrix connect ion. To ensure that the ent ire Citrix 
in terface is visible during recording, set the Resolut ion field in  the Citrix recording opt ions to a 
lower value than that of the desktop. Also, the screen resolut ion must be the same as the screen 
resolut ion specified in  the Citrix ICA fi le. 

Graceful l y di sconnect  session : Select to specify that a logoff  is issued before issuing a disconnect. If 
you do not select th is opt ion, you may need to configure the Citrix server to properly handle clean-
up sessions. 

 

Using ICA files 

ICA fi les, which are generated on the MetaFrame server, contain configurat ion opt ions for Citrix. You can 
specify an ICA fi le on the Citrix Record Options dialog box. 

ICA fi les are specified in  the script  with the CtxSetICAFile command. If an ICA fi le is specified, the cal l  is 
generated with an unquali fied fi le name. For example: 

CtxSetICAFile("customapp.ica"); 

   Note: The file name is not fully-qualified because the file may not exist in the same location among the 
remote Player machines. 

To val idate the script  on the same machine on which i t  was captured, copy the ICA fi le to the 
QALoad\BinaryFiles directory. 

To use the ICA fi le on remote Player machines, the ICA fi le should be specified as an attached fi le in  the 
External Data column of the Script Assignment tab in  the Conductor. 
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Citrix conversion options 

To set conversion opt ions, choose Convert ... from the Opt ions menu in the Script Development 
Workbench. 

Set the fol lowing opt ions for Citrix conversions: 

General 

Replay Output  M ode: Choose the playback mode to use during replay.  

!  Normal mode is normal headless replay.  

!  Renderless mode maximizes the number of possible client sessions (and minimizes CPU usage) by discarding all 
graphic data immediately after receipt. However, you cannot take snapshots in renderless mode.  

!  Windowless mode reduces CPU usage by allowing the client to skip drawing the screen image. Rendering still exists 
off-screen, which makes session snapshots possible.  

Enable Coun ters:  Select to enable the middleware counters that are bui l t  in  to Connect(), Disconnect(), 
and Ping() cal ls. Enabl ing these counters can affect load test performance.  

Keyboard/Mouse Input 

Com bine consecut i ve key characters i n to a st r i ng:  Select to combine consecut ive ASCII character key 
act ions. This opt ion combines individual cal ls to type characters in to one cal l  for the ent ire string. 

Convert  consecut i ve m ouse com m ands in to poin ts/ cl i cks:  Select to consol idate consecut ive 
MouseMove commands into a Point() command and to convert  matching MouseDown/M ouseUp 
command pairs in to Cl ick() commands.  

Timeout Values 

Connect : Type the number of seconds to wait  for the connect ion to complete.  

Ping: Type the number of seconds to wait  for the Ping() cal l  to return results.  

Disconnect : Type the number of seconds to wait  for the disconnect ion to complete.  

Wai t  Poin t : Type the number of seconds to wait  for wait  points to complete.  

Window  even ts: Type the number of seconds to wait  for window creat ion and destruct ion events to occur.  

Restore Defaul ts: Cl ick to set al l  t imeout opt ions to the default  sett ings. 

Window 

Enable veri f i cat ion : Select to enable window veri ficat ion. When th is opt ion is enabled, a window must be 
act ive for an act ion to be issued. Also choose the number of t imes to re-try for veri ficat ion i f an act ive 
window is not found, and the number of mil l iseconds to wait  between each try.  

Enable Wi ldcard Ti t l e M atch : Select to enable wi ldcard comparisons for matching Citrix window creat ion 
events. For more in format ion about wi ldcard comparisons, see Handling dynamic window t i t les. 

 

Citrix command reference 

QALoad provides descript ions and examples of the various commands avai lable for a Citrix script . For 
detai ls, refer to the Language Reference Help sect ion for Citrix. 

Advanced Scripting Techniques for Citrix 

Handl ing Ci t r i x  server farm s 
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Citrix servers can be grouped in farms. When load test ing, you may want to connect to a Citrix server farm 
rather than to a specific server. This type of setup load tests the server farm and Citrix load balancing 
rather than a single server, which provides a more real ist ic load test. 

To record a script  that connects to a farm, you must use an ICA fi le to connect. However, when a capture 
takes place, a specific server (in  the farm) must have a connect ion. Specify the correct ICA fi le to connect 
to the server farm as well  as a specific server with in that server farm. To veri fy that your script  is 
connect ing to a server farm and not a specific server, assign the server name to one blank space when 
val idat ing the script . For example: 

. 

. 

. 

/* Declare Variables */ 
const char *CitrixServer   = " "; 
const char *CitrixUsername = "citrix"; 
const char *CitrixPassword = "~encr~657E06726F697206"; 
const char *CitrixDomain   = "qacitrix2"; 
const int CitrixOutputMode = OUTPUT_MODE_NORMAL; 

. 

. 

. 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("Orders.cpp"); 

CitrixInit(4); 

/* Citrix replay settings */ 

CtxSetConnectTimeout(90); 
CtxSetDisconnectTimeout(90); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetDomainLoginInfo(CitrixUsername, CitrixPassword, Citrix-Domain); 
CtxSetICAFile("PRD desktop.ica"); 
CtxSetEnableCounters(TRUE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 

SYNCHRONIZE(); 

 

Handl ing dynam ic w indow  t i t l es 

Some appl icat ions create windows whose t i t les vary depending on the state of the window. For example, 
M icrosoft  Word creates a t i t le based on the default  document name at the t ime of the window creat ion. 
During replay, th is dynamic t i t le can differ from the window t i t le that was recorded, and the window is 
not recognized. If th is occurs, t ry the fol lowing steps to modify the script : 

1. Ensure that the Enable Wildcard Title Match check box is selected in the Citrix conversion options prior to 
converting the recording.  
In the Window Verification group of the Citrix Convert Options dialog box, ensure that the Enable Wildcard Title 
Match check box is selected. This check box is selected by default. If you are working with a previously-converted 
script, ensure that a CtxSetEnableWildcardMatching command exists in the script prior to the 
BEGIN_TRANSACTION command and that the parameter is set to TRUE. 

2. Verify whether there is an issue with dynamic window titles.  
When a script fails on validation because the run time window title is different than the expected window title from the 
recording, it is likely that you are dealing with a dynamic title issue that can be handled by this scripting technique. In 
this case, the script fails on the CtxWaitForWindowCreate call. 
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3. Identify a match “pattern” for the dynamic window title.  
Note the error message that is returned during validation (or replay). The message indicates the expected window 
title versus the window title from script playback. Examine the differences in the window titles to create a “match 
pattern” that recognizes the window title, while ignoring other windows. A match pattern can be a simple substring of 
the window title or a pattern string using wildcard characters such as ? (to match any single character) or * (to match 
any number of characters). The examples below illustrate the different match patterns. 

4. Insert a CtxSetWindowMatchTitle command prior to the CtxWaitForWindowCreate call for the dynamic 
window.  
When adding the SetWindowMatchTitle command, ensure that the first parameter contains the correct window 
object and the second parameter contains the match string in double-quotes. 

5. Validate the script to ensure the CtxWaitForWindowCreate command recognizes the dynamic window name.  
Run the revised script through validation to ensure that the script succeeds. If the script does not validate 
successfully, go to step 3 to determine if the match pattern is correct. 

Example 1: Using a substring match 

In  th is example, the M icrosoft  Word appl icat ion generates a dynamic t i t le when the script  is replayed. The 
dynamic name is a concatenat ion of the default  document that Word creates at appl icat ion startup with 
the name of the appl icat ion. The script  is altered to reflect the fact that the string “ Microsoft  Word”  is 
always part  of the window t i t le: 

// Window CWI_13 ("Microsoft Word") created 
CtxSetWindowMatchTitle( CWI_13, “Microsoft Word” ); 
CtxWaitForWindowCreate(CWI_13); 

Example 2: Using a wildcard match with the *  character 

In  th is example, the SampleClientApp appl icat ion generates a dynamic t i t le when the script  is replayed. 
The dynamic name is the name of the appl icat ion fol lowed by the name of the user, beginning with the 
word “ User” . The asterisk (*) wi ldcard is subst i tuted for a given username, reflect ing the pattern of 
“ SampleClientApp – User:”  as part  of the window t i t le fol lowed by an arbitrary user name: 

// Window CWI_13 ("SampleClientApp – User: John") created 
CtxSetWindowMatchTitle(CWI_13,“SampleClientApp – User: *” ); 
CtxWaitForWindowCreate(CWI_13); 

Example 3: Using a wildcard match with the ? character 

In  th is example, the RandomValue appl icat ion generates a dynamic t i t le when the script  is replayed. The 
dynamic name is the appl icat ion fol lowed by a random single digit . The question mark character is 
subst i tuted for the single digit  to reflect the pattern  that begins “ RandomValue: ” , fol lowed by single digit : 

// Window CWI_13 ("RandomValue: 0") created 
CtxSetWindowMatchTitle( CWI_13, “Sample Application: ?” ); 
CtxWaitForWindowCreate(CWI_13); 

 

 

Handl ing dynam ic w indow s 

During conversion, CtxWaitForWindowCreate cal ls are added to the script  for each named window 
creat ion event. During replay, some dynamic windows that were in  the capture may not appear, which 
causes the script  to fai l  because a wait  point t imes out. To avoid script  fai lure in  th is circumstance, 
comment out the CtxWaitForWindowCreate commands that may be referencing dynamic windows. 

Handl ing dynam ic w indow s that  requi re user i n teract ion  

Some windows that require user act ion before normal script  processing can proceed may appear 
in termit tent ly during replay. One example commonly encountered with Citrix is the ICA Seamless Host 
Agent window. This window, i f i t  appears, requires user act ion or the script  may fai l .  
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To w ork  around t h is issue, f ol low  t hese st eps: 

1. Capture a session in which the dynamic window appears and the user performs the action to dismiss the window. 
This may require multiple attempts to capture the window. Once this is captured in a recording, save the script as a 
temporary script. 

2. If the window did not appear in the primary script, extract the code snippet from the temporary script that acts on the 
dynamic window and insert it into the real script. The code usually consists of a CtxPoint command and a CtxClick 
command for this window. Insert the commands after the CtxWaitForWindowCreate command for the dynamic 
window. In addition, extract and insert the Citrix window information object constructor call and delete call to the 
relevant parts of the script, changing the object name to avoid conflicting with existing window objects. Ensure that 
the additional code is not inserted between a CtxPoint command and a CtxClick command in the primary script. 

3. Add a special CtxSetWindowMatchTitle command immediately before the CtxWaitForWindowCreate command. The 
first parameter of the CtxSetWindowMatchTitle command should be the correct window object. The second 
parameter contains a special wildcard match “*” that enables the CtxClick command to accept any window title, 
which ensures that even if the matching window does not appear, the command still executes successfully. 

4. If the window appears in the primary script, comment out the CtxWaitForWindowCreate command for the dynamic 
window. Because the window itself may not appear, the CtxWaitForWindowCreate command should be commented 
out. 

5. Validate the script. If the validation is not successful, ensure that steps 2-4 were performed correctly. 

In  the fol lowing example’s scenario, the ICA Seamless Window Agent window does not appear in  the 
primary script , but appears in termit tent ly when the primary script  is replayed, causing those replay 
sessions to fai l . A second Citrix script , which includes the window appearance, is recorded and the 
CtxPoint and CtxClick commands are extracted from th is script  and inserted in to the primary script , with 
the window object changed to match the object in  the primary script . In  addi t ion, the Citrix window 
object constructor cal l  and delete cal l  are added in the appropriate places in  the script , and the CtxClick 
command is changed to refer to th is object. In  the fol lowing example, the text in  bold represents code that 
was manually inserted in to the locat ion in  the primary script  where the window appears in  the secondary 
script . 

CtxWI *CWI_99 = new CtxWI(0x10052, "ICA Seamless Host Agent", 0, 0, 391, 224); 
... 
CtxSetWindowMatchTitle( CWI_99, “*” ); 
CtxPoint(190, 203); 
CtxClick(CWI_99, 0, L_BUTTON, NONE); 
CtxPoint(300, 400); 
... 
delete CWI_99; // "ICA Seamless Host Agent" 

 

 

Handl ing unexpected even ts in  Ci t r i x  

The CtxWindowEventExists and CtxScreenEventExists commands can be used to handle unexpected 
window and screen events in  Citrix scripts. When there is a possibi l i ty of unexpected dialogs appearing or 
unexpected screen events occurring, you must modi fy the script  to respond to the changes and cont inue 
the load test. 

For example, i f a script  opens a M icrosoft  Word document that resides on a network, and that document is 
already open by another network user, an unexpected dialog box appears that prompts the user to choose 
between cont inuing to open the document in  read-only mode or to cancel i t . To prevent script  fai lure, 
modificat ions can be made in the script  to handle the dialog boxes that appear in  th is si tuat ion.  

General ly, to handle unexpected events, you record two scripts. The first  script  contains a recording of the 
expected events. The second script  should include the unexpected events. Using the 
CtxWindowEventExists and CtxScreenEventExists funct ions, create a condit ional block of code that 
handles the dialogs that may appear. 

Example 
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The fol lowing script  example shows the addit ional script  l ines that were added to handle a Word 
document that is already open by another user on a network. The added l ines appear in  boldface type. 

/* 
 *  capSave11111-2.cpp 
 * 
 *  Script Converted on June 21, 2004 at 01:04:17 PM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 50 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
  
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 132 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Window Verification             : Yes 
 *   Session Timeouts                : Yes 
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *   Include Wait Points             : Yes 
 *   Enable Counters                 : No 
 *   Include Unnamed Windows         : Yes 
 *   Output Mode                     : Normal 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 */ 
  
#define CITRIX_CLIENT_VERSION "8.00.60000" 
#define CITRIX_ICO_VERSION    "2.4" 
#define SCRIPT_VER 0x00000205UL 
  
#include <stdio.h> 
#include "smacro.h" 
  
#include "do_citrix.h" 
  
/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 
  
#ifndef NULL 
#define NULL  0 
#endif 
  
extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 
            /* Declare Variables */ 
            const char *CitrixServer      = "qaccitrix"; 
            const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL;             
  
            /* Citrix Window Information Objects */ 
            CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
            CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
            CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
            CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 
397, 127); 
            CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 
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397, 127); 
            CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
            CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
            CtxWI *CWI_8 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
            CtxWI *CWI_9 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
            CtxWI *CWI_10 = new CtxWI(0x1008c, "", 115, 0, 405, 457); 
            CtxWI *CWI_11 = new CtxWI(0x1005a, "", 2, 49, 205, 408); 
            CtxWI *CWI_12 = new CtxWI(0x2006a, "", 200, 186, 156, 287); 
            CtxWI *CWI_13 = new CtxWI(0x10138, "", 112, 116, 416, 248); 
            CtxWI *CWI_14 = new CtxWI(0x50036, "Microsoft Word", -4, -4, 649, 461); 
            CtxWI *CWI_15 = new CtxWI(0x1017e, "Open", 19, 23, 602, 387); 
            CtxWI *CWI_16 = new CtxWI(0x20174, "*Microsoft Word", -4, -4, 649, 461); 
            CtxWI *CWI_17 = new CtxWI(0x10058, "", 113, 114, 305, 26); 
            CtxWI *CWI_18 = new CtxWI(0x2013e, "Calculator", 66, 66, 261, 253); 
            CtxWI *CWI_19 = new CtxWI(0x1005a, "", 2, 49, 205, 408); 
            CtxWI *CWI_20 = new CtxWI(0x3006a, "Shut Down Windows", 111, 96, 418, 193); 
  
            CtxWI *CWI_117 = new CtxWI(0x20172, "File In Use", 144, 127, 352, 179); 
            CtxWI *CWI_118 = new CtxWI(0x30172, "11111111 (Read-Only) - Microsoft Word", -4, 
-4, 649, 461); 
             
            SET_ABORT_FUNCTION(abort_function); 
  
            DEFINE_TRANS_TYPE("capSave11111-2.cpp"); 
  
            CitrixInit(1); 
  
            /* Citrix replay settings */ 
            CtxSetConnectTimeout(60); 
            CtxSetDisconnectTimeout(60); 
            CtxSetWindowTimeout(30); 
            CtxSetPingTimeout(20); 
            CtxSetWaitPointTimeout(30); 
            CtxSetWindowVerification(TRUE); 
            CtxSetEnableCounters(FALSE); 
            CtxSetWindowRetries(5, 5000); 
            CtxSetEnableWildcardMatching(TRUE); 
             
            SYNCHRONIZE(); 
  
            BEGIN_TRANSACTION(); 
  
            DO_SetTransactionStart(); 
             
            CtxConnect(CitrixServer, CitrixOutputMode); 
             
            // Window CWI_1 ("Warning !!") created 1087837356.454 
             
            CtxWaitForWindowCreate(CWI_1, 2125);             
             
            DO_MSLEEP(1891); 
            CtxPoint(246, 267);  //1087837358.797             
             
            DO_MSLEEP(453); 
            CtxMouseDown(CWI_1, L_BUTTON, NONE, 246, 267);  // 1087837358.797 
             
            CtxMouseUp(CWI_1, L_BUTTON, NONE, 247, 267); //1087837359.032 
             
            . 
            . 
            . 
             
            DO_MSLEEP(63); 
            // Window CWI_14 ("Microsoft Word") created 1087837397.390 
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            CtxWaitForWindowCreate(CWI_14, 141);             
             
            DO_MSLEEP(78); 
            CWI_14->setTitle("Document1 - Microsoft Word"); //1087837397.468 
             
            // Window CWI_13 ("") destroyed 1087837397.468             
             
            DO_MSLEEP(2468); 
            CtxPoint(37, 50);  //1087837400.218             
             
            DO_MSLEEP(282); 
            CtxClick(CWI_14, 203, L_BUTTON, NONE); //1087837400.421 
             
            // Window CWI_15 ("Open") created 1087837400.764 
             
            CtxWaitForWindowCreate(CWI_15, 344); 
             
             
            DO_MSLEEP(1656); 
            CtxPoint(132, 99);  //1087837402.671             
             
            DO_MSLEEP(250); 
            CtxDoubleClick(CWI_15); // 1087837402.874             
             
            DO_MSLEEP(109);       
             
             
            DO_MSLEEP(1953); 
            CtxPoint(247, 197);  //1087837404.827 
             
            // Window CWI_15 ("Open") destroyed 1087837404.827 
  
  
            if(CtxWindowEventExists(EVT_STR_CTXWINDOWCREATE,3000,CWI_16)) 
            BeginBlock();    
                        CtxPoint(337, 265);  //1087837404.905 
             
                        // Window CWI_16 ("11111111 - Microsoft Word") created 
1087837404.905 
             
                        CtxWaitForWindowCreate(CWI_16, 31); 
             
                        // Window CWI_14 ("Document1 - Microsoft Word") destroyed 
1087837404.905  
             
                        DO_MSLEEP(7547); 
                        CtxPoint(628, 9);  //1087837414.592             
             
                        DO_MSLEEP(2141); 
                        CtxClick(CWI_16, 281, L_BUTTON, NONE); //1087837414.873             
             
                        DO_MSLEEP(234); 
                        // Window CWI_16 ("11111111 - Microsoft Word") destroyed 
1087837415.108 
             
                        CtxPoint(113, 93);  //1087837418.779 
             
                        // Window CWI_17 ("") created 1087837418.779 
            EndBlock() 
  
///ReadOnly Code Start 
  
            else 
            BeginBlock();    
             



QALoad Online Help 

105 

                        // Window CWI_117 ("File In Use") created 1087840076.599 
             
                        CtxWaitForWindowCreate(CWI_117, 578); 
             
                        DO_MSLEEP(2360); 
                        CtxPoint(358, 283);  //1087840079.068 
             
             
                        DO_MSLEEP(125); 
                        CtxClick(CWI_117, 281, L_BUTTON, NONE); //1087840079.365 
             
             
                        DO_MSLEEP(109); 
                        // Window CWI_117 ("File In Use") destroyed 1087840079.458 
             
                        // Window CWI_118 ("11111111 (Read-Only) - Microsoft Word") created 
1087840079.521 
             
                        CtxWaitForWindowCreate(CWI_118, 63); 
             
                        // Window CWI_115 ("Document1 - Microsoft Word") destroyed 
1087840079.521 
                         
                        DO_MSLEEP(4766); 
                        CtxPoint(631, 3);  //1087840084.490 
             
                        DO_MSLEEP(203); 
                        CtxClick(CWI_118, 250, L_BUTTON, NONE); //1087840084.740 
             
                        DO_MSLEEP(93); 
                        // Window CWI_118 ("11111111 (Read-Only) - Microsoft Word") 
destroyed 1087840084.833 
             
                        DO_MSLEEP(2407); 
                        CtxPoint(34, 465);  //1087840087.333 
  
            EndBlock(); 
  
///ReadOnly Code End  
  
  
            DO_MSLEEP(1063); 
             
            DO_MSLEEP(484); 
            CtxPoint(112, 93);  //1087837419.654             
             
            DO_MSLEEP(406); 
            CtxDoubleClick(CWI_9); // 1087837419.904             
            . 
            . 
            . 
 
            // Window CWI_9 ("Program Manager") destroyed 1087837440.122 
             
            // Window CWI_7 ("") destroyed 1087837440.138 
             
            DO_SetTransactionCleanup(); 
             
            CtxDisconnect(); 
             
             
            END_TRANSACTION(); 
  
            delete CWI_1; // "Warning !!" 
            delete CWI_2; // "Log On to Windows" 
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            delete CWI_3; // "Please wait..." 
            delete CWI_4; // "Citrix License Warning Notice" 
            delete CWI_5; // "Citrix License Warning Notice" 
            delete CWI_6; // "UsrLogon.Cmd" 
            delete CWI_7; // "" 
            delete CWI_8; // "ICA Seamless Host Agent" 
            delete CWI_9; // "Program Manager" 
            delete CWI_10; // "" 
            delete CWI_11; // "" 
            delete CWI_12; // "" 
            delete CWI_13; // "" 
            delete CWI_14; // "Microsoft Word" 
            delete CWI_15; // "Open" 
            delete CWI_16; // "11111111 - Microsoft Word" 
            delete CWI_17; // "" 
            delete CWI_18; // "Calculator" 
            delete CWI_19; // "" 
            delete CWI_20; // "Shut Down Windows" 
  
            delete CWI_117; // "File In Use" 
            delete CWI_118; // "11111111 (Read-Only) - Microsoft Word" 
             
            CitrixUninit(); 
             
            REPORT(SUCCESS); 
            EXIT(); 
            return(0); 
} 
  
void abort_function(PLAYER_INFO *s_info) 
{ 
            RR__printf("Virtual User ABORTED."); 
             
            CitrixUninit(); 
             
            EXIT(); 
} 

 

M oving the Ci t r i x  connect  and disconnect  outside the t ransact ion  loop 

If your load test ing requirements for Citrix include creat ing extended logon sessions, in  which the user 
remains connected to the Citrix server between transact ions, review the fol lowing t ips for recording and 
script  development. 

Recording 

Perform the fol lowing steps during the recording process in  order to prepare for moving the connect and 
disconnect act ions outside the transact ion loop: 

1. Insert a comment such as “Logged in to Citrix” after the Citrix logon but before any windows have been opened. 

2. Ensure that all application windows are closed before disconnecting from the Citrix session. 

3. Insert a comment such as “Ready to log off Citrix” before the Citrix logoff sequence is initiated. Ensure that the first 
comment is added after the user has logged on and closed all login-related dialog boxes, but before any applications 
are started. Similarly, the second comment must be placed after all applications have been closed, but before the 
user logs off. 

Script ing 

Comment out the BEGIN_TRANSACTION and END_TRANSACTION cal ls and add new 
BEGIN_TRANSACTION and END_TRANSACTION cal ls at the locat ion where the comments from steps 1 
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and 3 above were placed. Comment out the cal ls instead of delet ing them so that the original locat ion of 
these commands can be determined for debugging purposes.  

Also comment out the DO_SetTransact ionStart  and DO_SetTransact ionCleanup cal ls. 

 

Using the CtxWai tForScreenUpdate com m and 

In  some situat ions, a window may vary in  how long i t  takes to refresh on the screen. For example, the 
Windows Start  menu is an unnamed window that can take varying amounts of t ime to appear, depending 
on system resource usage. To prevent playback problems in which a mouse cl ick does not synchronize with 
i ts in tended window, insert  the CtxWaitForScreenUpdate command in the script  after the act ion that 
causes the window to appear. The parameters for the CtxWaitForScreenUpdate command correspond to 
the X and Y coordinates and the width and height of the window. This command ensures that the window 
has enough t ime to display before the mouse cl ick. 

 

Java 

Overview 

QALoad does not support recording of Java scripts. Instead, Java scripts are created from script  templates 
that you use to create a stub script  that you can then edit  manually. Templates are saved in the 
QALoad\Middlewares\Java\Templates directory. QALoad suppl ies four default  templates. QALoad uses 
a token name to represent  the classpath — when you create a new Java script , QALoad simply replaces the 
token <classnamehere> with the class/script  name you assign. You can also instal l  addit ional templates 
using the <classnamehere> token i f you wish.  

Fol lowing is an example of a Java template with the classname token (in  bold): 

import com.compuware.qacenter.qaload.EasyScript.*; 
public class <classnamehere> implements EasyScript 

{ 
/** optional - Class method runs once for each script when class is loaded */ 
public static void setup QALoad Test () throws Exception 
{ 
} 

Use the Script Development Workbench to create a new EasyScript for Java script  from the provided stub 
scripts. 

Using my script  from a previous version of QALoad  

 

Accessing JavaDoc 

QALoad provides JavaDoc for your reference. To access i t  from the Script Development Workbench menu, 
choose Help>EasyScript  for Java: JavaDoc from a Java session. 

 

Creating a Java Script 

To creat e a Java scr ipt  f or  QALoad : 

1. With a Java session open, choose File>New from the menu. 

2. In the File area, click on the Middleware tree item. 
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3. In the Filename field, type a name for your new Java script. Note that Java file names do have special requirements, 
and QALoad will enforce those requirements. For example, Java file names cannot contain spaces. If you try to 
include a space in your file name, QALoad will give you an error prompt. 

4. Click OK. The Create Java Script dialog box opens. 

5. Under the Script field is a selection box listing all the templates available in your 
\QALoad\Middlewares\Java\Templates directory. QALoad provides four default templates. If you click on a 
template name, a sample is shown in the right pane. The four templates are: 

 long format — Provides al l  required and opt ional methods. 

 new class — Creates a class associated with the script . 

 old format — Shows modi ficat ions needed to run legacy scripts. 

 short  format — Provides only the min imum required methods. 

Select the template that best suits your needs and cl ick OK. QALoad creates a stub script  by the name 
you designated and opens i t  in  the Workbook pane for edit ing. 

6. Edit your script as necessary. You can use QALoad's Java Script Options dialog box to edit some script attributes. 

Note: The main call in the script is used for debugging proposes and is not executed in the Conductor. 

Oracle 

Oracle recording options 

User Started : Select th is opt ion i f you would l ike to start  your appl icat ion manually for recording, either 
before or after you start  recording. Because th is method may fai l  to record your appl icat ion ’s in i t ial  cal ls, 
Compuware recommends you use the Autom at i c opt ion instead. Select the User Started opt ion when you 
do not know the ful l  appl icat ion startup name and command opt ion parameters or when the appl icat ion 
spawns off processes that generate traffic that you want recorded. 

Note: If you choose this option and the application under test generates traffic before the first Windows 
screen displays, you must also select the Capture Init ializat ion Phase check box on the Workbench 
Configuration tab of the Configure QALoad Script Development Workbench dialog box. 

Autom at i c: Select th is opt ion for QALoad to automatical ly start  your appl icat ion when recording, al lowing 
you to record early appl icat ion startup act ivi ty. This is the recommended method of capturing API cal ls, 
because i t  takes advantage of QALoad’s enhanced abi l i t ies to handle various mult i-threaded programming 
techniques. Select th is opt ion to record traffic from just one appl icat ion. This opt ion l im its the recording 
output to just the traffic generated by the appl icat ion, not including the traffic that is generated by 
processes spawned by the appl icat ion. 

Com m and Line: If you chose Autom at i c Program  Startup, enter the command l ine of your Oracle 
appl icat ion. You can also use Brow se to locate your appl icat ion. 

Work ing Di rectory : Enter the working directory of your Oracle appl icat ion. 

Note: If you entered the full path in the Command Line field, this field is filled in automatically.  

 

Oracle conversion options 

Database Paths, Incl udes: Enter the locat ion of your Oracle database includes. 

Database Paths, Libraries: Enter the locat ion of your Oracle database l ibraries.  

Variabl i zat ion  (Act i veData) Enable: Select th is opt ion to enable Act iveData for Oracle during conversion. 
This opt ion is enabled by default . For more in formation, cl ick Act iveData for Oracle. 

M in im um  Characters: Enter the min imum number of characters to match for auto-variabl izat ion. 
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PostCapture: Fetch  I terat ion  Override: Type the number of fetch i terat ions al lowed while recording a 
script  to control the amount of data fetched during playback. To fetch al l  data, type: 1000000. 

 

ActiveData for Oracle 

Act i veData for Oracle 

Oracle variabl izat ion is a powerful script ing assistant that provides automatic correlat ion of data values in  
your script  (auto-variabl izat ion) and lets you use a datapool as the source of data values (manual-
variabl izat ion). 

Auto-variabl izat ion 

When you enable auto-variabl izat ion, QALoad correlates the data values produced by the execut ion of 
recorded SQL statements and assigns a single source variable to matching bind and stat ic variables that 
subsequently use the value. Auto-variabl izat ion wil l  on ly target a capture fi le's bind variables and 
embedded stat ic data in  recorded SQL statements as receivers of source variables. Source variables wi l l  be 
automatical ly generated based on the capture fi le's PostBind data, Fetch data, and embedded Stat ic data in  
SQL statements. Source variables from PostBind data wi l l  be generated only i f the PostBind data belongs to 
one of these OCI bind data types: 

Code OCI7 Bind Data Type OCI8 Bind Data Type 

3 SQLT_INT SQLT_INT 

4 SQLT_FLT SQLT_FLT 

68 SQLT_UIN SQLT_UIN 

1 SQLT_CHR SQLT_CHR 

5 SQLT_STR SQLT_STR 

96 SQLT_AFC SQLT_AFC 

97 SQLT_AFC SQLT_AFC 

11 SQLT_RID SQLT_RID Not Appl icable 

in  OCI8 

Source variables from Fetch data wi l l  be generated only i f the Fetch data belongs to one of the above OCI 
datatypes or one of the fol lowing:  

Code OCI7 Fetch  Data Type OCI8 Fetch  Data Type 

6 SQLT_VNU SQLT_VNU 

2 SQLT_NUM SQLT_NUM 

Note: Fetch data is made available in the capture file only when the Oracle Capture Option Use Fetch 
data for Variablizat ion is selected. 
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Stat ic data embedded in SQL statements wi l l  be used as source variable or receiver of a source variable only 
when the SQL statement states a SELECT, INSERT, UPDATE or DELETE operat ion. SQL statements that 
contain stored procedures (e.g. BEGIN…) wi l l  be excluded. 

Auto-variabl izat ion occurs by default  in  QALoad, but you can turn i t  off by clearing the conversion opt ion 
Variabl i zat ion  (Act i veData) on the Oracle Convert  Opt ions tab. If you choose to use automatic 
variabl izat ion, you can then use manual-variabl izat ion to change a source variable previously determined 
by auto-variabl izat ion to data from a local or central datapool. 

Manual Variabl izat ion 

Manual variabl izat ion al lows you to change the source of variables ident i fied through auto-variabl izat ion 
to use data from central or local datapools. You use the variabl izat ion tree-view and the opt ions avai lable 
from the tree-view to view and change source variables.  

Manual variabl izat ion is l im ited to changing the source variables to data that  was prepared from a local  
datapool or conductor (central) datapool. Once changed, al l  (but not individual) source variables may be 
changed back to the original source variables. 

W hy use Act iveData for Oracle? 

!  To avoid duplicate key errors which can occur during playback when the data relationships hidden (implied) 
within a set of Oracle SQL statements are not recorded. For example, a recorded Select SQL statement may 
include the Oracle nextval expression to get the next sequential unique number in the database. The returned value 
from the expression is used for the primary key in a subsequent Insert statement. The primary key is associated with 
a bind variable. The value of the bind variable is recorded and noted in the QALoad script. When the script is played 
back, the returned value from nextval will naturally be different from the value of the bind variable. The Insert SQL 
execution incurs a duplicate key error from the Oracle server.  

Oracle variabl izat ion prevents th is error by providing a logical relat ionship between the returned data 
from the Select statement and the data for the Insert  bind variable. The data relat ionship is establ ished 
through a source variable. 

!  To reduce diagnostic time for playback data issues, especially when dealing with large scripts. Using a single 
source variable for script variables that have the same data value reduces the amount of debugging time that would 
have been spent on multiple script variables. Additionally, the Compare Tool aids you in debugging data issues by 
highlighting SQL and data differences that could influence the load test of two similar capture files. 

Variabl i zat ion  m enu 

Access the Variabl i zat ion  menu from the Script Development Workbench's Session  menu, or by right-
cl icking from the variabl izat ion tree-view.  

Create/ Edi t  a source: Opens a tree-view of your variabl ized 
statements and their sources. 

Show  Capture Di f feren ce: Accesses the Compare Tool, where you 
can choose a capture fi le to compare to the current capture fi le and 
have the differences in  SQL statements and bind data h ighl ighted for 
your comparison with in the variabl izat ion tree-view.  

Revariabl i ze: Deletes al l  manually generated source variables and re-
executes auto-variabl izat ion. Note that datapool sources may not be 
changed back to PostBind, Fetch, or Stat ic data unless you select th is 
opt ion. 

Rem ove al l  sources: Deletes al l  source variables from the script 's .var 
fi le. 

Show  SQL statem en t : Provides a detai led view of the h ighl ighted 
SQL statement. The detai led view wil l  display associated Bind and 

Column data (from the Execute statement), associated PostBind data, and associated Fetch data. 
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Hin ts: Opens the Oracle Variabl izat ion Hints onl ine help. 

Word w rap: Shows the complete SQL statement in  wrapped format. This is selected by default . 

Displ ay opt ions: Al lows you to change display opt ions to one of the fol lowing: Only statements with bind 
variables, Unsourced Bind statements, or Show al l  SQL statements (default). 

The Refresh  the curren t  view  opt ion wil l  re-draw the tree-view after a source is manually changed. 

Save the Variabl i zat ion  VAR f i l e: Saves any changes to the script 's .var fi le. 

Save and Convert : Saves changes to the .var fi le and re-converts the script . 

Save and Convert  As: Saves changes to the .var fi le and prompts you to save your script  under a new name 
before re-convert ing i t . 

 

Variabl i ze 

Use th is dialog box to variabl ize a fi le or to compare two similar fi les. The results are displayed in a tree-
view from which you can manually variabl ize the fi le or view the differences between the two fi les. When 
you compare two fi les, the differences in  SQL statements and bind data are h ighl ighted with in the 
Variabl izat ion tree-view. 

Variabl i ze the fol l ow ing capture f i l e: Lists the path and name of the curren t ly selected capture fi le (.cap). 

Com pare and Variabl i ze w i th  the fol l ow ing f i l e: Navigate to the capture fi le you'd l ike to compare to the 
current ly selected capture fi le. 

Variabl i ze: Variabl izes the fi le and displays the recorded SQL statements, bind variables, stat ic variables 
embedded in SQL statements, data values and the sources of data values as determined by auto-
variabl izat ion. 

Cancel : Closes the dialog box without making any changes. 

 

Source Detai l s 

Displays detai ls about the source of the selected variable, and al lows you to replace the source with data 
from a central or local datapool.  

Nam e: Lists the name of the field in  the script  that was variabl ized. 

Value: Lists the value assigned to the variabl ized field. 

Line #: Lists the script  l ine where the field is located. 

(Defaul t ) From  Postbind/ Fetch / Stat i c data: If th is opt ion is selected, the source of the variable was 
determined by auto-variabl izat ion.  

Source variable nam e in  Convert  scri pt : The name assigned to the variable by auto-variabl izat ion, or 
when replaced by a datapool variable. 

From  datapool : Select th is opt ion to change the source to a central or local datapool. 

Field Num ber : Specify the column number in  the datapool fi le to use as the source. 

Advanced Opt ions: Cl ick to open the Act iveData Advanced Source Options dialog box where you can 
format the source before using i t , if necessary. 

Displ ay val ues m atched by auto-variabl i zat ion : In  th is area, cl ick the appropriate button to determine 
which values to display: Sources, Matching values, or Matching names and values. 

M atch  exact : Select i f the source must be an exact match, or de-select to use the source for a sub-string 
search. 
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Update Source: Cl ick to update the variable source according to the sett ings on th is dialog. 

Update ALL: Cl ick to use the newly created source variable for al l  i tems in the l ist  area. 

Delete Source: Cl ick to delete the variable and al l  i ts references from the tree-view. 

Qui t : Cl ick to cancel without saving any changes. 

 

Com paring f i l es 

The Oracle Variabl izat ion Compare Tool compares two similar capture fi les and h ighl ights the differences 
in  SQL statements and bind data and h ighl ights them in the Variabl izat ion Tree View. 

Why use the Compare Tool? 

The Compare Tool can help you debug data issues in  your transact ion that may cause load test problems, 
especial ly in  large scripts. With the differences h ighlighted in  a window display, you can quickly determ ine 
i f manual variabl izat ion is warranted for specific variables. Manual variabl izat ion can help you work 
around data issues that in fluence load tests. 

To use t he Com pare Tool : 

1. In the Workspace pane, right-click on the first capture file you want to compare and select Variablize from the 
shortcut menu. The Variablize dialog box opens, displaying the path and name of the selected file.  

2. Select the Compare and Variablize with the following file check box, and then navigate to the capture file you 
wish to compare against the first selected file. 

3. Click the Variablize button. A new tab opens in the Script Development Workbench, presenting a tree-view of the 
data. Differences in SQL statements and bind data are highlighted. 

4. View differing values by clicking on a highlighted bind variable or SQL statement. The Show Capture Difference 
window will open, listing the value used in each file.  

5. If you don't need to change the data, click OK to be returned to the tree-view. If you need to change the source of a 
bind item to a datapool variable, click Go to Source Display. The Source Details (for bind data) window or Show 
SQL Statement (for SQL statements) window opens. 

6. Change the source of any variables to call datapool items. 

7. Save the .var file and convert your capture file to build an updated script by right-clicking and selecting Save and 
Convert or Save and Convert As. 

 

Set t i ng up QALoad to run  Oracle scri pts on  UNIX 

After instal l ing the QALoad UNIX Player and ut i l i t ies, you should ensure that the fol lowing environment 
variables are set prior to start ing the Player Agent (loadagent):  

Plat form  Envi ronm en t  
Variable 

Value 

Al l  Plat form s: ORACLE_HOME <path>/oracle/product/<version> 

 TNS_ADMIN <location of config files> 

 ORACLE_SID <oracle instance name 

Linux : LD_LIBRARY_PATH <playerdir>/lib:<ORACLE_HOME>/lib
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Solari s: LD_LIBRARY_PATH <playerdir>/lib:<ORACLE_HOME>/lib

 

Sett ing environment variables on UNIX systems depends on your login shel l . For example: 

!  For ksh: export ORACLE_HOME=/oracle/product/8.1.6 

!  For csh: setenv ORACLE_HOME /oracle/product/8.1.6 

The ORACLE_HOME environment variable points to the directory where the Oracle workstat ion software 
has been instal led. The TNS_ADMIN environment variable should point to the locat ion of the cl ient 
and/or server config fi les. ORACLE_SID should be set to the name of the Oracle instance. For each UNIX 
platform, update the appropriate l ibrary path variable to include the l ibrary di rectory for the part icular 
version of Oracle. 

Scripts wi l l  automatical ly be downloaded to the Player machines by the Conductor and compiled, i f 
necessary, at test execut ion t ime. 

During the automatic script  download and compile, i f a script  compile error occurs, a scriptname.err fi le 
wi l l  be generated in  the scripts directory. 

To compile a script  by hand, use the Rmake command. The syntax is as fol lows: 

Rmake <scriptdir>/<scriptname> 

   or 

Rmake <scriptdir>/<scriptname>  

 

Oracle com m and referen ce 

QALoad provides descript ions and examples of the various commands avai lable for an Oracle script . For 
detai ls, refer to the Language Reference Help sect ion for Oracle OCI Version 7, General Oracle, or Oracle 
OCI Version 8. 

 

OFS 

Recording from Oracle Forms Server 

QALoad supports recording Oracle Forms 10g, 9i, and patched 6i (versions 6.0.8.14 and up) appl icat ions in  
HTTP mode (also cal led Servlet mode), Forms 6.0 and 6i appl icat ions in  socket  mode, and SSL-enabled 
Oracle Forms 9i and 10g appl icat ions. These recording types are described briefly below. 

Recording Servlet  M ode 

Oracle 9iAS and Oracle Appl icat ion Server 10g use HTTP to send Forms data across the network. To record 
in  Servlet mode, select the appropriate Servlet M ode opt ion in  the Record Opt ions dialog box before you 
start  recording your appl icat ion.  

Note: When using server-side recording, you must perform steps to configure the server. See Using server-
side recording for more information. 

Recording SSL M ode 

To record an OFS Servlet Mode appl icat ion in  SSL mode, select the appropriate Servlet mode opt ion in  the 
Record Options dialog box, and enter the Jin it iator certDB fi le that the appl icat ion uses. The certDB fi le 
veri fies the SSL Cert i ficate Authori ty on the cl ient side prior to the Forms connect ion.  
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Note: SSL mode is not available with server-side 9i recording. 

Recording Socket  M ode 

For Socket M ode recording, QALoad must start  your appl icat ion for you through your browser. Before 
recording, enter the URL of the Forms applet page in the URL field, and the Form s Server  port  in  the Port  
field. If you leave the Port  field blank, or enter an incorrect port  number, your recording wil l  on ly result  in  
an empty capture fi le. You may leave the URL field blank, but wi l l  be prompted for the Forms applet page 
on the in i t ial  browser page. From the applet page, cl ick the l ink to your Forms appl icat ion. QALoad wil l  
take over recording at th is point. 

 

Using server-side recording 

For Forms appl icat ions running in  Oracle 9iAS, you can use server-side recording, which avoids issues that 
can be encountered with some server configurat ions. Server-side recording creates a script  recording by 
using the Forms server's own capabi l i t ies to record transact ions.  

To enable server-side recording, select the 9i  Server-Side Recording check box on the Oracle Forms Server 
Record Options dialog box and provide the URL of the ListenerServlet in  the ListenerServlet  field. 

Server setup 

Before recording a script  using server-side recording, you must fi rst  modify the server configurat ion so that 
QALoad can communicate with the server properly. Once the server modificat ions are complete, recording 
and playback are the same as for standard OFS scripts. 

To prepare t he Form s server  f or  ser ver -side recording: 

1. Copy the ofsmessage.jar file from the \QALoad\Classes directory of the QALoad installation on the client 
machine to the \FORMS90\JAVA directory of the Oracle 9i Application Server installation on the server machine. 

2. Add a new section of configuration parameters to the formsweb.cfg file in the \FORMS90\server directory of the 
Oracle 9i Application Server installation. Use the following format, substituting your own information for the items in 
boldface type: 
 
[MsgBlk] 
form=test1.fmx 
userid=scott/tiger@iasdb 
archive_jini=f90all_jinit.jar,OfsMessage.jar 
archive_ie=f90all.cab,OfsMessage.jar 
archive=f90all.jar,OfsMessage.jar 
formsMessageListener=oracle.forms.iserver.MessageListener 
recordFileName=c:\temp\is 

3. When you begin to record, append a config parameter on the initial browser page's URL, as shown in boldface type in 
the following sample URL: 
http://ntsap45b:7779/forms90/l90servlet?config=MsgBlk 
  

  

Oracle Forms Server Recording Options 

QALoad records through your default  browser.  

Connect ions 

Form s version : Select your Oracle Forms Server version. This parameter must match the version of 
WebForms you are using or you wil l  not be able to record. You can select: 

!  10g Servlet - for Oracle Application Server 10g 
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!  9i Servlet - for Oracle 9i Application Server 

!  6i Servlet - for version 6i Servlet Applications 

!  6i Servlet (11i) - for version 6i Applications running in the 11i e-BusinessSuite 

!  6i Socket - for version 6i Applications in Socket mode 

!  6.0 Socket - for Forms 6.0 

Enable server-side recording: Select to enable Oracle Forms 9i server-side recording. 

Li stener servlet  URL: Type the URL of the l istener servlet that is used by the appl icat ion under test. 

Use SSL: Select th is opt ion i f the appl icat ion uses Forms Version 9i and the appl icat ion is SSL-enabled.  

Cert i f i cate f i l e: For SSL mode only. Type the name of, or browse for, the Oracle Jin it iator's certDB 
fi le that is located on the cl ient machine. The certDB fi le is used by Oracle 9i to veri fy the SSL 
Cert i ficate Authori ty on the cl ient side prior to the Forms connect ion. 

Socket  URL: For socket connect ions with Oracle Forms versions 6i or 6.0, enter the URL to in i t iate your 
applet. If you are recording from 9i, th is field is unavai lable.  

Port : If your Oracle Forms version is anyth ing other than 9i, type the port  number on your Oracle Forms 
Server appl icat ion server for QALoad to l isten on. This is the same port  as the Forms l istener (usual ly 9000). 

To det erm ine t he server  por t : 

1. Start the WebForms application in the browser. 

2. Once the application has started, choose the menu option View>Source. 

3. Look in the source code for a line that resembles this: 
<PARAM NAME = "serverPort" VALUE ="9000" >. This value is the server port. 

Addi t i onal  Jar Fi l es 

Override appl i cat ion  defaul ts: If you need to use Java resources other than those that are your 
appl icat ion 's defaults, select the check box and then cl ick Add  to navigate to the appropriate JAR fi les and 
add them to the l ist .  

 

Oracle Forms Server conversion options 

General  

Stop runn ing w hen  server m essages indicate errors: Select to check server messages for errors. If th is 
opt ion is selected, the script  stops running i f errors are encountered. If th is opt ion is not selected, the script  
ignores errors and cont inues. 

Stop on ly i f  server m essage m atches speci f i ed st r i ng: Select to al low script  fai lure only i f the 
specified server message is received. This opt ion is avai lable only i f the Stop runn ing w hen  server 
m essages indicate errors is also selected. 

M essage: Type a string to match against server messages, and select one of the fol lowing match 
types: 

con tains: Match based on the specified characters appearing anywhere in  the message. 
i s exact l y : Match based on the specified complete error message name. 
begins w i th : Match based on the specified characters appearing at the beginning of the 
message. 
ends w i th : Match based on the specified characters appearing at the end of the message. 
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Socket  M ode 

Send heartbeat  every [n ] m inutes: Type the number of minutes between each Forms 6i heartbeat 
message. Compuware recommends using a value of 4 or more to prevent socket usage issues. 

Sim ulate an  Oracle Appl i cat ions 11i  Login : Select to simulate an Oracle Appl icat ions 11i login via a 
Personal Home Page. Then complete the fol lowing three fields: 

Hom ePage URL: Type the locat ion (URL) of the Personal Home Page.  
Userid : Type the user name to be used on the Personal Home Page.  
Passw ord : Type the password for the user name that  is specified above in the Userid  field. 

 

Post  Capture Opt ions: Opens the OFS Post Capture Options dialog box where you can process a WWW 
fi le that is hexadecimal encoded (proxycap). This produces a new cap fi le, postcapweb fi le, longcap fi le, 
and sortedcap. This process overwrites these fi les when they already exist . 

Note: Before using Post Capture processing, you must select the appropriate Forms version in the Oracle 
Forms Server Record Options dialog box.  

 

 

Checkpoints in Oracle Forms Server scripts 

EasyScript for Oracle Forms Server supports QALoad's automatic middleware checkpoint t im ings in  both 
HTTP and socket modes. Default  checkpoints (Begin/End Checkpoint pairs) are not supported.  

Automatic checkpoints are enabled from the Conductor's Tim ing Opt ions column on the Script  
Assignm en t  tab and are enabled on a script-by-script  basis.  

At playback, automatic checkpoints are executed during the ofsSendRecv statement. 

 

Forms validation/playback debugging options 

Debug data 

When the Debug Data opt ion is enabled on the Configure Script  Development Workbench dialog box for 
val idat ion, or the Conductor's Debug Trace opt ion is enabled for playback, executed script  statements wi l l  
be displayed. For example:  

VU 0 : Line:90, ofsSetWindowSize( "FORMWINDOW" ,6, OFS_ENDMSG, 137, 750, 600 ) 
VU 0 : Line:91, ofsActivateWindow( "WINDOW_START_APP" ,11, OFS_ENDMSG, 247 ) 
VU 0 : Line:92, ofsShowWindow( "WINDOW_START_APP" ,11, OFS_ENDMSG, 173 ) 
VU 0 : Line:93, ofsFocus( "BUTTON" ,51, OFS_ENDMSG, 174 ) 
VU 0 : Line:94, ofsSetWindowSize( "FORMWINDOW" ,6, OFS_ENDMSG, 137, 750, 600 ) 
VU 0 : Line:95, ofsSendRecv( 1 )  //ClientSeqNo=2|MsgCount=6 

 

Oracle Forms Server method reference 

QALoad provides descript ions and examples of the various methods and funct ions avai lable for an Oracle 
Forms Server script . For detai ls, refer to the Language Reference Help sect ion for Oracle Forms Server. 

 

Using the certDB File for OFS Replay 

In  some Oracle Forms Server environments, the cert i ficates needed for the SSL handshake with the server 
are not in  the default  wal let  used during replay. This causes the SSL handshake to fai l . 

You can use the certDB fi le used by JIn it iator for OFS replay. To do th is for Script  Val idat ion, place the 
certdb.txt  fi le in  the BinaryFi les directory. 
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To use t he cer t DB f i le f or  OFS replay in  Conduct or : 

1. In the Conductor's Script Assignment tab, select a script in the Script column. 

2. Click Browse  . The External Data dialog box appears. 

3. In Attached Files, click Add. The Add Attached File dialog box displays. 

4. From the BinaryFiles folder, select certdb.txt, then click Open. 

5. Click OK. 

Advanced Scripting Techniques 

Understanding the C++ script  

Oracle Forms Server scripts are produced for Oracle Forms, 6.0, 6i, and 9i (Release 2 and later) recordings. 
The C++ script  executes OFS-related statements by passing the statements in  the script  DLL to the OFS Java 
engine that performs the cl ient act ivi t ies and the cl ient communicat ion with the server. Because the C++ 
script  statements are direct ly t ied to corresponding methods in the OFS Java engine, modificat ions to the 
script  statements are l im ited to changing the property parameter values through variabl izat ion. 

An OFS C++ script  contains three main sect ions: Connect ion, Appl icat ion Body, and Disconnect. The 
QALoad transact ion loop includes al l  three sect ions by default .  The transact ion loop can be moved using 
the guidel ines described in Moving the OFS transact ion loop.  An internal auto checkpoint is created 
during connect ion statements and transmission statements. 

The C++ script  statements are a condensed version of the Java-style script  statements.  The C++ script  
statements show the GUI controls in  the OFS appl icat ion and the control propert ies, which are either 
control at tributes or act ivi t ies. For example: 

ofsClickButton( "BUTTON", 52, OFS_ENDMSG, 325 ); 

In  th is example, the user cl icks (property 325) a button ( control ID 52).  OFS_ENDMSG is a flag that 
indicates that the GUI act ivi ty ends the current OFS Message.  

QALoad also al lows OFS and WWW statements from a Universal session to be scripted in  the C++ script , 
providing the abi l i ty to play back WWW and OFS statements. 

 

Connect ion  statem en ts 

The connect ion script  l ines in  the C++ script  vary depending on the type of Forms connect ion mode that is 
act ive. You choose the Forms connect ion mode on the Oracle Forms Server Recording Options dialog box. 
Forms connect ion modes include server-side recording, HTTP, HTTPS, or socket. 

Server-side recording is l im ited to appl icat ions that  use Forms 9i (appl icat ions running in Oracle 9iAS 
Release 2 and above). HTTP connect ion mode is avai lable for appl icat ions using Forms 9i and for 
appl icat ions using the patched Forms 6i version configured with the HTTP servlet. HTTPS connect ion 
mode is strict ly for SSL-enabled appl icat ions that use Forms 9i. Socket connect ion mode is for appl icat ions 
that use Forms 6i and lower versions, such as Oracle 11i. 

Server-side recording connect ions 

Server-side recording mode contains only one connect ion statement. The funct ion that is used – 
ofsSetServletMode –  contains the l istener servlet value that you entered on the Oracle Form s Server 
Recording Opt ions dialog box. The first  parameter defines the HTTP or HTTPS configurat ion of the 
appl icat ion environment. The second parameter defines the name of the Forms Listener Servlet used by the 
appl icat ion. To connect, QALoad internal ly invokes Oracle’s dispatch cal ls using the two parameters. 
Oracle’s proprietary classes provide the implementat ion for the HTTP or HTTPS connect ion.  For example: 

ofsSetServletMode(OFS_HTTP, "http://ntsap45b:7779/forms90/l90servlet" ); 
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HTTP connect ions 

HTTP connect ion mode contains mult iple connect ion statements. To connect, QALoad internal ly performs 
Java cal ls to accomplish the fol lowing tasks:   

!  Define HTTP header properties 

!  Connect to the Forms Servlet (an HTTP-GET request) 

!  Set the parameters of the Forms Listener Servlet 

!  Connect to the Forms Listener Servlet (an HTTP-GET request) 

!  Set additional HTTP header property for the Listener Servlet 

!  Connect to the Forms Listener Servlet (an HTTP-POST request). The last connection statement also initiates the 
required Forms “handshake” and determines the Forms encryption used by the application environment.  

For example: 

ofsHTTPSetHdrProperty("User-Agent", "Java1.3.1.9" );  
ofsHTTPSetHdrProperty("Host", "ntsap45b:7779" );  
ofsHTTPSetHdrProperty("Accept", "text/html, image/gif, image/jpeg, *; q=.2, "*/*; q=.2" 
);  
ofsHTTPSetHdrProperty("Connection", "Keep-alive" );  
ofsHTTPConnectToFormsServlet( 
"http://ntsap45b:7779/forms90/f90servlet?ifcmd=startsession"  ); 
ofsHTTPSetListenerServletParms( "?ifcmd=getinfo&ifhost=C104444D01&ifip= "192.168.234.1" 
); 
ofsHTTPConnectToListenerServlet( "http://ntsap45b:7779/forms90/l90servlet"); 
ofsHTTPSetHdrProperty("Content-type", "application/x-www-form-urlencoded" );  
ofsHTTPInitialFormsConnect(); 

HTTPS connect ions 

HTTPS connect ion mode uses the same connect ion statements as HTTP mode. To connect, QALoad 
internal ly performs the same tasks as the HTTP connect ion mode plus i t  performs the SSL connect ion 
when the ofsHTTPSDoSSLHandshake funct ion is cal led. This statement is posit ioned in the script  before 
the ofsHTTPConnectToFormsServlet funct ion. 

Socket connect ions 

Socket mode contains only one connect ion statement.  The funct ion that is used – ofsConnectToSocket  – 
contains the port  number and the URL you entered on the OFS Recording Options dialog box to start  OFS 
capture. The port  value is the port  on which the Forms Server direct ly l istens for Forms traffic. To connect, 
QALoad uses Java cal ls to open a Java socket using the parameters, in i t iate the required Forms "handshake” , 
and determine the Forms encrypt ion used by the appl icat ion environment. For example: 

ofsConnectToSocket("10.10.0.167", 9002 ); 

 

Appl i cat ion  statem en ts 

The appl icat ion statements in  the C++ script  consist of property statements and transmission statements. 
Property statements describe the attributes and act ivi t ies of GUI controls in  the appl icat ion. Transmission 
statements send the GUI controls and their propert ies as Forms Message data to the server. There is only 
one transmission statement: ofsSendRecv. QALoad creates an in ternal auto checkpoint when th is statement 
is executed. In  the fol lowing example, the first  two (property) statements set the locat ion and size of a 
FormWindow GUI control. The ofsSendRecv statement sends the GUI control  propert ies to the server. 

ofsSetWindowLocation( "FORMWINDOW", 6, OFS_ENDMSG, 135, 0, 0);   //Property  
ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 650, 500);   //Property 
ofsSendRecv(1 ); //Transmission 

Parameters of a property statement: 
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The parameters of a property statement are arranged in the fol lowing sequence: 

1. Captured control name.  If the name is not available, this value is the class name to which the control belongs. 

2. Captured control ID. 

3. Action type. This flag indicates if the property is to be added to the current Forms Message or if the property ends 
the current Forms Message. During playback, each control is treated as a Forms Message.  When the current 
Message ends, QALoad translates the control and its properties to binary format. The valid values are: 

 OFS_ADD –  add the property to the current Message. 

 OFS_ENDMSG – add the property to the current Message and end the Message. 

 OFS_STARTSUBMSG – add the property of the succeeding nested Message to the current 
Message. 

4. Property ID. The Forms version-specific ID of the property. 

5. Property value. Captured value of the property (optional) 

6. Property value. Captured value of the property (optional) 

For example: 

ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 650, 500); 

In  th is example, control ID 6, which belongs to GUI class FORMWINDOW, is resized (PROPERTY 
137) to have coordinates 650 and 500. This marks the end of the current Message. 

Forms environment statements: 

The in it ial  set of statements in  the Forms script  describes the Forms appl icat ion environment.  In  th is set, 
the "version ”  and the “ cmdline”  propert ies are the most important. The version property shows the Forms 
Bui lder version used by the appl icat ion. The version  indicates the capabi l i t ies of the appl icat ion. For 
example, some versions cannot support HTTP connect ions. The cmdline property shows the Forms 
configurat ion parameters passed to the server by the Forms applet. The parameter “ record=names”  
indicates that the appl icat ion enables GUI control names to be captured. Control names are preferred in  
mult i-threaded playback. The “ ICX”   parameter indicates that the appl icat ion  uses a Personal Home Page, 
which requires that you supply OracleAppsLogin in formation on the Oracle Forms Server Convert  opt ions 
dialog box for the script  to run successful ly. 

In  the sample script  below, the Forms bui lder version is 90290 (the version used in Oracle 9iAS Release 2, 
unpatched). The cmdline property shows “ record=forms”  which defaults “ record=names” . The cmdline 
property does not have the “ ICX”  t icket parameter. 

ofsSetInitialVersion( "RUNFORM", 1, OFS_ADD, 268, "90290" ); 
ofsSetScreenResolution( "RUNFORM", 1, OFS_ADD, 263, 96, 96); 
ofsSetDisplaySize( "RUNFORM", 1, OFS_ADD, 264, 1024, 768); 
ofsInitSessionCmdLine("RUNFORM", 1, OFS_ADD, 265,  
 "server module=test1.fmx userid=  sso_userid=  debug=no buffer_records=no debug_" 
 "messages=no array=no query_only=no quiet=yes render=no host=ntsap45b.prodti.com" 
 "puware.com port= record=forms tracegroup=debug log=run1 term=" ); 
ofsSetColorDepth( "RUNFORM", 1, OFS_ADD, 266, "256" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "0" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "8421504" ); 
ofsSetFontName( "RUNFORM", 1, OFS_ADD, 383, "Dialog" ); 
ofsSetFontSize( "RUNFORM", 1, OFS_ADD, 377, "900" ); 
ofsSetFontStyle( "RUNFORM", 1, OFS_ADD, 378, "0" ); 
ofsSetFontWeight( "RUNFORM", 1, OFS_ADD, 379, "0" ); 
ofsSetScaleInfo( "RUNFORM", 1, OFS_ADD, 267, 8, 20); 
ofsSetNoRequiredVAList( "RUNFORM", 1, OFS_ADD, 291 ); 
ofsSetPropertyString( "RUNFORM", 1, OFS_ENDMSG, 530, "America/New_York" ); 
ofsSendRecv(1 ); 
//ClientSeqNo=1|CapTime=1086884188.281|MsgCount=1 

Sending messages to the server: 
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The ofsSendRecv statement sends the accumulated GUI controls and their propert ies to the Forms Server as 
binary data. This statement represents the point at which the cl ient sends a Forms Terminal Message to the 
server. In  Oracle Forms, the cl ient and the server must end each data block with a Terminal Message before 
any transmission occurs. 

In ternal ly, QALoad varies the binary data transmission depending on the connect ion mode: 

!  For server-side recording mode, QALoad sends the binary data by invoking Oracle’s dispatch calls. Oracle’s own 
classes provide the implementation for the HTTP transmission.  

!  For HTTP or HTTPS mode, QALoad wraps the binary data inside an HTTP stream and invokes Java’s HTTP calls.  

!  For socket mode, QALoad sends the binary data directly to the Java socket opened at the connection point. 

The ofsSendRecv statement has one parameter: the response code of the captured Terminal Message. The 
possible values for th is parameter are 1 (add), 2 (update), and 3 (close). Typical ly, when the response code 
is 3, the Forms Server reacts by removing the GUI controls associated with the cl ient message from the 
server cache. 

A comment l ine appears after each ofsSendRecv statement that contains script-tracking in formation. The 
information on the comment l ine is also found in the capture fi le in  each ofsSendRecv capture l ine. The 
comment l ine shows the relat ive sequence of each cl ient request, as represented by a Terminal Message, 
from the start  of the appl icat ion (e.g. Cl ientSeqNo=1). The comment l ine also shows the t im ing mark of 
the captured Terminal Message (e.g. CapTime=1086884188.281) and the number of Forms messages 
contained in the request (e.g. MsgCount=1). The number of Messages can be veri fied by count ing the 
preceding ENDMSG and STARTSUBMSG flags in  the request block. The comment l ine is useful for 
debugging playback issues because i t  readi ly shows the cl ient request sequence number where the issue is 
occurring. 

Getting the server reply: 

During the execut ion of ofsSendRecv, QALoad also obtains the server’s reply and translates the binary 
Forms data in to Forms control values and control propert ies. The values are also writ ten to the playback 
log fi le (in  capture fi le format) i f script  logging is enabled. The fol lowing sample is a server reply: 

VU 0 :   M|S|2|0|1 
VU 0 :   P|S|322|java.lang.Integer|0|151000320 
VU 0 :   P|S|279|java.lang.Boolean|0|false 
VU 0 :   P|S|525|java.lang.String|AMERICAN_AMERICA.WE8MSWIN1252 
VU 0 :   T|S|1|ServerSeqNo=1|MsgCount=76 

The first  l ine indicates the start  of a Forms Message from the server (M |S). The th ird parameter is an act ion 
code (1= add, 2= update, 3= delete, 4= get property value). The fourth parameter is the Class Code of the 
control (0 = root class). The fi fth  parameter is the Control ID (1= RunForm). 

The second, th ird and fourth l ines are property l ines related to the above Forms Message from the server 
(P|S).  The th ird parameter of each l ine is the property ID (322). The fourth parameter is the data type of 
th is property (java.lang.In teger). The fi fth  parameter is the data value. If the value is 0, the data value is in  
a sixth parameter (false).  

The th ird l ine is the terminal message l ine from the server (T|S). The th ird parameter is the response code 
associated with the terminal message (1= add, 2= update,  = close). The fourth parameter is the relat ive 
sequence of the server reply, as represented by a Terminal Message, from the start  of the appl icat ion (e.g. 
ServerSeqNo= 1). The fi fth  parameter is the number of Forms messages contained in the reply (e.g. 
MsgCount = 1). The number of Messages may be veri fied by count ing the preceding M|S flags in  the reply 
block.  The fourth and fi fth  parameters are script-tracking in formation, which can be useful for debugging 
a playback issue. If logging is enabled, the log fi le shows the tracking in formation, which can make the 
comparison between server responses and captured responses easier. 

Processing large data and delayed response scenarios: 

When HTTP or HTTPS connect ion mode is used, Forms data is wrapped inside the HTTP reply stream. 
QALoad checks the HTTP header of the reply before processing the Forms data.  The HTTP header 
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sometimes indicates that the cl ient needs to perform addit ional HTTP POST requests to obtain the 
complete Forms data. This indicat ion occurs when the content-length of the reply is 64000 (a large data 
scenario), or the content-type is "text/plain ”  and the HTTP header contains an  “ i ferror: ”  string (a delayed 
response/re-post scenario). QALoad performs the necessary POST requests to obtain the complete reply 
data, and then translates the accumulated reply data to Forms controls and propert ies. 

 

Disconnect  statem en ts 

The disconnect script  l ines vary depending on the Forms connect ion mode.   

!  In server-side recording mode, the ofsServerSideDisconnect script statement internally invokes Oracle’s dispatch 
calls to disconnect.  

!  In HTTP mode, the ofsHTTPDisconnect statement internally makes Java calls to disconnect the main URL 
connection from the servlet.  

!  In socket mode, the ofsSocketDisconnect statement closes the socket on which the Forms Server listens for traffic. 

 

Using scri pt  l ogging as a debugging tool  

You can debug a playback issue in a C++ script  by enabl ing replay logging. The opt ion for enabl ing replay 
logging is located on the Script Assignment tab of the Conductor. For more in formation about enabl ing log 
fi le generat ion, see Debugging a script .  

In  Java-based scripts, logging is not enabled by default . To enable logging, change the parameter of the 
Logging method to true in  the script . For example: 

oracleForms.Logging( true ); 

When logging is enabled, QALoad writes the cl ient requests and server repl ies to the playback log fi le in  the 
same format as the capture fi le. The playback log fi le is found in the \QALoad\LogFiles directory. When 
there is an issue during playback, such as the server not responding to a cl ient  request, you can compare 
the capture fi les and check the differences in  the server reply data. Both the capture fi le and the log fi le 
contain tracking in format ion appended to the server’s terminal messages. The tracking data contains the 
relat ive sequence number of the server reply from the start  of the Forms session and the t im ing mark. The 
tracking data also shows the number of Forms messages contained in the reply block. The number of 
messages are based on the number of  “ M|S”  l ines prior to the “ T|S”  l ines.  

In  the fol lowing example, the first  set of statements shows the logged statements and the second set of 
statements shows the captured statements. The ServerSeqNo value shows that th is is the 8th reply from the 
server. The MsgCount value of 1 shows that only one Forms Message is included in th is reply block. 

1087419810.000|ofsShowWindow|WINDOW_START_APP|11|OFS_ENDMSG|173|PROPERTY_VISIBLE|java.lang.B
oolean|true 
1087419810.000|ofsSendRecv|1|ClientSeqNo=8|CapTime=1087419810.000|MsgCount=1 
1087419810.000|M|S|2|0|30 
1087419810.000|P|S|135|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087419810.000|P|S|137|java.awt.Point|0|java.awt.Point[x=706,y=464] 
1087419810.000|P|S|139|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087419810.000T|S|1|ServerSeqNo=8|CapTime=1087419810.000|MsgCount=1 

   

1087402349.296|ofsShowWindow|WINDOW_START_APP|11|OFS_ENDMSG|173|PROPERTY_VISIBLE|java.lang.B
oolean|true 
1087402349.296|ofsSendRecv|1|ClientSeqNo=8|CapTime=1087402349.296|MsgCount=1 
1087402349.296|M|S|2|0|30 
1087402349.296|P|S|135|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087402349.296|P|S|137|java.awt.Point|0|java.awt.Point[x=706,y=464] 
1087402349.296|P|S|139|java.awt.Point|0|java.awt.Point[x=0,y=0] 
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1087402349.296|T|S|1|ServerSeqNo=8|CapTime=1087402349.296|MsgCount=1 
  

 

 

M oving the OFS t ransact ion  loop 

To enable movement of the QALoad transact ion loop in the C++ script , you must fi rst  record a ful l  business 
transact ion and a part ial  business transact ion. The business transact ion is the act ivi ty that you would l ike 
to repeat during QALoad playback.  Insert  QALoad capture comments (using the Insert  Com m and  button 
on the Recording toolbar) at the start  and end of a business transact ion. These comments wi l l  help you 
find the spots in  the script  where you would l ike to reposit ion the BEGIN_TRANSACTION() and 
END_TRANSACTION() statements. Then re-start  the business transact ion.  

QALoad's OFS script  presents a sequence of Forms GUI objects. The GUI objects contain context 
dependencies. For example, when a window is opened, the buttons, text fields and edit  boxes inside that 
window are logical ly dependent on the state of that window. When only one business transact ion is 
captured and the corresponding script ’s transact ion loop is moved, the sequence of the GUI objects is 
broken during the second i terat ion of the transact ion loop. The broken sequence results in  a broken 
context, which causes the server to respond unpredictably during playback on the second and subsequent 
i terat ions of the transact ion loop. When the business transact ion is restarted during capture, the Forms 
GUI objects that compose the new transact ion are used to anchor in to the new transact ion loop without 
breaking the context dependencies of  GUI objects. 

When modifying the script , use the comment l ines as guides in  moving the END_TRANSACTION()  and 
BEGIN_TRANSACTION() statements. Ensure that there is a contextual flow from the new posit ion of the 
END_TRANSACTION() statement to the new posit ion of the BEGIN_TRANSACTION() statement. The set  of 
GUI objects that belong to the ofsSendRecv() statement just before the new END_TRANSACTION() 
statement must be the same as the set of GUI objects that belong to the ofsSendRecv() statement prior to 
the new BEGIN_TRANSACTION() statement. 

During playback, modify the Conductor sett ing for Transact ion Pacing on the Script Assignment tab to 
al low the database to process each new business transact ion. 

The fol lowing example shows a modified OFS transact ion loop: 

New position of the BEGIN_TRANSACTION statement 

/* 
NewSales 
*/ 

DO_SLEEP(13); 
ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "B" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 1, 1); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "1" ); 
ofsIndexKey( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 175, 97, 0); 

DO_SLEEP(6); 
ofsSendRecv(1); //ClientSeqNo=31|MsgCount=2|1093981339.921 
BEGIN_TRANSACTION(); 

ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "Business World" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 14, 14); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "14" ); 
ofsRemoveFocus( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 174 ); 
ofsSetSelection( "ORDER_CUSTOMER_NUMBER_0", 564, OFS_ADD, 195, 0, 0); 
ofsSetCursorPosition( "ORDER_CUSTOMER_NUMBER_0", 564, OFS_ENDMSG, 193, "0" ); 
ofsFocus( "ORDER_CUSTOMER_NUMBER_0", 564, OFS_ENDMSG, 174 ); 

DO_SLEEP(6); 
ofsSendRecv(1); //ClientSeqNo=32|MsgCount=4|1093981347.296 
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New position of the END_TRANSACTION statement 

/* 
EndTrans 
*/ 

DO_SLEEP(39); 
ofsSendRecv(1); //ClientSeqNo=61|MsgCount=4|1093981458.031 

ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "14" ); 
ofsSelectMenuItem( "Sales Orders", 257, OFS_ENDMSG, 477, "MENU_11059" ); 

DO_SLEEP(26); 
ofsSendRecv(1); //ClientSeqNo=62|MsgCount=2|1093981485.265 

ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "B" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 1, 1); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "1" ); 
ofsIndexKey( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 175, 97, 0); 

DO_SLEEP(3); 
ofsSendRecv(1); //ClientSeqNo=63|MsgCount=2|1093981488.437 
END_TRANSACTION(); 

ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "Business World" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 14, 14); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "14" ); 
ofsIndexSKey( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 176, 10, 0); 

DO_SLEEP(13); 
ofsSendRecv(1); //ClientSeqNo=64|MsgCount=2|1093981502.640 

Tips:  
During capture, the OFS configuration parameter "record=names" must be enabled to produce control names 
that may be included in the converted script. Control names persist throughout the Forms session, unlike 
control IDs, whose values may change at runtime. Add the “ record=names”  parameter in the Formsweb.cfg 
file or add this parameter to the startup servlet URL. Control IDs can create problems when the transaction 
loop is moved. Some of the control IDs that have been instantiated by the server prior to the new transaction 
loop lose context during iterations of the new loop. For example, in a second loop iteration, the server 
assumes that these client controls are new, generates new control IDs, and eventually cannot find the proper 
context. Then the server stops responding. If control names are used, Forms objects that have been 
instantiated before the new transaction loop are maintained through all iterations of the loop because the 
control name persists throughout the application session. 
During playback, ensure that the sleep factor is at 100% and that the transaction pacing is set to a large 
enough value for the server to process the business transaction that is contained in the new loop. These 
options can be set on the Script Assignment tab of the Conductor. 

 

OFS and WWW Un iversal  sessions 

You can record with a Universal session to capture both the OFS and WWW transact ions and merge the 
two sets of t ransact ions in to one script . The captured WWW statements contain non-servlet, non-Forms 
data such as GIF objects, whi le the captured OFS statements contain the Forms data.  

Universal script ing for OFS-WWW sessions is avai lable in  C++ format only. After conversion, the WWW 
statements do not appear in  visual scripts. 

Note: The only Universal session combination that is available for Oracle Forms Server is the combination 
of WWW and Oracle Forms Server. 

When an Oracle Appl icat ions login is captured, the login can be scripted using the OracleAppsLogin 
statement or the ofsSetICXTicket statement. Compuware recommends that you use ofsSetICXTicket.  
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When OracleAppsLogin is used, the login is performed twice: once by the scripted DO_Http statement for 
the WWW act ions and again by OracleAppsLogin. To prevent dupl icate logins, you must comment out the 
DO_Http (WWW middleware) statement. 

When ofsSetICXTicket is used, the login is performed just once. This statement al lows the WWW login to 
execute, extracts the ICX t icket from the server reply, and passes the ICX t icket to the Forms session.  

To use ofsSetICXTicket, you must modify the script .  

To capt ure an Oracle Appl icat ions login w i t h  of sSet ICXTicket : 

1. Add the following variable declaration statements to the top of the script: 
char *p; 
char ICX_Ticket[100]; 
char *pTicket; 

2. In the *.postcapweb file, find the HTTP request that returns the ICX ticket. The reply should contain a string that 
indicates the ICX ticket value, such as "ICX_TICKET=". Note the left and right characters that delimit the ICX ticket 
value. In the example in step 4, the left delimiter is "icx_ticket='" and the right delimiter is "'". 

3. In the script, find the matching request line for the HTTP request. 

4. After the matching HTTP request line, add the DO_GetUniqueString statement using your chosen delimiters. For 
example: 
p = DO_GetUniqueString( "icx_ticket='", "'"); 

5. Add script lines that copy the extracted value into your script variables. 
strcpy(ICX_Ticket, p); 
pTicket=ICX_Ticket; 

6. (optional) Verify the ICX ticket value. 
RR__printf("ICX_Ticket=\"%s\"\n", ICX_Ticket); 

7. Add the script line ofsSetICXTicket(&pTicket); before the ofsInitSessionCmdLine. This passes the value of 
the ICX ticket to the ofsInitSessionCmdLine statement. 

8. Free the memory allocated by DO_GetUniqueString and ofxSetICXTicket before the end of the transaction:  

free(p); 
p=NULL; 
free(pTicket); 

pTicket=NULL 

 

SAP 

Linking errors during validation or compilation of SAP scripts 

When you re-record SAP 4.x scripts for SAP 6.20/SAP 6.40, you must cl ick the Bui ld SAP Libraries button 
on the SAP Convert  Options dialog box. This button generates new l ibraries based on the version of SAP 
that is current ly instal led. If you have upgraded to a newer version of SAP and do not update the l ibraries, 
you may experience various l inking errors during val idat ion or compilat ion. 

 

SAP script validation fails 

If your SAP script  fai ls during val idat ion, you may need to disable automatic proxy configurat ion in  
Internet Explorer. 

To disable aut om at ic p roxy conf igurat ion: 
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1. In Internet Explorer, click Tools>Internet Options. 

2. On the Connections tab, click the LAN Settings button. 

3. Ensure that the Use automatic configuration script check box is cleared. 

If disabl ing the automatic proxy configurat ion does not solve the problem, consider increasing the script  
execut ion t imeout value to 100 seconds or to the length of the capture fi le (in  seconds), whichever is 
greater. 

To increase t he t im eout  value: 

1. With an SAP session open in the Script Development Workbench, click Options>Workbench. 

2. On the Script Validation tab, type the new value in the Wait up to field. 

3. Click OK. 

 

SAP 4.x 

Overview  

Use QALoad's SAP middleware support to load test systems that run SAP 4.0B, 4.5 or 4.6D.  

What is SAP? 

The SAP GUI front end is a middleware that al lows user to access SAP servers from Windows. The SAP 
servers run various SAP business appl icat ions, such as appl icat ions for customer relat ionship management, 
human resources, and supply chain management. 

Connect ing to the SAP server 

First , you must connect to the SAP server. Once you have connected to a mach ine that is running the SAP 
server, you can log on and interact with the SAP appl icat ions.  

Recording scripts 

To record scripts with SAP 4.x, you must start  the QALSAP appl icat ion. The QALSAP appl icat ion enables 
you to connect and log on to the SAP server. 

 

 

SAP recording opt ions (Versions 4.x ) 

Before you can successful ly record transact ions from a SAP-based appl icat ion , you must select the Dialog 
(modal) opt ion on the Help>Set t i ngs>F4 Help tab in  the SAP appl icat ion. You must do th is for the user 
you are recording. 

User Started : Select th is opt ion i f you would l ike to start  your appl icat ion manually for recording, either 
before or after you start  recording 

Because th is method may fai l  to record your appl icat ion ’s in i t ial  cal ls, Compuware recommends you use 
the Automatic opt ion instead. 

Autom at i c: Select th is opt ion for QALoad to automatical ly start  your appl icat ion for recording, al lowing 
you to record early appl icat ion startup act ivi ty. This is the recommended method of recording, as i t  takes 
advantage of QALoad’s enhanced abi l i t ies to handle various mult i threaded programming techniques. 

Com m and Line: Enter or browse for the path to QALSAP, then enter the startup parameter \c. For 
example, enter: c:\Program Files\Compuware\QALoad\Qalsap.EXE \c. 
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The fol lowing addit ional startup parameters are avai lable: 

Param eter Descript i on  

\a Version 3.1 cl ients only. Use th is parameter in  place of \c i f QALSAP cannot connect to 
your Sapgui. QALoad wil l  then record direct ly from QALSAP. For example:  
c:\Program Files\Compuware\QALoad\Qalsap.EXE \a 

\m Minimizes the Sapgui window after successful ly logging in . For example: c:\Program 
Files\Compuware\QALoad\Qalsap.EXE \c \m 

\r# Where # is a number from one to five. Type \r fol lowed by a number from one to five to 
indicate how many t imes QALoad should attempt to login to Sapgui i f the first  at tempt 
t imes out. For example: c:\Program Files\Compuware\ QALoad \Qalsap.EXE \c 
\r5 

Work ing Di rectory : Enter the working directory of your SAP appl icat ion. 

Note: If you entered the full path in the Command Line field, this field is filled in automatically. 

Disable SAP En joy Durin g Capture: Select th is check box to disable SAP Enjoy (SAP 4.6 and above) before 
recording. If you choose not to disable SAP Enjoy, you must manually shut down the SAP cl ient tray 
appl icat ion before you stop recording.  

 

Start i ng QALSAP 

QALSAP is the appl icat ion  that enables recording from QALoad for SAP 4.x scripts. To begin recording, you 
must start  th is appl icat ion . 

To st ar t  QALSAP: 

1. From the Windows Start menu, choose Run. 

2. On the Run dialog box, type QALSAP.  

 

SAP conversion  opt ions (Versions 4.x ) 

Consol idate Checkpoin ts: Select to consol idate checkpoints with the same descript ion in to a single 
checkpoint. The checkpoint descript ion is the Tcode concatenated with the first  30 characters of the screen 
t i t le. 

If you do not select th is opt ion, and QALoad detects a dupl icate descript ion, i t  wi l l  append a sequence 
number after the checkpoint descript ion. 

Graph ical  User In terface: Select to view val idat ion in  graphical mode. If selected, the script  wi l l  step 
through val idat ion transact ions with SAPGUI running. Due to memory requirements (15-20 MB per user), 
select th is opt ion only i f you are replaying a single user.  

 

An im at ing an  SAP capture f i l e 

Animating a capture fi le plays back the series of t ransact ions from an SAP recording. 

To anim at e an SAP capt ure f i le: 
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1. Open an SAP session in the QALoad Script Development Workbench. 

2. In the Workspace Pane, click the Captures tab. 

3. Select the capture file you want to animate. 

4. From the Session menu, choose Animate>Start. The QALoad Script Development Workbench opens the file in 
QALSAP, where you can view each transaction graphically.  

 

View ing SAP 4.x  post -test  l og f i l es 

If you selected the Detai l ed Logging opt ion on the QALoad Script Development Workbench ’s SAP 
Conversion Options dialog box before you ran the test, QALoad automatical ly generated a log fi le for each 
virtual user named saplg###.log (where ### is the virtual user number) during the test. Each log fi le 
contains a graphical representat ion of the events sent to and received from the server for a part icular 
virtual user. 

You can open and delete a log fi le from the QALoad Script Development Workbench using the fol lowing 
procedure. 

To open a vi r t ual  user  log f i le: 

1. With an SAP session open in the QALoad Script Development Workbench, select File>Browse. 

2. On the Browse dialog box, double-click Log Files. 

3. After QALSAP opens, select File>Open. 

4. In the Files of Type field, select Log File. The Browse Log Files dialog box opens, displaying the available SAP 
log files. 

5. Double-click on the log file you wish to open. Log files are named saplg###.log, where ### is the virtual user 
number. 
 
QALSAP opens the selected log file. In the Line # column of the log file, each request by the client is marked by a 
blue “client” icon, while each response from the server is marked by a white “server” icon, as shown in the following 
image. 

 

 

Viewing request or response detai ls 

QALSAP al lows you to view detai led in formation about each request and response in the log fi le, including 
each logged SAP screen, and i ts menus, funct ion keys, and controls. 

You determine which in formation to display by select ing one or both of the fol lowing commands from the 
View  menu: 
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!  View>Show Event — Opens a detail window, displaying detailed information about each logged event, including 
screen names, key names, tool tip text, and so on. 

!  View>Show Form — Opens a form window, displaying a graphic representation of the logged SAP screen and 
related menus. 

To view  a speci f ic r equest  or  response: 

1. With a log file open in QALSAP, select the appropriate command(s) from the View menu to determine what amount 
of detail to view. 

2. Double-click on the line number of the request or response you want to view. Detail windows open for the selected 
request or response, depending on the options you set in the View menu. In the image below, both Show Event and 
Show Form were selected. 

 To view the next l ike response—for example, i f you are viewing a cl ient request and 
want to view the next cl ient request—select View >Goto Nex t  Respon se. Alternately, 
from the form window, cl ick the appropriate toolbar button to view the next or 
previous response. 

 To view the next event in  the log, select View >Goto Nex t  Even t . Alternately, from the 
form window, cl ick the appropriate toolbar button to view the next or previous event. 

 

 

 

SAP 4.x  com m and reference 

QALoad provides descript ions and examples of the various commands avai lable for an SAP script . For 
detai ls, refer to the Language Reference Help sect ion for SAP 4.x . 

 

SAP 6.x 

Overview  
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Use QALoad's SAP middleware to load test systems that run SAP 6.20 and 6.40.  

What is SAP? 

The SAP GUI front end is a middleware that al lows users to access SAP servers from Windows. The SAP 
servers run various SAP business appl icat ions, such as appl icat ions for customer relat ionship management, 
human resources, and supply chain management. 

Connect ing to the SAP server 

Once you have connected to a machine that is running the SAP server, you can log on and interact with 
the SAP appl icat ions.  

 

Conf iguring an  SAP cl i en t  for l oad test ing 

Before you can record an SAP session, you must have an SAP cl ient that is configured to enable QALoad to 
access the SAP server. Configure the SAP cl ient through the SAP Logon appl icat ion. 

To conf igure an SAP cl ien t  f or  load t est ing: 

1. Start the SAP Logon application. From the taskbar, click Start>Programs>SAP Front End>SAPlogon. 

2. Click the New... button on the SAP Logon dialog box. The New Entry dialog box appears. 

 

3. Type values in the Description, Application Server, and System number fields.  

Note: QALoad uses the value in the Descript ion field to connect to the server. 

4. Click OK. The new SAP server entry appears in the list in the SAP Logon dialog box. 

 

SAP recording opt ions (Versions 6.x ) 

Save Server Descri pt i on : Select to specify and save the server descript ion (name) to which you want to 
connect during recording. If th is check box is not selected, you are prompted for a server descript ion 
during the log on process. 

 

Recording an  SAP session  

An SAP server connect ion must be configured before you can connect with QALoad. See Configuring an 
SAP cl ient for load test ing for more in formation. Addit ional ly, your SAP administrator must set the 
SAPGUI/User_Scripting securi ty profi le parameter to TRUE to successful ly record a script . For more 
in formation about SAP securi ty sett ings, refer to the SAP publ icat ion t i t led "Sapgui Scripting Security". 

To record an SAP session: 
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1. In the Script Development Workbench, click the Record button on the Session toolbar. If you have not already 
chosen SAP as the session type, click the SAP Session button to activate a new SAP session. 

2. If you have not selected the Save Server Description record option, the SAP Server Description dialog box appears. 
Type the name of the SAP server to which you want to connect. This value is the same as the Description field that 
displays in the SAP Logon configuration application. Press Enter. A log on dialog box appears. 

 

3. Type a user ID in the User field and the password in the Password field. Press Enter. The SAP application starts.  

 

4. In the SAP application, turn off the scripting and notification options. Click the Customizing of local layout button 
and choose Options. The Options dialog box appears. On the Scripting tab, select Enable Scripting, but clear the 
two Notify check boxes. 

5. Begin recording actions in SAP. 

 

SAP conversion  opt ions (Versions 6.x ) 

Save Passw ord: Select to save the encrypted password. If th is check box is not selected, you are prompted 
for a password during conversion. 

VB Script : Select to generate Visual Basic Script  for debugging outside QALoad . If th is opt ion is not 
selected, you receive C++ scripts that can be used for playback with in QALoad . 

Bui ld SAP Libraries: Cl ick the Bui ld  button to generate the QALoad SAP l ibraries based on your version of 
SAP. If you receive l inking errors whi le val idat ing or compil ing, you should cl ick th is button.  
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SAP 6.x  com m and reference 

QALoad provides descript ions and examples of the various commands avai lable for an SAP script . For 
detai ls, refer to the Language Reference Help sect ion for SAP 6.x. 

 

Advanced Scri pt i ng Techn iques for SAP 

Adding Custom Counters to Retrieve Server Information 

The fol lowing example adds custom counters to obtain and save the SAP Server in formation that is 
avai lable through the SAP Gui Script ing API. Not ice that SAPGuiSessionInfo is cal led before logging off , 
because the data is not avai lable after logging off. 

int id1, id2, id3, id4; 

long lRoundTrips,lFlushes; 

// "Counter Group", "Counter Name", "Counter Units 
// (Optional)", Data Type, Counter Type. 

id1 = DEFINE_COUNTER("Cumulative Group", "Cumulative RoundTrips", 0, DATA_LONG, 
COUNTER_CUMULATIVE); 

id2 = DEFINE_COUNTER("Cumulative Group", "Cumulative Flushes", 0, DATA_LONG, 
COUNTER_CUMULATIVE); 

id3 = DEFINE_COUNTER("Instance Group", "Instance RoundTrips", 0, DATA_LONG, 
COUNTER_INSTANCE); 

id4 = DEFINE_COUNTER("Instance Group", "Instance Flushes", 0, DATA_LONG, COUNTER_INSTANCE); 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

try{ 
   SAPGuiConnect( s_info,"qacsapdb2"); 
   ... 
   SAPGuiSessionInfo(GetRoundTrips,lRoundTrips); 
   SAPGuiSessionInfo(GetFlushes,lFlushes); 
   SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen( "SESSION_MANAGER", "SAPLSPO1", "Log Off" ); 

   COUNTER_VALUE( id1,lRoundTrips); 
   COUNTER_VALUE( id2,lFlushes); 
   COUNTER_VALUE( id3,lRoundTrips); 
   COUNTER_VALUE( id4,lFlushes); 

} // end try 

catch (_com_error e){ 
   char buffer[1024]; 
   sprintf(buffer,"SAP: EXCEPTION 0x%x %s for VU(%i)\n",e.Error(), (char *)e.Description(), 
S_task_id); 

   RR__FailedMsg(s_info,buffer); 

} // end catch 

END_TRANSACTION(); 

Required commands 
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Certain commands must be present in  an SAP script  for i t  to run successful ly. These commands are created 
automatical ly during the conversion process. Most of the commands exist  before the 
BEGIN_TRANSACTION statement. The required commands include: 

SET_ABORT_FUNCTION(abort function); 

DEFINE_TRANS_TYPE("capture.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info, "ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard(‘*’); 
SYNCHRONIZE(); 

Required commands for transaction restarting 

When transact ion restart ing is enabled in  the Conductor for an SAP script , the fol lowing commands, 
which are automatical ly added by QALoad during script  conversion, must exist  for the script  to run: 

SAPGuiApplication(RegisterROT); 
SAPGuiApplication(RevokeROT); 
SAPGui_error_handler(s_info, buffer); 

The SAPGuiApplicat ion command properly registers and removes the script 's SAP GUI usage on the 
Runtime Object Table (ROT). If a transact ion fai ls, these act ions are taken to start  and clean up the SAP 
environment. 

Note: Do not call RR__FailedMsg in an SAP script if the script includes a restart transaction operation. 
SAPGui_error_handler can be called with the same parameters as RR__FailedMsg to output a fatal error 
message while still allowing a proper clean up of the current transaction before restarting the transaction.  
 

Error handl ing and report ing 

A try/catch block is automatical ly generated for the commands between the BEGIN_TRANSACTION and 
END_TRANSACTION statements. This construct provides error handl ing and report ing from the script . 

BEGIN_TRANSACTION(); 

try{ 

   SAPGuiConnect( s_info,"qacsapdb2"); 
   SAPGuiVerCheckStr("6204.119.32"); 

   //Set SapApplication = CreateObject("Sapgui.ScripingCtrl.1")    
   //SapApplication.OpenConnection ("qacsapdb") 
   //Set Session = SapApplication.Children(0).Children(0) 

   DO_SLEEP(3); 

   SAPGuiPropIdStr("wnd[0]"); 
   SAPGuiCmd3(GuiMainWindow, ResizeWorkingPane, 83, 24, false); 

   DO_SLEEP(6); 

   SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME"); 
   SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 

   SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE"); 
   SAPGuiCmd1Pwd(GuiPasswordField, PutText,"~encr~1211616261"); 

   SAPGuiCmd0(GuiPasswordField,SetFocus); 
   SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 

   SAPGuiPropIdStr("wnd[0]"); 
   SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
   SAPGuiCheckScreen("S000","SAPMSYST","SAP"); 
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   ... 

   DO_SLEEP(10); 

   SAPGuiPropIdStr("wnd[0]/usr/cntlIMAGE_CONTAINER/shellcont/shell/shellcont[0]/shell"); 
   SAPGuiCmd1(GuiCtrlTree, ExpandNode, "0000000003"); 
   SAPGuiCmd1(GuiCtrlTree, PutSelectedNode, "0000000004"); 
   SAPGuiCmd1(GuiCtrlTree, PutTopNode, "Favo"); 
   SAPGuiCmd1(GuiCtrlTree, DoubleClickNode, "0000000004"); 
   SAPGuiCheckScreen("SESSION_MANAGER", "SAPLSMTR_NAVIGATION", "SAP Easy Access"); 
   SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off"); 

} // end try 

catch (_com_error e){ 
   char buffer[1024]; 
   sprintf (buffer," EXCEPTION 0x%x %s for VU(%i)\n",e.Error(),  
            (char *)e.Description(), S_task_id); 
   RR__FailedMsg(s_info,buffer); 

} // end catch 

END_TRANSACTION(); 

To include the log on with in the transact ion loop, move the SAPGuiConnect  cal l  inside the try block as 
shown in the fol lowing example: 

SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("capture.cpp"); 
RESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info,"ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

try{ 

   SAPGuiConnect( s_info,"qacsapdb2"); 
   SAPGuiVerCheckStr("6204.119.32"); 
   ... 
   SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off"); 

} // end try 

catch (_com_error e){ 

   char buffer[1024]; 
   sprintf(buffer," EXCEPTION 0x%x %s for VU(%i)\n",e.Error(),  
           (char *)e.Description(), S_task_id); 
   RR__FailedMsg(s_info,buffer); 

} // end catch 

END_TRANSACTION(); 

To include the log on outside the transact ion loop, move the log off sect ion so that i t  fol lows the 
END_TRANSACTION statement. However, ensure that the recording with in the transact ion loop begins 
and ends in the same locat ion in  the menu system. For example: 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("capture.cpp"); 

HRESULT hr = CoInitialize(0); 
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if( hr != ERROR_SUCCESS ) 
   RR__FailedMsg(s_info,"ERROR initializing COM"); 
SAPGuiSetCheckScreenWildcard('*'); 

SYNCHRONIZE(); 

SAPGuiConnect( s_info,"qacsapdb2"); 

SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME"); 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 

SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE"); 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~1211616261"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 

SAPGuiPropIdStr("wnd[0]"); 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
SAPGuiCheckScreen("S000","SAPMSYST","SAP"); 

BEGIN_TRANSACTION(); 

try{ 
   SAPGuiVerCheckStr("6204.119.32"); 
   ... 
} // end try 

catch (_com_error e){ 
   char buffer[1024]; 
   sprintf(buffer," EXCEPTION 0x%x %s for VU(%i)\n",e.Error(), 
           (char *)e.Description(), S_task_id); 
   RR__FailedMsg(s_info,buffer); 

} // end catch 

END_TRANSACTION(); 

SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off"); 

 

 

 

Handling mult iple logons 

You may need to modify your script  to handle mult iple logons when the recording scenario differs from 
the run-t ime scenario. For example, i f when you record, no users are logged on to the SAP environment 
and when you run the script , users are already logged on, the script  may fai l . To work around th is issue, 
you can use the SAPGuiPropIdStrExists and SAPGuiPropIdStrExistsEnd commands to handle either 
scenario. This technique works by checking for the mult iple logon dialog box from SAP and select ing the 
Cont inue opt ion. 

The fol lowing example demonstrates the usage of the SAPGuiPropIdStrExists and 
SAPGuiPropIdStrExistsEnd commands to handle mult iple logons: 

... 

SAPGuiCheckScreen("S000","SAPMSYST","SAP"); 
SAPGuiPropIdStrExists("wnd[1]/usr/radMULTI_LOGON_OPT2"); 

   DO_SLEEP(24); 

   SAPGuiCmd0(GuiRadioButton,Select); 
   SAPGuiCmd0(GuiRadioButton,SetFocus); 
   SAPGuiPropIdStr("wnd[1]/tbar[0]/btn[0]"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen("S000","SAPMSYST","License Information for Multiple Logon"); 
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SAPGuiPropIdStrExistsEnd("wnd[1]/usr/ radMULTI_LOGON_OPT2"); 

... 

 

Checking the SAP status bar 

The SAP status bar displays error and status messages, as shown in the fol lowing figure. 

 

You can use the SAPGuiCheckStatusbar command to test for certain status responses in the SAP 
environment. 

The SAPGuiCheckStatusbar command is used in the fol lowing script  example: 

... 
SAPGuiPropIdStr("wnd[0]"); 
SAPGuiCmd1(GuiMainWindow, SendVKey, 0); 
SAPGuiCheckScreen("S000", "SAPMSYST", "SAP"); 
SAPGuiCmd3(GuiMainWindow, ResizeWorkingPane, 94, 24, false); 

//SAPGuiCheckStatusbar returns TRUE if the message is found 
//and FALSE if not found 

BOOL bRetSts = SAPGuiCheckStatusbar("wnd[0]/sbar", "E: Make an entry in all required 
fields"); 

if (bRetSts) 
    RR__printf(" True\n"); 

else 
    RR__printf(" False\n"); 

... 

 

Object l i fe span 

Whenever a script  is run, al l  objects on the SAP GUI window are deleted and re-created. These objects, 
which are created in  the SAP environment and can disappear without user in teract ion, can cause script  
fai lure i f the script  references the objects after they have disappeared. 

For more troubleshoot ing in formation, refer to SAP’s publ icat ion t i t led “ SAP GUI Scripting API for the 
Windows and Java Platforms” . 
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UNIFACE 

Uniface recording options 

Un i face executable: Enter the ful l  path or browse to the Uniface 7 executable that is used by the 
appl icat ion you want to record. For example: c:\usys72\bin\UNIFACE.exe. 

Work ing di rectory : Enter or browse to the working directory of your Uniface appl icat ion or the directory 
of any addit ional fi les your appl icat ion may require that do not reside in  the appl icat ion ’s path 
environment. 

In i t i al i zat ion  (.i n i ) f i l e: Enter or browse to the ful l  path to the Uniface appl icat ion 's in i t ial izat ion fi le. 

Assignm en t  (.asn ) f i l e: Enter or browse to the ful l  path to the appl icat ion 's assignment fi le. For example: 
c:\usys72\project\myapp.asn. 

Com m and l i ne statem en t : Type command l ine opt ions that should be used at appl icat ion startup, 
including the command that is used to start  the appl icat ion. For example:  warehouse 1 control 
use=control dnp=tcp: 

 

Uniface conversion options 

Includes: Type the ful l  path or browse to the directory that contains the database include fi les. 

Libraries: Type the ful l  path or browse to the directory that contains the database l ibrary fi les. 

Generate Un i face l i sts: Uniface can handle in ternal  l ist  structures. Select th is check box to convert  strings 
contain ing l ist  i tems to a succession of DO_URB_xxx cal ls that manipulate Uniface l ists. 

Show  output  param eters: Select th is opt ion for the converted script  to contain the output parameters of 
an operat ion as commented l ines. 

Insert  t race m essages as com m ents: Select th is opt ion for the converted script  to contain the recorded 
content of the message frame as commented l ines. 

 

 

Uniface command reference 

QALoad provides descript ions and examples of the various commands avai lable for a Uniface script . For 
detai ls, refer to the Language Reference Help sect ion for Uniface. 

 

Winsock 

How QALoad handles DO_WSK_Send commands 

QALoad displays the contents of a DO_WSK_Send command as a string in  a Winsock script . Some of these 
strings are very large, which can cause a compiler error (fatal error C1076: compiler l im it : in ternal heap 
l im it  reached) i f there are several large strings in  a single script . 

To avoid th is compilat ion  error, QALoad does not al low strings that are displayed in a Winsock script  to be 
more than 12,000 characters. If a DO_WSK_Send command has a send buffer larger than 12,000 characters, 
i ts buffer is broken into smaller strings during the conversion. These smaller strings are then copied in to a 
char buffer named "SendBuffer", which is sent in  the DO_WSK_Send command. The size of the SendBuffer 
variable, by default , is declared as the size of the largest DO_WSK_Send + 1000. For example: 

int rhobot_script(s_info) 
PLAYER_INFO *s_info; 
{ 
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/* Declare Variables */ 
char SendBuffer[22139];  //Largest send is 21139 + 1000 

    ... 
... 
... 

     strcpy(SendBuffer, "$$ ...."); //Assume a large string, shortened for this example 
strcat(SendBuffer, "$$ ...."); 

     /* 12675 bytes */ 
DO_WSK_Send(S1, SendBuffer); 

     ... 
... 

     strcpy(SendBuffer, "$$ ...."); //SendBuffer is reused 
strcat(SendBuffer, "$$ ...."); 
strcat(SendBuffer, "$$ ...."); 

     /* 21139 bytes */ 
DO_WSK_Send(S1, SendBuffer); 

     ... 
... 

     REPORT(SUCCESS); 
EXIT(); 
return(0); 
} 

 

Handling Winsock application data flow 

Frequently, server programs return unique values (for example, a session ID) that vary with each execut ion 
of the script  and may be vital  to the success of subsequent transact ions. To create scripts that include these 
values, you need to subst i tute the hard-coded values returned by the server with variables. The fol lowing 
original and modified code examples demonstrate th is technique. 

Original  code 

In  th is script , the server sends a session ID in response to a connect ion by the cl ient. This session ID is 
required to successful ly complete subsequent transact ions. 

/* 
* wsk-AdvancedTechniques_original.c 
* 
* This script contains support for the following 
* middlewares: 
* - Winsock 
*/ 
 
/* Converted using the following options: 
* General: 
* Line Split : 80 characters 
* Sleep Seconds : 1 
* Auto Checkpoints : Yes 
*/ 

#define SCRIPT_VER 0x00000005UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_wsk.h" 

/* set function to call on abort*/ 

void abort_function(PLAYER_INFO *s_info); 
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#ifndef NULL 
#define NULL 0 
#endif 

int rhobot_script(s_info) 
PLAYER_INFO *s_info; 
{ 

/* Declare Variables */ 

SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("wsk-AdvancedTech_1.c"); 

// Checkpoints have been included by the convert process 

DefaultCheckpointsOn(); 

DO_WSK_Init(s_info); 

SetTimeout(20); /* Wait up to 20 seconds for each expected pattern */ 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Connect(S1, "172.22.24.125", 2100, AF_INET); 

///////////////////////////////////////////////////// 
// The session id returned by the server is 
// unique to each connection 
///////////////////////////////////////////////////// 

/* 21bytes: SessionID=jrt90847\r\n */ 

DO_WSK_Expect(S1, "\n"); 

////////////////////////////////////////////////////// 
// This unique id is then used for subsequent 
// requests 
////////////////////////////////////////////////////// 

/* 34 bytes */ 

DO_WSK_Send(S1, "SessionID=jrt90847\r\n:^B^@^@^@^B^@^@^@^A^@^@^@"); 

/* 15 bytes: ID Accepted#^@\r\n */ 

DO_WSK_Expect(S1, "\n"); 
DO_WSK_Closesocket(S1); 

END_TRANSACTION(); 

REPORT(SUCCESS); 

EXIT(); 

return(0); 
} 

void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User %i:ABORTED.", S_task_id); 

EXIT(); 
} 

M odi f i ed code 

If the original script  (wsk-AdvancedTechniques_original.c shown above) is replayed, i t  wi l l  fai l  because the 
session ID wil l  not be unique; rather, i t  wi l l  be the session ID that is coded in the script . To use the unique 
session ID received from the server, variable subst i tut ion must be used. 
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/* 
* wsk-AdvancedTechniques_modified.c 
* 
* This script contains support for the following 
* middlewares: 
* - Winsock 
*/ 

/* Converted using the following options: 
* General: 
* Line Split : 80 characters 
* Sleep Seconds : 1 
* Auto Checkpoints : Yes 
*/ 

#define SCRIPT_VER 0x00000005UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_wsk.h" 

/* set function to call on abort*/ 

void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL 0 
#endif 

int rhobot_script(s_info) 
PLAYER_INFO *s_info; 

{ 

/* Declare Variables */ 

char Buffer[64]; 
char SendBuffer[64]; 
int nBytesReceived = 0; 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("wsk-AdvancedTech_1.c"); 

// Checkpoints have been included by the convert process 

DefaultCheckpointsOn(); 

DO_WSK_Init(s_info); 

SetTimeout(20); /* Wait up to 20 seconds for each expected pattern */ 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Connect(S1, "172.22.24.125", 2100, AF_INET); 

////////////////////////////////////////////////////// 
// The reply from the server is read into 
// the Buffer variable. We will then have 
// the unique Session ID for this connection. 
// Also need to null-terminate the buffer 
// after receiving. 
////////////////////////////////////////////////////// 

DO_WSK_Recv(S1, Buffer, 64, 0, &nBytesReceived); 
Buffer[nBytesRecieved] = '\0'; 

/* 21bytes: SessionID=jrt90847\r\n */ 

//DO_WSK_Expect(S1, "\n"); 
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////////////////////////////////////////////////////// 
// Finally, substitute the Session ID received from 
// the server with the one coded in the script. 
////////////////////////////////////////////////////// 

sprintf(SendBuffer, "%s:^B^@^@^@^B^@^@^@^A^@^@^@", Buffer); 
DO_WSK_Send(S1, SendBuffer); 

/* 34 bytes */ 

//DO_WSK_Send(S1, "SessionID=jrt90847:^B^@^@^@^B^@^@^@^A^@^@^@"); 

/* 15 bytes: ID Accepted#^@\r\n */ 

DO_WSK_Expect(S1, "\n"); 
DO_WSK_Closesocket(S1); 

END_TRANSACTION(); 

REPORT(SUCCESS); 

EXIT(); 

return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 

{ 
RR__printf("Virtual User %i:ABORTED.", S_task_id); 
EXIT(); 
} 

Winsock recording options 

User Started : Select th is opt ion i f you would l ike to start  your appl icat ion manually for recording, either 
before or after you start  recording. Because th is method may fai l  to record your appl icat ion ’s in i t ial  cal ls, 
Compuware recommends you use the Autom at i c opt ion instead. Select the User Started opt ion when you 
do not know the ful l  appl icat ion startup name and command opt ion parameters or when the appl icat ion 
spawns off processes that generate traffic that you want recorded. 

Notes:  
If you run a character-based application in a DOS window, the Script Development Workbench does not 
record the API calls. 
 
If you choose this option and the application under test generates traffic before the first Windows screen 
displays, you must also select the Capture Init ializat ion Phase check box on the Workbench Configuration 
tab of the Configure QALoad Script Development Workbench dialog box. 

Autom at i c: Select th is opt ion i f you want QALoad to automatical ly start  your Winsock-based cl ient, 
al lowing you to record early appl icat ion startup act ivi ty. This is the recommended method of recording 
because i t  takes advantage of QALoad’s enhanced abi l i t ies to handle various mult i-threaded programming 
techniques. When you select th is opt ion, the QALoad Script Development Workbench records the API cal ls 
that occur before the cl ient enters i ts message loop. Select th is opt ion to record traffic from just one 
appl icat ion. This opt ion l im its the recording output to just the traffic generated by the appl icat ion, not 
including the traffic that is generated by processes spawned by the appl icat ion. 

Com m and Line: Enter the command l ine of your Winsock-based cl ient. Note that i f you enter the ful l  
path, QALoad automatical ly enters the path in  the Work ing Di rectory  field. 

Work ing Di rectory : Enter the working directory of your Winsock-based cl ient, i f necessary. 

Capture: Select the Winsock version to record. 

Set  IP Addresses: Cl ick th is button to open the Add/Delete IP Addresses dialog box, which you can use to 
specify the IP addresses and ports on which you want to record Winsock API cal ls or that you wish to 
exclude from recording.  
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Winsock conversion options 

There are no special ized conversion opt ions for Winsock.  

 

Winsock command reference 

QALoad provides descript ions and examples of the various commands avai lable for a Winsock script . For 
detai ls, refer to the Language Reference Help sect ion for Winsock. 

 

Advanced Scripting Techniques for Winsock 

Understanding data represen tat ion  in  the script  

This sect ion describes how data that is sent and received is displayed in a Winsock script . Use th is sect ion 
as a reference when you examine a script . 

During the conversion process, QALoad determines how to represent each character in  the script . This 
conversion process uses the fol lowing rules: 

1. The character is compared to the “space” character in the ASCII table, which has a decimal value of 32. If the 
character’s value is less than 32, the following steps are taken: 

b. If the character is “\r”, “\n”, “\t”, or “\f”, it is represented in the script as a normal C escape character. 

c. If the character is either “^\” or “^^”, it is represented in the script as an octal character. For example, the 
values would be “\034” and “\036”, respectively. 

d. If the character’s value is less than 32 and it does not meet the descriptions in a) and b) above, it is 
represented in the script as a control character. For example, if the character is a null character, it is represented in 
the script as “^@”. 

2. If the character’s decimal value is between 32 (the “space” character) and 126 (~), it displays in the script as a 
standard readable ASCII character, with the following exceptions: 

 If the character is “ \ ” , which has a decimal value of 92, i t  is represented as “ \ \ ”  in  the 
script . 

 If the character is “ “ “ , which has a decimal value of 34, i t  is represented as “ \ ” ”  in  the 
script . 

 If the character is “ ^ ” , which has a decimal value of 94, i t  is represented as “ ^^ ”  in  the 
script . 

3. If the character has a decimal value of 127, which corresponds to Delete (DEL), it is represented as “^” in the script. 

The fol lowing table summarizes the results of rules 1-3. 

Code Octal  Decim al  Char 

^@ 000 0 NUL 

^A 001 1 SOH 

^B 002 2 STX 

^C 003 3 ETX 

^D 004 4 EOT 

^E 005 5 ENQ 
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^F 006 6 ACK 

^G 007 7 BEL 

^H 010 8 BS 

\t 011 9 HT 

\n 012 10 LF 

^K 013 11 VT 

\f 014 12 FF 

\r 015 13 CR 

^N 016 14 SO 

^O 017 15 SI 

^P 020 16 SLE 

^Q 021 17 SC1 

^R 022 18 DC2 

^S 023 19 DC3 

^T 024 20 DC4 

^U 025 21 NAK 

^V 026 22 SYN 

^W 027 23 ETB 

^X 030 24 CAN 

^Y 031 25 EM 

^Z 032 26 SIB 

^[ 033 27 ESC 

\034 034 28 FS 

^] 035 29 GS 

^_ 037 31 US 

 040 32 SP 

\" 042 34 " 

\\ 134 92 \  

^^ 136 94 ^  
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^? 177 127 DEL 

4. If the character is not included in the groups defined in steps 1-3, it is represented as an octal character in the script. 
These characters are often referred to as high ASCII characters (those with a decimal value greater than 128), and 
are represented in the script as “\OOO”, where OOO is the octal value for the ASCII character. 

 

Handl ing Winsock  appl i cat ion  data f l ow  

Frequently, server programs return unique values (for example, a session ID) that vary with each execut ion 
of the script  and may be vital  to the success of subsequent transact ions. To create scripts that include these 
values, you need to subst i tute the hard-coded values returned by the server with variables. The fol lowing 
original and modified code examples demonstrate th is technique. 

Original code 

In th is script , the server sends a session ID in response to a connect ion by the cl ient. This session ID is 
required to successful ly complete subsequent transact ions. 

/* 
* wsk-AdvancedTechniques_original.c 
* 
* This script contains support for the following 
* middlewares: 
* - Winsock 
*/ 
 
/* Converted using the following options: 
* General: 
* Line Split : 80 characters 
* Sleep Seconds : 1 
* Auto Checkpoints : Yes 
*/ 

#define SCRIPT_VER 0x00000005UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_wsk.h" 

/* set function to call on abort*/ 

void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL 0 
#endif 

int rhobot_script(s_info) 
PLAYER_INFO *s_info; 
{ 

/* Declare Variables */ 

SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("wsk-AdvancedTech_1.c"); 

// Checkpoints have been included by the convert process 

DefaultCheckpointsOn(); 

DO_WSK_Init(s_info); 

SetTimeout(20); /* Wait up to 20 seconds for each expected pattern */ 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 
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DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Connect(S1, "172.22.24.125", 2100, AF_INET); 

///////////////////////////////////////////////////// 
// The session id returned by the server is 
// unique to each connection 
///////////////////////////////////////////////////// 

/* 21bytes: SessionID=jrt90847\r\n */ 

DO_WSK_Expect(S1, "\n"); 

////////////////////////////////////////////////////// 
// This unique id is then used for subsequent 
// requests 
////////////////////////////////////////////////////// 

/* 34 bytes */ 

DO_WSK_Send(S1, "SessionID=jrt90847\r\n:^B^@^@^@^B^@^@^@^A^@^@^@"); 

/* 15 bytes: ID Accepted#^@\r\n */ 

DO_WSK_Expect(S1, "\n"); 
DO_WSK_Closesocket(S1); 

END_TRANSACTION(); 

REPORT(SUCCESS); 

EXIT(); 

return(0); 
} 

void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User %i:ABORTED.", S_task_id); 

EXIT(); 
} 

Modified code 

If the original script  (wsk-AdvancedTechniques_original.c shown above) is replayed, i t  wi l l  fai l  because the 
session ID wil l  not be unique; rather, i t  wi l l  be the session ID that is coded in the script . To use the unique 
session ID received from the server, variable subst i tut ion must be used. 

/* 
* wsk-AdvancedTechniques_modified.c 
* 
* This script contains support for the following 
* middlewares: 
* - Winsock 
*/ 

/* Converted using the following options: 
* General: 
* Line Split : 80 characters 
* Sleep Seconds : 1 
* Auto Checkpoints : Yes 
*/ 

#define SCRIPT_VER 0x00000005UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_wsk.h" 

/* set function to call on abort*/ 

void abort_function(PLAYER_INFO *s_info); 
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#ifndef NULL 
#define NULL 0 
#endif 

int rhobot_script(s_info) 
PLAYER_INFO *s_info; 

{ 

/* Declare Variables */ 

char Buffer[64]; 
char SendBuffer[64]; 
int nBytesReceived = 0; 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("wsk-AdvancedTech_1.c"); 

// Checkpoints have been included by the convert process 

DefaultCheckpointsOn(); 

DO_WSK_Init(s_info); 

SetTimeout(20); /* Wait up to 20 seconds for each expected pattern */ 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Connect(S1, "172.22.24.125", 2100, AF_INET); 

////////////////////////////////////////////////////// 
// The reply from the server is read into 
// the Buffer variable. We will then have 
// the unique Session ID for this connection. 
// Also need to null-terminate the buffer 
// after receiving. 
////////////////////////////////////////////////////// 

DO_WSK_Recv(S1, Buffer, 64, 0, &nBytesReceived); 
Buffer[nBytesRecieved] = '\0'; 

/* 21bytes: SessionID=jrt90847\r\n */ 

//DO_WSK_Expect(S1, "\n"); 

////////////////////////////////////////////////////// 
// Finally, substitute the Session ID received from 
// the server with the one coded in the script. 
////////////////////////////////////////////////////// 

sprintf(SendBuffer, "%s:^B^@^@^@^B^@^@^@^A^@^@^@", Buffer); 
DO_WSK_Send(S1, SendBuffer); 

/* 34 bytes */ 

//DO_WSK_Send(S1, "SessionID=jrt90847:^B^@^@^@^B^@^@^@^A^@^@^@"); 

/* 15 bytes: ID Accepted#^@\r\n */ 

DO_WSK_Expect(S1, "\n"); 
DO_WSK_Closesocket(S1); 

END_TRANSACTION(); 

REPORT(SUCCESS); 

EXIT(); 

return(0); 

} 
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void abort_function(PLAYER_INFO *s_info) 

{ 
RR__printf("Virtual User %i:ABORTED.", S_task_id); 
EXIT(); 
} 

M odi fying QALoad's fun ct ions to i ncorporate dynam ic data 

If you need to use dynamic data with your scripts, you can modify some QALoad funct ions to handle 
dynamic data. The two scenarios below describe specific si tuat ions in  which you might need dynamic data, 
and how to achieve that in  the script . 

Scenario 1: 

One method of accessing dynamic data is by using a datapool fi le. However, you might need to read in  
data that is not in  the format of an ASCII string, which is required for datapool fi les. 

For example, i f the string “ \ 121\ 101\ 114\ 157\ 141\ 144”  is read in from a datapool fi le with one of the 
datapool funct ions, the output would be “ \ \ 121\ \ 101\ \ 114\ \ 157\ \ 141\ \ 144” , which is incorrect. To 
work around th is problem, you can use the OctalToChar() command to convert  any octal sequences into 
their binary representat ion. The fol lowing examples i l lustrates the use of the OctalToChar() command for 
th is purpose: 

Example 

In  th is example, the string “ \ 121\ 101\ 114\ 157\ 141\ 144”  is read in from a central datapool fi le and 
converted to i ts binary representat ion. 

/* Declare variables */ 
char temp[40]; 
 
... 

BEGIN_TRANSACTION(); 
GET_DATA(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 

strcpy(temp,VARDATA(1)); 

OctalToChar(temp); //used to convert octal strings 
                   //to their binary format 

DO_WSK_Send(S1,temp); 
//DO_WSK_Send(S1,"\121\101\122\165\156"); 
DO_WSK_Closesocket(S1); 

The DO_WSK_Send() command above sends the string “ 121\ 101\ 114\ 157\ 141\ 144”  to the server. This 
string is the octal representat ion of the string “  QALoad ” . 

Scenario 2: 

You might find that your capture data is not the same data you need for running a test. For example, you 
might need to change the value of a user ID during replay. One method of changing the value is to change 
the value through the DO_WSK_Send() command, but that results in  the value being stat ic only with in the 
funct ion. To subst i tute a different value each t ime, create a dynamic variable, such as a datapool value, to 
replace the user ID. 

Example  
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In  th is example, the script  includes a DO_WSK_Send() command that sends “ name=Jim ”  to the server as 
the user ID. Then a variable is used to change the name to “ Mark” . 

/* Declare variables */ 
char buffer[65]; 
char sendbuffer[65]; 

... 

BEGIN_TRANSACTION(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1,ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

//original DO_WSK_Send(S1,"name=Jim"); 

strcpy( buffer, "Mark"); 
sprintf( sendbuffer, "name=%s", buffer); 
DO_WSK_Send(S1, sendbuffer); 

/* 2 bytes: ok */ 

DO_WSK_Expect(S1,"ok"); 
DO_WSK_Closesocket(S1); 

The buffer before the DO_WSK_Send() command is modified and a new buffer is passed as the second 
parameter of the DO_WSK_Send() command. This effect ively sends “ name=Mark”  to the server instead of 
 "name=Jim ” . 

 

Saving server repl i es 

There are two methods for saving the ent ire reply that a server sends back. The fol lowing paragraphs 
describe each method. 

Using the Response() and ResponseLength() commands 

The Response() command can be cal led direct ly after the DO_WSK_Expect() command. It  returns a pointer 
to the data that has been received by DO_WSK_Expect(). To also receive the length of the replay, cal l  the 
ResponseLength() command, which returns the number of characters that were received. The fol lowing 
example uses the Response() and ResponseLength() commands. 

Example  

In  th is example, variables are declared to store the results from the two funct ions. Both funct ions are also 
used to save the buffer that is received with in the DO_WSK_Expect() command. 

/* Declare Variables */ 
int x = 0; 
char *temp; 

... 

BEGIN_TRANSACTION(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

/* 21 bytes: You are now connected */ 

DO_WSK_Expect(S1, "d"); 
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// Used to store the data that was received by the 
// DO_WSK_Expect 

temp = Response(); 

// Used to get the size of the response that was received 
// so far 

x = ResponseLength(); 

/* The line below will print the length of the response and the actual response */ 

RR__printf(“length = %d, and response= %s",x, temp); 
DO_WSK_Closesocket(S1); 

The message “ length=21 response=You are now connected”  displays in  the Player buffer window. 

 

Using the DO_WSK_Recv() command 

To save a response based on i ts size instead of a unique character string that is used with in the 
DO_WSK_Expect() command, use the DO_WSK_Recv() command. This command enables you to specify 
how much data to receive and where to store the data. 

You can also use the DO_WSK_Recv() command to store the reply that is returned from the server. This 
strategy is useful when you need to retrieve the buffer that is returned from the server, even though the 
returned data is too dynamic and causes the DO_WSK_Expect() command to fai l  every t ime. 

Example  

In  th is example, the DO_WSK_Recv() command is used to save a server reply based on size. Two variables 
are declared to store the results from the DO_WSK_Recv() command. 

/* Declare Variables */ 
int size = 0; 
char temp[45]; 

... 

BEGIN_TRANSACTION(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

/* 21 bytes: You are now connected */ 

memset(temp,'\0',45); 
DO_WSK_Recv(S1,temp,45,0,&size); 
RR__printf("size=%d string=%s",size,temp); 
DO_WSK_Closesocket(S1); 

The message “ size=21 string=You are now connected”  displays in  the Player buffer window. 

Note: If you use this method as a substitute for the DO_WSK_Expect() command, ensure that you receive 
the correct information prior to calling the next function in the script. 

 

Parsing server repl i es for  values 

To parse a buffer for a part icular value, you can write a parsing rout ine that searches the ent ire buffer for 
the value. However, you can also use one of QALoad ’s Winsock helper commands. The fol lowing scenarios 
describe two situat ions in  which you could use the Winsock commands to solve a parsing problem. 
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Scenario 1: 

To find a string in  a server reply, you can use the SkipExpr() and ScanExpr() commands. SkipExpr() 
searches for the first  occurrence of a string in  the in ternal buffer that contains the response that was 
received with in the DO_WSK_Expect() command. Then, use the ScanExpr() command to search for 
another string. ScanExpr() saves the buffer from the first  occurrence of the string that was used with 
SkipExpr() up to and including the string used with in ScanExpr(). The first  parameter of ScanExpr() is a 
UNIX-style regular expression. The fol lowing table l ists the most common expressions: 

Character M ean ing 

. Matches the end of a string. 

* Matches any number of characters. 

? Matches any one character. 

Example In th is example, the buffer contains “ sessionid=1234567890abc” , and the goal is to retrieve 
everyth ing after the “ =” , up to and including “ abc” . 

/* Declare Variables */ 
char temp[35]; 
int size = 0; 

... 

BEGIN_TRANSACTION(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

/* 23 bytes: sessionid=1234567890abc */ 

DO_WSK_Expect(S1, "c"); 
SkipExpr("sessionid="); 
size=ScanExpr(".*abc" , temp); 
RR__printf("length = %d string = %s", size, temp); 
DO_WSK_Closesocket(S1); 

The message “ length=13 string=1234567890abc”  displays in  the Player buffer window. 

Scenario 2: 

You may have data returned from the server that is too dynamic, that is, you are not able to base parsing 
on actual characters. The solut ion is to base the parsing on character posit ions instead. 

For example, to save the characters 20 through 25, you could use the ScanSkip() and ScanString() 
commands. ScanSkip() skips a specified number of characters in  the in ternal buffer that stores the response 
that was received with in the DO_WSK_Expect() command. ScanString() scans a number of characters from 
the current posit ion with in the buffer in to a character string. 

Example  

In  th is example, a buffer contain ing “ xxx123456789yyy”  is returned from the server. The value between 
“ xxx”  and “ yyy”  is returned. 

/* Declare Variables */ 

char temp[15]; 

... 

BEGIN_TRANSACTION(); 
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... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

/* 16 bytes: xxx0123456789yyy */ 

memset(temp,'\0',15); 
DO_WSK_Expect(S1, "yyy"); 
ScanSkip(3); 
ScanString(10,temp); 
RR__printf("string=%s",temp); 
DO_WSK_Closesocket(S1); 

The message “ string=0123456789”  displays in  the Player buffer window. 

 

WWW 

Visual Navigator 

The Visual  Navigator 

The visual script ing in terface, cal led the Visual Navigator, has three panes that represent different aspects 
of your script , and menu i tems that offer you addit ional funct ional i ty. Using the Visual Navigator to 
develop your scripts makes your job easier. For example, searching through l ines of code to locate a 
part icular button you cl icked on a part icular page can take a long t ime, but using the Visual Navigator you 
can simply cl ick through the pages to locate that button. In  fact, you can develop your whole script  – 
recording, variabl izing, convert ing, compil ing, and running i t  – al l  from the Visual Navigator's in terface 
without ever wri t ing a l ine of code. 

For a brief explanat ion of each Visual Navigator pane, cl ick on the panes in the graphic below. For more 
in formation about a pane, use the l inks l isted after the graphic. 

Note: To make the following graphic fit better in this help window, we've turned off the Script 
Development Workbench toolbars and panes that are not directly related to this help topic. You can 
hide/show many of the Script Development Workbench toolbars and panes using commands available from 
the View  menu. 
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Visual  Navigator's m en us 

The Visual Navigator has a number of special menu commands to help you develop your script . 

Visual Navigator menu 

The Visual Navigator menu is the main menu for Visual Script ing. Access the Visual Navigator menu from 
the Script Development Workbench's main menu, or by right-cl icking on any i tem in the Visual Navigator 
tree-view (left  pane).  
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Datapools and Variables: Opens the Datapools and Variables dialog box, where you can add, delete, or 
modify datapool fi les or variables.  

View  Script  Fi l e: Opens a window showing the C++ (.cpp) fi le based on what is current ly showing in the 
Visual Navigator's tree-view. This is a read-only script .  

Create Edi table Script  Fi le: Creates an editable C++ (.cpp) script  based on the current Visual Script . You 
can modify th is script  direct ly; however, any changes made to the script  wi l l  not be reflected in  the tree 
and vise-versa.  

Show  Hidden  Fields: Displays form fields that are h idden by the browser.  

Show  Redi rected Pages (3xx ):Toggles whether or not redirected pages are displayed. These are pages that 
come back with a reply status code of 3xx, for example: 302 Not Found. 

Show  Cl ien t  Error Pages (4xx ): Toggles whether or not Cl ient Error pages are displayed. These are pages 
that come back with a reply status code of 4xx, for example: 407 Proxy Authorization Required. 

Show  Server Error Pages (5xx ): Toggles whether or not Server Error pages are displayed. These are pages 
that come back with a reply status code of 5xx, for example: 503 Service Unavailable.  

Insert  Tree I tem : Opens a sub-menu where you can choose to insert  certain tree i tems into your script . For 
detai ls, see Insert ing script  i tems. 

Delete Tree I tem : Deletes the current ly selected tree i tem. If the selected i tem may not be deleted from the 
script , th is command is unavai lable.  

View  Source: Opens a text window displaying the source code of the current ly act ive HTML Page or 
Subrequest in  the tree view. 

Edit  menu 

The Script Development Workbench Edi t  menu provides special commands for Visual Navigator 
funct ional i ty as well  as common Edi t  menu commands. Access the Edit  menu from the main menu, or by 
right-cl icking on an edit  box that can be variabl ized in  the Visual Navigator form-view (bottom pane). 
Fields that can be variabl ized are denoted with a Var  button.  

The commands on the Edit  menu are dynamic and the avai labi l i ty of certain commands depends upon 
whether you have text selected and where your cursor is. The fol lowing graphics i l lustrate the difference: 
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Insert  Variable/ Subst i tute w i th  Variable: Opens the Datapools and Variables dialog, al lowing you to 
insert  a variable or replace the selected text with a variable. Subst i tuted text wi l l  refer to a local variable or 
datapool variable and wil l  look similar to one of the fol lowing examples: 

{$ VAR:Customer Number $} 

{$ VAR:Last Name:Customer Data $} 

These commands are only avai lable when the cursor is placed in an edit  box on a tree-view i tem that can 
be variabl ized (you wil l  see Var  or Var Wiz next to i t ).  

Insert  Random  Value/ Subst i tute w i th  Random  Value: Opens the Random Number Tag dialog box where 
you can specify a range wi th in which a random number should be generated for th is value. The subst i tuted 
text wi l l  look l ike th is:  

{$ RANDOM:0:100 $} 

and i t  produces a random number between the lower and upper l im it  each t ime i t  is executed. 

These commands are only avai lable when the cursor is placed in an edit  box on a tree-view i tem that can 
be variabl ized (you wil l  see Var  next to i t ).  

Insert  VU Num ber/ Subst i tute w i th  VU Num ber (Absolute): Inserts or replaces the h ighl ighted text with 
the fol lowing text:  

{$ VU:ABS $} 

This is the virtual user number at runt ime. The absolute virtual user number is assigned depending on the 
number of Players in  use. For example, two Player machines with 50 virtual users on each, would assign 
numbers 0 through 49 for Player 1 and 50 through 99 for Player 2. Typical ly, the VU number is combined 
with other text to form a larger string, such as:  

Customer{$ VU:ABS $} 

In  th is example, Player 1 has values of Customer0 through Customer49, and Player 2 has values of 
Customer50 through Customer99. These commands are only avai lable when the cursor is placed in an edit  
box on a tree-view i tem that can be variabl ized (you wil l  see Var  or Var Wiz next to i t ).  

Insert  VU Num ber/ Subst i tute w i th  VU Num ber (Relat i ve): Inserts or replaces the h ighl ighted text with 
the fol lowing text:  
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{$ VU:REL $} 

This is the virtual user number at runt ime. The relat ive virtual user number is assigned to each Player in  
use. Each Player has relat ive numbers from 0 to N, where N is the total number of VUs run on that Player. 
For example, two Player machines with 50 virtual users on each, would assign numbers 0 through 49 to 
each Player. Typical ly, the VU number is combined with other text to form a larger string, such as:  

Customer{$ VU:REL $} 

In  th is example, Player 1 has values of Customer0 through Customer49, and Player 2 has values of 
Customer0 through Customer49. These commands are only avai lable when the cursor is placed in an edit  
box on a tree-view i tem that can be variabl ized (you wil l  see Var  next to i t ). 

Revert  to Original  St r i ng: Rol ls the contents of the selected edit  box back to when i t  was first  created, 
usual ly when the recording was converted to a Visual Script .  

This menu i tem is enabled only i f the edit  box with in the form can be variabl ized and i t  has been changed 
at some point. 

Delete Variable Reference: Deletes the variable from the selected edit  box. Note that you can also 
h ighl ight a variable and press the Delete key to delete a variable with in an edit  box. 

This menu i tem becomes enabled when you h ighl ight a variable inside of an edit  box.  

Tools menu 

The Script Development Workbench Tools menu provides access to the Rule Library for parameterizat ion, 
the ZipFi le wizard for col lect ing fi les needed by the Technical Support team to analyze and resolve a 
problem, and common Tools menu commands. Access the Tools menu from the Script Development 
Workbench main menu. 

 
  

Rule Library : Opens the Rule Library dialog box, where you can add, delete, or modify saved Variable 
Replacement Rules. 

Visual  Script i ng Concepts 

In troducing Visual Script ing 

Visual Navigator for WWW is QALoad's easy-to-use visual in terface to QALoad's powerful script  
development tools. Visual  Navigator for WWW renders your recorded C++-based transact ion in  a tri -paned, 
browser-l ike environment  similar to popular visual ly-oriented development tools, with icons represent ing 
al l  the elements of your script . In  fact, you could set  up and run a WWW script without ever having to 
modify a C++-based script . 

With Visual Navigator's advanced edit ing features, you don't  have to know the syntax of QALoad's 
command set or your HTML requests or responses to customize your script . You can quickly and easi ly: 

!  See what URL calls were made and what type they were (for example a POST or GET statement) 
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!  See what information was passed in a call 

!  See what replies/pages were returned 

!  Add checkpoints or comments into your script 

!  Move the begin/end transaction statement 

!  Move the synchronize statement 

!  Edit an HTTP header 

!  Set particular flags and commands 

!  Add datapools 

!  Parameterizing your script 

!  Extract information from a reply to use in subsequent calls 

!  Save your script and go back to it at any time for further editing 

!  Create a C++-based script file, if you like   

 

Looking at a transact ion loop 

The transact ion loop is the port ion of your script  that is played back repeatedly, represent ing mult iple 
users making requests. The elements in  your transact ion loop depend on what  was original ly recorded on 
each page you requested. You can move the transact ion loop up or down in the tree-view using the arrow 
buttons, to al low certain requests to be moved in or out of the Transact ion Setup area, where they wil l  be 
executed before beginning the transact ion loop. 

Note: The following graphic does not show all the possible script elements, but gives a good 
representation of what your transaction loop might look like in the Visual Navigator. 

High-level script items 

There are three h igh-level script  i tems in the transact ion loop that represent the web pages you've 
recorded. NavigateTo, HTML Pages, and XML Requests:  

NavigateTo: This is always the first  i tem under the Transact ion Loop element , and is always denoted wi th 
an arrow icon. It  l ists the URL that was typed into the web browser at the start  of recording. This specifies 
the first  request to be made. The result  of th is request is the next i tem in the tree, which is general ly an 
HTML Page i tem.  

If the first  i tem is an HTTP request for XML data, i t  wi l l  appear as an XML Request i tem in the tree.  

Page (HTM L): Fol lowing NavigateTo there wil l  typical ly be a set of HTML Page i tems, which are always 
denoted with a globe icon underneath the Transact ion Loop element. These represent pages visi ted whi le 
the transact ion was being recorded. 

The form-view (bottom pane) l ists the request 's reply status, the requested URI, and the associated 
checkpoint name for the page returned. 

HTML Page i tems can be parent to a number of script  i tems in the tree-view, such as Act ion i tems. For 
more in formation about sub-i tems that can exist  under a Page i tem, see HTM L Page sub-i tems. 

XM L Request : Requests for XML documents are denoted by a document/arrow icon underneath the 
Transact ion Loop element . These represent the requests for XML data made during the transact ion that 
was recorded. XML Request i tems can be parent to a number of lower-level script  sub-i tems in the tree-
view, such as Header and Cookie i tems and the XmlReply document i tem. See XML requests to learn about 
sub-i tems that can exist  under an XML Request i tem. 

 

XML Support 
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QALoad's XML support is handled through the Script Development Workbench's Visual Navigator, which 
displays your script 's HTTP or XML requests in  an easy-to-use, visual ly-based interface that offers you 
point-and-cl ick script  edit ing. Although XML is supported through the Visual  Navigator, we recommend 
you read through th is help topic as well  as the Visual Navigator help topics to become famil iar with the 
features that are unique to QALoad's XML support. 

When an HTTP request is made for an XML document, ei ther in  the form of an HTTP GET request or an 
HTTP POST request with an XML document as the post data, the data is displayed in the three Visual 
Navigator panes as i l lustrated below. Cl ick on a pane in the graphic for a descript ion of i ts contents and 
funct ional i ty. 

Note: To make the following graphic fit better in this help window, we've turned off the Script 
Development Workbench toolbars and panes that are not directly related to this help topic. You can 
hide/show many of the Script Development Workbench toolbars and panes using commands available from 
the View  menu. 

 

 

Streaming media in  Visual Navigator 

If you selected the Streaming Media opt ion on the WWW Advanced conversion opt ions dialog box before 
recording your script , and the recorded transact ion contains RealOne Player or Windows Media streaming 
requests, your streaming media request wi l l  be presented as a Page in the tree-view, similar to the fol lowing 
graphic:  

The form-view (bottom pane) for a streaming media page wil l  show 
the t i t le Real Media Request or Windows Media Request to indicate the 
type of request you recorded, and wil l  l ist  the fol lowing fields: 

Requested URI : Lists the requested URI that invoked the media 
player. For Real M edia the fi le typical ly wi l l  be an RM fi le, whi le for 
Windows Media i t  wi l l  typical ly be an ASX fi le. 
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Play M edia Request : Select th is check box for the virtual user to process the RM or ASX fi le that is received 
and make the necessary requests to dupl icate what the cl ient performed while receiving the streaming 
media. If th is checkbox is not selected, then no further processing is performed after receiving the RM or 
ASX fi le. 

Play Requested M edia for N seconds: You can specify how much of the streaming media fi le the virtual 
user should play, in  seconds, before moving on to the next request. A value of zero indicates that the ent ire 
media stream should be played. 

Note: While a virtual user is playing a media request it will not make any other requests in the transaction 
loop. This may be different than what the user performed when recording the transaction because a browser 
is capable of spawning the streaming media player as a separate executable which can execute at the same 
time that the user continues to make further web requests in the browser. 
 
 

 

CJK and Visual Navigator 

The Visual Navigator handles both nat ive and encoded Chinese, Japanese, and Korean (CJK) characters. 
(See CJK Support in  QALoad for more in formation about CJK support.) 

The fol lowing graphic shows how the Visual Navigator provides nat ive character support. Both Engl ish and 
Chinese characters are displayed in the Workbook Pane. 

 

The same capture fi le, Shanghai.cap, is open in the graphic below. Here, the Visual Navigator displays the 
Chinese characters in  encoded format. 
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Prim ary Scri pt  Elem en ts 

Elements of a Visual Navigator script  

When you open a Visual Navigator script , you'l l  see standard elements of your script  l isted in  the left  pane. 
Each element can contain  a number of script  i tems, which in  turn have attributes that are editable in  some 
cases. This topic l ists the major elements of a script , and l inks to addit ional help topics describing each 
element 's associated script  i tems:  

The main elements of a Visual Navigator script  are: 

Playback Options 

Web Playback Options 

Traffic Fi l ters 

Variables  

Parameterizat ion Rules 

Datapool Fi les  

Common Http Headers  

Common Content Checks  

Transact ion Setup  

Transact ion Loop  

Transact ion Cleanup  
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Playback Options 

Lists various sett ings related to playback. Sett ings are contained in the Web Playback Options and Traffic 
Fi l ters i tems. 

 

Web Playback Options 

This i tem contains sett ings related to playback such as proxy sett ings, t ime out value, number of 
concurrent connect ions, baud rate emulat ion, and fi l ters. This form is divided into three areas: Proxy 
Sett ings, M iscel laneous Playback Sett ings, and Memory Options. 

Proxy Settings 

This sect ion of the form shows the proxy sett ings as they were original ly recorded. This is the same 
information you could enter in to the Internet Explorer or Netscape browsers to configure them. 

Use Auto Con f igurat ion  Script : If an auto-configurat ion script  was used while recording, then th is 
checkbox wil l  be selected and the address of the auto configurat ion script  wi l l  be shown. If an auto 
configurat ion script  was not used, then the other proxy sett ing fields are enabled. 
HTTP Proxy : The address of the proxy server machine and i ts port  number. 
SSL Proxy : The address of the SSL proxy server machine and i ts port  number. 
Except ions: Separate entries with a comma, for example: company.sample.com, 
company2.company.com  
  

Basic Authori zat ion  

Usern am e: A val id user ID to use i f the proxy server requires authorizat ion. 
Passw ord : A val id password corresponding to the user ID in the previous field, to use i f the proxy 
server requires authorizat ion. The password wil l  be encrypted when recording. 

Proxy Ht tp Version :  Specifies which protocol to use when making requests through a proxy. 
Options are 1.0 or 1.1. The version affects whether or not repl ies may come back chunked. Only 
HTTP 1.1 requests receives chunked repl ies. 

Miscellaneous Playback Settings 

This sect ion contains various sett ings used for playback. The values on th is form in it ial ly originate from 
the WWW Convert Options dialog box; however, you can change some of the values on th is form. 

Ht tp Version : Specifies which protocol to use when making HTTP and SSL requests during playback. 
Options are 1.0 or 1.1. The version affects whether or not repl ies may come back chunked. Only 
HTTP 1.1 requests receives chunked repl ies. 

Server Respon se Tim eout : The number of seconds to wait  for a response from the server before 
considering i t  to be t imed out. 
M ax  Connect ion  Ret ries: Specifies how many t imes a connect ion wil l  be tried before i t  is 
considered fai led. 
M ax  Concurren t  Connect ions: The maximum number of concurrent connect ions that can be 
opened to request documents. QALoad supports from 1 to 4 connect ions. This opt ion al lows QALoad 
to better simulate a browser’s behavior whi le playing back a script .  
Persi sten t  Connect ion  During Playback : When selected, QALoad wil l  t ry to maintain an open 
connect ion to the server during playback. An open connect ion may better simulate the recorded 
transact ion.  
Cach ing: When selected, QALoad wil l  simulate the browser’s caching behavior. 
Reuse SSL Session  ID : When selected, QALoad wil l  reuse the current session ’s communicat ion 
in formation (session ID) for al l  page requests with in the transact ion. 
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Use Transm ission  Baud Rate Em ulat ion : Select to simulate a specific baud rate for transmission of 
requests, and then select a rate from the drop-down field. QALoad wil l  then slow the transmission of 
requests appropriately in  order to emulate the transact ion rate of a modem.  
Use Recept ion  Baud Rate Em ulat ion : Select to simulate a specific baud rate for recept ion of 
requests, and then select a rate from the drop-down field. QALoad wil l  then slow the recept ion of 
requests appropriately in  order to emulate the transact ion rate of a modem.  
Refresh  Tim eout  (Seconds):  A page wil l  be considered a redirect i f the META Refresh CONTENT 
field's value is less than the value in  th is field. This field can only be set in  the conversion opt ions. 

Memory Options 

This sect ion contains sect ions related to memory usage at the virtual user level.  

Vi rtual  User M em ory Size: Indicates whether the current sett ing is for Typical or M in imize Memory 
Usage. 

M em ory Opt ions: Cl ick to open the M emory Options dialog box, from which you can 
change from M inimize M emory Usage mode to Typical mode, or change Typical mode 
sett ings. Once a script  is converted using Typical mode, the memory usage sett ing cannot be 
changed to M in imize Memory Usage. 

M an ual l y Select  Subrequests: Indicates whether the current sett ing is Act ive or Not Act ive. This 
opt ion can be modified on the Memory Options dialog box. When the opt ion is Act ive, the 
fol lowing buttons are also avai lable. 

Select  Al l  Subs: Cl ick to select al l  subrequests.  

Clear Al l  Subs: Cl ick to clear al l  subrequests. 

 

Traffic Fi l ters 

Traffic Fi l ters al lows you to fi l ter out certain requests whi le playing back a script . For example, you may 
want to el im inate advert isement requests that are being made of Web servers other than the one you are 
test ing. 

The first  t ime you convert  a capture fi le, i t  wi l l  use the fi l ters specified on the WWW Advanced conversion 
opt ions dialog box and wi l l  el im inate any pages indicated as being fi l tered. Fi l ter in formation entered on 
that dialog wil l  be writ ten to the Traffic Fi l ters tree i tem. Any changes you make to th is tree i tem wil l  not 
affect i tems in the Visual Navigator tree but wi l l  be strict ly for fi l tering subrequests at playback t ime. 

Note: Traffic filters do not affect which XML requests are written to the tree when a capture file is 
converted.  

Two types of fi l ters may be specified: 

!  Allowed Traffic 

This l ist  specifies a set of substrings for the type of URLs you wil l  al low to be requested. The URL of 
every request made must include at least one of the specified substrings. The fi l ter only appl ies to 
subrequests. 

For example, i f the l ist  contained the strings "compuware" and "compuweb" then QALoad would al low 
the URLs "www.compuware.com\ info.htm" and "http:/ /mycompuweb/weather.htm" to be requested, 
but not "www.google.com". 

!  Blocked Traffic 

This l ist  specifies a set of substrings for the type of URLs which should not be requested. If a URL to be 
requested contains any of the substrings in  th is l ist , then the request wi l l  not be sent. The fi l ter only 
appl ies to subrequests. 
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For example, i f th is l ist  contained the terms "doublecl ick" and "popup_source" then QALoad would not 
al low the fol lowing URL to be requested: "http:/ /www.doublecl ick.com/myAdvert isement.htm". 

The traffic fi l ters form-view also l ists the substrings that were converted to Addit ional Subrequests during 
conversion under the Traf f i c converted to Subrequests heading. This l ist  is read-only and displays the 
sett ings from the WWW Advanced conversion opt ions dialog box. 

 

Variables 

Lists local variables that have been created for th is script . For in formation about parameterizat ion, see 
About Parameterizat ion. 

Form View Fields 

When you h ighl ight a variable in  the tree view, the form view displays fields related to the variable type.   

Variable Nam e: The name you provided to ident i fy the variable. 

In i t i al : The in i t ial  value for th is field, before parameterizat ion takes place. 

Note: Variables that are saved in the Parameterization Rule Library can be changed only from the Rule 
Library. 

 

Datapool Fi les 

Lists datapool fi les being cal led by the script . Each datapool l isted has a l ist  of variables under i t  
represent ing columns in the datapool fi le. Datapools can be Local (specific to a single Player) or Central  
(avai lable to al l  Players). 

 

Common Http Headers 

Lists headers that were recorded from at least 50% of your requests. These headers wi l l  be sent out with 
every request that is made at playback unless they are overwrit ten by a header of the same name 
underneath an individual request act ion.  

You can insert  new header i tems from the tree-view by cl icking Visual  Navigator>Insert  Tree I tem >Ht tp 
Header . In  addit ion, you can modify the values in  the Http Header form in the right pane.  

 

Common Content Checks 

Lists common content checks, which apply to al l  repl ies sent by the server. Content checks enable you to 
veri fy whether the correct  page was returned based on the existence or absence of a specific search string. 
You can also set content checks at the page level. Cl ick the Add New  Con ten t  Check  I tem  button in  the 
form-view to add new common content checks. 

Common content checks can include variables. Common content checks enable you to generate an error 
code on a set condit ion even i f no individual page-level content checks are enabled. The search string is 
compared to the raw HTML returned by the server, so you may need to include HTML tags in  your search 
to match the text that appears in  the browser. 

 

Transact ion Setup 

Lists any act ions that occurred before the main transact ion loop. Any i tems/act ions that occur under th is 
heading wil l  be executed after the Synchronize but before the BEGIN_TRANSACTION(); statement at 
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playback. For example, you may have logged in to a part icular Web site and do not want to log in  and out 
with every transact ion at playback. You can move the Transact ion Setup i tem in the tree-view by 
h ighl ight ing it  and cl icking the Move UP/M ove DOWN buttons. The Transact ion Setup can contain cl ient 
cert i ficate tree i tems. 

 

Cl ient Cert i ficate tree i tem 

If the recorded transact ion contains a l ine with a ssl-clientcert command, then 
Visual Navigator wi l l  create a Cl ient Cert i ficate tree i tem and place i t  direct ly 
beneath the Transact ion Setup tree i tem. 

The Client Cert i ficate string can be modified or variabl ized in  the form-view. 

The Client Cert i ficate i tem can also be moved up and down the tree l ike other 
tree i tems, such as checkpoints. This al lows you to move i t  in to the Transact ion 
Loop area i f you wish to change the cert i ficate with each transact ion. 

A Client Cert i ficate i tem wil l  generate a script  l ine similar to the fol lowing: 

Set (EVERY_REQUEST, CERTIFICATE, “qaload_cl”); 
If the Requi res Passw ord  check box is selected, the generated script  l ine is similar to the fol lowing: 

Set (EVERY_REQUEST, CERTIFICATE_PASSWORD, "~encr~250F7641455876"); 

 

Transact ion Loop 

Lists the requests in  your transact ion. Al l  i tems/act ions that occur under th is heading are placed between 
the BEGIN_TRANSACTION and END_TRANSACTION statements, causing them to be repeated for as many 
t imes as the Conductor tel ls them to be. The transact ion loop has a number of possible sub-elements, 
depending on the Web site you tested. For detai led descript ions of the elements that can be l isted in  a 
transact ion loop, see Looking at a transact ion loop. 

 

Transact ion Cleanup 

Lists act ions that occur after the script  has fin ished execut ing the appropriate number of t ransact ions. Any 
i tems that occur under th is heading wil l  be placed after the END_TRANSACTION statement. For example, 
you may want to log out of a part icular Web site after complet ing the appropriate number of t ransact ions. 
You can move the Transact ion Cleanup i tem in the tree-view by h ighl ight ing i t  and cl icking the Move 
UP/Move DOWN buttons.  

 

Parameterizat ion Rules  

Lists Parameterizat ion Rules that you create when you define a variable to subst i tute for a value. Saving the 
variable as a rule enables you to reuse i t  for other instances of the variable. 

When you cl ick Param eteri zat ion  Rules in  the Visual Navigator tree-view, detai ls of the rules stored in  the 
Rule Library appears in  the right-hand pane.  

Notes:  

 Propert ies for the rules are defined using the Rule Library Wizard or the Variable Replacement 
Wizard. 

 An exclamation mark (!) in  the first  column, signifies that the rule matches the same parameter 
as another rule defined in the script . The rule appl ied first  prevents the other rules from being 
appl ied. Rules are appl ied in  the order they are displayed in the table. 
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Rule Nam e: Name of the rule. 

M atch ing I tem : Name of the i tem with in the script  that matches the parameters defined in the rule and 
that wi l l  be replaced with the rule.    

M atch ing Type: The type of  i tem with in a script  that is replaced by th is rule. Item types include: 

!  CGI Parameter 

!  Cookie 

!  Header 

!  EditBox 

!  RadioButton 

!  TextBox 

Fields Replaced : Fields of the matching i tem that are replaced by th is rule. Fields may be: 

!  Name 

!  Value 

!  Both name and value 

Apply : Apply the selected rule. 

Apply Al l : Apply the rule to al l  matching i tems in the script . 

Undo Apply : Remove the rule from matching i tems in the script . 

Edi t : Opens the Rule Library Wizard so you can edi t  the rule. 

Dupl i cate: Dupl icates the selected rule in  the l ist . 

Delete: Deletes the rule from the script . The rule remains in  the l ibrary. 

Add to Library : Adds the rule to the Rule Library. Only rules in  the Rule Library can be appl ied to future 
scripts. 

Note: You can create a rule using the Variable Replacement Wizard without adding it to the library.  

Goto Rule: Displays detai ls for the selected rule. 

Get  f rom  Library : Opens the Get Rule from Library dialog box. Select a rule to add to the visual t ree. 

 

Rules Detai ls  

When you cl ick an individual rule in  the Param eteri zat ion  Rule i tem in the Visual Navigator tree-view, 
the form-view displays in formation for that rule in  three tabs.  

Note: Properties for the rules are defined using the Rule Library Wizard or the Variable Replacement  
Wizard. 

Apply Rule: Appl ies the rule to al l  i tems in the Items to Replace table. 

Undo Apply : Removes the rule from al l  i tems in the Items to Replace table to which i t  has been appl ied.  

Edi t : Opens the Rule Library Wizard so you can edi t  the rule. 

Add to Library : Adds the rule to the Rule Library. Only rules in  the Rule Library can be appl ied to future 
scripts. 

Note: You can create a rule using the Variable Replacement Wizard without adding it to the library.  

General Tab 

Details Section: 
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Rule Nam e: Displays the name of the rule. You cannot edit  th is field. 

Descript i on : Displays the descript ion of the rule. This is generated by the Variable Replacement Wizard or 
suppl ied by the user. 

Status: Displays whether the rule is appl ied to i tems in the script . 

Folder : Displays the name of the folder where the rule is located. 

Last  M odi f i ed : Displays the date the rule was last modified.  

Rule Summary Section: 

Gives a descript ive summary of the parameters establ ished for th is rule. The rule parameters are defined 
using the New Library Rule Wizard or the Variable Replacement Wizard. 

Matching Items Tab  

Matching Item Properties 

I tem  Nam e: Displays the name by which the parameter is ident i fied in  the script .  

Exam ple: Shows an example of the parameter. 

I tem  Type: The type of  i tem with in the script  that is matched by th is rule  

Host  URL: Ident i fies the URL where the parameters reside that are replaced by th is rule. 

Items to Replace 
Note: When a different rule has been applied to an individual item, an red exclamation mark (!) appears 

next to the item in the table. Only one rule can be applied at a time. Click Go to Item and review the 
information in the Matching Parameter Rules area of the form-view to view the rule applied to the item. 

Nam e: Displays the name by which the parameter is ident i fied in  the script . 

Type: Displays the type of variable in  which i t  is used. This can be:  

!  CGI Parameter 

!  Cookie 

!  Editbox 

!  TextArea 

!  Radio button 

!  Header 

Found In : The name of Host URL where th is parameter is found. 

Apply to I tem : Appl ies the rule to the matching i tems in the Items to Replace table that you have selected. 

Undo Apply : Removes the rule from the matching i tems you have selected in  the table to which i t  has 
been appl ied. 

Edi t : Opens the Variable Replacement Wizard, where you can make changes to the variable and save i t  
again to the rule. 

Go to I tem : Takes you to the individual occurrence of the i tem in the script . 

Variables Tab 

Name field variable 

This area displays when you select Name as the field to replace when you created the rule. 

Variable Nam e: Displays the name of the variable to which th is rule appl ies. 
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Frequency : Shows the frequency with which the rule is appl ied to the script . 

Calculat ion : Shows the calculat ion used for the variable. 

Exam ple: Shows an example of the value returned from the calculat ion. 

Detai l s: Displays the Calculat ion Detai ls dialog box. 

Value field variable 

This area displays when you selected Value as the field to replace when you created the rule. 

Variable Nam e: Displays the name of the variable to which th is rule appl ies. 

Frequency : Shows the frequency with which the rule is appl ied to the script . This can be : Once per test, 
Once per transact ion, or Every usage. 

Calculat ion : Shows the calculat ion used for the variable. 

Exam ple: Shows an example of the value returned from the calculat ion. 

Detai l s: Displays the Calculat ion Detai ls dialog box. 

 

Transact ion  Loop I tem s 

Synch 

Inserts a Synch  i tem immediately after the current ly selected HTML Page. A Synch  i tem represents a spot 
where al l  virtual users wi l l  pause during replay unt i l  al l  act ive virtual users have reached the same point . 
Once the virtual users are synchronized th is way, the Conductor wi l l  instruct them al l  to cont inue.  

A Synch  i tem can be moved up or down the tree using Up/Dow n  in  the form-view.   

 

IP Spoof 

Inserts an IP Spoof  i tem immediately after the current ly selected HTML page. 

In order for IP Spoofing to work with Visual Navigator, i t  is necessary to create or insert  an exist ing local 
datapool fi le cal led QALOAD_IPSPOOF in the Visual Navigator tree-view. For more in formation about 
creat ing th is datapool fi le and insert ing i t , see Creat ing the QALOAD_IPSPOOF datapool fi le.  

 

Read Datapool 

Opens the Datapool and Variables dialog box, al lowing you to choose which datapool to use, and then 
inserts a Read Datapool  i tem immediately after the current ly selected HTML Page. 

You can move th is i tem up or down the tree-view by cl icking Up/Dow n  in  the form-view. 

Form View Fields 

The form-view (bottom pane) for a Read Datapool  i tem displays the fol lowing in formation: 

Datapool  Nam e: The name of the datapool fi le that wi l l  be used. To use a di fferent fi le, cl ick Select  f i le… 
and then choose or create another. 

Datapool  Variables: Lists the variables (fields) associated with th is datapool f i le. 
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Checkpoint pair 

Inserts a Begin  Checkpoi n t  i tem before the current ly selected HTML Page and an End Checkpoin t  after 
the current ly selected HTML Page. 

Checkpoints are used to measure durat ion t imes for certain act ions to be completed. You can move ei ther 
the Begin  or End  checkpoint i tem to encompass several requests, i f necessary. To move either i tem, 
h ighl ight i t  and then cl ick M ove Up/M ove Dow n  in  the form-view. 

Form View Fields 

The form-view fields for a Begin / End Checkpoin t  i tem l ists the fol lowing in formation:  

Nam e: The unique name of the checkpoint. When a checkpoint i tem is inserted,  i t  is given a default  name 
such as UserCheckpoint 1. This name can be changed. Changing the name of the Begin  or End  
Checkpoin t  i tem automatical ly changes the name of the corresponding Begin  or End  i tem. In addit ion, 
delet ing a Begin  or End  Checkpoin t  i tem automatical ly deletes the corresponding Begin  or End  i tem. 

Show  End/ Begin  Checkpoin t : Cl ick this button to quickly locate the Begin  or End  Checkpoin t  i tem that 
corresponds to the i tem current ly selected.  

 

Increment Variable/Decrement Variable/Reset Variable 

Increments, decrements, or resets the value of a local variable. 

Opens the Datapools and Variables dialog box, which al lows you to select which variable to increment, 
decrement, or reset. It  then inserts the appropriate i tem (Increm en t  Variable, Decrem en t  Variable, Reset  
Variable) after the curren t ly selected HTML page. 

Form View Fields 

The form-view (bottom pane) for an Increm en t , Decrem en t , or Reset  Variable i tem l ists the fol lowing 
in formation: 

Variable Nam e: The name of the variable being modified. To use a different variable, cl ick Select  Var… 
and then choose or create a different local variable. 

Act ion : Describes the type of act ion to perform on the local variable. Options are: 

!  Increment — increments the value by 1. 

!  Decrement — decrements the value by 1. 

!  Reset Value — Type a value to replace the current variable with in the New Value field.  

 

Print  Values (debugging) 

Inserts a Debug Prin t  i tem after the current ly selected HTML Page. This causes a string to be output to the 
Player window during playback. This can be useful for debugging a script  whi le you are trying to variabl ize 
i t  so that i t   replays correct ly with mult iple virtual users. 

Form View Field 

Debug Prin t  Statem en t : If you simply type a string in  th is field, i t  is prin ted in  the Player’s output window 
just as you typed i t . If you insert  a variable in to the string, the value of the variable is prin ted to the 
Player's window at playback so you can see i ts value. For example, to prin t  the value of a datapool variable 
you might enter a string l ike the fol lowing: 

Customer Name is {$ First Name:Customer Data $} {$ Last Name:Customer Data $} 
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This prin ts a statement l ike the fol lowing to the Player window at runt ime: Customer Name is Cindy 
Nelson. 

You can move the statement within the tree by clicking Move Up/Move/Down in the form-view. 

 

Comment 

Inserts a Com m ent  i tem after the current ly selected HTML page. Type your comment in to the form-view 
(bottom pane). 

 

HTML Pages 

HTML Page form-view 

The form-view (bottom pane) for an 
HTML Page tree i tem contains the 
fol lowing in formation: 

Reply Status: The code designat ing 
the status of the reply. For most pages 
that were returned correct ly, th is wi l l  
be 200 OK. 

Requested URI : This read-only field 
l ists the URI which was requested that 
resulted in  th is page being displayed. 

Checkpoin t  Nam e: If the page has a t i t le, then i t  wi l l  be used as the checkpoint name. If not, the word 
Checkpoint wi l l  be used. To make sure al l  checkpoin t names are unique, a number may be appended to the 
end of the checkpoint name.  

M eta Ref resh  Requi red [  ] Seconds Before Redi rect ion : If the Refresh Timeout opt ion was selected on the 
WWW Conversion Options dialog box, th is field displays the number of seconds that QALoad waits before 
i t  t reats a META refresh request as a normal request. This field only appears when refresh t imeouts are 
enabled. 

 

HTML Page sub-items 

The fol lowing script  i tems can exist  under a Page (HTML) i tem in the Visual Navigator's tree-view. Each 
possible page sub-i tem is l isted below, along with descript ions for the fields that appear in  the form-view in 
the right pane when you select the i tem in the tree-view. 

In addit ion, a Page i tem can contain sub-i tems that you insert  manually after recording the transact ion.  

Content Check sub-i tem 

PageCheck sub-i tem 

Addit ionalSubRequests sub-i tem 

SubRequests sub-i tem 

Cookies Set by Server sub-i tem 

Sleep sub-i tem 

Fi l l  In  Form sub-i tem 

Act ion sub-i tems 
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Content Check sub-item 

Inserts a Conten t  Check  i tem for the current ly-selected HTML page. This veri fies that the correct page was 
returned based on the existence or absence of a part icular search string in  the server's reply for that page. 
Content checks can include variables. The search st ring is compared to the raw HTML returned by the 
server, so you may need to include HTML tags in  your search to match the text that appears in  the 
browser. 

The top pane displays the source for the HTML page. You can easi ly select text in  the top pane and add i t  
to the content check defin i t ion by cl icking the Copy f rom  Source button. 

Form-view fields 

The form-view (bottom pane) includes the fol lowing fields: 

Enable th i s con ten t  check : Select to enable the content check for the page. Content checks are disabled 
by default . After checking th is box, choose whether the check succeeds i f the string is contained or not 
contained in the page. Then type the string text in  the box.  

String: Enter the string that defines the content check. You can type a string or cl ick the Var... button to 
select variables for the string. 

Var...: Opens the Select Variable dialog box where you can select the variable to add to the string. 

Copy f rom  Source: Select  text in  the top pane and cl ick th is button to copy the selected text in  the top 
pane to the text box. 

Veri fy: Click to test whether the check succeeds for the text shown in the top pane.  

 

PageCheck sub-item 

Allows you to veri fy that the t i t le of the page that was requested is correct. 

Form View Fields 

The form-view (bottom pane) includes the fol lowing fields: 

Original  Ti t l e: This read-only field displays the t i t le of the recorded page. 
Veri fy Page Ti t l e: Select th is checkbox to enable/disable t i t le veri ficat ion at playback, then select the 
appropriate opt ion: 
Com plete Ti t l e: The t i t le of the page that is requested must match exact ly wi th the original t i t le. 
Pref i x : Matches the first  characters of the t i t le. Specify how many characters to match. At playback t ime 
QALoad wil l  then compare the first  N characters to the original t i t le, al lowing you to veri fy t i t les which 
might change sl ight ly. 
Suf f i x : Matches the last characters of the t i t le. Specify how many characters to match. At playback t ime 
QALoad wil l  then compare the last N characters to the original t i t le, al lowing you to veri fy t i t les which 
might change sl ight ly. 

 

AdditionalSubRequests sub-item 

Some requests are contained in applets, Act iveX components, or other objects that are captured, but not 
played back by QALoad . These subrequests, which are not recognized as normal subrequests, are l isted in  
the Addi t i onalSubRequests t ree i tem . 

Each addit ional subrequest i tem appears in  the script  as a pre-loaded subrequest just before the main 
act ion. As a result , the playback engine requests the main page, regular subrequests, and then the pre-
loaded subrequests. 
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For example: 

//---------  REQUEST # 2  --------- 
// 
//  current page url is http://c96852d01/pda/ 
// 
// Pre-load the following image requests before the next request is made. 
// These requests seem to have been made by javascript or applets associated 
// with the next page but will not be made automatically by the replay engine, 
// hence they are here in the script. 
// 

Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST,  
     "http://c96852d01/pda/images/LeftBackgrnd.jpg"); 

Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST,  
     "http://c96852d01/pda/menuopen.gif"); 
Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST,  
     "http://c96852d01/pda/menuclose.gif"); 
Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST,  
     "http://c96852d01/pda/menuclose.gif"); 
Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST,  
     "http://c96852d01/pda/images/browsex.gif"); 

Click_On(IMAGE, 1, SRC_ATTRIBUTE, "http://c96852d01/pda/images/browse.gif"); 

 

 

SubRequests sub-item 

Lists al l  subrequests (such as images) that the page performed in order to be ful ly rendered in the browser. 
Subrequests cannot be changed and are shown strict ly to provide detai led in formation about the requests 
that were made during the recording session. 

Form View Fields 

The form-view (bottom pane) for subrequests contains the fol lowing fields: 

URI : Lists the URI of the subrequest that was made. 
View  Source: Cl ick to open the source fi le associated with the reply of the subrequest in  a text format. 
Image fi les wi l l  show up as most ly unreadable characters, but cascading stylesheet and JavaScript requests 
wi l l  be readable. 

 

Cookies set by Server sub-item 

If the reply from the server for the requested page contains a Set-Cookie command, i t  is l isted here. This 
i tem cannot be modified, i t  is l isted for your in formation only.  

Form View Fields 

The form-view (bottom pane) for cookies l ists the fol lowing in formation: 

Nam e: The name of the cookie. 
Value: The value that the cookie should be set to. 
Path : The path with in the domain to which th is cookie is assigned. This cookie wi l l  on ly be sent to the 
server i f future request URIs have the same domain and th is path. The path can be deeper but i t  must start  
with th is path. 
Dom ain : The domain to which th is cookie is assigned. This cookie wi l l  on ly be sent to the server i f future 
request URIs have th is domain and the path specified above. 
Expi res: The cookie's expirat ion date, i f i t  has one.  
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Sleep sub-item 

Every page wil l  have a Sleep i tem immediately before i ts Act ion  i tem. The sleep value specifies how many 
seconds were spent viewing th is page (or fi l l ing out a form) before an act ion was taken (such as cl icking on 
a l ink or button). 

 

Fill In Form sub-item 

If a requested page contains a Form (html element) that was fi l led in  by the user, then a Fi l l  In  Form  i tem 
and i ts associated elements wi l l  be created in  the tree-view. When th is tree i tem is selected, a bl inking 
frame wil l  appear around the form in the browser-view (top pane).  

Form View Fields 

The form-view (bottom pane) for a Form element l ists the fol lowing in formation: 

Form  Act ion  St r ing: The Act ion String associated with th is form. For example, the URI which wil l  be 
requested. 
Form  Num ber : The number assigned to the form, indicat ing which form wil l  be used.  

A Fi l l  In  Form item in the tree-view can include a number of sub elements. For detai ls, see Form sub-i tems. 

 

Extract String sub-item  

Inserts an Extract String i tem when you need to extract in formation from the script  and store i t  in  a 
variable to use later in  the script .  

When an Extract String i tem is inserted in to the tree-view, the browser-view displays the HTML source for 
the page in which the i tem is inserted. The string to extract is recognized by the text preceding i t  and the 
text fol lowing i t . The test string in  between is extracted and saved into a local variable. You must specify 
the local variable that receives the extracted string at run t ime by cl icking on Select  Var . 

Form View Fields 

The form-view (bottom pane) for an Extract String item l ists the fol lowing in formation: 

Search  for : Type the text you want to extract. 

Find prev : Ident i fies the previous occurrence of the selected text in  the source window (upper pane).  

Find nex t : Ident i fies the next occurrence of the selected text in  the source window (upper pane).  

M atch  Case: Enables you to make your search case-sensit ive. 

Variable to receive st r i n g: The local variable that receives the string extracted from the reply. The in i t ial  
value is None.  

Select  Var : Cl ick to access the Datapools and Variables dialog box where you can select or create a local  
variable to use with the Extract String i tem. 

Preceded by : The text preceding the string you want to extract. This is fi l led in  automatical ly when you 
select the text to extract and cl ick Copy f rom  Source. Use the spin controls to increase or decrease the size 
of the string. 

Ext racted : The string to be extracted on th is part icular reply. This is fi l led in  automatical ly when you 
select the text to extract and cl ick Copy f rom  Source. 

Fol low ed by : The text fol lowing the string to be extracted. This is fi l led in  automatical ly when you select 
the text to extract and cl ick Copy f rom  Source. Use the spin controls to increase or decrease the size of the 
string. 
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Copy f rom  Source: Copies the selected text from the source window and places i t  in  the edit  boxes. 

En ter St r i ng M an ual l y : This opt ion al lows you to cut and paste the text you select in  the source window 
into the  Preceded by , Ex t ract , and Fol low ed by  edit  boxes. 

 

Frames 

If an HTML page that is recorded contained frames, they wil l  be represented in the tree-view (left  pane) 
with a circle icon contain ing a capital F. A frame page wil l  be indented beneath the page that is i ts parent. 
If you cl ick on a frame icon in the tree-view, the corresponding frame wil l  be h ighl ighted in  the browser-
view (top pane) with a bl inking frame around i t  for ident i ficat ion. 

Duplicated frameset pages 

Sometimes when a user cl icks on a l ink or takes some other act ion inside of a frame, the new page that was 
requested simply replaces the contents of one of the frames already shown in the browser. To indicate that 
the frameset page (the main page that holds the frames) has not changed, Visual Navigator renames i t  
Duplicated Frameset n. Where n is an ident i fying number for the frameset that is incremented as more 
frameset pages are dupl icated. 

Form view fields 

The form-view (bottom pane) for a Frame Page i tem l ists the fol lowing in formation: 

Requested URI : The URI which was used to request  the frame page 
Fram e Nam e: The name of the frame as indicated in  the source HTML.  

 

Act ion Sub-Items 

Action sub-items 

An Act ion i tem appears under each HTML Page except the last one in the script . This represents the act ion 
that the user took to get to the next page. Act ion i tems include: 

!  NavigateTo – Visual Navigator could not determine how the user accessed the next page (they may have typed a 
URL directly into the address bar, or a JavaScript may have caused the jump). 

Note: A NavigateTo item is the first element that appears under the Transaction Loop element. 
This is because when the browser is launched during recording, the user must specify a starting 
address (typically by typing it into the Address bar). 

!  Click On Link – The user clicked on a text link 

!  Click On Image – The user clicked on an image link 

!  Click On Button – The user clicked on a Submit type button. 

!  PostTo – Data was sent to the server with a POST command but a matching submit button was not found. This may 
have been caused by a JavaScript. 

Action i tems can contain various sub-elements. For detai ls, see Act ion i tem sub-elements. 

 

NavigateTo sub-item 

Specifies a URI to be requested. If the Script  Development Workbench cannot determine how the next 
page was requested (typical ly due to a JavaScript making the request) then i t  wi l l  use a NavigateTo t ree 
i tem instead of something more specific such as a Cl i ck  On  Link . 

Form View Field 
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The form-view (bottom pane) for a NavigateTo i tem l ists the fol lowing in formation: 

URI : The URI that was requested. This value can be variabl ized. 
Use Link  En coding for CGI Param eters: If an HTTP GET request is the result  of a direct request that 
includes the CGI parameters with in the l ink, the parameters must be sent to the server in  a different 
encoding cal led Link Encoding. In  most cases, the Script Development Workbench automatical ly detects 
th is type of request and selects th is opt ion. However, you can manually change th is sett ing for 
troubleshoot ing. General ly, If a Navigate_To is associated with a form, use form encoding (do not select  
th is check box); i f a Navigate_To is associated with an anchor, use l ink encoding (select th is check box). 

 

Click On Link sub-item 

If the user cl icked on a text l ink or an image l ink, then a Cl ick On Link act ion i tem wil l  be inserted under 
that page. This is used to describe the act ion that was taken while on th is page that resulted in  the next 
page being requested. 

When a Click On Link tree-view i tem is selected, the text or image in the browser-view (top pane) wi l l  be 
h ighl ighted by a bl inking frame to make i t  easier to locate. There are several types of Cl ick On Links: 

 Tex t  Links – One of the more common l inks in  web pages are Text based l inks. These usual ly 
appear as underl ined text.  

 Im age Links – An image can have a l ink, similar to text. 

 Cl ien t -Side Im age M ap – A Cl ient-Side Image Map is an image on a page that  has mult iple 
l inks associated with i t . Each l ink is associated with a region, which can be any shape. When 
the user cl icks on the image, the browser wi l l  determine which region was cl icked on and wil l  
request the page l inked to from that region. 

 Server-Side Im age M ap – A Server-Side Image Map is an image on a page that has mult iple 
l inks associated with i t . Unl ike Cl ient-Side Image Maps, these l inks are stored on the server 
rather than the cl ient. When a user cl icks on the image, the browser wi l l  send the server the 
mouse coordinate relat ive to the top-left  corner of the image. The server wi l l  then reply with 
the appropriate page. 

Form View Fields 

The form-view (bottom pane) for Cl i ck  On  Link  i tems l ist  the fol lowing in formation: 

Link  Type: Specifies the type of l ink found. For example, Text, Image, Cl ient Side Image Map, or Server 
Side Image Map. 
Link  Tex t : Only avai lable for text l inks. Shows the text associated with the l ink, as displayed in the 
browser-view (top pane). During playback,  the script  wi l l  search for a l ink using th is text and then request 
the page specified by the l ink. 
Im age: Only avai lable for image l inks. Shows the URL of the image that was cl icked. When playing back 
the script , QALoad wil l  search for an image with a l ink that originated from th is URL and wil l  request the 
page specified by the l ink. 
I f  m ul t i ple m atches to Target  URI are found, use m atch : It  could be possible to have mult iple l inks to a 
single URI. Use the spin control to move to the next or previous l ink that matches the target URI. Selected 
l inks wi l l  be framed and the Link Text, or Image, or Image Region edit  box (the edit  box avai lable depends 
on what type of l ink i t  is) wi l l  be updated . 
Target  URI : Displays the URI that wi l l  be requested when th is l ink is cl icked on.  
X  and Y Coordinates: Server Side Image M aps only. The mouse coordinates, relat ive to the upper left  of 
the image, that were cl icked on while recording. 

 

Click On Button sub-item 
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Clicking on Subm i t  is usual ly associated with entering values in to a form (Fi l l  In  Form  i tem). When the 
Cl i ck  On  But ton  t ree-view i tem is selected, the associated button in  the browser window (top pane) wi l l  be 
h ighl ighted with a bl inking frame, making i t  easier to locate. 

Form View Fields 

The form-view (bottom pane) for Cl i ck  On  But tons (submits) l ists the fol lowing in formation: 

Iden t i fy by : Cl ick the appropriate button to choose whether to ident i fy the button by Name (in ternal 
name as indicated in  the HTML), by Label (the text  on the button), by Occurrence (e.g. the 3rd button), or 
by Image Source (in  case th is submit button is real ly an image). The edit  Ident i fy by buttons wil l  change 
appropriately, depending upon which opt ion you choose.  

Prev But ton / Nex t  But ton : If there are other submit buttons on the page, use Prev Button/Next Button to 
choose to use one of those other submit buttons. The name, label, or occurrence wil l  be updated 
automatical ly. 

Label : The Label field (or Name, Occurrence, or Image Source field) can be modified or variabl ized. If you 
variabl ize the field, cl icking Next Button or Prev Button wil l  not affect i ts contents. However i f you choose 
to use one of the other opt ions, different text wi l l  be displayed because variabl izat ion is specific to each 
method of ident i ficat ion. 

I f  m ul t i ple m atches to URL are found, use m atch : If QALoad finds mult iple matches (for example, two 
buttons labeled Buy Me) then you can use th is field to specify which match to use. For example you could 
specify that you want to cl ick on the 4th button with a label of Buy Me when looking at a page with a lot  of 
i tems for sale. 

Original  Label : The original label associated with the button that was cl icked while recording. 

Original  Nam e: The original name (from the HTM L source) for th is button. 

Form  Act ion : The URL associated with a form. This is the address for the request that wi l l  sent when the 
submit button is cl icked. 

Subm i t  M ethod : Whether th is submit i tem was a GET or POST. 

 

PostTo sub-item 

If the recorded request was a POST request rather than a GET request and the Script Development 
Workbench could not find a matching Submit type button, then a PostTo t ree act ion i tem wil l  be inserted 
under the page. This can sometimes happen i f the request is in i t iated by JavaScript. 

Form View Fields 

The form-view (bottom pane) for a PostTo i tem  l ists the fol lowing in formation: 

URI : The URI which is being posted to. 
Con ten t  Type: One of the fol lowing: DEFAULT, TEXT_PLAIN, or MULTIPART_FORM_DATA. This field is 
read-only. 

 

Act ion Item Sub-Items 

Http Headers sub-item 

If a header exists under an Act ion i tem, then i t  wi l l  be sent for that request only. If the header has the same 
name as one of the common headers, then i t  wi l l  override the common header for th is request only. It  is 
possible to insert  addit ional HTTP headers. 

Form View Fields 
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The form-view (bottom pane) for an HTTP Header l ists the fol lowing in formation: 

General 

Nam e: The name of the HTTP header. 
Value: The value of the HTTP header. 

Matching Parameter Rules 

Rule: Lists the rules that have been created for th is variable type. These rules may or may not have been 
placed in the Rule Library. 

Appl ied to I tem : Indicates whether the rule is appl ied to th is variable. 

GoTo Rule: Goes to the individual rule under the Parameterizat ion Rules tree i tem. In the right-hand pane, 
in formation on the rule displays in  the Matching Item tab of the Rule Detai ls dialog box. 

Previous M atch : Goes to the next matching variable immediately preceding the current i tem in the script . 

Next  M atch : Goes to the next matching variable immediately fol lowing the current i tem in the script . 

Apply : Appl ies the rule h ighl ighted in  the l istbox to th is variable. Only one rule can be appl ied to an 
instance of a  variable. 

Undo Apply : Removes appl icat ion of the rule h ighl ighted in  the l istbox from th is variable. Other 
matching variables to which th is rule is appl ied are not affected. 

 

Cookies sub-item 

When a Cookie i tem is a sub-element of an Act ion i tem, i t  contains a l ist  of cookie i tems that were sent  in  
the header of the request that the Act ion i tem made when recording. Cookies are added automatical ly by 
the browser based on the URI that is being requested. They are either set as a result  of the previous reply 
(the server returned a Set-Cookie command), or they are set by JavaScript contained in the previous reply. 

If the Cookie shown has a matching Set-Cookie i tem, then noth ing wil l  display in  the script  since the 
cookie is created automatical ly during playback. If there is no matching Set-Cookie i tem, then a Set-Cookie 
type statement wi l l  be generated in  the script . 

You can insert  addit ional cookies in to the Cookies sect ion of a page as another means of variabl izing the 
playback. How? 

Form View Fields 

The form-view (bottom pane) for a cookie i tem l ists the fol lowing in formation. Both of these i tems are can 
be edited and variabl ized. You can also insert  addit ional cookie i tems. 

General 

Nam e: The name of the cookie. 
Value: The value of the cookie. 

Matching Parameter Rules 

Rule: Lists the rules that have been created for th is variable type. These rules may or may not have been 
placed in the Rule Library. 

Appl ied to I tem : Indicates whether the rule is appl ied to th is variable. 

GoTo Rule: Goes to the individual rule under the Parameterizat ion Rules tree i tem. In the right-hand pane, 
in formation on the rule displays in  the Matching Item tab of the Rule Detai ls dialog box. 

Previous M atch : Goes to the next matching variable immediately preceding the current i tem in the script . 
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Next  M atch : Goes to the next matching variable immediately fol lowing the current i tem in the script . 

Apply : Appl ies the rule h ighl ighted in  the l istbox to th is variable. Only one rule can be appl ied to an 
instance of a  variable. 

Undo Apply : Removes appl icat ion of the rule h ighl ighted in  the l istbox from th is variable. Other 
matching variables to which th is rule is appl ied are not affected. 

 

CGI Parameters sub-item 

Lists CGI parameters sent along with the request made by the Act ion i tem.  

Form View Fields 

The form-view (bottom pane) for CGI Parameter i tems l ists the fol lowing in formation. Both these fields 
can be edited and variabl ized. You can also insert  addit ional CGI Parameter i tems. 

General 

Nam e: The name of the CGI Parameter. 
Value: The value of the CGI Parameter. 

Matching Parameter Rules 

Rule: Lists the rules that have been created for th is variable type. These rules may or may not have been 
placed in the Rule Library. 

Appl ied to I tem : Indicates whether the rule is appl ied to th is variable. 

GoTo Rule: Goes to the individual rule under the Parameterizat ion Rules tree i tem. In the right-hand pane, 
in formation on the rule displays in  the Matching Item tab of the Rule Detai ls dialog box. 

Previous M atch : Goes to the next matching variable immediately preceding the current i tem in the script . 

Next  M atch : Goes to the next matching variable immediately fol lowing the current i tem in the script . 

Apply : Appl ies the rule h ighl ighted in  the l istbox to th is variable. Only one rule can be appl ied to an 
instance of a  variable. 

Undo Apply : Removes appl icat ion of the rule h ighl ighted in  the l istbox from th is variable. Other 
matching variables to which th is rule is appl ied are not affected. 

 

NTLM Authentication sub-item 

Sometimes the pages being requested require NTLM  Authent icat ion, that is, the user wi l l  be presented with 
a dialog box asking for a UserID, Password, and Domain. This in formation is recorded and l isted in  the 
tree-view under the Act ion i tem that requires i t .  

Form View Fields 

The form-view (bottom pane) for NTLM Authent icat ion i tems l ists the fol lowing in formation: 

User : User name typed into the authent icat ion dialog. 
Passw ord : Password typed into the authent icat ion dialog.  
Dom ain : Domain typed into the authent icat ion dialog. 

 

Basic Authentication sub-item 
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Sometimes the pages being requested require Basic Authent icat ion, that is, the user wi l l  be presented with a 
dialog box asking for a UserID and Password. This in formation is recorded and presented in the tree-view 
under the Act ion i tem which requires i t .   

Form View Fields 

The form-view (bottom pane) for Basic Authent icat ion i tems l ists the fol lowing in formation: 

User : User name typed into the authent icat ion dialog. 
Passw ord : Password typed into the authent icat ion dialog.  

 

Action item sub-elements 

The fol lowing i tems can exist  under Act ion i tems in the tree-view:  

Http Headers sub-i tem 

Cookies sub-i tem 

CGI Parameters sub-i tem 

NTLM Authent icat ion sub-i tem 

Basic Authent icat ion sub-i tem 

  

 

Forms 

Forms 

Many pages that are used during a WWW load test ing session 
contain forms that a user must fi l l  out and submit buttons that get 
cl icked. QALoad ident i fies forms and the elements with in them, as 

well  as determin ing which submit button was cl icked i f there is more than one. 

When a page contains a form that wi l l  be submitted, then a Fi l l  In  Form item is inserted in to that page’s 
l ist  of i tems in the tree-view (left  pane). Underneath  the Fi l l  In  Form 
item are Form Element i tems, such as Edit  Boxes, Radio Buttons, and 
Check Boxes. Fol lowing the Fi l l  In  Form item is either a Cl ick On Button 
i tem or a PostTo i tem. For detai ls about Form Elements, see Form sub-
i tems. 

When a Fi l l  In  Form item is selected in  the tree-view (left  pane), Visual 
Navigator h ighl ights the form with a bl inking frame in the browser-view 
(top pane).  

 

Form sub-items 

A Fi l l  In  Form  i tem in the tree-view can contain a number of sub-i tems, 
represent ing elements that can appear in  forms on HTML pages.  

The fol lowing sub-i tems can appear under a Fi l l  In  Form item: 

Hidden sub-i tem 

Editbox sub-i tem 

Selectbox sub-i tem 
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TextArea sub-i tem 

Checkbox sub-i tem 

Radio sub-i tem 

 

Hidden sub-item 

Forms can contain h idden fields that do not show up on the page. These fields are not visible to the end 
user in teract ing with the browser, but they may need to be variabl ized for a load test, for example a field 
that contains a session ID may need to be variabl ized.  

Form View Fields 

The form-view (bottom pane) for a Hidden Field element l ists the fol lowing in formation: 

Nam e: The name of the h idden field 
Value: The value of the h idden field. 
Al l ow  th i s h idden  f i eld to be variabl i zed: Select to variabl ize th is field. Cl ick the var... button to select a 
variable. 

 

Editbox sub-item 

One of the more common elements in  a form is an edit  box. When th is tree item is selected, QALoad wil l  
draw a bl inking frame around the appropriate edit  box in  the browser-view (top pane). The edit  box in  the 
browser-view wil l  show the value that was original ly typed in when the transact ion was recorded.  

Form View Fields 

The form-view (bottom pane) for an Edit  Box element l ists the fol lowing in formation: 

General 

Nam e: The name of the edit  box. 
Value: The value of the edit  box. Any changes made to th is field wi l l  be reflected in  the edit  box in  the 
browser window. 

Matching Parameter Rules 

Rule: Lists the rules that have been created for th is variable type. These rules may or may not have been 
placed in the Rule Library. 

Appl ied to I tem : Indicates whether the rule is appl ied to th is variable. 

GoTo Rule: Goes to the individual rule under the Parameterizat ion Rules tree i tem. In the right-hand pane, 
in formation in  the M atch ing I tem  tab of the Rule Detai ls dialog box displays. 

Previous M atch : Goes to the next matching variable immediately preceding the current i tem in the script . 

Next  M atch : Goes to the next matching variable immediately fol lowing the current i tem in the script . 

Apply : Appl ies the rule h ighl ighted in  the l istbox to th is variable. Only one rule can be appl ied to an 
instance of a  variable. 

Undo Apply : Removes appl icat ion of the rule h ighl ighted in  the l istbox from th is variable. Other 
matching variables to which th is rule is appl ied are not affected. 

 

Selectbox sub-item 
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A select box is often cal led a drop down select ion box or l ist  box. The form-view wil l  appear sl ight ly 
different depending upon whether the Select Box is capable of support ing mult iple select ions or not. 

Form View Fields 

The form-view (bottom pane) for a Select Box element l ists the fol lowing in formation: 

Nam e: The name (in  the HTML) of the select box. 
I tem s f rom  the Select  Box : Lists the i tems present in  the Select Box in  the browser-view. An i tem has a 
checkbox next to i t  to indicate i f i t  has been selected. To change a select ion, select or clear the checkbox. 
Your choices wil l  be reflected in  the browser. If the Select Box only supports one select ion, then only the 
most recent select ion is selected. 
Variabl i zed Select ions: Edit  boxes that al low the use of variables (local or from a datapool) to specify what 
opt ions are chosen from the Select Box. For a mult iple select ion Select Box, i t  is possible to add up to six 
variables in  addit ion to any i tem chosen using the check boxes.  

For a single select ion Select Box, a single edit  box is provided to al low you to use a variable (local or from a 
datapool) to specify the opt ion you want chosen from the Select Box.  

 

TextArea sub-item 

A Text Area i tem is a multi-l ine text box. 

Form View Fields 

The form-view (bottom pane) for a TextArea element l ists the fol lowing in formation: 

General 

Nam e: The name of the Text Area field. 
Value: The value of the Text Area field. Any changes you enter in to th is edit  box are reflected in  the 
browser-view (top pane). To enter a l inefeed, press Ctrl+Enter. 

Matching Parameter Rules 

Rule: Lists the rules that have been created for th is variable type. These rules may or may not have been 
placed in the Rule Library. 

Appl ied to I tem : Indicates whether the rule is appl ied to th is variable. 

GoTo Rule: Goes to the individual rule under the Parameterizat ion Rules tree i tem. In the right-hand pane, 
in formation in  the M atch ing I tem  tab of the Rule Detai ls dialog box displays. 

Previous M atch : Goes to the next matching variable immediately preceding the current i tem in the script . 

Next  M atch : Goes to the next matching variable immediately fol lowing the current i tem in the script . 

Apply : Appl ies the rule h ighl ighted in  the l istbox to th is variable. Only one rule can be appl ied to an 
instance of a  variable. 

Undo Apply : Removes appl icat ion of the rule h ighl ighted in  the l istbox from th is variable. Other 
matching variables to which th is rule is appl ied are not affected. 

 

Checkbox sub-item 

The form-view (bottom pane) for a Checkbox element l ists the fol lowing in formation: 

Nam e: The name of the Checkbox. 
Value: The value of the Checkbox. 
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State: Reflects whether the box is checked (selected) or not. If the State is 1 (checked), then the Name and 
Value are passed along in the request to the server. If the State is 0 (not checked) then the Name and Value 
are not passed along. You can change the value of the State by cl icking on the checkbox control in  the 
browser-view (top pane). 

 

Radio sub-item 

Form View Fields 

The form-view (bottom pane) for a Radio Button element l ists the fol lowing in formation: 

General 

Group Nam e: The Group Name is shared by al l  radio buttons that belong to the same group. 
Value: The Value field is what different iates one radio button from another. The group name and value of 
the selected radio button wil l  be sent along with the request to the server. The Value of a radio button can 
be, and often is, di fferent than the text shown in the browser. 
use th i s val ue but ton : When you select a radio but ton in  the browser-view (top pane) i ts value wil l  display 
in  th is text box. Cl ick th is button to transfer th is value in to the above Value field. 

Matching Parameter Rules 

Rule: Lists the rules that have been created for th is variable type. These rules may or may not have been 
placed in the Rule Library. 

Appl ied to I tem : Indicates whether the rule is appl ied to th is variable. 

GoTo Rule: Goes to the individual rule under the Parameterizat ion Rules tree i tem. In the right-hand pane, 
in formation in  the M atch ing I tem  tab of the Rule Detai ls dialog box displays. 

Previous M atch : Goes to the next matching variable immediately preceding the current i tem in the script . 

Next  M atch : Goes to the next matching variable immediately fol lowing the current i tem in the script . 

Apply : Appl ies the rule h ighl ighted in  the l istbox to th is variable. Only one rule can be appl ied to an 
instance of a  variable. 

Undo Apply : Removes appl icat ion of the rule h ighl ighted in  the l istbox from th is variable. Other 
matching variables to which th is rule is appl ied are not affected. 

 

XML Requests 

XML document-view 

When you cl ick on an XML Request i tem in the tree-view (left  pane) the right pane becomes a document-
view displaying a tree-view of detai ls about the XM L document requested or returned as the result  of an 
XML request. Each individual XML item appears as a node in the XML document tree. XML elements can 
have chi ld elements and these appear as chi ld nodes of the XML element. Attributes of an element appear 
as chi ld nodes of the element, with the attribute value appearing as a chi ld of the attribute name. 

What if no XML data is associated with a request? 

If there is no XML document associated with the XML request (for example, an HTTP GET) a message 
indicat ing that there is no XML to be displayed is shown in the XML document view. 

How does the document-view relate to the form-view? 
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Select ing an i tem in the XML document tree wil l  display the form-view detai ls corresponding to that XML 
element type in the bottom pane. 

Fol lowing is an example of XML request data displayed in a port ion of the XML document-view: 

 

 

 

XML form-view 

When an XML request is displayed in the document-view (top pane) — as a result  of an XML request i tem 
or XML reply chi ld i tem being selected in  the Visual Navigator tree-view — you can cl ick on i tems in the 
document-view to display in formation about each in the form-view (bottom pane). If no XML item is 
selected in  the document-view, the XML Page form-view wil l  be displayed instead. For XML items, the 
form view display opt ions depend on two th ings: 

!  what type of XML item is selected in the Visual Navigator tree-view (left pane): an XML request or an XML reply 

!  what type of XML item is subsequently selected in the XML document-view (top pane). 

When an XML item is selected in  the XML document-view, the value of that XML item is displayed in an 
edit  box in  the form-view. Some values — at tribute values and text values — can be edited or variabl ized 
(that is, subst i tut ing one or more variables for the value in  an XML request or select ing the return value 
from an XML reply i tem to be received by a variable for later use in  the script). Text i tems, which are values 
between element tags, and attribute values represent volat i le i tems in an XML document structure, used for 
passing values to and from Web Services, for example. 

The fol lowing tables l ist  the possible act ions for XML items displayed in a form-view. Val id act ions are 
determined by the XML item type and whether the i tem is from an HTTP POST request or from an HTTP 
reply. 

In  the fol lowing tables: 

!  If an item is editable, the value in the form-view can be changed and the new value will be used during replay. 

!  If a value can be variablized, a variable can be substituted for all or part of the value. The variable's value will be 
placed in the variable's location at replay. An example is a value received from an item from a previous XML 
document reply. 

!  If a variable can receive a replay value, the return value for the item can be placed into a selected variable during 
replay. The variable can then be substituted for an input value in a later XML request. 

XM L Request  I tem s 

XM L Request  I tem  Edi table? Can  the Value 
be Variabl i zed? 

Declarat ion No No 

DTD (Document 
Type Defin i t ion) 

No No 
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PI (Processing 
Instruct ion) 

No No 

Comment No No 

Element No No 

Attribute (Name) No No 

Attribute (Value) Yes Yes 

Text Yes Yes 

 
XM L Reply I tem s 

XM L Request  I tem  Can  Variable 
Receive Replay 

Value 

Declarat ion No 

DTD (Document Type 
Defin i t ion) 

No 

PI (Processing 
Instruct ion) 

No 

Comment No 

Element No 

Attribute (Name) No 

Attribute (Value) Yes 

Text Yes 

 

Using Visual  Navigator 

Creat ing a Visual Navigator Script  

Creating a Visual Navigator script 

Using the Script Development Workbench, you can quickly and easi ly: 

!  Convert an old script to a Visual Script How? 

!  Record a new Visual Script How? 

 

Converting previously-recorded scripts 

You can convert  exist ing C-based scripts to a Visual  Navigator script . 
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To conver t  a previously-recorded scr ip t : 

1. With a WWW session open, choose Options>Convert. 

2. On the WWW tab, select the option Enable Visual Navigator. 

3. Click OK. 

4. On the Workspace Pane's Capture tab, right-click on the capture file to convert to a script. From the context menu, 
choose Convert (or Convert As). 

5. You may be prompted to overwrite an existing script file. Click Yes. 

The Script Development Workbench converts your capture fi le to a Visual Navigator script , opening i t  in  
the Workbook Pane. 

What does a Visual Script  look l ike? 

 

Recording a Visual Navigator script 

You record a Visual Navigator script  the same way you record a regular QALoad script  — by sett ing opt ions 
to determine the behavior of QALoad while recording, and then cl icking through a transact ion to mimic a 
user. QALoad wil l  record al l  sent and received HTTP and SSL cal ls using the Script Development 
Workbench's Web proxy and write the act ivi ty to a capture fi le.   

After recording, the capture fi le must be converted to an editable, C-based script . This is the point where 
Visual Scripting differs from a regular W WW script. By sett ing a single opt ion before convert ing the capture 
fi le to an editable script , you can turn your capture f i le data in to a Visual Script  that al lows you to view the 
actual Web pages you recorded in a browser-l ike in terface, where you can manipulate the transact ion and 
easi ly insert  variable in formation in to your script  wi thout direct ly edit ing a l ine of code. 

To record a Visual  Scr ip t : 

1. Open a WWW session in the Script Development Workbench. 

2. Click Options>Record. The WWW Record Options dialog box opens. Set any relevant options. 

3. Click OK. 

4. For convenience, set conversion options now also. (You can set conversion options after recording your transaction, 
if you prefer, or even change pre-set options at any time after recording and then re-convert the capture file to apply 
the changes.): 

a. Click Options>Convert. The Universal Convert Options dialog box opens.  

b. Set any applicable options on the General Convert and WWW tabs.  

c. On the WWW tab, select the Enable Visual Navigator check box, which will ensure your capture file is 
converted to a Visual Script later.  

d. Click OK. 

5. From the toolbar, click the Start Record button. QALoad launches your application and any proxies, if necessary, 
and begins recording calls. 

6. Record the transaction. 

7. When you are finished, click the Stop Record button. You will be prompted to save your capture file. By default, 
capture files (.cap) are saved in the directory QALoad\Middlewares\WWW\captures. 

8. If you previously set options to prompt automatic conversion, your capture file will be converted to a Visual Script 
and will open automatically in the editor. For more information about setting up automatic conversion, see 
Configuring the Script Development Workbench. 

If not, you will be prompted to save and name your file. When you are finished, click OK. 

9. Click the Script Development Workbench's Captures tab and locate the capture file you just saved. 



QALoad Online Help 

183 

10. Right-click the file and choose Convert. QALoad will convert your capture file to a Visual Navigator script and open it 
in the editor. 

 

Visual Navigator fi les 

When you create a script  using Visual Navigator, QALoad saves important in formation about your script  in  
the fol lowing fi les. These fi les are saved in the directory \Compuware\QALoad\Middlewares\WWW in  the 
subdirectories \Scripts and \Captures. Some of these fi les can be modified, and can be opened from the 
Script Development Workbench's Workspace pane, i f necessary. 

Fi lenam e Descript i on  

Fi l es Generated From  Recording 

<filename>.cap A fi le contain ing al l  of the requests 
and responses that were recorded. 

<filename>.rfd Replies to subrequests, wh ich most ly 
consist  of images, style sheets, and 
javascripts. This data is used to 
visual ly recreate the pages as they 
appeared when recording. 

Fi les Generated From  Conversion  to a Visual  Script  

<filename>.vistree Contains most of the elements of the 
Visual Navigator tree, including any 
elements that you modify later or 
add to your script . 

<filename>.VisHtml Contains the HTML pages of al l  the 
main requests as well  as images, 
stylesheets, and other subrequested 
pages. This data is used to visual ly 
recreate the pages as they appeared 
when recording. 

<filename>.VisXml Contains any XML/SOAP 
information that was recorded. 

<filename>.cpp A C++ representat ion of your script . 

 

Insert ing Script  Items 

Inserting tree items 

You can insert  a number of script  i tems into your converted script .  

To inser t  t ree i t em s: 

1. Do one of the following: 

 From the Script Development Workbench main menu, choose  Visual  
Navigator>In sert  Tree I tem .  
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 Right-cl ick in  the tree-view (left  pane) and choose Insert  Tree I tem .  

2. Choose the item to insert. 

Most of the inserted i tems can be moved up and down the tree using the Up/Dow n  arrows in the form-
view (bottom pane) for that i tem. You can also delete an i tem highl ighted in  the tree-view by choosing 
Delete Tree I tem  from the menu. 

The fol lowing script  i tems can be inserted from the Visual  Navigator  menu:  

Extract String 

Cookie 

Http Header 

Content Check 

CGI Parameter 

Synch 

IP Spoof 

Read Datapool 

Checkpoint pair 

Increment Variable/Decrement Variable/Reset Variable 

Print Values (debugging) 

Comment 

 

Inserting cookies into a script 

Cookie i tems can be added direct ly to the Html Page i tem they apply to, under the Act ion  i tem (for 
example, a Cl ick on Link i tem).  

To inser t  a cook ie i t em : 

1. In the Visual Navigator tree-view (left pane), navigate to the Html Page item requiring the cookie and then click on it 
to select it.  

2. From the menu, choose Visual Navigator>Insert Tree Item>Cookie. A Cookie form-view opens in the bottom 
pane. 

3. In the Name field, type a name for the new Cookie or click Var Wiz... to access the Select Variable dialog box where 
you can select a value from a datapool file or create a variable for this field. 

4. In the Value field, type a value for the new Cookie or click Var Wiz... to access the Select Variable dialog box where 
you can select a value from a datapool file or create a variable for this field. 

5. Click Save to save your changes. 

The Cookie i tem is added to the script  for the selected Html Page i tem.  

 

Inserting HTTP headers into a Visual Navigator script 

You can insert  HTTP headers under the Common Http Headers tree i tem. 

To inser t  a new  Ht t p  Header  i t em : 
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1. In the Visual Navigator tree-view (left pane), navigate to the Common Http Headers script item, and then click on it. 

2. From the menu, choose Visual Navigator>Insert Tree Item>Http Header. An Http Header form-view opens in the 
bottom pane. 

3. In the Name field, type a name for the new header or click Var Wiz... to access the Select Variable dialog box where 
you can select a value from a datapool file or create a variable for this field. 

4. In the Value field, type a value for the new header or click Var Wiz... to access the Select Variable dialog box where 
you can select a value from a datapool file or create a variable for this field. 

5. Click Save to save your changes. 

The header i tem is added to the script , and wil l  be used for al l  requests at playback unless i t  is overwrit ten 
by a header with the same name underneath an individual request act ion.  

 

XML Support 

XML Support 

QALoad's XML support is handled through the Script Development Workbench's Visual Navigator, which 
displays your script 's HTTP or XML requests in  an easy-to-use, visual ly-based interface that offers you 
point-and-cl ick script  edit ing. Although XML is supported through the Visual  Navigator, we recommend 
you read through th is help topic as well  as the Visual Navigator help topics to become famil iar with the 
features that are unique to QALoad's XML support. 

When an HTTP request is made for an XML document, ei ther in  the form of an HTTP GET request or an 
HTTP POST request with an XML document as the post data, the data is displayed in the three Visual 
Navigator panes as i l lustrated below. Cl ick on a pane in the graphic for a descript ion of i ts contents and 
funct ional i ty. 

Note: To make the following graphic fit better in this help window, we've turned off the Script 
Development Workbench toolbars and panes that are not directly related to this help topic. You can 
hide/show many of the Script Development Workbench toolbars and panes using commands available from 
the View  menu. 
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XML requests 

When an HTTP request is for an XML document, ei ther in  the form of an HTTP GET request, or an HTTP 
POST request with an XM L document as the post data, then an XML Request  tree i tem is displayed. in  the 
tree-view (left  pane). The form-view (bottom pane) for an XML Request i tem includes the fol lowing fields: 

Reply Status: The reply status code. For most pages which were returned correct ly th is wi l l  be 200 OK. 

Request  URI : This read-only field shows the URI which was requested that resulted in  th is page being 
displayed.   

Checkpoin t  Nam e: If the page has a t i t le, then i t  wi l l  be used as the checkpoint name. If not, the word 
Checkpoint wi l l  be used. To make sure al l  checkpoin t names are unique, QALoad wil l  add a number to the 
beginning of the checkpoint name. 

XML Request sub-items 

An XML Request i tem can contain the fol lowing sub-i tems.  

XML Reply  

The URI of the document returned as a result  of the XML request. XML data corresponding to the reply is 
displayed in the browser-view. 

HTTP Headers 

If a header exists under an act ion i tem then i t  wi l l  be sent for that request only. If the header has the same 
name as one of the common headers, then i t  wi l l  override the common header for th is request only. The 
form-view (bottom pane) for an HTTP header l ists i ts name and value. Because there is no XML data 
recorded for a header, the browser-view remains empty. It  is possible to insert  addit ional HTTP Headers. 
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Cookies CGI Parameter 

The Cookies tree i tem wil l  contain a l ist  of Cookie i tems that were sent in  the header of the request that  
th is i tem made while being recorded. Cookies are added automatical ly by the browser based on the URI 
that is being requested. They are either set as a result  of the previous reply (server returned a Set-Cookie 
command), or they are set by JavaScript contained in the previous reply. The form-view for a cookie i tem 
l ists i ts name and value. Because there is no XML data recorded for a header, the browser-view remains 
empty.  

 

XML document-view 

When you cl ick on an XML Request i tem in the tree-view (left  pane) the right pane becomes a document-
view displaying a tree-view of detai ls about the XM L document requested or returned as the result  of an 
XML request. Each individual XML item appears as a node in the XML document tree. XML elements can 
have chi ld elements and these appear as chi ld nodes of the XML element. Attributes of an element appear 
as chi ld nodes of the element, with the attribute value appearing as a chi ld of the attribute name. 

What if no XML data is associated with a request? 

If there is no XML document associated with the XML request (for example, an HTTP GET) a message 
indicat ing that there is no XML to be displayed is shown in the XML document view. 

How does the document-view relate to the form-view? 

Select ing an i tem in the XML document tree wil l  display the form-view detai ls corresponding to that XML 
element type in the bottom pane. 

Fol lowing is an example of XML request data displayed in a port ion of the XML document-view: 

 

 

 

XML form-view 

When an XML request is displayed in the document-view (top pane) — as a result  of an XML request i tem 
or XML reply chi ld i tem being selected in  the Visual Navigator tree-view — you can cl ick on i tems in the 
document-view to display in formation about each in the form-view (bottom pane). If no XML item is 
selected in  the document-view, the XML Page form-view wil l  be displayed instead. For XML items, the 
form view display opt ions depend on two th ings: 

!  what type of XML item is selected in the Visual Navigator tree-view (left pane): an XML request or an XML reply 

!  what type of XML item is subsequently selected in the XML document-view (top pane). 

When an XML item is selected in  the XML document-view, the value of that XML item is displayed in an 
edit  box in  the form-view. Some values — at tribute values and text values — can be edited or variabl ized 
(that is, subst i tut ing one or more variables for the value in  an XML request or select ing the return value 
from an XML reply i tem to be received by a variable for later use in  the script). Text i tems, which are values 
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between element tags, and attribute values represent volat i le i tems in an XML document structure, used for 
passing values to and from Web Services, for example. 

The fol lowing tables l ist  the possible act ions for XML items displayed in a form-view. Val id act ions are 
determined by the XML item type and whether the i tem is from an HTTP POST request or from an HTTP 
reply. 

In  the fol lowing tables: 

!  If an item is editable, the value in the form-view can be changed and the new value will be used during replay. 

!  If a value can be variablized, a variable can be substituted for all or part of the value. The variable's value will be 
placed in the variable's location at replay. An example is a value received from an item from a previous XML 
document reply. 

!  If a variable can receive a replay value, the return value for the item can be placed into a selected variable during 
replay. The variable can then be substituted for an input value in a later XML request. 

XM L Request  I tem s 

XM L Request  I tem  Edi table? Can  the Value 
be Variabl i zed? 

Declarat ion No No 

DTD (Document 
Type Defin i t ion) 

No No 

PI (Processing 
Instruct ion) 

No No 

Comment No No 

Element No No 

Attribute (Name) No No 

Attribute (Value) Yes Yes 

Text Yes Yes 

 
XM L Reply I tem s 

XM L Request  I tem  Can  Variable 
Receive Replay 

Value 

Declarat ion No 

DTD (Document Type 
Defin i t ion) 

No 

PI (Processing 
Instruct ion) 

No 

Comment No 

Element No 
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Attribute (Name) No 

Attribute (Value) Yes 

Text Yes 

 

Visual Navigator's Find and Replace feature 

Visual Navigator has an enhanced Find/Replace feature that al lows you to find occurrences of strings 
with in the tree-view, al lowing you to quickly locate and/or replace text. For example, you could find 
occurrences of Smith and replace them al l  with the datapool variable {$ Last Name:User Info $}. 

Access Find and Replace from the Edi t  menu, or by pressing Ctrl+F. 

Find tab 

Find w hat : Type the string to search for, or cl ick the var... button to select a variable to search for. The 
appropriate tree i tem wil l  be selected and the found text wi l l  be h ighl ighted in  the form-view (bottom 
pane). 

Case Sensi t i ve: Select i f Visual Navigator should only find strings with case matching that of the string to 
locate. 

var...: Cl ick to access the Select Variable dialog box, where you can choose a local variable or datapool 
variable to search for. 

Find Nex t : Cl ick to find the next occurrence of the string. 

Cancel : Cl ick to cancel the search and close the dialog box. 

Replace tab 

Find w hat : Type the string to search for, or cl ick the var... button to select a variable to search for. The 
appropriate tree i tem wil l  be selected and the found text wi l l  be h ighl ighted in  the form-view (bottom 
pane). 

Replace w i th : Type the string to replace the search string, or cl ick the var... button to select a variable to 
replace the search string. The replacement string can be a combinat ion of regular text and one or more 
variables.  

var...: Cl ick to access the Select Variable dialog box, where you can choose a local variable or datapool 
variable to search for. 

Case Sensi t i ve: Select i f Visual Navigator should only find strings with case matching that of the string to 
locate. 

Al low  read-on ly f i elds to be changed : Select to replace text in  read-only fields without a confirmation 
dialog box. If th is opt ion is not selected, a confirmat ion dialog box appears for each occurrence of a string 
in  a read-only field from which you can choose whether to replace the field. 

Replace: Cl ick to replace the string in  the Find w hat  field with the string in  the Replace with field. 

Replace Al l : Cl ick to replace al l  occurrences of the string in  the Find w hat  field with the string in  the 
Replace w i th  field. Matching strings that are found in read-only fields wi l l  not be replaced. 

Find Nex t : Cl ick to locate the next occurrence of the search string. 

Cancel : Cl ick to cancel the search and close the dialog box. 

 

Parameterizat ion 
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Overview of Parameterization  

Parameterizat ion is the process of subst i tut ing certain values in  a script  with variables. When you modify 
QALoad scripts before replaying them, the modificat ions usual ly are repet i t ive and consistent. 
Parameterizat ion provides the means for replacing these values with system-generated variables 
throughout your scripts. Parameterizat ion is used in Visual Script ing for WWW scripts. 

 

About Parameterization  

You can use Parameterizat ion in  Visual Scripts to subst i tute certain variables in  your script  with values you 
define. When you modify QALoad scripts before replaying them, the modificat ions usual ly are repet i t ive 
and consistent. Parameterizat ion provides the means for replacing values with system-generated variables 
throughout your scripts.  

The values for variables are derived from a datapool, an extract string, or a calculated value. A calculated 
variable generates i ts values dynamical ly at runt ime based on the formula you define. You can bui ld a 
calculated variable using datapool values, extract st rings, or other alphanumeric and numeric elements.  

Methods for Parameterizing a Script 

Values in  a script  that you can parameterize are noted in  the form-view (bottom pane) with the var  button 
next to the field. This gives you access to the Datapool and Variables dialog box, where you can define 
values for variables.  

Certain values in  the script  support the Variable Replacement Wizard. The Variable Replacement Wizard 
simpli fies the process of parameterizat ion by taking you through the necessary steps for defin ing variables 
for the fields you want to replace.  Fields for which the Variable Replacement Wizard is avai lable are shown 
in the form-view with Var Wiz button next to the field. 

Saving Parameters as Rules 

You can create and maintain a table of the variables you define by storing them as rules in  the Rule 
Library. Once stored, the script   looks for these rules and replaces the value wi th the parameters you assign 
to that rule.  

 

Using Variables with Visual Navigator 

Naming variables 

When you first  create a datapool fi le, the included variables are automatical ly assigned the default  names 
Var1, Var2, Var3, and so forth.  

QALoad al lows you to rename those variables with meaningful names that can even include spaces. This 
makes i t  much easier to work with datapools. For example, you could name a datapool variable something 
logical l ike City, rather than trying to remember that Var4 in  your datapool is the City variable. 

Renaming variables 

You can quickly and easi ly rename local or datapool variables from the tree-view. Simply h ighl ight the 
variable under the Datapool Fi les or Variables tree-view i tem, and then change the variable name in the 
result ing form-view (bottom pane). 

You can also edit  from the Datapools and Variables dialog box. To access i t , right-cl ick anywhere in  the 
tree-view and then choose Datapools and Variables from the shortcut menu. Highl ight the variable to 
rename and cl ick the Ren am e button.  
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Datapools and variables 

Datapools and variables can be added or modified by several methods. To simply create, delete, or modi fy 
datapool fi les and variables at any t ime while a script  is open in the editor, choose Visual  
Navigator>Datapools an d Variables from the menu to access the Datapools and Variables dialog box.  

Alternately, the same dialog box wil l  open automat ical ly whenever you are asked to choose a variable or 
datapool fi le whi le working with the script , al lowing you to create the variables you need on-the-fly.  

Data that can be variabl ized is denoted in the form-view (bottom pane) by the var... button. Cl icking 
the var... button wil l  open the Datapools and Variables dialog box. 

 

Types of Variables 

Types of Variables 

When values in  a script  are replaced with variables, the variables typical ly are derived from extract strings, 
datapools, or calculated variables. 

Extract Strings 

Insert  an Extract String i tem when you need to extract in formation from a reply and store i t  in  a variable to 
use in  future requests or simply for logging the in formation. For example, i f a string is located inside a 
JavaScript or in  a h idden tag that is not visible in  the browser, and i t  m ight change each t ime th is page is 
requested, use an Extract String to extract the value. Extract strings search on the text preceding and the 
text fol lowing the string you want to extract.  

Datapools 

Datapools draw values from a fi le of acceptable values and use a different set of values each t ime a 
parameter is replaced. You can select an exist ing datapool fi le or create a new datapool fi le to add to your 
script  from your datapool directory. Each datapool has a l ist  of variables under i t  represent ing columns in 
the datapool fi le. When you create a datapool, you specify the number of columns (variables) and rows 
(values) i t  contains.  

The datapool fi le you choose is added to your script  and is l isted under Datapool Fi les in  the Visual 
Navigator tree-view.  You can choose to add a central or local datapool to a script .  

Note: You can have only one central datapool file associated with a script, but can have any number of 
local datapool files.   

Central 

Central datapools are Conductor-based. They reside on the same workstat ion as the QALoad Conductor, 
and are avai lable to any Player system on the network that requests i t  from the Conductor. You can apply 
only one central datapool  fi le to a script . 

Local 

Local datapools are Player-based. They reside on a Player workstat ion, and are only avai lable to that Player. 
You can apply any number of local datapool fi les to a script . 

Calculated Variables 

Calculated variables are generated dynamical ly at runt ime and are based on a formula you define. For 
example, you might want  each virtual user to have a unique string, such as Smith1, Smith2, and so forth, 
or you may want to calculate a new value each t ime through the transact ion loop.  

Calculated variables are strings bui l t  from one or more elements. These can include datapools, local 
variables, and text, as well  as the fol lowing:  
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Date and Time 

Insert  the date and t ime in the format you select. 

Random Alphanumeric 

Subst i tutes the value with random alphanumeric characters at runt ime. Specify the type and length of 
characters to use. You can select: let ters only, numbers only, or both let ters and numbers. 

The value can be a fixed length, where you specify the number of characters, or variable length, where you 
specify the min imum and maximum number of characters. 

Random Numeric 

Subst i tutes the value with a random number at runt ime. You specify the min imum value, maximum value, 
the number of decimal places, and the number of leading digits. Numbers generated with fewer leading 
digits are padded with zeros.  

Local Variable 

A variable with a stat ic value that you set when you create i t . 

Virtual User Number 

The number used to ident i fy the virtual users during a test. You can include a virtual user number (VU) in  
the calculat ion. VUs may be absolute (assigned by the Conductor) or relat ive (assigned by the Player at 
runt ime). 

Absolute 

The absolute virtual user number is assigned by the Conductor based on the total number of virtual users 
on al l  Players. Each virtual user is assigned a number and no numbers are repeated. Insert  an absolute 
virtual user number when i t  is necessary to use a completely unique virtual user number in  place of a 
variable.  

Relat i ve 

The relat ive virtual user number is the number assigned to the virtual user by i ts Player. Because a test has 
mult iple Players and each Player assigns virtual user numbers from 0-n, a relat ive virtual user number is 
only unique on a single Player. 

Local Variable 

A local variable is a stat ic value that you can subst i tute wherever variables can be used. You can quickly 
add local variables to your script  from the Visual Navigator tree-view. Insert  Increment Variable, 
Decrement Variable, and Reset Variable i tems into the tree-view to manipulate the value of any variables. 

 

About Calculated Variables  

Calculated variables generate their values dynamical ly at runt ime based on the formula you define for 
them. They can generate strings that contain any combinat ion of text, random alphanumeric characters, 
t ime and date values, and values from other variables. For example, you might want to calculate a new 
value dynamical ly each t ime through the transact ion loop rather than use a datapool fi le of di fferent 
values. Another example is when you want each virtual user (VU) to have a unique ID string, such as 
Smith1, Smith2, and so forth. Using calculated variables serves th is purpose. You bui ld a calculated variable 
by choosing the elements you want to include and insert ing them in the calculat ion.  

 

About Datapool Variables  
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Datapools are text fi les contain ing data records that you can subst i tute in  your script  in  place of variable 
data. Each datapool comprises a l ist  of variables represent ing columns in the datapool fi le.  

Data that can be parameterized is denoted in the form-view (bottom pane) by the var... button. Cl icking 
the var... button opens the Datapools and Variabl es dialog box. Datapools can be Local (specific to a 
single Player) or Central (avai lable to al l  Players).  

Note: You can parameterize certain variables using the Variable Replacement Wizard.  

Central datapool 

A central datapool is a datapool that resides on the same workstat ion as the QALoad Conductor, and is 
avai lable to any Player system on the network that requests i t  from the Conductor. A central datapool is 
control led by the Conductor, and you use the Conductor to set any opt ions relat ing to i t . You can apply 
only one central datapool  fi le to a script . 

Local datapool 

A local datapool is a datapool that resides on a Player workstat ion, and is only avai lable to that Player. 
Because a local datapool resides local ly and is only avai lable to the local Player, i t  does not generate any 
network traffic. You can apply any number of local datapool fi les to a script . 

 

About Extract Strings  

Insert  an Extract String i tem in your script  when you need to replace a system-generated value or reuse a 
system-created value later in  a script . You can extract in formation from a reply and store i t  in  a variable to 
use in  future requests. For example, i f a system-created order number is assigned during a transact ion that 
must be used again later in  the transact ion, you can use an Extract String to store the value and insert  i t  
in to the script  at  the appropriate point.. 

When you select text to store in  an extract string, Visual Navigator uses 10 or more characters on either 
side of the extracted text to make the search string unique enough to find th is copy of the extracted text. 
You can increase or decrease the size of these strings.   

 

About Local Variables 

A local variable has a constant value that you assign  when you create the variable. It  can be subst i tuted 
wherever variables can be used. You can quickly add local variables to your script  by right-cl icking in  the 
Visual Navigator tree-view and select ing Datapools and Variables.  

Note: You can insert Increment Variable, Decrement Variable, and Reset Variable items into the tree-view 
to manipulate the value of any variables. 

 

Adding Variables 

Adding a Variable 

You can quickly variables to your script  from the Visual Navigator tree-view. Types of variables are: 

!  Local variables 

!  Datapools 

!  Calculated variables 

!  Extract Strings 
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Note: You can insert Increment Variable, Decrement Variable, and Reset Variable items into the tree-view 
to manipulate the value of any variables. 

 

Creating a Calculated Variable 

The fol lowing procedure provides step-by-step instruct ions for creat ing and edit ing a new calculated 
variable using the Datapools and Variables dialog box.  

Note: You can also use the Variable Replacement Wizard to create calculated variables. 

To creat e a calculat ed var iable: 

1. Access the Datapools and Variables dialog box by doing one of the following: 

 Click Visual  Navigator>Datapools and Variables. 

 Right-cl ick in  the Visual Navigator tree-view, then select Datapools and Var iables. 

 In  the Visual Navigator tree-view, cl ick the value you want to replace, and then cl ick var... in  
the form-view.  

2. Click New Calc Variable. A new calculated variable name appears in the list box with all the other variables 
assigned to the script. The new variable is added to the Variables section in the Visual Navigator tree-view (left 
pane). 

3. Type a name for the variable, then click OK. 

4. In the Visual Navigator tree-view, scroll to the Variables section and select the name of the variable you just created. 
Details of the calculation variable display in the right-hand pane. 

5. Click Edi t  Calculat ion . The Edit  Calculat ion Variable dialog box displays.  

6. Build the calculat ion variable by cl icking a form in the Templates area. 

7. Select or type the associated in formation in  the Detai ls area. 

8. Click Insert  i n to Calculat ion , then cl ick OK to save the changes. 

 

Adding a Variable to a Datapool 

You can quickly add datapool variables to your script  from the Visual Navigator tree-view.  

Note: You can insert Increment Variable, Decrement Variable, and Reset Variable items into the tree-view 
to manipulate the value of any variables. 

To add a var iable t o a dat apool : 

1. Right-click anywhere in the Visual Navigator tree-view.  

2. From the shortcut menu, select Datapools and Variables. The Datapools and Variables dialog box displays. 

3. Select a Datapool in the tree-view.  

4. Click the New Variable button. A variable with the default name Var# is added to your list of variables in the 
datapool you selected. You can rename the new variable or accept the default name. 

5. Click OK. In the Visual Navigator, the new variable is added to the datapool in the tree-view,and a new column for 
the variable displays in the form-view.  

6. Type a value for the variable in each cell of the column. 
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Creating, Editing, and Importing Datapools  

The fol lowing sect ions provide step-by-step instruct ions for creat ing and edit ing datapools, and for 
import ing a datapool fi le in to a script . 

To creat e a new  dat apool : 

1. With a script  open, choose Vi sual  Navigator>Datapools and Variables from the menu. The 
Datapools and Variables dialog box displays. 

2. Click New  Datapool  Fi l e.  

3. If th is script  doesn't  have a central (Conductor-based) datapool assigned, the Choose Datapool  
Type dialog box opens. Specify whether the datapool you are about to create should be central 
(Conductor-based) or local (Player-based), then cl ick OK. The Create New  Datapool  Fi l e dialog box 
appears. 

4. In  the Fi lenam e field, type the name for the new datapool. 

5. Type the number of rows and columns for the datapool fi le. 

6. Click OK to create the datapool. You are returned to the Datapools and Variables dialog box. The 
Datapools and Variables dialog box now displays any datapool fi les assigned to the script , 
including the one you just created. The new datapool is added to the Datapool Fi les sect ion in  the 
Visual Navigator tree-view (left  pane). 

7. Click OK.  

8. In  the Visual Navigator tree-view, scrol l  to the Datapool Fi les sect ion of the script  and cl ick the 
name of the datapool fi le you just created. 

9. In  the right-hand pane, type values in to the datapool fields to be used at test t ime. 

To im por t  a dat apool  f i le: 

1. Copy your datapool file, which must be in .csv or .dat format, to the Datapools directory of the QALoad installation. 

2. Insert the datapool into a script as described below. 

To edi t  a dat apool  f i le: 

If you need to make changes to a datapool fi le, Compuware recommends that you make a backup copy of 
the fi le fi rst . If a backup copy is not avai lable, you may need to check al l  other scripts that use that 
datapool fi le and make appropriate changes. 

Caut ion: Because it is possible for more than one script to use the same datapool file, care should be taken 
when modifying a datapool file's contents. Doing so for one script may cause errors in other scripts that use 
the datapool file.  

1. With your script  open, scrol l  to the Datapool Fi les sect ion in  the Visual Navigator tree-view (left  
pane). 

2. Select the datapool fi le you want to edit . A table opens in the right-hand pane displaying the 
contents of the datapool f i le. 

3. Perform any of the fol lowing funct ions: 

!  Edit  a cel l 's contents: Cl ick in  a cel l  and type over the exist ing contents to edit  the value. 
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!  Insert  columns or rows: Right-cl ick on a row or column header and choose In sert  Row  or 
Insert  Colum n  from the menu. Choose whether to insert  the new item before or after the 
selected i tem, and type the number of i tems to insert .  

!  Delete columns or rows: Right-cl ick on a row or column and choose Delete Row  or Delete 
Colum n  from the menu. (Press SHIFT to select mul t iple cont iguous i tems or CTRL to select 
mult iple non-cont iguous items.) 

!  Rearrange columns or rows: Select one or more columns or rows by cl icking on the headers 
(press SHIFT first  to select mult iple i tems). Drag the rows or columns to a new posit ion. As you 
drag them, a th in red l ine indicates where the select ion are moved. 

!  Rename a column header (variable):Cl ick on the column name and then type the new name in 
the Variable Nam e field. 

4. Click Fi le>Save to save your changes. 

 

Inserting Datapool Variables into a Script 

You can quickly add an exist ing datapool to your script  from the Visual Navigator tree-view. 

To inser t  a dat apool : 

1. Right-click anywhere in the tree-view. From the shortcut menu, choose Datapools and Variables. 

2. Click Insert Datapool File. 

Note: Data that can be parameterized is denoted in the form-view (bottom pane) by the var... button or 
the Var Wiz... button. Clicking the var... button opens the Datapools and Variables dialog box. Clicking the 
Var Wiz... button opens the Parameterization Wizard. 

3. If your script doesn't yet include a central datapool file, the Choose Datapool Type dialog box opens, where you 
can designate your datapool file as a central or local datapool. If your script already includes a central datapool, the 
Open dialog box appears. 

4. From the Open dialog box, navigate to the datapool file to add to your script. Datapool files are normally located in 
the directory \Compuware\QALoad\Datapools. 

5. Select the appropriate file and click Open. 

The fi le you selected is added to your script  and is l isted in  your Datapools and Variables dialog box, 
where you can edit  or delete i t  as necessary. If you expand the view of the fi le in  the Datapools and 
Variables dialog box, you can see the variables (columns) saved in the fi le. The names for those columns 
are stored in  the datapool fi le as a comment l ine. If they are not named, Visual Navigator assigns them the 
default  name Var#. 

 

Creating Extract Strings  

You can extract a value from the web page where i t  fi rst  occurs and place i t  in to a variable using an 
ExtractString tree i tem. When you insert  the tree i tem, the HTML source for the page appears in  the 
browser-view so that you can h ighl ight the text to extract. When you h ighl ight the string, some of the text 
preceding and fol lowing the string is selected to ident i fy where the string occurs during playback. 

To creat e an ext ract  st r ing by inser t ing a t r ee i t em : 

1. Right-click in the Visual Tree where you want to place the extract string. The HTML source for the page appears in 
the right-hand pane. 
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2. In the shortcut menu, click Insert Tree Item>ExtractString.  

3. In the form_view (bottom pane), type the text you want to extract in the Search for field. Select Match Case to make 
your search case-sensitive. 

4. Click Find prev and Find next to select the occurrence of the variable you want to replace.  

5. Click Select variable. The Datapool and Variable dialog box displays. 

6. Select the variable in which to store the extract string, and click OK. 

7. Do one of the following: 

 Click Copy f rom  source. This copies the selected text from the source window into the edit  
boxes. The text immediately before the selected text appears in  the Preceded by  field. The text 
immediately after the selected appears in  the Fol low ed by  field.  

Note: Use the arrows next to the fields to include more or less of the preceding and following 
text. 

 Click Enter st r i ngs m an ual l y and type the text before and after the string in  the Preceded by  
and Fol low ed by  fields.  

8. In the Extracted field, click Next to view each instance of the variable in the page. The extracted string is added to 
the Visual Tree. 

 

Adding a Local Variable 

You can quickly add local variables to your script  from the Visual Navigator t ree-view. A local variable can 
be subst i tuted wherever variables can be used.  

Note: You can insert Increment Variable, Decrement Variable, and Reset Variable items into the tree-view 
to manipulate the value of any variables. 

To add a local  var iable: 

1. Right-click anywhere in the Visual Navigator tree-view.  

2. From the shortcut menu, select Datapools and Variables. The Datapools and Variables dialog box displays. 

3. Select the Variables i tem in the tree-view.  

4. Click New  Variable. An unnamed variable is added to your l ist  of local variables.  

5. Type a name for the new variable. 

6. In  the In i t i al  Value field, type the value for the variable. 

7. Click OK. The local variable is added to the Visual Navigator tree-view under Variables. 

 

Using the Variable Replacement Wizard 

How to Use the Variable Replacement Wizard 

The Variable Replacement  Wizard guides you through the process of defin ing variables and subst i tut ing 
them for parameters in  the script . Using the wizard, you choose which fields of a parameter to replace with 
variables, define the variable that replaces the field, and select addit ional parameters to replace with the 
variable.  

When you use the Variable Replacement Wizard, the variable you define is saved as a rule. When you save 
the rule in  the Rule Library, you can apply the same parameters to future scripts. Subsequent captures use 
the stored rules during the convert  process to ident i fy matching parameters. 
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The Variable Replacement  Wizard is avai lable for the Visual Navigator tree i tems that have a Var Wiz... 
button associated with them in the form-view (bottom pane). These include: 

!  CGI Parameter 

!  Cookie 

!  Editbox 

!  TextArea 

!  Radio button 

!  Header 

To access t he Var iable Replacem ent  W izard: 

1. In the Visual Navigator, click the tree item you want to parameterize. 

2. Click Var Wiz... in the form-view. The Welcome dialog box of the Variable Replacement Wizard displays. 

3. Click Next to start the parameterization process.  

 

Step 1: Choose the Fields to Replace 

To choose t he f ields t o replace: 

1. Select the fields that in the item should get their values from variables. You can select: 

 Name field 

 Value field 

 Both name and value fields 

2. Click the down arrow on the Item Name box to display options for how the item you are replacing is identified in the 
script. This allows the wizard to find and replace similar matching items in the Visual Tree. You can select: 

 is equal to (variable to replace) 
 starts with (variable to replace_XXX) 
 ends with (YYY_variable to replace) 
 contains (YYY_variable to replace_XXX) 

The name and current value of the i tem you select displays in  the detai ls area at the bottom of the 
dialog box. 

3. Review your selections in the Details area, and click Next to proceed to the next step, where you define the 
variable. 

 

Step 2: Define the Variable that Replaces the Name or Value Field 

To def ine t he var iable t hat  r eplaces t he Nam e or  Value f ield: 

Notes:  
 The variable you define can replace the ent ire original value or port ions of i t .  

 When you choose to replace Both  nam e and val ue f i elds in  the previous step, the current step 
becomes Step 2.1: Def ine the variable to replace the Nam e f ield . When you complete th is 
step and cl ick Next , the dialog box appears again as Step 2.2: Def ine the vari able to replace 
the Value f i eld . Complete th is step for the Value field and cl ick Next  to proceed to Step 3. 
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1. In the Variable Name box, type a name for the variable or accept the default name. The default name is name#, 
where # is the number incremented by one for each new variable.  

2. Click the down arrow on the Frequency box to display selections for when the original value is replaced with the 
variable. You can select: 

 Once per test 
 Once per transact ion (default) 
 Every usage  

3. Do one of the following: 

 Type a value for the variable in  the Calculat ion  field. 

 In  the Tem plates area, cl ick the type of value you want to use , then select or type the 
associated detai ls in  the Detai l s area of the dialog box. Cl ick a template below to 
display the associated detai l  fields: 

o Date and Time 

o Random Alphanumeric 

o Random Number 

o Datapool Variable 

o Local Variable 

o Virtual User Number 

o Extract String 

Note: The text you type or the template you select can represent the entire variable, or you can combine it 
with other elements. 

4.  Repeat Step 3 until you include all elements for the calculation. 

5. Click Insert into Calculation. 

6. Click Next to proceed to the next step, where you select additional parameters to replace. Click Back to edit fields in 
the preceding dialog box. 

 

Step 3: Select Additional Parameters to Replace 

Once you ident i fy the i tem to replace, the Variable Replacement Wizard l ists al l  occurrences of the same 
item in the Visual Tree. Select the parameters that you want to replace with th is variable defin i t ion. 

 To select  addi t ional  param et ers t o r eplace w i t h t h is var iable def in i t ion: 

1. Click one or both of the following to select the type of parameters to replace: 

 Match only [variable type] parameters - Select th is opt ion to display only matching parameters 
of the same variable type as the original. For example, i f the original parameter you are 
replacing is a cookie, select ing th is opt ion replaces only cookie-type parameters. 

 Match only parameters from the host URL - Select th is opt ion to display only matching 
parameters from the same host URL as the original parameter. 

2. In the listbox, select the parameters that should be replaced with the variable definition. Click Select All to 
select all the listed parameters. 

3. Click Next to proceed to the next step, where you save the variable as a rule.  

 

Step 4: Save the Variable as a Rule 
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The Variable Replacement  Wizard saves the newly defined variable as a rule that you can store in  the Rule 
Library. Storing the rule in  the Rule Library means that i t  is automatical ly added to the Visual Script  when 
matching parameters are found in future capture fi les during the convert  process.  

To save t he var iable as a r ule: 

1. In the Rule name field, type a descriptive name for the rule or accept the default. 

2. Review the details in the Description box. This is a summary of the elements you used to define the variable. 

3. Select Add to rule library to store the rule so it can be used again in future capture files. 

4. If you add the rule to the Rule Library, do one of the following: 

 Click the down arrow in the Rule Folder  l ist  and select the folder name where the rule 
wi l l  be stored. 

 Click New  Folder . The Create New  Rule Folder  dialog box appears. In  the Folder 
Nam e field, type the name of the new folder, then cl ick OK. 

5. Review the Matching Items information.  

6. To edit any information, click Back until you return to the dialog box with details you want to change. 

7. Click Next to proceed to the Summary dialog box. 

 

Summary  

To review  and creat e t he var iable: 

1. In the Summary dialog box, review the information you entered for the variable. The information appears in three 
tabs: 

 Variable Propert i es - Shows the elements you used to define the variable and i ts 
frequency of use. Cl icking Detai l s displays the Calculat ion Detai ls dialog box. 

 I tem s to Replace - Shows the parameters with the same name in the script  that you 
chose to replace with th is variable defin i t ion. 

 Rule Propert i es - Shows detai ls of the variable and rule.  

2. Click Back to return to the appropriate dialog box to edit information. 

3. Click Finish to create the variable, apply it as a rule, and use it in the script.  

 

Using the Rule Library 

Overview of the Rule Library 

You can save variable replacements you define as rules. These are stored in  the Rule Library, where you can 
use them in future recordings and reduce repet i t ive parameterizat ion tasks.  

When subsequent captures are converted, the Visual  Navigator scans the Rule Library for matching 
parameters. For example, i f a rule parameterizes the value of a CGI Parameter named SessionID, the Visual 
Navigator scans through the Visual Tree for any CGI Parameters that match the descript ion defined in the 
rule. If a match is found, the rule is added to the Visual Tree, where you can apply i t  to the script . 

From the Rule Library, you can create rules, edit  rules, and view detai ls of individual rules and the folders 
in  which they are stored. 
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Elements of the Rule Library Dialog Box 

Create or modify parameter rules from the Rule Library  dialog box. The dialog box contains the fol lowing 
areas:  

!  Menu 

!  Rule Tree 

!  Details 

 

 

Rule Library Menus 

M en u Com m and Descript i on  

Fi l e New  Rule - Opens the Rule Creat ion Wizard. Use the wizard to 
define a rule that you can use to parameterize future scripts. 

New  Folder  - Creates a new folder in  the tree-view.  

Edi t  Use the Edit  menu to cut, copy, paste, delete, or rename rules. 

Rule Edi t  Rule - Opens the Rule Creat ion Wizard so you can edit  a 
rule you select in  the Rule Library. 

Help Displays QALoad help. 

 

 

Rule Library Tree-View 

The Rule Library tree-view displays a h ierarchical view of al l  rules and folders with in the Rule Library.  
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Rule Library Dialog Box Details  

The Detai ls area of the Rule Library dialog box displays in formation on the rules defined in the Rule 
Library. There are two levels of detai l : 

!  Folder - When you select a folder name in the Rule tree, the Details area of the dialog box displays information for 
each rule in the folder.  

!  Individual Rule - When you select a rule in a folder in the Rule tree, the Details area of the dialog box displays 
information for the individual rule in three tabs.  

 

Using the Rule Library 

Applying a Rule  

Follow these steps to apply a rule to i tems in the script . 

To apply a rule f rom  t he Visual  Tree: 

1. In the Visual Navigator vistree, click the Parameterization Rules script item and select the rule you want to apply. A 
description of the rule displays in the form-view. 

2. Click the Matching Items tab. The properties that determine the matching items and the matching items found in the 
script display. 
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3. Do one of the following: 

!  Click Apply Rule on the left-hand side of the dialog box to apply the rule to all the matching items. 

!  Select an item or items in the table and click Apply to Item on the right-hand side of the dialog box. 

 Note: When a different rule has been applied to an individual item, an red exclamation mark (!) appears 
next to the item in the table. Only one rule can be applied at a time. Click Go to Item and review the 
information in the Matching Parameter Rules area of the form-view to view the rule applied to the item. 

To apply a rule f rom  t he f orm -view  f or  a var iable: 

1. In the Visual Navigator vistree, select the variable to which you want to apply the rule. 

2. In the Matching Parameter Rules area at the bottom of the form-view (right-hand pane), select the rule you want to 
apply. 

3. Click Apply. The rule is applied to the variable. 

 

Editing a Rule  

Follow these steps to edit  rules stored in  the Rule Library. 

To edi t  a rule: 

1. Select a rule in the Rule Library visual tree, and click Rule>Edit Rule. The Rule Creation Wizard opens and displays 
the information on the rule you selected. 

2. Follow the procedure for creating a rule to make changes to the rule elements. 

 

Creating Rules from the Rule Library 

Create a new rule from the Rule Library using the Rule Creat ion Wizard. 

To open t he Rule Librar y W izard: 

1. Select Tools>Rule Library. The QALoad Rule Library opens. 

2. Select the folder in the tree-view where you want to store the new rule. 

3. Click File>New Rule. The Welcome dialog box of the Rule Creation Wizard displays. 

 

Using the Rule Library Wizard 

Step 1 of 3: Choose the Fields to be Replaced 

To choose t he f ields t o replace: 

1. Choose which fields of the matching item get their values from this rule. You can select: 

 Name field 

 Value field 

 Both name and value fields 
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2. Click the down arrow on the Item Name box to display options for how the item you are replacing is identified in the 
script. This enables the wizard to find and replace similar matching items. You can select: 

 is equal to (variable to replace) 
 starts with (variable to replace_XXX) 
 ends with (YYY_variable to replace) 
 contains (YYY_variable to replace_XXX) 

3. Select the parameter type to which you want the rule applied. Choose: 

 Only i tems of the specified type 

 All parameter types 

4. Select the URLs from which the item should be matched. Choose: 

 Match any i tems of the specified host URL and type the name of the URL. 

 Any host 

5. Click Next to proceed to the next step, where you define the variable. 

 

Step 2 of 3: Define the Variable 

To def ine t he var iable: 

Note: The variable you define can replace the entire original value or portions of it.  

1. In the Variable Name box, type a name for the variable or accept the default name. The default name depends on 
the field you chose to replace in the previous step. The default name is: 

 NameVar - i f you chose to replace the Name field in  the previous step.  

 ValueVar - i f you chose to replace the Value field in  the previous step. 

Note: When you choose to replace both the Name and Value in the previous step, the default 
is NameVar. When you complete this step and click Next , the dialog box displays again with 
ValueVar in the Variable Name field. Complete Step 1 through Step 5 for the Value variable. 

2. Click the down arrow on the Frequency box to display selections for when the original value is replaced with the 
rule. You can select: 

 Once per test 
 Once per transact ion (default) 
 Every usage  

3. In the Templates area, click the type of value you want to use , then select or type the associated details in the 
Details area of the dialog box. Click a template below to display the associated detail fields: 

 Date and Time 

 Random Alphanumeric 

 Random Numeric 

 Datapool Variable 

 Local Variable 

 Virtual User Number 

 Extract String 

Note: The text you type or the template you select can represent the entire variable, or you can combine it 
with other elements from the templates. 

4.  Repeat Step 3 and Step 4 until you include all elements for the calculation. 
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5. Click Insert into Calculation. 

6. Click Next to proceed to the next step, where you select additional parameters to replace. Click Back to edit fields in 
the preceding dialog box. 

Note: When you choose to replace Both name and value fields in the previous step, clicking Next  repeats 
the current step so you can define the variable for the Value field. Complete Step 1 through Step 5 for the 
Value field and click Next  to proceed to the next step. 
< Previous  Next > 

 

 

Step 3 of 3: Rule Description 

Review the rule you created. 

To view  t he rule: 

1. Review the details in the Description box. This is a summary of the elements you used to define the rule. 

Note: A default name is provided in the Rule Name field. You can type a new, descriptive name 
for the rule or accept the default. 

2. Store the rule in a folder by doing one of the following: 

 Click the down arrow in the Rule Folder  l ist  and select the folder name where the rule 
wi l l  be stored. 

 Click New  Folder . The Create New  Rule Folder  dialog box appears. In  the Folder 
Nam e field, type the name of the new folder, then cl ick OK. 

3. Click Next to proceed to the Summary dialog box. 

 

Summary  

To review  and creat e t he rule: 

1. In the Summary dialog box, review the information you entered for the rule. The information is displayed in two tabs: 

 Variable Propert i es - Shows the elements you used to define the rule and i ts frequency 
of use. Cl icking Detai l s displays the Variable Detai ls dialog box. 

 Rule Propert i es - Shows detai ls of the variable and rule.  

2. Click Back to return to the appropriate dialog box and edit any elements of the rule. 

3. Click Finish to create the rule and store it in the Rule Library. 

 

EasyScript  for WWW 

Configuring a Web browser (WWW) 

Before you record the WWW requests your Web browser makes, you must configure the browser to use 
QALoad’s proxy server. 

To conf igure a W eb brow ser : 
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1. Start your Web browser. 

2. Specify proxy settings: 

 In  the field designated to specify the address of the proxy server, enter the machine name 
where QALoad Script Development Workbench is instal led. 

 In  the Port  field, enter the port(s) that you specified on the Script Development Workbench ’s 
WWW Record Options wizard (Capture Ports fields). 

3. Click OK.  

 

Streaming media support 

QALoad includes support for audio and video download test ing of both Windows Media Player and 
RealOne Player and their supported media formats through a WWW session. When streaming media 
conversion is enabled and you record a transact ion that cal ls streaming media, an addit ional command 
that requests the media is inserted in to your script  . You do not have to l isten to or view the ent ire media 
you are request ing. You simply need to record i ts URL and ensure that the appropriate media player is 
instal led on the Player machines that plays back the script . At run t ime, the script  invokes your media 
player and requests the streaming media resource. Streaming media through a firewall  or proxy server is 
not supported. 

QALoad's streaming media support includes the fol lowing media player(s). The appropriate media player 
must be instal led on the machine you are recording from as well  as any QALoad Player machine that wi l l  
be execut ing the script . 

!  RealOne Player — The media download is initiated by requesting a file that is a data type supported by the 
RealOne Player. Supported data types are RealAudio, RealVideo, RealText, RealPix, MP3, and SMIL. As a result, 
the DownloadMediaRP command will be inserted into the script at the appropriate point. At runtime, this command 
initiates and waits for completion of the download. RealOne Player scripts must be executed as process-based 
scripts. 

!  Windows Media Player — The media download is initiated by downloading a file with a content type of 
(audio|video)/(x-ms-asf|s-ms-asf) in the browser. Currently, only .asx files are supported. As a result, the 
DownloadMediaFromASX command is inserted into the script at the appropriate point.  

Note: QALoad does not support scripts that have both RealNetworks media and Windows Media in the 
same script. To test both types in a single load test, use a different script for each type. 

Please note that asynchronous cal ls may not be played back exact ly as they were recorded. For example, i f 
you cl ick on a l ink in  the browser whi le recording while the media is playing, during replay that l ink wi l l  
not be requested unt i l  the media cl ip has fin ished being processed. 

How do I configure QALoad to process streaming media? 

 

 

XML Support 

QALoad's XML support is handled through the Script Development Workbench's Visual Navigator, which 
displays your script 's HTTP or XML requests in  an easy-to-use, visual ly-based interface that offers you 
point-and-cl ick script  edit ing. Although XML is supported through the Visual  Navigator, we recommend 
you read through th is help topic as well  as the Visual Navigator help topics to become famil iar with the 
features that are unique to QALoad's XML support. 

When an HTTP request is made for an XML document, ei ther in  the form of an HTTP GET request or an 
HTTP POST request with an XML document as the post data, the data is displayed in the three Visual 
Navigator panes as i l lustrated below. Cl ick on a pane in the graphic for a descript ion of i ts contents and 
funct ional i ty. 
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Note: To make the following graphic fit better in this help window, we've turned off the Script 
Development Workbench toolbars and panes that are not directly related to this help topic. You can 
hide/show many of the Script Development Workbench toolbars and panes using commands available from 
the View  menu. 

 

 

CJK Support in QALoad  

QALoad supports load test ing of Chinese, Japanese, and Korean (CJK) Web appl icat ions that use Double 
Byte Character Sets (DBCS). DBCS is a character set that uses two bytes (16 bits) rather than one byte (8 
bits) to represent a single character. Some languages, such as Chinese, Japanese, and Korean, have writ ing 
schemes with many different characters and character sets that cannot be represented with single-byte 
characters such as ASCII and EBCDIC.  

QALoad supports the fol lowing: 

!  Simplified Chinese - People's Republic of China (PRC), Singapore 

!  Traditional Chinese - Taiwan, Hong Kong, Macau 

!  Japanese 

!  Korean 

Notes:  

CJK support only applies to the WWW middleware. Currently, QALoad only supports the CJK Double 
Byte Character Sets; Web applications that host Bi-Directional (BiDi) characters (which includes Arabic 
and Hebrew languages) are not currently supported. 
UTF-8-encoded characters are treated as an additional character set used on CJK platforms. They are 
supported when represented on their native operating system. For example, Japanese characters are 
displayed properly on a Japanese operating system. 
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QALoad provides two methods of support for CJK: nat ive character and encoding. Depending on your 
test ing requirements and environment, i t  may be necessary to use both mechanisms to support the load 
test ing of a Web site that contains CJK characters.  

!  Native Character: converts the CJK characters to their original characters in Chinese, Japanese, or Korean. Native 
character support is only possible when using a native operating system (OS) such as load testing a Japanese Web 
application from a Japanese version of Microsoft Windows. QALoad supports one CJK language's characters in a 
script at a time, plus ASCII/English. Native character support is used within test scripts, error messages (generated 
through system commands that use native characters) and timing files, making script editing easier and timing file 
analysis quicker. 

!  Encoding: encodes all CJK characters into a sequence of printable characters regardless of the language and exact 
character set in use. Encoding support is used when load testing multiple language sites from the same OS, or when 
load testing a CJK site from that of another CJK platform. For example, testing a site with Japanese characters from 
a Korean or English/ASCII OS. The encoding option is used when native character support cannot be used or when 
script portability between different CJK language OS is required. 

 

WWW conversion options 

Form  f ield as com m ents: Select th is check box to include a comment block in  your script  that shows each 
val id field that is encountered after a CGI form has been requested. This opt ion is not avai lable i f the 
Visual Navigator is enabled. Fol lowing is an example of a form field comment block: 

/* Form:1 text Name: name, Value: , Desc: */ 
/* Form:1 text Name: e-mail, Value: , Desc: */ 
/* Form:1 text Name: Address, Value: , Desc: */ 
/* Form:1 text Name: city, Value: , Desc: */ 
/* Form:1 text Name: state, Value: , Desc: */ 
/* Form:1 text Name: zip, Value: , Desc: */ 
/* Form:1 check box Name: echo, Value: , Desc: Echo a copy of HTML page to email */ 
/* Form:1 radio Name: test, Value: capture, Desc: Capture */ 
/* Form:1 radio Name: test, Value: replay, Desc: Replay */ 
/* Form:1 hidden Name: hidden, Value: This rocks!, Desc: */ 

Anchors as com m ents: Select th is check box to include a comment block in  your script  that shows al l  the 
anchors encountered in a requested HTML document. If i t  is not selected, no anchors wi l l  be included in 
the script . This opt ion is not avai lable i f the Visual Navigator is enabled. The fol lowing is an example of an 
anchors comment block: 

/* Anchors:'http://playback1/standard.html' 'Standard Example' */ 
/* Anchors:'http://playback1/forms.html' 'Forms Example' */ 
/* Anchors:'http://playback1/dynamic.html' 'Dynamic HTML Example' */ 
/* Anchors:'http://playback1/cgi.html' 'CGI Example' */ 
/* Anchors:'http://playback1/cookies.html' 'Cookies Example’ */ 
/* Anchors:'http://playback1/ssl.html' 'SSL Example' */ 
/* Anchors:'http://playback1/javascript.html' 'Java Script Example' */ 

Cl ien t  Im age M aps as Com m ents: If selected, the command DO_GetClientM apHREF wil l  be inserted in to 
your script  fol lowed by a comment block denot ing cl ient image maps. This opt ion is not avai lable i f the 
Visual Navigator is enabled.   

DO_GetClientMapHREF(MAP(1), REGION(1), &ClientMapURL[0]); 

/* Client Map:1 Region:2 HREF: http://www.ethnicgrocer.com/eg/cp/cr.jsp?FOLDER%3C */ 
/* %3Efolder_id=169991 &ASSORTMENT%3C%3East_id=153827&site=EG&bmUID= */  
/* 1005685611375&WebLogicSession=O1GLayxDvTfjLthL65xY6X1cdQIVdCejWCT8wm */ 
/* D4PLs29z9H7WC wxlkr8f21K1aKoLSMI4Hml6o3|6518173674514870389/ */ 
/* 167838850/5/80/80/443/443/-1|-8250053020002903791/167838870/5/80 */ 
/* /80/443/443/-1|6518173674514872679Client Map:1 Region:3 HREF: */ 
/* http://www.ethnicgrocer.com/eg/cp/cr. */ 

You can search for DO_GetClientMapHREF in the script  to help locate the DO_Get and DO_SetValues in  
the script , as well  as where the array of DO_GetClientMapHREF is in i t ial ized and freed.  
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Debug com m ents: When th is opt ion is enabled, comments wi l l  be inserted in to the converted script  to 
denote repl ies from the server, anchors, and so on. This opt ion is not avai lable i f the Visual Navigator is 
enabled. For example: 

/* Received reply: 

URL:<http://abcweb.anywhere.com/cafe/default.htm> */ 

Docum en t  Ti t l e Veri f i cat ion : Periodical ly, the HTML page t i t le found in a load tested script  does not 
match the HTML page t i t le found in your recorded text. Select th is check box to compare the HTML page 
t i t le contents in  your load tested script  with the HTML page t i t le contents in  your capture fi le. You can 
enable the comparison based on prefix- or suffix-specified character match or ent ire string match. 

Ent i re Docum en t  Ti t l e: Select th is opt ion to compare the ent ire length of the HTML page t i t le. 

Pref i x : Select th is opt ion to compare the prefix (left-most specified characters) of the HTML page t i t le. 
Specify the number of characters to match in  the Characters to Match field. 

Suff i x : Select th is opt ion to compare the suffix (right-most specified characters) of the HTML page t i t le. 
Specify the number of characters to match in  the Characters to Match field. 

Characters to m atch : After you select the Prefix or Suffix opt ions, use th is field to specify the number of 
characters to match from the HTML page t i t le. 

Baud Rate Em ulat ion : Select th is check box to download web pages and images at a rate represent ing the 
speed of connect ion, then enter a connect ion speed in the Baud Rate field. This enables you to simulate 
modem speed. 

Refresh  Tim eout : Select th is check box and type a t ime value in  the field (in  seconds) to compare the 
specified t ime value against a Web page's META Refresh value (e.g. <META HTTP-EQUIV=Refresh 
CONTENT="10"; URL="http://www.compuware.com/"> ). If the META Refresh tag's CONTENT field 
value is less than the t ime value you specify, the page is treated as a redirected page. If the CONTENT field 
value is greater than the t ime you specify, the page is treated as a regular page. 

Tip: Select this option to avoid infinite loops in the script. Infinite loops can occur if a page refreshes 
periodically to update data. 

Represen t  CJK as Octal  Characters: Select th is check box to enable the encoding of captured data from 
Web appl icat ions contain ing Double Byte Character Sets (DBCS) such as Chinese, Japanese, or Korean. 
Enabl ing th is opt ion encodes al l  nat ive characters and is used when nat ive character support cannot be 
used. Data stays in  encoded format throughout the load test: from capture, through convert  and replay, to 
the analysis of the t im ing fi le. By leaving th is opt ion clear (default), CJK nat ive characters wi l l  be used 
with in test scripts, error messages, and t im ing fi les, making script  edit ing easier and t im ing fi le analysis 
quicker.  

Note: Native character support can only be used on the same CJK language OS as the application under 
test. For further information on CJK Support, see CJK Support in QALoad . 

Enable Visual  Navigator : Select th is check box to enable Visual Navigator, producing a visual ly-oriented 
script  rather than the standard QALoad C-based script .  

Note: When you select this option, some WWW conversion options are not available, such as commenting 
options, and some automatic playback options. 

Advanced but ton : Accesses the WWW Advanced dialog box, al lowing you to set advanced conversion 
opt ions.  

 

WWW Recording Options 

Autom at i c Startup of  In ternet  Explorer : Select th is opt ion to have QALoad automatical ly launch Internet 
Explorer, and configure the proxy and port  entries for the browser and the QALoad Script Development 
Workbench. If you do not select th is opt ion, you must manually configure your proxy opt ions before 
recording. 
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User Started Appl i cat ion : Select th is opt ion to configure the appl icat ion manually, and then set the 
appropriate opt ions from those that fol low. 

Proxy Sett ings for User Started Appl icat ion 

Di rect  Connect ion : Select th is opt ion i f you have a direct connect ion to the host from which you are 
recording. 

M an ual  Proxy Con f igurat ion : Select th is opt ion to specify a proxy through which to connect to the host. 
Then set the fol lowing proxy opt ions: 

HTTP: Type the address of the HTTP proxy server. This field has a 255 character l im it . Then enter 
the port  number in  the Port  field. QALoad accepts numbers from 0-65535. 

Secure: Type the address of the secure proxy server. This field is only avai lable i f you are l icensed to 
use EasyScript for Secure WWW. This field has a 255 character l im it . Then enter the port  number in  
the Port  field. QALoad accepts numbers from 0-65535. 

Except ions: Type the addresses of any hosts for which QALoad should not use the specified proxies. 

Proxy Autom at i c Con f igurat ion  Script : Select th is opt ion i f your proxy should use an automatic 
configurat ion script  located on your local area network. Then type the script 's URL in the URL field. 

Advanced Options 

Advanced Opt ions: This area displays the sett ings for several opt ions. To change any of these sett ings, 
cl ick the Change Advanced Opt ions button to open the Advanced Options dialog box. 

 

 

WWW command reference 

QALoad provides descript ions and examples of the various commands avai lable for a WWW script. For 
detai ls, refer to the Language Reference Help sect ion for WWW. 

 

EasyScript  for Secure WWW 

Overview 

EasyScript for Secure WWW supports SSL/HTTPS requests when used in conjunct ion with the WWW 
middleware. This support must be purchased separately and is distributed in  a separately-instal led module. 

 

Importing a client certificate from a Web browser (SSL) 

You can import and convert  a Cl ient Cert i ficate for any Web site you plan to visi t . 

To im por t  a cl ient  cer t i f icat e: 

1. Start your Web browser. 

2. From the browser, select the Client Certificate for the Web site you plan to visit. 

3. Export the Client Certificate (.p12 of .pfx file) to a directory where you can access it using the Script Development 
Workbench. 

Note: When the browser prompts you to enter a password, do not  enter a password. If you enter 
a password, QALoad cannot process the file. 

4. Start a WWW Session in the QALoad Script Development Workbench. 
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5. Click Tools>Maintain Certificates to open the SSL Certificate Maintenance dialog box. 

6. On the Client Certificates tab, click the browse button [...] to browse for the Client Certificate you want to convert. 
The Select the Exported Client Certificate to Convert dialog box opens. 

7. Make sure Files of Type specifies P12 files (*.p12) or PFX files (*.pfx). 

8. Select the appropriate Client Certificate and click Open. The path and file name of the selected Client Certificate 
appears in Enter Certificate to Convert on the Client Certificates tab. 

9. On the Client Certificates tab, click Convert. 

10. Click Close to exit the SSL Certificate Maintenance dialog box.  

 

Creating a client certificate in QALoad (SSL) 

This procedure assumes you have a WWW session act ive. 

To creat e a cl ien t  cer t i f i cat e: 

1. From the Tools menu, select Maintain Certificates to open the SSL Certificate Maintenance dialog box. 

2. On the Client Certificates tab, enter a name in the Certificate Name field. 

3. Enter the number of certificates to create. 

4. Click the Create button to create the QALoad Client Certificate. QALoad stores it in the QALoad\Certificates 
directory. 

Note: On the Unix player platform, you must create the Certificates sub-directory in the QALoad 
directory. The directory name is case sensitive. 

5. If necessary, configure your Web server to accept QALoad as the Certificate Authority. Refer to your Web server 
documentation for more information.  

 

Creating an SSL Certificate Authority 

Note that creat ing a new CA inval idates al l  previously created cl ient cert i ficates. 

To creat e an SSL Cer t i f i cat e Aut hor i t y: 

1. Start a WWW session. 

2. From the Tools menu, select Maintain Certificates. 

3. Click the Certificate Authority tab. 

4. Click the Create button to create a new Certificate Authority with the expiration date shown in the field.  

5. Exit and re-start the Script Development Workbench. 

6. After creating a new Certificate Authority, re-import the CA to your Web server and then create new Client 
Certificates.  

 

Creating an SSL Server Certificate 

To creat e an SSL Server  Cer t i f icat e: 

1. Start a WWW session. 

2. From the Tools menu, select Maintain Certificates. 

3. Click the Server Certificate tab. 
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4. Click the Create button to create a new Server Certificate with the expiration date shown in the field.  

 

Sample Scripts 

Overview 

This sect ion shows examples of how you can manipulate converted scripts to address specific si tuat ions or 
resolve certain problems. Samples include examples of variabl izat ion, changes to transact ion logic, and 
detai led descript ions of commonly used commands. Sample scripts are shown for these middlewares: 

Citrix 

Oracle Forms Server 

SAP 

Winsock 

WWW 

 

Cit rix Scripts 

Citrix Script Samples  

You can address specific si tuat ions or resolve certain  problems by modifying converted Citrix scripts. The 
samples shown here include a descript ion of the problem, the procedure for implementing the 
modificat ion, and samples of a modified script . Script  modificat ions are discussed for: 

Handling Citrix Server Farms 

Handling Dynamic Window Tit les 

Handling Intermit tent Windows 

Handling Unexpected Events 

Moving Citrix Connect and Disconnect Outside the Transact ion Loop 

Script ing Mouse Act ions 

Using the CtxWaitForScreenUpdate Command 

 

Handling Citrix Server Farms 

Handl ing Ci t r i x  Server Farm s 

Load test ing requirements may include connect ing to a Citrix server farm, where the load balancing 
feature supports dynamic redirect ion to a given server at connect ion t ime. This load tests the server farm 
and Citrix load balancing rather than a single server, which can provide a more real ist ic load test.   

In  order to record a script  that connects to a farm, you must use an ICA fi le specified in  the Citrix Record 
Options dialog. Since the ICA fi le should contain al l  the necessary connect ion  in formation, the server field 
should be left  blank when recording.  

When converted, the CitrixServer variable has a blank space: 

/* Declare Variables */ 
const char *CitrixServer   = " "; 
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const char *CitrixUsername = "citrix"; 
const char *CitrixPassword = "~encr~657E06726F697206"; 
const char *CitrixDomain   = "qacitrix2"; 
const int CitrixOutputMode = OUTPUT_MODE_NORMAL; 

The Citrix cl ient ignores th is value and uses the ICA fi le to dynamical ly retrieve the server name at 
playback t ime. 

Conclusion 

When you use these techniques to set up a Citrix server farm test script , you al low for dynamic server 
redirect ion at playback as part  of test ing a load balanced Citrix server farm.  

 

Sam ple Script  for Handl ing Ci t r i x  Server Farm s 

The fol lowing sample shows a snippet of a Citrix script   that sets up a server farm test script .  

Sample Script  
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 

#define CITRIX_CLIENT_VERSION "8.100.29670" 
#define CITRIX_ICO_VERSION    "2.4" 
#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 
#include "smacro.h" 

#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 
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/////////////////////////////////////////////////////////// 
     /// Convert sets the Citrix server name to a single blank 
/// space. This is only necessary to verify that the script actually is connecting to a 
server farm. 
/////////////////////////////////////////////////////////// 
const char *CitrixServer      = " "; 

const char *CitrixUsername    = "test"; 
const char *CitrixPassword    = "~encr~657E06726F697206"; 
const char *CitrixDomain      = "test"; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 

/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_3 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_4 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_5 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_6 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_7 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_8 = new CtxWI(0x1008c, "", 115, 0, 405, 457); 
CtxWI *CWI_9 = new CtxWI(0x2006c, "Calculator", 66, 66, 261, 253); 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("capCtxServerFarm.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetDomainLoginInfo(CitrixUsername, CitrixPassword, CitrixDomain); 
CtxSetICAFile("PRD desktop.ica"); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 

SYNCHRONIZE(); 

…rest of script… 
 

Handling Dynamic Window Titles 

M odi fying the Script  to Handle Dyn am ic Window  Ti t l es 

Window t i t les can vary based on the state of the appl icat ion. For example, M icrosoft  Word windows may 
appear with the name of a default  document t i t le as part  of the window name. Other window t i t les may 
contain the user’s name, or the day or t ime. When a window name in  the record session varies from the 
name in a val idat ion or playback session, the script  fai ls with a window t i t le mismatch error.   

When th is error occurs during val idat ion or playback, you must modify the script  to recognize the base 
pattern of the window t i t le name rather than an exact window t i t le. You can do th is during conversion  by 
adding CtxWaitForWindowCreate cal ls to the script  for each named window creat ion event. 

When you modify a script  for these occurrences, you must: 

!  Modify the recording process 

!  Perform an initial validation 
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!  Identify a Match Pattern  

!  Modify the script  

!  Revalidate the script  

Note: You may need to configure the workbench and player for validation.  
  

To m odi f y t he recording process: 

1. Record the Citrix session with the proper opt ions selected.  

2. Click Opt ions>Convert , then cl ick the Ci t r i x  tab.  

3. Ensure that the Enable W i ldcard Ti t l e M atch  check box is selected. 

4. Click OK to convert  the recording. 

To per f orm  an in i t ial  val idat ion af t er  scr ip t  record and conversion: 

1. Click Session>Validate Script.  

2. When the val idat ion session generates the window t i t le mismatch error, compare the actual 
window t i t le name to the expected window t i t le name.  

Note:  Repeated validations should generate a list of one or more window titles that differ from the 
expected title.   

To per f orm  a Mat ch Pat t ern ident i f icat ion: 

Ident i fy a match pattern that compares al l  actual window t i t les to original window t i t les using the l ist of 
window t i t les from val idat ions.   

Note: This regular-expression style match pattern uses the normal character set. Asterisks (*) denote 0 to n 
wildcard characters. Question marks denote one wildcard character. 

To m odi f y t he scr ipt : 

Make the script  changes when you ident i fy a workable match pattern for the dynamic window.   

1. In  the script , ensure that the SetEnableWi ldcardM atch ing command exists before the 
SYNCHRONIZE command. 

2. Ensure that the SetEnableWi ldcardM atch ing parameter value is set to TRUE.   

Note: This statement is inserted when you set the Enable Wildcard Tit le Match option in 
Opt ions>Convert  before converting the recording.   

3. Insert  a CtxSetWindow M atchTi t l e command before the CtxWai tForWindow Create cal l  for each 
window creat ion wait  event for the dynamic window.  The parameters include the Citrix window 
ident i fier and the ident i fied match pattern for the dynamic window.  

To reval idat e t he scr ipt : 

1. Click Session>Validate Script.  

2. If the CtxWai tForWindow Create wait  event cal l  fai ls, ident i fy the actual window t i t le returned.  

3. Perform the match pattern ident i ficat ion step and re-create a val id wi ldcard string to match al l  
expected window values.  
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Conclusion 

Fol lowing these techniques, you can modify window creat ion events to recognize dynamic window t i t les. 
The sample scripts i l lustrate how to determine a base pattern for the window t i t le by sequential  val idat ions 
of the script  and how to make relevant changes to the script . The first  example uses a substring match to 
recognize the dynamic window t i t le. The second example uses a wi ldcard match to accomplish th is. 

 

Exam ple One 

Script Samples: Example One - Using a Substring Match 

In th is example, the M icrosoft  Word appl icat ion generates a dynamic t i t le. The dynamic name is a 
concatenat ion of the default  document that Word creates at appl icat ion startup with the name of the 
appl icat ion.  

Original Window Tit le (Record)  “ Microsoft  Word”  

Actual Window Tit le (Val idat ion) “ document1 - M icrosoft  Word”  

Actual Window Tit le (Val idat ion) “ document 2 - M icrosoft  Word”  

The script  is altered to reflect the fact that the string “ Microsoft  Word”  is always part  of the window t i t le. 
 The asterisk (*) wi ldcard is subst i tuted for the default  document name. 

“ Match Pattern ”  from window 
t i t les 

 “ * - M icrosoft  Word”  

 

Sample: Original Citrix Script   

This is an example of an original Citrix script  converted from capture. In  th is example, the M icrosoft  Word 
appl icat ion generates a dynamic t i t le. The dynamic name is a concatenat ion of the default  document that 
Word creates at appl icat ion startup with the name of the appl icat ion. Points of in terest in  the script  are 
h ighl ighted in  bold. 

Sample Script 
/* 
 *  dynamicwindow.cpp 
 * 
 *  Script Converted on April 18, 2005 at 12:13:47 PM 
 *  Generated by Compuware QALoad convert module version 5.5.0 build 256 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
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 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 

#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000505UL 
 
#include <stdio.h> 
#include "smacro.h" 
 
#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 
 
extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix"; 
const char *CitrixPassword    = ""; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_8 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_9 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_10 = new CtxWI(0x1008c, "", 115, 0, 405, 457); 
CtxWI *CWI_11 = new CtxWI(0x20068, "", 112, 116, 416, 248); 

// Note the initial window title of “Microsoft Word” is set here in the script…  
CtxWI *CWI_12 = new CtxWI(0x2006e, "Microsoft Word", -4, -4, 649, 461); 
CtxWI *CWI_13 = new CtxWI(0x7001c, "Please wait...", 111, 112, 418, 145); 
 
SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("dynamicwindow.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
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CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 

CtxConnect(CitrixServer, CitrixOutputMode); 

CtxPoint(164, 61);  //1113840775.516 

// Window CWI_1 ("Warning !!") created 1113840775.516 

CtxWaitForWindowCreate(CWI_1, 1969); 

DO_MSLEEP(2046); 
CtxPoint(332, 359);  //1113840777.629 

DO_MSLEEP(63); 
CtxClick(CWI_1, 94, L_BUTTON, NONE); //1113840777.723 

// Window CWI_2 ("Log On to Windows") created 1113840777.817 

CtxWaitForWindowCreate(CWI_2, 93); 

DO_MSLEEP(16); 
// Window CWI_1 ("Warning !!") destroyed 1113840777.833 

CtxType(CWI_2, "citrix");  //1113840786.615 

DO_MSLEEP(8547); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113840786.678 

DO_MSLEEP(281); 
CtxType(CWI_2, "citrix");  //1113840788.650 

DO_MSLEEP(1672); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113840788.713 

DO_MSLEEP(359); 
CtxType(CWI_2, "q");  //1113840789.683 

DO_MSLEEP(438); 

DO_MSLEEP(1078); 
CtxPoint(231, 325);  //1113840790.309 

DO_MSLEEP(78); 
CtxMouseDown(CWI_2, L_BUTTON, NONE, 231, 325);  // 1113840790.309 

CtxMouseUp(CWI_2, L_BUTTON, NONE, 232, 325); //1113840790.388 

CtxPoint(232, 325);  //1113840790.544 

// Window CWI_3 ("Please wait...") created 1113840790.544 

CtxWaitForWindowCreate(CWI_3, 204); 

// Window CWI_2 ("Log On to Windows") destroyed 1113840790.544 

// Window CWI_4 ("Citrix License Warning Notice") created 1113840790.591 

CtxWaitForWindowCreate(CWI_4, 46); 

DO_MSLEEP(16); 
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// Window CWI_3 ("Please wait...") destroyed 1113840790.607 

// Window CWI_5 ("Citrix License Warning Notice") created 1113840790.654 

CtxWaitForWindowCreate(CWI_5, 47); 

DO_MSLEEP(16); 
// Window CWI_4 ("Citrix License Warning Notice") destroyed 1113840790.669 

// Window CWI_6 ("UsrLogon.Cmd") created 1113840790.716 

CtxWaitForWindowCreate(CWI_6, 46); 

DO_MSLEEP(16); 
// Window CWI_6 ("UsrLogon.Cmd") destroyed 1113840790.732 

// Window CWI_7 ("") created 1113840790.967 

DO_MSLEEP(234); 
// Window CWI_8 ("ICA Seamless Host Agent") created 1113840791.014 

CtxWaitForWindowCreate(CWI_8, 47); 

// Window CWI_9 ("Program Manager") created 1113840791.030 

CtxWaitForWindowCreate(CWI_9, 16); 

CtxPoint(347, 249);  //1113840793.080 

// Window CWI_10 ("") created 1113840793.080 

DO_MSLEEP(16); 

DO_MSLEEP(1203); 
CtxPoint(571, 256);  //1113840796.133 

DO_MSLEEP(1844); 
// Window CWI_10 ("") destroyed 1113840796.133 

DO_MSLEEP(1828); 
CtxPoint(446, 208);  //1113840798.309 

DO_MSLEEP(344); 
CtxClick(CWI_5, 78, L_BUTTON, NONE); //1113840798.387 

DO_MSLEEP(437); 
CtxPoint(311, 303);  //1113840798.935 

DO_MSLEEP(110); 
CtxClick(CWI_5, 109, L_BUTTON, NONE); //1113840799.045 

DO_MSLEEP(94); 
// Window CWI_5 ("Citrix License Warning Notice") destroyed 1113840799.138 

DO_MSLEEP(390); 
CtxPoint(275, 1);  //1113840799.718 

DO_MSLEEP(188); 
CtxClick(CWI_8, 62, L_BUTTON, NONE); //1113840799.780 

DO_MSLEEP(703); 
CtxPoint(200, 187);  //1113840800.579 

DO_MSLEEP(94); 
CtxClick(CWI_8, 78, L_BUTTON, NONE); //1113840800.657 

DO_MSLEEP(110); 
CtxPoint(209, 192);  //1113840800.766 
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// Window CWI_8 ("ICA Seamless Host Agent") destroyed 1113840800.766 

DO_MSLEEP(5328); 
CtxPoint(115, 175);  //1113840806.245 

DO_MSLEEP(140); 
CtxDoubleClick(CWI_9); // 1113840806.621 

CtxMouseUp(CWI_7, L_BUTTON, NONE, 114, 174); //1113840806.512 

DO_MSLEEP(16); 
CtxPoint(114, 174);  //1113840806.621 

DO_MSLEEP(359); 
CtxPoint(284, 205);  //1113840807.028 

// Window CWI_11 ("") created 1113840807.028 

DO_MSLEEP(16); 
CtxPoint(309, 208);  //1113840807.326 

// Window CWI_12 ("Microsoft Word") created 1113840807.326 

/// The window create wait event.  If the window title at replay 
/// is any different that “Microsoft Word”, this wait event will FAIL. 

CtxWaitForWindowCreate(CWI_12, 266); 

DO_MSLEEP(46); 
CWI_12->setTitle("Document1 - Microsoft Word"); //1113840807.388 

DO_MSLEEP(16); 
// Window CWI_11 ("") destroyed 1113840807.388 

DO_MSLEEP(4188); 
CtxPoint(626, 8);  //1113840811.693 

DO_MSLEEP(109); 
CtxClick(CWI_12, 94, L_BUTTON, NONE); //1113840811.787 

DO_MSLEEP(218); 
CtxPoint(623, 40);  //1113840812.006 

// Window CWI_12 ("Document1 - Microsoft Word") destroyed 1113840812.006 

DO_MSLEEP(2204); 
CtxPoint(385, 1);  //1113840815.262 

DO_MSLEEP(1046); 
// Window CWI_9 ("Program Manager") destroyed 1113840815.262 

// Window CWI_7 ("") destroyed 1113840815.262 

// Window CWI_13 ("Please wait...") created 1113840815.513 

CtxWaitForWindowCreate(CWI_13, 0); 

DO_SetTransactionCleanup(); 

CtxDisconnect(); 

END_TRANSACTION(); 

delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
delete CWI_4; // "Citrix License Warning Notice" 
delete CWI_5; // "Citrix License Warning Notice" 
delete CWI_6; // "UsrLogon.Cmd" 
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delete CWI_7; // "" 
delete CWI_8; // "ICA Seamless Host Agent" 
delete CWI_9; // "Program Manager" 
delete CWI_10; // "" 
delete CWI_11; // "" 
delete CWI_12; // "Microsoft Word" 
delete CWI_13; // "Please wait..." 

CitrixUninit(); 

EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 

CitrixUninit(); 

EXIT(); 
} 

 

Sample One: Modified Cit rix Script   

In  th is example, the M icrosoft  Word appl icat ion generates dynamic t i t le that is a concatenat ion of the 
default  document that Word creates at appl icat ion startup with the name of the appl icat ion. This script  is 
altered to reflect the fact that the string “ Microsoft  Word”  is always part  of the window t i t le. The asterisk 
(*) wi ldcard is subst i tuted for the default  document name. Changes to the original script  are h ighl ighted in  
bold. 

Sample Script 
/* 
 *  dynamicwindow.cpp 
 * 
 *  Script Converted on April 18, 2005 at 12:13:47 PM 
 *  Generated by Compuware QALoad convert module version 5.5.0 build 256 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
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 *   Enable Wildcard Title Match     : Yes 
 */ 

#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 
#include "smacro.h" 

#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix"; 
const char *CitrixPassword    = ""; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_8 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_9 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_10 = new CtxWI(0x1008c, "", 115, 0, 405, 457); 
CtxWI *CWI_11 = new CtxWI(0x20068, "", 112, 116, 416, 248); 

// The initial window title of “Microsoft Word” does not change 
CtxWI *CWI_12 = new CtxWI(0x2006e, "Microsoft Word", -4, -4, 649, 461); 
CtxWI *CWI_13 = new CtxWI(0x7001c, "Please wait...", 111, 112, 418, 145); 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("dynamicwindow.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 

CtxConnect(CitrixServer, CitrixOutputMode); 
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CtxPoint(164, 61);  //1113840775.516 

// Window CWI_1 ("Warning !!") created 1113840775.516 

CtxWaitForWindowCreate(CWI_1, 1969); 

DO_MSLEEP(2046); 
CtxPoint(332, 359);  //1113840777.629 

DO_MSLEEP(63); 
CtxClick(CWI_1, 94, L_BUTTON, NONE); //1113840777.723 

// Window CWI_2 ("Log On to Windows") created 1113840777.817 

CtxWaitForWindowCreate(CWI_2, 93); 

DO_MSLEEP(16); 
// Window CWI_1 ("Warning !!") destroyed 1113840777.833 

CtxType(CWI_2, "citrix");  //1113840786.615 

DO_MSLEEP(8547); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113840786.678 

DO_MSLEEP(281); 
CtxType(CWI_2, "citrix");  //1113840788.650 

DO_MSLEEP(1672); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113840788.713 

DO_MSLEEP(359); 
CtxType(CWI_2, "q");  //1113840789.683 

DO_MSLEEP(438); 

DO_MSLEEP(1078); 
CtxPoint(231, 325);  //1113840790.309 

DO_MSLEEP(78); 
CtxMouseDown(CWI_2, L_BUTTON, NONE, 231, 325);  // 1113840790.309 

CtxMouseUp(CWI_2, L_BUTTON, NONE, 232, 325); //1113840790.388 

CtxPoint(232, 325);  //1113840790.544 

// Window CWI_3 ("Please wait...") created 1113840790.544 

CtxWaitForWindowCreate(CWI_3, 204); 

// Window CWI_2 ("Log On to Windows") destroyed 1113840790.544 

// Window CWI_4 ("Citrix License Warning Notice") created 1113840790.591 

CtxWaitForWindowCreate(CWI_4, 46); 

DO_MSLEEP(16); 
// Window CWI_3 ("Please wait...") destroyed 1113840790.607 

// Window CWI_5 ("Citrix License Warning Notice") created 1113840790.654 

CtxWaitForWindowCreate(CWI_5, 47); 

DO_MSLEEP(16); 
// Window CWI_4 ("Citrix License Warning Notice") destroyed 1113840790.669 

// Window CWI_6 ("UsrLogon.Cmd") created 1113840790.716 

CtxWaitForWindowCreate(CWI_6, 46); 
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DO_MSLEEP(16); 
// Window CWI_6 ("UsrLogon.Cmd") destroyed 1113840790.732 

// Window CWI_7 ("") created 1113840790.967 

DO_MSLEEP(234); 
// Window CWI_8 ("ICA Seamless Host Agent") created 1113840791.014 

CtxWaitForWindowCreate(CWI_8, 47); 

// Window CWI_9 ("Program Manager") created 1113840791.030 

CtxWaitForWindowCreate(CWI_9, 16); 

CtxPoint(347, 249);  //1113840793.080 

// Window CWI_10 ("") created 1113840793.080 

DO_MSLEEP(16); 

DO_MSLEEP(1203); 
CtxPoint(571, 256);  //1113840796.133 

DO_MSLEEP(1844); 
// Window CWI_10 ("") destroyed 1113840796.133 

DO_MSLEEP(1828); 
CtxPoint(446, 208);  //1113840798.309 

DO_MSLEEP(344); 
CtxClick(CWI_5, 78, L_BUTTON, NONE); //1113840798.387 

DO_MSLEEP(437); 
CtxPoint(311, 303);  //1113840798.935 

DO_MSLEEP(110); 
CtxClick(CWI_5, 109, L_BUTTON, NONE); //1113840799.045 

DO_MSLEEP(94); 
// Window CWI_5 ("Citrix License Warning Notice") destroyed 1113840799.138 

DO_MSLEEP(390); 
CtxPoint(275, 1);  //1113840799.718 

DO_MSLEEP(188); 
CtxClick(CWI_8, 62, L_BUTTON, NONE); //1113840799.780 

DO_MSLEEP(703); 
CtxPoint(200, 187);  //1113840800.579 

DO_MSLEEP(94); 
CtxClick(CWI_8, 78, L_BUTTON, NONE); //1113840800.657 

DO_MSLEEP(110); 
CtxPoint(209, 192);  //1113840800.766 

// Window CWI_8 ("ICA Seamless Host Agent") destroyed 1113840800.766 

DO_MSLEEP(5328); 
CtxPoint(115, 175);  //1113840806.245 

DO_MSLEEP(140); 
CtxDoubleClick(CWI_9); // 1113840806.621 

CtxMouseUp(CWI_7, L_BUTTON, NONE, 114, 174); //1113840806.512 

DO_MSLEEP(16); 
CtxPoint(114, 174);  //1113840806.621 
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DO_MSLEEP(359); 
CtxPoint(284, 205);  //1113840807.028 

// Window CWI_11 ("") created 1113840807.028 

DO_MSLEEP(16); 
CtxPoint(309, 208);  //1113840807.326 

// Window CWI_12 ("Microsoft Word") created 1113840807.326 

//////////////////////////////////////////////////////////////////////  
/// The CtxSetWindowMatchTitle command is inserted prior to the  
/// CtxSetWindowMatchTitle call. Note that the window identifier is the  
//  same for both calls, and the “match pattern” for the command is from  
/// Example One in the Match Pattern Identification section above.  
////////////////////////////////////////////////////////////////////// 

CtxSetWindowMatchTitle(CW1_12, "*Microsoft Word"" ); 
 
/// The window create wait event call does not change. 

CtxWaitForWindowCreate(CWI_12, 266); 

DO_MSLEEP(46); 
CWI_12->setTitle("Document1 - Microsoft Word"); //1113840807.388 

DO_MSLEEP(16); 
// Window CWI_11 ("") destroyed 1113840807.388 

DO_MSLEEP(4188); 
CtxPoint(626, 8);  //1113840811.693 

DO_MSLEEP(109); 
CtxClick(CWI_12, 94, L_BUTTON, NONE); //1113840811.787 

DO_MSLEEP(218); 
CtxPoint(623, 40);  //1113840812.006 

// Window CWI_12 ("Document1 - Microsoft Word") destroyed 1113840812.006 

DO_MSLEEP(2204); 
CtxPoint(385, 1);  //1113840815.262 

DO_MSLEEP(1046); 
// Window CWI_9 ("Program Manager") destroyed 1113840815.262 

// Window CWI_7 ("") destroyed 1113840815.262 

// Window CWI_13 ("Please wait...") created 1113840815.513 

CtxWaitForWindowCreate(CWI_13, 0); 

DO_SetTransactionCleanup(); 

CtxDisconnect(); 

END_TRANSACTION(); 

delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
delete CWI_4; // "Citrix License Warning Notice" 
delete CWI_5; // "Citrix License Warning Notice" 
delete CWI_6; // "UsrLogon.Cmd" 
delete CWI_7; // "" 
delete CWI_8; // "ICA Seamless Host Agent" 
delete CWI_9; // "Program Manager" 
delete CWI_10; // "" 
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delete CWI_11; // "" 
delete CWI_12; // "Microsoft Word" 
delete CWI_13; // "Please wait..." 

CitrixUninit(); 

EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 

CitrixUninit(); 

EXIT(); 

} 

 

Exam ple Tw o 

Script Samples: Example Two - Using a Wildcard M atch 

In th is example, the Sample Appl icat ion generates a dynamic t i t le. The dynamic name is the name of the 
appl icat ion fol lowed by the t ime the script  is created.  

Original Window Tit le (Record)  “ Sample Appl icat ion – 09:01:23 AM ”  

Actual Window Tit le (Val idat ion) “ Sample Appl icat ion – 11:00:04 AM ”  

Actual Window Tit le (Val idat ion) “ Sample Appl icat ion – 12:20:52 PM ”  

The quest ion mark (?) wi ldcard is subst i tuted for a given t ime. 

“ Match Pattern ”  from window 
t i t les 

“ Sample Appl icat ion – ??:??:?? ?M ”  

 

Sample Two: Original Citrix Script   

The fol lowing sample is an original Citrix script  converted from capture. In  th is example, the Sample 
Appl icat ion generates a dynamic t i t le. The dynamic name is the name of the appl icat ion fol lowed by the 
t ime the script  is created. Points of in terest in  the script  are h ighl ighted in  bold. 

Sample Script 

/* 
 *  dynamicwindow2.cpp 
 * 
 *  Script Converted on April 18, 2005 at 12:13:47 PM 
 *  Generated by Compuware QALoad convert module version 5.5.0 build 256 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
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 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 

#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 
#include "smacro.h" 

#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix"; 
const char *CitrixPassword    = ""; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_8 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_9 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_10 = new CtxWI(0x1008c, "", 115, 0, 405, 457); 
CtxWI *CWI_11 = new CtxWI(0x20068, "", 112, 116, 416, 248); 

// Note the initial window title of “Sample Application 09:01:23 AM” is set here…  
CtxWI *CWI_12 = new CtxWI(0x2006e, "Sample Application 09:01:23 AM ", -4, -4, 649, 461); 
CtxWI *CWI_13 = new CtxWI(0x7001c, "Please wait...", 111, 112, 418, 145); 
 
SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("dynamicwindow.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
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CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 
 
CtxConnect(CitrixServer, CitrixOutputMode); 
 
CtxPoint(164, 61);  //1113840775.516 
 
// Window CWI_1 ("Warning !!") created 1113840775.516 
 
CtxWaitForWindowCreate(CWI_1, 1969); 
 
DO_MSLEEP(2046); 
CtxPoint(332, 359);  //1113840777.629 
 
DO_MSLEEP(63); 
CtxClick(CWI_1, 94, L_BUTTON, NONE); //1113840777.723 
 
// Window CWI_2 ("Log On to Windows") created 1113840777.817 
 
CtxWaitForWindowCreate(CWI_2, 93); 
 
DO_MSLEEP(16); 
// Window CWI_1 ("Warning !!") destroyed 1113840777.833 
 
CtxType(CWI_2, "citrix");  //1113840786.615 
 
DO_MSLEEP(8547); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113840786.678 
 
DO_MSLEEP(281); 
CtxType(CWI_2, "citrix");  //1113840788.650 
 
DO_MSLEEP(1672); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113840788.713 
 
DO_MSLEEP(359); 
CtxType(CWI_2, "q");  //1113840789.683 
 
DO_MSLEEP(438); 
 
DO_MSLEEP(1078); 
CtxPoint(231, 325);  //1113840790.309 
 
DO_MSLEEP(78); 
CtxMouseDown(CWI_2, L_BUTTON, NONE, 231, 325);  // 1113840790.309 
 
CtxMouseUp(CWI_2, L_BUTTON, NONE, 232, 325); //1113840790.388 
 
CtxPoint(232, 325);  //1113840790.544 
 
// Window CWI_3 ("Please wait...") created 1113840790.544 
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CtxWaitForWindowCreate(CWI_3, 204); 
 
// Window CWI_2 ("Log On to Windows") destroyed 1113840790.544 
 
// Window CWI_4 ("Citrix License Warning Notice") created 1113840790.591 
 
CtxWaitForWindowCreate(CWI_4, 46); 
 
DO_MSLEEP(16); 
// Window CWI_3 ("Please wait...") destroyed 1113840790.607 
 
// Window CWI_5 ("Citrix License Warning Notice") created 1113840790.654 
 
CtxWaitForWindowCreate(CWI_5, 47); 
 
DO_MSLEEP(16); 
// Window CWI_4 ("Citrix License Warning Notice") destroyed 1113840790.669 
 
// Window CWI_6 ("UsrLogon.Cmd") created 1113840790.716 
 
CtxWaitForWindowCreate(CWI_6, 46); 
 
DO_MSLEEP(16); 
// Window CWI_6 ("UsrLogon.Cmd") destroyed 1113840790.732 
 
// Window CWI_7 ("") created 1113840790.967 
 
DO_MSLEEP(234); 
// Window CWI_8 ("ICA Seamless Host Agent") created 1113840791.014 
 
CtxWaitForWindowCreate(CWI_8, 47); 
 
// Window CWI_9 ("Program Manager") created 1113840791.030 
 
CtxWaitForWindowCreate(CWI_9, 16); 
 
CtxPoint(347, 249);  //1113840793.080 
 
// Window CWI_10 ("") created 1113840793.080 
 
DO_MSLEEP(16); 
 
DO_MSLEEP(1203); 
CtxPoint(571, 256);  //1113840796.133 
 
DO_MSLEEP(1844); 
// Window CWI_10 ("") destroyed 1113840796.133 
 
DO_MSLEEP(1828); 
CtxPoint(446, 208);  //1113840798.309 
 
DO_MSLEEP(344); 
CtxClick(CWI_5, 78, L_BUTTON, NONE); //1113840798.387 
 
DO_MSLEEP(437); 
CtxPoint(311, 303);  //1113840798.935 
 
DO_MSLEEP(110); 
CtxClick(CWI_5, 109, L_BUTTON, NONE); //1113840799.045 
 
DO_MSLEEP(94); 
// Window CWI_5 ("Citrix License Warning Notice") destroyed 1113840799.138 
 
DO_MSLEEP(390); 
CtxPoint(275, 1);  //1113840799.718 
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DO_MSLEEP(188); 
CtxClick(CWI_8, 62, L_BUTTON, NONE); //1113840799.780 
 
DO_MSLEEP(703); 
CtxPoint(200, 187);  //1113840800.579 
 
DO_MSLEEP(94); 
CtxClick(CWI_8, 78, L_BUTTON, NONE); //1113840800.657 
 
DO_MSLEEP(110); 
CtxPoint(209, 192);  //1113840800.766 
 
// Window CWI_8 ("ICA Seamless Host Agent") destroyed 1113840800.766 
 
DO_MSLEEP(5328); 
CtxPoint(115, 175);  //1113840806.245 
 
DO_MSLEEP(140); 
CtxDoubleClick(CWI_9); // 1113840806.621 
 
CtxMouseUp(CWI_7, L_BUTTON, NONE, 114, 174); //1113840806.512 
 
DO_MSLEEP(16); 
CtxPoint(114, 174);  //1113840806.621 
 
DO_MSLEEP(359); 
 
CtxPoint(284, 205);  //1113840807.028 
 
// Window CWI_11 ("") created 1113840807.028 
 
DO_MSLEEP(16); 
CtxPoint(309, 208);  //1113840807.326 
 
// Window CWI_12 ("Microsoft Word") created 1113840807.326 
 

/// The window create wait event.  If the window title at replay 
/// is any different that “Sample Application 09:01:23 AM”, this wait event  
/// will FAIL. 

CtxWaitForWindowCreate(CWI_12, 266); 
 
DO_MSLEEP(46); 
CWI_12->setTitle("Document1 - Microsoft Word"); //1113840807.388 
 
DO_MSLEEP(16); 
// Window CWI_11 ("") destroyed 1113840807.388 
 
DO_MSLEEP(4188); 
CtxPoint(626, 8);  //1113840811.693 
 
DO_MSLEEP(109); 
CtxClick(CWI_12, 94, L_BUTTON, NONE); //1113840811.787 
 
DO_MSLEEP(218); 
CtxPoint(623, 40);  //1113840812.006 
 
// Window CWI_12 ("Document1 - Microsoft Word") destroyed 1113840812.006 
 
DO_MSLEEP(2204); 
CtxPoint(385, 1);  //1113840815.262 
 
DO_MSLEEP(1046); 
// Window CWI_9 ("Program Manager") destroyed 1113840815.262 
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// Window CWI_7 ("") destroyed 1113840815.262 
 
// Window CWI_13 ("Please wait...") created 1113840815.513 
 
CtxWaitForWindowCreate(CWI_13, 0); 
 
DO_SetTransactionCleanup(); 
 
CtxDisconnect(); 
 
END_TRANSACTION(); 

delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
delete CWI_4; // "Citrix License Warning Notice" 
delete CWI_5; // "Citrix License Warning Notice" 
delete CWI_6; // "UsrLogon.Cmd" 
delete CWI_7; // "" 
delete CWI_8; // "ICA Seamless Host Agent" 
delete CWI_9; // "Program Manager" 
delete CWI_10; // "" 
delete CWI_11; // "" 
delete CWI_12; // "Microsoft Word" 
delete CWI_13; // "Please wait..." 
 
CitrixUninit(); 
 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

 

Sample Two: Modified Citrix Script   

The fol lowing is an example of a Citrix script  modi fied to handle a dynamic window t i t le. In  th is example, 
the Sample Appl icat ion generates a dynamic t i t le. The dynamic name is the name of the appl icat ion 
fol lowed by the t ime the script  is created. The quest ion mark (?) wi ldcard is subst i tuted for a given t ime. 
Changes to the original script  are h ighl ighted in  bold. 

Sample Script 

/* 
 *  dynamicwindow2.cpp 
 * 
 *  Script Converted on April 18, 2005 at 12:13:47 PM 
 *  Generated by Compuware QALoad convert module version 5.5.0 build 256 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
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 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 

#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 
#include "smacro.h" 

#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix"; 
const char *CitrixPassword    = ""; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_8 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_9 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_10 = new CtxWI(0x1008c, "", 115, 0, 405, 457); 
CtxWI *CWI_11 = new CtxWI(0x20068, "", 112, 116, 416, 248); 

// The initial window title of “Sample Application 09:01:23 AM” does not change 
CtxWI *CWI_12 = new CtxWI(0x2006e, "Sample Application 09:01:23 AM", -4, -4, 649, 461); 
CtxWI *CWI_13 = new CtxWI(0x7001c, "Please wait...", 111, 112, 418, 145); 
 
SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("dynamicwindow.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
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CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 
 
CtxConnect(CitrixServer, CitrixOutputMode); 
 
CtxPoint(164, 61);  //1113840775.516 
 
// Window CWI_1 ("Warning !!") created 1113840775.516 
 
CtxWaitForWindowCreate(CWI_1, 1969); 
 
DO_MSLEEP(2046); 
CtxPoint(332, 359);  //1113840777.629 
 
DO_MSLEEP(63); 
CtxClick(CWI_1, 94, L_BUTTON, NONE); //1113840777.723 
 
// Window CWI_2 ("Log On to Windows") created 1113840777.817 
 
CtxWaitForWindowCreate(CWI_2, 93); 
 
DO_MSLEEP(16); 
// Window CWI_1 ("Warning !!") destroyed 1113840777.833 
 
CtxType(CWI_2, "citrix");  //1113840786.615 
 
DO_MSLEEP(8547); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113840786.678 
 
DO_MSLEEP(281); 
CtxType(CWI_2, "citrix");  //1113840788.650 
 
DO_MSLEEP(1672); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113840788.713 
 
DO_MSLEEP(359); 
CtxType(CWI_2, "q");  //1113840789.683 
 
DO_MSLEEP(438); 
 
DO_MSLEEP(1078); 
CtxPoint(231, 325);  //1113840790.309 
 
DO_MSLEEP(78); 
CtxMouseDown(CWI_2, L_BUTTON, NONE, 231, 325);  // 1113840790.309 
 
CtxMouseUp(CWI_2, L_BUTTON, NONE, 232, 325); //1113840790.388 
 
CtxPoint(232, 325);  //1113840790.544 
 
// Window CWI_3 ("Please wait...") created 1113840790.544 
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CtxWaitForWindowCreate(CWI_3, 204); 
 
// Window CWI_2 ("Log On to Windows") destroyed 1113840790.544 
 
// Window CWI_4 ("Citrix License Warning Notice") created 1113840790.591 
 
CtxWaitForWindowCreate(CWI_4, 46); 
 
DO_MSLEEP(16); 
// Window CWI_3 ("Please wait...") destroyed 1113840790.607 
 
// Window CWI_5 ("Citrix License Warning Notice") created 1113840790.654 
 
CtxWaitForWindowCreate(CWI_5, 47); 
 
DO_MSLEEP(16); 
// Window CWI_4 ("Citrix License Warning Notice") destroyed 1113840790.669 
 
// Window CWI_6 ("UsrLogon.Cmd") created 1113840790.716 
 
CtxWaitForWindowCreate(CWI_6, 46); 
 
DO_MSLEEP(16); 
// Window CWI_6 ("UsrLogon.Cmd") destroyed 1113840790.732 
 
// Window CWI_7 ("") created 1113840790.967 
 
DO_MSLEEP(234); 
// Window CWI_8 ("ICA Seamless Host Agent") created 1113840791.014 
 
CtxWaitForWindowCreate(CWI_8, 47); 
 
// Window CWI_9 ("Program Manager") created 1113840791.030 
 
CtxWaitForWindowCreate(CWI_9, 16); 
 
CtxPoint(347, 249);  //1113840793.080 
 
// Window CWI_10 ("") created 1113840793.080 
 
DO_MSLEEP(16); 
 
DO_MSLEEP(1203); 
CtxPoint(571, 256);  //1113840796.133 
 
DO_MSLEEP(1844); 
// Window CWI_10 ("") destroyed 1113840796.133 
 
DO_MSLEEP(1828); 
CtxPoint(446, 208);  //1113840798.309 
 
DO_MSLEEP(344); 
CtxClick(CWI_5, 78, L_BUTTON, NONE); //1113840798.387 
 
DO_MSLEEP(437); 
CtxPoint(311, 303);  //1113840798.935 
 
DO_MSLEEP(110); 
CtxClick(CWI_5, 109, L_BUTTON, NONE); //1113840799.045 
 
DO_MSLEEP(94); 
// Window CWI_5 ("Citrix License Warning Notice") destroyed 1113840799.138 
 
DO_MSLEEP(390); 
CtxPoint(275, 1);  //1113840799.718 
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DO_MSLEEP(188); 
CtxClick(CWI_8, 62, L_BUTTON, NONE); //1113840799.780 
 
DO_MSLEEP(703); 
CtxPoint(200, 187);  //1113840800.579 
 
DO_MSLEEP(94); 
CtxClick(CWI_8, 78, L_BUTTON, NONE); //1113840800.657 
 
DO_MSLEEP(110); 
CtxPoint(209, 192);  //1113840800.766 
 
// Window CWI_8 ("ICA Seamless Host Agent") destroyed 1113840800.766 
 
DO_MSLEEP(5328); 
CtxPoint(115, 175);  //1113840806.245 
 
DO_MSLEEP(140); 
CtxDoubleClick(CWI_9); // 1113840806.621 
 
CtxMouseUp(CWI_7, L_BUTTON, NONE, 114, 174); //1113840806.512 
 
DO_MSLEEP(16); 
CtxPoint(114, 174);  //1113840806.621 
 
DO_MSLEEP(359); 
 
CtxPoint(284, 205);  //1113840807.028 
 
// Window CWI_11 ("") created 1113840807.028 
 
DO_MSLEEP(16); 
CtxPoint(309, 208);  //1113840807.326 
 
// Window CWI_12 ("Microsoft Word") created 1113840807.326 

//////////////////////////////////////////////////////////////////////  
/// The CtxSetWindowMatchTitle command is inserted prior to the  
/// CtxSetWindowMatchTitle call. Note that the window identifier is the  
//  same for both calls, and the “match pattern” for the command is from  
/// Example Two in the Match Pattern Identification section above.  
////////////////////////////////////////////////////////////////////// 

CtxSetWindowMatchTitle(CW1_12, "Sample Application ??:??:?? ?M" ); 
 

/// The window create wait event call does not change. 
CtxWaitForWindowCreate(CWI_12, 266); 
 
DO_MSLEEP(46); 
CWI_12->setTitle("Document1 - Microsoft Word"); //1113840807.388 
 
DO_MSLEEP(16); 
// Window CWI_11 ("") destroyed 1113840807.388 
 
DO_MSLEEP(4188); 
CtxPoint(626, 8);  //1113840811.693 
 
DO_MSLEEP(109); 
CtxClick(CWI_12, 94, L_BUTTON, NONE); //1113840811.787 
 
DO_MSLEEP(218); 
CtxPoint(623, 40);  //1113840812.006 
 
// Window CWI_12 ("Document1 - Microsoft Word") destroyed 1113840812.006 
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DO_MSLEEP(2204); 
CtxPoint(385, 1);  //1113840815.262 
 
DO_MSLEEP(1046); 
// Window CWI_9 ("Program Manager") destroyed 1113840815.262 
 
// Window CWI_7 ("") destroyed 1113840815.262 
 
// Window CWI_13 ("Please wait...") created 1113840815.513 
 
CtxWaitForWindowCreate(CWI_13, 0); 
 
DO_SetTransactionCleanup(); 
 
CtxDisconnect(); 
 
END_TRANSACTION(); 
delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
delete CWI_4; // "Citrix License Warning Notice" 
delete CWI_5; // "Citrix License Warning Notice" 
delete CWI_6; // "UsrLogon.Cmd" 
delete CWI_7; // "" 
delete CWI_8; // "ICA Seamless Host Agent" 
delete CWI_9; // "Program Manager" 
delete CWI_10; // "" 
delete CWI_11; // "" 
delete CWI_12; // "Microsoft Word" 
delete CWI_13; // "Please wait..." 
 
CitrixUninit(); 
 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

 

Handling Intermittent Windows 

M odi fying the Script  for In term i t ten t  Window s 

Windows that don't  appear when a script  is recorded can appear in termit tent ly during replay. One 
example commonly encountered with Citrix is the ICA Seamless Host Agent window.  If an unexpected 
window appears at val idat ion or playback, you must modify the script  to handle the window event.  

To simpli fy the script ing process, record a temporary session and convert  i t  to a script . This should be a 
session where the unexpected window appears so that the user must in teract, for example, with a mouse 
cl ick or keyboard entry, to dismiss the in termittent window. Note the locat ion in  the playback script  where 
the presence of the in termit tent window prevented the script  from cont inuing. This is where code is added 
to the script .   

Do the fol lowing i f a val idat ion or playback session indicates an unexpected window appeared that 
requires user in teract ion:   
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!  Record a temporary script where the unexpected window event appears.  

!  Convert the original session to a script. 

!  Modify the original script with a section of the temporary script. 

To record a t em porary scr ip t : 

Simpli fy  the script ing effort  required by doing the fol lowing: 

1. Record a temporary session of the transact ion. This should include the appearance of the 
in termit tent window and the subsequent user in teract ion that dismisses the window.   

2. Add a comment when the window appears and before the window is dismissed. 

3. Give the successful record session a temporary name.   

4. Click Opt ions>Convert , and cl ick OK to convert  the session to a script . 

To m odi f y t he or ig inal  scr ip t : 

Extract a small  sect ion of the temporary script  code and insert  i t  in to the original script . 

1. Ident i fy the locat ion in  the original script  where the unexpected window appeared.  You can do 
th is by not ing the last window that was successful ly created before val idat ion fai lure.  

Tip: Note the location with a code-style comment. This is the location where you paste in code from the 
temporary script. 

2. Ident i fy the code in the temporary script  that creates the Citrix window object.  This code is in  the 
sect ion labeled /* Citrix Window Information Objects */  and can be ident i fied by the name 
parameter.   

3. Cut and paste th is l ine in to the corresponding sect ion in  the original script .   

4. Modify the l ine pasted in to the original script ,  giving the statement a unique Citrix window 
ident i fier.   

Note: This identifier, CWI_n, must be a unique value in the original script or the script will not compile.   

5. Find the l ine in  the temporary script  that deletes the Citrix window object. This code is after the 
END_TRANSACTION cal l .   

6. Copy th is l ine to the same locat ion in  the original script  and modify i t  with the unique Citrix 
window ident i fier from Step 4. 

7. Add a special version of the CtxSetWindowMatchTit le command in the original script  in  the 
locat ion where the original script  fai led because of the in termit tent window.   

This is where the window must be recognized and dismissed, i f i t  exists. The first  parameter is the 
Citrix window object ident i fier from Step 2. The second parameter is an asterisk enclosed in double 
quotes (“ *” ). This parameter ensures that commands l ike CtxClick work with any matched window, 
even i f the in termit tent window does not exist . 

9. Ident i fy the code that dismisses th is window in the temporary script  by scrol l ing to the comment 
you inserted during capture, and backtracking unt i l  you find the correct WaitForWindowCreate 
statement. Usual ly th is code consists of either a set of CtxPoint and CtxClick or one or more 
keyboard entry cal ls after the window create event.    

Caut ion: Do not include the WaitForWindowCreate statement. 

10. Copy the code from the temporary script  and paste i t  after the CtxSetWindowMatchTit le cal l  added 
in Step 5. Ensure that the Citrix window object parameter for these cal ls is the Citrix window 
object ident i fier from Step 2. 
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Conclusion 

Fol lowing these techniques, you can modify a session to handle the appearance of in termit tent windows 
that require user act ion to dismiss. The sample original script , the sample temporary script , and the sample 
modified script  i l lustrate th is process. 

 

Sam ple: Original  Ci t r i x  Script  for In term i t ten t  Window s 

The fol lowing is an example of an original Citrix script  converted from capture. Points of in terest in  the 
script  are h ighl ighted in  bold. 

Sample Script  
/* 
 *  intermittent_original.cpp 
 * 
 *  Script Converted on April 18, 2005 at 03:23:41 PM 
 *  Generated by Compuware QALoad convert module version 5.5.0 build 256 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 

#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 
#include "smacro.h" 

#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
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{ 
/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix"; 
const char *CitrixPassword    = ""; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_8 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_9 = new CtxWI(0x100b8, "", 115, 0, 405, 457); 
CtxWI *CWI_10 = new CtxWI(0x7001c, "Please wait...", 111, 112, 418, 145); 

/// A line will be copied and modified here to create the new Citrix window object 
 
SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("intermittent_original.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 
 
CtxConnect(CitrixServer, CitrixOutputMode); 
 
// Window CWI_1 ("Warning !!") created 1113852175.329 
 
CtxWaitForWindowCreate(CWI_1, 2047); 
 
DO_MSLEEP(1203); 
CtxPoint(162, 161);  //1113852176.561 
 
DO_MSLEEP(31); 
CtxClick(CWI_1, 79, L_BUTTON, NONE); //1113852176.639 
 
DO_MSLEEP(718); 
CtxPoint(323, 362);  //1113852177.451 
 
DO_MSLEEP(94); 
CtxClick(CWI_1, 63, L_BUTTON, NONE); //1113852177.513 
 
// Window CWI_2 ("Log On to Windows") created 1113852177.638 
 
CtxWaitForWindowCreate(CWI_2, 125); 
 
// Window CWI_1 ("Warning !!") destroyed 1113852177.638 
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CtxType(CWI_2, "citr");  //1113852180.291 
 
DO_MSLEEP(2625); 
CtxType(CWI_2, "ix");  //1113852180.790 
 
 
DO_MSLEEP(343); 
CtxPoint(324, 362);  //1113852180.790 
 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113852180.868 
 
DO_MSLEEP(266); 
CtxType(CWI_2, "citrix");  //1113852182.194 
 
DO_MSLEEP(1078); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113852182.225 
 
DO_MSLEEP(281); 
CtxType(CWI_2, "q");  //1113852183.692 
 
DO_MSLEEP(1078); 
 
DO_MSLEEP(844); 
CtxPoint(263, 324);  //1113852184.176 
 
DO_MSLEEP(31); 
CtxClick(CWI_2, 79, L_BUTTON, NONE); //1113852184.254 
 
DO_MSLEEP(109); 
// Window CWI_2 ("Log On to Windows") destroyed 1113852184.363 
 
// Window CWI_3 ("Please wait...") created 1113852184.394 
 
CtxWaitForWindowCreate(CWI_3, 16); 
 
// Window CWI_4 ("Citrix License Warning Notice") created 1113852184.457 
 
CtxWaitForWindowCreate(CWI_4, 78); 
 
// Window CWI_3 ("Please wait...") destroyed 1113852184.472 
 
// Window CWI_5 ("Citrix License Warning Notice") created 1113852184.566 
 
CtxWaitForWindowCreate(CWI_5, 109); 
 
// Window CWI_6 ("UsrLogon.Cmd") created 1113852184.566 
 
CtxWaitForWindowCreate(CWI_6, 0); 
 
// Window CWI_4 ("Citrix License Warning Notice") destroyed 1113852184.566 
 
DO_MSLEEP(31); 
// Window CWI_6 ("UsrLogon.Cmd") destroyed 1113852184.597 
 
// Window CWI_7 ("") created 1113852184.878 
 
// Window CWI_8 ("Program Manager") created 1113852184.941 
 
CtxWaitForWindowCreate(CWI_8, 0); 
 
CtxPoint(195, 192);  //1113852186.891 
 
// Window CWI_9 ("") created 1113852186.891 
 



QALoad Online Help 

241 

DO_MSLEEP(516); 
CtxPoint(316, 271);  //1113852187.406 
 
CtxMouseDown(CWI_5, L_BUTTON, NONE, 316, 271);  // 1113852187.406 
 
CtxMouseUp(CWI_5, L_BUTTON, NONE, 317, 278); //1113852187.515 
 
DO_MSLEEP(219); 
CtxPoint(317, 287);  //1113852187.671 
 
DO_MSLEEP(46); 
CtxClick(CWI_5, 63, L_BUTTON, NONE); //1113852187.734 
 
DO_MSLEEP(62); 
// Window CWI_5 ("Citrix License Warning Notice") destroyed 1113852187.796 
 

/// Below is the last statement that executed prior to script failure 
/// This is where the code to identify and dismiss the window will be added. 

 
DO_MSLEEP(829); 
CtxPoint(555, 200);  //1113852188.639 
 
DO_MSLEEP(15); 
CtxClick(CWI_9, 94, L_BUTTON, NONE); //1113852188.732 
 
DO_MSLEEP(875); 
CtxPoint(555, 199);  //1113852189.934 
 
DO_MSLEEP(328); 
// Window CWI_9 ("") destroyed 1113852189.934 
 
DO_MSLEEP(19766); 
CtxPoint(337, 157);  //1113852210.000 
 
DO_MSLEEP(328); 
// Window CWI_9 ("Program Manager") destroyed 1113852210.000 
 
// Window CWI_7 ("") destroyed 1113852210.016 
 
// Window CWI_10 ("Please wait...") created 1113852210.266 
 
CtxWaitForWindowCreate(CWI_10, 0); 
 
DO_SetTransactionCleanup(); 
 
CtxDisconnect(); 
 
 
END_TRANSACTION(); 

delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
delete CWI_4; // "Citrix License Warning Notice" 
delete CWI_5; // "Citrix License Warning Notice" 
delete CWI_6; // "UsrLogon.Cmd" 
delete CWI_7; // "" 
delete CWI_8; // "Program Manager" 
delete CWI_9; // "" 
delete CWI_10; // "Please wait..." 

/// A line will be copied here and modified to delete the Citrix window object. 
 
CitrixUninit(); 
 
EXIT(); 
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return(0); 
} 
void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

 

Sam ple: M odi f i ed Ci t r i x  Script  to Handle In term i t ten t  Window   

The fol lowing is an example of a modified Citrix script  to handle an in termit tent window. Changes to 
Original script  are h ighl ighted in  bold. 

Sample Script  

/* 
 *  intermittent_original.cpp 
 * 
 *  Script Converted on April 18, 2005 at 03:23:41 PM 
 *  Generated by Compuware QALoad convert module version 5.5.0 build 256 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 

#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 
#include "smacro.h" 

#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 
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#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix"; 
const char *CitrixPassword    = ""; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_8 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_9 = new CtxWI(0x100b8, "", 115, 0, 405, 457); 
CtxWI *CWI_10 = new CtxWI(0x7001c, "Please wait...", 111, 112, 418, 145); 

/// This line was added from the temporary script and modified so the Citrix window variable 
is unique for the original script. 

CtxWI *CWI_99 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
 
SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("intermittent_original.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 
 
CtxConnect(CitrixServer, CitrixOutputMode); 
 
// Window CWI_1 ("Warning !!") created 1113852175.329 
 
CtxWaitForWindowCreate(CWI_1, 2047); 
 
DO_MSLEEP(1203); 
CtxPoint(162, 161);  //1113852176.561 
 
DO_MSLEEP(31); 
CtxClick(CWI_1, 79, L_BUTTON, NONE); //1113852176.639 
 
DO_MSLEEP(718); 
CtxPoint(323, 362);  //1113852177.451 
 
DO_MSLEEP(94); 
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CtxClick(CWI_1, 63, L_BUTTON, NONE); //1113852177.513 
 
// Window CWI_2 ("Log On to Windows") created 1113852177.638 
 
CtxWaitForWindowCreate(CWI_2, 125); 
 
// Window CWI_1 ("Warning !!") destroyed 1113852177.638 
 
CtxType(CWI_2, "citr");  //1113852180.291 
 
DO_MSLEEP(2625); 
CtxType(CWI_2, "ix");  //1113852180.790 
 
DO_MSLEEP(343); 
CtxPoint(324, 362);  //1113852180.790 
 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113852180.868 
 
DO_MSLEEP(266); 
CtxType(CWI_2, "citrix");  //1113852182.194 
 
DO_MSLEEP(1078); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113852182.225 
 
DO_MSLEEP(281); 
CtxType(CWI_2, "q");  //1113852183.692 
 
DO_MSLEEP(1078); 
 
DO_MSLEEP(844); 
CtxPoint(263, 324);  //1113852184.176 
 
DO_MSLEEP(31); 
CtxClick(CWI_2, 79, L_BUTTON, NONE); //1113852184.254 
 
DO_MSLEEP(109); 
// Window CWI_2 ("Log On to Windows") destroyed 1113852184.363 
 
// Window CWI_3 ("Please wait...") created 1113852184.394 
 
CtxWaitForWindowCreate(CWI_3, 16); 
 
// Window CWI_4 ("Citrix License Warning Notice") created 1113852184.457 
 
CtxWaitForWindowCreate(CWI_4, 78); 
 
// Window CWI_3 ("Please wait...") destroyed 1113852184.472 
 
// Window CWI_5 ("Citrix License Warning Notice") created 1113852184.566 
 
CtxWaitForWindowCreate(CWI_5, 109); 
 
// Window CWI_6 ("UsrLogon.Cmd") created 1113852184.566 
 
CtxWaitForWindowCreate(CWI_6, 0); 
 
// Window CWI_4 ("Citrix License Warning Notice") destroyed 1113852184.566 
 
DO_MSLEEP(31); 
// Window CWI_6 ("UsrLogon.Cmd") destroyed 1113852184.597 
 
// Window CWI_7 ("") created 1113852184.878 
 
DO_MSLEEP(282); 
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// Window CWI_9 ("Program Manager") created 1113852184.941 
 
CtxWaitForWindowCreate(CWI_8, 0); 
 
CtxPoint(195, 192);  //1113852186.891 
 
// Window CWI_10 ("") created 1113852186.891 
 
DO_MSLEEP(516); 
CtxPoint(316, 271);  //1113852187.406 
 
CtxMouseDown(CWI_5, L_BUTTON, NONE, 316, 271);  // 1113852187.406 
 
CtxMouseUp(CWI_5, L_BUTTON, NONE, 317, 278); //1113852187.515 
 
DO_MSLEEP(219); 
CtxPoint(317, 287);  //1113852187.671 
 
DO_MSLEEP(46); 
CtxClick(CWI_5, 63, L_BUTTON, NONE); //1113852187.734 
 
DO_MSLEEP(62); 
// Window CWI_5 ("Citrix License Warning Notice") destroyed 1113852187.796 
 

/// This is the location where the code to set the intermittent 
/// window match name is added. 

CtxSetWindowMatchTitle( CWI_99, “*” ); 
/// The location where the code to dismiss the code was copied from  
/// the temporary script.  The parameter for the CtxClick command  
/// was corrected with the Citrix window object variable. 

DO_MSLEEP(14000); 
CtxPoint(178, 194);  //1113851799.788 
 
DO_MSLEEP(47); 
CtxClick(CWI_8, 63, L_BUTTON, NONE); //1113851799.866 
 
DO_MSLEEP(829); 
CtxPoint(555, 200);  //1113852188.639 
 
DO_MSLEEP(15); 
CtxClick(CWI_9, 94, L_BUTTON, NONE); //1113852188.732 
 
DO_MSLEEP(875); 
CtxPoint(555, 199);  //1113852189.934 
 
DO_MSLEEP(328); 
// Window CWI_10 ("") destroyed 1113852189.934 
 
DO_MSLEEP(19766); 
CtxPoint(337, 157);  //1113852210.000 
 
DO_MSLEEP(328); 
// Window CWI_9 ("Program Manager") destroyed 1113852210.000 
 
// Window CWI_7 ("") destroyed 1113852210.016 
 
// Window CWI_11 ("Please wait...") created 1113852210.266 
 
CtxWaitForWindowCreate(CWI_10, 0); 
 
DO_SetTransactionCleanup(); 
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CtxDisconnect(); 
 
END_TRANSACTION(); 

delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
delete CWI_4; // "Citrix License Warning Notice" 
delete CWI_5; // "Citrix License Warning Notice" 
delete CWI_6; // "UsrLogon.Cmd" 
delete CWI_7; // "" 
delete CWI_8; // "ICA Seamless Host Agent" 
delete CWI_9; // "Program Manager" 
delete CWI_10; // "" 
delete CWI_11; // "Please wait..." 

/// The code copied and modified to delete the Citrix window object. 
delete CWI_99; 
 
CitrixUninit(); 
 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

 

Sam ple: Tem porary Ci t r i x  Script  w i th  Window  Creat ion  and Dism issal  

The fol lowing is an example of a temporary Citrix script  with window creat ion and dismissal. Code to be 
ident i fied and copied from the temporary script  is h ighl ighted in  bold. 

Sample Script  

/* 
 *  intermittent_temporary.cpp 
 * 
 *  Script Converted on April 18, 2005 at 03:16:57 PM 
 *  Generated by Compuware QALoad convert module version 5.5.0 build 256 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
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 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 

#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 
#include "smacro.h" 

#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix"; 
const char *CitrixPassword    = ""; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 

/// The code line to copy to the original script.  
CtxWI *CWI_8 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_9 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_10 = new CtxWI(0x10084, "", 115, 0, 405, 457); 
 
SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("intermittent_temporary.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 
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DO_SetTransactionStart(); 
 
CtxConnect(CitrixServer, CitrixOutputMode); 
 
CtxPoint(120, 159);  //1113851768.564 
 
// Window CWI_1 ("Warning !!") created 1113851768.564 
 
CtxWaitForWindowCreate(CWI_1, 2063); 
 
DO_MSLEEP(766); 
CtxPoint(313, 361);  //1113851769.344 
 
DO_MSLEEP(31); 
CtxClick(CWI_1, 62, L_BUTTON, NONE); //1113851769.407 
 
// Window CWI_2 ("Log On to Windows") created 1113851769.454 
 
CtxWaitForWindowCreate(CWI_2, 47); 
 
// Window CWI_1 ("Warning !!") destroyed 1113851769.454 
 
CtxType(CWI_2, "citrix");  //1113851774.556 
 
DO_MSLEEP(4891); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113851774.618 
 
DO_MSLEEP(281); 
CtxType(CWI_2, "citrix");  //1113851776.460 
 
DO_MSLEEP(1594); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113851776.522 
 
DO_MSLEEP(312); 
CtxType(CWI_2, "q");  //1113851779.627 
 
DO_MSLEEP(2469); 
 
DO_MSLEEP(953); 
CtxPoint(231, 322);  //1113851780.017 
 
DO_MSLEEP(78); 
CtxMouseDown(CWI_2, L_BUTTON, NONE, 231, 322);  // 1113851780.017 
 
CtxMouseUp(CWI_2, L_BUTTON, NONE, 231, 321); //1113851780.080 
 
DO_MSLEEP(16); 
CtxPoint(231, 321);  //1113851780.127 
 
DO_MSLEEP(94); 
// Window CWI_2 ("Log On to Windows") destroyed 1113851780.127 
 
// Window CWI_3 ("Please wait...") created 1113851780.236 
 
CtxWaitForWindowCreate(CWI_3, 109); 
 
// Window CWI_4 ("Citrix License Warning Notice") created 1113851780.298 
 
CtxWaitForWindowCreate(CWI_4, 63); 
 
// Window CWI_3 ("Please wait...") destroyed 1113851780.298 
 
// Window CWI_5 ("Citrix License Warning Notice") created 1113851780.314 
 
CtxWaitForWindowCreate(CWI_5, 15); 
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// Window CWI_6 ("UsrLogon.Cmd") created 1113851780.330 
 
CtxWaitForWindowCreate(CWI_6, 16); 
 
// Window CWI_4 ("Citrix License Warning Notice") destroyed 1113851780.330 
 
DO_MSLEEP(78); 
// Window CWI_6 ("UsrLogon.Cmd") destroyed 1113851780.408 
 
// Window CWI_7 ("") created 1113851780.766 
 
DO_MSLEEP(344); 
// Window CWI_8 ("ICA Seamless Host Agent") created 1113851780.766 
 
CtxWaitForWindowCreate(CWI_8, 15); 
 
// Window CWI_9 ("Program Manager") created 1113851780.766 
 
CtxWaitForWindowCreate(CWI_9, 0); 
 
DO_MSLEEP(891); 
CtxPoint(333, 300);  //1113851781.718 
 
DO_MSLEEP(62); 
CtxClick(CWI_5, 141, L_BUTTON, NONE); //1113851781.859 
 
DO_MSLEEP(156); 
CtxPoint(261, 250);  //1113851782.186 
 
DO_MSLEEP(172); 
// Window CWI_5 ("Citrix License Warning Notice") destroyed 1113851782.186 
 
CtxPoint(303, 251);  //1113851782.811 
 
// Window CWI_10 ("") created 1113851782.811 
 
DO_MSLEEP(625); 
 
DO_MSLEEP(2078); 
CtxPoint(518, 254);  //1113851785.760 
 
DO_MSLEEP(875); 
// Window CWI_10 ("") destroyed 1113851785.760 

/// The following code dismisses the “ICA Seamless Host Agent”.   
/// Copy the bold section below to the original script. 
/// The DO_MSLEEP comments can also be copied. 

 
DO_MSLEEP(14000); 
CtxPoint(178, 194);  //1113851799.788 
 
DO_MSLEEP(47); 
CtxClick(CWI_8, 63, L_BUTTON, NONE); //1113851799.866 
 

/// End of code section to copy. 

DO_MSLEEP(125); 
CtxPoint(183, 197);  //1113851799.975 
 
// Window CWI_8 ("ICA Seamless Host Agent") destroyed 1113851799.975 
 
DO_MSLEEP(1250); 
CtxPoint(609, 12);  //1113851804.469 
 
DO_MSLEEP(3250); 



QALoad 5.5  

250 

// Window CWI_9 ("Program Manager") destroyed 1113851804.469 
 
// Window CWI_7 ("") destroyed 1113851804.469 
 
DO_SetTransactionCleanup(); 
 
CtxDisconnect(); 
 
END_TRANSACTION(); 

delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
delete CWI_4; // "Citrix License Warning Notice" 
delete CWI_5; // "Citrix License Warning Notice" 
delete CWI_6; // "UsrLogon.Cmd" 
delete CWI_7; // "" 

/// Copy this code to the original script to delete the Citrix window object. 
delete CWI_8; // "ICA Seamless Host Agent" 
delete CWI_9; // "Program Manager" 
delete CWI_10; // "" 
 
CitrixUninit(); 
 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

 

Handling Unexpected Events 

M odi fying the Script  to Handle Unexpected Even ts 

Unexpected Citrix events that were not recorded in the original script  can occur during a playback session . 
These can include Intermit tent Windows or appl icat ion windows that may appear based on the user’s 
session state. For example, the calculator appl icat ion may already be present when the Citrix user logs on a 
session, or the user may need to invoke the appl icat ion.  

When there is the possibi l i ty of unexpected events occurring, you must modi fy the script  to respond to the 
changes and cont inue the load test. Use the CtxWindowEventExists funct ion to create a condit ional block 
of code that handles the unexpected dialogs.   

When you modify a script  to handle unexpected events, you must: 

!  Perform an initial validation of the script. 

!  Record a temporary script to capture the unexpected event. 

!  Modify the original script to include and handle the unexpected event. 

!  Re-validate the script. 

Note: You may need to configure the workbench and player for validation. 

To per f orm  an in i t ial  val idat ion: 
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1. Click Session>Validate to validate the script. This is when an unexpected event can cause sporadic failure during 
validation or playback.  

2. Identify the sporadic event visually so that you can recognize it in a later record session. 

To record a t em porary scr ip t : 

1. Click Options>Record to record a second script that recreates the unexpected event.  Successive sessions should 
be recorded until the unexpected event occurs.  

2. Insert  comments at two points:  

 Where the event is fi rst  recognized. 

 Where the event is acted on and the Citrix session state and any window states have 
returned to the state before the event occurred.  

Note: You may need to position the mouse over a window or control, such as a button, before inserting 
the second comment. (See Scripting Mouse Events.)  

3. Give this capture a name to denote this session’s temporary status. 

4. Click Options>Convert, then click OK to convert the session to a script. 

To m odi f y t he or ig inal  scr ip t  w i t h code f rom  t he t em porary scr ipt : 

Follow these steps to insert  script  code from the temporary script  that handles the unexpected event.  

1. Insert a code comment in the original script where the unexpected event occurred. 

2. Copy the code between the two comments in the temporary script and paste it into the original script at the location 
of the unexpected event you identified.  

Note: Comments ensure that the pasted code is clearly marked in the script.   

3. Identify any Citrix window objects that exist in API calls in the pasted code snippet. For each object, do one of the 
following: 

 If the window object is whol ly contained, both created and destroyed, in  the pasted code 
snippet: 

a. Identify the Citrix window creation and deletion lines of code in the temporary script.   

b. Copy these lines to the original script. This is the creation line in the /* Citrix Window Information Objects */ 
section and the deletion line after the END_TRANSACTION call.   

c. Give the Citrix window object variable a unique variable name.   

d. Change all variable references to the Citrix window in the pasted code snippet API calls to the new variable 
name. 

 If the window object referenced in a pasted API cal l  is an act ion on an exist ing window object 
in  the original script , modify al l  API cal ls in  the pasted cal ls to refer to the variable name of the 
Citrix window object in  the original script . 

4. Before the code snippet, add a conditional check to see if the unexpected window event has occurred. Use the 
CtxWindowEventExists API call in an If conditional, where if the result is TRUE, a block of code is executed. Then 
add a BeginBlock on the next line. BeginBlock is logically identical to the C begin brace “{“. 

5. After the code snippet, add an EndBlock. EndBlock is logically identical to the C end brace “}“. 

Note: If there is code in the original script that should not be executed if the condition is TRUE, 
 put this code in an Else block within the BeginBlock and EndBlock calls. 

To re-val idat e t he scr ipt : 

1. Click Session>Compile to compile the script after making scripting changes. 
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2.  Click Session>Validate Script to validate the script.  Make sure that validation succeeds when the unexpected 
event occurs and when the event does not occur. 

Conclusion 

Fol lowing these techniques, you can modify scripts to handle unexpected events that occur during 
playback.  Script ing around unexpected events al lows you to perform load test ing for complex user 
scenarios. The sample original script  and sample modified script  i l lustrate th is process. 

 

Sam ple: Original  Ci t r i x  Scripts for Unexpected Even ts 

The fol lowing sample shows two examples of an unexpected Citrix event. In  the first  example, the 
calculator appl icat ion must be started in  the original script .  The second example has a session where the 
calculator appl icat ion is already present when the user logs on.  Points of in terest in  the script  are 
h ighl ighted in  bold.  

Example 1: Original Record Script with No Calculator Appl icat ion Present at Logon 
/* 
 *  CalculatorCreateNew.cpp 
 * 
 *  Script Converted on May 17, 2004 at 12:33:36 PM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 33 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Window Verification             : Yes 
 *   Session Timeouts                : Yes 
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *   Include Wait Points             : Yes 
 *   Enable Counters                 : No 
 *   Include Unnamed Windows         : Yes 
 *   Output Mode                     : Normal 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 */ 
#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000205UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_citrix.h" 
/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 
#ifndef NULL 
#define NULL  0 
#endif 
extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 
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/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix2"; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001a, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001a, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x3002e, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x40030, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_5 = new CtxWI(0x3002c, "", 0, 0, 641, 481); 
CtxWI *CWI_6 = new CtxWI(0x20026, "", -2, 452, 645, 31); 
CtxWI *CWI_7 = new CtxWI(0x10052, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_8 = new CtxWI(0x10048, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_9 = new CtxWI(0x10084, "", 115, 0, 405, 457); 
CtxWI *CWI_10 = new CtxWI(0x20058, "Calculator", 44, 44, 261, 255); 
CtxWI *CWI_11 = new CtxWI(0x5002e, "Please wait...", 111, 112, 418, 145); 
 
SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("CalculatorCreateNew.cpp"); 
CitrixInit(1); 
/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 
BEGIN_TRANSACTION(); 
CtxConnect(CitrixServer, CitrixOutputMode); 
 
DO_MSLEEP(1172); 
CtxPoint(172, 214); 
 
DO_MSLEEP(250); 
// Window CWI_1 ("Warning !!") created 1084811574.696 
 
CtxWaitForWindowCreate(CWI_1); 
 
DO_MSLEEP(906); 
CtxPoint(308, 359); 
 
DO_MSLEEP(156); 
CtxClick(CWI_1, 78, L_BUTTON, NONE); 
 
DO_MSLEEP(63); 
// Window CWI_2 ("Log On to Windows") created 1084811575.899 
 
CtxWaitForWindowCreate(CWI_2); 
 
// Window CWI_1 ("Warning !!") destroyed 1084811575.899 
 
Type(CWI_2, "citrix"); 
 
DO_MSLEEP(2547); 
TypeVK(CWI_2, VK_TAB, NONE); 
 
DO_MSLEEP(328); 
Type(CWI_2, "citrix"); 
 
DO_MSLEEP(3015); 
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TypeVK(CWI_2, VK_TAB, NONE); 
 
DO_MSLEEP(282); 
Type(CWI_2, "q"); 
 
DO_MSLEEP(703); 
 
DO_MSLEEP(1343); 
CtxPoint(247, 322); 
 
DO_MSLEEP(110); 
CtxClick(CWI_2, 62, L_BUTTON, NONE); 
 
DO_MSLEEP(391); 
// Window CWI_2 ("Log On to Windows") destroyed 1084811584.685 
 
DO_MSLEEP(16); 
// Window CWI_3 ("Please wait...") created 1084811584.701 
 
CtxWaitForWindowCreate(CWI_3); 
 
DO_MSLEEP(156); 
// Window CWI_3 ("Please wait...") destroyed 1084811584.857 
 
DO_MSLEEP(156); 
// Window CWI_4 ("UsrLogon.Cmd") created 1084811585.013 
 
CtxWaitForWindowCreate(CWI_4); 
 
DO_MSLEEP(63); 
CtxPoint(259, 322); 
 
// Window CWI_4 ("UsrLogon.Cmd") destroyed 1084811585.076 
 
DO_MSLEEP(187); 
CtxPoint(449, 462); 
 
DO_MSLEEP(63); 
// Window CWI_5 ("") created 1084811585.326 
 
DO_MSLEEP(93); 
// Window CWI_5 ("") destroyed 1084811585.420 
 
DO_MSLEEP(16); 
// Window CWI_6 ("") created 1084811585.436 
 
DO_MSLEEP(219); 
// Window CWI_7 ("ICA Seamless Host Agent") created 1084811585.654 
 
CtxWaitForWindowCreate(CWI_7); 
 
DO_MSLEEP(15); 
// Window CWI_8 ("Program Manager") created 1084811585.670 
 
CtxWaitForWindowCreate(CWI_8); 
 
DO_MSLEEP(641); 
CtxPoint(135, 347); 
 
DO_MSLEEP(3359); 
// Window CWI_9 ("") created 1084811589.672 
 
DO_MSLEEP(3032); 
CtxPoint(192, 216); 
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// Window CWI_9 ("") destroyed 1084811592.705 
 
DO_MSLEEP(921); 
CtxPoint(190, 199); 
 
DO_MSLEEP(63); 
CtxClick(CWI_6, 78, L_BUTTON, NONE); 
 
DO_MSLEEP(16); 
// Window CWI_7 ("ICA Seamless Host Agent") destroyed 1084811593.784 

 
/// These methods are, by placement in the script prior to the creation  
/// of the calculator window, deduced to be the actions that result in the 
/// creation of the Calculator application window. Paying attention to actions 
/// performed while recording makes this task easier. 

DO_MSLEEP(3843); 
CtxPoint(112, 98); 
 
DO_MSLEEP(282); 
CtxDoubleClick(CWI_8); 
 
DO_MSLEEP(110); 
 
DO_MSLEEP(140); 
// Window CWI_10 ("Calculator") created 1084811598.255 

 
/// Scripting Step 1: 
/// The calculator window is created at this point  
/// Working backward, we deduce that the CtxPoint and  
/// CtxDoubleClick API calls created this window. 

CtxWaitForWindowCreate(CWI_10); 
 
DO_MSLEEP(2672); 
CtxPoint(295, 48); 
 
DO_MSLEEP(672); 
CtxClick(CWI_10, 94, L_BUTTON, NONE); 
 
// Window CWI_10 ("Calculator") destroyed 1084811601.694 
 
DO_MSLEEP(1125); 
CtxPoint(256, 95); 
 
DO_MSLEEP(281); 
// Window CWI_8 ("Program Manager") destroyed 1084811603.101 
 
// Window CWI_6 ("") destroyed 1084811603.101 
 
// Window CWI_11 ("Please wait...") created 1084811603.601 
 
CtxWaitForWindowCreate(CWI_11); 
 
CtxDisconnect(); 
 
END_TRANSACTION(); 
delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
delete CWI_4; // "UsrLogon.Cmd" 
delete CWI_5; // "" 
delete CWI_6; // "" 
delete CWI_7; // "ICA Seamless Host Agent" 
delete CWI_8; // "Program Manager" 
delete CWI_9; // "" 
delete CWI_10; // "Calculator" 
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delete CWI_11; // "Please wait..." 
 
CitrixUninit(); 
 
REPORT(SUCCESS); 
EXIT(); 
return(0); 
} 

void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

Example 2: Original Record Script with Calculator Appl icat ion Present at Logon 
Points of interest in the script are highlighted in bold. 
/* 
 *  CalculatorUseExisting.cpp 
 * 
 *  Script Converted on May 17, 2004 at 12:35:29 PM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 33 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Window Verification             : Yes 
 *   Session Timeouts                : Yes 
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *   Include Wait Points             : Yes 
 *   Enable Counters                 : No 
 *   Include Unnamed Windows         : Yes 
 *   Output Mode                     : Normal 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 */ 
#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000205UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_citrix.h" 
/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 
#ifndef NULL 
#define NULL  0 
#endif 
extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 



QALoad Online Help 

257 

const char *CitrixServer      = "qaccitrix2"; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x20026, "", -2, 740, 1029, 31); 
CtxWI *CWI_4 = new CtxWI(0x10136, "Calculator", 154, 154, 261, 253); 
CtxWI *CWI_5 = new CtxWI(0x10048, "Program Manager", 0, 0, 1025, 769); 
CtxWI *CWI_6 = new CtxWI(0x2017c, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_7 = new CtxWI(0x5002e, "Please wait...", 303, 208, 418, 145); 
 
SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("CalculatorUseExisting.cpp"); 
CitrixInit(1); 
/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 
BEGIN_TRANSACTION(); 
CtxConnect(CitrixServer, CitrixOutputMode); 
 
DO_MSLEEP(625); 
CtxPoint(130, 78); 
 
DO_MSLEEP(797); 
// Window CWI_1 ("Warning !!") created 1084811688.065 
 
CtxWaitForWindowCreate(CWI_1); 
 
DO_MSLEEP(1813); 
CtxPoint(309, 365); 
 
DO_MSLEEP(203); 
CtxClick(CWI_1, 140, L_BUTTON, NONE); 
 
DO_MSLEEP(63); 
// Window CWI_2 ("Log On to Windows") created 1084811690.285 
 
CtxWaitForWindowCreate(CWI_2); 
 
DO_MSLEEP(15); 
// Window CWI_1 ("Warning !!") destroyed 1084811690.300 
 
CtxType(CWI_2, "citrix"); 
 
DO_MSLEEP(2375); 
CtxPoint(309, 364); 
 
CtxTypeVK(CWI_2, VK_TAB, NONE); 
 
DO_MSLEEP(813); 
CtxType(CWI_2, "citrix"); 
 
DO_MSLEEP(1844); 
CtxTypeVK(CWI_2, VK_TAB, NONE); 
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DO_MSLEEP(328); 
CtxType(CWI_2, "q"); 
 
DO_MSLEEP(672); 
 
DO_MSLEEP(1281); 
CtxPoint(241, 317); 
 
DO_MSLEEP(125); 
CtxClick(CWI_2, 141, L_BUTTON, NONE); 
 
DO_MSLEEP(406); 
// Window CWI_2 ("Log On to Windows") destroyed 1084811698.289 
 
DO_MSLEEP(828); 
CtxPoint(514, 358); 
 
DO_MSLEEP(125); 
// Window CWI_3 ("") created 1084811699.258 
 
DO_MSLEEP(16); 
// Window CWI_4 ("Calculator") created 1084811699.258 

 
/// The following comment inserted during record indicates that the 
/// calculator window has appeared in the script.   
/// Since it happens before any events after the Logon window 
/// was destroyed, we know that in this session, we will not have to  
/// start the calculator application – it is already present!  

/* 
The calculator has been created at this point in the modified script! 
*/ 

/// Scripting Step 2:  
/// The code in bold is cut and pasted into the original script 

CtxWaitForWindowCreate(CWI_4); 
 
// Window CWI_5 ("Program Manager") created 1084811699.258 
 
CtxWaitForWindowCreate(CWI_5); 
 
DO_MSLEEP(640); 
// Window CWI_6 ("ICA Seamless Host Agent") created 1084811699.899 
 
CtxWaitForWindowCreate(CWI_6); 
 
DO_MSLEEP(1672); 
CtxPoint(200, 195); 
 
DO_MSLEEP(234); 
CtxClick(CWI_6, 141, L_BUTTON, NONE); 
 
DO_MSLEEP(16); 
// Window CWI_6 ("ICA Seamless Host Agent") destroyed 1084811701.962 
 
DO_MSLEEP(672); 
CtxPoint(200, 205); 
 
DO_MSLEEP(125); 
CtxClick(CWI_3, 109, L_BUTTON, NONE); 
 
DO_MSLEEP(719); 
CtxPoint(275, 316); 
 
DO_MSLEEP(31); 
CtxMouseDown(CWI_4, L_BUTTON, NONE, 275, 316); 
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CtxMouseUp(CWI_4, L_BUTTON, NONE, 274, 316); 
 
DO_MSLEEP(812); 
CtxPoint(349, 376); 
 
DO_MSLEEP(172); 
CtxClick(CWI_4, 110, L_BUTTON, NONE); 
 
DO_MSLEEP(1297); 
CtxPoint(259, 313); 
 
DO_MSLEEP(46); 
CtxClick(CWI_4, 79, L_BUTTON, NONE); 
 
DO_MSLEEP(843); 
CtxPoint(387, 374); 
 
CtxMouseDown(CWI_4, L_BUTTON, NONE, 387, 374); 
 
CtxMouseUp(CWI_4, L_BUTTON, NONE, 387, 375); 
 
DO_MSLEEP(3782); 
CtxPoint(397, 160); 
 
DO_MSLEEP(1140); 
CtxClick(CWI_4, 125, L_BUTTON, NONE); 
 
DO_MSLEEP(16); 
// Window CWI_4 ("Calculator") destroyed 1084811712.045 

/// Scripting Step 2: 
/// This is the end of the code snippet that will be cut and pasted into the  
/// original script. 
/// The following comment inserted during record indicates that the 
/// calculator window has been destroyed.   
/// Since it happens before any events after the Logon window 
/// was destroyed, we know that in this session, we will not have to  
/// start the calculator application – it is already present!  

/* 
The calculator has been destroyed at this point in the modified script! 
*/ 
DO_MSLEEP(1469); 
CtxPoint(235, 85); 
 
DO_MSLEEP(343); 
// Window CWI_5 ("Program Manager") destroyed 1084811713.858 
 
// Window CWI_3 ("") destroyed 1084811713.858 
 
// Window CWI_7 ("Please wait...") created 1084811714.359 
 
CtxWaitForWindowCreate(CWI_7); 
 
CtxDisconnect(); 
 
END_TRANSACTION(); 
delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "" 
delete CWI_4; // "Calculator" 
delete CWI_5; // "Program Manager" 
delete CWI_6; // "ICA Seamless Host Agent" 
delete CWI_7; // "Please wait..." 
 
CitrixUninit(); 
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REPORT(SUCCESS); 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

 

Sam ple: M odi f i ed Ci t r i x  Script  for Handl ing Unexpected Even ts 

The fol lowing sample shows a Citrix script  that is modified to address whether the calculator appl icat ion is 
present is present at logon. Changes to Original script  are h ighl ighted in  bold. 

Sample Script  
/* 
 *  CalculatorUseExisting.cpp 
 * 
 *  Script Converted on May 17, 2004 at 12:35:29 PM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 33 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Window Verification             : Yes 
 *   Session Timeouts                : Yes 
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *   Include Wait Points             : Yes 
 *   Enable Counters                 : No 
 *   Include Unnamed Windows         : Yes 
 *   Output Mode                     : Normal 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 */ 
#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000205UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_citrix.h" 
/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 
#ifndef NULL 
#define NULL  0 
#endif 
extern "C" int rhobot_script(PLAYER_INFO *s_info) 
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{ 
/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix2"; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x20026, "", -2, 740, 1029, 31); 
CtxWI *CWI_4 = new CtxWI(0x10136, "Calculator", 154, 154, 261, 253); 
CtxWI *CWI_5 = new CtxWI(0x10048, "Program Manager", 0, 0, 1025, 769); 
CtxWI *CWI_6 = new CtxWI(0x2017c, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_7 = new CtxWI(0x5002e, "Please wait...", 303, 208, 418, 145); 
 
SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("CalculatorUseExisting.cpp"); 
CitrixInit(1); 
/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 
BEGIN_TRANSACTION(); 
CtxConnect(CitrixServer, CitrixOutputMode); 
 
DO_MSLEEP(625); 
CtxPoint(130, 78); 
 
DO_MSLEEP(797); 
// Window CWI_1 ("Warning !!") created 1084811688.065 
 
CtxWaitForWindowCreate(CWI_1); 
 
DO_MSLEEP(1813); 
CtxPoint(309, 365); 
 
DO_MSLEEP(203); 
CtxClick(CWI_1, 140, L_BUTTON, NONE); 
 
DO_MSLEEP(63); 
// Window CWI_2 ("Log On to Windows") created 1084811690.285 
 
CtxWaitForWindowCreate(CWI_2); 
 
DO_MSLEEP(15); 
// Window CWI_1 ("Warning !!") destroyed 1084811690.300 
 
CtxType(CWI_2, "citrix"); 
 
DO_MSLEEP(2375); 
CtxPoint(309, 364); 
 
CtxTypeVK(CWI_2, VK_TAB, NONE); 
 
DO_MSLEEP(813); 
CtxType(CWI_2, "citrix"); 
 
DO_MSLEEP(1844); 
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CtxTypeVK(CWI_2, VK_TAB, NONE); 
 
DO_MSLEEP(328); 
CtxType(CWI_2, "q"); 
 
DO_MSLEEP(672); 
 
DO_MSLEEP(1281); 
CtxPoint(241, 317); 
 
DO_MSLEEP(125); 
CtxClick(CWI_2, 141, L_BUTTON, NONE); 
 
DO_MSLEEP(406); 
// Window CWI_2 ("Log On to Windows") destroyed 1084811698.289 
 
DO_MSLEEP(828); 
CtxPoint(514, 358); 
 
DO_MSLEEP(125); 
// Window CWI_3 ("") created 1084811699.258 
 
DO_MSLEEP(16); 
// Window CWI_4 ("Calculator") created 1084811699.258 

 
/// Here is where we can determine that either the Calculator application  
/// exists in this session or it needs to be created.    

/// Scripting Step  
if(CtxWindowEventExists("WindowCreate", 4000, "Calculator", ""))  

/// If the window exists, the block below will be  
/// executed. 

 BeginBlock();  

/// Scripting Step 2: 
/// The following code was cut and pasted from the second script.  

/// Scripting Step 3:  
/// All Citrix window object name references have been reconciled with the 
/// correct Citrix window object definition. 
 

CtxWaitForWindowCreate(CWI_4); 
 
// Window CWI_5 ("Program Manager") created 1084811699.258 
 
CtxWaitForWindowCreate(CWI_5); 
 
DO_MSLEEP(640); 
// Window CWI_6 ("ICA Seamless Host Agent") created 1084811699.899 
 
WaitForWindowCreate(CWI_6); 
 
DO_MSLEEP(1672); 
CtxPoint(200, 195); 
 
DO_MSLEEP(234); 
CtxClick(CWI_6, 141, L_BUTTON, NONE); 
 
DO_MSLEEP(16); 
// Window CWI_6 ("ICA Seamless Host Agent") destroyed 1084811701.962 
 
DO_MSLEEP(672); 
CtxPoint(200, 205); 
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DO_MSLEEP(125); 
CtxClick(CWI_3, 109, L_BUTTON, NONE); 
 
DO_MSLEEP(719); 
CtxPoint(275, 316); 
 
DO_MSLEEP(31); 
CtxMouseDown(CWI_4, L_BUTTON, NONE, 275, 316); 
 
CtxMouseUp(CWI_4, L_BUTTON, NONE, 274, 316); 
 
DO_MSLEEP(812); 
CtxPoint(349, 376); 
 
DO_MSLEEP(172); 
CtxClick(CWI_4, 110, L_BUTTON, NONE); 
 
DO_MSLEEP(1297); 
CtxPoint(259, 313); 
 
DO_MSLEEP(46); 
CtxClick(CWI_4, 79, L_BUTTON, NONE); 
 
DO_MSLEEP(843); 
CtxPoint(387, 374); 
 
CtxMouseDown(CWI_4, L_BUTTON, NONE, 387, 374); 
 
CtxMouseUp(CWI_4, L_BUTTON, NONE, 387, 375); 
 
DO_MSLEEP(3782); 
CtxPoint(397, 160); 
 
DO_MSLEEP(1140); 
CtxClick(CWI_4, 125, L_BUTTON, NONE); 

/// Scripting Step 5: 
/// Here is the end of the code snippet, so an EndBlock goes here. 

EndBlock() 

/// Scripting Step 6: 
/// The original behavior has been put into the else 
/// section of the if conditional between BeginBlock 
/// and EndBlock commands. 

else  
BeginBlock(); 

DO_MSLEEP(1672); 
CtxPoint(200, 195); 
 
DO_MSLEEP(234); 
CtxClick(CWI_6, 141, L_BUTTON, NONE); 

DO_MSLEEP(3843); 
CtxPoint(112, 98); 
 
DO_MSLEEP(282); 
CtxDoubleClick(CWI_5); 

CtxWaitForWindowCreate(CWI_4); 
 
DO_MSLEEP(2672); 
CtxPoint(295, 48); 
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DO_MSLEEP(672); 
CtxClick(CWI_4, 94, L_BUTTON, NONE); 

 
EndBlock();  

 
DO_MSLEEP(16); 
// Window CWI_4 ("Calculator") destroyed 1084811712.045 
 
DO_MSLEEP(1469); 
CtxPoint(235, 85); 
 
DO_MSLEEP(343); 
// Window CWI_5 ("Program Manager") destroyed 1084811713.858 
 
// Window CWI_3 ("") destroyed 1084811713.858 
 
// Window CWI_7 ("Please wait...") created 1084811714.359 
 
//CtxWaitForWindowCreate(CWI_7); 
 
CtxDisconnect(); 
 
END_TRANSACTION(); 

delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "" 
delete CWI_4; // "Calculator" 
delete CWI_5; // "Program Manager" 
delete CWI_6; // "ICA Seamless Host Agent" 
delete CWI_7; // "Please wait..." 
 
CitrixUninit(); 
 
REPORT(SUCCESS); 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

 

Moving Citrix Connect and Disconnect Actions 

M odi fying the Script  to M ove Connect  and Disconnect  Outside the Transact ion  Loop 

Load test ing for Citrix may require you to create extended logon sessions, in  which the user remains 
connected to the Citrix server between transact ions. When th is is necessary, you can move the connect 
and disconnect act ions outside the transact ion loop so that the script  does not  logon and off with each 
i terat ion through the loop.  

To modify the script , you must: 

!  Modify the recording process to prepare for moving the connect and disconnect actions. 

!  Modify the script. 
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To m odi f y t he recording process: 

Prepare for moving the connect and disconnect act ions outside the transact ion loop by performing the 
fol lowing steps during recording: 

1. Insert  a comment, such as “ Logged in to Citrix”  , after the Citrix logon but before any windows are 
opened or any appl icat ions are started. 

2. Ensure that al l  appl icat ion windows are closed before disconnect ing from the Citrix session. 

3. Insert  a comment, such as “ Ready to log off Citrix” , before the Citrix logoff sequence is in i t iated. 
You must place the second comment after al l  appl icat ions have been closed but before the user logs 
off. 

To m odi f y t he scr ipt : 

1. Comment out the BEGIN_TRANSACTION and END_TRANSACTION cal ls.  

2. Add new BEGIN_TRANSACTION and END_TRANSACTION cal ls where the comments were placed 
in Step 1 and Step 3 in  the recording process described above.  

3. Comment out the DO_SetTransact ionStart  and DO_SetTransact ionCleanup cal ls. 

Note: Commenting out the calls instead of deleting them allows you to determine the original location of 
these commands for debugging purposes.  

Conclusion 

When you use these techniques, you can script  a set of act ions so that the script  does not log on and log 
off with each i terat ion through the loop.   

Caut ion: You must take care when you perform this action. In the event of a failure, you must log off 
before using a transaction restart. 

The sample original script  and sample modified script  i l lustrate th is process. 

 

Sam ple: Original  Ci t r i x  Script  for M odi fying the Transact ion  Loop 

The fol lowing sample is an original Citrix script  converted from capture. Points of in terest in  the script  are 
shown in bold. 

Sample Script  
/* 
 *  capCtxMoveLoop.cpp 
 * 
 *  Script Converted on February 28, 2005 at 08:30:06 AM 
 *  Generated by Compuware QALoad convert module version 5.5.0 build 231 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
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 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 
#define CITRIX_CLIENT_VERSION "8.100.29670" 
#define CITRIX_ICO_VERSION    "2.4" 
#define SCRIPT_VER 0x00000505UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_citrix.h" 
/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 
#ifndef NULL 
#define NULL  0 
#endif 
extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 
const char *CitrixServer      = "QACCitrix"; 
const char *CitrixUsername    = "Citrix"; 
const char *CitrixPassword    = "~encr~657E06726F697206"; 
const char *CitrixDomain      = "QACCitrix"; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_3 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_4 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_5 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_6 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_7 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_8 = new CtxWI(0x1008c, "", 115, 0, 405, 457); 
CtxWI *CWI_9 = new CtxWI(0x2006c, "Calculator", 66, 66, 261, 253); 
 
SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("capCtxMoveLoop.cpp"); 
CitrixInit(1); 
/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetDomainLoginInfo(CitrixUsername, CitrixPassword, CitrixDomain); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 
BEGIN_TRANSACTION(); 
DO_SetTransactionStart(); 
 
CtxConnect(CitrixServer, CitrixOutputMode); 
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// Window CWI_1 ("Warning !!") created 1109597295.502 
 
CtxWaitForWindowCreate(CWI_1, 2156); 
 
DO_MSLEEP(922); 
CtxPoint(333, 233);  //1109597296.611 
 
DO_MSLEEP(188); 
CtxMouseDown(CWI_1, L_BUTTON, NONE, 333, 233);  // 1109597296.611 
 
CtxMouseUp(CWI_1, L_BUTTON, NONE, 332, 233); //1109597296.861 
 
DO_MSLEEP(1250); 
CtxPoint(319, 360);  //1109597297.938 
 
DO_MSLEEP(78); 
CtxMouseDown(CWI_1, L_BUTTON, NONE, 319, 360);  // 1109597297.938 
 
CtxMouseUp(CWI_1, L_BUTTON, NONE, 320, 360); //1109597298.235 
 
DO_MSLEEP(78); 
CtxPoint(320, 360);  //1109597298.282 
 
DO_MSLEEP(265); 
// Window CWI_1 ("Warning !!") destroyed 1109597298.282 
 
CtxPoint(321, 358);  //1109597298.469 
 
// Window CWI_2 ("Please wait...") created 1109597298.469 
 
CtxWaitForWindowCreate(CWI_2, 31); 
 
DO_MSLEEP(47); 
CtxPoint(324, 353);  //1109597298.500 
 
// Window CWI_2 ("Please wait...") destroyed 1109597298.500 
 
CtxPoint(321, 325);  //1109597298.578 
 
// Window CWI_3 ("Citrix License Warning Notice") created 1109597298.578 
 
CtxWaitForWindowCreate(CWI_3, 15); 
 
// Window CWI_4 ("UsrLogon.Cmd") created 1109597298.578 
 
CtxWaitForWindowCreate(CWI_4, 0); 
 
DO_MSLEEP(16); 
// Window CWI_4 ("UsrLogon.Cmd") destroyed 1109597298.594 
 
CtxPoint(307, 268);  //1109597298.766 
 
// Window CWI_5 ("") created 1109597298.766 
 
DO_MSLEEP(63); 
// Window CWI_6 ("ICA Seamless Host Agent") created 1109597298.828 
 
CtxWaitForWindowCreate(CWI_6, 62); 
 
// Window CWI_7 ("Program Manager") created 1109597298.828 
 
CtxWaitForWindowCreate(CWI_7, 0); 
 
// Window CWI_8 ("") created 1109597301.123 



QALoad 5.5  

268 

 
DO_MSLEEP(2297); 
 
DO_MSLEEP(2797); 
// Window CWI_8 ("") destroyed 1109597303.918 
 
DO_MSLEEP(5438); 
CtxPoint(289, 212);  //1109597309.524 
 
DO_MSLEEP(171); 
CtxClick(CWI_3, 266, L_BUTTON, NONE); //1109597309.789 
 
DO_MSLEEP(1109); 
CtxPoint(329, 295);  //1109597310.944 
 
DO_MSLEEP(47); 
CtxClick(CWI_3, 250, L_BUTTON, NONE); //1109597311.194 
 
DO_MSLEEP(63); 
// Window CWI_3 ("Citrix License Warning Notice") destroyed 1109597311.257 
 
DO_MSLEEP(984); 
CtxPoint(261, 132);  //1109597312.475 
 
DO_MSLEEP(235); 
CtxClick(CWI_6, 312, L_BUTTON, NONE); //1109597312.787 
 
DO_MSLEEP(563); 
CtxPoint(208, 194);  //1109597313.708 
 
DO_MSLEEP(359); 
CtxClick(CWI_6, 281, L_BUTTON, NONE); //1109597313.989 
 
DO_MSLEEP(78); 
// Window CWI_6 ("ICA Seamless Host Agent") destroyed 1109597314.067 
 
/* 
After Logon 
*/ 
DO_MSLEEP(29578); 
CtxPoint(101, 96);  //1109597343.983 
 
DO_MSLEEP(360); 
CtxDoubleClick(CWI_7); // 1109597344.186 
 
CtxMouseUp(CWI_5, L_BUTTON, NONE, 100, 96); //1109597344.093 
 
DO_MSLEEP(47); 
CtxPoint(100, 96);  //1109597344.186 
 
DO_MSLEEP(156); 
 
// Window CWI_9 ("Calculator") created 1109597344.327 
 
CtxWaitForWindowCreate(CWI_9, 141); 
 
DO_MSLEEP(921); 
CtxPoint(181, 195);  //1109597345.420 
 
DO_MSLEEP(172); 
CtxMouseDown(CWI_9, L_BUTTON, NONE, 181, 195);  // 1109597345.420 
 
CtxMouseUp(CWI_9, L_BUTTON, NONE, 181, 196); //1109597345.529 
 
DO_MSLEEP(438); 
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CtxPoint(210, 196);  //1109597345.857 
 
CtxMouseDown(CWI_9, L_BUTTON, NONE, 210, 196);  // 1109597345.857 
 
CtxMouseUp(CWI_9, L_BUTTON, NONE, 211, 197); //1109597346.013 
 
DO_MSLEEP(562); 
CtxPoint(252, 230);  //1109597346.950 
 
DO_MSLEEP(532); 
CtxClick(CWI_9, 140, L_BUTTON, NONE); //1109597347.091 
 
DO_MSLEEP(531); 
CtxPoint(171, 222);  //1109597347.653 
 
DO_MSLEEP(32); 
CtxMouseDown(CWI_9, L_BUTTON, NONE, 171, 222);  // 1109597347.653 
 
CtxMouseUp(CWI_9, L_BUTTON, NONE, 172, 222); //1109597347.746 
 
DO_MSLEEP(547); 
CtxPoint(231, 231);  //1109597348.215 
 
DO_MSLEEP(15); 
CtxMouseDown(CWI_9, L_BUTTON, NONE, 231, 231);  // 1109597348.215 
 
CtxMouseUp(CWI_9, L_BUTTON, NONE, 230, 231); //1109597348.340 
 
DO_MSLEEP(953); 
CtxPoint(303, 293);  //1109597349.370 
 
DO_MSLEEP(188); 
CtxMouseDown(CWI_9, L_BUTTON, NONE, 303, 293);  // 1109597349.370 
 
CtxMouseUp(CWI_9, L_BUTTON, NONE, 302, 293); //1109597349.480 
 
DO_MSLEEP(1859); 
CtxPoint(314, 79);  //1109597351.494 
 
DO_MSLEEP(281); 
CtxClick(CWI_9, 157, L_BUTTON, NONE); //1109597351.650 
 
DO_MSLEEP(62); 
// Window CWI_9 ("Calculator") destroyed 1109597351.712 
 
/* 
Before Logoff 
*/ 
DO_MSLEEP(33781); 
CtxPoint(384, 13);  //1109597396.040 
 
DO_MSLEEP(10579); 
// Window CWI_7 ("Program Manager") destroyed 1109597396.040 
// Window CWI_5 ("") destroyed 1109597396.040 
 
DO_SetTransactionCleanup(); 
CtxDisconnect(); 
 
END_TRANSACTION(); 
delete CWI_1; // "Warning !!" 
delete CWI_2; // "Please wait..." 
delete CWI_3; // "Citrix License Warning Notice" 
delete CWI_4; // "UsrLogon.Cmd" 
delete CWI_5; // "" 
delete CWI_6; // "ICA Seamless Host Agent" 
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delete CWI_7; // "Program Manager" 
delete CWI_8; // "" 
delete CWI_9; // "Calculator" 
 
CitrixUninit(); 
 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

 

Sam ple: M odi f i ed Ci t r i x  Script  for M odi fying the Transact ion  Loop 

The fol lowing sample is a modified Citrix script  that moves the transact ion loop. Changes to  the original 
script  are shown in bold. 

Sample Script  
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 
#define CITRIX_CLIENT_VERSION "8.100.29670" 
#define CITRIX_ICO_VERSION    "2.4" 
#define SCRIPT_VER 0x00000505UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_citrix.h" 
/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 
#ifndef NULL 
#define NULL  0 
#endif 
extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 
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const char *CitrixServer      = "QACCitrix"; 
const char *CitrixUsername    = "Citrix"; 
const char *CitrixPassword    = "~encr~657E06726F697206"; 
const char *CitrixDomain      = "QACCitrix"; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_3 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_4 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_5 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_6 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_7 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_8 = new CtxWI(0x1008c, "", 115, 0, 405, 457); 
CtxWI *CWI_9 = new CtxWI(0x2006c, "Calculator", 66, 66, 261, 253); 
 
SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("capCtxMoveLoop.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetDomainLoginInfo(CitrixUsername, CitrixPassword, CitrixDomain); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 
///////////////////////////////////////////// 
// Remove the BEGIN_TRANSACTION();  
// and place it after the logon comment 
// in the script 
///////////////////////////////////////////// 

// BEGIN_TRANSACTION(); 

///////////////////////////////////////////// 
// Remove the DO_SetTransactionStart();  
// Restart transaction cannot be used if the 
// Transaction Loop has been moved 
///////////////////////////////////////////// 
 

// DO_SetTransactionStart(); 
 
CtxConnect(CitrixServer, CitrixOutputMode); 
 
// Window CWI_1 ("Warning !!") created 1109597295.502 
 
CtxWaitForWindowCreate(CWI_1, 2156); 
 
DO_MSLEEP(922); 
CtxPoint(333, 233);  //1109597296.611 
 
DO_MSLEEP(188); 
CtxMouseDown(CWI_1, L_BUTTON, NONE, 333, 233);  // 1109597296.611 
 
CtxMouseUp(CWI_1, L_BUTTON, NONE, 332, 233); //1109597296.861 
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DO_MSLEEP(1250); 
CtxPoint(319, 360);  //1109597297.938 
 
DO_MSLEEP(78); 
CtxMouseDown(CWI_1, L_BUTTON, NONE, 319, 360);  // 1109597297.938 
 
CtxMouseUp(CWI_1, L_BUTTON, NONE, 320, 360); //1109597298.235 
 
DO_MSLEEP(78); 
CtxPoint(320, 360);  //1109597298.282 
 
DO_MSLEEP(265); 
// Window CWI_1 ("Warning !!") destroyed 1109597298.282 
 
CtxPoint(321, 358);  //1109597298.469 
 
// Window CWI_2 ("Please wait...") created 1109597298.469 
 
CtxWaitForWindowCreate(CWI_2, 31); 
 
DO_MSLEEP(47); 
CtxPoint(324, 353);  //1109597298.500 
 
// Window CWI_2 ("Please wait...") destroyed 1109597298.500 
 
CtxPoint(321, 325);  //1109597298.578 
 
// Window CWI_3 ("Citrix License Warning Notice") created 1109597298.578 
 
CtxWaitForWindowCreate(CWI_3, 15); 
 
// Window CWI_4 ("UsrLogon.Cmd") created 1109597298.578 
 
CtxWaitForWindowCreate(CWI_4, 0); 
 
DO_MSLEEP(16); 
// Window CWI_4 ("UsrLogon.Cmd") destroyed 1109597298.594 
 
CtxPoint(307, 268);  //1109597298.766 
 
// Window CWI_5 ("") created 1109597298.766 
 
DO_MSLEEP(63); 
// Window CWI_6 ("ICA Seamless Host Agent") created 1109597298.828 
 
CtxWaitForWindowCreate(CWI_6, 62); 
 
// Window CWI_7 ("Program Manager") created 1109597298.828 
 
CtxWaitForWindowCreate(CWI_7, 0); 
 
// Window CWI_8 ("") created 1109597301.123 
 
DO_MSLEEP(2297); 
 
DO_MSLEEP(2797); 
// Window CWI_8 ("") destroyed 1109597303.918 
 
DO_MSLEEP(5438); 
CtxPoint(289, 212);  //1109597309.524 
 
DO_MSLEEP(171); 
CtxClick(CWI_3, 266, L_BUTTON, NONE); //1109597309.789 
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DO_MSLEEP(1109); 
CtxPoint(329, 295);  //1109597310.944 
 
DO_MSLEEP(47); 
CtxClick(CWI_3, 250, L_BUTTON, NONE); //1109597311.194 
 
DO_MSLEEP(63); 
// Window CWI_3 ("Citrix License Warning Notice") destroyed 1109597311.257 
 
DO_MSLEEP(984); 
CtxPoint(261, 132);  //1109597312.475 
 
DO_MSLEEP(235); 
CtxClick(CWI_6, 312, L_BUTTON, NONE); //1109597312.787 
 
DO_MSLEEP(563); 
CtxPoint(208, 194);  //1109597313.708 
 
DO_MSLEEP(359); 
CtxClick(CWI_6, 281, L_BUTTON, NONE); //1109597313.989 
 
DO_MSLEEP(78); 
// Window CWI_6 ("ICA Seamless Host Agent") destroyed 1109597314.067 
 
/* 
After Logon 
*/ 
///////////////////////////////////////////// 
// Move Begin Transaction Loop to after  
// the Logon comment created during capture 
// process You may want to reduce the sleep 
// time introduced into the process by adding 
// the comment 
///////////////////////////////////////////// 
BEGIN_TRANSACTION(); 
 
DO_MSLEEP(2578); 
CtxPoint(101, 96);  //1109597343.983 
 
DO_MSLEEP(360); 
CtxDoubleClick(CWI_7); // 1109597344.186 
 
CtxMouseUp(CWI_5, L_BUTTON, NONE, 100, 96); //1109597344.093 
 
DO_MSLEEP(47); 
CtxPoint(100, 96);  //1109597344.186 
 
DO_MSLEEP(156); 
 
// Window CWI_9 ("Calculator") created 1109597344.327 
 
CtxWaitForWindowCreate(CWI_9, 141); 
 
DO_MSLEEP(921); 
CtxPoint(181, 195);  //1109597345.420 
 
DO_MSLEEP(172); 
CtxMouseDown(CWI_9, L_BUTTON, NONE, 181, 195);  // 1109597345.420 
 
CtxMouseUp(CWI_9, L_BUTTON, NONE, 181, 196); //1109597345.529 
 
DO_MSLEEP(438); 
CtxPoint(210, 196);  //1109597345.857 
 
CtxMouseDown(CWI_9, L_BUTTON, NONE, 210, 196);  // 1109597345.857 
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CtxMouseUp(CWI_9, L_BUTTON, NONE, 211, 197); //1109597346.013 
 
DO_MSLEEP(562); 
CtxPoint(252, 230);  //1109597346.950 
 
DO_MSLEEP(532); 
CtxClick(CWI_9, 140, L_BUTTON, NONE); //1109597347.091 
 
DO_MSLEEP(531); 
CtxPoint(171, 222);  //1109597347.653 
 
DO_MSLEEP(32); 
CtxMouseDown(CWI_9, L_BUTTON, NONE, 171, 222);  // 1109597347.653 
 
CtxMouseUp(CWI_9, L_BUTTON, NONE, 172, 222); //1109597347.746 
 
DO_MSLEEP(547); 
CtxPoint(231, 231);  //1109597348.215 
 
DO_MSLEEP(15); 
CtxMouseDown(CWI_9, L_BUTTON, NONE, 231, 231);  // 1109597348.215 
 
CtxMouseUp(CWI_9, L_BUTTON, NONE, 230, 231); //1109597348.340 
 
DO_MSLEEP(953); 
CtxPoint(303, 293);  //1109597349.370 
 
DO_MSLEEP(188); 
CtxMouseDown(CWI_9, L_BUTTON, NONE, 303, 293);  // 1109597349.370 
 
CtxMouseUp(CWI_9, L_BUTTON, NONE, 302, 293); //1109597349.480 
 
DO_MSLEEP(1859); 
CtxPoint(314, 79);  //1109597351.494 
 
DO_MSLEEP(281); 
CtxClick(CWI_9, 157, L_BUTTON, NONE); //1109597351.650 
 
DO_MSLEEP(62); 
// Window CWI_9 ("Calculator") destroyed 1109597351.712 
 
/* 
Before Logoff 
*/ 
///////////////////////////////////////////// 
// Move End Transaction Loop to before  
// the Logoff comment created during capture 
// process You may want to reduce the sleep 
// time introduced into the process by adding 
// the comment 
///////////////////////////////////////////// 
END_TRANSACTION(); 
 
DO_MSLEEP(3781); 
CtxPoint(384, 13);  //1109597396.040 
 
DO_MSLEEP(1079); 
// Window CWI_7 ("Program Manager") destroyed 1109597396.040 
 
// Window CWI_5 ("") destroyed 1109597396.040 
///////////////////////////////////////////// 
// Remove the DO_SetTransactionCleanup();  
// Restart transaction cannot be used if the 
// Transaction Loop has been moved 



QALoad Online Help 

275 

///////////////////////////////////////////// 
 

// DO_SetTransactionCleanup(); 
 
CtxDisconnect(); 
 
///////////////////////////////////////////// 
// Remove the END_TRANSACTION();  
// and place it before the logoff comment 
// in the script 
///////////////////////////////////////////// 
 

// END_TRANSACTION(); 
delete CWI_1; // "Warning !!" 
delete CWI_2; // "Please wait..." 
delete CWI_3; // "Citrix License Warning Notice" 
delete CWI_4; // "UsrLogon.Cmd" 
delete CWI_5; // "" 
delete CWI_6; // "ICA Seamless Host Agent" 
delete CWI_7; // "Program Manager" 
delete CWI_8; // "" 
delete CWI_9; // "Calculator" 
 
CitrixUninit(); 
 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

 

Scripting Mouse Actions 

M odi fying the Script  for Con t rol l i ng M ouse Act ions  

Changes to screen resolut ion or server sett ings can cause the appearance, size, and locat ion coordinates of 
a window to differ from the expected behavior in  the recorded script . By sett ing Display coordinate 
tool t i p on  r i gh t -cl i ck  opt ion  in  val idat ion  w indow  in  the Convert  Opt ions dialog box, you can right-
cl ick the mouse at the desired locat ion to extract screen coordinate values that correspond to buttons and 
other controls in  real t ime during val idat ion .  

To modify a script  to retrieve coordinate values, you must: 

!  Validate the settings. 

!  Modify the script. 

To val idat e t he set t ings: 

1. Click Opt ions>Convert , and cl ick the Ci t r i x  tab.  

2. Ensure that the Display coordinate tool t i p on  r i gh t -cl i ck  opt ion  in  val i dat ion  w indow  
checkbox is selected.  

3. Set Replay output  m ode to Normal. 
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4. Click OK to convert  the script . 

  

During val idat ion, a right mouse-cl ick results in  a toolt ip display of the screen coordinate values. You can 
use these values in  a manually added CtxPoint cal l  to ensure that the mouse is moved to these coordinates 
before any subsequent mouse cl ick act ions. 

Tip: Make a note of these coordinate values, since this tooltip is not logged. 
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To m odi f y t he scr ipt : 

Once you determine the correct mouse coordinates from val idat ion, modify the script .  

1. Add or modify the CtxPoint command. 

2. Insert the new values into the script. 

Conclusion 

Fol lowing these techniques, you can retrieve screen coordinates at val idat ion and insert  them into a script . 
This corrects mouse behavior as a result  of changes to the server sett ings or the user session environment. 
The sample scripts, showing added CtxPoint and CtxMouseClick, and modified CtxPoint, i l lustrate these 
techniques. 

 

Sam ple: Script  Sn ippet  w i th  Added CtxPoin t  and CtxCl i ck   

The fol lowing sample shows a script  extract with CtxPoint and CtxClick commands added. Comments and 
added script  l ines are h ighl ighted in  bold. 

Sample Script  Snippet 

…beginning of script… 
DO_MSLEEP(687); 
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/// This CtxPoint is for an intermittent window  
/// that appeared. A button is required to dismiss 
/// this window. Right-clicking on the button during  
/// validation gave the coordinates in a tooltip.  

CtxPoint(268, 60); 
 
/// A DO_MSLEEP will pause execution for a second. 

DO_MSLEEP(1000); 
/// This CtxSetWindowMatchName is for the intermittent window name. 

SetWindowMatchName( CWI_9, "*" ); 

/// This CtxClick command is added to dismiss the window. 
CtxClick(CWI_9, 78, L_BUTTON, NONE); 

…end of script… 
 

Sam ple: Script  Sn ippet  w i th  M odi f i ed CtxPoin t  

The fol lowing sample shows a script  extract with a modified CtxPoint command. Comments and added 
script  l ines are h ighl ighted in  bold. 

Sample Script  
…beginning of script… 

DO_MSLEEP(1844); 
// Window CWI_10 ("") destroyed 1113840796.133 
 
DO_MSLEEP(1828); 

/// Modifying a CtxPoint is easy once you have the 
/// target coordinates and have identified the  
/// CtxClick statement that was failing. Just 
/// insert the X and Y coordinates as the parameters. 

CtxPoint(200, 200);  //1113840798.309 
 
DO_MSLEEP(344); 
CtxClick(CWI_5, 78, L_BUTTON, NONE); //1113840798.387 

…end of script… 
 

Using CtxWaitForScreenUpdate Command 

M odi fying the Script  w i th  the CtxWai tForScreen Update Com m and 

Windows in a Citrix session can take varying amounts of t ime to complete screen updates. This can result  
in  keyboard and mouse events not synchronizing with the appropriate window.  

For example, the Windows Start  menu is an unnamed window. The amount of t ime i t  takes to appear 
depends on system resource usage. Adding a CtxWaitForScreenUpdate command before the keyboard entry 
or mouse cl ick can ensure that the window that the window has enough t ime to display before any 
subsequent mouse cl icks or keyboard entries take place. You can add the command while recording a script  
or after a script  has been recorded. 

Note: When recording a session with windows that load slowly, pay attention to the ScreenUpdate 
messages that scroll in the message panel.  

Once the window has completed loading, do the fol lowing: 
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To add Ct xW ait ForScreenUpdat e w hi le r ecording a session: 

1. Click the last ScreenUpdate message to h ighl ight the l ine. 

2. Click  Wai tPoin t  to insert  a statement in  the record session.  The statement is converted to a 
CtxWai tForScreenUpdate command in the script , which waits for the screen update before 
proceeding. 

Note: Anyt ime a window loads slowly or has the potent ial  to load slowly during a Citrix record 
session, such as when traffic is heavy, consider using th is technique before performing any keyboard or 
mouse act ivi ty on that window. 

 

 

To add Ct xW ait ForScreenUpdat e t o an  exist ing scr ip t : 

Manually enter the CtxW ai tForScreenUpdate before the keyboard or mouse event that is fi ring 
prematurely.   

Note: To prevent playback problems in which a mouse click does not synchronize with its intended 
window, insert the command in the script after the action that causes the window to appear.  

The parameters for the CtxWaitForScreenUpdate command correspond to the X and Y coordinates, and 
the width and height of the window. You can determine the parameters from the Citrix window object 
declarat ion parameters. 

Conclusion 

Fol lowing these techniques, you can prevent problems with premature mouse cl icks and keyboard entry 
statements during replay. The sample scripts, for using the command while recording and for using the 
command after recording, i l lustrate th is technique. 
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Sam ple: Using the Com m and Af ter Recording  

The fol lowing sample shows a script  with WaitPoin t inserted after recording is completed. Script  changes 
are h ighl ighted in  bold. 

Sample Script  
/* 
 *  waitforscreenupdate.cpp 
 * 
 *  Script Converted on April 19, 2005 at 02:44:44 PM 
 *  Generated by Compuware QALoad convert module version 5.5.0 build 256 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 
#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 
#include "smacro.h" 

#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix"; 
const char *CitrixPassword    = ""; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
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/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_5 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_6 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_7 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_8 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_9 = new CtxWI(0x10088, "", 115, 0, 405, 457); 
CtxWI *CWI_10 = new CtxWI(0x10134, "", 112, 116, 416, 248); 
CtxWI *CWI_11 = new CtxWI(0x1012e, "Microsoft Word", 0, 0, 649, 461); 
CtxWI *CWI_12 = new CtxWI(0x10176, "Microsoft Word", 162, 193, 322, 109); 
CtxWI *CWI_13 = new CtxWI(0x7001c, "Please wait...", 111, 112, 418, 145); 
 
SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("waitforscreenupdate.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 
 
CtxConnect(CitrixServer, CitrixOutputMode); 
 
CtxPoint(202, 89);  //1113936216.354 
 
// Window CWI_1 ("Warning !!") created 1113936216.354 
 
CtxWaitForWindowCreate(CWI_1, 1953); 
 
DO_MSLEEP(1859); 
CtxPoint(320, 372);  //1113936218.260 
 
DO_MSLEEP(47); 
CtxClick(CWI_1, 78, L_BUTTON, NONE); //1113936218.338 
 
// Window CWI_2 ("Log On to Windows") created 1113936218.479 
 
CtxWaitForWindowCreate(CWI_2, 141); 
 
// Window CWI_1 ("Warning !!") destroyed 1113936218.479 
 
CtxType(CWI_2, "citrix");  //1113936220.995 
 
DO_MSLEEP(2312); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113936221.073 
 
DO_MSLEEP(281); 
CtxType(CWI_2, "citrix");  //1113936223.104 
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DO_MSLEEP(1782); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113936223.151 
 
DO_MSLEEP(297); 
CtxType(CWI_2, "q");  //1113936224.354 
 
DO_MSLEEP(718); 
 
DO_MSLEEP(1407); 
CtxPoint(243, 326);  //1113936225.291 
 
DO_MSLEEP(15); 
CtxClick(CWI_2, 63, L_BUTTON, NONE); //1113936225.354 
 
DO_MSLEEP(78); 
// Window CWI_2 ("Log On to Windows") destroyed 1113936225.432 
 
// Window CWI_3 ("Please wait...") created 1113936225.510 
 
CtxWaitForWindowCreate(CWI_3, 78); 
 
DO_MSLEEP(78); 
// Window CWI_3 ("Please wait...") destroyed 1113936225.588 
 
// Window CWI_4 ("Citrix License Warning Notice") created 1113936225.651 
 
CtxWaitForWindowCreate(CWI_4, 63); 
 
// Window CWI_5 ("UsrLogon.Cmd") created 1113936225.666 
 
CtxWaitForWindowCreate(CWI_5, 15); 
 
DO_MSLEEP(16); 
// Window CWI_5 ("UsrLogon.Cmd") destroyed 1113936225.682 
 
// Window CWI_6 ("") created 1113936225.916 
 
DO_MSLEEP(234); 
// Window CWI_7 ("ICA Seamless Host Agent") created 1113936225.963 
 
CtxWaitForWindowCreate(CWI_7, 47); 
 
// Window CWI_8 ("Program Manager") created 1113936225.979 
 
CtxWaitForWindowCreate(CWI_8, 16); 
 
DO_MSLEEP(953); 
CtxPoint(332, 299);  //1113936226.963 
 
DO_MSLEEP(31); 
CtxClick(CWI_7, 78, L_BUTTON, NONE); //1113936227.041 
 
DO_MSLEEP(63); 
// Window CWI_4 ("Citrix License Warning Notice") destroyed 1113936227.104 
 
DO_MSLEEP(328); 
CtxPoint(198, 203);  //1113936227.588 
 
DO_MSLEEP(156); 
CtxClick(CWI_7, 63, L_BUTTON, NONE); //1113936227.651 
 
DO_MSLEEP(78); 
CtxPoint(208, 216);  //1113936227.744 
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DO_MSLEEP(15); 
// Window CWI_7 ("ICA Seamless Host Agent") destroyed 1113936227.744 
 
CtxPoint(266, 237);  //1113936228.260 
 
// Window CWI_9 ("") created 1113936228.260 
 
DO_MSLEEP(453); 
 
DO_MSLEEP(3031); 
// Window CWI_9 ("") destroyed 1113936231.291 
 
DO_MSLEEP(8531); 
CtxPoint(115, 170);  //1113936240.182 
 
DO_MSLEEP(360); 
CtxDoubleClick(CWI_8); // 1113936240.338 
 
DO_MSLEEP(78); 
 
// Window CWI_10 ("") created 1113936240.463 
 
DO_MSLEEP(125); 
CtxPoint(243, 205);  //1113936240.619 
 
// Window CWI_11 ("Microsoft Word") created 1113936240.619 
 
CtxWaitForWindowCreate(CWI_11, 156); 
 
// Window CWI_10 ("") destroyed 1113936240.619 
 
DO_MSLEEP(32); 
CtxPoint(250, 208);  //1113936240.666 
 
DO_MSLEEP(15); 
CWI_11->setTitle("Document1 - Microsoft Word"); //1113936240.869 
 
CtxPoint(296, 0);  //1113936245.916 

/// This command was added to the script manually.  The size parameters 
/// are from the Citrix window creation object, and the last parameter 
/// indicates that the wait time for completion of this screen  
/// update is set to 5 seconds.  Note that this statement is 
/// placed before any mouse moves for that window. 

CtxWaitForScreenUpdate(0, 0, 649, 481, 5000); 

 
DO_MSLEEP(2094); 
CtxPoint(56, 201);  //1113936248.260 
 
DO_MSLEEP(250); 
CtxClick(CWI_11, 47, L_BUTTON, NONE); //1113936248.307 
 
CtxType(CWI_11, "N");  //1113936249.760 
 
DO_MSLEEP(1453); 
CtxPoint(68, 213);  //1113936249.760 
 
CtxType(CWI_11, "ow I");  //1113936251.041 
 
DO_MSLEEP(1281); 
CtxType(CWI_11, " can type text!");  //1113936255.119 
 
DO_MSLEEP(4078); 
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DO_MSLEEP(2766); 
 
DO_MSLEEP(2094); 
CtxPoint(635, 5);  //1113936260.010 
 
DO_MSLEEP(31); 
CtxClick(CWI_11, 78, L_BUTTON, NONE); //1113936260.088 
 
CtxPoint(634, 12);  //1113936260.213 
 
// Window CWI_12 ("Microsoft Word") created 1113936260.213 
 
CtxWaitForWindowCreate(CWI_12, 16); 
 
DO_MSLEEP(875); 
CtxPoint(325, 275);  //1113936261.088 
 
CtxClick(CWI_12, 63, L_BUTTON, NONE); //1113936261.151 
 
DO_MSLEEP(62); 
// Window CWI_12 ("Microsoft Word") destroyed 1113936261.213 
 
DO_MSLEEP(16); 
// Window CWI_11 ("Document1 - Microsoft Word") destroyed 1113936261.229 
 
DO_MSLEEP(1375); 
CtxPoint(385, 165);  //1113936262.963 
 
DO_MSLEEP(359); 
// Window CWI_8 ("Program Manager") destroyed 1113936262.963 
 
// Window CWI_6 ("") destroyed 1113936262.979 
 
// Window CWI_13 ("Please wait...") created 1113936263.244 
 
CtxWaitForWindowCreate(CWI_13, 0); 
 
DO_SetTransactionCleanup(); 
 
CtxDisconnect(); 
 
END_TRANSACTION(); 

delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
delete CWI_4; // "Citrix License Warning Notice" 
delete CWI_5; // "UsrLogon.Cmd" 
delete CWI_6; // "" 
delete CWI_7; // "ICA Seamless Host Agent" 
delete CWI_8; // "Program Manager" 
delete CWI_9; // "" 
delete CWI_10; // "" 
delete CWI_11; // "Microsoft Word" 
delete CWI_12; // "Microsoft Word" 
delete CWI_13; // "Please wait..." 
 
CitrixUninit(); 
 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 
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RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

 

Sam ple: Using the Com m and Wh i le Recording 

The fol lowing sample shows a script  with the WaitPoint command inserted at  record t ime. Points of 
in terest in  the script  are h ighl ighted in  bold. 

Sample Script  
/* 
 *  waitforscreenupdate.cpp 
 * 
 *  Script Converted on April 19, 2005 at 02:44:44 PM 
 *  Generated by Compuware QALoad convert module version 5.5.0 build 256 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 

#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 
#include "smacro.h" 

#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 
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extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix"; 
const char *CitrixPassword    = ""; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_5 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_6 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_7 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_8 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_9 = new CtxWI(0x10088, "", 115, 0, 405, 457); 
CtxWI *CWI_10 = new CtxWI(0x10134, "", 112, 116, 416, 248); 
CtxWI *CWI_11 = new CtxWI(0x1012e, "Microsoft Word", -4, -4, 649, 461); 
CtxWI *CWI_12 = new CtxWI(0x10176, "Microsoft Word", 162, 193, 322, 109); 
CtxWI *CWI_13 = new CtxWI(0x7001c, "Please wait...", 111, 112, 418, 145); 
 
SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("waitforscreenupdate.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 
 
CtxConnect(CitrixServer, CitrixOutputMode); 
 
CtxPoint(202, 89);  //1113936216.354 
 
// Window CWI_1 ("Warning !!") created 1113936216.354 
 
CtxWaitForWindowCreate(CWI_1, 1953); 
 
DO_MSLEEP(1859); 
CtxPoint(320, 372);  //1113936218.260 
 
DO_MSLEEP(47); 
CtxClick(CWI_1, 78, L_BUTTON, NONE); //1113936218.338 
 
// Window CWI_2 ("Log On to Windows") created 1113936218.479 
 
CtxWaitForWindowCreate(CWI_2, 141); 
 
// Window CWI_1 ("Warning !!") destroyed 1113936218.479 
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CtxType(CWI_2, "citrix");  //1113936220.995 
 
DO_MSLEEP(2312); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113936221.073 
 
DO_MSLEEP(281); 
CtxType(CWI_2, "citrix");  //1113936223.104 
 
DO_MSLEEP(1782); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113936223.151 
 
DO_MSLEEP(297); 
CtxType(CWI_2, "q");  //1113936224.354 
 
DO_MSLEEP(718); 
 
DO_MSLEEP(1407); 
CtxPoint(243, 326);  //1113936225.291 
 
DO_MSLEEP(15); 
CtxClick(CWI_2, 63, L_BUTTON, NONE); //1113936225.354 
 
DO_MSLEEP(78); 
// Window CWI_2 ("Log On to Windows") destroyed 1113936225.432 
 
// Window CWI_3 ("Please wait...") created 1113936225.510 
 
CtxWaitForWindowCreate(CWI_3, 78); 
 
DO_MSLEEP(78); 
// Window CWI_3 ("Please wait...") destroyed 1113936225.588 
 
// Window CWI_4 ("Citrix License Warning Notice") created  
 
CtxWaitForWindowCreate(CWI_4, 63); 
 
// Window CWI_5 ("UsrLogon.Cmd") created 1113936225.666 
 
CtxWaitForWindowCreate(CWI_5, 15); 
 
DO_MSLEEP(16); 
// Window CWI_5 ("UsrLogon.Cmd") destroyed 1113936225.682 
 
// Window CWI_6 ("") created 1113936225.916 
 
DO_MSLEEP(234); 
// Window CWI_7 ("ICA Seamless Host Agent") created 1113936225.963 
 
CtxWaitForWindowCreate(CWI_7, 47); 
 
// Window CWI_8 ("Program Manager") created 1113936225.979 
 
CtxWaitForWindowCreate(CWI_8, 16); 
 
DO_MSLEEP(953); 
CtxPoint(332, 299);  //1113936226.963 
 
DO_MSLEEP(31); 
CtxClick(CWI_7, 78, L_BUTTON, NONE); //1113936227.041 
 
DO_MSLEEP(63); 
// Window CWI_4 ("Citrix License Warning Notice") destroyed 1113936227.104 
 
DO_MSLEEP(328); 
CtxPoint(198, 203);  //1113936227.588 
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DO_MSLEEP(156); 
CtxClick(CWI_7, 63, L_BUTTON, NONE); //1113936227.651 
 
DO_MSLEEP(78); 
CtxPoint(208, 216);  //1113936227.744 
 
DO_MSLEEP(15); 
// Window CWI_7 ("ICA Seamless Host Agent") destroyed 1113936227.744 
 
CtxPoint(266, 237);  //1113936228.260 
 
// Window CWI_9 ("") created 1113936228.260 
 
DO_MSLEEP(453); 
 
DO_MSLEEP(3031); 
// Window CWI_9 ("") destroyed 1113936231.291 
 
DO_MSLEEP(8531); 
CtxPoint(115, 170);  //1113936240.182 
 
DO_MSLEEP(360); 
CtxDoubleClick(CWI_8); // 1113936240.338 
 
DO_MSLEEP(78); 
 
// Window CWI_10 ("") created 1113936240.463 
 
DO_MSLEEP(125); 
CtxPoint(243, 205);  //1113936240.619 
 
// Window CWI_11 ("Microsoft Word") created 1113936240.619 
 
CtxWaitForWindowCreate(CWI_11, 156); 
 
// Window CWI_10 ("") destroyed 1113936240.619 
 
DO_MSLEEP(32); 
CtxPoint(250, 208);  //1113936240.666 
 
DO_MSLEEP(15); 
CWI_11->setTitle("Document1 - Microsoft Word"); //1113936240.869 
 
CtxPoint(296, 0);  //1113936245.916 

/// This command was added to the script by clicking on the  
/// ScreenUpdate message in the message panel, highlighting it, 
/// then clicking on the WaitPoint button 

CtxWaitForScreenUpdate(0, 0, 481, 641, 1406); 
 
DO_MSLEEP(2094); 
CtxPoint(56, 201);  //1113936248.260 
 
DO_MSLEEP(250); 
CtxClick(CWI_11, 47, L_BUTTON, NONE); //1113936248.307 
 
CtxType(CWI_11, "N");  //1113936249.760 
 
DO_MSLEEP(1453); 
CtxPoint(68, 213);  //1113936249.760 
 
CtxType(CWI_11, "ow I");  //1113936251.041 
 



QALoad Online Help 

289 

DO_MSLEEP(1281); 
CtxType(CWI_11, " can type text!");  //1113936255.119 
 
DO_MSLEEP(4078); 
 
DO_MSLEEP(2766); 
 
DO_MSLEEP(2094); 
CtxPoint(635, 5);  //1113936260.010 
 
DO_MSLEEP(31); 
CtxClick(CWI_11, 78, L_BUTTON, NONE); //1113936260.088 
 
CtxPoint(634, 12);  //1113936260.213 
 
// Window CWI_12 ("Microsoft Word") created 1113936260.213 
 
CtxWaitForWindowCreate(CWI_12, 16); 
 
DO_MSLEEP(875); 
CtxPoint(325, 275);  //1113936261.088 
 
CtxClick(CWI_12, 63, L_BUTTON, NONE); //1113936261.151 
 
DO_MSLEEP(62); 
// Window CWI_12 ("Microsoft Word") destroyed 1113936261.213 
 
DO_MSLEEP(16); 
// Window CWI_11 ("Document1 - Microsoft Word") destroyed 1113936261.229 
 
DO_MSLEEP(1375); 
CtxPoint(385, 165);  //1113936262.963 
 
DO_MSLEEP(359); 
// Window CWI_8 ("Program Manager") destroyed 1113936262.963 
 
// Window CWI_6 ("") destroyed 1113936262.979 
 
// Window CWI_13 ("Please wait...") created 1113936263.244 
 
CtxWaitForWindowCreate(CWI_13, 0); 
 
DO_SetTransactionCleanup(); 
 
CtxDisconnect(); 
 
END_TRANSACTION(); 

delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
delete CWI_4; // "Citrix License Warning Notice" 
delete CWI_5; // "UsrLogon.Cmd" 
delete CWI_6; // "" 
delete CWI_7; // "ICA Seamless Host Agent" 
delete CWI_8; // "Program Manager" 
delete CWI_9; // "" 
delete CWI_10; // "" 
delete CWI_11; // "Microsoft Word" 
delete CWI_12; // "Microsoft Word" 
delete CWI_13; // "Please wait..." 
 
CitrixUninit(); 
 
EXIT(); 
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return(0); 
} 
void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
EXIT(); 

} 

 

OFS Scripts 

Oracle Forms Server Script Samples 

You can address specific si tuat ions or resolve certain  problems by modifying converted Oracle Forms Server 
(OFS) scripts. The samples shown here include a descript ion of the problem, the procedure for 
implementing the modificat ion, and samples of a modified script . Script  modificat ions are discussed for: 

Parameterizat ion of Login Credent ials 

Using an ICX Ticket in  an OFS Script 

 

Parameterization of Logon Credentials 

M odi fying the OFS Script  to Param eteri ze Logon  Creden t ial s  

If your load test ing environment for Oracle Forms Server prevents a user from being logged in multiple 
t imes concurrent ly, you may need to parameterize the logon information.  This means creat ing unique 
values for the username and password of each virtual user (VU) and transact ion. 

To scr ip t  param et ers f or  logon in f orm at ion:  

1. Create a datapool that contains user names and passwords for the system you are test ing. 

2. Modify the script  to open the datapool, read the username and password from the datapool, and 
use the values in  the ofsSetLogonUserName() and ofsSetLogonPassWord() script  commands.  

Conclusion 

The sample script  i l lustrates the parameterizat ion of logon credent ials. 

 

Sam ple: Param eteri zat ion  of  OFS Logon  Creden t ial s  

The fol lowing is a sample script  from an Oracle Forms Server Session that tests Oracle 10g Applicat ion 
Server and uses a central datapool to ensure that username and passwords are unique.  The code necessary 
to parameterize the username and password is in  bold. 

Sample Script  
/* 
 *  sample-variablization.cpp 
 * 
 *  Script Converted on April 22, 2005 at 07:46:55 AM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 230 
 * 
 *  This script contains support for the following middlewares:  
 *      - Oracle Forms Server 
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 */ 

/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Oracle Forms Server 
 *  Send (Forms 6i) heartbeat every  : 4 minutes 
 *  Simulate Oracle Application Login: No 
 *  Stop for server error messages   : Yes 
 *    Stop if server msg is matched  : No 
 */ 

#define SCRIPT_VER 0x00000205UL 

#include <stdio.h> 
extern "C" { 
#include "smacro.h" 
#include "do_OFS.h" 
} 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 

//------------------------------------------------- 
// Pointers to use for username and password values  
// returned from VARDATA(). 
//------------------------------------------------- 
char *username = NULL; 
char *password = NULL; 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("sample-variablization.cpp"); 

ofsSetRunOptions( "9i", OFS_HTTP, 4, OFS_CHECKMSGS ); 

 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

//------------------------------------------------- 
// Requests that QALoad Conductor send the next 
// datapool record to the script.  
//------------------------------------------------- 
GET_DATA(); 
 
ofsHTTPSetHdrProperty("User-Agent", "Java1.3.1.17-internal" );  
 
ofsHTTPSetHdrProperty("Host", "hostname.com:7778" );  
 
ofsHTTPSetHdrProperty("Accept", "text/html, image/gif, image/jpeg, *; q=.2, " 
        "*/*; q=.2" );  
 
ofsHTTPSetHdrProperty("Connection", "Keep-alive" );  
 



QALoad 5.5  

292 

ofsHTTPConnectToFormsServlet( 
"http://hostname.com:7778/forms90/f90servlet?acceptLanguage=" 
        "en-us&ifcmd=startsession" ); 
 
 
DO_SLEEP(1); 
 
ofsHTTPSetListenerServletParms( "?ifcmd=getinfo&ifhost=dtx76852&ifip=" 
        "10.15.16.128" ); 
 
ofsHTTPConnectToListenerServlet( "http://hostname.com:7778/forms90/l90servlet" 
        ); 
 
 DO_SLEEP(1); 
 
ofsHTTPSetHdrProperty("Content-type", "application/octet-stream" );  
 
ofsHTTPInitialFormsConnect(); 
 
DO_SLEEP(1); 
ofsSetInitialVersion( "RUNFORM", 1, OFS_ADD, 268, "904000" ); 
ofsSetScreenResolution( "RUNFORM", 1, OFS_ADD, 263, 96, 96); 
ofsSetDisplaySize( "RUNFORM", 1, OFS_ADD, 264, 1280, 1024); 
ofsInitSessionCmdLine("RUNFORM", 1, OFS_ADD, 265,  
 "server escapeParams=true module=test1.fmx userid=  sso_userid=%20 sso_formsid=" 
        "f" 
 "ormsApp_ hostname.com_C49C18E49987450D8A6D907CABEFCD4C sso" 
 "_subDN= sso_usrDN= debug=no host= port= buffer_records=no debug_messages=no arr" 
 "ay=no obr=no query_only=no quiet=yes render=no record= tracegroup= log= term=" 
); 
ofsSetColorDepth( "RUNFORM", 1, OFS_ADD, 266, "256" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "0" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "255" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "65535" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "4210752" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "8421504" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "65280" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "12632256" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16711935" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16762880" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16756655" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16711680" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16777215" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16776960" ); 
ofsSetFontName( "RUNFORM", 1, OFS_ADD, 383, "Dialog" ); 
ofsSetFontSize( "RUNFORM", 1, OFS_ADD, 377, "900" ); 
ofsSetFontStyle( "RUNFORM", 1, OFS_ADD, 378, "0" ); 
ofsSetFontWeight( "RUNFORM", 1, OFS_ADD, 379, "0" ); 
ofsSetScaleInfo( "RUNFORM", 1, OFS_ADD, 267, 8, 20); 
ofsSetNoRequiredVAList( "RUNFORM", 1, OFS_ADD, 291 ); 
ofsInitSessionTimeZone( "RUNFORM", 1, OFS_ENDMSG, 530, "America/New_York" ); 
 
DO_SLEEP(3); 
ofsSendRecv(1); //ClientSeqNo=1|MsgCount=1|1114170373.195 
 
ofsSetWindowLocation( "FORMWINDOW", 6, OFS_ENDMSG, 135, 0, 0); 
ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 750, 600); 
ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 750, 600); 
 
DO_SLEEP(2); 
ofsSendRecv(1); //ClientSeqNo=2|MsgCount=3|1114170375.195 
 
ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 750, 600); 
 
DO_SLEEP(1); 
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ofsSendRecv(1); //ClientSeqNo=3|MsgCount=1|1114170376.242 

//------------------------------------------------- 
// Get values from the datapool.  Column 1 contains 
// the username and column 2 the password. 
//------------------------------------------------- 
username = VARDATA(1); 
password = VARDATA(2); 

//RR__printf("V1=\"%s\"", username); 
//RR__printf("V2=\"%s\"", password); 

//------------------------------------------------- 
// Pass the username and password retrieved from 
// the datapool into the OFS script commands that 
// specify the login credentials. 
//------------------------------------------------- 
ofsSetLogonUserName( "Logon", 34, OFS_ADD, 433, username ); 
ofsSetLogonPassWord( "Logon", 34, OFS_ADD, 434, password ); 
//ofsSetLogonUserName( "Logon", 34, OFS_ADD, 433, "scott" ); 
//ofsSetLogonPassWord( "Logon", 34, OFS_ADD, 434, "tiger" ); 
ofsSetLogonDatabase( "Logon", 34, OFS_ENDMSG, 435, "dbinstance" ); 
 
DO_SLEEP(10); 
ofsSendRecv(1); //ClientSeqNo=4|MsgCount=1|1114170385.898 
 
ofsActivateWindow( "WINDOW_START_APP", 11, OFS_ENDMSG, 247 ); 
ofsFocus( "BUTTON", 52, OFS_ENDMSG, 174 ); 
 
DO_SLEEP(1); 
ofsSendRecv(1); //ClientSeqNo=5|MsgCount=2|1114170387.289 
 
ofsShowWindow( "WINDOW_START_APP", 11, OFS_ENDMSG, 173 ); 
 
DO_SLEEP(1); 
ofsSendRecv(1); //ClientSeqNo=6|MsgCount=1|1114170388.305 
 
ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 750, 600); 
 
DO_SLEEP(1); 
ofsSendRecv(1); //ClientSeqNo=7|MsgCount=1|1114170389.320 
 
ofsRemoveFocus( "BUTTON", 52, OFS_ENDMSG, 174 ); 
ofsFocus( "BUTTON", 54, OFS_ENDMSG, 174 ); 
 
DO_SLEEP(2); 
ofsSendRecv(1); //ClientSeqNo=8|MsgCount=2|1114170391.742 
 
ofsClickButton( "BUTTON", 54, OFS_ENDMSG, 325 ); 
 
DO_SLEEP(1); 
ofsSendRecv(1); //ClientSeqNo=9|MsgCount=1|1114170392.773 
 
ofsHTTPDisconnect(); 
 
END_TRANSACTION(); 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
EXIT(); 

} 
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Using an ICX Ticket in an OFS Script 

M odi fying the OFS Script  to Use an  ICX Ticket  

Some Oracle Forms (OFS) environments use a unique cookie, cal led an ICX t icket, to ident i fy sessions. 
 When ICX t ickets are present, you must make changes to the QALoad script  in  order to replay 
successful ly. 

To m odi f y t he scr ipt : 

Modify QALoad Universal  scripts to extract the ICX t icket from WWW middleware traffic and pass that 
value to the OFS middleware. 

Conclusion 

The sample script  i l lustrates using an ICX t icket in  an OFS script . 

 

Sam ple: Using an  ICX Ticket  i n  an  OFS Script  

The fol lowing is a script  sample of a Universal session WWW/OFS script . It  tests an Oracle Forms 6i 
environment (socket mode), where an ICX Ticket cookie must be retrieved from the WWW command and 
used in an OFS command later in  the script .  In  th is case, the val idat ion of the script  in i t ial ly fai ls with the 
fol lowing error: 

Sample: Original Script  

VU 0 : Line:494, ofsSendRecv( 2 )  //ClientSeqNo=4|MsgCount=0 

VU 0 : Line: 494,  OFS-ERROR-032 -  Failed because the server sent this error message: APP-
FND-01931: Your session is no longer valid or your logon information could not be 
reestablished from your session. 

VU 0 :  Stopping HeartBeat... 

VU 0 : Line 494, Exception in function ofsSendRecv: 
 com.compuware.qacenter.qaload.QALoadBaseScript.QALoadException: Line: 494,  OFS-ERROR-032 - 
 Failed because the server sent this error message: APP-FND-01931: Your session is no longer 
valid or your logon information could not be reestablished from your session.  at 
com.compuware.qacenter.qaload.Do_Webforms.RootHandler.exitOnError(Unknown Source)  at 
com.compuware.qacenter.qaload.Do_Webforms.SocketConnection.socketSendRecv(Unknown Source) 
 at com.compuware.qacenter.qaload.Do_Webforms.RunForm.sendRecv(Unknown Source)  at 
com.compuware.qacenter.qaload.Do_Webforms.OracleForms.ofsSendRecv(Unknown Source)    

VU 0 : Line 494, EXIT 

However, a warning is generated by QALoad during the conversion process that is put in  the script : 

/***** WARNING ***** 

  icx_ticket found in INITIAL_CMDLINE. Add ofsSetICXTicket() or OracleAppsLogin(). 

 *****/ 

There is a cookie that is needed by OFS from one of the earl ier WWW requests: 

HTTP/1.0 200 OK 

Date: Fri, 22 Apr 2005 15:59:33 GMT 

Server: Oracle HTTP Server Powered by Apache/1.3.19 (Unix) mod_fastcgi/2.2.10 
mod_oprocmgr/1.0 mod_perl/1.25 

Content-Length: 4826 
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Set-Cookie: WF_WORKLIST_MODE=-1;path=/ 

Set-Cookie: bas112_vis11i=DECC7C3C58F62B42;path=/;domain=.compuware.com 

Connection: close 

Content-Type: text/html; charset=ISO-8859-1 

Sample: Modified Script  

Once the cookie is extracted and passed to the OFS middleware using the ofsSetICXTicket() script  
command, the script  should replay successful ly.  In  the example below, changes are in  bold. 
/* 
 *  sample_univicx.cpp 
 * 
 *  Script Converted on April 22, 2005 at 10:44:58 AM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 230 
 * 
 *  This script contains support for the following middlewares:  
 *      - Oracle Forms Server 
 *      - WWW 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Oracle Forms Server 
 *  Send (Forms 6i) heartbeat every  : 4 minutes 
 *  Simulate Oracle Application Login: No 
 *  Stop for server error messages   : Yes 
 *    Stop if server msg is matched  : No 
 * WWW 
 *  Form Field Comments              : No 
 *  Anchors as Comments              : No 
 *  Client Maps as Comments          : No 
 *  Debug Comments                   : No 
 *  Doc Title Verification           : Yes 
 *   Compare By                      : Entire Document Title 
 *  Baud Rate Emulation              : No 
 *  Enable Refresh                   : No 
 *  Encode DBCS Characters           : No 
 *  Cache                            : No 
 *  Dynamic Redirect                 : Yes 
 *  Dynamic Cookies                  : Yes 
 *  Process Subrequests              : Yes 
 *  Persistent Connections           : Yes 
 *  Max Concurrent Connection        : 2 
 *  Max Connection Retries           : 4 
 *  Server Response Timeout          : 120 
 *  HTTP Version Detection           : Auto 
 *  ActiveData                       : Yes 
 *  IPSpoofing                       : No 
 *  Streaming Media                  : No 
 *  Hostnames as IP Addresses        : No 
 *  Strip All Cookies From Requests  : No 
 *  Traffic Filters                  : No 
 */ 

#define SCRIPT_VER 0x00000205UL 

#include <stdio.h> 
#include "UniversalScript.h" 

#include "do_www.h" 
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extern "C" { 
#include "smacro.h" 
#include "do_OFS.h" 
} 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 
int i; 
char *Field[1]; 
char *Anchor[1]; 
char *ActionURL[1]; 
char *p;  
char ICX_Ticket[100]; 
char * pTicket; 
 
SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("sample_univicx.cpp"); 

ofsSetRunOptions( "6i", OFS_SOCKET, 4, OFS_CHECKMSGS ); 

for(i=0;i<1;i++) 
Field[i]=NULL; 

for(i=0;i<1;i++) 
Anchor[i]=NULL; 

for(i=0;i<1;i++) 
ActionURL[i]=NULL; 

DO_InitHttp(s_info); 
DO_SetTimeout(120); /* Maximum time to wait for an HTTP Reply */ 
DO_SaveReplyType("text/;application/x-javascript"); /* Save replies of these types */ 
 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 
DO_SetMaxBrowserThreads(2); 
DO_SetMaximumRetries(4); 
DO_UsePersistentConnections(TRUE); 
DO_AutomaticSubRequests(TRUE); 
DO_DynamicCookieHandling(TRUE); 
DO_DynamicRedirectHandling(TRUE); 
DO_Cache(FALSE);     /* Disable cache */ 
DO_HTTPVersion("Auto"); 
 
/* Request: 1  */ 
DO_SetCheckpointName("http://server:7779/ - chkpt:  1"); 
DO_Http("GET http://server:7779/ HTTP/1.0\r\n" 
        "Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, " 
        "application/vnd.ms-excel, application/vnd.ms-powerpoint, application/msword" 
        ", */*\r\n" 
        "Accept-Language: en-us\r\n" 
        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 
        "1.1.4322; .NET CLR 1.0.3705)\r\n\r\n" 
        ); 
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DO_VerifyDocTitle("Oracle9iAS - Welcome", TITLE); 
DO_GetAnchorHREF( "Forms 6i - Socket Mode with ICX Ticket;For Convert Option - " 
        "OracleAppsLogin: URL = " 
        "http://server2.com:8002/pls/vis11i/oraclemypage.home; LOGIN = " 
        "mfg/welcome; PORT = 9002", &Anchor[0]); 
 
 
/* Request: 2  To: Forms 6i - Socket Mode with ICX Ticket;For Convert Option -  
        OracleAppsLogin: URL =  
        http://server2.com:8002/pls/vis11i/oraclemypage.home; LOGIN = mfg/welcome; PORT = 
9002 From: Oracle9iAS - Welcome */ 
 
/*    Variable: Anchor000 links to: Forms 6i - Socket Mode with ICX Ticket;For Convert  
        Option - OracleAppsLogin: URL =  
        http://server2.com:8002/pls/vis11i/oraclemypage.home; LOGIN = mfg/welcome; PORT = 
9002 on page: Oracle9iAS - Welcome */ 
DO_SetValue("Anchor000", Anchor[0]); 
DO_SetCheckpointName("Forms 6i - Socket Mode with ICX Ticket;For Convert Option " 
        "- OracleAppsLogin: URL = " 
        "http://server2.com:8002/pls/vis11i/oraclemypage.home; LOGIN = " 
        "mfg/welcome; PORT = 9002 - chkpt:  2"); 
 
DO_Http("GET {*Anchor000} HTTP/1.0\r\n" 
        "Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, " 
        "application/vnd.ms-excel, application/vnd.ms-powerpoint, application/msword" 
        ", */*\r\n" 
        "Referer: http://server:7779/\r\n" 
        "Accept-Language: en-us\r\n" 
        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 
        "1.1.4322; .NET CLR 1.0.3705)\r\n\r\n" 
        ); 
DO_VerifyDocTitle("Oracle Applications Login", TITLE); 
DO_GetFormActionStatement(FORM(1), &ActionURL[0]); 
DO_GetFormValueByName(FORM(1), "hidden", "rmode", 1, &Field[0]); 
 
/* Request: 3  From: Oracle Applications Login */ 
DO_SetValue("action_statement0", ActionURL[0]); 
DO_SetValue("i_1", "mfg"); 
DO_SetValue("i_2", "welcome"); 
DO_SetValue("rmode", Field[0]); 
DO_SetValue("home_url", "" 
        "http%3A%2F%2Fserver2.com%3A8002%2FOA_HTML%2FUS%2FICXINDEX.htm" 
        ); 
 
DO_SetCheckpointName("http://server2.com:8002/pls/vis11i/oraclemypage.home " 
        "- chkpt:  3"); 
 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/toolbar_divider." 
        "gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/toolbar_icon_help." 
        "gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/toolbar_icon_help_active." 
        "gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/toolbar_icon_help_disabled." 
        "gif" 
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        ); 
DO_AdditionalSubRequest("http://server2.com:8002/OA_MEDIA/FNDEXIT.gif" 
        ); 
DO_AdditionalSubRequest("http://server2.com:8002/OA_MEDIA/FNDMANOP.gif" 
        ); 
DO_Http("POST {*action_statement0} HTTP/1.0\r\n" 
        "Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, " 
        "application/vnd.ms-excel, application/vnd.ms-powerpoint, application/msword" 
        ", */*\r\n" 
        "Referer: http://server2.com:8002/OA_HTML/US/ICXINDEX.htm\r\n" 
        "Accept-Language: en-us\r\n" 
        "Content-Type: application/x-www-form-urlencoded\r\n" 
        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 
        "1.1.4322; .NET CLR 1.0.3705)\r\n" 
        "Content-Length: {*content-length}\r\n" 
        "Pragma: no-cache\r\n\r\n{i_1}&{i_2}&{rmode}&{home_url}{*crnl}" 
        ); 

//--------------------------------------------------------- 
// Get the ICX Ticket from the HTTP headers of the response 
// to this WWW request.  Print out the value to verify the 
// value. 
//--------------------------------------------------------- 
p = DO_GetUniqueString( "bas112_vis11i=", ";" ); 
strcpy( ICX_Ticket, p ); 
pTicket=ICX_Ticket; 
RR__printf("*********************************************************************"); 
RR__printf("ICX_Ticket=\"%s\"\n", ICX_Ticket); 
RR__printf("*********************************************************************"); 

//--------------------------------------------------------- 
// Set the ICX ticket in the OFS middleware.  The ICX 
// ticket is used to replace the ticket contained in the 
// ofsInitSessionCmdLine() command. 
//--------------------------------------------------------- 
ofsSetICXTicket(&pTicket); 
 
/* Request: 4  */ 
DO_SetCheckpointName("http://server2.com:8002/ - chkpt:  4"); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/FNDLWAPP.gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/container_bottom_left." 
        "gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/container_bottom_right." 
        "gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/container_top_left_tabs." 
        "gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/container_top_right_tabs." 
        "gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/pixel_color3.gif" 
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        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/pixel_color4.gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/pixel_color6.gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/pixel_gray2.gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/pixel_gray5.gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/tab_edit_icon.gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/tab_left_non_selected." 
        "gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/tab_left_selected." 
        "gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/tab_right_non_selected." 
        "gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/tab_right_selected." 
        "gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/toolbar_left.gif" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_HTML/webtools/images/toolbar_right.gif" 
        ); 
DO_Http("GET http://server2.com:8002/ HTTP/1.0\r\n" 
        "Accept: */*\r\n" 
        "Referer: " 
        "http://server2.com:8002/pls/vis11i/oraclemypage.home\r\n" 
        "Accept-Language: en-us\r\n" 
        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 
        "1.1.4322; .NET CLR 1.0.3705)\r\n\r\n" 
        ); 
DO_VerifyDocTitle("Oracle Applications Rapid Install", TITLE); 
 
/* Request: 5  */ 
DO_SetValue("ICX_TICKET", ""); 
DO_SetValue("RESP_APP", "INV"); 
DO_SetValue("RESP_KEY", "INVENTORY"); 
DO_SetValue("SECGRP_KEY", "STANDARD"); 
DO_SetCheckpointName("" 
        "http://server2.com:8002/pls/vis11i/fnd_icx_launch.runforms - " 
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        "chkpt:  5"); 
 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_JAVA/java/awt/KeyboardFocusManager.class" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_JAVA/oracle/apps/fnd/jar/fndbalishare." 
        "jar" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_JAVA/oracle/ewt/lwAWT/BufferedAppletBeanInfo." 
        "class" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_JAVA/oracle/ewt/popup/PopupAppletBeanInfo." 
        "class" 
        ); 
DO_AdditionalSubRequest("" 

        "http://server2.com:8002/OA_JAVA/oracle/ewt/swing/JBufferedAppletBeanInfo." 
        "class" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_JAVA/oracle/forms/engine/MainBeanInfo." 
        "class" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_JAVA/sun/beans/infos/BufferedAppletBeanInfo." 
        "class" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_JAVA/sun/beans/infos/JBufferedAppletBeanInfo." 
        "class" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_JAVA/sun/beans/infos/MainBeanInfo.class" 
        ); 
DO_AdditionalSubRequest("" 

"http://server2.com:8002/OA_JAVA/sun/beans/infos/PopupAppletBeanInfo." 
        "class" 
        ); 
DO_Http("GET http://server2.com:8002/pls/vis11i/fnd_icx_launch.runforms?{ICX_TICKET}" 
        "&{RESP_APP}&{RESP_KEY}&{SECGRP_KEY} HTTP/1.0\r\n" 
        "Accept: */*\r\n" 
        "Accept-Language: en-us\r\n" 
        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 
        "1.1.4322; .NET CLR 1.0.3705)\r\n\r\n" 
        ); 
DO_VerifyDocTitle("Oracle Applications 11i", TITLE); 
 
/* Request: 6  */ 
DO_SetCheckpointName("" 
        "http://server2.com:8002/OA_JAVA/oracle/forms/registry/Registry." 
        "dat - chkpt:  6"); 
 
DO_Http("GET " 
        "http://server2.com:8002/OA_JAVA/oracle/forms/registry/Registry." 
        "dat HTTP/1.0\r\n" 
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        "User-Agent: Java1.1.8.16\r\n" 
        "Accept: text/html, image/gif, image/jpeg, *; q=.2, */*; q=.2\r\n\r\n" 
        ); 
 
/* Request: 7  */ 
DO_SetCheckpointName("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/fnd/formsClient/OracleApplications." 
        "dat - chkpt:  7"); 
 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afapps.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afattach.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afclps.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afclpsa.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afclrall.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afclrrw.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afclsfrm.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afcopy.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afcut.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afdelrw.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afedit.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/affind.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/affldtls.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afhelp.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afinsrw.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/aflleft.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/aflright.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afnav.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afnavig.gif" 
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        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afnxtstp.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afpaste.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afprint.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afrsp115.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afsave.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/aftrans.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afxpnd.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afxpnda.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afxpndc.gif" 
        ); 
DO_AdditionalSubRequest("" 
        "http://server2.com:8002/OA_JAVA/oracle/apps/media/afzoom.gif" 
        ); 
DO_Http("GET " 
        "http://server2.com:8002/OA_JAVA/oracle/apps/fnd/formsClient/OracleApplications." 
        "dat HTTP/1.0\r\n" 
        "User-Agent: Java1.1.8.16\r\n" 
        "Accept: text/html, image/gif, image/jpeg, *; q=.2, */*; q=.2\r\n\r\n" 
        ); 
ofsConnectToSocket("10.10.0.167", 9002 ); 
ofsSetInitialVersion( "RUNFORM", 1, OFS_ADD, 268, "60818" ); 
ofsSetScreenResolution( "RUNFORM", 1, OFS_ADD, 263, 96, 96); 
ofsSetDisplaySize( "RUNFORM", 1, OFS_ADD, 264, 1280, 1024); 
 
/***** WARNING ***** 
  icx_ticket found in INITIAL_CMDLINE. Add ofsSetICXTicket() or OracleAppsLogin(). 
 *****/ 
ofsInitSessionCmdLine("RUNFORM", 1, OFS_ADD, 265,  
 "server module=/oracle/appl/vis11iappl/fnd/11.5.0/forms/US/FNDSCSGN userid=APPLS" 
 "YSPUB/PUB@vis11i fndnam=APPS  config='bas112_vis11i' icx_ticket='.903869489' re" 
 "sp='INV/INVENTORY' secgrp='STANDARD' " 
); 
ofsSetColorDepth( "RUNFORM", 1, OFS_ADD, 266, "256" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "0" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "255" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "65535" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "4210752" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "8421504" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "65280" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "12632256" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16711935" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16762880" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16756655" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16711680" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16777215" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16776960" ); 
ofsSetFontName( "RUNFORM", 1, OFS_ADD, 383, "Dialog" ); 
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ofsSetFontSize( "RUNFORM", 1, OFS_ADD, 377, "900" ); 
ofsSetFontStyle( "RUNFORM", 1, OFS_ADD, 378, "0" ); 
ofsSetFontWeight( "RUNFORM", 1, OFS_ADD, 379, "0" ); 
ofsSetScaleInfo( "RUNFORM", 1, OFS_ADD, 267, 9, 18); 
ofsSetRequiredVAList( "RUNFORM", 1, OFS_ADD, 291 ); 
ofsSetPropertyString("RUNFORM", 1, OFS_ADD, 510,  
 "NLS_LANG='AMERICAN_AMERICA.WE8ISO8859P1' FORMS60_USER_DATE_FORMAT=" 
        "'DD-MON-RRRR'" 
 " FORMS60_USER_DATETIME_FORMAT='DD-MON-RRRR HH24:MI:SS' NLS_DATE_LANGUAGE='AMERI" 
 "CAN' NLS_SORT='BINARY' NLS_NUMERIC_CHARACTERS='.,'" 
); 
ofsInitSessionTimeZone( "RUNFORM", 1, OFS_ENDMSG, 527, "EST" ); 
ofsSendRecv(1); //ClientSeqNo=1|MsgCount=1|1114181041.445 
 
ofsSetWindowLocation( "FORMWINDOW", 6, OFS_ENDMSG, 135, 0, 0); 
ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 250, 120); 
ofsSetWindowLocation( "Object Properties", 11, OFS_ENDMSG, 135, 307, 269); 
ofsSetWindowLocation( "Progress", 15, OFS_ENDMSG, 135, 288, 336); 
ofsSetWindowLocation( "Rename Label", 20, OFS_ENDMSG, 135, 192, 192); 
ofsSetWindowLocation( "Launch", 24, OFS_ENDMSG, 135, 192, 192); 
ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 250, 120); 
ofsSetPropertyInteger( "CUSTOMCONTROL", 54, OFS_ADD, 1, "21002" ); 
ofsSetPropertyInteger( "CUSTOMCONTROL", 54, OFS_ADD, 1, "0" ); 
ofsSetPropertyStringArray( "CUSTOMCONTROL", 54, OFS_ENDMSG, 1, "0" ); 
ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 1280, 1024); 
ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 1280, 1024); 
ofsSendRecv(1); //ClientSeqNo=2|MsgCount=10|1114181041.445 
 
ofsSendRecv(2); //ClientSeqNo=3|MsgCount=0|1114181041.633 
 
ofsSendRecv(2); //ClientSeqNo=4|MsgCount=0|1114181043.961 
 
ofsSetSelection( "TEXTFIELD", 89, OFS_ADD, 195, 0, 0); 
ofsSetCursorPosition( "TEXTFIELD", 89, OFS_ENDMSG, 193, "0" ); 
ofsSetWindowSize( "NAVIGATOR", 28, OFS_ENDMSG, 137, 670, 432); 
ofsSetWindowSize( "NAVIGATOR", 28, OFS_ENDMSG, 137, 670, 600); 
ofsSetWindowLocation( "NAVIGATOR", 28, OFS_ENDMSG, 135, 55, 0); 
ofsSetWindowLocation( "NAVIGATOR", 28, OFS_ENDMSG, 135, 55, 46); 
ofsShowWindow( "NAVIGATOR", 28, OFS_ENDMSG, 173 ); 
ofsActivateWindow( "NAVIGATOR", 28, OFS_ENDMSG, 247 ); 
ofsFocus( "TEXTFIELD", 89, OFS_ENDMSG, 174 ); 
ofsSendRecv(2); //ClientSeqNo=5|MsgCount=8|1114181044.258 
 
ofsSendRecv(2); //ClientSeqNo=6|MsgCount=0|1114181045.305 
 
ofsSetSelection( "TEXTFIELD", 89, OFS_ENDMSG, 195, 0, 0); 
ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 1280, 1024); 
ofsSendRecv(1); //ClientSeqNo=7|MsgCount=2|1114181045.320 
 
ofsRemoveFocus( "TEXTFIELD", 89, OFS_ENDMSG, 174 ); 
ofsFocus( "TLIST", 95, OFS_ENDMSG, 174 ); 
ofsSendRecv(1); //ClientSeqNo=8|MsgCount=2|1114181058.445 
 
 
DO_SLEEP(13); 
ofsListItemValue( "TLIST", 95, OFS_ENDMSG, 131, "0" );  /*Item value = 1. View Quantities  
        On-hand*/ 
 
ofsSendRecv(1); //ClientSeqNo=9|MsgCount=1|1114181058.555 
 
ofsRemoveFocus( "TLIST", 95, OFS_ENDMSG, 174 ); 
ofsFocus( "TEXTFIELD", 89, OFS_ENDMSG, 174 ); 
ofsSendRecv(1); //ClientSeqNo=10|MsgCount=2|1114181058.664 
 
ofsRemoveFocus( "TEXTFIELD", 89, OFS_ENDMSG, 174 ); 
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ofsFocus( "TLIST", 95, OFS_ENDMSG, 174 ); 
ofsActivateListItem( "TLIST", 95, OFS_ENDMSG, 341, "0" ); 
ofsSendRecv(1); //ClientSeqNo=11|MsgCount=3|1114181060.086 
 
ofsRemoveFocus( "TLIST", 95, OFS_ENDMSG, 174 ); 
ofsFocus( "TEXTFIELD", 89, OFS_ENDMSG, 174 ); 
ofsSendRecv(2); //ClientSeqNo=12|MsgCount=2|1114181060.492 
 
ofsSetSelection( "TEXTFIELD", 269, OFS_ADD, 195, 0, 0); 
ofsSetCursorPosition( "TEXTFIELD", 269, OFS_ENDMSG, 193, "0" ); 
ofsRemoveFocus( "TEXTFIELD", 89, OFS_ENDMSG, 174 ); 
ofsFocus( "TEXTFIELD", 269, OFS_ENDMSG, 174 ); 
ofsDeActivateWindow( "Find On_hand Quantities", 161, OFS_ENDMSG, 247 ); 
ofsSendRecv(2); //ClientSeqNo=13|MsgCount=4|1114181060.695 
 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 1, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 2, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 3, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 4, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 5, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 6, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 7, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 8, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 9, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 10, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 11, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 12, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 13, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 14, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 15, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 16, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 17, 1); 
ofsLOVRequestRow( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 451, 18, 1); 
ofsSendRecv(1); //ClientSeqNo=14|MsgCount=18|1114181061.289 
 
ofsSetWindowLocation( "Object Properties", 124, OFS_ENDMSG, 135, 307, 269); 
ofsSetWindowLocation( "Sort Data", 128, OFS_ENDMSG, 135, 307, 269); 
ofsSetWindowLocation( "Calendar", 132, OFS_ENDMSG, 135, 96, 96); 
ofsSetWindowLocation( "Progress", 136, OFS_ENDMSG, 135, 288, 336); 
ofsSetWindowLocation( "Autosize All", 141, OFS_ENDMSG, 135, 307, 269); 
ofsSetWindowLocation( "Folder Query", 145, OFS_ENDMSG, 135, 240, 216); 
ofsSetWindowLocation( "Save Folder", 149, OFS_ENDMSG, 135, 269, 307); 
ofsSetWindowLocation( "Change Prompt", 153, OFS_ENDMSG, 135, 269, 326); 
ofsSetWindowLocation( "Folder Tools", 157, OFS_ENDMSG, 135, 240, 144); 
ofsSendRecv(1); //ClientSeqNo=15|MsgCount=9|1114181061.289 
 
ofsActivateWindow( "Find On_hand Quantities", 161, OFS_ENDMSG, 247 ); 
ofsLOVSelection( "LISTVALUESDIALOG", 274, OFS_ENDMSG, 450, "3" ); 
ofsSendRecv(1); //ClientSeqNo=16|MsgCount=2|1114181065.758 
 
 
DO_SLEEP(4); 
 
DO_SLEEP(7); 
ofsSendRecv(2); //ClientSeqNo=17|MsgCount=0|1114181075.195 
 
ofsSetSelection( "TEXTFIELD", 269, OFS_ADD, 195, 0, 3); 
ofsSetCursorPosition( "TEXTFIELD", 269, OFS_ENDMSG, 193, "3" ); 
ofsSetWindowLocation( "Item On_hand Quantities", 173, OFS_ENDMSG, 135, 29, 29); 
 
ofsSetWindowLocation( "Revision On_hand Quantities", 177, OFS_ENDMSG, 135, 58,  
        58); 
 
ofsSetWindowLocation( "Subinventory On_hand Quantities", 181, OFS_ENDMSG, 135, 87 
        , 87); 
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ofsSetWindowLocation( "Detailed On_hand Quantities", 185, OFS_ENDMSG, 135, 116,  
        116); 
 
ofsSetWindowLocation( "Lot On_hand Quantities", 169, OFS_ENDMSG, 135, 145, 145); 
 
ofsSetWindowLocation( "Serial On_hand Quantities", 165, OFS_ENDMSG, 135, 174,  
        174); 
 
ofsCloseWindow( "Find On_hand Quantities", 161, OFS_ENDMSG, 216 ); 
 
DO_SLEEP(2); 
ofsSendRecv(1); //ClientSeqNo=18|MsgCount=8|1114181077.570 
 
ofsFocus( "BUTTON", 73, OFS_ENDMSG, 174 ); 
ofsActivateWindow( "NAVIGATOR", 28, OFS_ENDMSG, 247 ); 
ofsRemoveFocus( "BUTTON", 73, OFS_ENDMSG, 174 ); 
ofsFocus( "TEXTFIELD", 89, OFS_ENDMSG, 174 ); 
 
DO_SLEEP(1); 
ofsSendRecv(1); //ClientSeqNo=19|MsgCount=4|1114181078.930 
 
ofsCloseWindow( "NAVIGATOR", 28, OFS_ENDMSG, 216 ); 
ofsSendRecv(1); //ClientSeqNo=20|MsgCount=1|1114181080.102 
 
ofsDeActivateWindow( "NAVIGATOR", 28, OFS_ENDMSG, 247 ); 
ofsSendRecv(1); //ClientSeqNo=21|MsgCount=1|1114181080.102 
 
 
DO_SLEEP(1); 
ofsSetPropertyInteger( "CUSTOMCONTROL", 293, OFS_ADD, 1, "20002" ); 
ofsSetPropertyInteger( "CUSTOMCONTROL", 293, OFS_ENDMSG, 1, "0" ); 
ofsSendRecv(1); //ClientSeqNo=22|MsgCount=1|1114181080.680 
 
ofsActivateWindow( "NAVIGATOR", 28, OFS_ENDMSG, 247 ); 
ofsSendRecv(2); //ClientSeqNo=23|MsgCount=1|1114181080.867 
 
ofsSetPropertyInteger( "FORMWINDOW", 6, OFS_ENDMSG, 130, "1" ); 
ofsSendRecv(3); //ClientSeqNo=24|MsgCount=1|1114181080.867 
 
ofsSocketDisconnect(); 
 
DO_SetTransactionCleanup(); 
/* Clear up some internal storage used for DO_SetValue() */ 
DO_HttpCleanup(); 
for(i=0; i<1; i++) 
{ 
free(Field[i]); 
Field[i]=NULL; 
} 
for(i=0; i<1; i++) 
{ 
free(Anchor[i]); 
Anchor[i]=NULL; 
} 
for(i=0; i<1; i++) 
{ 
free(ActionURL[i]); 
ActionURL[i]=NULL; 
} 
 
END_TRANSACTION(); 
DO_FreeHttp(); 
 
EXIT(); 
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return(0); 
} 

void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
DO_FreeHttp(); 
 
EXIT(); 

} 

 

Using HTTP Cookies and ICX Tickets in an OFS Script 

Using HTTP Cook ies and ICX Tickets i n  an  OFS Script   

Some Oracle Forms environments use a unique cookies to ident i fy sessions requiring changes to be made 
to the QALoad script  in  order to replay successful ly. 

Script ing 

In cases l ike these, QALoad Universal scripts need to be modified to extract the ICX t icket and any other 
required cookies from WWW middleware traffic and to pass them to the OFS middleware. 

Example 

The fol lowing is a script  sample of a Universal session WWW/OFS script  test ing an Oracle Forms 6i 
environment (servlet mode) where an ICX Ticket cookie needs to be retrieved from the WWW command 
and used in an OFS command later in  the script .  

This server environment has two cookies that must be retrieved from the WWW traffic in  order to pass i t  
in to the OFS middleware: JServSessionIdrootbas114 and nvis510.  Once these cookies are extracted and 
passed to the OFS middleware, the script  should replay successful ly.   

In  the example below, changes are  shown in bold. 

/ * 

 *  This script is a sample Universal OFS (Servlet mode) / WWW script 

 *  that shows examples of setting cookies and setting the ICX ticket. 

 * 

 *  This script contains support for the following middlewares:  

 *      - Oracle Forms Server 

 *      - WWW 

 */ 

/* Converted using the following options: 

 * General: 

 *  Line Split                       : 80 characters 

 *  Sleep Seconds                    : 1 

 *  Auto Checkpoints                 : No 

 * Oracle Forms Server 

 *  Simulate Oracle Application Login: No 

 *  Stop for server error messages   : Yes 

 *    Stop if server msg is matched  : No 

 * WWW 
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 *  Form Field Comments              : No 

 *  Anchors as Comments              : No 

 *  Client Maps as Comments          : No 

 *  Debug Comments                   : No 

 *  Doc Title Verification           : Yes 

 *   Compare By                      : Entire Document Title 

 *  Baud Rate Emulation              : No 

 *  Enable Refresh                   : No 

 *  Represent CJK as Octal Characters: No 

 *  Cache                            : No 

 *  Dynamic Redirect                 : No 

 *  Dynamic Cookies                  : Yes 

 *  Process Subrequests              : Yes 

 *  Persistent Connections           : Yes 

 *  Reuse SSL Session ID             : Yes 

 *  Max Concurrent Connection        : 2 

 *  Max Connection Retries           : 4 

 *  Server Response Timeout          : 120 

 *  HTTP Version                     : 1.1 

 *  Proxy HTTP Version               : 1.0 

 *  ActiveData                       : Yes 

 *  IPSpoofing                       : No 

 *  Streaming Media                  : No 

 *  Hostnames as IP Addresses        : No 

 *  Strip All Cookies From Requests  : No 

 *  Traffic Filters                  : No 

 */ 

#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 

#include "UniversalScript.h" 

#include "do_www.h" 

extern "C" { 

#include "smacro.h" 

#include "do_OFS.h" 

} 

/* set function to call on abort*/ 

void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 

#define NULL  0 

#endif 
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extern "C" int rhobot_script(PLAYER_INFO *s_info) 

{ 

/* Declare Variables */ 

int i; 

char *Field[3]; 

char *Anchor[2]; 

char *ActionURL[1]; 

//----------------------------------------------------------------------------- 

// Variable declarations 

//----------------------------------------------------------------------------- 

char *sessionid = NULL; // JServSessionIdbas114 cookie 

char *nvis510 = NULL; // nvis510 cookie 

char *cookieHeaderValue = NULL; // combined cookie 

char *icx_ticket = NULL; 

char buf[512]; // used for formatting of cmdline, 

//  URL parameters  

 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("sample_cookiesandicxticket.cpp"); 

ofsSetRunOptions(FORMS_6i_11i_SERVLET, OFS_HTTP, 4, OFS_CHECKMSGS); 

for(i=0;i<3;i++) 

Field[i]=NULL; 

for(i=0;i<2;i++) 

Anchor[i]=NULL; 

for(i=0;i<1;i++) 

ActionURL[i]=NULL; 

DO_InitHttp(s_info); 

DO_SetTimeout(120); /* Maximum time to wait for an HTTP Reply */ 

DO_SaveReplyType("text/;application/x-javascript"); /* Save replies of these types */ 

SET_SCRIPT_LANGUAGE(SLID_English); 

 

SYNCHRONIZE(); 

/* Select following statement for reuse of Session ID with SSL */ 

/* If session ID needs only to be reused within a transaction, insert */ 

/* after the BEGIN_TRANSACTION statement */ 

/* DO_SSLReuseSession(TRUE); */ 

 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 
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DO_SetMaxBrowserThreads(2); 

DO_SetMaximumRetries(4); 

DO_UsePersistentConnections(TRUE); 

DO_AutomaticSubRequests(TRUE); 

DO_DynamicCookieHandling(TRUE); 

DO_DynamicRedirectHandling(FALSE); 

DO_Cache(FALSE);     /* Disable cache */ 

DO_HTTPVersion("1.1"); 

DO_ProxyHTTPVersion("1.0"); 

 

 

/* Request: 1  */ 

DO_Http("GET http://server.company.com:8060/oa_servlets/AppsLogin HTTP/1.0\r\n" 

        "Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, " 

        "application/vnd.ms-excel, application/vnd.ms-powerpoint, application/msword" 

        ", */*\r\n" 

        "Accept-Language: en-us\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n\r\n" 

        ); 

 

/* Request: 2  */ 

DO_SetValue("requestUrl", "APPSHOMEPAGE"); 

DO_SetValue("cancelUrl", "" 

        "http%3A%2F%2Fserver.company.com%3A8060%2Foa_servlets%2Foracle.apps.fnd." 

        "sso.AppsLogin"); 

 

DO_Http("GET http://server.company.com:8060/OA_HTML/AppsLocalLogin.jsp?{requestUrl}" 

        "&{cancelUrl} HTTP/1.0\r\n" 

        "Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, " 

        "application/vnd.ms-excel, application/vnd.ms-powerpoint, application/msword" 

        ", */*\r\n" 

        "Accept-Language: en-us\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n\r\n" 

        ); 

DO_VerifyDocTitle("Login", TITLE); 

DO_GetFormActionStatement(FORM(1), &ActionURL[0]); 

DO_GetFormValueByName(FORM(1), "hidden", "langCode", 1, &Field[0]); 

DO_GetFormValueByName(FORM(1), "hidden", "cancelUrl", 1, &Field[1]); 

DO_GetFormValueByName(FORM(1), "hidden", "requestUrl", 1, &Field[2]); 
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/* Request: 3  */ 

DO_Http("GET http://server.company.com:8060/OA_HTML/cabo/images/cache/cghec.gif " 

        "HTTP/1.0\r\n" 

        "Accept: */*\r\n" 

        "Referer: http://server.company.com:8060/OA_HTML/AppsLocalLogin.jsp?requestUrl=" 

        "APPSHOMEPAGE&cancelUrl=" 

        "http%3A%2F%2Fserver.company.com%3A8060%2Foa_servlets%2Foracle.apps.fnd." 

        "sso.AppsLogin\r\n" 

        "Accept-Language: en-us\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n\r\n" 

        ); 

 

DO_SLEEP(8); 

 

/* Request: 4  */ 

DO_SetValue("action_statement0", ActionURL[0]); 

DO_SetValue("username", "operations"); 

DO_SetValue("password", "welcome"); 

DO_SetValue("langCode", Field[0]); 

DO_SetValue("cancelUrl", Field[1]); 

DO_SetValue("requestUrl", Field[2]); 

DO_Http("POST {*action_statement0} HTTP/1.0\r\n" 

        "Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, " 

        "application/vnd.ms-excel, application/vnd.ms-powerpoint, application/msword" 

        ", */*\r\n" 

        "Referer: http://server.company.com:8060/OA_HTML/AppsLocalLogin.jsp?requestUrl=" 

        "APPSHOMEPAGE&cancelUrl=" 

        "http%3A%2F%2Fserver.company.com%3A8060%2Foa_servlets%2Foracle.apps.fnd." 

        "sso.AppsLogin\r\n" 

        "Accept-Language: en-us\r\n" 

        "Content-Type: application/x-www-form-urlencoded\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n" 

        "Content-Length: {*content-length}\r\n" 

        "Pragma: no-
cache\r\n\r\n{username}&{password}&{langCode}&{cancelUrl}&{requestUrl}" 

        ); 

 

//----------------------------------------------------------------------------- 
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// There are a couple of cookies that need to be extracted from the response 

// to the POST request done for the login.  In this case there are two cookies 

// (JServSessionIdrootbas114 and nvis510) that need to be combined into  

// a single cookie header in the format "Set-Cookie: name=value; name=value". 

// The resulting string is stored in cookieHeaderValue which is used later. 

//----------------------------------------------------------------------------- 

//RR__printf("REPLY: %s\n", DO_GetReplyBuffer()); 

sessionid = (char *)malloc(128); 

memset(sessionid, 0, 128); 

strcpy(sessionid, "JServSessionIdrootbas114="); 

strcat(sessionid, DO_GetUniqueString("Set-Cookie: JServSessionIdrootbas114=", ";")); 

// RR__printf("COOKIE: %s", sessionid); 

nvis510 = (char *)malloc(128); 

memset(nvis510, 0, 128); 

strcpy(nvis510, "nvis510="); 

strcat(nvis510, DO_GetUniqueString("Set-Cookie: nvis510=", ";")); 

// RR__printf("COOKIE: %s", nvis510); 

cookieHeaderValue = (char *)malloc(512); 

memset(cookieHeaderValue, 0, 512); 

strcpy(cookieHeaderValue, sessionid); 

strcat(cookieHeaderValue, "; "); 

strcat(cookieHeaderValue, nvis510); 

//RR__printf("COOKIE: %s", cookieHeaderValue); 

DO_SLEEP(9); 

 

/* Request: 5  */ 

DO_SetValue("OAFunc", "OAHOMEPAGE"); 

DO_Http("GET http://server.company.com:8060/OA_HTML/OA.jsp?{OAFunc} " 

        "HTTP/1.0\r\n" 

        "Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, " 

        "application/vnd.ms-excel, application/vnd.ms-powerpoint, application/msword" 

        ", */*\r\n" 

  "Referer: http://server.company.com:8060/OA_HTML/AppsLocalLogin.jsp?requestUrl=" 

        "APPSHOMEPAGE&cancelUrl=" 

"http%3A%2F%2Fserver.company.com%3A8060%2Foa_servlets%2Foracle.apps.fnd." 

        "sso.AppsLogin\r\n" 

        "Accept-Language: en-us\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n" 

        "Pragma: no-cache\r\n\r\n" 
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        ); 

DO_VerifyDocTitle("Oracle Applications Home Page", TITLE); 

DO_GetAnchorHREF( "Interaction History JSP Admin", &Anchor[0]); 

 

/* Request: 6  From: Oracle Applications Home Page */ 

DO_Http("GET http://server.company.com:8060/OA_HTML/cabo/images/cache/cghec.gif " 

        "HTTP/1.0\r\n" 

        "Accept: */*\r\n" 

        "Referer: http://server.company.com:8060/OA_HTML/OA.jsp?OAFunc=" 

        "OAHOMEPAGE\r\n" 

        "Accept-Language: en-us\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n" 

        "Cookie:  oracle.uix=0^^^^GMT-4:00; \r\n\r\n" 

        ); 

 

DO_SLEEP(18); 

 

/* Request: 7  To: Interaction History JSP Admin From: Oracle Applications Home  

        Page */ 

 

 

/*    Variable: Anchor000 links to: Interaction History JSP Admin on page: Oracle  

        Applications Home Page */ 

 

DO_SetValue("Anchor000", Anchor[0]); 

DO_Http("GET {*Anchor000} HTTP/1.0\r\n" 

        "Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, " 

        "application/vnd.ms-excel, application/vnd.ms-powerpoint, application/msword" 

        ", */*\r\n" 

        "Referer: http://server.company.com:8060/OA_HTML/OA.jsp?OAFunc=" 

        "OAHOMEPAGE\r\n" 

        "Accept-Language: en-us\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n" 

        "Cookie:  oracle.uix=0^^^^GMT-4:00; \r\n\r\n" 

        ); 

DO_VerifyDocTitle("Oracle Applications Home Page", TITLE); 

DO_GetAnchorHREF( "Inventory, Vision Operations (USA)", &Anchor[1]); 

 

/* Request: 8  From: Oracle Applications Home Page */ 
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DO_Http("GET http://server.company.com:8060/OA_HTML/cabo/images/cache/cghec.gif " 

        "HTTP/1.0\r\n" 

        "Accept: */*\r\n" 

        "Referer: http://server.company.com:8060/OA_HTML/OA.jsp?OAFunc=" 

        "OAHOMEPAGE&akRegionApplicationId=0&navRespId=23216&navRespAppId=690&navSecGrpId=" 

        "0&transactionid=1703444656&oapc=2&oas=EltFim-hJGa3FZYVV1DbQg..\r\n" 

        "Accept-Language: en-us\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n" 

        "Cookie:  oracle.uix=0^^^^GMT-4:00; \r\n\r\n" 

        ); 

 

DO_SLEEP(9); 

 

/* Request: 9  To: Inventory, Vision Operations (USA) From: Oracle Applications  

        Home Page */ 

 

 

/*    Variable: Anchor001 links to: Inventory, Vision Operations (USA) on page:  

        Oracle Applications Home Page */ 

 

DO_SetValue("Anchor001", Anchor[1]); 

DO_Http("GET {*Anchor001} HTTP/1.0\r\n" 

        "Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, " 

        "application/vnd.ms-excel, application/vnd.ms-powerpoint, application/msword" 

        ", */*\r\n" 

        "Referer: http://server.company.com:8060/OA_HTML/OA.jsp?OAFunc=" 

        "OAHOMEPAGE&akRegionApplicationId=0&navRespId=23216&navRespAppId=690&navSecGrpId=" 

        "0&transactionid=1703444656&oapc=2&oas=EltFim-hJGa3FZYVV1DbQg..\r\n" 

        "Accept-Language: en-us\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n" 

        "Cookie:  oracle.uix=0^^^^GMT-4:00; \r\n\r\n" 

        ); 

DO_VerifyDocTitle("Oracle Applications Home Page", TITLE); 

 

/* Request: 10  From: Oracle Applications Home Page */ 

DO_Http("GET http://server.company.com:8060/OA_HTML/cabo/images/cache/cghec.gif " 

        "HTTP/1.0\r\n" 

        "Accept: */*\r\n" 

        "Referer: http://server.company.com:8060/OA_HTML/OA.jsp?OAFunc=" 
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        "OAHOMEPAGE&akRegionApplicationId=0&navRespId=50583&navRespAppId=401&navSecGrpId=" 

        "0&transactionid=1703444656&oapc=3&oas=uO79v_OeLsXVyAHNb2CnuQ..\r\n" 

        "Accept-Language: en-us\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n" 

        "Cookie:  oracle.uix=0^^^^GMT-4:00; \r\n\r\n" 

        ); 

 

DO_SLEEP(10); 

 

/* Request: 11  From: Oracle Applications Home Page */ 

DO_SetValue("function_id", "1006901"); 

DO_SetValue("resp_id", "50583"); 

DO_SetValue("resp_appl_id", "401"); 

DO_SetValue("security_group_id", "0"); 

DO_SetValue("lang_code", "US"); 

DO_SetValue("oas", "cmiXz7a5U71yEfvDNQpeyQ.."); 

DO_SetValue("formsLink", "yes"); 

DO_Http("GET http://server.company.com:8060/OA_HTML/RF.jsp?{function_id}&{resp_id}" 

        "&{resp_appl_id}&{security_group_id}&{lang_code}&{oas}&{formsLink} " 

        "HTTP/1.0\r\n" 

        "Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, " 

        "application/vnd.ms-excel, application/vnd.ms-powerpoint, application/msword" 

        ", */*\r\n" 

        "Referer: http://server.company.com:8060/OA_HTML/OA.jsp?OAFunc=" 

        "OAHOMEPAGE&akRegionApplicationId=0&navRespId=50583&navRespAppId=401&navSecGrpId=" 

        "0&transactionid=1703444656&oapc=3&oas=uO79v_OeLsXVyAHNb2CnuQ..\r\n" 

        "Accept-Language: en-us\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n" 

        "Cookie:  oracle.uix=0^^^^GMT-4:00; \r\n\r\n" 

        ); 

 

DO_SLEEP(1); 

 

/* Request: 12  From: Oracle Applications Home Page */ 

DO_SetValue("resp_app", "INV"); 

DO_SetValue("resp_key", "INVENTORY_VISION_OPERATIONS"); 

DO_SetValue("secgrp_key", "STANDARD"); 

DO_SetValue("start_func", "INV_INVMATWB"); 

DO_SetValue("other_params", ""); 
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DO_Http("GET http://server.company.com:8060/pls/nvis510/fnd_icx_launch.launch?{resp_app}" 

        "&{resp_key}&{secgrp_key}&{start_func}&{other_params} HTTP/1.0\r\n" 

        "Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, " 

        "application/vnd.ms-excel, application/vnd.ms-powerpoint, application/msword" 

        ", */*\r\n" 

        "Referer: http://server.company.com:8060/OA_HTML/OA.jsp?OAFunc=" 

        "OAHOMEPAGE&akRegionApplicationId=0&navRespId=50583&navRespAppId=401&navSecGrpId=" 

        "0&transactionid=1703444656&oapc=3&oas=uO79v_OeLsXVyAHNb2CnuQ..\r\n" 

        "Accept-Language: en-us\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n" 

        "Cookie:  oracle.uix=0^^^^GMT-4:00; \r\n\r\n" 

        ); 

 

/* Request: 13  From: Oracle Applications Home Page */ 

DO_SetValue("appletmode", "nonforms"); 

DO_SetValue("HTMLpageTitle", ""); 

DO_SetValue("HTMLpreApplet", ""); 

DO_SetValue("code", "oracle/apps/fnd/formsClient/FormsLauncher.class"); 

DO_SetValue("width", "400"); 

DO_SetValue("height", "100"); 

DO_SetValue("archive", "/OA_JAVA/oracle/apps/fnd/jar/fndforms.jar" 

        ",/OA_JAVA/oracle/apps/fnd/jar/fndformsi18n.jar" 

        ",/OA_JAVA/oracle/apps/fnd/jar/fndewt.jar" 

        ",/OA_JAVA/oracle/apps/fnd/jar/fndswing.jar" 

        ",/OA_JAVA/oracle/apps/fnd/jar/fndbalishare.jar" 

        ",/OA_JAVA/oracle/apps/fnd/jar/fndaol.jar" 

        ",/OA_JAVA/oracle/apps/fnd/jar/fndctx.jar" 

        ",/OA_JAVA/oracle/apps/fnd/jar/fndlist.jar"); 

 

DO_SetValue("gp14", "jinit_appletcache"); 

DO_SetValue("gv14", "offjinit_appletcache=off"); 

DO_SetValue("gp2", "resp_app"); 

DO_SetValue("gv2", "INV"); 

DO_SetValue("gp3", "resp"); 

DO_SetValue("gv3", "INVENTORY_VISION_OPERATIONS"); 

DO_SetValue("gp4", "sec_group"); 

DO_SetValue("gv4", "STANDARD"); 

DO_SetValue("gp5", "function"); 

DO_SetValue("gv5", "INV_INVMATWB"); 

DO_SetValue("gp6", "other_params"); 
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DO_SetValue("gv6", ""); 

DO_SetValue("gp7", "forms_url"); 

DO_SetValue("gv7", "" 

        "http%3A%2F%2Fserver.company.com%3A8060%2Fpls%2Fnvis510%2Ffnd_icx_launch." 

        "runforms%3FICX_TICKET%3D%26resp_app%3DINV%26resp_key%3DINVENTORY_VISION_OPERATIONS%
" 

        "26secgrp_key%3DSTANDARD%26start_func%3DINV_INVMATWB%26other_params%3D" 

        ); 

 

DO_SetValue("encoding", "UTF-8"); 

DO_SetValue("gp8", "error_url"); 

DO_SetValue("gv8", "" 

        "http%3A%2F%2Fserver.company.com%3A8060%2FOA_HTML%2Fjsp%2Ffnd%2Ffnderror." 

        "jsp%3Fdbc%3Dnvis510"); 

 

DO_SetValue("gp12", "port"); 

DO_SetValue("gv12", "6945"); 

DO_SetValue("gp13", "dbc"); 

DO_SetValue("gv13", "nvis510"); 

DO_SetValue("gp15", "icx_ticket"); 

DO_SetValue("gv15", "614175610"); 

DO_Http("GET http://server.company.com:8060/dev60cgi/f60cgi?&{appletmode}&{HTMLpageTitle}" 

        "&{HTMLpreApplet}&{code}&{width}&{height}&{archive}&{gp14}&{gv14}&{gp2}&{gv2}" 

        "&{gp3}&{gv3}&{gp4}&{gv4}&{gp5}&{gv5}&{gp6}&{gv6}&{gp7}&{gv7}&{encoding}" 

        "&{gp8}&{gv8}&{gp12}&{gv12}&{gp13}&{gv13}&{gp15}&{gv15} HTTP/1.0\r\n" 

        "Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, " 

        "application/vnd.ms-excel, application/vnd.ms-powerpoint, application/msword" 

        ", */*\r\n" 

        "Referer: http://server.company.com:8060/OA_HTML/OA.jsp?OAFunc=" 

        "OAHOMEPAGE&akRegionApplicationId=0&navRespId=50583&navRespAppId=401&navSecGrpId=" 

        "0&transactionid=1703444656&oapc=3&oas=uO79v_OeLsXVyAHNb2CnuQ..\r\n" 

        "Accept-Language: en-us\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n" 

        "Cookie:  oracle.uix=0^^^^GMT-4:00; \r\n\r\n" 

        ); 

 

/* Request: 14  */ 

DO_Http("GET " 

        "http://server.company.com:8060/OA_JAVA/java/awt/KeyboardFocusManager." 

        "class HTTP/1.0\r\n" 



QALoad Online Help 

317 

        "Accept: */*\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n" 

        "Cookie:  oracle.uix=0^^^^GMT-4:00; \r\n\r\n" 

        ); 

DO_VerifyDocTitle("403 Forbidden", TITLE); 

 

/* Request: 15  */ 

DO_Http("GET " 

        "http://server.company.com:8060/OA_JAVA/java/awt/KeyboardFocusManager." 

        "class HTTP/1.1\r\n" 

        "cookie:  oracle.uix=0^^^^GMT-4:00; \r\n" 

        "User-Agent: Java1.3.1.18-internal\r\n" 

        "Accept: text/html, image/gif, image/jpeg, *; q=.2, */*; q=.2\r\n\r\n" 

        ); 

DO_VerifyDocTitle("403 Forbidden", TITLE); 

 

/* Request: 16  */ 

DO_Http("GET http://server.company.com:8060/OA_MEDIA/appslogo_new.gif " 

        "HTTP/1.0\r\n" 

        "Accept: */*\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n" 

        "Cookie:  oracle.uix=0^^^^GMT-4:00; \r\n\r\n" 

        ); 

 

/* Request: 17  */ 

DO_Http("GET http://server.company.com:8060/OA_MEDIA/appslogo_new.gif " 

        "HTTP/1.1\r\n" 

        "cookie:  oracle.uix=0^^^^GMT-4:00; \r\n" 

        "User-Agent: Java1.3.1.18-internal\r\n" 

        "Accept: text/html, image/gif, image/jpeg, *; q=.2, */*; q=.2\r\n\r\n" 

        ); 

 

DO_SLEEP(2); 

 

/* Request: 18  */ 

DO_SetValue("ICX_TICKET", ""); 

DO_SetValue("resp_app", "INV"); 

DO_SetValue("resp_key", "INVENTORY_VISION_OPERATIONS"); 

DO_SetValue("secgrp_key", "STANDARD"); 
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DO_SetValue("start_func", "INV_INVMATWB"); 

DO_SetValue("other_params", ""); 

DO_Http("GET 
http://server.company.com:8060/pls/nvis510/fnd_icx_launch.runforms?{ICX_TICKET}" 

        "&{resp_app}&{resp_key}&{secgrp_key}&{start_func}&{other_params} " 

        "HTTP/1.0\r\n" 

        "Accept: */*\r\n" 

        "Accept-Language: en-us\r\n" 

        "Cookie:  oracle.uix=0^^^^GMT-4:00; \r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n\r\n" 

        ); 

 

//----------------------------------------------------------------------------- 

// The ICX ticket needs to be extracted from the response from the 

// fnd_icx_launch.runforms GET request 

//----------------------------------------------------------------------------- 

//RR__printf("REPLY: %s\n", DO_GetReplyBuffer()); 

icx_ticket = (char*) malloc(128); 

strcpy(icx_ticket, DO_GetUniqueString("icx_ticket='", "'")); 

// RR__printf("ICX TICKET: \"%s\"\n", icx_ticket); 

sprintf(buf, "+config='nvis510'+icx_ticket='%s'+resp=" 

        "'INV%2FINVENTORY_VISION_OPERATIONS'+secgrp='STANDARD'+start_func=" 

        "'INV_INVMATWB'", icx_ticket); 

 

DO_SetValue("lookAndFeel", "ORACLE"); 

DO_SetValue("colorScheme", "BLAF"); 

DO_SetValue("lang", "US"); 

DO_SetValue("env", "NLS_LANG='AMERICAN_AMERICA.UTF8'+FORMS60_USER_DATE_FORMAT=" 

        "'DD-MON-RRRR'+FORMS60_USER_DATETIME_FORMAT=" 

        "'DD-MON-RRRR%20HH24%3AMI%3ASS'+NLS_DATE_LANGUAGE='AMERICAN'+NLS_SORT=" 

        "'BINARY'+NLS_NUMERIC_CHARACTERS='.,'"); 

 

//-----------------------------------------------------------------------------  

// The ICX ticket value extracted needs to go into the URL parameters 

//----------------------------------------------------------------------------- 

// DO_SetValue("form_params",  

//                 "+config='nvis510'+icx_ticket='.1315587967'+resp=" 

//       "'INV%2FINVENTORY_VISION_OPERATIONS'+secgrp='STANDARD'+start_func=" 

//         "'INV_INVMATWB'"); 
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DO_SetValue("form_params", buf); 

 

DO_SetValue("encoding", "UTF-8"); 

DO_Http("GET "http://server.company.com:8060/dev60cgi/f60cgi?{lookAndFeel}&{colorScheme}" 

        "&{lang}&{env}&{form_params}&{encoding} HTTP/1.0\r\n" 

        "Accept: */*\r\n" 

        "Accept-Language: en-us\r\n" 

        "Cookie:  oracle.uix=0^^^^GMT-4:00; \r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n\r\n" 

        ); 

DO_VerifyDocTitle("Oracle Applications 11i", TITLE); 

 

/* Request: 20  */ 

DO_Http("GET " 

        "http://server.company.com:8060/OA_JAVA/oracle/forms/icons/oracle_logo_light." 

        "gif HTTP/1.0\r\n" 

        "Accept: */*\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n" 

        "Cookie:  oracle.uix=0^^^^GMT-4:00; \r\n\r\n" 

        ); 

DO_VerifyDocTitle("404 Not Found", TITLE); 

 

/* Request: 21  */ 

DO_Http("GET " 

        "http://server.company.com:8060/OA_JAVA/oracle/forms/icons/oracle_logo_light." 

        "gif HTTP/1.1\r\n" 

        "cookie:  oracle.uix=0^^^^GMT-4:00; \r\n" 

        "User-Agent: Java1.3.1.18-internal\r\n" 

        "Accept: text/html, image/gif, image/jpeg, *; q=.2, */*; q=.2\r\n\r\n" 

        ); 

DO_VerifyDocTitle("404 Not Found", TITLE); 

 

/* Request: 22  */ 

DO_Http("GET " 

        "http://server.company.com:8060/OA_JAVA/oracle/forms/icons/oracle_logo_light." 

        "gif HTTP/1.0\r\n" 

        "Accept: */*\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n" 
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        "Cookie:  oracle.uix=0^^^^GMT-4:00; \r\n\r\n" 

        ); 

DO_VerifyDocTitle("404 Not Found", TITLE); 

 

/* Request: 23  */ 

DO_Http("GET " 

        "http://server.company.com:8060/OA_JAVA/oracle/forms/icons/oracle_logo_light." 

        "gif HTTP/1.1\r\n" 

        "cookie:  oracle.uix=0^^^^GMT-4:00; \r\n" 

        "User-Agent: Java1.3.1.18-internal\r\n" 

        "Accept: text/html, image/gif, image/jpeg, *; q=.2, */*; q=.2\r\n\r\n" 

        ); 

DO_VerifyDocTitle("404 Not Found", TITLE); 

 

DO_SLEEP(2); 

 

/* Request: 24  */ 

DO_Http("GET " 

        "http://server.company.com:8060/OA_JAVA/oracle/forms/registry/Registry." 

        "dat HTTP/1.1\r\n" 

        "cookie:  oracle.uix=0^^^^GMT-4:00; \r\n" 

        "User-Agent: Java1.3.1.18-internal\r\n" 

        "Accept: text/html, image/gif, image/jpeg, *; q=.2, */*; q=.2\r\n\r\n" 

        ); 

 

DO_SLEEP(1); 

 

/* Request: 25  */ 

DO_Http("GET " 

        "http://server.company.com:8060/OA_JAVA/oracle/apps/fnd/formsClient/OracleApplicati
ons." 

        "dat HTTP/1.1\r\n" 

        "cookie:  oracle.uix=0^^^^GMT-4:00; \r\n" 

        "User-Agent: Java1.3.1.18-internal\r\n" 

        "Accept: text/html, image/gif, image/jpeg, *; q=.2, */*; q=.2\r\n\r\n" 

        ); 

 

ofsHTTPSetHdrProperty("User-Agent", "Java1.3.1.18-internal" );  

 

ofsHTTPSetHdrProperty("Host", "server.company.com:8060" );  
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ofsHTTPSetHdrProperty("Accept", "text/html, image/gif, image/jpeg, *; q=.2, " 

        "*/*; q=.2" );  

 

ofsHTTPSetHdrProperty("Connection", "Keep-alive" );  

 

//----------------------------------------------------------------------------- 

// Tell the OFS middleware to set the Cookie header for the requests that 

// follow... 

//----------------------------------------------------------------------------- 

ofsHTTPSetHdrProperty("cookie:", cookieHeaderValue); 

 

ofsHTTPConnectToFormsServlet( "http://server.company.com:8060/forms/formservlet?ifcmd=" 

        "getinfo&ifhost=dtx76852&ifip=10.15.16.128" ); 

 

 

DO_SLEEP(2); 

 

ofsHTTPSetHdrProperty("Content-type", "application/octet-stream" );  

 

ofsHTTPInitialFormsConnect(); 

 

 

DO_SLEEP(2); 

ofsSetInitialVersion( "RUNFORM", 1, OFS_ADD, 268, "60824" ); 

ofsSetScreenResolution( "RUNFORM", 1, OFS_ADD, 263, 96, 96); 

ofsSetDisplaySize( "RUNFORM", 1, OFS_ADD, 264, 1600, 1200); 

 

//----------------------------------------------------------------------------- 

// The ICX ticket value extracted from the web traffic needs to be passed to 

// OFS replay as part of the cmdline 

//----------------------------------------------------------------------------- 

sprintf(buf, 

 "server module=/oracle/appl/nvis510appl/fnd/11.5.0/forms/US/FNDSCSGN fndnam=APPS" 

  "  config='nvis510' icx_ticket='%s' resp='INV/INVENTORY_VISION_OPERATIO" 

  "NS' secgrp='STANDARD' start_func='INV_INVMATWB'", 

icx_ticket); 

// ORIGINAL CODE: 

// ofsInitSessionCmdLine("RUNFORM", 1, OFS_ADD, 265,  

//  "server module=/oracle/appl/nvis510appl/fnd/11.5.0/forms/US/FNDSCSGN fndnam=APPS" 

//  "  config='nvis510' icx_ticket='.1315587967' resp='INV/INVENTORY_VISION_OPERATIO" 
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//  "NS' secgrp='STANDARD' start_func='INV_INVMATWB'" 

// ); 

ofsInitSessionCmdLine("RUNFORM", 1, OFS_ADD, 265, buf); 

ofsSetColorDepth( "RUNFORM", 1, OFS_ADD, 266, "256" ); 

ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "0" ); 

ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "255" ); 

ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "65535" ); 

ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "4210752" ); 

ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "8421504" ); 

ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "65280" ); 

ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "12632256" ); 

ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16711935" ); 

ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16762880" ); 

ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16756655" ); 

ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16711680" ); 

ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16777215" ); 

ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "16776960" ); 

ofsSetFontName( "RUNFORM", 1, OFS_ADD, 383, "Dialog" ); 

ofsSetFontSize( "RUNFORM", 1, OFS_ADD, 377, "900" ); 

ofsSetFontStyle( "RUNFORM", 1, OFS_ADD, 378, "0" ); 

ofsSetFontWeight( "RUNFORM", 1, OFS_ADD, 379, "0" ); 

ofsSetScaleInfo( "RUNFORM", 1, OFS_ADD, 267, 8, 22); 

ofsSetRequiredVAList( "RUNFORM", 1, OFS_ADD, 291 ); 

ofsSetPropertyString("RUNFORM", 1, OFS_ADD, 510,  

 "NLS_LANG='AMERICAN_AMERICA.UTF8' FORMS60_USER_DATE_FORMAT='DD-MON-RRRR' FORMS60" 

 "_USER_DATETIME_FORMAT='DD-MON-RRRR HH24:MI:SS' NLS_DATE_LANGUAGE='AMERICAN' NLS" 

 "_SORT='BINARY' NLS_NUMERIC_CHARACTERS='.,'" 

); 

 

ofsSetPropertyString( "RUNFORM", 1, OFS_ENDMSG, 527, "America/New_York" ); 

DO_SLEEP(2); 

 

DO_SLEEP(2); 

ofsSendRecv(1); //ClientSeqNo=1|MsgCount=1|1128450767.703 

 

 

DO_SLEEP(1); 

 

/* Request: 26  */ 

DO_Http("GET " 
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        "http://server.company.com:8060/OA_JAVA/oracle/apps/media/afclrall.gif " 

        "HTTP/1.0\r\n" 

        "Accept: */*\r\n" 

        "User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; .NET CLR " 

        "1.1.4322; .NET CLR 1.0.3705)\r\n" 

        "Cookie:  oracle.uix=0^^^^GMT-4:00; JServSessionIdforms=" 

        "z6m86mb2u1.mA5Nah4OcA9vqN4Lb6yImQXHq7jRml9z/AbJphCLc3mKa0--; \r\n\r\n" 

        ); 

 

/* Request: 27  */ 

DO_Http("GET " 

        "http://server.company.com:8060/OA_JAVA/oracle/apps/media/afclrall.gif " 

        "HTTP/1.1\r\n" 

        "cookie:  oracle.uix=0^^^^GMT-4:00; JServSessionIdforms=" 

        "z6m86mb2u1.mA5Nah4OcA9vqN4Lb6yImQXHq7jRml9z/AbJphCLc3mKa0--; \r\n" 

        "User-Agent: Java1.3.1.18-internal\r\n" 

        "Accept: text/html, image/gif, image/jpeg, *; q=.2, */*; q=.2\r\n\r\n" 

        ); 

ofsSetWindowLocation( "FORMWINDOW", 6, OFS_ENDMSG, 135, 0, 0); 

ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 558, 120); 

ofsSetWindowLocation( "Object Properties", 11, OFS_ENDMSG, 135, 307, 269); 

ofsSetWindowLocation( "Progress", 15, OFS_ENDMSG, 135, 288, 336); 

ofsSetWindowLocation( "Rename Label", 20, OFS_ENDMSG, 135, 192, 192); 

ofsSetWindowLocation( "Launch", 24, OFS_ENDMSG, 135, 192, 192); 

ofsSetPropertyInteger( "CUSTOMCONTROL", 54, OFS_ADD, 1, "21002" ); 

ofsSetPropertyInteger( "CUSTOMCONTROL", 54, OFS_ADD, 1, "0" ); 

ofsSetPropertyStringArray( "CUSTOMCONTROL", 54, OFS_ENDMSG, 1, "0" ); 

ofsSendRecv(1); //ClientSeqNo=2|MsgCount=7|1128450772.156 

 

 

DO_SLEEP(2); 

ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 558, 120); 

 

ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 1600, 1200); 

DO_SLEEP(2); 

ofsSendRecv(2); //ClientSeqNo=3|MsgCount=2|1128450775.531 

 

 

DO_SLEEP(1); 

ofsSetCursorPosition( "TEXTFIELD", 89, OFS_ENDMSG, 193, "0" ); 

ofsActivateWindow( "NAVIGATOR", 28, OFS_ENDMSG, 247 ); 
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ofsShowWindow( "NAVIGATOR", 28, OFS_ENDMSG, 173 ); 

 

ofsFocus( "TEXTFIELD", 89, OFS_ENDMSG, 174 ); 

DO_SLEEP(3); 

ofsSendRecv(2); //ClientSeqNo=4|MsgCount=4|1128450779.859 

 

 

DO_SLEEP(1); 

ofsSetWindowSize( "NAVIGATOR", 28, OFS_ENDMSG, 137, 819, 432); 

ofsSetWindowSize( "NAVIGATOR", 28, OFS_ENDMSG, 137, 819, 570); 

 

ofsSetWindowLocation( "NAVIGATOR", 28, OFS_ENDMSG, 135, 0, 13); 

DO_SLEEP(2); 

ofsSendRecv(2); //ClientSeqNo=5|MsgCount=3|1128450781.562 

 

ofsSendRecv(2); //ClientSeqNo=6|MsgCount=0|1128450783.375 

 

 

DO_SLEEP(2); 

 

DO_SLEEP(2); 

ofsSendRecv(2); //ClientSeqNo=7|MsgCount=0|1128450786.875 

 

 

DO_SLEEP(1); 

ofsSetWindowLocation( "Object Properties", 125, OFS_ENDMSG, 135, 307, 269); 

ofsSetWindowLocation( "Sort Data", 133, OFS_ENDMSG, 135, 307, 269); 

ofsSetWindowLocation( "Folder Tools", 137, OFS_ENDMSG, 135, 240, 144); 

ofsSetWindowLocation( "Change Prompt", 141, OFS_ENDMSG, 135, 269, 326); 

ofsSetWindowLocation( "Save Folder", 145, OFS_ENDMSG, 135, 269, 307); 

ofsSetWindowLocation( "Destination Details", 149, OFS_ENDMSG, 135, 269, 307); 

ofsSetWindowLocation( "Folder Query", 153, OFS_ENDMSG, 135, 240, 216); 

ofsSetWindowLocation( "Autosize All", 157, OFS_ENDMSG, 135, 307, 269); 

ofsSetWindowLocation( "Calendar", 197, OFS_ENDMSG, 135, 96, 96); 

ofsSetWindowLocation( "Progress", 201, OFS_ENDMSG, 135, 288, 336); 

ofsSendRecv(2); //ClientSeqNo=8|MsgCount=10|1128450789.296 

 

 

DO_SLEEP(2); 

ofsRemoveFocus( "TEXTFIELD", 89, OFS_ENDMSG, 174 ); 

ofsFocus( "BUTTON", 293, OFS_ENDMSG, 174 ); 
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ofsDeActivateWindow( "Material Workbench", 161, OFS_ENDMSG, 247 ); 

ofsSendRecv(2); //ClientSeqNo=9|MsgCount=3|1128450790.734 

 

 

DO_SLEEP(1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 1, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 2, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 3, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 4, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 5, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 6, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 7, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 8, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 9, 3); 

ofsSendRecv(1); //ClientSeqNo=10|MsgCount=9|1128450793.250 

 

 

DO_SLEEP(3); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 1, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 2, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 3, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 4, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 5, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 6, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 7, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 8, 1); 

ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 1600, 1200); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 9, 3); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 1, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 2, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 3, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 4, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 5, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 6, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 7, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 8, 1); 

ofsLOVRequestRow( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 451, 9, 3); 

ofsSendRecv(1); //ClientSeqNo=11|MsgCount=19|1128450795.187 

 

ofsSendRecv(1); //ClientSeqNo=12|MsgCount=0|1128450795.187 
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DO_SLEEP(2); 

 

DO_SLEEP(2); 

ofsActivateWindow( "Material Workbench", 161, OFS_ENDMSG, 247 ); 

ofsSetPropertyVoid( "LISTVALUESDIALOG", 615, OFS_ENDMSG, 105 ); 

ofsSendRecv(1); //ClientSeqNo=13|MsgCount=2|1128450801.593 

 

 

DO_SLEEP(4); 

ofsSendRecv(2); //ClientSeqNo=14|MsgCount=0|1128450802.921 

 

 

DO_SLEEP(1); 

ofsSetCursorPosition( "TEXTFIELD", 89, OFS_ENDMSG, 193, "0" ); 

ofsFocus( "TABCONTROL", 255, OFS_ENDMSG, 174 ); 

ofsFocus( "BUTTON", 73, OFS_ENDMSG, 174 ); 

ofsActivateWindow( "NAVIGATOR", 28, OFS_ENDMSG, 247 ); 

ofsRemoveFocus( "BUTTON", 73, OFS_ENDMSG, 174 ); 

ofsFocus( "TEXTFIELD", 89, OFS_ENDMSG, 174 ); 

ofsSendRecv(2); //ClientSeqNo=15|MsgCount=6|1128450804.515 

 

 

DO_SLEEP(2); 

ofsSendRecv(2); //ClientSeqNo=16|MsgCount=0|1128450805.828 

 

 

DO_SLEEP(1); 

ofsCloseWindow( "NAVIGATOR", 28, OFS_ENDMSG, 216 ); 

ofsSendRecv(1); //ClientSeqNo=17|MsgCount=1|1128450808.656 

 

 

DO_SLEEP(3); 

ofsDeActivateWindow( "NAVIGATOR", 28, OFS_ENDMSG, 247 ); 

ofsSetPropertyInteger( "CUSTOMCONTROL", 616, OFS_ADD, 1, "20002" ); 

ofsSetPropertyInteger( "CUSTOMCONTROL", 616, OFS_ENDMSG, 1, "0" ); 

ofsSendRecv(1); //ClientSeqNo=18|MsgCount=2|1128450810.875 

 

 

DO_SLEEP(2); 

ofsSetCursorPosition( "TEXTFIELD", 89, OFS_ENDMSG, 193, "0" ); 
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ofsActivateWindow( "NAVIGATOR", 28, OFS_ENDMSG, 247 ); 

ofsSendRecv(2); //ClientSeqNo=19|MsgCount=2|1128450812.406 

 

 

DO_SLEEP(2); 

ofsSetPropertyInteger( "FORMWINDOW", 6, OFS_ENDMSG, 130, "1" ); 

ofsSendRecv(3); //ClientSeqNo=20|MsgCount=1|1128450813.609 

 

 

DO_SLEEP(1); 

ofsHTTPDisconnect(); 

 

DO_SetTransactionCleanup(); 

/* Clear up some internal storage used for DO_SetValue() */ 

DO_HttpCleanup(); 

for(i=0; i<3; i++) 

{ 

free(Field[i]); 

Field[i]=NULL; 

} 

for(i=0; i<2; i++) 

{ 

free(Anchor[i]); 

Anchor[i]=NULL; 

} 

for(i=0; i<1; i++) 

{ 

free(ActionURL[i]); 

ActionURL[i]=NULL; 

} 

//----------------------------------------------------------------------------- 

// Free up memory that was allocated earlier 

//----------------------------------------------------------------------------- 

if (NULL != sessionid) free(sessionid); 

if (NULL != nvis510) free(nvis510); 

if (NULL != cookieHeaderValue) free(cookieHeaderValue); 

if (NULL != icx_ticket) free(icx_ticket); 

 

END_TRANSACTION(); 

DO_FreeHttp(); 



QALoad 5.5  

328 

 

EXIT(); 

return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 

{ 

RR__printf("Virtual User ABORTED."); 

DO_FreeHttp(); 

 

EXIT(); 

} 

 

SAP Scripts 

SAP Script Samples  

You can address specific si tuat ions or resolve certain  problems by modifying converted SAP scripts. The 
samples shown here include a descript ion of the problem, the procedure for implementing the 
modificat ion, and samples of a modified script . Script  modificat ions are discussed for: 

Checking and Handling SAPGuiCheckScreen Errors 

Checking the SAP Status Bar 

Handling Mult iple SAP Logons in a Single Script  

Required SAP Commands to Support Transact ion Restart  

Required SAP Script Commands 

Retrieving SAP Counter Data 

 

 

Checking and Handling SAPGuiCheckScreen Errors 

Overview : Handl ing SAPGuiCheckScreen  Errors 

The SAP screen returned from the SAP server during playback can differ from the screen status of the 
session during record. The SAPGuiCheckScreen cal l  returns a Boolean value that indicates whether the 
screen status is expected or unexpected.  By checking the status returned from th is cal l , you can bui ld more 
extensive error handl ing capabi l i ty in to the script .  

Create custom error handl ing code by placing the SAPGuiCheckScreen cal l  wi th in an If condit ional that 
checks the return value, then writ ing custom error handl ing code for the funct ions that fai l  with in that 
condit ional block.  

The sample script   shows the code for creat ing error code blocks to use with checking the status of a 
returned SAP screen. 

 

Sam ple: SAP Script  w i th  SAPGuiCheckScreen  Error Handler 
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The fol lowing shows an SAP script  sn ippet with SAPGuiCheckScreen Error Handler. Points of in terest in  the 
script  are h ighl ighted in  bold. 

Sample Script  Snippet 

…beginning of script… 

SAPGuiPropIdStr("wnd[0]/usr/subSA_0100_1:SAPLEXAMPLE_ENTRY_SCREEN:0200/subSA_200_1:SAPLEXAMP
LE_ENTRY_SCREEN:0800/cntlCC_HTML_INDEX/shellcont/shell"); 
SAPGuiCmd3(GuiCtrlHTMLViewer, SapEvent, "","","sapevent:FLD_SHORT?FLD" ); 

/// In this small example, if any of the following are FALSE 
///    OKCode == “BIBS” 
///    screen name == “SAPLEXAMPLE_ENTRY_SCREEN” 
///   title == "Style Guide: Dropdown list" 
/// …then the block of error code is processed! 

BOOL bRetSts = SAPGuiCheckScreen (  
"BIBS",  
"SAPLEXAMPLE_ENTRY_SCREEN",  
"Style Guide: Dropdown list" ); 

if (bRetSts != TRUE)  
{ 

RR__printf("Style Guide: Dropdown list not found"); 
SAPGui_error_handler(s_info, "Error: Style Guide: Dropdown list"); 

} 

DO_SLEEP(9); 

SAPGuiCmd3(GuiCtrlHTMLViewer, SapEvent, "","","sapevent:PUB_SHORT?PUB" ); 

…end of script… 
 

Checking the SAP Status Bar 

Overview : Check ing the Status Bar 

The SAP status bar displays error and status messages. When running an SAP script , you can check the 
status bar to determine whether the script  is execut ing properly.  
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 Conclusion 

Use the SAPGuiCheckStatusbar command to test for certain status responses in the SAP environment and 
take act ions based on messages returned from the SAP server. The sample script  i l lustrates th is procedure. 

 

Sam ple Script : Check ing the SAP Status Bar  

The SAPGuiCheckStatusbar command is used in the fol lowing script  example to test for certain status 
responses. The code added to check the status bar is shown in bold. 

Sample Script  
... 
SAPGuiPropIdStr("wnd[0]");//1109615021.466 
SAPGuiCmd1(GuiMainWindow,SendVKey,4); 
SAPGuiCheckScreen("PA40","SAPMP50A","Personnel Actions");  //1109615021.481 
 
DO_SLEEP(15); 
 
SAPGuiPropIdStr("" 
   "wnd[1]/usr/tabsG_SELONETABSTRIP/tabpTAB001/ssubSUBSCR_PRESEL:SAPLSDH4:0220/sub:" 
"SAPLSDH4:0220/txtG_SELFLD_TAB-LOW[0,24]" ); //1109615036.231 
SAPGuiCmd1(GuiTextField,PutText,"pan"); 
SAPGuiCmd1(GuiTextField,PutCaretPosition,3); 
 
SAPGuiPropIdStr("wnd[1]/tbar[0]/btn[0]");//1109615036.246 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("PA40","SAPLSDH4","Restrict Value Range"); //1109615036.246 
 
// Check to determine if the name we chose is found in db 
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// If not stop the script should not continue 
BOOL bRetSts =  
SAPGuiCheckStatusbar("wnd[0]/sbar", "No values for this selection"); 
if (bRetSts) 
{ 
    RR__printf(" No such last name in Database"); 
    SAPGui_error_handler(s_info," End Now No such name in Database"); 
} 
... 

 

Handling Multiple SAP Logons in a Single Script 

M odi fying the Script  for M ul t i ple Logons 

Load test ing requirements for SAP may include al lowing for mult iple logons in a script  session. When you 
incorporate mult iple logon funct ional i ty for an SAP script , you must add a code block to the script  to see i f 
the mult iple logon opt ion is avai lable, and whether the user has selected the radio button that al lows 
concurrent connect ions from the same user. 

To m odi f y a scr ip t  t o handle m ul t ip le logons: 

1. Find the fol lowing l ine of code in a script  you just captured.   

Tip: This line of code should be near the top of the script after the logon commands.  

SAPGuiCheckScreen("S000","SAPMSYST","SAP"); 

2. After th is l ine of code, add the fol lowing code block. This shows whether the mult iple logon opt ion 
is avai lable and i f the user has pressed the Al low  Concurren t  Connect ions f rom  the Sam e User  
radio button on the SAP logon screen. 

SAPGuiPropIdStrExists("wnd[1]/usr/radMULTI_LOGON_OPT2"); 

DO_SLEEP(20);  

SAPGuiCmd0(GuiRadioButton,Select); 

SAPGuiCmd0(GuiRadioButton,SetFocus); 

SAPGuiPropIdStr("wnd[1]/tbar[0]/btn[0]"); 

SAPGuiCmd0(GuiButton,Press); 

SAPGuiCheckScreen("S000","SAPMSYST","License Information for Multiple Logon"); 

SAPGuiPropIdStrExistsEnd("wnd[1]/usr/radMULTI_LOGON_OPT2"); 

SAPGuiPropIdStr("wnd[0]"); // sets focus back to wind[0] 

This code acts l ike an If condit ional that is not in  a control loop. It  can be stated as fol lows: 

!  IF the mult i-logon screen appears, select radio button opt ion 2. In  th is code snippet, radio button 
2 tel ls the server to al low concurrent connect ions from the same user.  

!  THEN check to make certain the script  is synced to the "License Information for Mult iple Logon ”  
sect ion.   

!  ELSE do noth ing and cont inue with the script .  

Conclusion 

This technique enables support for mult iple SAP logon sessions in  a script . It  asks SAP whether the mult i-
logon radio button is selected and, i f i t  is, simulates select ing the button during replay. This al lows you to 
run the same script  with many virtual users under a single SAP logon ID. 
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The sample original script  and sample modified script  i l lustrate th is process. 

 

Sam ple: Original  SAP Script  for M ul t i ple Logons 

The fol lowing sample shows an original script  converted from capture. Points of in terest in  the script  are 
h ighl ighted in  bold. 

Sample Script  
/* 
 *  multilogon.cpp 
 * 
 *  Script Converted on July 20, 2004 at 08:43:23 AM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 73 
 * 
 *  This script contains support for the following middlewares:  
 *      - SAP 
 */ 

/* Converted using the following options: 
 * General: 
 *  Line Split                       : 132 characters 
 *  Sleep Seconds                    : 1 
 *  Constants to Variables           : Yes 
 *  Remove Quotes                    : No 
 *  Tabs To Spaces                   : No 
 *  Auto Checkpoints                 : No 
 * SAP 
 *  Version                          : 6204.119.32 
 */ 

#define SCRIPT_VER 0x00000205UL 

#include <stdio.h> 
#include <windows.h> 
#include <atlbase.h> 
#include <objbase.h> 
#include "do_SAPCCOM.h" 
#include <atlwin.h> 
#include <atlcom.h> 
#include <atlhost.h> 
#include "cscript.h" 
#include "do_SapGui.h" 
#include "mwCommon.h" 

extern "C" { 
#include "smacro.h" 
} 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("capture.cpp"); 
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HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info,"SAP: ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 
 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 

try{ 

SAPGuiConnect( s_info,"testsap620"); 

SAPGuiApplication(RegisterROT); 
 
SAPGuiVerCheckStr("6204.119.32");  
 
//Set SapApplication = CreateObject("Sapgui.ScriptingCtrl.1") 
//SapApplication.OpenConnection ("testsap620") 
//Set Session    = SapApplication.Children(0).Children(0) 
 
DO_SLEEP(18); 
 
SAPGuiPropIdStr("wnd[0]");//1057828784.513 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(16); 
 
SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME");//1057828800.786 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 
 
SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE");//1057828800.796 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~0000x_'9d"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 
 
SAPGuiPropIdStr("wnd[0]");//1057828800.836 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
SAPGuiCheckScreen("S000","SAPMSYST","SAP");//1057828800.856 
 
DO_SLEEP(6); 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(3); 
 
SAPGuiPropIdStr("wnd[0]/tbar[0]/btn[15]");//1057828809.839 
SAPGuiCmd0(GuiButton,Press); 

/// This is the command to look for. The parameters indicate that this  
/// SAP Easy Access session screen.   

SAPGuiCheckScreen("SESSION_MANAGER","SAPLSMTR_NAVIGATION","SAP Easy 
Access");//1057828809.859 
 
DO_SLEEP(2); 
 
SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1");//1057828811.382 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off");//1057828811.402 
 
} // end try 
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catch (_com_error e){ 
char buffer[1024]; 
sprintf(buffer,"SAP: EXCEPTION 0x%x  %s for VU(%i)\n",e.Error(), (char 
*)e.Description(), S_task_id); 
SAPGui_error_handler(s_info,buffer); 
} // end catch 

DO_SetTransactionCleanup(); 

SAPGuiApplication(RevokeROT); 
 
END_TRANSACTION(); 

REPORT(SUCCESS); 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
EXIT(); 

} 

 

 Sam ple: M odi f i ed SAP Script  for M ul t i ple Logon s 

The fol lowing sample shows a SAP script  modified to handle mult iple logon sessions. Added code snippet 
and related comments are h ighl ighted in  bold. 

Sample Script  
/* 
 *  multilogon.cpp 
 * 
 *  Script Converted on July 20, 2004 at 08:43:23 AM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 73 
 * 
 *  This script contains support for the following middlewares:  
 *      - SAP 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 132 characters 
 *  Sleep Seconds                    : 1 
 *  Constants to Variables           : Yes 
 *  Remove Quotes                    : No 
 *  Tabs To Spaces                   : No 
 *  Auto Checkpoints                 : No 
 * SAP 
 *  Version                          : 6204.119.32 
 */ 

#define SCRIPT_VER 0x00000205UL 

#include <stdio.h> 
#include <windows.h> 
#include <atlbase.h> 
#include <objbase.h> 
#include "do_SAPCCOM.h" 
#include <atlwin.h> 
#include <atlcom.h> 
#include <atlhost.h> 
#include "cscript.h" 
#include "do_SapGui.h" 
#include "mwCommon.h" 
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extern "C" { 
#include "smacro.h" 
} 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("multilogon.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info,"SAP: ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 
 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 

try{ 

SAPGuiConnect( s_info,"testsap620"); 

SAPGuiApplication(RegisterROT); 
 
SAPGuiVerCheckStr("6204.119.32");  
 
//Set SapApplication = CreateObject("Sapgui.ScriptingCtrl.1") 
//SapApplication.OpenConnection ("testsap620") 
//Set Session    = SapApplication.Children(0).Children(0) 
 
DO_SLEEP(18); 
 
SAPGuiPropIdStr("wnd[0]");//1057828784.513 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(16); 
 
SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME");//1057828800.786 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 
 
SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE");//1057828800.796 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~0000x_'9d"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 
 
SAPGuiPropIdStr("wnd[0]");//1057828800.836 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 

/// Scripting: Step 1 
/// Here is the command to look for in the script.  Note the parameters 
/// of the call, they are consistent in every SAP script.  

SAPGuiCheckScreen("S000","SAPMSYST","SAP");//1057828800.856 
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/// Scripting: Step 2 
/// Add this code snippet in bold after the SAPGuiCheckScreen which  
/// confirms the login screen is present. 

SAPGuiPropIdStrExists("wnd[1]/usr/radMULTI_LOGON_OPT2"); 

DO_SLEEP(20);  
SAPGuiCmd0(GuiRadioButton,Select); 
SAPGuiCmd0(GuiRadioButton,SetFocus); 
SAPGuiPropIdStr("wnd[1]/tbar[0]/btn[0]"); 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("S000","SAPMSYST","License Information for Multiple 
Logon"); 

SAPGuiPropIdStrExistsEnd("wnd[1]/usr/radMULTI_LOGON_OPT2"); 

SAPGuiPropIdStr("wnd[0]"); // sets focus back to wind[0] 

DO_SLEEP(6); 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(3); 
 
SAPGuiPropIdStr("wnd[0]/tbar[0]/btn[15]");//1057828809.839 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSMTR_NAVIGATION","SAP Easy 
Access");//1057828809.859 
 
DO_SLEEP(2); 
 
SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1");//1057828811.382 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off");//1057828811.402 
 
} // end try 

catch (_com_error e){ 
char buffer[1024]; 
sprintf(buffer,"SAP: EXCEPTION 0x%x  %s for VU(%i)\n",e.Error(), (char 
*)e.Description(), S_task_id); 
SAPGui_error_handler(s_info,buffer); 
} // end catch 

DO_SetTransactionCleanup(); 

SAPGuiApplication(RevokeROT); 
 
END_TRANSACTION(); 

REPORT(SUCCESS); 
EXIT(); 
return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
EXIT(); 

} 

 

Required SAP Commands to Support Transaction Restart 

Overview : Transact ion  Restart  Com m ands 
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If your load test ing requirements include support ing transact ion restarts, review the fol lowing commands 
and ensure that those required to support t ransact ion restart  are present.  

Note: These are automatically added during the script conversion process.   

Script ing 

Required commands and associated code statements for the SAP script  are:   

!  SAPGuiApplication(RegisterROT) - This command sets or resets the SAP runtime object library (ROT).  Executing 
this command ensures the SAP environment is in an initial state at the beginning of the script. 

!  SAPGuiApplication(RevokeROT) - This command clears the SAP runtime object library (ROT).  Executing this 
command ensures the memory SAP environment is de-allocated. 

!  SAPGui_error_handler(s_info, buffer) - When scripting an error code block, be sure to use the 
SAPGui_error_handler command instead of the RR__FailedMsg command if the Transaction Restart option is used. 

Note: These functions are required, but additional SAP script commands are also essential to run an SAP 
script. 

Conclusion 

If unexpected playback errors occur when playing back an edited script  with Transact ion Restart  enabled, 
perform a review of the commands to ensure that those required to support t ransact ion restart  are present. 
  

The sample script  shows the commands used in the script .  

 

Sam ple: Requi red SAP Com m ands Support i ng Transact ion  Restart  

The fol lowing sample script  shows the SAP commands required to support t ransact ion restart . Essent ial  
Transact ion Restart  commands are h ighl ighted in  bold. 

Sample Script  

/* 
 *  capturewithrestart.cpp 
 * 
 *  Script Converted on July 20, 2004 at 08:43:23 AM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 73 
 * 
 *  This script contains support for the following middlewares:  
 *      - SAP 
 */ 

/* Converted using the following options: 
 * General: 
 *  Line Split                       : 132 characters 
 *  Sleep Seconds                    : 1 
 *  Constants to Variables           : Yes 
 *  Remove Quotes                    : No 
 *  Tabs To Spaces                   : No 
 *  Auto Checkpoints                 : No 
 * SAP 
 *  Version                          : 6204.119.32 
 */ 

#define SCRIPT_VER 0x00000205UL 

#include <stdio.h> 
#include <windows.h> 
#include <atlbase.h> 
#include <objbase.h> 
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#include "do_SAPCCOM.h" 
#include <atlwin.h> 
#include <atlcom.h> 
#include <atlhost.h> 
#include "cscript.h" 
#include "do_SapGui.h" 
#include "mwCommon.h" 

extern "C" { 
#include "smacro.h" 
} 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 

{ 

/* Declare Variables */ 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("capturewithrestart.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info,"SAP: ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 
 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 

try{ 

SAPGuiConnect( s_info,"testsap620"); 

/// This command registers the SAP Runtime Object Table (ROT). 
/// Setting the ROT effectively sets or resets the SAP runtime environment. 

SAPGuiApplication(RegisterROT); 
 
SAPGuiVerCheckStr("6204.119.32");  
 
//Set SapApplication = CreateObject("Sapgui.ScriptingCtrl.1") 
//SapApplication.OpenConnection ("testsap620") 
//Set Session    = SapApplication.Children(0).Children(0) 
 
DO_SLEEP(18); 
 
SAPGuiPropIdStr("wnd[0]");//1057828784.513 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(16); 
 
SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME");//1057828800.786 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 
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SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE");//1057828800.796 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~0000x_'9d"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 
 
SAPGuiPropIdStr("wnd[0]");//1057828800.836 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
SAPGuiCheckScreen("S000","SAPMSYST","SAP");//1057828800.856 
 
 
DO_SLEEP(6); 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(3); 
 
SAPGuiPropIdStr("wnd[0]/tbar[0]/btn[15]");//1057828809.839 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSMTR_NAVIGATION","SAP Easy 
Access");//1057828809.859 

// Check to determine if the name we chose is found in db 
// If not stop the script should not continue 

BOOL bRetSts =  
SAPGuiCheckStatusbar("wnd[0]/sbar", "No values for this selection"); 

if (bRetSts) 
{ 

RR__printf(" No such last name in Database"); 
/// Use the SAPGui_error_handler call within code blocks that process 
/// error conditions.  Do not use the RR__FailedMsg call in scripts 
/// where the Transaction Restart option will be enabled! 

SAPGui_error_handler(s_info," End Now No such name in Database"); 
} 

DO_SLEEP(2); 
 
SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1");//1057828811.382 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off");//1057828811.402 
 
 
} // end try 

catch (_com_error e){ 
char buffer[1024]; 
sprintf(buffer,"SAP: EXCEPTION 0x%x  %s for VU(%i)\n",e.Error(), (char 
*)e.Description(), S_task_id); 
SAPGui_error_handler(s_info,buffer); 
} // end catch 

DO_SetTransactionCleanup(); 

/// This command clears the SAP Runtime Object Table (ROT). 
/// Revoking the ROT deletes the SAP runtime environment from memory. 

SAPGuiApplication(RevokeROT); 
 

END_TRANSACTION(); 

REPORT(SUCCESS); 
EXIT(); 
return(0); 

} 
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void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
EXIT(); 

} 

 

Required SAP Script Commands 

Overview : Requi red SAP Script  Com m ands 

Certain commands must be present in  an SAP script . These commands are created automatical ly during the 
conversion process. Most of the commands are before the BEGIN_TRANSACTION statement. Review th is 
sect ion i f you are having unexpected issues after script  edit ing. 

Note: If the SAP script supports transaction restarting, review Required Commands for Supporting 
Transaction Restart in SAP.   

Required Script Commands 

Required commands and associated code statements for the SAP script  are:    

SET_ABORT_FUNCTION(abort funct ion); 

DEFINE_TRANS_TYPE("capture.cpp"); 

HRESULT hr = CoIn it ial ize(0); 

i f( hr != ERROR_SUCCESS ) 

    RR__FailedMsg(s_info, "ERROR in it ial izing COM"); 

SAPGuiSetCheckScreenWildcard(‘*’); 

SYNCHRONIZE(); 

Note: These functions are required, but additional SAP API script commands are also essential to run an 
SAP script. 

Conclusion 

When encountering unexpected compiler errors after script  edit ing, review the script  to ensure al l  required 
commands are present. This might reveal a problem created by the script  edits, especial ly when moving the 
transact ion loop. You must take care when doing extensive script  edit ing not to accidental ly remove 
cri t ical commands. Recording the transact ion again and doing a windiff comparison can also help when 
unexpected compiler errors occur. 

The sample script  shows the statements used in the script . 

 

Sam ple: SAP Script  w i th  Com m ands 

The fol lowing sample is a SAP Script with required commands. Required commands in the script  are 
h ighl ighted in  bold. 

Sample Script  

/* 
 *  capture.cpp 
 * 
 *  Script Converted on July 20, 2004 at 08:43:23 AM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 73 
 * 
 *  This script contains support for the following middlewares:  
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 *      - SAP 
 */ 

/* Converted using the following options: 
 * General: 
 *  Line Split                       : 132 characters 
 *  Sleep Seconds                    : 1 
 *  Constants to Variables           : Yes 
 *  Remove Quotes                    : No 
 *  Tabs To Spaces                   : No 
 *  Auto Checkpoints                 : No 
 * SAP 
 *  Version                          : 6204.119.32 
 */ 

#define SCRIPT_VER 0x00000205UL 

#include <stdio.h> 
#include <windows.h> 
#include <atlbase.h> 
#include <objbase.h> 
#include "do_SAPCCOM.h" 
#include <atlwin.h> 
#include <atlcom.h> 
#include <atlhost.h> 
#include "cscript.h" 
#include "do_SapGui.h" 
#include "mwCommon.h" 

extern "C" { 
#include "smacro.h" 
} 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 

/// These script functions in bold must be present and  
/// before the SYNCHRONIZE command in every SAP script. 

ACTION(); 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("capture.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 

    RR__FailedMsg(s_info,"SAP: ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 
 
SYNCHRONIZE(); 

BEGIN_TRANSDO_SetTransactionStart(); 

try{ 
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SAPGuiConnect( s_info,"testsap620"); 

SAPGuiApplication(RegisterROT); 
 
SAPGuiVerCheckStr("6204.119.32");  
 
//Set SapApplication = CreateObject("Sapgui.ScriptingCtrl.1") 
//SapApplication.OpenConnection ("testsap620") 
//Set Session    = SapApplication.Children(0).Children(0) 
 
DO_SLEEP(18); 
 
SAPGuiPropIdStr("wnd[0]");//1057828784.513 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(16); 
 
SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME");//1057828800.786 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 
 
SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE");//1057828800.796 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~0000x_'9d"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 
 
SAPGuiPropIdStr("wnd[0]");//1057828800.836 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
SAPGuiCheckScreen("S000","SAPMSYST","SAP");//1057828800.856 
 
DO_SLEEP(6); 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(3); 
 
SAPGuiPropIdStr("wnd[0]/tbar[0]/btn[15]");//1057828809.839 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSMTR_NAVIGATION","SAP Easy 
Access");//1057828809.859 
 
DO_SLEEP(2); 
 
SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1");//1057828811.382 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off");//1057828811.402 
 
} // end try 

catch (_com_error e){ 
char buffer[1024]; 
sprintf(buffer,"SAP: EXCEPTION 0x%x  %s for VU(%i)\n",e.Error(), (char 
*)e.Description(), S_task_id); 
SAPGui_error_handler(s_info,buffer); 
} // end catch 

DO_SetTransactionCleanup(); 

SAPGuiApplication(RevokeROT); 
 
END_TRANSACTION(); 

REPORT(SUCCESS); 
EXIT(); 
return(0); 

} 
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void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
EXIT(); 

} 

 

Retrieving SAP Counter Data 

M odi fying the Script  to Ret rieve SAP Coun ter Data 

SAP scripts can retrieve customer counter in formation for each virtual user. By insert ing code snippets that 
use the SAPGui script ing API in to the SAP script , you can obtain and save SAP server in formation.  

To m odi f y t he scr ipt  t o ret r ieve SAP count er  dat a: 

1. Declare and initialize the counter identification (ID) variables using the int data type. You should declare a variable 
for each counter value to be extracted. The DEFINE_COUNTER macro initializes the declared counter identifier 
variable and creates a holder for the value in the timing file. 

2. Declare and initialize the variable to hold the actual SAP counter value. You should  declare the variable using a 
datatype that can hold any expected value for the counter. Usually a long is appropriate.  

3. Retrieve the counter information from the SAP server using the SAPGuiSessionInfo command. The value is placed 
in the variable you created in Step 2. The first parameter is the SAP property object corresponding to the counter. 
The second parameter is the variable to hold the value.  

4. Save the counter value to the timing file. The COUNTER_VALUE macro command extracts the value from the 
server.  The value is extracted to the variable created in Step 2. It is stored in the timing file using the associated ID 
created in Step 1.  

Conclusion 

Fol lowing these techniques, you can obtain customer counter in formation from the SAP server, save i t  to 
the virtual user’s t im ing fi le, and view i t  in  Analyze. The sample original script  and sample modified script  
i l lustrate th is modificat ion.  

 

Sam ple: Original  SAP Script  w i th  Coun ters 

The fol lowing sample shows an original SAP script  extract with counters. Points of in terest in  the script  are 
h ighl ighted in  bold. 

Sample Script  

/* 
 *  counters.cpp 
 * 
 *  Script Converted on July 20, 2004 at 08:43:23 AM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 73 
 * 
 *  This script contains support for the following middlewares:  
 *      - SAP 
 */ 

/* Converted using the following options: 
 * General: 
 *  Line Split                       : 132 characters 
 *  Sleep Seconds                    : 1 
 *  Constants to Variables           : Yes 
 *  Remove Quotes                    : No 
 *  Tabs To Spaces                   : No 
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 *  Auto Checkpoints                 : No 
 * SAP 
 *  Version                          : 6204.119.32 
 */ 

#define SCRIPT_VER 0x00000205UL 

#include <stdio.h> 
#include <windows.h> 
#include <atlbase.h> 
#include <objbase.h> 
#include "do_SAPCCOM.h" 
#include <atlwin.h> 
#include <atlcom.h> 
#include <atlhost.h> 
#include "cscript.h" 
#include "do_SapGui.h" 
#include "mwCommon.h" 

extern "C" { 
#include "smacro.h" 
} 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 

/// Declare the SAP custom counter variable IDs 
/// Also declare any SAP counter value variables. 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("counters.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info,"SAP: ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 

/// Initialize the SAP custom counter variable IDs. 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 

try{ 

SAPGuiConnect( s_info,"testsap620"); 

SAPGuiApplication(RegisterROT); 
 
SAPGuiVerCheckStr("6204.119.32");  
 
//Set SapApplication = CreateObject("Sapgui.ScriptingCtrl.1") 
//SapApplication.OpenConnection ("testsap620") 
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//Set Session    = SapApplication.Children(0).Children(0) 
 
DO_SLEEP(18); 
 
SAPGuiPropIdStr("wnd[0]");//1057828784.513 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(16); 
 
SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME");//1057828800.786 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 
 
SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE");//1057828800.796 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~0000x_'9d"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 
 
SAPGuiPropIdStr("wnd[0]");//1057828800.836 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
SAPGuiCheckScreen("S000","SAPMSYST","SAP");//1057828800.856 
 
DO_SLEEP(6); 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(3); 
 
SAPGuiPropIdStr("wnd[0]/tbar[0]/btn[15]");//1057828809.839 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSMTR_NAVIGATION","SAP Easy 
Access");//1057828809.859 
 
DO_SLEEP(2); 
 
SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1");//1057828811.382 
SAPGuiCmd0(GuiButton,Press); 

/// This is where we would like to retrieve the RoundTrips  
/// and Flushes counter.  Here the SAPGuiSessionInfo command  
/// will be inserted to retrieve these SAP counter values from the server. 

SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off");//1057828811.402 

/// Here is where the counter information will actually be  
/// written to the timing file.  
 

} // end try 

catch (_com_error e){ 
char buffer[1024]; 
sprintf(buffer,"SAP: EXCEPTION 0x%x  %s for VU(%i)\n",e.Error(), (char 
*)e.Description(), S_task_id); 
SAPGui_error_handler(s_info,buffer); 

} // end catch 

DO_SetTransactionCleanup(); 

SAPGuiApplication(RevokeROT); 
 
END_TRANSACTION(); 

REPORT(SUCCESS); 
EXIT(); 
return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 
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{ 
RR__printf("Virtual User ABORTED."); 
EXIT(); 

} 

 

Sam ple: M odi f i ed SAP Script  w i th  Custom  Coun ters 

The fol lowing sample shows a modified SAP script  with SAP custom counters. Changes to Original script  
are h ighl ighted in  bold. 

Sample Script  

/* 
 *  counters.cpp 
 * 
 *  Script Converted on July 20, 2004 at 08:43:23 AM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 73 
 * 
 *  This script contains support for the following middlewares:  
 *      - SAP 
 */ 

/* Converted using the following options: 
 * General: 
 *  Line Split                       : 132 characters 
 *  Sleep Seconds                    : 1 
 *  Constants to Variables           : Yes 
 *  Remove Quotes                    : No 
 *  Tabs To Spaces                   : No 
 *  Auto Checkpoints                 : No 
 * SAP 
 *  Version                          : 6204.119.32 
 */ 

#define SCRIPT_VER 0x00000205UL 

#include <stdio.h> 
#include <windows.h> 
#include <atlbase.h> 
#include <objbase.h> 
#include "do_SAPCCOM.h" 
#include <atlwin.h> 
#include <atlcom.h> 
#include <atlhost.h> 
#include "cscript.h" 
#include "do_SapGui.h" 
#include "mwCommon.h" 

extern "C" { 
#include "smacro.h" 
} 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 
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/// Scripting: Step 1 

int id1, id2, id3, id4; 
long lRoundTrips,lFlushes; 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("counters.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info,"SAP: ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 

/// Scripting: Step 2 

// "Counter Group", "Counter Name", "Counter Units 
// (Optional)", Data Type, Counter Type. 

id1 = DEFINE_COUNTER("Cumulative Group", "Cumulative RoundTrips", 0, DATA_LONG, 
COUNTER_CUMULATIVE); 

id2 = DEFINE_COUNTER("Cumulative Group", "Cumulative Flushes", 0, DATA_LONG, 
COUNTER_CUMULATIVE); 

id3 = DEFINE_COUNTER("Instance Group", "Instance RoundTrips", 0, DATA_LONG, 
COUNTER_INSTANCE); 

id4 = DEFINE_COUNTER("Instance Group", "Instance Flushes", 0, DATA_LONG, 
COUNTER_INSTANCE); 

 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 

try{ 

SAPGuiConnect( s_info,"testsap620"); 

SAPGuiApplication(RegisterROT); 
 
SAPGuiVerCheckStr("6204.119.32");  
 
//Set SapApplication = CreateObject("Sapgui.ScriptingCtrl.1") 
//SapApplication.OpenConnection ("testsap620") 
//Set Session    = SapApplication.Children(0).Children(0) 
 
DO_SLEEP(18); 
 
SAPGuiPropIdStr("wnd[0]");//1057828784.513 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(16); 
 
SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME");//1057828800.786 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 
 
SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE");//1057828800.796 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~0000x_'9d"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 
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SAPGuiPropIdStr("wnd[0]");//1057828800.836 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
SAPGuiCheckScreen("S000","SAPMSYST","SAP");//1057828800.856 
 
DO_SLEEP(6); 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(3); 
 
SAPGuiPropIdStr("wnd[0]/tbar[0]/btn[15]");//1057828809.839 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSMTR_NAVIGATION","SAP Easy 
Access");//1057828809.859 
 
 
DO_SLEEP(2); 
 
SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1");//1057828811.382 
SAPGuiCmd0(GuiButton,Press); 

/// Scripting: Step 3 

SAPGuiSessionInfo(GetRoundTrips,lRoundTrips); 
SAPGuiSessionInfo(GetFlushes,lFlushes); 

SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off");//1057828811.402 
 
/// Scripting: Step 4 

COUNTER_VALUE( id1,lRoundTrips); 
COUNTER_VALUE( id2,lFlushes); 
COUNTER_VALUE( id3,lRoundTrips); 
COUNTER_VALUE( id4,lFlushes); 

} // end try 

catch (_com_error e){ 
char buffer[1024]; 
sprintf(buffer,"SAP: EXCEPTION 0x%x  %s for VU(%i)\n",e.Error(), (char 
*)e.Description(), S_task_id); 
SAPGui_error_handler(s_info,buffer); 

} // end catch 

DO_SetTransactionCleanup(); 

SAPGuiApplication(RevokeROT); 
 
END_TRANSACTION(); 
REPORT(SUCCESS); 
EXIT(); 
return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
EXIT(); 

} 

 



QALoad Online Help 

349 

Winsock Scripts 

Winsock Script Samples  

You can address specific si tuat ions or resolve certain  problems by modifying converted Winsock scripts. 
These samples show a descript ion of the problem, the procedure for implementing the modificat ion, and 
samples of a modified script . Script  modificat ions are discussed for: 

Handling Winsock Connect ion Problems 

Accessing Local and Remote Network Addresses 

Using Central Datapools with in a Winsock Script 

Using Local Datapools with in a Winsock Script 

Accessing Server Replies with DO_WSK_Read 

Accessing Server Replies with DO_WSK_Recv 

Receiving Winsock UDP Data with DO_WSK_Recvfrom 

Sending Variable Data with DO_WSK_Send 

Sending Variable Data using DO_WSK_SendAll  

Sending Variable Data using DO_WSK_SendTo 

Sending Variable Data using DO_WSK_Write 

Accessing Server Replies Using Response() and ResponseLength() 

Parsing Server Replies Using ScanFloat and ScanInt 

Parsing Server Replies Using ScanSkip and ScanString 

Parsing Server Replies Using SkipExpr and ScanSkip 

 

 

Handling Winsock Connection Problems 

Overview : Handl ing Winsock  Connect ion  Probl em s 

When a remote appl icat ion is handl ing other tasks and is not able to accept a connect ion, you can modify 
your script  so that i t  retries the connect ion. When implementing th is sort  of funct ional i ty, be sure you:  

!  Limit  the number of connect ion retries so that the script  doesn't  execute indefin i tely. 

!  Turn off the abort  flag before the connect ion and turn i t  back on immediately after the connect ion 
loop. Otherwise the virtual user aborts when a connect ion fai ls.  

Conclusion 

The sample script  i l lustrates how to create a script  that attempts to reconnect  to a remote appl icat ion i f the 
first  connect ion fai ls.  

Caut ion: It is very import that you specify a limit to the number of connection retries or the script runs in 
an endless loop. This may create a denial of service attack on the remote application.  

 

Sam ple: Handl ing Winsock  Connect ion  Problem s  

The fol lowing script  sn ippet shows an example of how to handle connect ion problems. The code in bold 
shows how you can l im it  the ret ires and turn off the abort  flag. 
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Sample Script Snippet 

… 
/* Declare Variables */ 
//Declared nNumRetries to keep track of the number of retry attempts that are made 
int nNumRetries = 0; 
//Declared “ret” to store the return code from DO_WSK_Connect() 
int ret = -1; 
… 
BEGIN_TRANSACTION(); 

DO_WSK_Socket(S2, AF_INET, SOCK_STREAM, IPPROTO_TCP); 
 
//In order to handle the failure for the DO_WSK_Connect the script needs to 
// turn off the abort on error flag. After the connection is made the flag 
// should be turned back on. 
s_info->bAbortOnError = 0; 

//The example below will try to make a connection to the remote application, 
// and if it fails it will repeat the attempt up to 5 times. 
while( ret = -1 && nNumRetries < 5) 
{ 

//Attempts to connect to the remote application. 
ret = DO_WSK_Connect(S2, "10.4.26.24", 123, AF_INET); 
 
if(ret == -1) 
{ 

//pause between connection attempts 
DO_MSLEEP(500); 
//increment the counter for the number of retry attempts. 
nNumRetries++; 

} 
} 

//turning the abort flag back on. 
s_info->bAbortOnError = 1; 
//If the max number of retries has been met then this virtual user should fail. 
if(nNumRetries == 5) 
RR__FailedMsg(s_info,"ERROR: Max number of connection retries has been reached"); 
...  

DO_WSK_Closesocket(S2); 

 

Parsing Server Replies Using SkipExpr and ScanSkip 

Overview : Parsing Server Repl ies   

You can find a string with in the reply returned from the sever using SkipExpr() and ScanExpr(). SkipExpr() 
searches the in ternal buffer that contains the response received in the DO_WSK_Expect() for the first  
occurance of the string. It  places the pointer in  the posit ion immediately fol lowing the string. Then use 
ScanExpr() to search for the end of the string. This saves the buffer fol lowing the first  occurrence of the 
string used in SkipExpr(), up to and including the string in  ScanExpr(). The first  parameter of ScanExpr() 
takes a Unix-style regular expression. The fol lowing table shows some of the most common expressions. 

Character M ean ing 

“ .”   Matches the end of a string 

“ *”   Matches any number of characters 
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“ ?”  Matches any one character 

Conclusion 

Use the SkipExpr() and ScanExpr() to find a string returned from the server. The sample script  i l lustrates 
th is technique. 

 

Sam ple: Parsing Server Repl ies Using Sk ipExpr an d ScanSk ip 

In  th is example, the buffer returned from the server is: "sessionid=1234567890abc” , and you are retrieving 
everyth ing after the “ =” , up to and including “ abc” . The message “ length = 13 string = 1234567890abc”  is 
prin ted to the player buffer window. The code added to check the status bar is shown in bold. 

Sample Script  
/* Declare Variables */ 
char temp[35]; 
int size = 0; 
… 
BEGIN_TRANSACTION(); 
… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 
//Below indicates the buffer that was received at capture time. 
/* 23 bytes: sessionid=1234567890abc */ 
DO_WSK_Expect(S1, "c"); 

//Finds the string “sessionid=” within the buffer that was received, and 
//the moves the pointer to the next position within the received buffer. 
SkipExpr("sessionid="); 
 
//Copies any data from the current buffer position up to the string “abc” 
//into the variable temp. 
size=ScanExpr(".*abc" , temp); 

//prints the string that was found to the playerbuffer window. 
RR__printf("length =  %d string  = %s", size, temp); 

DO_WSK_Closesocket(S1); 

 

Accessing Local and Remote Network Addresses  

You can retrieve the IP address or port  to which a socket handle is connected, or retrieve the IP address and 
port  to which a socket handle is bound. The sample script  i l lustrates how to retrieve and store socket 
address and port  in format ion. The required code is shown in bold. 

Sam ple Script  
... 
/* Declare Variables */ 

//Belows are two socket structs that will store the address and port information. 
struct sockaddr_in RemoteAddr; 
struct sockaddr_in LocalAddr; 
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… 
BEGIN_TRANSACTION(); 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_TCP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
/* Socket S2 was bound to address 0.0.0.0 on port 3320 (hibyte=12,lobyte=248) */   

//Called after the DO_WSK_Bind() to see which address the socket was bound to 
LocalAddr.sin_addr.s_addr = ntohl(GetLocalAddr(S1)); 

//Called after the DO_WSK_Bind() to see which port the socket was bound to 
LocalAddr.sin_port  = GetLocalPort(S1); 

DO_WSK_Connect(S1, "10.4.26.24", 80, AF_INET); 

//Called to retrieve the remote address that S1 is connected to. 
RemoteAddr.sin_addr.s_addr = ntohl(GetRemoteAddr(S1)); 

//Called to retrieve the remote port that S1 is connected to. 
RemoteAddr.sin_port = ntohs(GetRemotePort(S1)); 

//The function below will print the remote and local address and port information 
// to the playerbuffer. Within the RR__printf() the script is using the socket function 
// “inet_ntoa()” to convert the IP from an unsigned long to a string 
// format, “XXX.XXX.XXX.XXX”. 
RR__printf("Remote: address=%s port=%d",inet_ntoa(RemoteAddr.sin_addr), 
RemoteAddr.sin_port); 
RR__printf("Local: address=%s port=%d",inet_ntoa(LocalAddr.sin_addr), LocalAddr.sin_port); 

DO_WSK_Closesocket(S1); 

… 

Conclusion  

When th is code is executed, a message is prin ted to the playerbuffer, such as: 

VU  0 : Remote: address=10.4.26.24 port=80 

VU 0 : Local: address=10.15.16.26 port=1125 

 

Accessing Server Replies Using Response and ResponseLength  

You can save the ent ire reply that a server returns using Response() and ResponseLength(). When you cal l  
Response() direct ly after the DO_WSK_Expect(), i t  returns a pointer to the data received by the 
DO_WSK_Expect(). To receive the length of the received reply, cal l  the ResponseLength(). This returns the 
number of characters received.  

The sample script  i l lustrates how to use these commands to save a server reply. In  th is sample, the code in 
bold shows how to use Response() and ResponseLength().  

Sam ple Script  
/* Declare Variables */ 
//Below are variables needed for this example 
int x = 0; 
char *temp; 
… 
BEGIN_TRANSACTION(); 
… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
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DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 
 
//Below is the actual buffer that was returned at capture time. 
/* 21 bytes: You are now connected */ 
DO_WSK_Expect(S1, "d"); 

// used to store the data that was received by the DO_WSK_Expect 
temp = Response();  

//used to get the size of the response that was received so far. 
x = ResponseLength(); 

//The line below will print the length of the response  to the playerbuffer 
RR__printf(“The size of the received buffer was %d bytes ",x,); 

DO_WSK_Closesocket(S1); 

Conclusion  

In  th is example, Response() and ResponseLength() are used to prin t  the message “ The size of the received 
buffer was 21 bytes”  to the player buffer window. 

 

Accessing Server Replies with DO_WSK_Read  

When the data received is too dynamic and there is noth ing on which to base the unique string,you 
cannot use the DO_WSK_Expect() to access server repl ies. In  th is case, when the number of characters 
received is always the same, you can use DO_WSK_Read().  

In  the fol lowing example, the user sends a logon string to the server and the server sends back a unique 
key that is used for subsequent cal ls. Since the ending characters always change, DO_WSK_Read is cal led to 
receive a specified number of characters. You can parse th is data for any values you need. The required 
code is shown in bold. 

Sam ple Script  
... 
BEGIN_TRANSACTION(); 

DO_WSK_Socket(S2, AF_INET, SOCK_STREAM, IPPROTO_TCP); 
 
DO_WSK_Bind(S2, ANY_ADDR, ANY_PORT); 
 
DO_WSK_Connect(S2, "10.4.26.24", 80, AF_INET); 
 
/* 20 bytes */ 
DO_WSK_Send(S2, "^@user=Bob^@pwd=CPWR^@\377"); 
 
//The data that is being sent from the server is dynamic and the ending 
// character is never the same. Since this is the case using 
// DO_WSK_Expect() will not work, so the script will use DO_WSK_Read() 
// to receive the same number of bytes that were originally sent. 
/* 14 bytes: SID=1234567890 */ 
//DO_WSK_Expect(S2, "^@"); 
 
//The script will now print the response that was received by 
// calling Response() to gain access to the received buffer. 

If ( DO_WSK_Read(S2,14) != -1) 
RR__printf("String = %s",Response()); 
... 

Conclusion  
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Using DO_WSK_Read() instead of DO_WSK_Expect() al lows the virtual user to receive a specific number of 
bytes instead of a sequence of characters. 

 

Accessing Server Replies with DO_WSK_Recv  

When the data returned is too dynamic and the DO_WSK_Expect() fai ls, you can use DO_WSK_Recv() to 
store the reply returned from the server. This saves the response based on i ts size instead of on the unique 
character string used in the DO_WSK_Expect(). When you use DO_WSK_Recv(), you specify how much 
data you want to receive and where to store i t . In  th is sample, the required code is shown in bold. 

Sam ple Script  

/* Declare Variables */ 
//Below are variables that were declared to use with DO_WSK_Recv, 
//and the size of temp will vary depending upon the buffers that your 
//application is returning. 
int size = 0; 
char temp[45]; 
… 
BEGIN_TRANSACTION(); 
… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 
 
//Below is the data that was received at capture time. 
/* 21 bytes: You are now connected */ 
 
//Initializing the temp variable 
memset(temp,'\0',45); 

//Instead of calling DO_WSK_Expect() to receive the data, the 
//script will now call DO_WSK_Recv(). This will allow the script to  
//receive a specified number of characters instead of looking at the data 
//to determine if the buffer has been received entirely or not. 

DO_WSK_Recv(S1,temp,45,0,&size); 

//Original function that was in the script 
//DO_WSK_Expect(S1, “d”); 
//Prints the size of the string that was received to the playerbuffer. 
RR__printf("Size of the received buffer was %d bytes", size); 

DO_WSK_Closesocket(S1); 

Conclusion  

In  th is example, the message “ Size of the received buffer was 21 bytes”  is prin ted to the player buffer 
window.  

Caut ion: When using this method instead of the DO_WSK_Expect(), verify that you receive the correct 
information before moving on to the next function in your script. 
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Parsing Server Replies Using ScanFloat and ScanInt  

Sometimes local appl icat ions must in terpret and act on numeric values sent from a remote appl icat ion. For 
example, remote appl icat ions may send a port  number to the local appl icat ion. The local appl icat ion parses 
the remote port  from the data i t  receives and attempts to connect to the remote machine on the new port .  

By using ScanInt(), you can parse the received buffer for numeric values, such as port  numbers, or use 
ScanFloat() to parse for larger numeric values. The sample script  i l lustrates how to use ScanFloat() and 
ScanInt(). The required code is shown in bold. 

Sam ple Script  

... 

/* Declare Variables */ 

//The variable "port" was declared to store the port# that the remote 

// application sends. The variable "nID" is used to store the unique 

// ID that is sent by the remote application. 

unsigned short port; 

float nID; 

... 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_TCP); 

DO_WSK_Socket(S2, AF_INET, SOCK_STREAM, IPPROTO_TCP); 

DO_WSK_Connect(S1, "10.15.21.225", 33, AF_INET); 

 

/* 11 bytes: "port=\nA\0\0aB" */ 

 

//Since the end of the data that is being received is dynamic, the 

// script will use DO_WSK_Read() to receive the data instead 

// using the DO_WSK_Expect() that was converted into the script. 

//DO_WSK_Expect(“B”); 
DO_WSK_Read(S1,11); 

//Calling ScanSkip to move the pointer to the first byte of the port 

ScanSkip(5); 

 

//Calling ScanInt to copy the next two bytes into a variable that will 

// store the port from the remote application. 

ScanInt(MyByteOrder(),2,(char*)&port); 

 

//Calling ScanFloat to copy the next four bytes into a variable that will 

// store the unique ID from the remote application. 

ScanFloat(MyByteOrder(),4,(char*)&nID); 

//Printing the port number to the playerbuffer window, and converting  

// the value from network byte order to host byte order. 
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RR__printf("port=%d",ntohs(port)); 

//Printing the unique ID that the remote application sent to the  

// playerbuffer. 

RR__printf("float=%f",nID); 

DO_WSK_Closesocket(S1); 

//Below is the original DO_WSK_Connect that was converted into the script 

//DO_WSK_Connect(S2,”10.15.21.225”, 2526, AF_INET); 

//Uses the port that was returned above to reconnect to the remote application 

DO_WSK_Connect(S2, "10.15.21.225", ntohs(port), AF_INET); 

DO_WSK_Send(S2,"Hello World"); 

DO_WSK_Closesocket(S2); 

... 

Conclusion  

In  th is example, the script  parses the port  number sent from the remote appl icat ion and uses th is to 
reconnect to the remote appl icat ion. The script  also uses ScanFloat() to parse a unique ID from the message 
sent by the remote appl icat ion. 

 

Parsing Server Replies Using ScanSkip and ScanString  

Data returned from the server may be too dynamic to base your parsing on actual characters. In  th is case, 
 you can base your search on character posit ions using ScanSkip() and ScanString().  

For example, you can save characters 20 through 25 that are returned from a server. The ScanSkip() skips 
the specified number of characters in  the in ternal buffer that stores the response received in the 
DO_WSK_Expect(). The ScanString() scans the number of characters you specify in to a character string 
from the current posit ion in  the buffer.  

In  th is sample,  the buffer returned from the server is xxx123456789yyy. You are retrieving the value 
between xxx and yyy. The required code is shown in bold. 

Sam ple Script  

... 

/* Declare Variables */ 

//Variable to store the string that we are searching for. 

char temp[15]; 

… 
BEGIN_TRANSACTION(); 

… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 

 

DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 

 

DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
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DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

 

//Below is the actual data that was returned at capture time. 

/* 16 bytes: xxx0123456789yyy */ 

DO_WSK_Expect(S1, "yyy"); 

//making sure that all of the data within our variable has been initialized  

memset(temp,'\0',15); 

//skips 3 bytes within the buffer that was received. 

ScanSkip(3);  

 

//copies the next 10 bytes of the buffer that was received into our temp variable 

ScanString(10,temp); 

//Displays the string that was found to the playerbuffer window. 

RR__printf("string=%s",temp); 

DO_WSK_Closesocket(S1); 

... 

Conclusion  

In  th is example, the message “ string=0123456789”  is prin ted to the player buffer window. 

 

Receiving Winsock UDP Data with DO_WSK_Recvfrom  

When the appl icat ion you are capturing is using the UDP protocol, you can use the DO_WSK_Recvfrom() 
to receive data from the remote appl icat ion. The sample script  i l lustrates how to use the Do_Wsk_Recvfrom 
(). The required code is shown in bold. 

Sam ple Script  

... 

/* Declare Variables */ 

//The variable strBuf is used to formulate the dynamic data that is  

// sent in the DO_WSK_Sendto() below. 

char strBuf[256]; 

//RemoteAddr stores the remote applications address and port 

struct sockaddr_in RemoteAddr; 

//nBytes is used to stor the number of bytes that were received via DO_WSK_Recvfrom() 

int nBytes = 0; 

… 
BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_DGRAM, IPPROTO_UDP); 

 

DO_WSK_Bind(S1, "10.15.16.26", 333); 

 



QALoad 5.5  

358 

//Receives data via the UDP protocol 

DO_WSK_Recvfrom(S1,strBuf,(struct sockaddr*) &RemoteAddr, 256, 0, &nBytes);  

 

//Prints to the player buffer the number of bytes that were received and 

// the remote address and port that sent them. 

RR__printf("Received %d bytes from %s:%d", 

nBytes, inet_ntoa(RemoteAddr.sin_addr),  

ntohs(RemoteAddr.sin_port)); 

… 
DO_WSK_Closesocket(S1); 

Conclusion  

This example shows how to use DO_WSK_Recvfrom() to receive UDP protocol data. It  shows how to access 
the address and port  of the remote appl icat ion sending the data. 

 

Sending Variable Data with DO_WSK_Send  

Captured data may not be the data you want to use while running a test. For example, you might change 
the user name sent during capture t ime to a differen t value during replay. You can change the value in  the 
DO_WSK_Send() to make a stat ic value with in the funct ion. However, i f you want to subst i tute a different 
value each t ime, you can create a dynamic variable, such as a datapool value, to replace the user name.  

In  th is example, the script  includes a DO_WSK_Send() that sends “ name=Jim ”  to the server as the user 
name. For test ing purposes, you want to change the name to include a variable that represents a different 
name, such as “ Mark” . The code required for th is is shown in bold. 

Sam ple Script  

…  

/* Declare Variables */ 

//Below are variables needed for the dynamic data. The size of these 

//variables will depend upon how big the buffer is that you are replacing 

char buffer[65]; 

char sendbuffer[65]; 

… 
BEGIN_TRANSACTION(); 

… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 

 

DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 

 

DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 

 

DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

 

//Below is the original send based upon the capture file. 
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// DO_WSK_Send(S1,"name=Jim"); 

//The script will now create a buffer that is different than what was captured, 

//and if we wanted the string “Mark” could also of been a datapool value. 
strcpy( buffer, "Mark"); 

sprintf( sendbuffer, "name=%s", buffer); 

//The script will now send the variable string that was created above 

DO_WSK_Send(S1, sendbuffer); 

/* 2 bytes: ok */ 

DO_WSK_Expect(S1,"ok"); 

DO_WSK_Closesocket(S1); 

Conclusion  

In  th is example, the user name sent to the server is changed from “ name=Jim ”   to “ name=Mark”  by 
modifying the buffer before the DO_WSK_Send() and passing the new buffer as the second parameter of 
the DO_WSK_Send(). 

 

Sending Variable Data using DO_WSK_SendAll  

When only a port ion of a string that the script  is sending must be modified to make i t  dynamic, using the 
DO_WSK_SendAll() can be easier than modifying the DO_WSK_Send().  

The fol lowing example sends the username “ Bob”  and the password “ CPWR”  to the server to logon. Since 
only one instance of th is user can be logged on to the server, you must modify the script  to read different 
user names and passwords from a datapool before sending i t . In  the sample script  sn ippet, the required 
code is shown in bold. 

Sam ple Script  

... 

BEGIN_TRANSACTION(); 

//Reads in a datapool record to be used to make the username and password dynamic. 

GET_DATA(); 

DO_WSK_Socket(S2, AF_INET, SOCK_STREAM, IPPROTO_TCP); 

 

DO_WSK_Bind(S2, ANY_ADDR, ANY_PORT); 

 

DO_WSK_Connect(S2, "10.0.6.32", 80, AF_INET); 

 

//In the string that was sent below "Bob" and "CPWR" both need to be modified 

// to allow for multiple users to execute this script. 

/* 20 bytes */ 

//DO_WSK_Send(S2, "^@user=Bob^@pwd=CPWR^@\377"); 

 

//Using DO_WSK_Sendall the message that is being sent can easily be modified, so 

// that the script can read in the username and password from a datapool file. 
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DO_WSK_SendAll(S2,5, "^@user", VARDATA(1), "^@pwd=", VARDATA(2), "^@\377"); 

/* 15 bytes: SID=1234567890^@ */ 

DO_WSK_Expect(S2, "^@"); 

 

DO_WSK_Closesocket(S2); 

... 

Conclusion  

In  the sample modified script , the user name and password are read in from a datapool fi le and the data is 
sent using the DO_WSK_SendAll(). 

 

Sending Variable Winsock UDP Data 

Captured data may not be the data that you want to use while running a test. For example, you may want 
to subst i tute a user name sent during capture with a different value each t ime during replay. You can do 
th is using a dynamic variable, such as a datapool variable.  

Note: Changing the value located in the DO_WSK_Sendto() makes the value static within the function.  

In  th is sample, the code in bold below shows how change data values. 

Sam ple Script  

... 

/* Declare Variables */ 

//The variable strBuf is used to formulate the dynamic data that is  

// sent in the DO_WSK_Sendto() below. 

char strBuf[24]; 

…  
BEGIN_TRANSACTION(); 

//Reads in a row of data from a central datapool file, and this will be 

//used as part of the dynamic data that will be sent via the DO_WSK_Sendto() 

GET_DATA(); 

DO_WSK_Socket(S1, AF_INET, SOCK_DGRAM, IPPROTO_IP); 

 

DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_BROADCAST, 1); 

 

DO_WSK_Bind(S1, "127.0.0.1", 5634); 

 

//Below is the original DO_WSK_Sendto() that was converted into the script 

//DO_WSK_Sendto(S1, "name=Brian", "10.25.26.24", 1234); 

//The example below reads a record in from a central datapool, and the value 

// is then sent as part of the DO_WSK_Sendto() buffer. 

memset(strBuf, 0, 24); 

sprintf(strBuf, "name=%s", VARDATA(1)); 

DO_WSK_Sendto(S1, strBuf, "10.25.26.24",  1234); 
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… 
DO_WSK_Closesocket(S1); 

… 

Conclusion  

In  th is example, the virtual user reads in  a row of data from a central datapool, which is used to create a 
dynamic message. This message is used in the DO_WSK_Sendto() to send i t  to the address “ 10.25.26.24” . 

 

Sending Variable Data using DO_WSK_Write  

You can use DO_WSK_Write() instead of DO_WSK_Send() when coding scripts by hand. DO_WSK_Write() 
does not expect strings that have certain control and nul l  characters encoded, as does DO_WSK_Send(). 
This al lows you to send data without using EscapeStr() to encode any possible control characters.  

The sample script  i l lustrates how to use DO_WSK_Write(). The required code is shown in bold. 

Sam ple Script  

... 

/* Declare Variables */ 

//Variable that will be used to send data to the server via DO_WSK_Write() 

char temp[24]; 

... 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S2, AF_INET, SOCK_STREAM, IPPROTO_TCP); 

DO_WSK_Bind(S2, ANY_ADDR, ANY_PORT); 

DO_WSK_Connect(S2, "10.4.26.24", 60, AF_INET); 

 

//The original data that was sent was... "^@user=Bob^@pwd=CPWR^@", and the 

// ^@ are encoded null characters. The function below constructs the same 

// data that was sent without the data being encoded. 

memcpy(temp,"\0user=Bob\0pwd=CPWR\0", 19); 

/* 19 bytes */ 

//The DO_WSK_Send() below was converted to the script from the capture file. 

//DO_WSK_Send(S2, "^@user=Bob^@pwd=CPWR^@"); 

 

//Since the script is now using DO_WSK_Write() to send the data it does not 

//need to call EscapeStr() to encoded the NULL characters within the string 

//that is being sent. 

DO_WSK_Write(S2,temp, 19); 

/* 15 bytes: SID=1234567890^@ */ 

DO_WSK_Expect(S2, "^@"); 

DO_WSK_Closesocket(S2); 

... 



QALoad 5.5  

362 

Conclusion  

In  the sample script , the data was sent using the DO_WSK_Write() instead of the DO_WSK_Send(). This 
al lows you to send data without encoding i t .  

 

Using Central Datapools within a Winsock Script  

You can use dynamic data in  your script  by reading data from a datapool fi le. However, datapool fi les must 
be in  an ASCII string, and not al l  dynamic data are in  th is format. For example, when the string 
 “ \ 121\ 101\ 114\ 157\ 141\ 144”  appears in  a datapool fi le and is read in using a one of the datapool 
funct ions, you receive \ \ 121\ \ 101\ \ 114\ \ 157\ \ 141\ \ 144 as the output.  

You can ensure that the output string you receive is accurate by using the OctalToChar() to convert  any 
octal sequences into their binary representat ion. In  th is sample script , the string 
“ \ 121\ 101\ 114\ 157\ 141\ 144”  is read in from a central datapool fi le and converted to i ts binary 
representat ion. The required code is shown in bold. 

Sam ple Script  

/* Declare Variables */ 

//Variable declared to store the central datapool record. 

char temp[40]; 

… 
BEGIN_TRANSACTION(); 

//Gets a row of data from the Conductor during the test. 

GET_DATA(); 

… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 

 

DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 

 

DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 

//Read the first column from the central datapool row that was  

//returned when the GET_DATA() was called. 

strcpy(temp,VARDATA(1)); 

 

//used to convert octal strings to their binary format 

OctalToChar(temp);  

//The script is now setup to send the data that was read in from the 

//central datapool file instead of the hard coded values that were captured. 

DO_WSK_Send(S1,temp); 

//Below is the original send that was captured. 

//DO_WSK_Send(S1,”\121\101\122\165\156”); 

DO_WSK_Closesocket(S1);  

Conclusion  
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In  th is example, the DO_WSK_Send() sends the octal representat ion for the string “ QALoad” , 
 “ \ 121\ 101\ 114\ 157\ 141\ 144” , to the server.  

 

Using Local Datapools within a Winsock Script  

You can use dynamic data in  your script  by reading data from a datapool fi le. However, datapool fi les must 
be in  an ASCII string, and not al l  dynamic data are in  th is format. For example, when the string 
 “ \ 121\ 101\ 114\ 157\ 141\ 144”  appears in  a datapool fi le and is read in using a one of the datapool 
funct ions,  you receive \ \ 121\ \ 101\ \ 114\ \ 157\ \ 141\ \ 144 as the output.  

You can ensure that the output string you receive is accurate by using the OctalToChar() to convert  any 
octal sequences into their binary representat ion. In  th is sample script , the string 
“ \ 121\ 101\ 114\ 157\ 141\ 144”  is read in from a local datapool fi le and converted to i ts binary 
representat ion. The required code is shown in bold. 

Sam ple Script  

//This is used as an easy to remember descriptor for the datapool file. 

#define DP1 1/* Identifier for a datapool file*/ 

/* Declare Variables */ 

//Variable declared to store the local datapool record. 

char temp[40]; 

… 
//Opens the datapool file 

OPEN_DATA_POOL("datapool.dat", DP1, TRUE) 

BEGIN_TRANSACTION(); 

//Reads a row of data in from the datapool file that was opened above 

READ_DATA_RECORD(DP1); 

… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 

 

DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 

 

DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 

//Read the first column from the local datapool row that was  

//returned when the READ_DATA_RECORD () was called. 

strcpy(temp, GET_DATA_FIELD(DP1, 1)); 

 

//used to convert octal strings to their binary format 

OctalToChar(temp);  

//The script is now setup to send the data that was read in from the 

//local datapool file instead of the hard coded values that were captured. 

DO_WSK_Send(S1,temp); 

//Below is the original send that was captured. 

//DO_WSK_Send(S1,”\121\101\122\165\156”); 
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DO_WSK_Closesocket(S1);  

Conclusion  

In  th is example, the DO_WSK_Send() sends the octal representat ion for the string “ QALoad” , 
 “ “ \ 121\ 101\ 114\ 157\ 141\ 144” , to the server.  

 

WWW Scripts 

WWW Script Samples  

You can address specific si tuat ions or resolve certain  problems by modifying converted WWW scripts. The 
samples shown here include a descript ion of the problem, the procedure for implementing the 
modificat ion, and samples of a modified script . Scripts modificat ions are discussed for: 

Extract ing a String from a WWW Response and Reusing i t  as a CGI Parameter 

Extract ing and Reusing Web Service XML Values 

Moving the Transact ion Loop 

Extract ing and Reusing Cookies 

Extract ing a String from a WWW Response for Val idat ion 

Forcing a Subrequest 

IP Spoofing with a Local Datapool 

Prevent ing Unwanted Subrequests 

 

Extracting a String from a WWW Response for Validation 

Overi vew : Ex t ract ing a St r ing f rom  WW W Response for Val idat ion  

In  some load tests, you must val idate an operat ion by examining a string other than the document t i t le. In  
these cases, you can extract the string and use a comparison funct ion. 

Script ing 

When you script  for string extract ion and val idat ion, you must: 

!  Create the variable to store the extracted string value. 

!  Modify the script to extract the string from the response page. 

!  Compare the extracted string to the expected result. 

Visual Navigator 

If you are using Visual Navigator, you can use the Content Check in  the tree view to specify any text that 
should be present in  the response.  

Conclusion 

Using these script ing techniques, you can modify a script  for string extract ion  and val idat ion. The sample 
script  segment i l lustrates the use of extract ion and comparison. 

 

Sam ple: Ex t ract ing a St r ing f rom  WW W Response for Val idat ion  
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The fol lowing sample is a script  segment that i l lustrates the use of extract ion and comparison. 

Sample Script  

. 

. 

. 

// Declare variables 

CloadString strName = “”; 
Navigate_To(“http://test.page.com”); 
Click_on(LINK, “First Test”); 
/* 

 * 

 * This page should return HTML in this form 

 ******************************************** 

 <HTML> 

 <HEAD>Test Page</HEAD> 

 <BODY> 

 Welcome to the first day of testing, James.<br> 

 You have 42 tasks left to complete. 

 </BODY> 

 </HTML> 

 ******************************************** 

 * 

* Passing the test requires that the name on 

* the page is James and not Jim. 

 * 

 */ 

strName = Get(REPLY, STRING, “testing, “, “.<br>”); 
if ( strName.Compare(“James”) != 0) 
{ 

RR__FailedMsg(s_info, "James was not returned"); 

} 

. 

. 

. 

 

Extracting a String from a WWW Response to Reuse as a CGI Parameter 

Overview : Ex t ract ing and Reusing a St r ing as a CGI Param eter 

Page requests sometimes use CGI parameter values received in a previous page response. Since the value is 
received dynamical ly, the script  must extract that value from the previous response and insert  i t  in to the 
CGI parameter l ist  at  runt ime.  
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Script ing 

When you script  for string extract ion and reuse, you must: 

!  Create the variables to store the extracted string value. 

!  Modify the script to extract the string values from the page response. 

!  Insert the variables into the CGI parameter list. 

Visual Navigator 

When you use Visual Navigator, you can use the Parameterizat ion Rules Wizard for th is task.  

Conclusion 

By fol lowing these script ing techniques, you can modify a Visual Script  to extract values from page 
requests and reuse the string's CGI parameter values in  later page requests. You can use similar script ing 
techniques for reusing extracted strings in  form values. 

The sample original script  and the sample modified script  i l lustrate the procedure for extract ing and 
reusing a string. 

 

Sam ple: Original  WWW Script  Sn ippets 

The fol lowing are original script  sn ippets from a record session before extract ing a string to reuse as a CGI 
parameter. The sample below has two page requests. The first  request returns HTML with values that must 
be extracted for use with the second page request. The second page request uses form values to pass the 
CGI parameters.  The comments indicate the locat ions in  the script  where the script ing steps occur. Points 
of in terest in  the script  are h ighl ighted in  bold 

Sample Script  Snippets 

... beginning of script ... 

extern "C" int rhobot_script(PLAYER_INFO* s_info) 

{ 

// Declare Variables 

//  

// Add variables to receive extracted strings here! 

// NOTE: Declare the variable as CLoadString – this 
//     class is used by Visual Script to encapsulate 

//     string functionality.                 

SET_ABORT_FUNCTION(abort_function); 

... script up to Request #2 ... 

//---------  REQUEST # 2 --------- 

// 

//  current page url is http://qawebserv/cgiquery.htm 

// 

Click_On(LINK, 1, DESCRIPTION, "CGI Query Example"); 

Verify(PAGE_TITLE, "CGI Query Example"); 

 



QALoad Online Help 

367 

// The response page for this request will contain  

// the values we want to extract. Each value will  

// be extracted using the Get command with the STRING attribute  

// set and the left (preceded-by string) and  

// right (followed-by string) as parameters.  

/*** HTML snippet with values we’re looking to extract *** 
<body><h2>Get Query Value Result</h2> 

Name: JohnDoe <br> 

Password: jdoe<br> 

E-mail Address: johndoe@compuware.com<br> 

Address: One Main Street<br> 

City: Anywhere<br> 

State: NY<br> 

Zip Code: 12345<br> 

Comments:This is an example of string extraction in WWW<br> 

<hr> 

*** / 

//---------  REQUEST # 3  (see action item on Page 6)  --------- 

// 

//  current page url is http://qawebserv/cgiquery.htm 

// 

// The values set for the CGI parameter in the Set command 

// will need to be replaced with variables holding the  

// extract string values.  

Set (NEXT_REQUEST_ONLY, CGI_PARAMETER, "name", "JohnDoe"); 

Set (NEXT_REQUEST_ONLY, CGI_PARAMETER, "password", "jdoe"); 

Set (NEXT_REQUEST_ONLY, CGI_PARAMETER, "e-mail",  

"johndoe@compuware.com"); 

Set (NEXT_REQUEST_ONLY, CGI_PARAMETER, "address",  

"One Main Street"); 

Set (NEXT_REQUEST_ONLY, CGI_PARAMETER, "city", "Anywhere"); 

Set (NEXT_REQUEST_ONLY, CGI_PARAMETER, "state", "NY"); 

Set (NEXT_REQUEST_ONLY, CGI_PARAMETER, "zip", "12345"); 

Set (NEXT_REQUEST_ONLY, CGI_PARAMETER, "comments",  

"This is an example of string extraction in WWW"); 

 

Click_On(BUTTON, 1, DESCRIPTION, "Submit CGI Query"); 

Verify(PAGE_TITLE, "CGI Query - Results"); 

... end of script... 
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Sam ple: M odi f i ed WW W  Script  Sn ippets  

The fol lowing sample is a modified WWW script sn ippet that extracts a string to reuses i t  as a CGI 
parameter. Changes to original script  are h ighl ighted in  bold. 

Sample Script  Snippet 

... beginning of script... 

extern "C" int rhobot_script(PLAYER_INFO* s_info) 

{ 

// Declare Variables 

//  

CLoadString strName = ""; 

CLoadString strEmailAddress = ""; 

CLoadString strPassword = ""; 

CLoadString strAddress = ""; 

CLoadString strCity = ""; 

CLoadString strState = ""; 

CLoadString strZip = ""; 

CLoadString strComment = ""; 

SET_ABORT_FUNCTION(abort_function); 

... script up to Request #1... 

//---------  REQUEST # 2 --------- 

// 

//  current page url is http://qawebserv/cgiquery.htm 

// 

Click_On(LINK, 1, DESCRIPTION, "CGI Query Example"); 

Verify(PAGE_TITLE, "CGI Query Example"); 

 

strName = Get(REPLY, STRING, "Name: ", " <br>"); 

strPassword = Get(REPLY, STRING, "Password: ", "<br>"); 

strEmailAddress = Get(REPLY, STRING, "E-mail Address: ", "<br>"); 

strAddress = Get(REPLY, STRING, "<br>\rAddress: ", "<br>"); 

strCity = Get(REPLY, STRING, "City: ", "<br>"); 

strState = Get(REPLY, STRING, "State: ", "<br>"); 

strZip = Get(REPLY, STRING, "Zip Code: ", "<br>"); 

strComment = Get(REPLY, STRING, "Comments: ", "<br>"); 

//---------  REQUEST # 3  (see action item on Page 2)  --------- 

// 

//  current page url is http://qawebserv/cgiquery.htm 

// 

Set (NEXT_REQUEST_ONLY, CGI_PARAMETER, "name", __Name); 

Set (NEXT_REQUEST_ONLY, CGI_PARAMETER, "password", __Password); 
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Set (NEXT_REQUEST_ONLY, CGI_PARAMETER, "e-mail", __EmailAddress); 

Set (NEXT_REQUEST_ONLY, CGI_PARAMETER, "address", __Address); 

Set (NEXT_REQUEST_ONLY, CGI_PARAMETER, "city", __City); 

Set (NEXT_REQUEST_ONLY, CGI_PARAMETER, "state", __State); 

Set (NEXT_REQUEST_ONLY, CGI_PARAMETER, "zip", __Zip); 

Set (NEXT_REQUEST_ONLY, CGI_PARAMETER, "comments", __Comment); 

 

Click_On(BUTTON, 1, DESCRIPTION, "Submit CGI Query"); 

Verify(PAGE_TITLE, "CGI Query - Results"); 

... end of script... 

 

Extracting and Reusing Cookies 

Overview : Ex t ract ing and Reusing a Cook ie 

In  some load tests, you may need to extract a cookie and use i t  later in  the script .   

Script ing 

To extract the cookie, use the DO_GetCookie(). Reuse the value with DO_SetValue. 

Conclusion 

The sample script  sn ippet i l lustrates extract ing and reusing a cookie. 

 

Sam ple: Ex t ract ing and Reusing a Cook ie  

The fol lowing sample is a port ion of a script  that extracts and reuses a cookie. 

Sample Script  

char * userid;  

char * aspsessionid;  

...  

...  

BEGIN_TRANSACTION();  

...  

...  

/* Request: 1 */  

DO_Http ("GET http://company.com/ HTTP/1.0\r\n\r\n");  

/*  

 * Get a cookie named USER_ID  

 */  

DO_GetCookie ( "USER_ID", 1, &userid );  

/*  

 * Get the second ASPSESSIONID cookie. ASPSESSIONID  
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 * cookies always have extra characters on the end to make  

 * them unique.  

 *  

 * An example ASPSESSIONID: ASPSESSIONIDQQQGGQDO=EBOOONBBFH  

 * BBELAJIMEFAKAP  

 */  

DO_GetCookie ("ASPSESSIONID*", 2, &aspsessionid );  

DO_SetValue(“User”, userid) 

DO_Http("POST http://company.com/ HTTP/1.0\r\n\r\n” 
 “Content-Type: application/x-www-form-urlencoded\r\n" 
 "Content-Length: {*content-length}\r\n" 

        “{User}”);  
 

Extracting and Reusing Web Service XML Values 

Overview : Ex t ract ing and Reusing Web Servi ce XM L Values 

When test ing Web services, data dependencies may exist  between XML request data values and XML 
values returned as part  of an XML document reply earl ier in  the script . You can retrieve values from a 
response contain ing an XML document and store the values in  a variable, by using a version of the Get 
command. You can reuse th is value as a CGI parameter, as post data, or you can subst i tute i t  into an XML 
document string sent as part  of a Web Services XML request.   

To m odi f y t he scr ipt : 

1. Extract an XML value by inserting a Get command in the script after the request.  

2. Ensure that the XPATH attribute is set and that the XML element is specified. Use the modified XPath syntax used 
by QALoad to extract text and attribute values from an XML document response page.  

Visual Navigator 

Visual Navigator provides a GUI in terface in  the Visual t ree pane. You can use th is to extract text and 
attribute values from XM L documents returned as a reply, and to parameterize text and attribute values 
sent as part  of an XML request.   

Conclusion 

By fol lowing these techniques, you can extract  XM L text and attribute values from XML documents in to 
variables for later use.  

The sample original script  and the sample modified script  i l lustrate these techniques. The modified script  
reuses the value in  a subsequent  XML request.  

 

Sam ple: Original  WWW Script  for W eb Servi ces  

The fol lowing sample shows original script  sn ippets converted from a record session. Points of in terest in  
the script  are h ighl ighted in  bold. Bold and i tal icized text indicates script  l ines that wi l l  be modified. 

Sample Script  Snippets 

... beginning of script ... 
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extern "C" int rhobot_script(PLAYER_INFO* s_info) 

{ 

// Declare Variables 

// 

CLoadString _QALTmpVars[  4]; 

// Create and initialize the CLoadString variable to  

// hold the XML value. 

... more script to Request 1... 

//---------  REQUEST # 1  --------- 

// 

Set (NEXT_REQUEST_ONLY, HEADER, "SOAPAction",      

"\"http://tempuri.org/Calc/action/Calc.Add\""); 

_QALTmpVars[0]  = "<?xml version=\"1.0\" encoding=\"UTF-8\"  

standalone=\"no\"?>"; 

_QALTmpVars[0] += "<SOAP-ENV:Envelope SOAP-ENV:encodingStyle=\"\" 

xmlns:SOAPSDK1=" 

"\"http://www.w3.org/2001/XMLSchema\" xmlns:SOAPSDK2=" 

"\"http://www.w3.org/2001/XMLSchema-instance\" xmlns:SOAPSDK3=" 

"\"http://schemas.xmlsoap.org/soap/encoding/\"  

xmlns:SOAP-ENV=" 

     "\"http://schemas.xml"; 

_QALTmpVars[0] += "lsoap.org/soap/envelope/\">"; 

_QALTmpVars[0] += "<SOAP-ENV:Body SOAP-ENV:encodingStyle=" 

     "\"http://schemas.xmlsoap.org/soap/encoding/\">"; 

_QALTmpVars[0] +=  "<m:Add  

xmlns:m=\"http://tempuri.org/Calc/message/\" " 

      "SOAP-ENV:encodingStyle=\"\">"; 

_QALTmpVars[0] +=   "<A SOAP-ENV:encodingStyle=\"\">10</A>"; 

_QALTmpVars[0] +=   "<B SOAP-ENV:encodingStyle=\"\">5</B>"; 

_QALTmpVars[0] +=  "</m:Add>"; 

_QALTmpVars[0] += "</SOAP-ENV:Body>"; 

_QALTmpVars[0] += "</SOAP-ENV:Envelope>"; 

 

Set(NEXT_REQUEST_ONLY, XML_DATA, (char *)_QALTmpVars[0]); 

XmlRequest( "POST", 
       "http://mssoapsampleserver/MSSoapSamples30/Calc/Service/SrSz/AspVbsCpp/Calc." 

        "asp" ); 

// An XML text value from the XML document returned from  

// Request 1 will be extracted here using an inserted Get command. 
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//---------  REQUEST # 2  --------- 

// 

Set (NEXT_REQUEST_ONLY, HEADER, "SOAPAction", 

 "\"http://tempuri.org/Calc/action/Calc.Multiply\""); 

// Visual Scripting takes XML documents sent as part of a 

// XML or Web Service request and stores it in a CLoadString 

// variable.  Inserting a value means altering the string 

// concatenation for the literal value and  

// substituting the variable. 

_QALTmpVars[1]  = "<?xml version=\"1.0\" encoding=\"UTF-8\"  

standalone=\"no\"?>"; 

_QALTmpVars[1] += "<SOAP-ENV:Envelope SOAP-ENV:encodingStyle=\"\"  

xmlns:SOAPSDK1=" 

      "\"http://www.w3.org/2001/XMLSchema\" xmlns:SOAPSDK2=" 

      "\"http://www.w3.org/2001/XMLSchema-instance\" xmlns:SOAPSDK3=" 

          "\"http://schemas.xmlsoap.org/soap/encoding/\" xmlns:SOAP-ENV=" 

"\"http://schemas.xm"; 

_QALTmpVars[1] += "lsoap.org/soap/envelope/\">"; 

_QALTmpVars[1] += "<SOAP-ENV:Body SOAP-ENV:encodingStyle=" 

"\"http://schemas.xmlsoap.org/soap/encoding/\">"; 

_QALTmpVars[1] +=  "<m:Multiply  

xmlns:m=\"http://tempuri.org/Calc/message/\" " 

"SOAP-ENV:encodingStyle=\"\">"; 

// We want to substitute the result from Request 1 

// for the text value “10” for the “A” tag.  
_QALTmpVars[1] +=   "<A SOAP-ENV:encodingStyle=\"\">10</A>"; 

_QALTmpVars[1] +=   "<B SOAP-ENV:encodingStyle=\"\">5</B>"; 

_QALTmpVars[1] +=  "</m:Multiply>"; 

_QALTmpVars[1] += "</SOAP-ENV:Body>"; 

_QALTmpVars[1] +="</SOAP-ENV:Envelope>"; 

Set(NEXT_REQUEST_ONLY, XML_DATA, (char *)_QALTmpVars[1]); 

XmlRequest( "POST",  

"http://mssoapsampleserver/MSSoapSamples30/Calc/Service/SrSz/AspVbsCpp/Calc.asp" ); 

... rest of script ... 

 

Sam ple: M odi f i ed WW W  Script  for Ex t ract ing an d Reusing Web Servi ce XM L Values 

The fol lowing sample is a script  sn ippet that is modified to extract and reuse Web service XML values. 
Code added to the script  is h ighl ighted in  bold. Modified code is in  bold and i tal icized. 
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Sample Script Snippet 

... beginning of script ... 

extern "C" int rhobot_script(PLAYER_INFO* s_info) 

{ 

// Declare Variables 

// 

CLoadString _QALTmpVars[  4]; 

CLoadString __Sum = ""; 

... more script to Request 1... 

//---------  REQUEST # 1  --------- 

// 

Set (NEXT_REQUEST_ONLY, HEADER, "SOAPAction",      

"\"http://tempuri.org/Calc/action/Calc.Add\""); 

_QALTmpVars[0]  = "<?xml version=\"1.0\" encoding=\"UTF-8\"  

standalone=\"no\"?>"; 

_QALTmpVars[0] += "<SOAP-ENV:Envelope SOAP-ENV:encodingStyle=\"\" 

xmlns:SOAPSDK1=" 

"\"http://www.w3.org/2001/XMLSchema\" xmlns:SOAPSDK2=" 

"\"http://www.w3.org/2001/XMLSchema-instance\" xmlns:SOAPSDK3=" 

"\"http://schemas.xmlsoap.org/soap/encoding/\"  

xmlns:SOAP-ENV=" 

     "\"http://schemas.xml"; 

_QALTmpVars[0] += "lsoap.org/soap/envelope/\">"; 

_QALTmpVars[0] += "<SOAP-ENV:Body SOAP-ENV:encodingStyle=" 

     "\"http://schemas.xmlsoap.org/soap/encoding/\">"; 

_QALTmpVars[0] +=  "<m:Add  

xmlns:m=\"http://tempuri.org/Calc/message/\" " 

      "SOAP-ENV:encodingStyle=\"\">"; 

_QALTmpVars[0] +=   "<A SOAP-ENV:encodingStyle=\"\">10</A>"; 

_QALTmpVars[0] +=   "<B SOAP-ENV:encodingStyle=\"\">5</B>"; 

_QALTmpVars[0] +=  "</m:Add>"; 

_QALTmpVars[0] += "</SOAP-ENV:Body>"; 

_QALTmpVars[0] += "</SOAP-ENV:Envelope>"; 

 

Set(NEXT_REQUEST_ONLY, XML_DATA, (char *)_QALTmpVars[0]); 

XmlRequest( "POST", 
       "http://mssoapsampleserver/MSSoapSamples30/Calc/Service/SrSz/AspVbsCpp/Calc." 

        "asp" ); 

strSum = Get ( XML, TEXT,  

"/SOAP-ENV:Envelope[1]/SOAP-ENV:Body[1]/m:AddResponse[1]/Result[1]" ); 
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//---------  REQUEST # 2  --------- 

// 

Set (NEXT_REQUEST_ONLY, HEADER, "SOAPAction", 

 "\"http://tempuri.org/Calc/action/Calc.Multiply\""); 

_QALTmpVars[1]  = "<?xml version=\"1.0\" encoding=\"UTF-8\"  

standalone=\"no\"?>"; 

_QALTmpVars[1] += "<SOAP-ENV:Envelope SOAP-ENV:encodingStyle=\"\"  

xmlns:SOAPSDK1=" 

      "\"http://www.w3.org/2001/XMLSchema\" xmlns:SOAPSDK2=" 

      "\"http://www.w3.org/2001/XMLSchema-instance\" xmlns:SOAPSDK3=" 

          "\"http://schemas.xmlsoap.org/soap/encoding/\" xmlns:SOAP-ENV=" 

"\"http://schemas.xm"; 

_QALTmpVars[1] += "lsoap.org/soap/envelope/\">"; 

_QALTmpVars[1] += "<SOAP-ENV:Body SOAP-ENV:encodingStyle=" 

"\"http://schemas.xmlsoap.org/soap/encoding/\">"; 

_QALTmpVars[1] +=  "<m:Multiply  

xmlns:m=\"http://tempuri.org/Calc/message/\" " 

"SOAP-ENV:encodingStyle=\"\">"; 

// Original value: <A SOAP-ENV:encodingStyle=\"\">10</A> 

// Variablized value: <A SOAP-ENV:encodingStyle=\"\">{$ VAR:Sum $}</A> 

_QALTmpVars[1] +=   "<A SOAP-ENV:encodingStyle=\"\">"; 

_QALTmpVars[1] +=                                  __Sum; 

_QALTmpVars[1] +=   "</A>"; 

_QALTmpVars[1] +=   "<B SOAP-ENV:encodingStyle=\"\">5</B>"; 

_QALTmpVars[1] +=  "</m:Multiply>"; 

_QALTmpVars[1] += "</SOAP-ENV:Body>"; 

_QALTmpVars[1] +="</SOAP-ENV:Envelope>"; 

Set(NEXT_REQUEST_ONLY, XML_DATA, (char *)_QALTmpVars[1]); 

XmlRequest( "POST",  

"http://mssoapsampleserver/MSSoapSamples30/Calc/Service/SrSz/AspVbsCpp/Calc.asp" ); 

... rest of script ... 

 

Forcing a Subrequest 

Overview : Forcing a Subrequest  that  i s not  Being M ade Autom at i cal l y 

Occasional ly, one of the necessary subrequests that is recorded is not requested automatical ly at playback 
t ime. This can be caused by complex javascript  code not execut ing correct ly, or by an Act iveX control that 
cannot be used at playback t ime. You can force th is subrequest by insert ing an 
ADDITIONAL_SUBREQUEST statement. 



QALoad Online Help 

375 

Script ing 

To request an addit ional subrequest, insert  a command l ike the one below before the act ion statement 
(Cl ick_On, Navigate_To, or Post_To).   

Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST, "http://xyz.com/onsale.aspx"); 

This adds the specified URL to the l ist  of subrequests automatical ly generated when the requested page is 
parsed. 

Conclusion 

Using these techniques, you can modify a script  to force a subrequest. The sample modified script  
i l lustrates forcing a subrequest. 

 

Sam ple: M odi f i ed Script  for Forcing a Subrequest   

In  th is example, one of the pages has an Act iveX object associated with i t  that automatical ly generates a 
request for i tems that are on sale.  However, at  playback th is request is not made because Act iveX objects 
are not executed at playback t ime. To force th is subrequest, you can insert  an Addit ional Subrequest i tem 
just before the act ion statement. Relevant statements are shown in bold. 

Sample Script  

//---------  REQUEST # 5  (see action item on Page 4)  --------- 

// 

//  current page url is http://xyz.com/chairs.htm 

// 

Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST, "http://xyz.com/onsale.aspx"); 

Click_On(LINK, 1, DESCRIPTION, "Nuts and Bolts"); 

Verify(PAGE_TITLE, "Nuts and Bolts"); 

 

IP Spoofing with a Local Datapool 

Overview : IP Spoof ing w i th  a Local  Datapool  

Datapools can provide IP spoofing addresses to scripts on playback machines. By creat ing a special IP 
spoofing datapool for the part icular playback machine, you can spoof the correct addresses at runt ime.   

Note:  For the script to execute properly, the IP addresses in the local datapool must match the IP 
addresses bound to the network cards on the playback machine. 

Script ing 

When you modify a Visual Script  to al low for IP spoofing for a local playback machine, you must: 

!  Create a datapool file with the IP addresses associated with the network cards on the playback machine. 

!  Insert the required scripting code for datapool access into the script. 

!  Retrieve and use the spoofed IP address. 

Visual Navigator 

Visual Navigator provides GUI in terfaces in  the tree view for creat ing datapool fi les and using spoofed IP 
addresses. You can use the datapool variables as IP spoofing addresses in  the IP spoof in terface. 

Conclusion 
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By fol lowing these script ing techniques, you can modify a Visual Script  to extract IP addresses from 
datapool fi les for use as  spoofed addresses. The modified script  sample i l lustrates the modificat ions 
required in  the script . 

 

Sam ple: M odi f i ed Script  for IP Spoof ing w i th  a Local  Datapool  

This sample snippet shows the script ing required to open and access the datapool and use the extracted IP 
address as a spoofed address. Points of in terest and modified code in the script  are h ighl ighted in  bold. 

Sample Script  Snippet 

... beginning of script ... 

// Before the SYNCHRONIZE command, add a #define to  

// identify the datapool file and a call to  

// OPEN_DATA_POOL to open the datapool file  

// (Note: the datapool file name is “ipspoof.dat”)  
#define IPSPOOF_DP  1  /* identifier for datapool file */ 

OPEN_DATA_POOL("ipspoof.dat", IPSPOOF_DP, TRUE); 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

RESTART_TRANSACTION_TOP(); // do not modify this statement 

// After the start of transaction, read the data record, and 

// use the Set command to specify that this value is to  

// be used as the spoofed IP address for every request. 

READ_DATA_RECORD(IPSPOOF_DP); 

Set (EVERY_REQUEST, SPOOFED_IP_ADDRESS, 

GET_DATA_FIELD (IPSPOOF_DP, 1) ); 

... rest of script ... 

 

Moving the Transaction Loop Statements 

Overview : M oving the Transact ion  Loop Statem en ts 

Load test ing a web site can require you to logon and logout when you want to perform mult iple 
transact ions during a single session. You can move the BEGIN_TRANSACTION statement and the 
END_TRANSACTION statement so that the virtual user does not logon and logout with every transact ion. 

To m odi f y t he scr ipt : 

1. Move the BEGIN_TRANSACTION and RESTART_TRANSACTION_TOP statements so that they are just below any 
statements that log the user onto the system. 

2. Keep the RESTART_TRANSACTION_BOTTOM, Clear(TRANSACTION), and END_TRANSACTION statements 
together and move them so that they are immediately above the Logout requests. 

Visual Navigator 
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If you are using Visual Navigator, you can move the Transact ion Loop statements in  the tree view rather 
than in the C++ script .  Simply select the Begin Transact ion i tem and cl ick the Move Down button unt i l  i t  
moves below the Logon pages.  Do the same for the End Transact ion by select ing the Transact ion Cleanup 
tree i tem and moving i t .  Any pages after the Transact ion Cleanup, such as the Logout, take place after al l  
t ransact ion in  the main loop have fin ished execut ing. 

Sample Scripts 

The fol lowing original script  sample and modified script  sample show a script  that logs in to a newsgroup 
forum, performs act ions, such as reading threads and replying to them, and then logs out. The scripts 
ident i fy the Logon and Logout requests and show the old and new locat ions of the transact ion statements.  

 

Sam ple: Original  WWW Script  Show ing the Transact ion  Loop 

The fol lowing sample shows the original script . The sect ions in  i tal ics are the requests involved with the 
Login and Logout.  The original  locat ions of the transact ion statements are shown in bold. 

Sample Script  

SYNCHRONIZE(); 

BEGIN_TRANSACTION();  

RESTART_TRANSACTION_TOP(); // do not modify this statement 

 

//---------  REQUEST # 1  --------- 

// 

Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 1 - "); 

 

Navigate_To("http://www.myforum.org/"); 

Verify(PAGE_TITLE, "My woodworking forum - powered by vBulletin"); 

 

DO_SLEEP(9); 

 

//---------  REQUEST # 2  (see action item on Page 1)  --------- 

// 

//  current page url is http://www.myforum.org/ 

// 

// The submit button for this form could not be positively identified so 

// an appropriate action has been added (Post_To or Navigate_To).  The 

// values for the form fields will be set using Set( ) statement. 

// 

Set(NEXT_REQUEST_ONLY, POST_DATA, "vb_login_username", "John Smith"); 

Set(NEXT_REQUEST_ONLY, POST_DATA, "cookieuser", "1"); 

Set(NEXT_REQUEST_ONLY, POST_DATA, "vb_login_password", ""); 

Set (NEXT_REQUEST_ONLY, POST_DATA, "s", "3669625a913735e99e31ec9a866a2f28"); 

Set (NEXT_REQUEST_ONLY, POST_DATA, "do", "login"); 

Set (NEXT_REQUEST_ONLY, POST_DATA, "forceredirect", "1"); 
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Set (NEXT_REQUEST_ONLY, APPEND_CRLF_AFTER_POST_BODY, TRUE); 

Set (NEXT_REQUEST_ONLY, POST_DATA, "vb_login_md5password", 

       "df0349ce110b69f03b4def8012ae4970"); 

Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 2 - "); 

 

Post_To("http://www.myforum.org/login.php"); 

Verify(PAGE_TITLE, "My Woodworking Forum"); 

 

DO_SLEEP(3); 

 

//---------  REQUEST # 4  (see action item on Page 3)  --------- 

// 

//  current page url is http://www.myforum.org/ 

// 

Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 4 - "); 

 

Click_On(LINK, 1, DESCRIPTION, "Tables and Chairs"); 

Verify(PAGE_TITLE, "My Woodworking Forum – Tables and Chairs"); 
 

DO_SLEEP(2); 

 

//---------  REQUEST # 5  (see action item on Page 4)  --------- 

// 

//  current page url is http://www.myforum.org/forumdisplay.php?f=17 

// 

Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 5 - "); 

 

Click_On(LINK, 1, DESCRIPTION, "Log Out"); 

Verify(PAGE_TITLE, "My Woodworking Forum"); 

 

RESTART_TRANSACTION_BOTTOM(); // do not modify this statement 

Clear ( TRANSACTION ); 

END_TRANSACTION(); 

 

DO_FreeHttp(); 

 

EXIT(); 

return(0); 

 

Sam ple: M odi f i ed WW W  Script  for M oving the Transact ion  Loop Statem en ts 
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The fol lowing sample shows the script  modified to move the transact ion loop statements. The sect ions in  
i tal ics are the requests involved with the Logon and Logout.  The new  locat ions of the transact ion 
statements are shown in bold. 

Sample Script  

SYNCHRONIZE(); 

 

//---------  REQUEST # 1  --------- 

// 

Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 1 - "); 

 

Navigate_To("http://www.myforum.org/"); 

Verify(PAGE_TITLE, "My woodworking forum - powered by vBulletin"); 

 

DO_SLEEP(9); 

 

//---------  REQUEST # 2  (see action item on Page 1)  --------- 

// 

//  current page url is http://www.myforum.org/ 

// 

// The submit button for this form could not be positively identified so 

// an appropriate action has been added (Post_To or Navigate_To).  The 

// values for the form fields will be set using Set( ) statement. 

// 

Set(NEXT_REQUEST_ONLY, POST_DATA, "vb_login_username", "John Smith"); 

Set(NEXT_REQUEST_ONLY, POST_DATA, "cookieuser", "1"); 

Set(NEXT_REQUEST_ONLY, POST_DATA, "vb_login_password", ""); 

Set (NEXT_REQUEST_ONLY, POST_DATA, "s", "3669625a913735e99e31ec9a866a2f28"); 

Set (NEXT_REQUEST_ONLY, POST_DATA, "do", "login"); 

Set (NEXT_REQUEST_ONLY, POST_DATA, "forceredirect", "1"); 

Set (NEXT_REQUEST_ONLY, APPEND_CRLF_AFTER_POST_BODY, TRUE); 

Set (NEXT_REQUEST_ONLY, POST_DATA, "vb_login_md5password", 

       "df0349ce110b69f03b4def8012ae4970"); 

Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 2 - "); 

 

Post_To("http://www.myforum.org/login.php"); 

Verify(PAGE_TITLE, "My Woodworking Forum"); 

 

BEGIN_TRANSACTION();  

RESTART_TRANSACTION_TOP(); // do not modify this statement 

DO_SLEEP(3); 
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//---------  REQUEST # 4  (see action item on Page 3)  --------- 

// 

//  current page url is http://www.myforum.org/ 

// 

Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 4 - "); 

 

Click_On(LINK, 1, DESCRIPTION, "Tables and Chairs"); 

Verify(PAGE_TITLE, "My Woodworking Forum – Tables and Chairs"); 
 

DO_SLEEP(2); 

               All additional Requests that will occur every transaction 

RESTART_TRANSACTION_BOTTOM(); // do not modify this statement 

Clear ( TRANSACTION ); 

END_TRANSACTION(); 

//---------  REQUEST # 5  (see action item on Page 4)  --------- 

// 

//  current page url is http://www.myforum.org/forumdisplay.php?f=17 

// 

Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 5 - "); 

 

Click_On(LINK, 1, DESCRIPTION, "Log Out"); 

Verify(PAGE_TITLE, "My Woodworking Forum"); 

 

DO_FreeHttp(); 

 

EXIT(); 

return(0); 

 

Preventing Unwanted Subrequests 

Overview : Preven t ing Unw an ted Subrequests 

Pages your script  requests may make a subrequest that causes the transact ion to abort . There also may be 
subrequests that skew the load test results. For example, one of the pages you visi t  may bring up random 
advert isements, some of which can take a long t ime to load. To prevent these subrequests, you can insert  
one or more Traffic Fi l ter commands. 

To m odi f y t he scr ipt : 

1. Identify the URL of the offending subrequest.   

2. Insert a Set command with the BLOCK_TRAFFIC_FROM keyword and a string that identifies the URLs to block. 
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 Typical ly, you place th is statement near the top of the script  before the BEGIN_TRANSACTION statement, 
since you always want i t  in  effect.  For example, the fol lowing command prevents any subrequests to URLs 
contain ing “ AcmeAds” : 

Set (EVERY_REQUEST, BLOCK_TRAFFIC_FROM, "AcmeAds"); 

Note: The filter string does not need to be a complete URL.   

You can also fi l ter the traffic by specifying a substring that must be present in  the requested URL.  For 
example, i f you are concerned with making subrequests only to pages on your company’s web site, you can 
insert  a ONLY_ALLOW_TRAFFIC_FROM traffic fi l ter command.  The fol lowing example only al lows 
subrequests whose URLs contain the substring “ myCorp” : 

Set (EVERY_REQUEST, ONLY_ALLOW_TRAFFIC_FROM, "myCorp"); 

Visual Navigator 

If you are using Visual Navigator, you can specify fi l ters by h ighl ighting the Traffic Fi l ters tree i tem 
underneath the Playback Options at the top of the tree and type the commands in the top pane of the 
window.  

Conclusion 

By fol lowing these script ing techniques, you can modify a script  to prevent unwanted subrequests. The 
sample script  i l lustrates the modificat ions required in  the script . 

 

Sam ple: Preven t ing Unw an ted Subrequests 

The fol lowing sample uses a fi l ter string to prevent the unwanted subrequest. Points of in terest are 
h ighl ighted in  bold. 

Sample Script  

Set (EVERY_REQUEST, BLOCK_TRAFFIC_FROM, "AcmeAds"); 

SYNCHRONIZE(); 

 

BEGIN_TRANSACTION();  

RESTART_TRANSACTION_TOP(); // do not modify this statement 

 

//---------  REQUEST # 1  --------- 

// 

Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 1 - "); 

 

Navigate_To("http://www.mystore.com/"); 

Verify(PAGE_TITLE, "Jack’s Hardware Store"); 

etc.  
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NetLoad 

Using NetLoad 

NetLoad is QALoad’s suite of load generat ion scripts that al lows you to simulate load condit ions on your 
network using any of the fol lowing protocols: 

!  FTP 

!  HTTP 

!  PING 

!  LDAP 

!  POP3 

!  SMTP 

!  TCP 

!  UDP 

!  MSExchange 

NetLoad includes QALoad-provided scripts, which you can access from the Conductor to run in  a test, for 
each protocol. You can customize the act ivi ty of the script  by creat ing reusable datapools in  the QALoad 
Script Development Workbench to use during test ing. When you run a test, each virtual user requests a 
single datapool record. Once al l  the records have been read, the datapool fi le is rewound and the process 
starts again. You can use QALoad’s components to run scripts and analyze the results as usual, or you can 
integrate your results with Compuware’s ServerVantage product. 

In  short , NetLoad al lows you to generate traffic on your network in  a control led manner and gather 
performance t im ings from the network. To faci l i tate test ing under TCP/IP and UDP, NetLoad provides you 
with a server module to simulate server act ivi ty — al lowing you to gather network t im ings without 
expending your actual server resources. 

Note: To use NetLoad for MSExchange to test on Outlook 2000, you must ensure that CDO support is 
installed on your workstation before you continue. For instructions, see Verifying CDO Support for 
MSExchange. 

For more in formation on the NetLoad Server modules, see NetLoad Server Modules for TCP/IP and UDP. 

 

NetLoad server modules for TCP/ IP and UDP 

If you are load test ing a network running TCP/IP or UDP, you should use the appropriate NetLoad Server 
module to simulate server responses during your load test. This al lows you to load your network and 
col lect t im ings without expending your own server’s resources. The NetLoad Server modules are only for 
use i f you’re test ing on TCP/IP or UDP. You do not need to instal l  the Server modules to test any other 
NetLoad-supported protocol.  

You can instal l  or copy the NetLoad Server modules to any Windows workstat ion on your network. After 
start ing the appropriate Server module, you supply the QALoad Script Development Workbench with the 
host name of the machine where the Server module is running and the port  number that you specified 
when you started the Server module. When you are ready to run a test, start  the Server module fi rst . During 
the test NetLoad communicates with the NetLoad Server module, effect ively loading the network. If 
NetLoad does not find the NetLoad Server module at the specified port—for instance i f you mistyped the 
port  number—the test fai ls (TCP) or fai ls to in i t iate (UDP).  
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Determining when to use the TCP server module 

If you are going to send TCP packets using NetLoad, you must have a QALoad TCP Server module running 
on each machine that you are sending packets to. Copy the TCP Server module fi le, Net loadTCPServer.exe, 
to each machine that wi l l  be receiving packets and double-cl ick on the fi le to start  the TCP Server module. 

Because the QALoad TCP Server module is a Windows-based program, you cannot use i t  to send NetLoad 
TCP packets to a UNIX machine.  

Determining when to use the UDP server module 

It  is not necessary to have a QALoad UDP Server module running at the dest inat ion machine for NetLoad 
to successful ly send packets to i t ; however, the Netload UDP Server can be useful to veri fy that the packets 
are being sent. To instal l  the UDP Server module on  a machine you are sending packets to, copy the 
program NetloadUDPServer.exe to that machine. Double-cl ick the fi le to start  the UDP Server module. 

Since i t  is not necessary to have the UDP Server module running, you can send NetLoad UDP packets to 
both UNIX and Windows workstat ions. 

Note: If you are testing UDP in “ broadcast”  mode, it is not necessary to use the NetLoad Server module. 

 

Installing the NetLoad Server module 

If you are load test ing a network running TCP/IP or UDP, the NetLoad Server module appropriate for your 
protocol must be running on a Windows workstat ion on your network before you start  the test. The Server 
modules are instal led automatical ly i f you chose the opt ion to instal l  them during setup. However, once 
the Server module is instal led on one workstat ion, you can instal l  i t  on another workstat ion by simply 
copying the program from one workstat ion to another. The NetLoad Server modules are instal led to the 
directory \Program Files\Compuware\QALoad\Middlewares\NetLoad\Server, and are named: 

!  NetLoadTCPServer.exe (for TCP/IP): If you are going to send TCP packets using NetLoad, you must have a TCP 
Server module running on each machine you are sending packets to. Because the TCP Server module is a Windows 
program, you cannot send NetLoad TCP packets to a UNIX machine. 

!  NetLoadUDPServer.exe (for UDP): It is not necessary to have a UDP Server module running on the machines you 
are sending UDP packets to. However, the UDP Server is useful for verifying that the packets are being sent. Since 
it is not necessary to have a UDP Server module installed on the destination workstations, you can send NetLoad 
UDP packets to UNIX machines.  

 

Start ing the NetLoad server module 

You can configure and start  the NetLoad server module from the Start  menu.  

If you are load test ing a network running TCP/IP or UDP, the NetLoad Server module appropriate for your 
protocol should be running on a Windows workstat ion on your network before you start  the test. The 
Server modules are instal led with your QALoad product i f you chose to instal l  them during setup. If you are 
unsure i f you should be using a NetLoad Server module, see NetLoad server modules for TCP/IP and UDP. 

To st ar t  t he m odule: 

1. Point to Start>Programs>Compuware> QALoad >NetLoad. Then click on the appropriate Server module: TCP 
Server or UDP Server. 

2. When prompted, type the port number of the host machine and click OK. 

3. On the QALoad NetLoad Server window, under the Options menu, select one of the following: 
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 Show  M essage Every Packet  — Displays a message, including byte size, after sending or 
receiving a packet. 

 Show  M essage Every 100 Packets — Displays a message every 100 packets l ist ing the total 
number of packets received.  

 

Start ing a NetLoad session 

You can start  a NetLoad session from the workbench with an exist ing datapool fi le or a new one. 

To st ar t  a session: 

1. From the QALoad Script Development Workbench, choose Session>NetLoad. 

2. Open an existing protocol datapool file or create a new one: 

 To create a new datapool f i le, choose Fi le>New . The New NetLoad Fi le dialog box opens. 

 To open an exist ing datapool fi le, choose Fi le>Open . The Open NetLoad Fi le dialog box opens. 

3. Select the protocol you wish to test on and click OK. If you are opening an existing datapool file, navigate to the file 
and open it. 

4. Enter or edit the appropriate datapool information in the Workbook Pane. 

The QALoad Script Development Workbench al lows you to have mult iple fi les open at the same t ime. 
Datapool fi les are located in  the directory \Program 
Files\Compuware\QALoad\Middlewares\NetLoad\Scripts.  

 

Creat ing a NetLoad datapool 

To creat e a Net Load dat apool : 

1. From the QALoad Script Development Workbench, click Session>NetLoad. 

2. Click File>New to open the New NetLoad File dialog box. 

3. Select the protocol for which you wish to create a datapool file and click OK. 

A grid opens in the Workbook Pane. Each row on the grid represents a single data record. The 
column headings indicate the appropriate field in formation to enter. Note that the actual fields in  
the grid vary by protocol. 

4. Enter the appropriate information for your datapool file. 

Some fields on the grid contain pul l-down menus. To act ivate them, cl ick anywhere with in the field. 
Then make your select ion  from the menu that appears. 

5. When you are finished, select File>Save to name and save the datapool file. 

The datapool fi le is l isted in  the Workspace Pane Datapools tab. QALoad creates a script  with the same 
name and l ists i t  on the Scripts tab. Both fi les are saved to the \NetLoad\Scripts directory (for example, 
c:\Program Files\Compuware\QALoad\Middlewares\NetLoad\Scripts\datapool.dat).  
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To ent er  dat apool  dat a: 

1. From the QALoad Script Development Workbench, choose Session>NetLoad. 

2. Click File>New to open the New NetLoad File dialog box. Select the protocol for which you wish to create a 
datapool file and click OK. A grid similar to the one shown below appears in the Workbook Pane. Each row on the 
grid represents a single data record. The column headings indicate the appropriate field information to enter. Note 
that the actual fields in the grid vary by protocol. 
 

 

3. Enter the appropriate information for your datapool file. Note that some fields on the grid contain pull-down menus. 
To activate them, click anywhere within the field. Then make your selection from the menu that appears. 

4. When you are finished, click File>Save to name and save the datapool file. Note that your datapool file is listed in 
the Workspace Pane Datapools tab. QALoad creates a C-based script by the same name and lists it in the 
Workspace Pane Scripts tab. Both files will be saved to your \NetLoad\Scripts directory (for example, 
c:\Program Files\Compuware\QALoad\Middlewares\NetLoad\Scripts\datapool.dat). 

5. (Optional) Write a description of this datapool file for later reference by selecting Options>NetLoad. Once a 
description has been entered for a datapool file, you can review or edit the description any time the file is open by 
selecting Options>NetLoad again. 

 

Edit ing a NetLoad datapool 

You can edit  the NetLoad datapool to make changes or addit ions to the fi le. 

To edi t  a dat apool : 

1. With the appropriate NetLoad protocol session open, open the datapool by choosing File>Open and navigating to it, 
or select it from the Workspace tab Datapools tab. 

2. Make any changes or additions to the file. 

3. To delete an entire record (a single row), click its row number and select Grid>Delete Row(s). 

4. To insert a new record (a single row) above an existing record, click a row number and select Grid>Insert Row. 
NetLoad inserts a blank row above the selected row. 

5. Save any changes to the file by selecting File>Save.  
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Adding or edit ing a NetLoad datapool descript ion 

You can add a meaningful descript ion, or edit  a previous one, for any NetLoad datapool. 

To edi t  a descr ipt ion: 

1. With a datapool file open, select Options>NetLoad. 

2. Enter a description for the current datapool file.  

 

Datapool fields 

The fol lowing protocol-specific fields are provided with in a datapool: 

M SExchange 

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Prof i l e Nam e: Type the name of your mail  profi le. For example, M icrosoft  Out look. 

Send To: Type the names of one or more mail  recipients, separated by commas (,) or semi-colons (;). 

Cc: Type the names of one or more mail  recipients, separated by commas (,) or semi-colons (;). 

Size of  Body: Select a fi le size from the drop-down l ist  for the body of the mai l  message. 

At tached f i l e si ze: Select a fi le size for the attachment fi le from the drop-down l ist . 

FTP 

Send/ Receive: Specifies whether the script  wi l l  be sending or receiving a fi le. 

ASCII / Binary: Describes whether the fi le contains ASCII or binary data. 

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Host : The name of the host computer. 

User ID: A user ID for accessing the host computer. 

Passw ord: A password for accessing the host computer. 

Fi le Size Opt ions: Describes whether the fi le being sent to the host is of fixed or random size. 

Fi le Size (m in ): The min imum fi le size to send to the host or the size of the fixed fi le. 

Fi le Size (m ax): The maximum fi le size to send to the host. 

Path : The path of the fi le to receive, or the dest inat ion of the fi le being sent. You must enter an absolute 
path. 

Fi lenam e: The name of the fi le to receive or of the fi le being sent. 

HTTP  

Connect ion : Describes whether the connect ion is regular (the connect ion is closed after the 
request/ response completes) or persistent (the connect ion remains open for subsequent requests). 

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

URL: The address of the page to receive. 

Proxy Server: The name of the proxy server (opt ional). Note that only proxy servers that do not require a 
user ID and password are supported. 
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PING  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Host  Nam e: The name of the host computer. 

Pkt  Size (Fixed/ Random ): Describes i f the packet being sent to the host is of fixed or random size. 

Pkt  Size (m in ): The min imum packet size to send, or the size of the fixed packet to send. 

Pkt  Size (m ax): The maximum packet size to send. 

LDAP  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Host  Nam e: The name of the host computer. 

Search  St r ing: The text string to search for. 

POP3  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

POP3 Server: The name of the POP3 server machine. 

User ID: A user ID for accessing the POP3 server. 

Passw ord: A password for accessing the POP3 server. 

Delete af ter read: Choose whether to delete the message after i t  has been read. 

Connect ion : Describes whether the connect ion is regular (the connect ion is closed after the 
request/ response completes) or persistent (the connect ion remains open for subsequent requests). 

SM TP  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

SM TP Server: The name of the SMTP server machine. 

From : Enter an email  address or name. 

Send To: Type the names of one or more mail  recipients, separated by commas (,) or semi-colons (;). 

Cc: Type the names of one or more mail  recipients, separated by commas (,) or semi-colons (;). 

Size of  Body: Select a fi le size from the drop-down l ist  for the body of the mai l  message. 

Fi le Path : Select a fi le from the drop-down l ist  to use as the body of the mail  message. This field displays 
fi les in  the local directory only i f you selected Browse in the Size of Body field. 

At tached f i l e si ze: Select a fi le size for the attachment fi le from the drop-down l ist . 

At tached f i l e path : Select a fi le from the drop-down l ist  to use as an attachment. This field displays fi les in  
the local directory only i f you selected Browse in the Attached Fi le Size field. 

Connect ion : Describes whether the connect ion is regular (the connect ion is closed after the 
request/ response completes) or persistent (the connect ion remains open for subsequent requests). 

TCP  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Host  Nam e: The name of the host computer. 

Port : The port  number of the host computer. 

Pkt  Size (Fixed/ Random ): Describes i f the packet being sent to the host is of fixed or random size. 
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Pkt  Size (m in ): The min imum packet size to send, or the size of the fixed packet to send. 

Pkt  Size (m ax): The maximum packet size to send. 

UDP  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Host  Nam e: Type the name of the host computer that is to receive the packet. 

Port : The port  number of the host computer. 

Pkt  Size (Fixed/ Random ): Describes i f the packet being sent to the host is of fixed or random size. 

Pkt  Size (m in ): The min imum packet size to send, or the size of the fixed packet to send. 

Pkt  Size (m ax): The maximum packet size to send. 

 

Verifying CDO support  for MSExchange 

Before you can successful ly test with NetLoad for M SExchange using Outlook 2000, you must ensure that 
Col laborat ion Data Objects (CDO) support is instal led. 

To ver i f y CDO suppor t : 

1. From the Windows task bar, click Start>Settings>Control Panel. 

2. Double-click the Add/Remove Programs icon. 

3. From the list on the Install/Uninstall tab, select Microsoft Office 2000 or Microsoft Outlook 2000. 

4. Click the Add/Remove button. 

5. Click Add or Remove Features. 

6. Click the plus sign (+) next to Microsoft Outlook for Windows. 

7. Select Collaboration Data Objects, and then click Run from My Computer. 

 

UNIX 

Installing UNIX Players 

The necessary UNIX Player software is distributed with your QALoad Windows instal lat ion. 

Note: For updated UNIX system requirements and installation procedures, please refer to the QACenter 
Performance Edition Installation and Configuration Guide. You can access this guide by clicking 
Start>Programs>Compuware>QALoad>Documentat ion>Installat ion and Configurat ion Guide. 

 

Transferring scripts to a UNIX Player 

Normally, the appropriate script  is automatically uploaded from the QALoad Conductor to the Players and 
compiled at runt ime. However, i f i t  is ever necessary to manually transfer a script , use the procedure that 
fol lows. 
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Note: The machine where the QALoad Script Development Workbench is installed must have Winsock-
based TCP/IP to transfer a script to the UNIX machine where you wish to run it. 

To t ransf er  a scr ip t : 

The fol lowing procedure describes how to transfer a script  fi le from the Windows workstat ion where the 
QALoad Script Development Workbench resides to the system running the QALoad Player. 

1. Access the Script Development Workbench. 

2. From the Session menu, choose the middleware session you want to start. 

3. In the Workspace Pane, click the Scripts tab. 

4. On the Scripts tab, select the script you want to transfer. 

5. From the Tools menu, choose FTP to open the FTP Transfer dialog box. Note that the file name you selected to 
transfer appears in the File to Transfer field. 

6. Enter the Host Name, User Name, Password, and Destination Directory. 

7. Click Transfer to send the file to the system where your QALoad Player is installed. 

8. If you want to save the information you have entered for subsequent transfers, click Save Settings. 

9. Click Close/Abort to exit the FTP Transfer dialog box.  

 

Test ing with QARun 

Creat ing a QARun script  

To create a QARun script , insert  any number of QARun transact ions (QARun scripts) in to a QALoad 
template script  accessible from the QALoad Script Development Workbench. The template script  is a 
simple QALoad script  that can be compiled and run; however, i t  contains no funct ional i ty unt i l  you insert  
the QARun transact ions appropriate for your test ing needs. QALoad provides two methods for insert ing 
QARun transact ions: automated and manual. 

Using the automated method, you enter in formation in  the QALoad Script Development Workbench about 
the QARun transact ions to use and then let  QALoad generate the test script  using the in formation you 
provided. This method is fast and efficient when you know exact ly which QARun scripts to use and where 
they are located. 

The manual method al lows you to open a copy of the QALoad template script  and insert  t ransact ions and 
commands manually. You may want to use th is method i f you suspect you may need to edit  your script  
whi le you're creat ing i t . 

 

Automat ically creat ing a QARun script  

To aut om at ical ly creat e a QARun scr ipt : 

1. From the QALoad Script Development Workbench, click Session>QARun to start a QARun scripting session. 

2. Click Session>Generate Script. The Create New QARun Execution Script dialog box opens. 

3. In the Login String field, select or type a valid username and password to access your installation of QARun. 

4. In the Environment field, select the appropriate QARun environment. 
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5. In the QARun Script field, enter the name of the QARun transaction to insert, or select it from the list, which 
contains a record of the last five QARun script names you entered.  
 
Although you can enter a script name from any database, when the test is actually running and QALoad invokes 
QARun, QARun attempts to retrieve that script from its default database. Therefore, in the QARun program installed 
on the Player, you should designate a default database that contains the script(s) you want to run. 

6. Select the Automatically Include Checkpoint check box if you want QALoad to automatically insert a checkpoint 
into the script after this QARun transaction. 

7. In the QALoad Script Name field, enter a name for this QALoad script. To write over an existing script, click the 
Browse button to the right of this field and select a script from the list of available scripts. 

8. To add additional QARun transactions to this script, click Add Script and repeat Steps 3–6 for each additional 
transaction. 

9. When you are finished, click Create Script. The QALoad script is saved in the directory \Program 
Files\Compuware\QALoad\Middlewares\QARun\Scripts, and the script opens in the script editor. 

10. To compile the script for testing, click Session>Compile.  

 

Manually creat ing a QARun script  

You can manually insert  QARun commands or scripts in to a QALoad script  to compile. 

To m anual ly creat e a scr ipt : 

1. From the QALoad Script Development Workbench, select Session>QARun to start a QARun scripting session. 

2. Select Session>New Template to create a new script from the QALoad template script. 

3. In the Choose Script Name dialog box, enter a name for the new QALoad script in the Script Name field and click 
OK. The script is saved in the directory \Program 
Files\Compuware\QALoad\Middlewares\QARun\Scripts, and the script opens in the script editor. 

4. Edit the script as necessary: 

!  You can manually enter any transactions or scripting commands directly in the script. 

!  You can insert a QARun transaction by positioning the cursor on the appropriate line and selecting 
Session>Insert>Transaction. On the Insert a QARun Transaction dialog box that opens: 

!  In Login String, select or type a valid user name and password to access your installation of 
QARun. 

!  In Environment, select the appropriate QARun environment. 

!  In QARun Script Name, enter the name of the QARun transaction to insert, or select it from the 
list, which contains a record of the last five QARun script names you entered. Note that you can 
enter a script name from any database; however, when the test is actually running and QALoad 
invokes QARun, QARun will attempt to retrieve that script from its default database. Therefore, in 
the QARun program installed on the Player, you should designate a default database that contains 
the script(s) you want to run. 

!  When you are finished, click Insert to insert the script you just created into the QALoad script. 

5. When you are finished, save any changes. 

6. To compile the script for testing, select Session>Compile.  
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Troubleshoot ing 

The Default  Session Prompt  didn't  open? 

If the Default  Session Prompt fai ls to open when you start  a middleware session, then default  session 
checking was previously disabled. Do the fol lowing to enable default  session checking: 

1. From the Options menu, choose Workbench. The Configure QALoad Script Development Workbench dialog box 
opens. 

2. On the Workbench Configuration tab, select the Enable default Session checking check box. 

The next t ime you open a QALoad Script Development Workbench middleware session, you are prompted 
to make i t  your default  session.  

 

Winsock running out  of socket  resources 

You may encounter a problem running out of socket resources on NT or Solaris when there are large 
numbers of short-l ived connect ions. 

When TCP/IP connect ions are shutdown, they go in to a TIME_WAIT state wait ing for the specified in terval 
to expire. While in  that state the connect ion is looking for any stray packets that may have been sent to 
th is connect ion and remain unacknowledged. 

If th is process was skipped, i t  would be possible for a new connect ion to be opened using the same address 
and port  as the previous connect ion and to incorrect ly receive data that was intended for the previous 
connect ion. When QALoad is generat ing many short-l ived connect ions, during a Winsock or WWW load 
test, the default  sett ing for the t imed wait  delay may be so h igh that the driver machine wil l  run out of 
socket resources as al l  closed sockets wait  in  the TIME_WAIT state. 

To change the sett ing for the t imed wait  delay: 

Windows NT 

Set the registry key: 

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\tcpip\ 
Parameters\TcpTimedWaitDelay 

to a lower value. It  can be set to anyth ing between 30 and 300. Compuware suggests using the lowest 
possible value (30). 

Solaris 2.6 

Using "ndd" set the "tcp_close_wait_interval" to 30 seconds: 

ndd -get /dev/tcp tcp_close_wait_interval 

ndd -set /dev/tcp tcp_close_wait_interval 30000 

Solaris 2.7 

Use "ndd" as shown previously for Solaris 2.6, but subst i tute the "tcp_t ime_wait_interval"  

 

SAP script  validat ion fails 

If your SAP script  fai ls during val idat ion, you may need to disable automatic proxy configurat ion in  
Internet Explorer. 
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To disable aut om at ic p roxy conf igurat ion: 

1. In Internet Explorer, click Tools>Internet Options. 

2. On the Connections tab, click the LAN Settings button. 

3. Ensure that the Use automatic configuration script check box is cleared. 

If disabl ing the automatic proxy configurat ion does not solve the problem, consider increasing the script  
execut ion t imeout value to 100 seconds or to the length of the capture fi le (in  seconds), whichever is 
greater. 

To increase t he t im eout  value: 

1. With an SAP session open in the Script Development Workbench, click Options>Workbench. 

2. On the Script Validation tab, type the new value in the Wait up to field. 

3. Click OK. 

 

Linking errors during validat ion or compilat ion of SAP scripts 

When you re-record SAP 4.x scripts for SAP 6.20/SAP 6.40, you must cl ick the Bui ld SAP Libraries button 
on the SAP Convert  Options dialog box. This button generates new l ibraries based on the version of SAP 
that is current ly instal led. If you have upgraded to a newer version of SAP and do not update the l ibraries, 
you may experience various l inking errors during val idat ion or compilat ion. 

 

Performance issues with SAP or Cit rix scripts 

If you experience performance issues with SAP or Citrix scripts, increase your system paging fi le size to a 
fixed size of at least four t imes the amount of RAM on the machine. 

 

Recording Cit rix Scripts for Rest ricted Desktops  

When recording a Citrix script  on a restricted desktop, you must take extra steps to ensure proper playback. 
Dynamic windows may be created and destroyed with no user in teract ion at both logon and logoff. To 
prevent unexpected results during playback, do not cl ick on any of these dynamic windows. For example, 
the script  might attempt to cl ick on a destroyed window or a window that has not been created yet. The 
appearance of dynamic windows often depends on the speed of the server or the load on the farm during 
playback. 

 

Desktop Screen Resolut ion When Recording Cit rix Scripts 

To ensure that the ent ire Citrix in terface is visible during recording, set the Resolut ion field in  the Citrix 
recording opt ions to a lower value than that of the desktop. Also, the screen resolut ion must be the same 
as the screen resolut ion specified in  the Citrix ICA fi le. 
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Wait  Points in Cit rix Scripts 

 When mouse move consol idat ion is enabled via the Combine Mouse Input opt ion on the Convert  
Options dialog box, not al l  events that were captured appear during replay. As a result , the placement of 
wait  points for window moves and window resizing is important. When a window is moved on the 
desktop, a window move event is created for each mouse move. However, during replay of a consol idated 
script , only one mouse move is made (to the final dest inat ion), and subsequently only one window move 
event occurs. Because of th is consol idat ion of consecut ive mouse and window moves, the 
WaitForWindowMove command in your script  should target the final window move in the series. This 
issue also appl ies to the WaitForWindowResize command and the resizing of windows on the desktop. 

If a window's t i t le changes while the window is being created (such as a browser window's t i t le bar 
changing once the default  Web page begins to load), the WaitForWindowCreate command may t ime out. 
If th is occurs, remove the wait  point or insert  a WaitForScreenUpdate command to preserve the wait  in  
the script . 
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Analyze 

Overview of QALoad Analyze 
QALoad Analyze is the QALoad component used to create summary stat ist ics and graphs from t im ing data 
col lected during a load test. Set cri teria for col lect ing and displaying test data in  QALoad Analyze before or 
after opening a test ’s t im ing fi le (.t im). For example, alter output opt ions, t ime ranges, and graphics display 
opt ions.  

QALoad Analyze stores the state of a t im ing fi le when i t  is closed so that next t ime you open i t , you see the 
same reports and graphs that were present last t ime you viewed i t .  You also have the abi l i ty to easi ly create 
templates, which enable you to specify the reports and graphs that are automatical ly generated for any 
new t im ing fi le you open. 

In addit ion, QALoad Analyze generates a working folder where al l  fi les and reports related to the t im ing fi le 
are stored. QALoad Analyze provides seven pre-defined reports as well  as the abi l i ty to create custom 
reports using XML fi le (.xml), XSL translat ion fi le (.xsl), and HTM fi le (.h tm) formats. View these reports in  
QALoad Analyze or in  a Web browser.      

QALoad Analyze displays a t im ing fi le tab in  the Workspace, each tab contain ing groups. Use QALoad 
Analyze’s in teract ive view to sort  test data, produce detai led checkpoint data, produce a variety of graphs 
and reports (with drag and drop funct ional i ty), export  data to different formats, and email  test results and 
pre-defined reports. 

 

Understanding durat ions 
When you begin to analyze your test results, i t  is important to understand how durat ions are calculated by 
QALoad.  

Transact ion durat ion 

Transact ion durat ion is the t ime that the script  being tested takes to complete a transact ion, from the 
BEGIN_TRANSACTION command to the END_TRANSACTION command. 

Three factors comprise transact ion durat ion: 

!  The script processing time including, but not limited to, added script logic, QALoad processing of server replies, and 
other QALoad processing. 

!  Sleep time. 

!  The response time of the application under test including, but not limited to, the application server, database access, 
and network. 

Checkpoint  durat ion 

Checkpoint durat ion is the amount of t ime between begin and end checkpoint statements. The fol lowing 
factors comprise checkpoint durat ion and apply to both automatic checkpoints and user-defined 
checkpoints. 

If you select the Conductor's Enable t im ing of  autom at i c m iddlew are checkpoin ts option or use the 
BeginCheckpoint and EndCheckpoint funct ions in  the script , the fol lowing factors comprise checkpoint 
durat ion: 
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!  The response time of the application under test, including, but not limited to, the application server, database access, 
and network. 

!  Sleep time, if the Conductor's Include sleep times when calculating checkpoint timings option is selected. 

!  QALoad processing time is not included within these checkpoints in order to provide a more accurate value of 
server, database, and network response times. 

Checkpoint durat ions do not always sum to the same value as the transact ion durat ion. For more 
in formation, see Comparing checkpoint durat ions to transact ion durat ion. 

 

QALoad Analyze Menus 

QALoad Analyze menus and toolbar but tons 

Click a menu or toolbar name in the fol lowing l ist  for a descript ion.  

Fi le 

Edit  

View 

Templates 

Tools 

Window 

Help 

Analyze Toolbar buttons 

Graph Toolbar buttons  

 

File menu  

I tem  Descript i on  

Open  Opens a dialog box to select a t im ing fi le for Analyze to process. When a t im ing 
fi le is opened, Analyze opens a Summary report  in  the Data window and 
corresponding t im ing fi le tab in  the Workspace. 

Close Closes the current t im ing fi le view displayed in the Data window. In the 
Workspace, the associated group and t im ing fi le tab wil l  remain open. 

Close Tim ing 
Fi l e 

Closes the current t im ing fi le and al l  reports, detai l  views, or graphs associated 
with that t im ing fi le. 

Prin t  Opens the Print dialog box to set opt ions for prin t ing the current Summary 
report . 
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Prin t  Preview  Opens a window displaying the current Summary report  as i t  wi l l  look when 
printed. 

Prin t  Setup Opens the Print Setup dialog box to select a prin ter and to set opt ions for 
prin t ing. 

Export  Opens the Save As dialog box to save a load test Detai l  view as a CSV (*.csv) fi le, 
HTML (*.htm, *.html) fi le, or save graphs to HTML (*.htm, *.html) fi les. 

Send Opens the Send dialog box, which enables you to save test data outside Analyze, 
package test data in to .zip fi les, or email  test data.  

Propert i es Opens the Propert ies dialog box, which displays detai ls about Analyze and the 
current t im ing fi le. This dialog box also contains buttons that enable you to save 
the displayed information  to the cl ipboard or in  a fi le.  

Ex i t  Exits the Analyze program. 

 

Edit  menu commands 

  
 

Opt ion  Descript i on  

Copy Copies selected text to the cl ipboard. 

Select  Al l  Selects al l  counters, checkpoints, data 
points, etc., of the act ive t im ing fi le in  
the Workspace. 

Unselect  Al l  Un-selects al l  previously selected 
counters, checkpoints, data points, 
etc., in  the Workspace of the act ive 
t im ing fi le. 

 

View menu commands 

  
 

Opt ion  Descript i on  

Toolbar Displays or removes the toolbar from 
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the top of the screen. 

Status Bar Displays or removes the status bar from 
the bottom of the screen. 

Detai l  Opens a Detai l  in formation view in the 
Data Window for the selected 
checkpoints. 

Graph  Opens the Select Graph dialog box to 
choose a graphical format  for reviewing 
the current data. 

as Web Page Opens the current report , graph, or 
detai l  view, in  the default  Web browser.  

Workspace Displays or h ides the Workspace. 

Workbook  Displays or h ides the Data window. 

 

Template Menu Commands 
 

Opt ion  Descript i on  

Save Curren t  View s... Opens the Speci fy Tem pl ate to Save 
dialog box that al lows you to name the 
new template fi le.  The default  is the 
SessionID port ion of the f i le name of the 
open t im ing fi le. 

Use Ex i st i ng... Opens the Select  Tem plate to Use for 
Open  Tim ing Fi l es dialog box, where 
you can select the template to apply to 
your open t im ing fi les. This closes al l  
current reports and graphs and opens 
the views specified in  the template. 

Rem ove... Opens the Select  Tem plate(s) to 
Rem ove From  Disk  dialog box, where 
you can remove stored templates from 
disk. No open views are affected by th is 
act ion and no templates are checked for 
dependencies. 

Thresholds... Opens the Thresholds dialog box where 
you can create or edit  system-wide 
thresholds. 
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Tools menu commands 

  
 

Opt ion  Descript i on  

Opt ions Provides access to opt ions for 
customizing data. 

Show  Replay Launches the Conductor to replay a test 
recording. 

Conductor Starts QALoad's Conductor program, 
which is used to control al l  test ing 
act ivi ty. 

Workbench  Starts the QALoad Script Development 
Workbench, which is used to create and 
manage test scripts. 

 

Window menu commands 

  
 

Opt ion  Descript i on  

Cascade Automatical ly moves and resizes al l  the 
act ive windows, so they overlap one 
another. 

Ti le 
Hori zon tal l y 

Moves and resizes al l  the act ive 
windows so they are l ined up 
horizontal ly. 

Ti le 
Vert i cal l y 

Moves and resizes al l  the act ive 
windows so they are l ined up 
vert ical ly. 

Arrange 
Icons 

Arranges any min imized windows 
with in QALoad Analyze's parent 
window. 

Close Al l  Closes al l  open windows. 

 

Help menu  
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Opt ion  Descript i on  

Help Topics Displays QALoad's onl ine help 
contents. 

About  QALoad 
Analyze 

Displays the program's About box 
and copyright not ice. 

 

QALoad Analyze Toolbars 

Analyze toolbar but tons 

Click a toolbar button for a descript ion of that button.  

 

 

Graph toolbar but tons 

Change the style and appearance of a graph using opt ions avai lable from the Graph toolbar. The Graph 
toolbar also contains buttons for standard Windows operat ions. Although i t  normally appears atop a 
graph, the toolbar is completely dockable. M ove the toolbar to another side of the graph, or off the graph 
altogether, by cl icking any unpopulated area of the toolbar and dragging i t  to another area. 

Cl ick any button in  the fol lowing toolbar for a descript ion of that button.  

 

Display the Graph toolbar by right-cl icking in  an open area of a graph and choosing the Toolbar  opt ion 
from the shortcut menu. 

Accessing Test  Data 

Using t iming files 

When you run a test using a part icular session ID fi le (set up in  the Conductor), each Player compiles a 
local t im ing fi le comprised of a series of t im ing records for each checkpoint of each script  run on that 
Player. Each t im ing record in  the fi le consists of a response t ime/elapsed t ime pair of values specifying the 
amount of t ime i t  took a certain checkpoint to fin ish (response t ime) at a specific t ime in the test (elapsed 
t ime). 

At the end of a test, Player t im ing fi les are sent to the Conductor and are merged into a single t im ing fi le, 
cal led the Primary t im ing fi le, for analysis. If you set  up in tegrat ion with Compuware's ServerVantage 
product, the Conductor col lects t im ing data from the ServerVantage central console and merges that data 
in to the t im ing fi le as well . 

Primary t im ing fi les are saved in the \Program Files\Compuware\QALoad\TimingFiles directory, and 
are name <sessionID>_date_time.tim. 
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The Primary t im ing fi le created by the Conductor after a test run contains al l  of the t im ing records of al l  
Players in  that test run. Use QALoad Analyze to view, sort , graph, and create reports using the test data in  
the t im ing fi le. 

Hint : In the event that something goes wrong on the network and a Player timing file is not passed to the 
Conductor, it is still possible to analyze results from a Player timing file. Player timing files are saved in the 
\Program Files\Compuware\QALoad\TimingFiles directory and are named 
tim_yyyymmdd_hhmmss_xxx.ptf, where yyyymmdd_hhmmss is the date/ time the test was started, and 
xxx is the Player number. 

 

Accessing test  data 

When you open a t im ing fi le, QALoad ’s Analyze program summarizes the checkpoints recorded in the fi le 
during the load test and presents the data in  a report  format cal led the Summary report . 

Three ways to access QALoad Analyze and open a t im ing fi le contain ing test results are: 

To access Analyze f rom  t he QALoad Conduct or : 

1. In the QALoad Conductor, click Tools>Options. The Options dialog box appears. 

2. Click the General tab. In the General Options area, select the Launch Analyze After Test check box. 

At the end of each test run, QALoad Conductor automatical ly launches QALoad Analyze and opens the 
most recent t im ing fi le. Or, i f you did not select the Launch Analyze After Test check box before the test: 

1. Click Tools>Analyze. 

2. In QALoad Analyze, click File>Open. The Open Timing File dialog box appears. Select a timing file to work with by 
double-clicking the file name in the list of available timing files. 

Use the fol lowing method when accessing a previously-created t im ing fi le. 

To access Analyze f rom  t he W indow s St ar t  m enu: 

1. Click Start>Program Files>Compuware> QALoad >Analyze. 

2. Click File>Open. The Open Timing File dialog box appears. Select a timing file to work with by double-clicking the 
file name in the list of available timing files. 

3. Select the template to use for viewing the timing file. 

Use the fol lowing method when you are already working in  the QALoad Script Development Workbench 
and need to access a previously-created t im ing fi le. 

To access Analyze f rom  t he QALoad Scr ip t  Developm ent  W orkbench: 

1. In the QALoad Script Development Workbench, click Tools>Analyze. 

2. In QALoad Analyze, click File>Open. The Open Timing File dialog box appears. Select a timing file to work with by 
double-clicking the file name in the list of available timing files. 

3. Select the template to use for viewing the timing file. 
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Accessing Test  Data via Groups 

Located in the QALoad Analyze Workspace, each group displays data from a t im ing fi le. The data displayed 
and the groups avai lable may vary, depending on the type of data that was col lected during the load test. 

Access groups to select data for generat ing a detai l  view or graph. Cl ick a group name below to view the 
type of data that is displayed by each group. 

Reports 

Checkpoints 

Counters 

Server Monitoring 

Player Performance Counters 

Top Processes 

RIP Fi les 

Appl icat ionVantage 

Expert User 
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Using Templates 

Using Timing File Templates  

Timing fi le templates enable you to save current views of an open t im ing fi le. Al l  open views, such as 
reports, graphs, and thresholds are stored in  the template. When you reopen a t im ing fi le or open a new 
t im ing fi le and apply a template, i t  appears with the set of views defined for the template.  

Every t ime you close a t im ing fi le in  Analyze, a Last Viewed State template for the t im ing fi le is created. 
This fi le stores the reports and graphs that are open, their posit ions and sizes, and any thresholds you 
defined. You can use an opt ion s in  the Open  menu or in  the Tools>Opt ions menu to choose to reopen a 
t im ing fi le in  the same state i ts last viewed state.   

Use the Tem plate menu to: 

!  Save the current views of a timing file to create a template. 

!  Select an existing template and apply it to the open timing file. 

!  Remove the template from the current timing file or from disk. 

!  Create system-wide thresholds for counters and checkpoints. 

You can apply a template to any t im ing fi le you open. If any part  of the template cannot be appl ied to the 
t im ing fi le, for example, i f the template references a script  that doesn't  exist  in  the current fi le, a dialog box 
displays with the name of the report  or graph that doesn't  apply. The default  name for the template is the 
SessionID port ion of the f i le name of the open t im ing fi le.  

Note: Only one t im ing fi le is saved to a template. If more than one t im ing fi le is open, the opt ion to 
define a template is disabled. 

 

Creating a New Template 

Create a template to save the views of an open t im ing fi le. This saves reports and graphs that are open, as 
well  any thresholds that have been defined. When you open other t im ing fi les using the template, the fi les 
display in  the views saved to the template.  

To creat e a new  t em plat e: 

1. Click Tem plate>Save curren t  view s. The Speci fy Tem plate to Save curren t  view s and 
th resholds dialog box appears. 

Note: This menu option is available only if a single timing file is open. 

2. Select a folder in  the Save in  field. By default , al l  templates are stored in  the Tem plates folder. The 
default  template name is the Session ID port ion of the t im ing fi le name.  

3. Do one of the fol lowing: 

 Click Create to accept the Session ID as the template name. When you use th is name 
for the template, al l  future t im ing fi les created by th is Conductor session automatical ly 
open with the views speci fied in  the template. 

 Type a name for the new template in  the Fi le nam e field, and cl ick Create.  

Note: You can choose template options that globally set how timing files open using the options 
in the Analyze Opt ions dialog box . 
. 
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Opening a Timing File in a Template 

When you open a t im ing fi le, you can select how it  displays by opening i t  in  a template. Specifying a 
template opens the reports, graphs, and thresholds defined in the template. 

To open a t im ing f i le in  a t em plat e: 

1. Click File>Open. The Open Timing File dialog box displays. 

2. In the File name field, select the timing file to open. 

3. Select one of the following: 

 Open  last  view ed state i f  avai lable - (Default) Opens the t im ing fi le in  the same views 
that were displayed when you last closed i t .  This restores al l  reports and graphs that 
were open, their posit ions and sizes, as well  as any defined thresholds for graphs. If 
there is no last viewed state or i f you do not select th is opt ion, the fi le opens using the 
opt ion you select in  the Tem plate area below. 

 In  the Tem plate area, cl ick one of the fol lowing opt ions: 

o Do NOT use a tem plate w hen  open ing t im ing f i le - No template is appl ied and only 
the Summary report  for the t im ing fi le displays. 

o Use tem plate associated w i th  Session  ID f i l e nam e - (Default) Appl ies the template 
with the same Session ID name as the t im ing fi le. Use th is opt ion to open al l  future 
t im ing fi les created by th is Conductor session with the views specified in  the template. 
If no match is found, only the Summary report  displays. 

o Use th i s tem plate for open ing the t im ing f i l e - Enables the Brow se (...) button. Select 
a saved template to apply to al l  t im ing fi les when they are opened.  

Note: By default, both the Open in last  viewed state if available and Use template associated with the 
Session ID file name are selected. This way if there is no last viewed state, the template associated with the 
Session ID file name is applied to the timing file. 

4. Click Open. The timing file you selected appears in the views defined for the selected template. 

 

Applying a Template to an Open Timing File 

You can select an exist ing template and apply i t  to al l  open t im ing fi le. This closes al l   the reports and 
graphs that are open and displays the t im ing fi le in  the views defined in the template.  

To apply a t em plat e t o an open t im ing f i le: 

1. Click Tem plate>Use ex ist i ng. The Select  Tem plate to Use for Open  Tim ing Fi l es dialog box 
appears. 

2. Select a template and cl ick Apply .  

Al l  open reports and graphs are closed and those specified in  the template are opened.  

Note: If any part of the template cannot be applied to the timing file, for example, if the template 
references a script that doesn't exist in the current file, a dialog box appears with the name of the report or 
graph that can't be displayed. 
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Applying Templates Globally 

You can select template opt ions that global ly set how t im ing fi les open. Using a template opens the 
reports, graphs, and thresholds defined in the template. 

To select  a t em plat e op t ion f or  appl icat ion t o f i les w hen t hey are opened: 

1. Click Tools>Options. The Analyze Options dialog box displays. 

2. Click the Templates tab. 

3. Select one of the following: 

 Open  last  view ed state i f  avai lable - (Default) Opens the t im ing fi le in  the same views that 
were displayed when you last closed i t . This restores al l  reports and graphs that were open, their 
posit ions and sizes, as well  as any defined thresholds for graphs. If there is no last viewed state 
or i f you do not select th is opt ion, the fi le opens using the opt ion selected in  the Tem plate area 
below. 

 In  the Tem plate area, select one of the fol lowing: 

o Do NOT use a tem plate w hen  open ing t im ing f i les - No template is appl ied. The 
Summary report  for the t im ing fi le displays. 

o Use tem plate associated w i th  the Session  ID f i l e nam e - (Default) Appl ies the template 
with the same Session ID name as the t im ing fi le. Use th is opt ion to open al l  future 
t im ing fi les created by th is Conductor session with the views specified in  the template. If 
no match is found, only the Summary report  displays. 

o Use th i s tem plate for open ing t im ing f i l es -  Enables the Brow se (...) button. Select a 
saved template to apply to al l  t im ing fi les when they are opened.  

Note: By default, both Open in last  viewed state if available and Use template associated with the last  
Session ID file name are selected. This way, if there is no last viewed state, the template associated with the 
Session ID file name is applied to the timing file. 

4. Click Ok. 

 

Using the Options Dialog Box for Templates 

Use the Analyze Options dialog box to select a template opt ion that appl ies when you open al l  t im ing fi les. 
Using a template opens the reports, graphs, and thresholds defined in the template. Sett ing the template 
opt ion here determines how al l  t im ing fi les open. 

Note: Use Template>Use Exist ing to apply a template to an individual open timing file.   

To speci f y a t em plat e: 

1. Click Tools>Options.   

2. Click the Templates tab and select one of the following: 

 Open  last  view ed state i f  avai lable - (Default) Opens the t im ing fi le in  the same views 
that were displayed when you last closed i t . This restores al l  reports and graphs that 
were open, their posit ions and sizes, as well  as any defined thresholds for graphs. If 
there is no last viewed state or i f you do not select th is opt ion, the fi le opens using the 
opt ion selected in  the Tem plate area below.  
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 In  the Tem plate area, select one of the fol lowing: 

o Do NOT use a tem plate w hen  open ing t im ing f i les - No template is appl ied. The 
Summary report  for the t im ing fi le displays.  

o Use tem plate associated w i th  the Session  ID f i l e nam e - (Default) Appl ies the template 
with the same Session ID name as the t im ing fi le. Use th is opt ion to open al l  future t im ing 
fi les created by th is Conductor session with the views specified in  the template. If no match 
is found, only the Summary report  displays.  

o Use th i s tem plate for open ing t im ing f i l es - Enables the Browse (...) button. Select a saved 
template to apply to al l  t im ing fi les when they are opened.  

Note: By default, both Open in last  viewed state if available and Use template associated with the 
Session ID file name are selected. This way if there is no last viewed state, the template associated with the 
Session ID file name is applied to the timing file. 

 

Displaying Detail Data 

Detail Views 

You can view detai l  data by right-cl icking a script  or group and select ing Detai l . The detai l  view displays 
data from a t im ing fi le. The data displayed and the groups avai lable may vary, depending on the type of 
data that was col lected during the load test. Detai l  data is displayed in two panes: a summary table and a 
data table.  

You can view detai ls for the fol lowing groups: 

Checkpoints 

Counters 

Server Monitoring 

Player Performance Counters 

Top Processes 

Expert Users 

 

 

Displaying detail data 

Display detai led stat ist ics from a t im ing fi le such as checkpoints, counters, in  the QALoad Analyze Data 
window. View stat ist ics for not only the act ive t im ing fi le, but also for other t im ing fi les and drag and drop 
onto the act ive t im ing fi le detai l  view. 

To display det ai led st at ist ics: 

1. In the workspace, with the appropriate Timing File tab selected, click the group for which you want to view statistics.  

2. Select the appropriate checkpoints or counters (depending on which group you choose).  

3. From the Analyze toolbar, click the Detail button or right-click on a selected checkpoint or counter and choose 
Detail.  
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Detai l  in formation is presented in the Data window in both a summary and data table. The information  
displayed varies based on the group selected.  

Note: If the test aborts, complete data for all the checkpoints and counters may not display. 

The fol lowing detai l  views are avai lable: 

Checkpoints Detai l  Data 

Counters Detai l  Data 

Server Monitoring Detai l  Data 

Player Performance Counters Detai l  Data 

Top Processes Detai l  Data 

Expert  user Detai l  Data 

 

 

Checkpoints Detail Data 

You can view checkpoint detai l  data by Script  or by Player. The View  by Script  displays the detai l  data of 
selected checkpoints and raw data col lected for each script  during the load test. The View  by Player  groups 
the detai l  data by player machine and shows only the scripts for which individual players gathered data. 
For each view, checkpoint detai l  data is displayed in two panes: a summary table and a data table.  

Checkpoin ts Sum m ary Table 

Shows stat ist ical averages for the selected checkpoin ts and displays a summary of the raw data col lected 
from the load test. The fol lowing data may be displayed: 

Tim ing Fi l e: Name of the t im ing fi le the checkpoint  came from. 

Script : Name of the script  fi le. 

Checkpoin t : Checkpoint name 

Type: Type of checkpoint: response t ime or sleep t ime. 

Group: Automatic (avai lable i f automatic checkpoint t im ings are enabled in  the Conductor), or User (for 
user-defined checkpoints). 

#Tran s: Total number of data points that were used to calculate the stat ist ics. If data th inning is enabled, 
th is column displays as "#Thinned Trans". 

#Recs: Number of records recording during the test. If data th inning is enabled, th is column displays as 
"#Thinned Recs". 

Data Th in : If the Enable Tim ing Data Th inn ing check box was selected in  the QALoad Conductor's 
Timing Options dialog box prior to start ing a load test, the value typed in the Th in  Every <xx> 
Transact ions wi l l  be in  th is column. If not selected, the value is none.  

Note: For a complete description of this QALoad Conductor option, see Timing Options. 

M in : M in imum recorded response t ime. 

M ean : Average of the response t imes. 

M ax : Maximum recorded response t ime. 
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StdDev : Standard deviat ion of al l  response t imes. Standard deviat ion is an indicator of how widely values 
are dispersed from the average (mean) value. A large standard deviat ion indicates a wide variance in 
response t imes. 

M edian : Median response t ime (in  seconds). The median is the value at which half of the responses are 
greater and half of the responses are less. If the number of responses is large, the median is usual ly close to 
the mean. 

Nth  Percen t i l e: Displays that nth% of the responses have a value less than the value shown. 

Pacing (Seconds): Rate at which the script  executed transact ions. 

VU ’s: Number of virtual users execut ing th is script . 

Threshold : Value that sets the l im it  for the threshold, which is the expected warning and cri t ical level for 
the checkpoint. 

Fai lure Rate: Percentage of checkpoints that surpassed the threshold l im it . 

Total  Violat i ons: Total number of threshold violat ions. 

Checkpoin ts Data Table 

Provides a view of the raw data col lected during the load test. It  can be useful for pinpoint ing anomalies 
with load test results.  The fol lowing data may be displayed: 

Tim ing Fi l e: Name of the t im ing fi le the checkpoint  came from. 

Script : Name of the script  fi le. 

Checkpoin t : Checkpoint name. 

Type: Type of checkpoint: response t ime or sleep t ime. 

Group: Automatic (avai lable i f automatic checkpoint t im ings are enabled in  the Conductor), or User (for 
user-defined checkpoints). 

VU: The virtual user that was running. 

Player : Player machine the test results came from. 

#Sam ples: Displays how many records were th inned into a single record i f data th inning was enabled. If 
the value is 1, the data records were not th inned. 

Elapsed (Seconds): Time into the test at which a data point was col lected. 

Respon se (Seconds): Value of the data col lected. 

Threshold : Value that sets the l im it  for the threshold, which is the expected warning and cri t ical level for 
the checkpoint. 

 

 

Counters Detail Data 

Counter detai l  data is displayed as fol lows: 

Coun ters Sum m ary Tabl e 

Shows stat ist ical averages for the selected counters. It  is a summary of raw data col lected from a load test. 
 The fol lowing data may be displayed: 

Tim ing Fi l e: Name of the t im ing fi le the counter came from. 
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Script : Name of the script  fi le that contained the counter. 

Group: Group name. 

Note: Not all counters will belong to a group. Those counters that do will have a group name displayed. 
For instance, custom and Web counters are logically organized by groups. However, Virtual Users and Total 
Virtual Users do not belong to a group. 

Nam e: Name of the counter. 

Note: Certain statistical data is shared across all detail views. For a description of these fields, click the 
following: Statistical Information 

Coun ters Data Table 

Provides a view of the raw data col lected during a load test. It  can be useful for pinpoint ing anomalies 
with in load test results.  The fol lowing data may be displayed: 

Tim ing Fi l e: Name of the t im ing fi le the counter came from. 

Script : Name of the script  fi le that contained the counter. 

Group: Group name. Custom and Web counters are logical ly organized by groups. 

Coun ter :  

Instan ce:  

VU: Name of the virtual user. 

Player : Player machine the test results came from. 

#Recs: Displays how many records were th inned in to a single record i f data th inning was enabled. If the 
value is 1, the data records were not th inned. 

Elapsed (Seconds): Time into the test at which a data point was col lected. 

Value: Value of the data col lected. This column displays the value of instance counters. 

Cum ulat i ve Value: Total number of occurrences during the elapsed t ime. This column displays the value 
of cumulat ive counters. 

Threshold : Value that sets the l im it  for the threshold, which is the expected warning and cri t ical level for 
the checkpoint. 

 

Server Monitoring Detail Data 

QALoad provides performance counter data through three server monitoring methods. Cl ick the fol lowing 
l inks for descript ions of the server monitoring detai l  data opt ions: 

!  Remote Monitoring - Monitoring of performance counters from a machine under test without the use of agent 
software on the machine. 

!  Server Analysis - Monitoring of performance counters from a machine under test using the ServerVantage agent 
software installed on the machine. 

!  ServerVantage - Availability Management application complimentary to QALoad for service level monitoring of 
performance counters for applications, servers, and databases during production. ServerVantage also provides 
notification, event management, and reporting features. 
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Player Performance Counters Detail Data 

Player performance counters detai l  data is displayed as fol lows: 

Player Performance Summary Table 

Shows stat ist ical averages for the selected Player performance counters. It  is a summary of the raw data 
col lected from a load test.  The fol lowing data may be displayed: 

Tim ing Fi l e: Name of the t im ing fi le the counter came from. 

Player : Player name. 

Descript i on : Descript ion of the counter. 

Note: Certain statistical data is shared across all detail views.  

Player Performance Data Table 

Provides a view of the raw data col lected during a load test. It  can be useful for pinpoint ing anomalies 
with in load test results. The fol lowing data may be displayed: 

Tim ing Fi l e: Name of the t im ing fi le the performance counter came from. 

Player : Player name. 

Descript i on : Name of the counter. 

Elapsed (Seconds): Time into the test at which a data point was col lected. 

Value (%): Value of the data col lected. 

Threshold : Value that sets the l im it  for the threshold, which is the expected warning and cri t ical level for 
the checkpoint. 

 

Top Processes Detail Data 

Top Processes detai l  data is displayed as fol lows: 

Top Processes Summary Table 

Shows stat ist ical averages for the selected Top Processes data. It  is a summary of the raw data col lected from 
a load test.  The fol lowing data may be displayed: 

Tim ing Fi l e: Name of the t im ing fi le the counter came from. 
Process: Name of the process monitored during the test. 
#DataPts: Number of data points col lected for each part icular process. 

Note: Certain statistical data is shared across all detail views. For a description of these fields, click 
the following: Statistical Information 

Top Processes Data Table 

Provides a view of raw data col lected during a load test. It  can be useful for pinpoint ing anomalies with in 
load test results. The fol lowing data may be displayed: 

Tim ing Fi l e: Name of the t im ing fi le the counter came from. 
Process: Process name. 
Elapsed (Seconds): Time into the test at which a data point was col lected. 
% CPU: Percent of CPU used. 
Threshold : Value that sets the l im it  for the threshold, which is the expected warning and cri t ical 
level for the checkpoint. 
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Expert  User Detail Data 

Expert User detai l  data is displayed as fol lows: 

Expert User Summary Table: 

Shows stat ist ical averages for the selected expert  user data. It  is a summary of the raw data col lected from a 
load test.  The fol lowing data may be displayed: 

Tim ing Fi l e: Name of the t im ing fi le the expert  user data came from. 

Script : Name of the script  the expert  user data came from. 

Player : Name of the Player machine the expert  user data came from. 

M ain  URL: The of the main URL requested. 

Respon se: The HTTP status code of the request returned by the server.  

Subrequest  URL: Lists the URL of the subrequests that were made from the Main URL.  

Data Type: The type of data. This can be Server or Network. 

Note: Certain statistical data is shared across all detail views. For a description of these fields, click the 
following: Statistical Information 

Expert User Data Table 

Provides a view of the raw data col lected during a load test. It  can be useful for pinpoint ing anomalies 
with in load test results. The fol lowing data may be displayed: 

Tim ing Fi l e: Name of the t im ing fi le the performance counter came from. 

Script : QALoad Player agent name. 

Player : Server analysis counter. 

M ain  URL: Mult iple occurrences in  t ime of the performance counter. 

Respon se: The HTTP status code of the request returned by the server.   

Subrequest  URL: Lists the URL of the subrequests that were made from the Main URL. 

Data Type: The type of data. This can be Server or Network. 

Elapsed (Seconds): Time into the test at which a data point was col lected. 

Respon se (Seconds): Network and server response t imes in the t ime scale you select in  
Tools>Options>Workspace. You can select seconds, minutes, or hours. The default  is seconds. 

Threshold : Value that sets the l im it  for the threshold, which is the expected warning and cri t ical level for 
the checkpoint. 

 

Sort ing test  data 

A Detai l  view potent ial ly contains a large number of checkpoints, counters, and so forth, especial ly i f a 
load test had many virtual users. To make information manageable, specify up to three levels of cri teria to 
sort  by, in  ascending or descending order. 

For example, i f a test ran using five scripts on 100 virtual users, sort  the data by script  name. Suppose each 
virtual user ran more than one transact ion using a part icular script , then sort  by both script  name and by 
virtual user. Or, to quickly locate any t im ing bott lenecks, sort  by response t ime. 
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Use the Sort  Detai ls dialog box to sort  a detai l  view. To access th is dialog box, select Tools>Sort  from the 
Analyze menu or cl ick Sort  on the Analyze toolbar. 

Speci fy sort  opt ions for t he fol l ow ing grid : Select the Sum m ary  opt ion to conduct sort  on the Sum m ary  
table. Select the Data opt ion to conduct a sort  on the Data table. 

Sort  By : Select the first  column to sort  by from the list , then select the Ascending or Descending sort  
order opt ion. 

Then  By : Select the second column to sort  by from the l ist , then select the Ascending or Descending sort  
order opt ion. 

Then  By : Select the th ird column to sort  by from the l ist , then select the Ascending or Descending sort  
order opt ion.  

 

Graphing QALoad t iming data 

A t im ing fi le can potent ial ly contain enough data that graphing al l  of i t  at  one t ime results in  an 
unreadable graph. Before beginning, consider th inning the amount of data to be shown on a single graph. 
Detai ls 

Select the group to graph: 

In  the Workspace, with the appropriate Timing Fi le tab selected, cl ick the group for which to create a 
graph.  

Note: If the test aborts, complete data may not be available for all checkpoints and counters. 

The fol lowing groups are avai lable, depending on the t im ing fi le: 

Checkpoints 
Counters 
Server Monitoring 
Player Performance Counters 
Top Processes 
Expert User 

Note: For each Group except Checkpoints and Expert User, the graph type is a line graph. For graphing 
multiple checkpoints or expert users, the graph type is either a line or bar graph. For graphing a single 
checkpoint only, in addition to line and bar graphs, you can also create Response Time Distribution and 
Cumulative Response Time Distribution graphs. 
 

 

Thresholds 

Using Thresholds 

Thresholds are user-defined values that show the expected warning and cri t ical l im its for a counter or 
checkpoint. Thresholds help ident i fy problem areas in  the test, such as checkpoints or counters that go 
above or below a specified number. They act ively monitor response t imes by indicat ing whether data 
records are surpassing user-defined expected warning and cri t ical levels.  

Thresholds are saved in the Template fi le. The information displays in  graphs and detai l  reports in  the 
detai l  data view.  

Graphs 
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The selected data is displayed in a l ine graph format in  the Data window. Graphs show thresholds as 
horizontal l ines with the number of fai led points.  

 

Detai l  Reports 

Detai l  reports display thresholds in  a Summary table and a Data table. The Summary table is a summary of 
raw data col lected from a load test. The defined threshold l im its, the percentage of fai lures for the 
threshold, and the total violat ions are displayed. In the Data table, the fai led points are shown in red. 
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Creating Thresholds 

Define thresholds to show the expected warning and cri t ical l im its for a counter or checkpoint. 

To creat e Thresholds: 

1. Select Template>Thresholds. The Thresholds dialog box appears. 

2. Click the appropriate  group in the Workspace. Data within each group is listed in a tree-view. 

3. Highlight a counter or checkpoint and drag it to the Threshold dialog box.  

Note: You can drag entire groups or individual items to the Threshold dialog box.  

4. Click Edit to name the threshold and set the threshold limits and conditions. 

5. Do one of the following: 

 Click the check box in  the Act i ve column for the thresholds you want to use, then cl ick 
Apply .  

 Click Act i vate Al l  to use al l  of the thresholds, then cl ick Apply . 

 

Editing Thresholds 

Once you create the threshold, set the threshold propert ies using the Edi t  funct ion. 

To edi t  Thresholds: 

1. In the Thresholds dialog box, do one of the following: 

 Double-cl ick the threshold you want to edit .  

 Highl ight the appropriate threshold and cl ick Edi t . 

The Threshold Propert i es dialog box appears. 
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2. In the Threshold Label field, type a name for the threshold. This is optional. 

3. In the Limit field, type the number for the threshold. This is used with the Condition you select to calculate 
violations. 

4. In the Limit Condition section, choose how the threshold violations are calculated. You can select: 

 Greater than the threshold l im it  you defined (>) 

 Equal to the threshold l im it  you defined (=) 

 Less than the threshold l im it  you defined (<) 

5. Click OK. The Threshold dialog box appears showing the limit and condition you specified. 

 

Viewing Thresholds 

Threshold in formation displays in  graphs and detai l  reports in  the detai l  data view .  

Note: The data displayed and the groups available may vary, depending on the type of data that is 
collected during the load test. 

To view  t h resholds in  g raphs: 

1. In the Workspace, click the appropriate Timing File tab. Data is listed in a tree-view. 

2. Click the group to view, and select the appropriate checkpoints or counters to display in the graph.   

Note: You can select an entire group or individual data files. 

3. Click View> Graph or right-click and choose Graph from the context menu.  

The selected data displays in  a l ine graph format in  the Data window.  Graphs show thresholds as 
horizontal l ines with the number of fai led points.  

To view  t h resholds in  det ai l  repor t s: 

1. In the Workspace, click the appropriate Timing File tab. Data is listed in a tree-view. 

2. Click the group to view, and select the appropriate checkpoints or counters to display in the detail report.  

Note: You can select an entire group or individual data files. 

3. Click View> Detail or right-click and choose Detail from the context menu.  

The detai l  report  for the selected data displays. Detai l  reports display thresholds in  a Summary table and a 
Data table. The Summary table is a summary of raw data col lected from a load test. In  the Data table, the 
fai led points are shown in red. 

 

Using the Thresholds Dialog Box  

The Thresholds dialog box al lows you to create system-wide thresholds for specific checkpoints and 
counter sets. Here you set the value that defines the l im it  for the threshold, which is the expected warning 
and cri t ical level for the checkpoint or counter. This value is used in conjunct ion with the Lim i t  
Condi t i on  that you set in the Threshold Propert i es dialog box to determine whether data violates the 
threshold.  
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Copy : Al lows you to copy a counter or checkpoint and assign a different threshold l im it  and condit ion. 

Edi t : Opens the Threshold Propert ies dialog box, where you define the threshold l im it  and choose how the 
violat ions are calculated. 

Rem ove: Deletes the threshold you have h ighl ighted. 

Act i vate Al l : Selects al l  the thresholds so that they may be appl ied  to the open t im ing fi le. A check is 
placed in the Act ive column. 

Act i vate None: Removes the check in  the Act ive column of al l  the thresholds so that none are appl ied to 
the open t im ing fi le. 

Apply : Appl ies the thresholds that you act ivate to the open t im ing fi le. 

 

Creat ing a Chart  or Graph 

Thinning data before graphing 

Test results may contain more data than can reasonably be graphed. Thinning data before graphing 
provides a clearer and more manageable graph. 

To set  up dat a t h inning : 

1. With a timing file open, click Tools>Options. 

2. Click the Data Thinning tab. 

3. Type the number of data points to plot on each graph and select the method by which to graph the data points. 

4. Click OK. 

For a descript ion of the opt ions on th is dialog box, see Options Dialog Box - Data Thinning Tab.  

 

Graphing checkpoints 
Note: A timing file can potentially contain enough data that graphing all of it at one time results in an 

unreadable graph. Before beginning, consider thinning the amount of data to be shown on a single graph. 
Details 

To graph checkpoin t s: 

1. Open the appropriate .tim file in QALoad Analyze. In the Workspace, click the Checkpoints group. Checkpoint data is 
listed in a tree-view. 

2. Select the checkpoints to graph. 

3. From the View menu, choose Graph. The Select Graph dialog box appears.  

4. In the Graph Type drop-down list, select from the following: 

 Line (response t imes versus elapsed t imes for the selected data.) 

 Bar (median, mean, or a percent i le response t ime of the selected checkpoints.) 
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Note: The following graph types are only available when graphing a single checkpoint: 

 Response Time Distribut ion (how the response t imes of a single checkpoint are distributed.) 

 Cumulat ive Response Time Distribut ion (the percentage of checkpoint t im ings that were equal 
to or less than a specified value.) 

Data for the selected checkpoint(s) is graphed in the Data window in the format selected in  step 4. 

 

Graphing counters 
Note: A timing file can potentially contain enough data that graphing all of it at one time results in an 

unreadable graph. Before beginning, consider thinning the amount of data to be shown on a single graph. 
Details 

To graph count er s: 

1. Open the appropriate .tim file in QALoad Analyze. In the Workspace, click the Counters group. Counter data is 
listed in a tree-view. 

2. Select the counter(s) to graph. 

3. From the View menu, choose Graph. Data for the selected counter(s) is graphed in a line graph format in the Data 
window. 

 

Graphing Player performance counters 
Note: A timing file can potentially contain enough data that graphing all of it at one time results in an 

unreadable graph. Before beginning, consider thinning the amount of data to be shown on a single graph. 
Details 

To graph Player  per f orm ance count er s: 

1. Open the appropriate .tim file in QALoad Analyze. Select the Player Performance Counters group. 

2. In the Workspace, select the performance counter(s) to graph. 

3. Click the View Graph button or right-click and choose Graph from the context menu. Data for the selected Agent(s) 
is graphed in a line graph format in the Data window. 

  

Graphing server monitoring data 

Monitoring servers is a method of load test ing. QALoad provides performance counter data through three 
server monitoring methods: 

!  Remote Monitoring - Performs the monitoring of performance counters from a machine under test without the use of 
agent software on the machine. 
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!  Server Analysis - Performs the monitoring of performance counters from a machine under test using the 
ServerVantage agent software installed on the machine. 

!  ServerVantage - An Availability Management application complementary to QALoad for service level monitoring of 
performance counters for applications, servers, and databases during production. ServerVantage also provides 
notification, event management, and reporting features. 

  

Graphing top processes 
Note: A timing file can potentially contain enough data that graphing all of it at one time results in an 

unreadable graph. Before beginning, consider thinning the amount of data to be shown on a single graph. 
Details 

To graph t op  processes: 

1. Open the appropriate .tim file in QALoad Analyze. Select the Top Processes group.  

Note: The Top Processes group is available only if you enable the option in the QALoad Conductor 
Server Analysis Agent configuration screen before running a test. 

2. In the Workspace, select the data point(s) to graph. 

3. Click the View Graph button or right-click and choose Graph from the context menu. Data for the selected Agent(s) 
is graphed in a line graph format in the Data window. 

  

Graphing Expert  User Data 
Note: A timing file can potentially contain enough data that graphing all of it at one time results in an 

unreadable graph. Before beginning, consider thinning the amount of data to be shown on a single graph. 
Details 

To graph exper t  user  dat a: 

1. Open the appropriate .tim file in QALoad Analyze.  

2. Select the Expert User group in the Workspace tree-view. 

3. In the Workspace, select the data point(s) to graph. 

4. Click the View Graph button or right-click and choose Graph from the context menu. Data for the selected Agent(s) 
is graphed in a line graph format in the Data window. 

 

Customizing a Chart  or Graph 

Customizing a graph 

Change the style and appearance of a graph using opt ions avai lable from the Graph toolbar. The Graph 
toolbar contains buttons for standard Windows operat ions as well  as for customizing a graph's appearance. 
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Display the Graph toolbar by right-cl icking in  an open area of a graph and choosing the Toolbar  opt ion 
from the shortcut menu. Although i t  in i t ial ly appears above the graph, the toolbar is completely dockable. 
Move the toolbar to another side of the graph, or off the graph altogether, by cl icking on any unpopulated 
area of the toolbar and dragging i t  to another area. 

The fol lowing features can be customized from the Graph toolbar. Cl ick on any feature in  the fol lowing l ist  
for addit ional in formation or instruct ions: 

Graph type 

Color 

Grid orientat ion (horizontal and vert ical) 

Legend box 

Dimension (3D or 2D) 

Rotat ion 

Z-Cluster 

Font  

 

Viewing Reports 

Viewing Pre-Defined Reports 

Pre-Defined Reports 

QALoad Analyze provides pre-defined reports for viewing load test results 
without t ime-consuming data manipulat ion. 

In  the Workspace, select the Reports group and cl ick the appropriate 
report . The reports are in  HTML generated by XSL fi les. View them in 
QALoad Analyze, or direct ly in  a Web browser.  

Note: Compuware provides each of the available pre-defined reports as 
convenience to view the results of a load test without any data manipulation. 
In addition, create customized versions of these reports by selecting the 
appropriate group and creating detail reports and graphs. 

The fol lowing reports are avai lable. Cl ick a report  name for detai ls. 

 Summary 

 Session 

 Concurrent Users 

 Response Time Analysis 

 Output 

 Cl ient Throughput 

 Server Monitoring 

 Transact ion Throughput  
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 Top Ten Longest Checkpoint Durat ions 

 Worst Performing Checkpoints and Counters 

  Player Performance  

  Expert  User 

  Appl icat ionVantage 

 

 

 

 

 

 

Summary report 

The Summary report  is the primary output from each test run, one of the pre-defined reports QALoad 
Analyze makes avai lable. When you open a t im ing fi le, QALoad Analyze automatical ly displays the Load 
Test Summary in  the Data window. It  presents t im ing in formation for each transact ion in  the t im ing fi le 
and the min imum, maximum, and median response t imes for each checkpoint. The output is divided into 
two sect ions. The first  sect ion presents the Summary Test In formation, Test Time information, and Data 
Thinning and Time Range information.  

The second sect ion presents the Script In formation for each script . It  shows t im ing Summaries and 
Checkpoint in formation for each script . 

Sam ple Sum m ary 

For a brief descript ion of each report  sect ion, scrol l  down and cl ick a sect ion heading, for example, Test 
In formation, in  the fol lowing sample. 
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Session report 

Provides summary in formation about the test session. The information in  th is report  was obtained from 
the Conductor’s configurat ion sett ings when the load test was started. To view a summary of test sett ings 
that includes changes made while the test was running, see the Summary report .  
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or descript ions of the in formation provided in each sect ion, cl ick the sect ions in  the fol lowing image.  

 

 

 

 

Concurrent Users report 

Displays the total number of virtual users for the test, concurrent users vs. elapsed t ime, as well  as graphs 
for individual scripts that were part  of the test.  

Note: A totals graph will not display if the test contains only one script. 
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Response Time Analysis report 

Provides an indicator of how well  a script  ran. The report  displays a graph of each script 's transact ion 
durat ion (response t ime vs. elapsed t ime) as well  as the fol lowing checkpoint summary data: 

#Tran s: Number of data points used to calculate the stat ist ics. 
#Recs: Number of data records. This value, i f di fferent from the value of #Trans, reflects the number of 
checkpoint records that are used for analysis after data th inning has been appl ied. 
M in : M in imum recorded response t ime. 
M ax : Maximum recorded response t ime. 
Std. Dev : Standard deviat ion of al l  response t imes. A large standard deviat ion indicates a wide variance in 
response t imes. 
M edian : Median response t ime, in  seconds. 
n th%: n percent of the responses have a value less than the value shown.  

 

 

Output report 

Provides a cumulat ive l ist  of al l  errors, sorted by script  and occurrence in t ime, that occurred during the 
course of a load test.  

Note: Failed messages are included in the errors count that appears in the Test Information section of the 
report, but are detailed in the Script Messages section. 
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Client Throughput report 

Provides a graph of HTTP Reply analysis for key HTTP counters, HTTP counter vs. elapsed t ime. 

 

 

 

Server Monitoring report 

Server monitoring is a component of load test ing. QALoad provides performance counter data through 
three server monitoring methods: Remote M onitoring, ServerVantage, and Server Analysis Agent 
monitoring. 
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Transaction Throughput report 

Provides the cumulat ive number of t ransact ions over elapsed t ime for each script  and for the total test.  
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Top Ten Longest Checkpoint Durations report 

Provides graphs and l ists detai ls about checkpoints that had the longest checkpoint durat ion during the 
test. Checkpoints with longest durat ions are those that consumed the most amount of t ime during the test. 
This report  contains the fol lowing sect ions: 

!  A summary section with overview information about the test.  

!  A bar graph of the ten longest checkpoint durations in the test, followed by details for each checkpoint in the graph. 
These checkpoints can originate in any script that was included in the test. 

!  Bar graphs for each script that show up to the ten longest checkpoint durations, followed by details for each 
checkpoint in the script. 
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The report  is generated by Analyze only i f each script  has at least one checkpoint other than the durat ion 
checkpoint. The data provided in the report  can be used as a start ing point to ident i fy performance 
problems. 

Note: Transaction duration checkpoints are not included in the report. 
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Player Performance report 

Displays transact ion durat ions in  a graph format by player machine. This report  helps ident i fy individual 
player machines that have poor test results. In  addi t ion to the bar graph that plots the average transact ion 
durat ion for each player machine, the report  also includes summary data for the overal l  test, and detai ls for 
each player machine. This report  is generated by Analyze only i f two or more player machines were used in 
the test.  

 

 

Worst Performing Checkpoints and Counters report 

This report  provides graphs and l ists detai ls about checkpoints and counters that had the worst 
performance during the test. Performance is based on the thresholds you define.  

Checkpoints with the worst performance are calculated using the average response t ime for each 
checkpoint. Counters with the worst performance are those that consume the most amount of t ime during 
the test. Checkpoints with the most errors and counters with the h ighest fai lure rates are l isted first . The 
data provided is a start ing point for ident i fying performance problems. 

Note: The report is generated by Analyze only if a threshold is defined and if the threshold is violated by 
the data. Thresholds that are not violated do not appear in the report. 

The bar graphs for each script  show up to ten of the longest checkpoint durat ions and are fol lowed by 
detai ls for each checkpoin t in  the graph. The checkpoints can originate in  any script  that was included in 
the test. The report  contains the fol lowing sect ions: 

!  A summary section with overview information about the test.  

!  Bar  graphs for checkpoints and bar graphs for counters showing the following:  
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–     Summary by percentage of violat ions - Shows the number of points that exceeded the 
threshold divided by the total number of data points. For example, in  the report  for counters 
below, the total fai lure of 8 divided by the total records of 60, yields a fai lure rate of 13.3 
percent. 

–     Summary by severi ty - Shows the percent of t ime during the test that the data is in  violat ion 
of the threshold. This calculat ion uses a weighted average to determine the percentage. For 
example, in  the report  for counters below, when the weighted average is used to calculate 
the severi ty, the fai lure rate is 7.6 percent and 6.5 percent.  

Since the first  method measures the fai lure rate by percentage of violat ions, and the second method 
measures fai lures by the amount of t ime the data is in  violat ion, the numbers can differ great ly between 
the two methods. It  is possible for a data set to have a 5 percent fai lure rate when calculated by percentage 
of fai lures, and an 80 percent fai lure rate when calculated by severi ty. This can indicate that an error 
deviat ing significant ly from the norm may be a more notable fai lure than a greater number of fai lures. 

In  the example below, the counter summary by percent of violat ions for Server Analysis shows a total of 8 
fai lures out of 60 records, for a fai lure rate of 13.3 percent. The percentage of violat ions for Remote 
Monitoring has a total of 3 fai lures in  41 records, for a fai lure rate of 4.2 percent.  

When measured by severi ty, however, the fai lure rate for Remote Monitoring is more serious than for 
Server Analysis. Here, the fai lure rate for Remote M onitoring is 7.6 percent compared to the rate 6.5 
percent for Server Analysis.  

Note: Transaction duration checkpoints are not included in the report. 
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Expert User Report  

Displays in formation on the scripts that ran on each player machine with the Expert  User opt ion enabled. 
It  provides a t im ing breakdown of the individual components, such as HTML, images, and objects, of the 
web pages that were requested during a test. The Expert User report  shows how much t ime i t  took to 
download a part icular component of a web page from the server. It  also shows the percentage of network 
and server t ime for the request. 

The Expert User report  contains a summary sect ion and a detai l  sect ion. The Summary sect ion at the top of 
the report  displays overview information about the test for each QALoad Player instance.  

The detai l  sect ion displays the main requests and each subrequest made when the script  executes. Main 
requests are made when Navigate_to(), Cl ick_On(), Post_to(), DO_http(), or DO_https() are executed in a 
WWW script. The subrequests, or Web components, that make up the main page can include html, css, js 
pages, and so forth. 

The percentage of server and network t ime displays in  the Average Server and Average Network fields, with 
a graphic representat ion in  the Server/Network field. This in formation can help you determine whether 
web pages with a h igh response t ime are having server- or network-related performance problems. If an  
except ional amount of t ime is being spent on the server, you can monitor the server that is under test 
using a server monitoring tool such as ServerVantage or QALoad's Remote M onitoring opt ions. If too much 
t ime is being spent on the network, you can monitor the network under test using a tool such as 
Appl icat ionVantage. 
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ApplicationVantage Report 

Displays in formation on the scripts that ran on each player machine. It  contains a summary sect ion with 
overview information about the test, a graph of the transact ion response t ime of the script . 

Note: If Expert User data was collected (WWW only), the Network and Server percentage data is also 
displayed.  

A detai l  sect ion displays the beginning and ending t ime for the trace fi les produced by the scripts running 
on the Appl icat ionVantage player machines. If more than one Applicat ionVantage Player machine ran 
during the test period, a separate sect ion appears for each one. 

 

 

Publishing or Sharing Test  Results 

Export ing test  data 

Convert test data in to three convenient formats for viewing or export ing: 
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HTM L — Export  data in  a detai l  view or graph to HTML fi les for convenient viewing in  a default  Web 
browser or for sending as attachments in  an email  message. See Export ing data to HTML for instruct ions. 

Com m a-separated value (CSV) — Export  data in  a detai l  view to comma-separated value (CSV) fi les which 
can be imported in to popular spreadsheet appl icat ions. See Export ing data to CSV for instruct ions.  

RIP — Any t ime a user fai ls during load test ing, QALoad Analyze generates a RIP fi le contain ing user errors. 
If a t im ing fi le has RIP fi le data, you can export  the RIP fi le to the working folder and view i t  in  QALoad 
Analyze or the QALoad Script Development Workbench. See Export ing RIP fi le data for instruct ions.  

Appl i cat ionVan tage (AV) t race f i l es - When a t im ing fi le has Appl icat ionVantage data, you can export  
the Appl icat ionVantage trace fi les to a working directory and view them with in Appl icat ionVantage. See 
Export ing Appl icat ionVantage Trace Fi les for instruct ions. 

  

Export ing data to HTML 

To expor t  dat a f rom  a det ai l  view  t o HTM L: 

1. Open a timing file. 

2. Generate a detail view or graph. 

3. Click anywhere in the detail view or graph, making it active. 

4. From the File menu, choose Export>Data. The Save As dialog box appears. 

5. Navigate to the appropriate location for saving the HTML file and name the file. 

6. Select Web Page (*.htm;*.html) as the file type and click Save. 

 

Export ing data to CSV 

To expor t  dat a f rom  t he Det ai l  view  t o a CSV f i le ( *.csv) : 

1. Open a timing file. 

2. Generate a detail view. 

3. Click anywhere in the detail view making it active. 

4. From the File menu, choose Export>Data. The Save As dialog box appears. 

5. Navigate to the appropriate location for saving the file. In the File name field, type a name for the file. 

6. Select CSV (comma delimited) (*.csv) as the file type and click Save.  

 

Export ing RIP file data 
Note: If a timing file does not contain any RIP data, then a RIP Files group will not exist in the Workspace. 
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To expor t  t he RIP f i le dat a t o t he w ork ing f older : 

1. Open a timing file. 

2. In the Workspace, click the RIP Files group. 

3. In the tree view, select the appropriate RIP files check box. 

4. Right-click on the selected files and choose Export. The Browse For Folder dialog box appears. 

5. Select the folder you wish to export the RIP file data to. The default is the working folder. 

6. Click OK. Analyze exports the RIP file to the working folder. 

 

Export ing Applicat ionVantage Trace Files 

You can export  Appl icat ionVantage trace fi les to a working folder or to Appl icat ionVantage. 

Note: If a timing file does not contain any ApplicationVantage data, then the ApplicationVantage group 
does not exist in the Workspace. 

To expor t  t he Appl icat ionVant age dat a t o a w ork ing  f older : 

1. Open a timing file. 

2. In the Workspace, click the ApplicationVantage group. 

3. In the tree view, select the appropriate ApplicationVantage files check box. 

4. Right-click on the selected files and choose Export to File. The Browse For Folder dialog box appears. 

5. Select the folder you wish to export the ApplicationVantage file data to. The default is the working folder. 

6. Click OK. Analyze exports the ApplicationVantage file to the working folder. 

To expor t  t he Appl icat ionVant age dat a t o App l icat ionVant age: 

1. Open a timing file. 

2. In the Workspace, click the ApplicationVantage group. 

3. In the tree view, select the appropriate ApplicationVantage files check boxes. 

4. Do one of the following: 

 Right-cl ick on the selected fi les and choose Export  to Appl i cat ionVan tage.  

 Double-cl ick the fi le to export . 

The trace fi les are loaded into the Appl icat ionVantage database and then opened in 
Appl icat ionVantage.  

Sending email messages with test  data 

If you are using a M icrosoft  mail  program, QALoad Analyze can send an emai l  message with a t im ing fi le or 
pre-defined report  at tached. The recipient(s) of the message wil l  be able to open the fi les in  a Web browser. 



QALoad 5.5  

436 

To em ai l  p re-def ined repor t s: 

1. Choose File>Send. 

2. In the Send dialog box, select reports, views, and timing files from their respective tabs and click Add to add them to 
the list of items you want to send.  

3. In the Send To field, choose Email Recipient.  

4. (optional) Click the Zip to file check box to send the files in the compressed .zip format. Type a name for the .zip file 
in the adjacent field. 

5. Click OK. Analyze creates a new Outlook email message that contains all of the pre-defined reports, .xml, .xsl, and 
files associated with the timing file as attachments, or a single .zip file that contains those files as an attachment. 
Address the email, add message text, and send the message. 

Creat ing a .zip file of test  results 

You can create a .zip fi le to convenient ly package al l  test data in to one fi le for sending to others or storing 
local ly. Analyze creates a f i le in  .zip format, which you can either save to a locat ion on your computer or 
send as an attachment to an email . 

To creat e a .zip f i le: 

1. Choose File>Send. 

2. In the Send dialog box, select reports, views, and timing files from their respective tabs and click Add to add them to 
the list of items you want to include in the .zip file.  

3. In the Send To field, choose Email Recipient to email the zip file or choose File to save the file on your computer.  

4. Click the Zip to file check box to send the files in the compressed .zip format. Type a name for the .zip file in the 
adjacent field. 

5. If you chose File in step 3, type the path of the location for the .zip file or click the browse button [...] to select a 
location. 

6. Click OK. Depending on which option you chose in step 3, Analyze performs one of the following actions: 

 If you chose Em ai l  Recipi en t , Analyze creates a new Outlook email  message that 
contains al l  of the pre-defined reports, .xml, .xsl, and fi les associated with the t im ing 
fi le as a single, compressed .zip fi le attachment. Address the email , add message text, 
and send the message. 

 If you chose Fi le, Analyze creates a single, compressed .zip fi le in  the locat ion you 
specified in  step 5 that contains al l  of the pre-defined reports, .xml, .xsl, and fi les 
associated with the t im ing fi le. 

 

Viewing reports 

View reports generated by QALoad Analyze on a machine with QALoad instal led or on any machine with a 
Web browser. In  order to save the contents of a t im ing fi le's working folder, when viewing reports, clear 
the Remove XML Working Folder opt ion. To properly set th is opt ion, see the Workspace tab on the 
Options dialog box. For more in formation, see Options Dialog Box - Workspace Tab.  
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Viewing reports on a machine with QALoad Analyze 

To view reports in  QALoad Analyze, cl ick the Summary report  button or any of the pre-defined report  
buttons in  the QALoad Analyze Workspace. See Load Test Summary for a quick in troduct ion to viewing 
reports. 

Viewing reports on a machine without QALoad Analyze 

To view reports in  a Web browser, copy the ent ire working folder for the t im ing fi le onto the machine. The 
fol lowing fi les are required (where <Summary> represents the name of the report): 

!  <Summary>.htm 

!  <Summary>.xml 

!  <Summary>.xsl 

In  addit ion, the M icrosoft  XML version 4.0 parser (provided with QALoad ) is required to view QALoad 
reports. View any of the pre-defined reports by cl icking the <Summary>.htm fi le to launch a report  with the 
assistance of the associated XML and XSL support fi les. 

Other ways to view test data 

View not only pre-defined reports, but also t im ing fi le detai l  views and graphs by export ing or sending 
email  messages with test data to another machine. Cl ick the fol lowing l inks for more in formation:  

!  Exporting Test Data 

!  Sending Email Messages with Test Data 

 

Viewing test  results in a Web browser 

An important part  of the load test ing process is viewing and studying the results of a test. You can view the 
results of a load test not only on a machine where QALoad is instal led, but also on any machine with a 
Web browser. QALoad Analyze provides pre-defined reports as well  as .xml and .xsl fi les which can be 
customized to meet desired specificat ions. 

When you open a t im ing fi le, QALoad Analyze generates a working folder contain ing al l  support ing fi les, 
reports, and images generated from that t im ing fi le. This folder is located in  the directory \Program 
Files\Compuware\QALoad\TimingFiles\xxx.xml.source where <xxx> is the name of the t im ing fi le. 

The fol lowing fi les are found in the working folder: 

Fi le Nam e Descript i on  

<timingfile>.xml.source Working folder generated in  the Reports folder when opening a 
t im ing fi le. The working folder name is always the <name of the 
t im ing fi le> with a .xml.source extension. 

<timingfile>.xml Original t im ing fi le with just enough information to create the 
QALoad Analyze pre-defined reports. It  is a representat ion of the 
t im ing fi le, <t im ingfi le>.t im. 

<timingfile>.complete.xml Original t im ing fi le contain ing al l  data col lected during a load 
test. It  can be an extremely large fi le. Use th is fi le i f creat ing a 
report  using XSL that required th is data. 

summary.htm Use th is HTM fi le to view the Summary report  (or any other 
avai lable pre-defined report) in  any Web browser. 

summary.xml Generated XML fi le for the Summary report  (or any other 
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avai lable pre-defined report .) 

summary.xsl Generated XSL fi le for the Summary report  (or any other 
avai lable pre-defined report .) Translates the .xml fi le specifying 
HTML as i ts output and generates the HTML report . Use th is fi le 
to customize the reports by writ ing in  .xsl. 

default.htm Report which provides a main screen to  launch any other pre-
defined reports. Uses nav.htm for the navigat ion frame. 

When closing a t im ing fi le, ei ther keep al l  of the reports generated from the t im ing fi le in  the working 
folder, or delete them. To set th is opt ion, see the Workspace tab on the Options dialog box. 

To view load test results in  a Web browser, cl ick: How to View Reports. 
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